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About this Guide

This guide describes how to perform Accolade’s initial setup and configuration tasks, and
explains how to maintain Accolade to provide the continually changing data needed for
excellent product innovation and development.

You must have the Administrator user role in Accolade to perform most of the tasks in this
guide.
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Who Should Read This Guide
You should read this guide if you are setting up, configuring, or administering Accolade. This
guide assumes you are familiar with:

l Accolade, its concepts and general navigation

l Microsoft Windows procedures and user interface (UI)

l Web site administration

l Database administration

l Security administration

Contents of This Guide
This guide describes how to configure and administer Accolade. It is divided into the following
chapters:

l Chapter 1 - Describes how to create user accounts for access to Accolade and the
various user roles, how to design access groups for project accessibility, and how to
use security lists and security profiles to further refine user access.

l Chapter 2 - Describes how to define the components used to enter and gather data for
Accolade projects including metrics, matrices, quick grids, document templates,
reports, and taking portfolio snap shots.

l Chapter 3 - Describes how to setup additional components for the process flows in your
organization including classes, workflows, and reference tables. These components are
part of process models that Process Designers within your organization define.

l Chapter 4 - Describes how to setup reports and charts for viewing Accolade data.

l Chapter 5 - Describes how to configure the Accolade web site including replacing logos
and other graphics, replacing and translating terminology, creating resource pools,
adding menus, defining currencies, and setting up Time Tracking.

l Chapter 6 - Describes how to integrate Accolade with other applications, such as MS
Office applications.

l Chapter 7 - Provides information about how to import project, metric, and resource data
into Accolade using specially formatted reference table.

l Chapter 8 - Provides information about backing up the databases associated with
Accolade.

l Appendix A - Provides a list of the standard database views and their fields available for
reports based on queries, and describes how to create custom reporting views.

l Appendix B - Provides a list of the columns available for creating reports using Accolade
Online Reporting and Accolade Office Extensions.
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l Appendix C - Provides a list of the Accolade system-level parameters that are managed
using the Accolade Administration Console.

l Appendix D - Provides details about the XML structure and elements used to create
online forms.

l Appendix E - Provides details about adding database queries to Accolade for use in
reports and query-based metrics, and provides a list of query field codes.

l Appendix F - Provides a list of the Accolade field codes available for use in Smart
templates.

Font Conventions
l This bold font is used for important words and the names of the items you need to
identify.

Create a SQL account named “Geneva”, and give this account the VS_Write database
role.

l This fixed-width font is used for examples of code, paths, and URLS.

https//:your-server-name:port-number/

l This italic font is used for document names.

l An italic font enclosed in brackets shows what information is displayed in this location
when the information is changeable, rather than fixed.

l Process Document - Online Form Example<version>.xml

l Blue text indicates a cross-reference link that you can click to take you to that location.

Icon Conventions

- Indicates a section with Sopheon best practices for system setup.

- Indicates a tip to assist with Accolade configuration or management.

- Indicates an example use case to assist with Accolade component configuration.

Important! This is an important statement. Read it carefully before proceeding with
an action.

Contacting Technical Publications
To send comments and suggestions regarding this document, send email to
techpubs@sopheon.com.

19
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Managing Access to Accolade

This project describes how to setup project security using access groups, security lists, and
security profiles and how to define user accounts for user who require access to the
application. See the following sections:

l Before You Begin

l Access Groups

l Security Lists

l Security Profiles

l Accolade Users and User Accounts

l Company Functions

Chapter 1
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Before You Begin
Prior to setting up access to Accolade, ensure that you have the following items:

l The initial Accolade administrator login created during the installation, or the login of
any Accolade user with the Administrator user role, for example your own login name
and password.

l The access groups hierarchy your company plans to use.

Important! The design of the access groups hierarchy is a critical process. The
structure of the hierarchy greatly determines information access and security and
plays a major role in how much time it takes to administer Accolade.

Design and create the access groups hierarchy early in the implementation.
Changing the hierarchy after a large number of users and projects have been
entered into the system can be a time-consuming process.

For more information, see "Designing the Access Group Hierarchy" on page 25.

l The structure of the security lists your company plans to use if you decide to enable
security lists.

l The login name, email address (optional), online conferencing tool address (optional),
and role(s) for each Accolade user.

Depending on how Accolade was installed, an Accolade user’s login name could be the
same as the login in their Windows domain account, or local machine account.

Familiarize yourself with Accolade roles and the authority granted to those roles. Roles
are key to workflow and security in Accolade. For more information about Accolade
roles, see "Users and User Accounts Overview" on page 54.

Access Groups Overview
An access group is a container that determines what information users can access. Access
groups can be assigned to all areas of a project, including classes, process models, projects,
reference tables, layouts, metrics, templates, quick grids, and planning elements in Accolade
Innovation Planning. Access groups operate in combination with security lists and security
profiles. If your company uses security lists, then users must have access to both access
groups and security lists to have access to project information.

Access groups restrict project and information access in the following areas:

l Reporting in Accolade Office Extensions and Accolade Online Reporting

l Upcoming Gates

l Reference Tables
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l Planning Elements in Accolade Innovation Planning

l Portfolio Optimizer Scenarios

l Classes

l Process Models

l Layouts

l Deliverables and Activities

l Metrics

l Matrices

l Templates

l Quick Grids

l Workflows

l Functions

l Search

Note: A user still has access to a project through search if the user is a member of
the project team, even if the user does not have access group access.

These areas only display project data for access groups to which a user belongs. The access
group settings in a user's account must match the settings for a project, reference table, or
planning element for information access. However, an access group assignment does not
restrict who can be added a project team, unless the Enforce Project Security for Add
Team Member system parameters is enabled

Access Group Best Practices

Keep the following set of best practice recommendations in mind when designing the access
groups structure:

l Design Early - The access groups hierarchy design is a critical process and should
happen early in the Accolade implementation. Changing the hierarchy after a large
number of users and projects are entered into the system can be a time-consuming
process.

l Keep it Simple - Keeping the structure simple makes it easier to assign users and
projects correctly and efficiently. It minimizes unintended denials of information, and is
easier for other administrators to understand the system.

l Limited Use of Root Access Group - Assign few or no users to the Root access
group. Keeping the Root group sparsely populated reduces maintenance in case you
decide to redesign the groups structure or to add restricted groups high in the hierarchy.

l Restricted Users - Create a special group for Restricted TeamMembers and do not
add any projects to it. All users must be assigned to at least one access group. Because
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users still have access to projects to which they are assigned, assign users with the
Restricted TeamMembers role to this access group.

l Idea Project - Create a special group for the initial assignment of all idea projects. Idea
Managers can re-assign promising ideas to other groups after the initial evaluation.

l Automate the Access Group Assignment - Create a calculated metric that
automates a project's access group classification. Using a metric at the model level
allows you to make a project more or less secure based on a metric's value.

l Restrict Access Group Assignment at the Process Model Level - To help ensure
that portfolios and other projects are created in the correct access group, set restrictions
on where projects created using a model can exist. Without restrictions, Process
Managers and Idea Managers can create and move projects to the access groups that
are assigned to their user. With access group restrictions, they can only create and
move projects to the access groups that are assigned to their user that are also part of
the restricted list.

l Tests and Training - Create a special group for test projects and training new
employees. This allows users to learn and experiment in Accolade without mixing
practice and training projects in with real, ongoing company projects.

l Project Assignments - Whenever possible, assign users to projects within their
access group assignments. Users can still participate in projects outside those access
group when assigned on the project. For example, as a Document Reviewer.

Information Security Examples

Consider the following information security examples as you are planning the security
framework at your company.

l Using the Restricted TeamMember role and the access groups tree, you can set up
several different levels of information security in your projects. For example, use the
access groups hierarchy to restrict the information in some projects to project members
only while making the information from other projects available to everyone.

l Using the Restricted TeamMember role to prevent users from seeing any information
other than the deliverable and activity pages that they own. They cannot see other
projects, other teammember assignments in their own projects, or other project
information available.

l Assigning Project TeamMembers and Project Managers to an access group that
contains no projects and has no children that contain projects, restricts those users to
accessing only the project pages of projects to which they are assigned. They cannot
search for any projects or documents. They can see all the deliverables and activities in
their own projects, but none in other projects.

l Assigning Project TeamMembers and Project Managers to an access group that
contains their own project but that has no children, allows them to search for documents
in their own projects only. They can access deliverables in their own project both
through Search and through the Project pages, but they cannot see other projects.
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l Creating all access groups as children of the Root access group and assigning Project
TeamMembers and Project Managers only to projects in their own group allows these
users to see and search for information in all of the projects in their group but prevents
them from seeing any information from projects in any other groups.

l Assigning users to an access group that contains multiple projects or one with children
that contain multiple projects, allows the users to search for and access many projects
and their documents. These users can access the projects that they can see both
through the Project pages and through Search.

l Assigning Process Managers, Executives, and other users who cannot be members of
a project to a group that is part way down the access groups tree completely hides
project information in the portions of the tree above where they are assigned. For
example, a Process Manager assigned in this manner only sees a portion of the total
number of projects when viewing projects through the Upcoming Gates page. Making
this kind of assignment can cause unexpected problems. For example, a Resource
Planner would not see all of the projects that might be pulling resources from one of her
pools.

l To give users access to all projects in Accolade, assign them to the Root access group.

Designing the Access Group Hierarchy

Access groups are arranged in a hierarchical tree structure. The tree determines ease of
maintenance and openness of information flow. Simpler trees make it easier to provide
adequate information access. Complex trees are more time consuming to maintain but offer
more specific information control. The access group tree and information control is specific to
your company. Use the information below to guide you in building your access group structure.

Accolade installs with a default access group called Root, which is always at the top of the
tree. You cannot delete this group; however, you can rename it. All additional groups are either
a child of Root, or a child of another access group in the tree. Thus, a user who is a member of
Root has access to every project and document in the system.

Users can search for documents, projects, see links to projects, and see chart and report
information about projects and reference tables that are assigned to the same access group to
which the user is assigned, or an access group that is in the same branch. In the hierarchy
above, a user assigned to Group A is able to access projects and information in Group A, but
not access to projects and information in Groups B, C, or D.
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A user assigned to access Group B is able to see information in Groups B, C, and D (because
Groups C and D are children of Group B), but cannot see information in Group A.

Example

A consumer goods company has business units named for the general categories of the
product types they develop, such as:

l Beverages & Snacks

l Healthy Living

l Restaurant Supplies

The company has created access groups named for each business unit. Optionally, a
company could create access groups under each business unit representing brands within
each unit. For example, in the Beverages & Snacks business unit, there are brands for Drinks,
Fun and Convenience, and On the Go products.
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Depending on security needs, users can be assigned at the brand level (Drinks) or at the
business unit level (Beverages & Snacks). A user added to the Beverages & Snacks access
group can see everything in Drinks, Fun and Convenience, and On the Go, but cannot access
any projects in the Healthy Living or Restaurant Supplies business unit.

If a user is assigned at the Drinks brand level, they can access all the projects in the Drinks
brand but not in the Fun and Convenience or On the Go brand.
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Note: If Accolade Innovation Planning is enabled, a second default group,
[Innovation Planner Default] is added as a child of Root. It is the group to
which all planning elements are added when they are created. You cannot
delete this default group; however, you can rename it, and you can assign
planning elements to a different access group once they are created.

In the most open tree, everyone is assigned to Root and has access to all information. Or,
perhaps only a few users are assigned to Root and a few others are in groups part way down
the tree. In the later of the structure, teammembers can access only the information in projects
to which they belong. Only a few users, such as Executives, can see project information from
more than one group.

Creating Access Groups

Access groups are arranged in a hierarchical tree that Administrators and Process Designers
create in Accolade by adding groups in a nested structure.

To create an access group:

1. From the Systemmenu, select Security & Groups > Access Groups.

The current access group tree displays.

2. In the Access Groups list, select the group to which you want to add a child group.

To create the first group in a new hierarchy, select the top most group (Root).

Based on your company's configuration, the top level group may have
been named something other than Root.

3. In the upper right corner of the Access Groups list, click to add a new access
group.

4. In the Name field, enter a unique name for the new group.
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5. In the System Name field, enter a unique system name for the new group.

6. Click Create to create the new group.

The new group displays in the hierarchy.

To rename an existing group, select the group to rename in the hierarchy,
update the name in the Name field, and click Apply.

Deleting Access Groups

You can delete an access group if it does not contain any configuration items (process model,
layout, metric, ...) in the access group hierarchy. As an Administrator, you can move users and
reference tables to a different access group and delete empty child access groups. However, a
Process Manager must move projects to a different access group. A Process Designer or
someone with Root access group permission must move process models to a different access
group.

An access group may be deleted while referenced in a snapshot; however, when the access
group is deleted it is also deleted from the snapshot.

To determine what is currently assigned to an access group, see "Reporting on Access Group
Contents" on page 29.

To delete an empty access group:

1. From the Systemmenu, select Security & Groups > Access Groups.

The current access group tree displays.

2. In the Access Groups list, select the group to delete.

Select the lowest child of the access group, or the group itself if it has no children.

The name of the selected group displays in the Name field in the Access Group editor.

3. Click Delete to remove the access group.

Reporting on Access Group Contents

An access group is assigned to users, projects, reference tables, and planning elements in
Accolade Innovation Planning. Use a report to determine if an access group currently contains
any of the items listed above.

Knowing an access group's contents can help you better understand an existing access group
structure, or to identify items that need moving prior to deleting an access group.

Reports created using the Accolade Office Extensions add-in and
Accolade Online Reports

Using the Access Groups subject, add the following columns:

29



Chapter 1  Managing Access to Accolade

Administrator's Guide

l Access Group Name

l Project Name

l User Name

l Table Display Name

Query in an HTML Report

Create SQL queries that select columns from the following reporting views:

l RVP_ProjectsByGroup - Select the ProjectName and AccessGroupName columns to
return information about the projects assigned to an access group.

l RV_ReferenceTables - Select the RTableName and RTableAccessGroup columns to
return information about the reference tables assigned to an access group.

l RV_UsersByGroup - Select the UserID and AccessGroupName columns to return
information about the users assigned to an access group.

Include the ParentGroupName column in any of the above reporting views to also select the
parent group's name.

See "Creating Excel Report Templates Using Queries" on page 369 for more information
about how to define a query and create a report.
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Restricting Configuration via Access Groups Overview
Use access groups to restrict reporting and configuration components within Accolade.
Defining who can view and edit components in the system allows your company to establish
corporate guardrails and mitigate risk of Process Designers accidentally making changes to
items outside of their business group or division. Establishing an access group hierarchy and
restricting edit rights within that hierarchy allows for configuration flexibility while still ensuring
corporate standards for configuration are met.

A Process Designer might be able to view a corporate-level process model but not be able to
edit it. They would, however, be able to edit components within the process model such as
deliverables specific to their business unit or division. By segmenting configuration and
restricting configuration edit permissions, you can ensure business units across your company
follow corporate guidelines such as processes for process models while still granting
autonomy at the lower division levels. When designing access group hierarchies, consider the
corporate use of configuration and the local autonomy of employees that need to view and/or
edit items within their business unit or division.

For example, Process Designer Sandy has access group view and edit permissions at the
corporate level. She can view and edit configuration for the all the business groups and
divisions in the organizational hierarchy. She might set corporate standards that apply across
the organization.

Process Designer Jeff can only edit requirements for his business group and the divisions
below. However, he has view access group permissions for the Electronics business group
and corporate configurations so he can view configurations and collaborate across the
organization.

Restricting configuration components is driven by the access group assignment of the
configuration component and the access group assignment of the user. When assigning users
to access groups, assign them additional view and edit permissions within the access group.

Configuration components that respect access group restrictions include all levels of process
model and reporting setup, to include classes, process models, gate documents, layouts,
deliverables and activities, metrics, matrices, templates, quick grids, workflows, functional
areas and functions, online charts and reports, and Accolade Office Extensions reports.

Restricting Configuration for Classes

Restrict who can view and edit classes by assigning the class to one or more access groups.
Process Designers with matching access group permissions set in their user profile will be
able to view or edit the class.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
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settings for the class must match the user permissions of other Process
Designers in order to display for them.

To restrict class configuration:

1. From the Systemmenu, select Process > Classes.

To narrow the class list, search by the class name, system name, or category.

2. Either select the class to edit.

3. Click the Security tab to display the configuration access group settings.

4. Select the access group(s) to which this class belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

The class is selected to the highest level access group listed by default. Note that the
class is only added to access groups that are checked. It does not propagate to child
access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the class, depending on their individual access group permissions.

5. Click Apply to save your changes.

Restricting Configuration for Process Models

Restrict who can view and edit process models by assigning the process model to one or more
access groups. Process Designers with matching access group permissions set in their user
profile will be able to view or edit process model components.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile and the access groups assigned
to the class the model is being attached to. Additionally, access group
settings on the process model must match the user permissions of other
Process Designers in order to display for them.

To restrict process model configuration:

1. From the Systemmenu, select Process > All Models and select the model to edit.

2. Click the Security tab to display the configuration access group settings.

3. Select the access group(s) to which this process model belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

32



Administrator's Guide

Sopheon Accolade Version 16.2

The process model is selected to the highest level access group listed by default. Note
that the process model is only added to access groups that are checked. It does not
propagate to child access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the process model, depending on their individual access group permissions.

4. Click Apply to save your changes.

Restricting Configuration for Gate Documents

Restrict who can view and edit gate documents by assigning the gate document to one or
more access groups. Process Designers with matching access group permissions set in their
user profile will be able to view or edit the gate document.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the gate document must match the user permissions of other
Process Designers in order to display for them.

Gate documents inherit the access group visibility assigned for the model. All deliverables and
activities on the model display regardless of their individual access group assignments.

To restrict gate document configuration:

1. From the Systemmenu, select Process > All Models and select the model to edit.

2. Do one of the following:

l To add a new gate document - In the Component Tree tab, click next to the
gate to add the gate document.

l To edit an existing gate document - Expand the gate within the component tree
and select the gate document.

4. Select the access group(s) to which the gate document belongs.

The access groups displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

The gate document is selected to the highest level access group listed by default. Note
that the gate document is only added to access groups that are checked. It does not
propagate to child access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the gate document, depending on their individual access group permissions.

5. Click Apply to save your changes.
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Restricting Configuration for Layouts

Restrict who can view and edit layouts by assigning the layout to one or more access groups.
Process Designers with matching access group permissions set in their user profile will be able
to view or edit the layout.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the layout must match the user permissions of other Process
Designers in order to display for them.

To restrict layout configuration:

1. From the Systemmenu, select Page Design > Layouts.

2. Do one of the following:

l To add a new page layout - Click Add New in the upper right corner of the page
and create the layout.

l To edit an existing page layout - Click the name of the layout to open it for editing.

3. In the Layout section under Configuration Access Groups, click to select the
access group(s) to which this layout belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

The layout is selected to the highest level access group listed by default. Note that the
layout is only added to access groups that are checked. It does not propagate to child
access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the layout, depending on their individual access group permissions.

4. Click Apply to save your changes.

5. Click Save or Save and Close to save the layout to Accolade.
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Restricting Configuration for Deliverables and Activities

Restrict who can view and edit deliverables and activities by assigning the deliverable or
activity to one or more access groups. Process Designers with matching access group
permissions set in their user profile will be able to view or edit the deliverable or activity.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the deliverable or activity must match the user permissions of
other Process Designers in order to display for them.

Deliverables and activities inherit the access group visibility assigned for the model. All
deliverables and activities on the model display regardless of their individual access group
assignments.

To restrict deliverable and activity configuration:

1. From the Systemmenu, select Process > All Models and select the model to edit.

2. Do one of the following:

l To add a new deliverable - In the Model tree, click next to the stage to add the
deliverable to.

l To add a new activity - In the Model tree, click next to the deliverable to which
the activity applies.

l To edit an existing deliverable or activity - Expand the stage or deliverable within
the Model tree and select the deliverable or activity.

3. Select the access group(s) to which the deliverable or activity belongs.

The access groups displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
Parent access group information is visible for access groups to which you have View
permission.

The deliverable/activity is selected to the highest level access group listed by default.
Note that the deliverable/activity is only added to access groups that are checked. It
does not propagate to child access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the deliverable and activity, depending on their individual access group
permissions.

4. Click Apply to save your changes.

Restricting Configuration for Metrics

Restrict who can view and edit metrics by assigning the metric to one or more access groups.
Process Designers with matching access group permissions set in their user profile will be
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able to view or edit the metric.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the metric must match the user permissions of other Process
Designers in order to display for them.

To restrict metric configuration:

1. From the Systemmenu, select Content Sources> Metrics.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page and
create the metric.

l To edit an existing metric - Click the name of the metric to open it for editing.

3. Click the Security tab to display the configuration access group settings.

4. Select the access group(s) to which this metric belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

The metric is selected to the highest level access group listed by default. Note that the
metric is only added to access groups that are checked. It does not propagate to child
access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the metric, depending on their individual access group permissions.

5. Click Apply to save your changes.

Restricting Configuration for Matrices

Restrict who can view and edit matrices by assigning the matrix to one or more access groups.
Process Designers with matching access group permissions set in their user profile will be able
to view or edit the matrix.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the matrix must match the user permissions of other Process
Designers in order to display for them.

To restrict matrix configuration:

1. From the Systemmenu, select Content Sources > Matrices.

2. Do one of the following:
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l To add a new matrix - Click Add New in the upper right corner of the page and
create the matrix.

l To edit an existing matrix - Click the name of the matrix to open it for editing.

3. Click the Security tab to display the configuration access group settings.

4. Select the access group(s) to which this matrix belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

The matrix is selected to the highest level access group listed by default. Note that the
matrix is only added to access groups that are checked. It does not propagate to child
access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the matrix, depending on their individual access group permissions.

5. Click Apply to save your changes.

Restricting Configuration for Templates

Restrict who can view and edit templates by assigning the template to one or more access
groups. Process Designers with matching access group permissions set in their user profile
will be able to view or edit the template.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the template must match the user permissions of other Process
Designers in order to display for them.

To restrict template configuration:

1. From the Systemmenu, select Page Design > Template Library.

2. Do one of the following:

l To add a new template - Click Add New in the upper right corner of the page and
create the template.

l To edit an existing template - Click the name of the template to open it for editing.

3. Select the access group(s) to which this template belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.
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The template is selected to the highest level access group listed by default. Note that
the template is only added to access groups that are checked. It does not propagate to
child access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the template, depending on their individual access group permissions.

4. Click Apply to save your changes.

Restricting Configuration for Quick Grids

Restrict who can view and edit quick grids by assigning the quick grid to one or more access
groups. Process Designers with matching access group permissions set in their user profile
will be able to view or edit the quick grid.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the quick grid must match the user permissions of other Process
Designers in order to display for them.

To restrict quick grid configuration:

1. From the Systemmenu, select Page Design > Quick Grids.

2. Do one of the following:

l To add a new quick grid - Click Add New in the upper right corner of the page and
create the quick grid.

l To edit an existing quick grid - Click the name of the quick grid to open it for
editing.

3. In the Quick Grid Design section under Configuration Access Groups, click to
select the access group(s) to select the access group(s) to which this quick grid
belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

The quick grid is selected to the highest level access group listed by default. Note that
the quick grid is only added to access groups that are checked. It does not propagate to
child access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the quick grid, depending on their individual access group permissions.

4. Click Apply to save your changes.

5. Click Save or Save and Close to save the quick grid to Accolade.
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Restricting Configuration for Workflows

Restrict who can view and edit workflows by assigning the workflow to one or more access
groups. Process Designers with matching access group permissions set in their user profile
will be able to view or edit the workflow.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the workflow must match the user permissions of other Process
Designers in order to display for them.

To restrict workflow configuration:

1. From the Systemmenu, select Process > Workflows.

2. Do one of the following:

l To add a new workflow - Click Add New in the upper right corner of the page and
create the workflow.

l To edit an existing workflow - Click the name of the workflow to open it for editing.

3. Click the Security tab to display the configuration access group settings.

4. Select the access group(s) to which this workflow belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

The workflow is selected to the highest level access group listed by default. Note that
the workflow is only added to access groups that are checked. It does not propagate to
child access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the workflow, depending on their individual access group permissions.

5. Click Apply to save your changes.

Restricting Configuration for Functions

Restrict who can view and edit functions by assigning the function to one or more access
groups. Process Designers with matching access group permissions set in their user profile
will be able to view or edit the function.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the function must match the user permissions of other Process
Designers in order to display for them.
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To restrict function configuration:

1. From the Systemmenu, select Security & Groups > Functions.

2. Do one of the following:

l To add a new function - Click in the lower left corner of any functional area and
create the function.

l To edit an existing function - Click on the function field you want to edit.

3. To configure access groups, click on the function's access group cell to open a dialog
where the function's access group(s) may be edited.

4. Select the access group(s) to which this function belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

The function is selected to the highest level access group listed by default. Note that the
function is only added to access groups that are checked. It does not propagate to child
access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the function, depending on their individual access group permissions.

5. Click Apply to save your changes.

Restricting Configuration for Charts and Reports

Restrict who can view and edit configurable Accolade charts and reports by assigning the chart
or report to one or more access groups. Process Designers with matching access group
permissions set in their user profile will be able to view or edit the chart or report.

Note: The access groups that display for selection are based on your access group
permissions as defined in your user profile. Additionally, access group
settings for the chart or report must match the user permissions of other
Process Designers in order to display for them.

To restrict online charts and reports configuration:

1. From the Systemmenu, select Content Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new chart or report - Click Add New in the upper right corner of the page
and create the chart or report.

l To edit an existing chart or report - Click the name of the chart or report to open it
for editing.
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You must either be an owner of the existing chart or report, or it must be
set as Available to Configuration in the Shared Charts & Reports
section.

3. Under Configuration Access Groups, click to select the access group(s) to which
this chart or report belongs.

The access group(s) displayed are based on the current user's access group
permissions. Only access group(s) to which you have Edit permissions are selectable.
However, parent access group information is visible for access groups to which you
have View permission.

The chart or report is selected to the highest level access group listed by default. Note
that the chart or report is only added to access groups that are checked. It does not
propagate to child access groups unless those child groups are checked.

Process Designers with matching access group permissions will be able to navigate to
and edit the chart or report, depending on their individual access group permissions.

4. Click Save to save your changes.

Process Model Component Tree

A component tree has been added to the process model configuration definition, displaying all
Accolade objects associated with the process model, including stages, gates, deliverables,
activities, custom layouts, metrics, matrices, charts, reports, queries, quick grids, templates,
and workflows. With a quick view, Process Designers can determine which Accolade
components have been correctly configured based on access group security restrictions.

To view a process model's related components:

1. From the Systemmenu, select Process > All Models and select the model to edit.

2. Click the Component Tree tab to display the process components.

The components are grouped by type and can be expanded for additional review.
Clicking on the component name will display the process model's parent access group
on the left, and the component's access group on the right.

Misaligned components will be highlighted in the component tree with a
or .

3. Review and align the configuration access groups using the following guidelines:

Field Description

In Trouble This error states that the access group configuration of this item is
inconsistent with one or more items that use it.

To resolve, do one of the following:

l If the mismatch is on the parent side, the issue can be
resolved by aligning the process model's access group on
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Field Description

the Security tab.

l If the mismatch is on the component side, the issue can be
resolved by aligning the component's access group in the
component tree panel.

Warning This warning states that the access group configuration of an
ancestor is inconsistent with one or more items that use it.

This is usually resolved when the error at the parent level is
addressed, If there is still a mismatch, do one of the following:

l If the mismatch is on the parent side, the issue can be
resolved by aligning the process model's access group on
the Security tab.

l If the mismatch is on the component side, the issue can be
resolved by aligning the component's access group in the
component tree panel.

4. Click Apply to save your changes.

Security Lists Overview
Security lists are hierarchical lists of different object types that control access to projects and
unowned resource pools. Security lists grant access based on matches between security list
selections in a user account and security list selections in projects and resource pools.
Security lists manage access based on a combination of factors rather than just on the
structure of the access groups tree. Accolade supports the definition of up to five security lists,
with a maximum of 10 levels in each list.

Security lists prevent the following:

l Users without access from seeing or navigating to project data in Upcoming Gates,
Charts and Reports, or in optional components such as Accolade Portfolio Optimizer,
Dashboards for Accolade, Accolade Innovation Planning, and the Accolade Office
Extensions add-ins

l Users without access from linking to a related project to which they do not have access.

l Process Managers without access from managing projects to which they have Manage
Process rights.

l Resource Pool Administrators from seeing or creating pools that are outside their scope
of access.

l Resource Planners without access from seeing and modifying demand on resource
pools they do not own.

l Resource Planners without access from modifying capacity.
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Users can still access projects of which they are a member of the project team through All My
Work, My Project, and through Search, regardless of their security list settings. Project
members not assigned to the project cannot search for project data or refresh Accolade Office
Extensions reports on their projects.

If security lists are enabled, the combination of both access groups and security lists controls
access to projects. User settings for both access groups and security lists must match those
set for a project for users to have access to that project. To base access primarily on security
lists, you can give most users high level access or even access at the Root level within the
access groups. However, because security lists do not affect the management rights of
Process Managers and Idea Managers or access to data in Reference Tables, the access
groups must be developed at least to the level at which you want to define these rights.

Note: Security lists do not control access to reference tables, and they do not affect
the management rights of Process Managers and Idea Managers. Access
groups control access for these roles.

Once defined, security lists are assigned to user accounts, projects, and resource pools.

Example

A user with Paris selected in the hierarchy below could see reports on projects that also had
Paris selected as long as the user and project also had the same check boxes selected in the
other security lists in the system.

But this user could not search for projects in Dijon, Asia, or in projects that only had France
selected. Note also that check boxes that are filled in do not provide access. They indicate
that one or more of their child items are selected.

Combine the settings from multiple security lists to create a more intricate security framework.
For example, one security list could define sales territory as in the example above. A second
security list could define products by division, product type, and brand. Access to project
information would be based on a combination of location and product responsibilities.
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Security list selections are available throughout the system to grant access to projects,
resource pools, or planning elements in Accolade Innovation Planning.

Building Security Lists Manually

Administrators can create security lists manually or using reference tables. How you choose to
create security lists is up to you. The procedure below provides instructions to manually build
security lists. See "Building Security Lists Using Reference Tables" on page 47 if you prefer to
use reference tables.

Each security list contains a Default level, which provides access to the entire list. The
additional levels that you define within the list are its primary categories. For example, in a list
based on geography, the levels might be Country, Region, and City.

As you add security lists to your system, consider the following:

l User accounts have no security list options selected. Administrators must set security
access for all users.

l Existing projects have all security list options selected. Process Managers and Project
Managers must clear check boxes to limit access appropriately.

l Resource Pools have no check boxes selected. Resource Pool Administrators and
Administrators must select security list options to grant Resource Planners, Resource
Planners, and other users the appropriate access.

Accolade supports the definition of up to five security lists, with a maximum of 10 levels in each
list.

To build a security list manually:

1. From the Systemmenu, select Security & Groups > Security Lists.

2. Click to activate the security list you want to define.

By default, all security lists are inactive.

3. Enter the following information to identify the security list:

Field Description

Name Enter a name, up to 64 characters long, which identifies the
security list.

System Name (Read Only) Displays the system name of the list selected.
Active Select the check box when the security list is ready to use.

If list is inactive, the levels information will not be displayed in
the security list tree.

Levels Level 1: Enter the description name of the first level in the
security list. This will be the highest level of access within the
security list. Displays Default Access as a default.
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Field Description

Once the first level is created, Click to add additional

level description names to the security list.

Note: All security lists must contain a minimum of
one level, and have a maximum of 10 levels
on one security list.

4. Click Done to save changes to the security list details.

5. To enter levels and categories:

l Under the security list just created, click the Default Access to open the list editor. In
the Name field, enter the name to define this parent node.

l To enter additional levels or entries in the security list tree, click to the right of the
node. This will add a new entry to the level below it.

l To add children levels, click on the Children field and enter the name of the child.
Press Enter to continue add additional child levels to this node.

Note: Children categories can only be deleted prior to clicking Apply. Once saved,
they are considered "in use" and cannot be deleted.

6. Click Apply to save your changes.

Example

A user wants to manage their Accolade projects by managing their business units access
within a security list. The business is within North America, in the states of California,
Colorado, and Michigan. There are different operations areas in California and Colorado that
will need to have separate access.
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In the example above:

l There are 3 distinct levels defined in the business - Level 1 (Region), Level 2 (State),
and Level 3 (City).

l Level 1 is the highest access level. It is defined as the Regional level, and in the system
it is named North America.

l Level 2 is the next access level down. It is defined as the State level, and in the system it
contains the entries California, Colorado, and Michigan.

l Level 3 is the lowest access level in the example. It is defined as the City level, and in
the system it contains the entries Sacramento, San Francisco and Denver.

Remember that additional levels and/or entries can be added by clicking on the security list
tree, and entries are added beneath the level clicked. So for example, if the user wanted to add
Detroit to the City level under Michigan, they would click to the right of the Michigan entry.

Notes:
l To move and item up or down in the list, click an item and drag it to the new
location.

l To remove a security list, click next to the list and click Restore to Default.
This will deactivate the list and clear all levels and nodes.

l To remove an entire heading row or an item, click next to the heading row or
item to delete. You must remove all child items before removing its parent, and
entries that are already in use cannot be deleted.
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l If you create Resource Editor filters that match pools to projects, a user with
access to many pools and projects could experience significant wait times while
the filters try to calculate matching pools and projects. To reduce the wait time,
ensure the security lists you define for resource pools and projects have as few
redundant selections as possible. .

Resource Planning is an optional Accolade component that you may not have
access to. To implement this solution, contact Sopheon Customer Support.

Building Security Lists Using Reference Tables

Administrators and Process Designers can create security lists manually or by using a
reference table for each list.

To build a security list using a reference table, complete the following tasks:

l Create a spreadsheet file containing the security list information.

l Add the file to Accolade as a reference table.

See "Building Security Lists Manually" on page 44 if you are an Administrator and prefer to
build security lists manually.

Creating the Spreadsheet File

Each reference table can contain one security list. Accolade supports up to five security lists,
with a maximum of 10 levels in each list.

Create a spreadsheet file titled SGM_SecurityList_<number> that includes a worksheet
named SGM_RefTableSheet which contains the security list data and meets the
requirements and specifications. Column headings are in the first row of the worksheet.

Important! The columns in the spreadsheetmust be present and in the order
listed for the security list to upload successfully.

Component Requirements

ID Enter a unique ID that identifies the item in the security list.

IDs can include letters (English alphabet), numbers, and the
underscore.

ParentID Enter the ID number of this item's parent item. The parent is
the item in the list hierarchy that this item appears to be
contained in.

l The top item in the security list, which is the root item
of the list, must have an empty cell in this column.
If you were to create a second item with an empty cell
in the ParentID column, you would create two
separate lists.
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Component Requirements

l For every value that exists in the Parent ID column,
there must exist an item that has that value in its ID
column.

Name Enter this item's name as it should appear in the displayed
list hierarchy. This is the item's label within Accolade.

Level Enter an integer specifying this item's level in the list
hierarchy. The level numbers specify the parent-child
relationship in the hierarchy.

l There should be one item at the top level that is
equivalent to the root level. This item should have level
1, and when this top level is selected, all levels are
selected.

l Each level should only have one associated level
name.

Level Name Enter the name of the type of items that should be in this
level.

The level name is not displayed in the security hierarchy. It is
used by the table owner who maintains the reference table
as a reminder to enter consistent and appropriate items in
each level.
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Example

Note the following in the example above:

l This example builds the list under a root list of Geography as follows:

l The column headings in order from left to right, on the first row of the worksheet. The
worksheet is named SGM_RefTableSheet and is loaded to Accolade as SGM_
SecurityList_1.

Adding the Reference Table to Accolade

After creating the worksheet with the security list information, save the file and add it to
Accolade as a reference table.

Keep the following in mind when uploading the reference table to Accolade:

l Security list reference tables must have a System Name of SGM_SecurityList_
<number> where <number> is 1 to 5. For example, "SGM_SecurityList_2", "SGM_
SecurityList_3", and so on.

l The reference table display name is used as the list's name where the list is displayed
within Accolade.

Enable automatic uploading to upload new versions automatically.
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After a reference table is added to Accolade, its table owner can then upload later versions to
maintain the contents of the table.

Notes:
l If projects already exist and you change the access value to a value other
than the default, after uploading the security list reference table, also run a
project import for the existing projects, specifying the values to set in the
Security List data columns for those projects.

Assigning Users to Security Lists

When security lists are first added to Accolade, they are configured with no users assigned to
the list. Administrators must configure the security for all existing users.

To assign a user to a security list:

1. From the Systemmenu, select Security & Groups > User Admin.

To filter the list of users, enter one or more search criteria to filter by name, login
name, email address, function, or extended field by selecting one or more of the
following options and clicking Search.More...
l Selecting a Function in the drop-down will display available users that are
assigned to the function.

l Select aGroup By option to arrange the user list by roles, functions,
resource pools, or access groups.

l ClickMore options check box displays or hides the additional filter options.
l In the Active/Inactive drop-down, select to filter users by active and inactive
status from the following options:

l Active Users Only - excludes inactive users.
l Show All Users - displays active and inactive users.
l Inactive Users - displays only users marked as inactive. Inactive
status is indicated with grey italics.

l In the Roles drop-down, select a specific role to apply to filter the user list.

2. In the Users list, click the name of the user to open the user details for editing .

3. Select the Security Lists tab.

4. Select the check boxes for each security list to assign to the user, noting the tree
structure.

Selecting a top level of a tree selects all the lists below it. A check box filled with
indicates that some of its child items are selected, but does not provide access to the
corresponding list.
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5. Click Save to save your changes.

Security Profiles Overview
Security profiles define project access based on classes and metric values associated with a
project and a user. The class and metric value settings assigned to a project must match those
assigned in the profile that is assigned to a user for the user to have access to the project
information. Two users in the same access group can have access to separate sets of projects
in that group using two different security profiles.

Important! A profile can distinguish user access within an access group, but
cannot grant access to projects or reference tables that the access group hierarchy
denies.

Security profiles restrict project and information access in the following areas:
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l Reporting in Accolade Office Extensions and Accolade Online Reporting

l Upcoming Gates

l Reference Tables

l Planning Elements in Accolade Innovation Planning

l Portfolio Optimizer Scenarios

A security profile does not prevent users assigned to a project from navigating to it through All
My Work or through Search. If a Process Manager is assigned as the project manager to a
project that is restricted based on a security profile, the Process Manager only has the rights
and permissions on the project that an assigned project manager has. The Process Manager
loses all management rights for that project, except for Manage Team rights.

Security Profiles Best Practices

Keep the following set of best practice recommendations in mind when designing security
profiles for your organization:

l Use security profiles only when necessary. They can introduce additional risk that
unintentionally blocks project information that your users need.

l Carefully analyze the class and metric structure before implementing security profiles.
Can you accomplish the same security set up with access groups?

l Metrics used in security profiles must be a List, Multi-Select List, or String type metric.
Number, Date, and Long String metric types are not available for use in security
profiles.

l Metrics whose value is initialized from another metric, and calculated metrics are not
available for use in security profiles.

l Accolade allows the definition of up to 250 profiles. However, keep it simple!

Creating Security Profiles

Security profiles define project access based on classes and metric values associated with a
project and a user. Associating a metric with a security profile further refines the access based
on the values assigned to the metrics. The available metrics are those associated with models
in the selected classes, so the metrics in a profile can distinguish access only within the
selected classes.

Note: Prior to creating a security profile, ensure that the classes and metrics exist
within Accolade.

To create a security profile:

1. From the Systemmenu, select Security & Groups > Security Profiles.

To narrow the list, search by the category.

2. Do one of the following:
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l To add a new security profile - Click Add New in the top right corner of the page.

l To edit an existing security profile - Click the name of the security profile to open
it for editing.

3. Enter the following information to identify the security profile:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
security profile.

System Name Enter a unique, shorter name that identifies the security
profile in queries, reporting views, field codes, and other
places in Accolade.

The name must be unique among security profiles, and can
only contain letters (English alphabet), numbers, and the
underscore.

Description Enter a description of the purpose or nature of the security
profile. This description helps other users identify the profile
throughout the system.

Category Enter or select the group to which this security profile
belongs.More...

Use categories to organize like profiles together.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted automatically.

Order Enter a number to specify the security profile's place in the
list of profiles on the Security Profiles page. A smaller
number places the profile higher in the list.

Visible Select this check box when this security profile is ready for
use.

Classes Select which classes to include in this security profile.

Note: A security profile must have at least one
class.

4. In theMetrics section, click Add Metrics and select one or more metrics to add from
the Available Metrics list. Use the Category, Name or System Name options to filter
the list of available metrics. Click Select to select the metrics, and then click Done when
finished.
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A metric must be a List, Multi-Select List, or String type and be associated with at least
one model in a class selected in the profile to add it to a security profile. Additionally,
security lists cannot include initialized or calculated metrics.

5. For each profile metric, click the Value column to specify the values.
l For List type metrics - Select the values the metric must have to allow access to
the project.

l For String type metrics - Enter the exact string of characters that this metric must
have to allow access to the project.

6. (Optional) To allow access to projects whose assigned process model does not include
this metric, select the Extended Access check box. Extended access allows access to
projects that do not contain the metric itself, not to projects that contain a different value
for the metric.

7. Click Create to create the new security profile or Apply to save changes to an existing
security profile.

Notes:
l To delete a security profile, ensure the profile is not in use, select the profile, and
click Delete.

l Select to print the list of security profiles.

Users and User Accounts Overview
Each employee who uses Accolade has an Accolade user account that contains information
that defines who the employee is and what he or she can do and see within Accolade.

Administrators create user accounts that identify a user by login, name, email address, and
chat address. Administrators also assign each user a set of attributes that determines what the
user can see and do, email notifications they receive about system activity, and the default
language in which the application displays. See "User Attributes Overview" on page 74 for
details about attributes you can assign after an account is created.

See "User Roles Reference" on page 80 for information about user roles
and their permissions within Accolade.

To help streamline user creation in your system, consider the following:

l Template Users - Create template users that represent various employee
responsibilities in your organization. For example, to configure all your Project
Managers in your Europe office the same, create a template user account called
ProjectManager-Europe. Configure that user with the roles, access group, security
settings, and so on that you want to assign to your Europe-based Project Managers.
When you create a user account for a new Project Manager in Europe, you can select to
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copy the account's attributes into the new account.

l Importing and Updating User Accounts - You can import multiple users using a
specially formatted spreadsheet file. Importing users in this manner is useful when you
are first setting up your system.

l Synchronizing with Active Directory - If your company uses Microsoft's Active
Directory for user authentication and administration, you can synchronize the user
accounts defined in Accolade to those defined in your Active Directory server.
Synchronizing the user data between your Active Directory and Accolade allows you to
maintain user data such as email addresses and user names in the Active Directory
without having to maintain the information in multiple locations.

Creating Accolade User Accounts

Create an Accolade user account for each employee that accesses Accolade. The user
account contains the attributes the employee needs to do their job and to log in to Accolade.

The procedure below details how to create an individual account. See the additional topics in
the Learn More section for information about defining attributes to the user account. To create
multiple users at the same time, see "Importing and Updating Accolade User Accounts" on
page 58. If your company uses Microsoft’s Active Directory for user authentication and
administration, you can synchronize the user accounts in Accolade to those defined in your
Active Directory.

To create a user account:

1. From the Systemmenu, select Security & Groups > User Admin.

2. Click to display the Add New User dialog box.

3. Complete the following information about the user:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

User Name Enter the user's name as you want it to display in
Accolade.

(Optional) If the Enable User Profile Images
system parameter is enabled, add a user profile
image that displays with the user's name in various
locations within Accolade, click next to the user
name, click Choose Image, navigate to and select
the image to add, and click Upload File. To remove
a profile image, click the image next to the user
name and click Remove.

Note: To display as an image within
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Field Description

Accolade, an image file must be one
of the following file types: .bmp, .dib,
.gif, .jpg, .jpeg, .jpe, jfif, or .png.

Login Enter the login the user uses to access Accolade.

You may consider keeping logins consistent, such
as first initial and last name (jdoe) or first name.last
name (jane.doe).

Depending on how Accolade is installed, a user’s
login name could be the same as the login in their
Windows domain account, or local machine account.
For Windows Authentication, logins are
<domain>\<login name> where <domain> is the
network domain and <login name> is the login
assigned to the user.

Email Address (Optional) Enter the user's corporate email address.
Accolade uses this address for email notifications
and for email links throughout the system.

Chat Address (Optional) Enter the user's address for your
company's selected chat tool.

Resource Pool (Optional) Select the resource pool to which the
user belongs. Users are grouped into resource pools
for resource planning purposes for assignments to
projects.

Note: This field is only available if your
company uses the resource
planning components within
Accolade and at least one resource
pool is defined.

Copy From (Optional) Click [None] and select the user whose
configuration details you want to copy to this user.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role
to the current user (if they have the appropriate
rights).

l Selecting a Function in the drop-down will
display available users that are assigned to the
function. The current selection defaults to the
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Field Description

function to which you are assigning a user,
however depending on the project configuration,
you can assign any user.

l Clicking the Show advanced filters check box
displays or hides the additional filter options.

l Clicking Clear removes the current user
assignment and displays [None] to indicate that
no user is assigned.

Copying configuration details from existing users
ensures that users that you want to have the same
permissions are set up identically. It allows you to
assign most of the details automatically, including
the initial All My Work page and Stages page
column configurations, and only make a few
changes to the user.

For example, you may have a set of Process
Managers in your organizations that all receive the
same configuration. Create one, and then copy the
configuration to all others.

Create a group of template users that have
the appropriate functions, roles, extended
fields, and other details that apply to all
users in a group. Associating a template
with each user applies details
automatically as part of the create process.

4. Click Create to create the user account.

5. Complete the user setup by adding or updating the following:

l Assign general user details.

l Add user roles and rights.

l Grant access group permissions.

l Add custom details and extended fields, if set as active for the user.

l Define security list and/or security profiles, if in use by your company.

l Define user functions.

l Set up user-specific menu items and links.

l Set up project email notifications.

l Set up HTML report notifications.
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Importing and Updating Accolade User Accounts

Accolade provides Administrators and Process Designers the ability to export user accounts to
update information, and to move configuration between environments. For example, if you are
first setting up your system or opening a new office and have multiple user accounts to create
at once, or if you need to update accounts such as renewing a user's access on a periodic
basis, you can do so in two ways. Either execute all changes directly from the User Admin
dashboard (See Updating User Accounts) or use a spreadsheet file with worksheet tabs to
create and update the user accounts within Accolade. Below are details on how to update by
spreadsheet.

Current user accounts can be downloaded from an Accolade environment, changes made to
the data, and then uploaded either into the same environment, or moved into a new
environment.

Administrators who wish to make bulk updates to user logins by spreadsheet can do so with
the User Importer feature.

Create a group of template users that have the appropriate functions,
roles, extended fields, and other details that apply to all users in a group.
Associating a template with each user applies details automatically as
part of the import process. Using filters allows you to assign details to a
variety of sub-groups or combinations of groups.

Important! In very large implementations we recommend running user imports in
batches. The size of the batches will depend on the server performance and the
number of updates per user, so that, for example, no more than a few thousand
users are imported at a time.

A download of current user accounts exports the user account configuration information into a
spreadsheet file with the parts grouped into tabs.

To download user accounts:

1. From the Systemmenu, select Security & Groups > User Admin.

2. Select the users that you want to download.

To narrow the list by function or user name, add the criteria to filter by in the appropriate
filter text box. These filters are case insensitive. To download all users, clear all search
filters.

3. Click in the users panel to view details of selected users.

4. Click in the users panel.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.
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To import user accounts into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any user account information that you do not want to include in the upload from
the spreadsheet and save the file.

3. From the Systemmenu, select Security & Groups > User Admin.

4. Click in the users panel.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the user accounts in the spreadsheet and adds any
new user accounts with unique user logins.

To update user logins en masse:

1. After downloading the spreadsheet file, navigate to the UpdateUserLogins tab. This is
the last tab on the downloaded spreadsheet file.

Note: The UpdateUserLogins tab will be pre-filled with the existing user
login data from your selection.

2. Fill in the New User Login column with updated user logins.

3. Follow the previous steps to import updated spreadsheet file into Accolade.

Applying Template User Settings to Existing Users

In Accolade versions 16.0 and later, Administrators can apply the settings of an existing user
(hereby referred to as a "template user") to other existing users. This can be done via the
Accolade User Interface (UI), the application programming interface (API), or by using the
User Importer feature. The instructions below discuss how to use the User Importer feature to
apply the settings of a template user to an existing user. See Updating User Accounts for
instructions on how to use the Accolade User Interface instead.

To apply template user settings to existing users:

1. From the Systemmenu, select Security & Groups > User Admin.

2. Select the users that you want to download.

To narrow the list by function or user name, add the criteria to filter by in the appropriate
filter text box. These filters are case insensitive. To download all users, clear all search
filters.

3. Click in the users panel to view details of selected users.

4. Click in the users panel.
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By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.

5. From the User Admin dashboard, search for the template user you wish to copy.

6. Select the appropriate template user from the search results list.

7. In the General Details tab of the User Admin dashboard, copy the template user's
login.

8. In the downloaded spreadsheet, navigate to ImportUsers tab, which is the first tab and
displayed by default.

9. In the Copy From User column, paste the copied template user's login for each existing
user whose settings you wish to update.

10. Save the file.

11. From the Systemmenu, select Security & Groups > User Admin.

12. Click in the users panel.

13. Click Load File and select the spreadsheet file to load.

14. Click Upload File.

Accolade uploads the changes to the user accounts in the spreadsheet and adds any
new user accounts with unique user logins.

User Account Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each user account in the
order listed below. For a description of each user account setting, see the Creating Accolade
User Accounts or User Attributes Overview topics in the online Help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Import Users

Column Name Accepted Values on
Upload* Additional Notes

User Name Alphanumeric
characters,
underscore**

If blank, the user account does not upload.

User Login Any Use the format with which the user accessed
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Column Name Accepted Values on
Upload* Additional Notes

Accolade, such as domain\username or
username@domain.com.

Used for matching for upload.

If a user account exists, its settings are
changed with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new user account is
created.

If blank, the user account does not upload.
Email
Address

Valid email address Can be blank.

Chat
Address

Valid chat address Can be blank.

Resource
Pool

Valid resource pool
display name

Can be blank.

Copy From
User

User login of user
account to copy
from

Use the format (username) without the
parentheses.

If the import creates a new user account, the
copy from user account settings will be used
for the new user setup, and all other tabs in
the import worksheet will be ignored.

Can be blank.
Language An active language If blank, defaults to English.
Date Format A valid date format

enum
If blank, defaults to MMM dd, yyyy (Feb 28,
2020).

Expiration
Date

Valid date Use the format MM/DD/YYYY.

Can be blank.
Active Yes, Y, True, 1, X* All other values are treated as No on upload.
Show
Messages

Yes, Y, True, 1, X* All other values are treated as No on upload.

Enable Auto
Search

Yes, Y, True, 1, X* All other values are treated as No on upload.

Reporting
Rights

None
Refresh
AllRights

If blank, defaults to None.

My Project
Page

Yes, Y, True, 1, X* All other values are treated as No on upload.
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Column Name Accepted Values on
Upload* Additional Notes

Updates
Email
Format

HTML
Plain Text

If blank, defaults to Plain Text.

Send Email
Number of
Days before
Defined
Date

Valid number If blank, defaults to 7.

Delete Yes, Y, True, 1, X* All other values are treated as No on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Security Lists

Security lists are optional when importing user accounts. The worksheet must be
included in the spreadsheet file, but can be left blank if the users do not have security
list assignments.

Column Name Accepted Values on
Upload Additional Notes

User Login Valid Accolade
user login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Security
List Name

Valid security list
system name

Can be blank.

Security
List Value

Valid security list
value system name

For each security list field above, include the
value for that field to assign to each user. For
multi-select extended fields, include a
separate row for each value.

On import, if a security list value is not
included in the sheet, the existing settings for
that user are preserved for that field. If a value
currently assigned to a user is not included in
the sheet, the value is removed from the user.

l Functions
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Column Name Accepted Values on
Upload Additional Notes

User Login Valid Accolade
user login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Function Valid function
system name

Include a separate row for each function.

l Roles

Column
Name

Accepted Values on
Upload Additional Notes

User Login Valid Accolade
user login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Role Valid Accolade
user role

Include a separate row for each role.
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l Portfolio Optimizer Rights

Portfolio Optimizer is an optional Accolade component that may not be used by your
company. The worksheet must be included in the spreadsheet file, but can be left blank
if you do not use Portfolio Optimizer.

Column
Name

Accepted Values on
Upload Additional Notes

User Login Valid Accolade user
login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Right PortfolioLoad
PortfolioSave
ScenarioLoad
ScenarioSave

Include a separate row for each right to be
assigned.

l Pools Rights

Resource Planning is an optional Accolade component that may not be used by your
company. The worksheet must be included in the spreadsheet file, but can be left blank
if you do not use Resource Planning.

Column
Name

Accepted Values on
Upload Additional Notes

User Login Valid Accolade
user login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Pool Name Valid resource pool
display name

Include a separate row for each pool.

Can be blank.

l Extended Fields

Column Name Accepted Values on
Upload Additional Notes

User Login Valid Accolade
user login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Extended
Field 1...10

Valid extended
field name

Enter ExtendedField_ and the field ID of the
field being updated.
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Column Name Accepted Values on
Upload Additional Notes

This entry, in combination with the data type
field in the next column, identify the field being
updated. For example, use the following
format: ExtendedField_1 or ExtendedField_
24.

Extended
Field Data
Type

Date
List
Long String
Multi-Select
Number
String

Enter the data type of the field being updated.

This entry, in combination with the Extended
Field value in the previous column, identify the
field being updated.

Value Valid extended
field value

For each extended field above, include the
value for that field to assign to each user.

For multi-select extended fields, separate
values using a pipe ( | ) character.

On import, if an extended field value is not
included in the sheet, the existing settings for
that user are preserved for that field. If a value
currently assigned to a user is not included in
the sheet, the value is removed from the user.

If an extended field that is defined as required
is not included or does not include a value, the
user is set to inactive.

l Access Groups

Column Name Accepted Values
on Upload Additional Notes

User Login Valid Accolade
user login

Used for matching for upload. Must match a
user login from the Import Users
worksheet.

If a user account exists, its settings are
changed with the values in the uploaded file.

Access Group Valid access
group system
name

Include a separate row for each access
group.

If users are assigned a root level or parent
access group, they will be automatically
assigned to the child groups of that access
group.
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Column Name Accepted Values
on Upload Additional Notes

Important! Access group
permissions are not always
additive to what is already defined
in the Accolade environment.
The Administrator doing the
import can only make changes to
access groups that they can
manage. With matching access,
the import will add or replace
access groups according to what
is specified in the file.

Do not leave the column blank
unless you intend to clear out the
settings for the specified user.

Access Yes, Y, True, 1,
X*

All other values are treated as No on upload.

Manage Team Yes, Y, True, 1,
X*

All other values are treated as No on upload.

Manage
Process

Yes, Y, True, 1,
X*

All other values are treated as No on upload.

Add Project Yes, Y, True, 1,
X*

All other values are treated as No on upload.

Migrate
Project

Yes, Y, True, 1,
X*

All other values are treated as No on upload.

Delete Project Yes, Y, True, 1,
X*

All other values are treated as No on upload.

Delete Activity Yes, Y, True, 1,
X*

All other values are treated as No on upload.

View
Configuration

Yes, Y, True, 1,
X*

All other values are treated as No on upload.

Edit
Configuration

Yes, Y, True, 1,
X*

All other values are treated as No on upload.
If Edit Configuration is selected as Yes,
View Configuration will automatically
default to Yes.

Member Of Yes, Y, True, 1,
X*

All other values are treated as No on upload.

MemberOf access does not
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Column Name Accepted Values
on Upload Additional Notes

propagate down to child groups.

Admin Of Yes, Y, True, 1,
X*

All other values are treated as No on upload.

AdminOf access does propagate
down to child groups.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

l Security Profiles

Security profiles are optional when importing user accounts. The worksheet must be
included in the spreadsheet file, but can be left blank if the users do not have security
profile assignments.

Column Name Accepted Values on
Upload Additional Notes

User Login Valid Accolade
user login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Security
Profile

Valid security
profile system
name

If system name is entered, then the value is
TRUE for that system name.

l User Links

Column
Name

Accepted Values on
Upload Additional Notes

User Login Valid Accolade user
login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Title Alphanumeric
characters,
underscore**

If blank, the link does not upload.
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Column
Name

Accepted Values on
Upload Additional Notes

Link http://
https://
ftp://
file://
qvp://
mailto:
callto:

If blank, the link does not upload.

URL Valid link URL If blank, the link does not upload.
Link
Number

Any number 1-5 If blank, the link does not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Email Notifications

Column Name Accepted Values on
Upload* Additional Notes

User Login Valid Accolade user
login

Used for matching for upload. Must match a
user login from the Import Users
worksheet.

If a user account exists, its settings are
changed with the values in the uploaded file.

Notification Valid email
notification option

See the Email
Notification
Distribution
Reference topic in
the online Help for
options.

Can be blank.

On Selected
Days

Yes, Y, True, 1, X* If YES is entered, select at least one of the
day options on the Email Days worksheet.
All other values are treated as No on upload.

Immediately Yes, Y, True, 1, X* All other values are treated as No on upload.
Notification
System
Name

Valid notification
system name

If blank, the notification does not upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.
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l Email Days

Column Name Accepted Values on
Upload* Additional Notes

User Login Valid Accolade
user login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Monday Yes, Y, True, 1, X* All other values are treated as No on upload.
Tuesday Yes, Y, True, 1, X* All other values are treated as No on upload.
Wednesday Yes, Y, True, 1, X* All other values are treated as No on upload.
Thursday Yes, Y, True, 1, X* All other values are treated as No on upload.
Friday Yes, Y, True, 1, X* All other values are treated as No on upload.
Saturday Yes, Y, True, 1, X* All other values are treated as No on upload.
Sunday Yes, Y, True, 1, X* All other values are treated as No on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

l Assignment Notifications

Column
Name

Accepted Values on
Upload* Additional Notes

User Login Valid Accolade
user login

Used for matching for upload. Must match a
user login from the Import Users worksheet.
If a user account exists, its settings are
changed with the values in the uploaded file.

Past Stages Yes, Y, True, 1, X* All other values are treated as No on upload.
Current
Stages

Yes, Y, True, 1, X* All other values are treated as No on upload.

Future
Stages

Yes, Y, True, 1, X* All other values are treated as No on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

Notes:
l Accolade Portfolio Optimizer is an optional Accolade component that you may
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not have access to. To implement this solution, contact Sopheon Customer
Support.

l Resource Planning is an optional Accolade component that you may not have
access to. To implement this solution, contact Sopheon Customer Support.

Deactivating and Removing User Accounts

As employees change roles or leave your company, you can choose to remove their Accolade
user all together, or disable their access by deactivating the user account.

l Deactivating User Accounts - Deactivating a user account removes the access for
that user, allowing Administrators to save the account information, but ensuring the user
cannot access Accolade. Reactivation reinstates assignments and email notification
settings as they were set prior to deactivation. Deactivate accounts for situations such
as a leave of absence, or a time period when an employee does not require Accolade
access. If you use Active Directory to maintain user information in Accolade, you can
disable users in Active Directory to deactivate them in Accolade; however, you cannot
reactivate an Accolade user account using Active Directory.

l Removing User Accounts - Removing a user account removes the user from any
default assignments within process models, and removes the user from any project
teams. However, the user is not removed as the owner of deliverable or activities in
either completed or currently in progress documents. Create reports identifying the
deleted user's assignments to identify what needs reassignment.

Removing a user does not delete the user name from the system. For historical record
and auditability purposes, projects and other areas of the system will still reference the
original user name even when that user is removed. To mask the user name, change
the user's name to a generic placeholder like Bob M######. A name with a strike-
through indicates a deleted user (i.e., Bob M######) throughout the system.

Removing a user deletes the following user data:

l User Image

l User Email

l Chat Address

l User extended field values

Additionally, when a user is deleted, the system maintains the state of the user account
at the time of deletion for historical and auditability purposes. For example, if a user is
active at the time of deletion, the user account will still be marked as active in the
database.
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To deactivate a user account:

1. From the Systemmenu, select Security & Groups > User Admin.

To filter the list of users, enter one or more search criteria to filter by name, login
name, email address, function, or extended field by selecting one or more of the
following options and clicking Search.More...
l Selecting a Function in the drop-down will display available users that are
assigned to the function.

l Select aGroup By option to arrange the user list by roles, functions,
resource pools, or access groups.

l ClickMore options check box displays or hides the additional filter options.
l In the Active/Inactive drop-down, select to filter users by active and inactive
status from the following options:

l Active Users Only - excludes inactive users.
l Show All Users - displays active and inactive users.
l Inactive Users - displays only users marked as inactive. Inactive
status is indicated with grey italics.

l In the Roles drop-down, select a specific role to apply to filter the user list.

2. In the Users list, select the user(s) to modify.

3. In theGeneral Details section, clear the Active check box to indicate the user is
deactivated.

4. Click Save to save your changes.

To remove a user account:

1. From the Systemmenu, select Security & Groups > User Admin.

To filter the list of users, enter one or more search criteria to filter by name, login
name, email address, function, or extended field by selecting one or more of the
following options and clicking Search.More...
l Selecting a Function in the drop-down will display available users that are
assigned to the function.

l Select aGroup By option to arrange the user list by roles, functions,
resource pools, or access groups.

l ClickMore options check box displays or hides the additional filter options.
l In the Active/Inactive drop-down, select to filter users by active and inactive
status from the following options:

l Active Users Only - excludes inactive users.
l Show All Users - displays active and inactive users.
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l Inactive Users - displays only users marked as inactive. Inactive
status is indicated with grey italics.

l In the Roles drop-down, select a specific role to apply to filter the user list.

2. In the Users list, select the user(s) to modify.

3. Click Delete User(s) and clickOK at the prompt.

Notes:
l Remove user accounts when employees are no longer with your company or if a
user withdraws consent in accordance with GDRP regulations. If you remove a
user, inform the Process Designers in your organization to update default
assignments on process models, as necessary. Understand that deleting a user
is a permanent action and cannot be restored. If a user might be reactivated in
the future, consider deactivating the user account instead of deleting it.

Locating Records of User Changes

You can find the history of changes to Accolade users in the history tables in the Accolade
database. Each separate change to a user record is identified by a HistoryID column in each
table.

The following tables record user history:

l HIS_Users - Records who made the change and when as well as user details such as
name, user login, email address, custom links, Home page assignment, Table Wizard
rights, and other details on the Details tab of the User page.

l HIS_UserRoles - Contains the list of roles assigned to each user.

This data is only available in database tables; therefore, a familiarity with SQL Server
Management Studio is necessary for accessing the data. Contact Sopheon Customer Support
for additional information.

Auditing System Access

Accolade maintains a record of every user attempt to log on to Accolade. Using the information
in the user access logs, Administrators can determine which users are actively accessing
Accolade and conduct general system security audits. The user access logs contain the
following information and are saved according to the Number of Days to Maintain User
Access Logs parameter setting:

l The date and time of the login attempt.

l TheWindows ID of the user logging in.

l Whether each login attempt was successful.

l The Accolade user name and system ID of the user who successfully logged in.
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l The IP address, the browser version, and operating system of the client machine.

l The client machine's language setting as accepted by the Accolade server.

To access the data about user log in history, design reports using the RV_UserAccessLog
and RV_UserAccessLastLogin reporting views. See Design Charts and Reports Overview.

SQL Query Examples

The following are example SQL queries that you can use to create reports regarding user
access to Accolade.

SQL query to gather all user access log information:

SELECT * FROMRV_UserAccessLog

This query generates an HTML report similar to the following:

SQL query to gather the date of last attempted log in for each user:

SELECT UserLogin as Login, LastLoginDate as "Login Date" FROMRV_
UserAccessLastLogin order by LastLoginDate desc

This query generates an HTML report similar to the following:

SQL query to gather the users that have not attempted access in 6 months or more:

SELECT Name, UserLogin as Login, LastLoginDate as "Login Date"
FROMRV_UserAccessLastLogin
WHERE (LastLoginDate IS NULL OR CONVERT(DATETIME, REPLACE
(SUBSTRING   

(LastLoginDate, 1, 10),' ','')) < dateadd(month,-6,GetDate())
 )
order by LastLoginDate desc
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This query generates an HTML report similar to the following:

User Attributes Overview
After creating a user account, administrators also assign each user a set of attributes that
defines the following:

l Active Status - Determines if the user account is active or deactivated.
l Default Language - Determines the language in which text within Accolade displays.
l Date Format - Determines the format, such as MM/dd/yyyy or dd/MM/yyyy in which
dates display and are entered in Accolade.

l User Roles - Determines the portions of the application the user can see and what
types of tasks he or she can complete in Accolade. The user role, like their login name
and email address, belongs to the user regardless of which projects or access groups
the user is assigned.

l Rights to Additional Accolade Features - Determines what permissions the user has
when using Accolade Office Extensions for creating reports and spreadsheets, and for
portfolio analysis using Accolade Portfolio Optimizer.

l Access Groups and Security Settings - Determines which projects, documents, and
process models the user can view and/or edit.

l Project Management Rights - For the Process Manager and Idea Manager roles,
determines the projects that the user has project management rights, such as the ability
to delete a project, based on access group.

l Email Notifications - Identifies which events generate and send an automated email
notification to the user.

l Links to Additional Sites and Content - Provides access to websites, FTP sites,
email, or local intranet sites through additional menu options. Links defined here are
user-specific. To define this type of link that is available for all users, or users assigned
a specific role, see "Adding Menu Items for Multiple Users (Global Links)" on page 386.

Individual users can modify and add some details within their user profile, such as email
notifications and subscribing to reports.

Important! Prior to assigning attributes to user accounts, ensure that your
company's access groups and security lists are defined.
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Note: You can also select multiple users and update them at once. To do this,
select one, and press and hold your Shift key to select multiple in a row, or
press and hold your Ctrl key and select multiple users from separate
locations on the list. Then, click on the View Details icon, and all attributes
related to the selected users will load.
If there is a tick in attribute check-boxes, all users share this attribute. If there
is a blue box in attribute check-boxes, one or more users share this attribute,
but not all. Updates done to any attributes here will apply to all users.
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Assigning General User Details

For each user account you create, assign general settings including whether the user account
is active, receives confirmation messages for successful actions within Accolade, expires after
a specific date, and the default display language and date format for the user.

Users can change settings for all general details except their user name, login, and active
status within their own user profile.

To assign general user settings:

1. From the Systemmenu, select Security & Groups > User Admin.

To filter the list of users, enter one or more search criteria to filter by name, login
name, email address, function, or extended field by selecting one or more of the
following options and clicking Search.More...
l Selecting a Function in the drop-down will display available users that are
assigned to the function.

l Select aGroup By option to arrange the user list by roles, functions,
resource pools, or access groups.

l ClickMore options check box displays or hides the additional filter options.
l In the Active/Inactive drop-down, select to filter users by active and inactive
status from the following options:

l Active Users Only - excludes inactive users.
l Show All Users - displays active and inactive users.
l Inactive Users - displays only users marked as inactive. Inactive
status is indicated with grey italics.

l In the Roles drop-down, select a specific role to apply to filter the user list.

2. In the Users list, click the name of the user to open the user details for editing .

3. Ensure theGeneral Details tab is selected and specify the following information for the
user:

Field Description

Language Select the language in which the application text
displays. The default language is English.

Date Format Select the display and entry format for dates.

The default date format is MMM dd, yyyy (Feb 28,
2016).

Expiration Date Enter the last date on which the user's account is
active.
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Field Description

After this date, the user's account is automatically
deactivated. Deactivated users are not removed from
Accolade; however, they do not have access to any
Accolade information.

For example, you may set an expiration date if you
require users to submit access requests on a yearly or
more frequent basis, or if a user only requires
temporary access to Accolade information.

Use a spreadsheet file to import the
expiration date for multiple users at once.

User Name Update the user's name as you want it to display in
Accolade.

(Optional) If the Enable User Profile Images system
parameter is enabled, add a user profile image that
displays with the user's name in various locations
within Accolade, click next to the user name, click
Choose Image, navigate to and select the image to
add, and click Upload File. To remove a profile image,
click the image next to the user name and click
Remove.

Note: To display as an image within
Accolade, an image file must be one of
the following file types: .bmp, .dib, .gif,
.jpg, .jpeg, .jpe, jfif, or .png.

Login Update the login the user uses to access Accolade.

Depending on how Accolade is installed, a user’s login
name could be the same as the login in their Windows
domain account, or local machine account. For
Windows Authentication, logins are <domain>\<login
name> where <domain> is the network domain and
<login name> is the login assigned to the user.

Note: You may consider keeping logins
consistent, such as first initial and last
name (jdoe) or first name.last name
(jane.doe).

Email Address (Optional) Enter the user's corporate email address.

Accolade uses this address for email notifications and
for email links throughout the system.
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Field Description

Chat Address (Optional) Enter the user's address for your company's
selected chat tool.

Resource Pool (Optional) Select the resource pool to which the user
belongs.

Users are grouped into resource pools for resource
planning purposes for assignments to projects.

Note: This field is only available if your
company uses the resource planning
components within Accolade and at
least one resource pool is defined.

Show confirmation
messages

Select this check box to enable or disable the display of
confirmation messages as the user successfully
completes actions within the system.

Disabling this option does not disable the display of
error messages.

Enable Auto Search
on Project Creation

Select this check box to enable or disable an automatic
search for projects with the same or similar names or
descriptions when creating new projects.

When enabled, Quick Search finds and displays
existing projects that match the new project name or
description. Use this feature to help discover if like-
projects exist so Process Managers do not duplicate
efforts when creating projects.

4. Select the Active check box to activate or deactivate the user.

5. Click Save to save your changes.

Notes:
l User details, such as name, login, email, and chat, show for each user when
editing multiple users.

Assigning User Roles and Rights

User roles determine the portions of the application the user can see and what types of tasks
the user can complete in Accolade. The user role belongs to the user regardless of which
projects or access groups the user is assigned.

Rights determine what permissions the user has when creating Accolade online reports or
reports with the Accolade Office Extensions add-in, and for portfolio analysis using Accolade
Portfolio Optimizer.
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Use a spreadsheet file to import or update the roles and rights for multiple
users at once.

To assign roles and rights to one or more users:

1. From the Systemmenu, select Security & Groups > User Admin.

To filter the list of users, enter one or more search criteria to filter by name, login
name, email address, function, or extended field by selecting one or more of the
following options and clicking Search.More...
l Selecting a Function in the drop-down will display available users that are
assigned to the function.

l Select aGroup By option to arrange the user list by roles, functions,
resource pools, or access groups.

l ClickMore options check box displays or hides the additional filter options.
l In the Active/Inactive drop-down, select to filter users by active and inactive
status from the following options:

l Active Users Only - excludes inactive users.
l Show All Users - displays active and inactive users.
l Inactive Users - displays only users marked as inactive. Inactive
status is indicated with grey italics.

l In the Roles drop-down, select a specific role to apply to filter the user list.

2. In the Users list, click the name of the user to open the user details for editing.

3. Select the Roles and Rights tab.

4. Select the check boxes next to the roles to assign.

5. In the Reporting Rights section, select the permissions to grant to this user when
creating and viewing reports containing Accolade data in the Accolade Office
Extensions add-in or Accolade online reports.

l None - The user cannot create or refresh reports created using the add-in or online
reports.

l Refresh Workbook Data - The user can refresh to view the most current data in
reports, but cannot create or modify the reports. This is the only option for users
assigned only the Read Only role.

l All Rights - The user has full permissions to create and refresh reports.

6. In the Portfolio Optimizer Rights section, select the permissions to grant to this user
in Portfolio Optimizer.More...

If a user has Load Portfolio rights, projects load as follows in Portfolio Optimizer:

l If a user has the Process Manager user role, all projects in access groups to which
they have Manage Process rights are loaded when they select to load a portfolio.
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They can choose to select the Include All Projects I Can Access option to load all
projects that they have security access to, which may include projects they do not
have Manage Process rights to.

l If a user does not have the Process Manager user role, or has the role without
Manage Process rights, they must select the Include All Projects I Can Access
option within Portfolio Optimizer when loading portfolio data. They can work with the
data within Portfolio Optimizer; however, they cannot commit changes to projects in
Accolade.

l If a Process Manager cannot load all the projects that have demand on a given
resource pool, demand data for that pool is incomplete, preventing resource
availability from being calculated accurately. To give managers complete demand
data in Portfolio Optimizer, you can allow them to load all the projects that have
demand on those pools using the check box and selecting all the pools. However,
allowing managers to load projects over which they do not have Manage Process
rights also enables them to reschedule resource demand and gate meeting dates in
those projects using Portfolio Optimizer.

Users must have Save Portfolio rights, the Process Manager user role, and Manage
Process rights in all projects that have changed to save changes made in Portfolio
Optimizer back to Accolade.

See the Portfolio Optimizer Online Help, available within the Portfolio Optimizer
application, for additional information.

7. In the Additional Rights section, select the Allow Updates from My Work page
option to allow the user to update multiple projects at once using the download and
upload feature for projects from the MyWork page.

This setting applies only to Project Managers, Idea Managers, and Project Team
Members.

8. Click Save to save your changes.

Notes:
l Accolade Portfolio Management and Portfolio Optimization are optional
Accolade components that you may not have access to. To implement these
solutions, contact Sopheon Customer Support.

User Roles Reference

A user role is an attribute assigned within a user account that determines what pages the user
can see and what tasks the user can complete within Accolade. A user role determines:

l The default Home page displayed when first entering Accolade. The default home
pages listed in the descriptions below are the Home pages that display if only that role is
assigned. Administrators and Process Designers have the ability to set different home
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pages for different user roles using Global Links.

l The menus available in the menu bar.

l Tasks the user can complete.

Note: Role names within Accolade are configurable. The roles referred to
throughout this documentation use the default role names provided in
Accolade.

A user role does not determine which projects and documents users can see. That visibility
depends on the user’s place in the access groups hierarchy and on the user’s security profile,
if any.

Process Execution Roles

Several different types of managers have control over various objects such as projects, project
gates, and reference tables, while other roles are necessary to participate in projects. Process
execution roles include:

Role Description

Document Reviewer * Document Reviewers review and edit deliverable documents
through a structured process defined in a workflow. This role
is required to assign someone as an action owner in a
workflow process. This role is typically combined with other
roles to allow users to review documents in addition to their
other tasks.

Document Reviewers can:
l Be assigned to an action in a workflow.
l Complete an action in a workflow.
l Enter decisions in the details of a deliverable's workflow.
Access groups control a Document Reviewer's access to
deliverables.

The Document Reviewer role exists only if your company has
purchased the Collaborative Workflow features.

Default Home Page: All My Work
Executive Executives monitor projects and serve as gatekeepers at

gate meetings, and are typically upper-level management
employees. Executives are people in the organization that
make Go or No Go decisions throughout the Phase Gate
process.

Executives can:
l Be assigned as a gatekeeper on a project.
l View dates for upcoming gate meetings and view project
information through Upcoming Gates.

81



Chapter 1  Managing Access to Accolade

Administrator's Guide

Role Description

l Search for and view published documents.
l Use discussions and email to communicate with other
gatekeepers on a project.

l View summaries and comparisons of project information
using charts and reports.

Executives cannot modify data in the system unless they are
assigned a role that allows them to do so.

Default Home Page: Charts & Reports
Gate Manager Gate Managers oversee gate details and the creation and

completion of gate documents. A user with the Gate Manager
role receives the management rights over the data in a
specific gate when assigned as the gate owner of that gate.

Gate Managers can:
l Be assigned as gate owners.
l Manage gate details, upload gate documents, and change
gatekeepers on gates they own.

Default Home Page: Upcoming Gates
Idea Manager * Idea Managers filter submitted ideas and guide idea projects

through the evaluation process. Idea Managers throughout
your company may have different responsibilities depending
on their management rights.

Idea Managers with sufficient rights can:
l Review new ideas and either begin work on the project,
migrate, close, or delete the idea project.

l Request that the idea submitter resubmit the idea, if
necessary, and cancel resubmissions.

l Update idea project details such as project name, project
manager, and description.

l Upload versions of unowned deliverables, activities, and
gate documents.

l Delete deliverables and activities that do not apply.
l Update gate meeting details, change a gatekeeper for a
gate meeting, enter gate meeting decisions, and upload
gate documents for gates with no owner.

l Act as the project manager or gate owner when an idea
project or gate has no assigned owner.

The Idea Manager role exists only if your company has
purchased the Idea Submission or Accolade Idea Lab.

Default Home Page: All My Work
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Role Description

Process Manager Process Managers guide projects through the Phase Gate
process from project creation to staffing to deleting the
project when it is complete. Process Managers throughout
your company may have different responsibilities depending
on their management rights.

Process Managers with sufficient management rights can:
l Create, edit, migrate, close, and delete projects.
l Add and remove teammembers, including the project
manager.

l Update project details such as project name, description,
and group.

l Upload versions of unowned deliverables, activities, and
gate documents.

l Delete activities that do not apply.
l Enter project status.
l Set gate dates, enter gate meeting decision, and change a
gatekeeper for a gate meeting.

l Act as the project manager or gate owner when a project
or gate has no assigned owner.

Default Home Page: Upcoming Gates
Project Manager Project Managers oversee the completion of one or more

projects. Process Managers assign Project Managers to
projects when the project is created. Users assigned the
Project Manager role can be assigned as a Project Manager
to a project.

When assigned to a project, Project Managers can do the
following within that project:
l Add teammembers (if the Project Manager has Manage
Team rights)

l Assign ownership of deliverables and activities.
l Upload versions of unowned deliverables and activities.
l Change the project name, description, and enter project
status and metrics.

l Maintain related documents.
l Request resources.
Project managers cannot:
l Change the project manager or gate owners.
l Enter gate details and results.
l Create, close, or delete projects.
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Role Description

Some members of a project teammay have both the Project
TeamMember and Project Manager roles. However, if they
are added to the project as a Project TeamMember, they
only have TeamMember rights in that project.

Default Home Page: All My Work
Project Team
Member

Project TeamMembers research and complete work on one
more assigned projects.

TeamMembers can:
l Locate projects and assignments through All My Work.
l View project information and communicate with other
project members through the project pages.

l Create and publish deliverable and activity versions for
documents they own.

l Assign activities for deliverables that they own to other
members of the team.

l Add related documents to the project.
l Refresh charts and reports based on assigned rights.
l View any project that is visible to them or to which they are
assigned using Search.

Default Home Page: All My Work

* These roles are available with purchase of their respective features.

Reduced Access Roles

Assign reduced access roles to users that need only visibility or limited rights to edit into one or
more projects within your organization. Reduced access roles include:

Role Description

Restricted Team
Member

Restricted TeamMembers work on deliverables or activities
in projects. They are not able to see any project information
other than the deliverables and activities they own, nor do
they have permission to use reporting mechanisms. Assign
this role to consultants or other outside experts (either outside
the company or outside the project team) to produce a
deliverable in a project without being given access to any
other project information.

Restricted TeamMembers can:
l Locate and edit deliverables and activities assigned to
them through All My Work.

l Create and publish deliverable and activity versions for
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Role Description

documents they own.
l Enter time on timesheets if the company has purchased
Time Tracking features. Restricted TeamMembers can
only enter time on projects that contain the activities and
deliverables they own.

Default Home Page: All My Work
Read Only The Read Only role provides access for company staff who

need to search for documents and information throughout the
company, but do not have a need to update information.

Read Only users can:
l Browse, search for and view existing projects, activities,
deliverables and published documents to which they have
access group or security list access.

l View charts and reports.
This role does not have any editing or reporting functions, and
is restricted from adding or editing projects, related data and
documents, creating or printing reports, or viewing
dashboards.

Important! If a user who was previously not set to
Read Only is assigned as the owner of any
deliverables or activities, removing their other
assigned roles and assigning them the Read Only
role does not remove their access from the project
or the ability to update project information by
uploading new versions of the assigned
documents. To ensure a user is truly Read Only,
the assigned Project Manager must remove the
user as the document owner from any assigned
documents in the project.

Default Home Page: Search

Administrative Roles

Assign administrative roles to users that configure security, define how Accolade is configured,
and design and maintain the development process for your company. Depending on your
organization, you may have one or more people in these roles. In order to assign a user to an
Administrative role, you must have Admin Of the root access group. Administrative roles
include:
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Role Description

Administrator Administrators maintains Accolade users, access groups,
templates, and configuration. Process Designers throughout
your company may have different configuration rights.

Administrators with sufficient rights can:
l Create, modify, deactivate, and remove Accolade user
accounts.

l Create, modify, and delete access groups.
l Create queries, charts, reports, classes, link types,
spreadsheet workbooks, reference tables, global links,
workflows, quick grids, functional areas, functions, and
configure Accolade parameters.

l Create resource pools and assign resource pool owners.
l Edit existing metric definitions.
l Download, edit, delete, and add templates to the Template
Library, when combined with the Template Access user
role.

Administrators cannot access projects unless they are
assigned a role that allows them to do so. In order to be
assigned Admin Of an access group, you must have the
Administrator role. See "Granting Access Group Permissions
to Users" on page 91

Default Home Page: User Administration
Process Designer Process Designers manage the overall Phase Gate process

of a company or division. Process Designers throughout your
company may have different configuration rights.

Process Designers with sufficient rights can:
l Create, modify, and delete models and migration maps.
l Create, modify, and delete reference tables.
l Create, modify, download, and delete templates in the
Template Library, when combined with the Template
Access user role.

l Create queries, charts, reports, metrics, classes, link
types, spreadsheet workbooks, reference tables, global
links, workflows, quick grids, functional areas, functions,
and configure Accolade parameters.

Process Designers cannot access projects unless they are
assigned a role that allows them to do so. See "Granting
Access Group Permissions to Users" on page 91.

Default Home Page:Models
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Reference Table
Manager

Reference Table Managers update reference table values
using new versions of existing reference tables that they own.
This role is assigned with other user roles.

Reference Table Managers can:
l Upload a new version of a reference table that they own.
l Modify reference table details in tables that they own.
Only Administrators and Process Designers can create and
upload new reference tables. Users assigned the Reference
Table Manager user role can be assigned as the table's
owner and can update new versions of the tables they own.

Default Home Page: Reference Tables
Project Importer Project Importers import data into Accolade from external

files. Project Importers can import multiple projects, project
links, matrices and related documents. Paired with the
Process Designer role, the Project Importer can also import
resource data including demands, pools, curves, and others.

A user who imports projects may also need the Reference
Table Manager role to edit the reference tables used in the
import, and the Process Manager role, to confirm the results
of the import.

Default Home Page: Imports
Service Account The Service Account role is not intended for assignment to an

actual Accolade user. Assign this role to the user account for
the Accolade Autoloader Service, which uploads reference
tables and related documents automatically from a
designated drop box at a scheduled time. If Accolade is
configured with Windows Authentication, this user account
must also be a user account on the domain, although it does
not have to be the account of an actual person.

To ensure that reference tables assigned to a specific access
group are uploaded successfully when enabled for automatic
upload, assign the user with the System Service user role
access to all access groups defined in the system. See
"Granting Access Group Permissions to Users" on page 91.

Data Analyst The Data Analyst own the creation and maintenance of API
keys that can access Accolade data to be used for queries
and reporting.

IT Manager The IT Manager has access to Advanced Administration. This
role is generally given to IT or Administrative roles within a
company.
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Planner Roles

Assign one or more planner roles to update objects and views within Innovation Planning.
These roles exist only if your company has purchased the Innovation Planning features. Plan-
ner roles include:

Role Description

Planner * Planners develop and maintain innovation plans in Accolade
Innovation Planning. Users with the Planner role can see the
Planningmenu and access the Innovation Planning
application.

The Planner role can be assigned with the Process Manager
role to allow Planners to create planning elements. In
addition, a Planner can also be a Project TeamMember to
allow assignment to planning element teams, and the
Process Manager role that grants administrative privileges
based on assigned management rights.

A Planner's additional rights within Innovation Planning are
defined through Accolade security lists and access group
rights.

If your company does not run Innovation Planning, but uses
Accolade's integration with Microsoft Project, assign this role
to users for access to the My Project Gantt view.

Default Home Page: Planning Board
Planning View
Designer *

Planning View Designers can share the planning views they
create with other Planners by making the views public, and
they can also update the settings in other public views to
which they have access.

Planning View Designers must also have the Planner role to
access the Planningmenu, and cannot change values within
planning elements in a view unless they have the other user
roles that allows them to do so.

* These roles are available with purchase of their respective features.

Resource Planning Roles

Assign one or more resource planning roles to users that manage resource capacity and
demand within your company. Combine these roles with other roles if a user has more than
one role within your company. These roles exist only if your company has purchased the
Resource Planning features. Resource planning roles include:

88

POPUP_ManagementRights.htm
PROC_ViewingProjectsInGanttViews.htm


Administrator's Guide

Sopheon Accolade Version 16.2

Role Description

Resource Planner * Resource Planners maintain resource capacity levels for
resources (both employee and material) throughout the
company, and plan and assign the resources, personnel and
material, that each project needs. They adjust resource
assignments from stage to stage and balance resource
requests against resource availability.

Resource Planners can:
l Enter resource demands for projects.
l Apply demand curves to projects.
l Add resources to an individual project and modify
resource demand.

l Adjust demand values in demand curves for resources in
pools they own on the Demand Curve page.

l Transfer a resource from pools they own pool to a different
pool on the Edit Resource page.

Default Home Page: Resource Planning
Resource Pool
Administrator *

Resource Pool Administrators create and maintain resource
pools. Resource pools group your resources by geographical
region, job function, or any other grouping that fits into your
organization.

Resource Pool Administrators can:
l Create resource pools, add or remove members from a
pool, and delete pools.

l Assign pool owners.
l Link pools together.
l Create and edit demand curves.
Default Home Page: Pools

* These roles are available with purchase of their respective features.

Time Tracking Roles

Assign time tracking roles to users participating in projects and managers needing to approve
project time entries. These roles exist only if your company has purchased the Time Tracking
feature. Time tracking roles include:

89



Chapter 1  Managing Access to Accolade

Administrator's Guide

Role Description

Timesheet User * Timesheet Users can access timesheets, which is where
users can track their time against various projects within
Accolade. This role can be the only role available to users
who are required to log their time, but do not require access to
additional information within Accolade.

The Time Sheet Approver role exists only if your company
has purchased the Time Tracking features.

Default Home Page: Timesheet Entry
Timesheet Approver
*

Timesheet Approvers can access the Timesheet Approval
page, where they can review timesheets for all employees
who report to them. This role can be the only role assigned to
users who are required to approve time worked, but do not
require access to additional information within Accolade, or
combined with any other role. Users with the Timesheet
Approver role can be assigned as the timesheet approver for
a resource pool. If combined with the Resource Pool
Administrator user role, the timesheet approver can define
and configure resource pools for time tracking purposes.

Note: Project Managers have access to approve
time for projects they manage, without
having the Timesheet Approver role.

Default Home Page: Timesheet Approval

* These roles are available with purchase of their respective features.

General Roles

Assign general roles to enhance the ability of other user roles within Accolade. For example,
allow managers to delegate responsibilities when they are on leave, or give the template
access role to users configuring or designing processes to easily add or update templates.
General roles include:

Role Description

Template Access Template Access users can access the Template Library,
which is where templates for documents created in your
company are stored. This role is combined with other user
roles, and the role combination determines what type of
access the user has:
l Administrators and Process Designers with this role can
view existing templates and add templates to the library. In
addition, Administrators and Process Designers can
create and modify Quick Grid andWorkflow templates.
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l Process Managers, Idea Managers, Project Managers,
and Project TeamMembers with this role can view
templates that are labeled asOther. These are typically
templates that are not formatted or populated with any
data types.

Default Home Page: N/A
Can Delegate
Assignments

Users with this role are able to delegate their assignments to
another user for a specific time period; for example, while
they are out of the office. Delegating assignments helps to
ensure that project work, including workflows, continues while
a teammember is unavailable.

This role does not determine who is available to delegate
assignments to. Assignments can be delegated to any user
with the Project Manager, Idea Manager, Project Team
Member, or Document Reviewer role.

Default Home Page: N/A

Granting Access Group Permissions to Users

An access group is a container of projects, users, reference tables, and/or planning elements
(in Accolade Innovation Planning) that enforces information security. Access groups restrict
which process models, projects, reference tables, or planning elements users can see or find
using search. See "Designing the Access Group Hierarchy" on page 25 for more information
about planning the access groups for your company.

Assign each user account within your system to one or more access groups to grant access to
the data available within that group.

Note: Selecting the top-level access group (i.e. Root) grants permission to all
access groups in the tree. Additionally, selecting a parent within the tree
structure grants permissions to all access groups within that tree.

To assign permissions to an access group:

1. From the Systemmenu, select Security & Groups > User Admin.

To filter the list of users, enter one or more search criteria to filter by name, login
name, email address, function, or extended field by selecting one or more of the
following options and clicking Search.More...
l Selecting a Function in the drop-down will display available users that are
assigned to the function.

l Select aGroup By option to arrange the user list by roles, functions,
resource pools, or access groups.
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l ClickMore options check box displays or hides the additional filter options.
l In the Active/Inactive drop-down, select to filter users by active and inactive
status from the following options:

l Active Users Only - excludes inactive users.
l Show All Users - displays active and inactive users.
l Inactive Users - displays only users marked as inactive. Inactive
status is indicated with grey italics.

l In the Roles drop-down, select a specific role to apply to filter the user list.

2. In the Users list, click the name of the user to open the user details for editing.

3. Click the Access Groups tab.

The access groups display in the tree on the left. Use the check boxes to grant the user
certain permissions within selected access groups.

Note: Selecting a parent access group in the tree structure automatically includes
the child access groups, except for the Member Of column.

4. Define user admin rights for users with the Administrator role:

User Admin Right Description

Member Of When checked, the user becomes a member of that
particular access group.

Users must be aMember Of at least one
access group.

Admin Of Only enabled if the user has the Administrator role
checked on the Roles and Rights tab.

Administrators are granted create/edit ability only within
the access groups for which they have Admin Of
checked. All other rows will be disabled.

Users with the Administrator role must be the Admin Of
at least 1 Access Group. Only a root level administrator
can grant a user Admin Of rights if they are not already
an Administrator (roles and rights).

If multiple users are selected and the editor does not
select Admin Of for ALL users, they will appear to be
read only.

5. Check the access group that the user belongs to for project access in the Access
column.

6. Define project management rights for users with the Process Manager, Project
Manager or Idea Manager user roles:
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l The Project Manager role will be disabled if the user being edited has Manage Team
checked in their Access Groups tab.

l The Process Manager and Idea Manager roles will be disabled if the user being
edited has any of the following components checked in their Access Groups tab
outside of the editors Admin Of groups.

l Manage Team

l Manage Process

l Migrate Project

l Add Project

l Delete Project

l Delete Activity

l Only Administrators at the highest level of the Access Group hierarchy (Root) can
Create/Edit/Remove the following roles on the Roles and Rights tab:

l Administrator

l Process Designer

l Service Account

Note: When creating a new user through Copy From, the same access group
logic applies. Access group permissions will apply based on the
administration permissions of the user creating the user profile.
Administrator, Process Designer, and Service Account roles will not be
copied over unless the editor is a root level Administrator.

Management Right Description

Manage Team The ability to edit the members of a team. Your
company may have highly sensitive data and projects
that require restriction around who can be assigned to
the project. Use this option to define which Project
Managers and Process Managers within your
organization have the ability to add teammembers to
their projects and change project team leaders.

For example, if you are developing products in other
countries, or developing products or services that
require specific security clearance, it becomes
increasingly important to manage the team based on
location or specific security credentials. You want to
ensure that once a team is set for the product, team
members who do not meet the criteria for working on the
project are not added.

l Users with the Project Manager user role do not
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Management Right Description

require Manage Team rights at the access group
level to manage a team:

l Use the Project Manager can manage team
option when assigning a Project Manager to
indicate that the user assigned as the Project
Manager can add, remove, or replace members
on the project's team. If a Project Manager user
does have Manage Team rights at the access
group level, you can override their Manage
Team rights for a single project on project
creation, migration, import, and when changing
the Project Manager on the team.

l Users with a Process Designer role can only
select a class for the model that is within the same
Access Group branch.

Manage Process The ability to assign gate owners and project managers,
add teammembers to upload documents without a
document owner and to enter metric values. As a best
practice, only one user should have Manage Process
rights for a project. Keeping Manage Process rights
separate helps to prevent accidentally overwriting
another user's changes.

Add The ability to add a new project using an existing class
and model.

Migrate The ability to migrate or copy a project to a different
process model.

Delete The ability to delete a closed project from the system.
Delete Activity The ability to delete activities that do not apply from

within projects.

7. Define configuration permissions for users with the Administrator or Process Designer
user role:

Configuration Rights Description

Edit The ability to edit configuration components. Your
organization may be structured to have multiple
Administrators or Process Designers in different
branches. Restrict users to edit only the configuration
components relevant to their branch of the organization.

View is automatically checked when Edit is
selected.
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Configuration Rights Description

View The ability to view configuration components. Your
organization may be structured to have multiple
Administrators or Process Designers in different
branches. When you grant users View access only,
configuration components such as process models,
gate documents, and deliverables and activities will
display as read-only.

8. (Optional) Define the Security permissions via the Security Lists or Security Profiles
tabs.

l Security Lists provide a regional list.

l Security Profiles provide a list of access for Class and Metrics to choose from for a
user account.

9. Click Save to save your changes.

Adding User-Specific Menu Items

User links provide access to websites, FTP sites, email, local intranet sites, or files available
on your network through an additional Accolade menu available to individual users.
Administrators can define up to five links for each user.

To define a link that is available for all users, or users assigned a specific
role, see "Adding Menu Items for Multiple Users (Global Links)" on page
386.

User-specific links display under theMy Linksmenu, which is only available if the user
account has a user-specific link defined, or if a global link is defined to display in that menu.

To create a user link for one or more users:

1. From the Systemmenu, select Security & Groups > User Admin.

To filter the list of users, enter one or more search criteria to filter by name, login
name, email address, function, or extended field by selecting one or more of the
following options and clicking Search.More...
l Selecting a Function in the drop-down will display available users that are
assigned to the function.

l Select aGroup By option to arrange the user list by roles, functions,
resource pools, or access groups.

l ClickMore options check box displays or hides the additional filter options.
l In the Active/Inactive drop-down, select to filter users by active and inactive
status from the following options:

l Active Users Only - excludes inactive users.
l Show All Users - displays active and inactive users.
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l Inactive Users - displays only users marked as inactive. Inactive
status is indicated with grey italics.

l In the Roles drop-down, select a specific role to apply to filter the user list.

2. In the Users list, click the name of the user to open the user details for editing.

3. Select the User Links tab.

4. In the Title field, click None and enter the name of the link, up to 64 characters in length,
as you want it to display.

5. In the Link field, select the link type to create:
l http or https - A URL to a Web page or secure Web page. The Disable Link to
Website system parameter settings determines if you can link to Web page.

l ftp - A link to an FTP download site.

l file - A link to a file or executable on your company's intranet. The Disable Link to
File system parameter setting determines if you can link to a file.

l qvp - A link to a Qlik application file. The Disable Link to File system parameter
setting determines if you can link to a file.

l mailto - Opens the user's email application and displays a blank email addressed to
this email address.

l callto - Opens your selected chat and collaboration tool, which invites the person at
the address you define to a chat.

6. Is the adjacent field, enter the path to complete the link address.

For example, if you select http:// from the Link field, enter the remainder of the web site
address, www.google.com.

7. Click Save to save your changes.

Notes:
l To delete a user-specific link, clear the information entered in all the fields for the
link and click Save.

Assigning Custom Details to Users

If extended fields are set as active for users, an Extended Fields section displays for each
user record defined within Accolade. Use these fields to assign custom details, such as
department information, to each user. How extended fields are used, and whether they are
required for users, is specific to your company.

The Extended Fields section is disabled if multiple users are selected to
modify. To assign extended fields to multiple users at once, use a
spreadsheet file to import the extended field settings.
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To assign an extended field values to a user:

1. From the Systemmenu, select Security & Groups > User Admin.

To filter the list of users, enter one or more search criteria to filter by name, login
name, email address, function, or extended field by selecting one or more of the
following options and clicking Search.More...
l Selecting a Function in the drop-down will display available users that are
assigned to the function.

l Select aGroup By option to arrange the user list by roles, functions,
resource pools, or access groups.

l ClickMore options check box displays or hides the additional filter options.
l In the Active/Inactive drop-down, select to filter users by active and inactive
status from the following options:

l Active Users Only - excludes inactive users.
l Show All Users - displays active and inactive users.
l Inactive Users - displays only users marked as inactive. Inactive
status is indicated with grey italics.

l In the Roles drop-down, select a specific role to apply to filter the user list.

2. In the Users list, click the name of the user to open the user details for editing .

3. Select the Extended Fields tab.

4. Enter the custom information as needed for each user.

5. Click Save to save your changes.

Notes:
l Use the User Details column set in the Users subject within Accolade Office
Extensions and Accolade Online Reporting to report on extended fields assigned
to users.
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Setting User Email Notifications for System Events

You can configure most users to receive an email notification when Accolade events occur,
such as activity and deliverable deadlines. Email notifications about system events allow users
to receive notification of changes in the system or upcoming events, without having to login to
Accolade to check the status of their projects. You can select to notify users about events
immediately or on specific days each week.

Notifications are not distributed to all users. See "Email Notification Distribution Reference" on
page 99.

To set email notifications for one or more user:

1. From the Systemmenu, select Security & Groups > User Admin.

To filter the list of users, enter one or more search criteria to filter by name, login
name, email address, function, or extended field by selecting one or more of the
following options and clicking Search.More...
l Selecting a Function in the drop-down will display available users that are
assigned to the function.

l Select aGroup By option to arrange the user list by roles, functions,
resource pools, or access groups.

l ClickMore options check box displays or hides the additional filter options.
l In the Active/Inactive drop-down, select to filter users by active and inactive
status from the following options:

l Active Users Only - excludes inactive users.
l Show All Users - displays active and inactive users.
l Inactive Users - displays only users marked as inactive. Inactive
status is indicated with grey italics.

l In the Roles drop-down, select a specific role to apply to filter the user list.

2. In the Users list, click the name of the user to open the user details for editing .

3. Select the Email Notifications tab.

4. Select when to send emails to the users:

l To provide the users with scheduled emails - Select one or more days of the
week in the Send me emails every row and one or more events in theOn Selected
Days column. Emails are sent at midnight before the selected days and include a
report about the selected events. You must select at least one day of the week and at
least one event in theOn Selected Days column for the report to send.

l To provide the users with immediate notifications - Select one or more check
boxes in the Immediately column.

It is possible to send both an immediate notification and a scheduled notification about
the same event.
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If you are modifying settings for multiple users, some settings may be
different for different users in the group. Check boxes with different
values display with a blue filled in center . Click the check box once to
clear it for all users and a second time to select it for all users.

5. To limit the stages for which assignment notifications are sent, select one or more stage
selections in the Send notifications for assignments in options.

For example, if your deliverable and activity owners only want to receive notifications for
their assignments in the current stage of a project, select Current Stage and ensure
the Past Stages and Future Stages options are cleared.

6. At the bottom of the event list, select whether to send emails in either plain text or HTML
format.

7. Click Save to save your changes.

Notes:
l The Number of days before...is due events occur at midnight before the
relevant day, and any immediate notifications for them are sent out then. The
events for the late notifications, such as Deliverable is late, occur at midnight
after the relevant day, and any “immediate” notifications are sent out then.

l Set users with the Document Reviewer user role to receive a notification that a
deliverable is ready for their review, as that notification alerts them that their
workflow action has started.

l Emails to users set as Restricted TeamMembers do not contain any project links
that emails to other roles or assignments because of a Restricted Team
Member's limited navigation ability within Accolade.

Email Notification Distribution Reference

The following table shows which assignment types and roles receive notifications for Accolade
events that generate an automated email. To receive a notification, you must be subscribed to
an event.

In general, notifications about events are sent to members of the project in which the event
occurred. However, the "Project created" notification is sent to all users who can see the
project. Process Managers and Process Designers receive emails regarding all projects within
their access group visibility.

Accolade Event Email Recipients

Days Before Defined Date

# days before activity deadline Activity Owner, Deliverable Owner

99



Chapter 1  Managing Access to Accolade

Administrator's Guide

Accolade Event Email Recipients

# days before activity dependent finish
date

Activity Owner, Deliverable Owner

# days before activity dependent start
date

Activity Owner, Deliverable Owner

# days before activity finish date Activity Owner, Deliverable Owner

# days before deliverable deadline Deliverable Owner, Project Manager

# days before deliverable dependent fin-
ish date

Deliverable Owner, Project Manager

# days before deliverable dependent start
date

Deliverable Owner, Project Manager

# days before deliverable finish date Deliverable Owner, Project Manager

# days before MS Project task deadline MS Project Task Owner

Activity Events

Activity deadline changes Activity Owner, Deliverable Owner

Activity finish date changes Activity Owner, Deliverable Owner

Activity finish date is past the gate date Activity Owner, Project Manager

Activity is completed Deliverable Owner

Activity is in trouble Deliverable Owner

Activity is late Activity Owner, Deliverable Owner

Activity is ready to finish Activity Owner

Activity is ready to start Activity Owner

Activity is past finish date Activity Owner, Deliverable Owner

Activity is ready for your review Document Reviewer

Activity is approved by a reviewer Activity Owner, Deliverable Owner, Project
Manager

Activity is rejected by a reviewer Activity Owner, Deliverable Owner, Project
Manager

Activity review is declined by a reviewer Activity Owner, Deliverable Owner, Project
Manager

Another reviewer creates a new activity
version

Reviewers assigned to the workflow step
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Activity review is late Activity Owner, Deliverable Owner, Project
Manager, Reviewer

Activity owner changes New Activity Owner, Deliverable Owner

Deliverable Events

Deliverable deadline changes Deliverable Owner, Project Manager

Deliverable finish date changes Deliverable Owner, Project Manager

Deliverable finish date is past the gate
date

Deliverable Owner, Project Manager

Deliverable is completed Project Manager

Deliverable is in trouble Project Manager

Deliverable is late Deliverable Owner, Project Manager

Deliverable is ready to finish Deliverable Owner

Deliverable is ready to start Deliverable Owner

Deliverable is past finish date Deliverable Owner, Project Manager

Deliverable is ready for your review Document Reviewer

Deliverable is approved by a review Deliverable Owner, Project Manager

Deliverable is rejected by reviewer Deliverable Owner, Project Manager

Deliverable review is declined by a
reviewer

Deliverable Owner, Project Manager

Another reviewer creates a new deliv-
erable version

Reviewers assigned to the workflow step

Deliverable review is late Deliverable Owner, Project Manager,
Reviewer

Deliverable owner changes New Deliverable Owner, Project Manager

Gate and Gate Decision Events

All deliverables are ready for gate meeting Gatekeepers for the gate, Gate Owners,
Project Manager, Process Managers.

Gate changes Gatekeeper, Gate Owner, Project Manager

Gate decision awaits approval Gatekeeper, Gate Owner, Project Manager

Gate decision occurs Project Gatekeepers, Gate Owner, Idea
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Submitter, Project Manager, Idea Manager,
and TeamMembers assigned to the pro-
ject,

Gate decision has been approved Gatekeeper, Gate Owner, Project Manager

Gate decision has been rejected Gatekeeper, Gate Owner, Project Manager

Gate owner changes New Gate Owner, Project Gate Owners,
current Project Gatekeepers, Project Man-
ager, Idea Manager, and TeamMembers
assigned to the project

Gatekeeper approves a decision Gatekeeper, Gate Owner, Project Manager

Gatekeeper rejects a decision Gatekeeper, Gate Owner, Project Manager

Gatekeeper decision has been skipped Gatekeeper that was skipped, Gate Owner,
Project Manager

Gatekeeper changes New Gatekeeper, Project Gatekeepers,
Gatekeeper, Project Manager, Idea Man-
ager, and TeamMembers assigned to the
project

Project Status Events

Project is created Any Executive, Gate Owner (of first gate),
Idea Manager, Project Manager, Process
Manager, Resource Planner, and Team
Members who can see the project

Project is created through copy or migra-
tion

Any Executive, Gate Owner (of first gate),
Idea Manager, Project Manager, Process
Manager, Resource Planner, and Team
Members who can see the project.

Project Manager Changes New Project Manager, Project Gate-
keepers, Gate Owner, Process Manager,
Project Manager, Idea Manager, and Team
Members assigned to the project

Project status report is added to one of my
projects

Project Gatekeepers, Process Managers,
Project Manager, Idea Manager, and Team
Members assigned to the project

Project status report is added to any pro-
ject

All Executives, Idea Managers, Project
Managers, Process Managers, and Team
Members and who can see the project
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Project discussion is started or a com-
ment added

TeamMembers, Project Manager, Idea
Managers assigned to the project

One of my projects is in trouble Project Gatekeepers, Gate Owners, Pro-
cess Managers, Project Manager, Idea
Manager, and TeamMembers assigned to
the project

Any project is in trouble All Executives, Idea Managers, Project
Managers, TeamMembers, and Process
Managers who can see the project

Team Member Events

Teammember is added TeamMembers, Project Manager, Idea
Managers assigned to the project

Teammember is removed TeamMembers, Project Manager, Idea
Managers assigned to the project

Workflow Events

Workflow is canceled for an activity Activity Owner, Deliverable Owner, Project
Manager, Reviewer

Workflow is complete and activity is
approved

Activity Owner, Deliverable Owner, Project
Manager

Workflow is complete and activity is rejec-
ted

Activity Owner, Deliverable Owner, Project
Manager

Workflow is canceled for a deliverable Deliverable Owner, Project Manager,
Reviewer

Workflow is complete and deliverable is
approved

Deliverable Owner, Project Manager

Workflow is completed and deliverable is
rejected

Deliverable Owner, Project Manager

MS Project Events

MS Project task deadline changes MS Project Task Owner

MS Project task is completed MS Project Task Owner, Project Manager

MS Project task is in trouble MS Project Task Owner, Project Manager

MS Project task is late MS Project Task Owner, Project Manager
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MS Project task owner changes NewMS Project Task Owner

Resource Demand Events

A resource is assigned to a project I own Project Manager

An assigned resource is removed from a
project I own

Project Manager

A requested resource is removed from a
project I own

Project Manager

I am assigned as a resource demand User resource

I am removed as a resource demand User resource

A resource is requested Resource Pool Owner

A resource request is removed Resource Pool Owner

Resource demands change for a pool I
own

Resource Pool Owner

Reporting Events

Report scheduled to export fails Report Owner

Notes:
l Idea Submitters can subscribe to Gate Decision Occurs events by selecting the
Notify Me check box when submitting an idea.

l HTML reports are sent to users subscribed to the report

Synchronizing Users with Active Directory Overview

Note: The information in this section assumes that you have a working knowledge
of Active Directory and how it is setup and defined at your company.

If your company uses Microsoft's Active Directory for user authentication and administration,
you can synchronize the user accounts defined in Accolade to those defined in your Active
Directory server. Synchronizing the user data between your Active Directory and Accolade
allows you to maintain user data such as email addresses and user names in the Active
Directory without having to maintain the information in multiple locations. If you disable users in
the Active Directory those users are deactivated within Accolade when the synchronization
runs. However, you cannot activate users in Accolade using Active Directory.
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Synchronize additional data from your Active Directory users to user
accounts in Accolade using extended fields. See "Adding Custom Details
Throughout Accolade" on page 402

A service runs once an hour to synchronize the data from Active Directory to Accolade.

Example

If an employee changes their name or their login information changes, if you synchronize user
data with Active Directory, you need only to make the changes within Active directory. An
Accolade service runs in the background that keeps the information synchronized with the
user information mapped in Accolade.

In addition, when you create user accounts in Accolade, you can search Active Directory for
users and pull the user information directly from Active Directory into the user profile within
Accolade.

After the Active Directory Enabled parameter is set in the Administration Console, continue
with the following sections to map the server and create accounts.

Mapping the Active Directory Server

To synchronize users with Active Directory, you must first tell Accolade where to find the Active
Directory instance, and then map attributes available within Active Directory used to identify
users.

To sync users between Accolade and the Active Directory at any time,
click Sync on the Active Directory page. A synchronization service runs in
the background once an hour.

To add an Active Directory and define the server information:

1. Ensure that the Active Directory Enabled system parameter is set to 1 in the
Administration Console.

The functionality is disabled by default.

2. Within Accolade, from the Systemmenu, select System > Active Directory.

3. Do one of the following:

l To add a new Active Directory - Click in the lower left corner of the page.

l To edit an existing Active Directory - Click inside the field that you want to edit.

4. Enter the following information:

Field Description

Display Name Enter the name of the server, as it displays in the Active
Directory page.
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Field Description

System Name Enter a unique identifier for the Active Directory for within
Accolade, for example, companyNameAD.

The system name is not displayed to users and can be
abbreviated to make it easy to use in queries.

The system name must be unique and can include only
letters (English alphabet), numbers, and the underscore.

URL Enter the path to the Active Directory in your network using
LDAP syntax.

LDAP is case sensitive, and the URL must contain a
forward slash after the port to be valid. For example:
LDAP://server1.sopheon.com:389/.

Search
Distinguished Name

Enter the attributes separated by commas that make up
the distinguished name in Active Directory that defines
users.

For example: OU=Sopheon Users, DC=Sopheon,
DC=com. This example includes the
organizationUnitName and domainComponent attributes.
The distinguished name is set of attributes you have
chosen to identify users.

5. Click Apply to save your changes.

6. Continue with the next procedure to complete the required mapping to active directory
attributes.

To map Accolade fields to objects in the Active Directory structure:

1. Ensure that the Active Directory Enabled parameter is set to 1 in the Administration
Console.

2. Within Accolade, from the Systemmenu, select System > Active Directory.

3. Click the plus next to the Active Directory server you want to map.

4. In the Row Value column, enter the attribute name from Active Directory that
corresponds to each Row Label. The mapping created using these fields determines
which attributes are matched to map users between Accolade and the Active Directory.

Note: The Domain option is an actual value that is used to create the user login
and is not a mapping option. It is concatenated with the Row Value for Login
to create the user login.

5. Any extended field that has the AD Sync check box selected is also available to map
data to from Active Directory. Map those fields, as necessary.

6. Click Apply to save your changes.
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Notes:
l To sync Active Directory with Accolade, the user must have at least read-only
rights to the configured domains on the server and be an Accolade user with the
Service Account role.

107



Chapter 1  Managing Access to Accolade

Administrator's Guide

Creating User Accounts from Active Directory

When you add a user using Active Directory, Accolade imports the user information such as
the user's name and email address from the Active Directory objects you indicated when you
mapped the Active Directory server to fields within Accolade.

Prior to creating users in Accolade using Active Directory:

l Define the users within the Active Directory. After Active Directory is enabled in
Accolade, you can only add user accounts that are defined within Active Directory.

l Create and map the Active Directory server within Accolade.

To add a user account from Active Directory:

1. From the Systemmenu, select Security & Groups > User Admin.

The current list of users displays.

2. Click to display the Add New User dialog box.

3. In the Server field, select the Active Directory in which you want to search for the user.

To search all servers you have defined, select All.

4. Enter any or all of the following as it exists in the Active Directory and click Search to
search the domain for the user:

Field Description

User Email Contacts Enter any part of the user's corporate email address.
User Login Name
Contains

Enter any part of the name the user uses to log on to
your network.

User Name Contains Enter any part of the user's user name.

Users matching the information you entered display in the Select a User list.

5. Select the user in the list to add.

6. In the Chat Address field, enter the user's address for your selected chat tool.

This can be the same or different than the user's standard email address.

7. (Optional) If the Enable User Profile Images system parameter is enabled, add a user
profile image that displays along with the user's name in various locations within
Accolade, click next to the user name, click Choose Image, navigate to and select
the image to add, and click Upload Image. To remove a profile image, click the image
next to the user name and click Remove.

To display as an image within Accolade, an image file must be one of the following file
types: .bmp, .dib, .gif, .jpg, .jpeg, .jpe, jfif, or .png.

8. (Optional) In the Copy From User field, select the user whose configuration details
you want to copy to this user.More...
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Copying configuration details from existing users allows you to assign most of the
details automatically, and only make a few changes to the user, and helps to ensure
that users that you want to have the same permissions are set up identically. For
example, you may have a set of Process Managers in your organizations that all
receive the same configuration. Create one, and then copy the configuration to all
others.

9. Click Create to create the user account.

Notes:
l The users that exist in Accolade prior to enabling Active Directory and running a
sync are not removed from Accolade if they do not exist in the Active Directory
when a sync runs.

l After Active Directory is enabled, you cannot change the values in the fields for any
user within Accolade, such as the users email address.

l To import users, disable Active Directory, run the import, and then re-enable the
Active Directory functionality.

Synchronizing Users with Slack Integration

To synchronize users with Slack, you must first have configurations set in Slack and a valid
token provided by Slack. The Slack bot token is needed when setting the Slack integration in
Accolade. If a Slack user identification changes, you can resynchronize a user.

When configuring the Slack integration in Accolade, note the following:

l The token field is required.

l If the Slack token is changed, the integration will not work and needs to be updated in
Accolade.

l When populating the chat address in Accolade, use the Slack prefix with user ID. All
Slack user IDs need to have the Slack prefix. For example: SLACK:A1B2

l Accolade and Slack email addresses need to be the same.

To resynchronize a user:

1. In Accolade, from the Systemmenu, select Security & Groups > User Admin.

2. Select the user from the list.

3. In theGeneral Details tab, add the email address and the chat address.

4. Click Save.
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Company Functions Overview
A function is a label that helps identify the type of specialist within your company who should
own a deliverable, activity, workflow action, or gatekeeper position in a project. Within process
models, Process Designers can select a function to identify the default functional owner of
deliverables, activities, workflow actions, or gatekeeper positions that make up the model.
When defining a project team within a project, the Project Manager or a Process Manager can
select which user assigned to the function is a member of the project. That user is
automatically assigned to all the documents that have that function assigned in the project,
streamlining the assignment creation process.

Functional areas serve as categories to sort functions into logical groups and typically reflect
departments within your company: Engineering, Marketing, Manufacturing, and so on.
Functional areas can be as large or as granular as what fits your company's needs. Functions
typically reflect job titles or positions that fall within a functional area. For example, a functional
area of Engineering could have functions defined for Electrical Engineer, Mechanical
Engineer, and Chemical Engineer.

Note: Although functional areas and functions typically reflect departments and job
titles or positions within your company, you can use them to identify users in
other classifications.

Example

Company A has a functional area defined for Operations, which includes members of its
purchasing department. Within the Operations functional area, there is a function defined
called Purchasing Leader.

Company A requires Purchasing Leaders to gather Non-Disclosure Agreements (NDAs) from
parts vendors during the first phase of any project that requires manufacturing. A Process
Designer defines a process model to use for manufacturing projects that contains a deliverable
in the first stage called Vendor-NDA. The Vendor-NDA deliverable indicates the Purchasing
Leader as the function assigned.
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Within a project based on the process model, the Process Manager or Project Manager
assigned to the project can select the employee assigned to the Purchasing Leader function to
add to the project team. Within the deliverable assignments for the Vendor-NDAs with the
project, the user list now includes the teammember selected for the Purchasing Leader
function as owner of that deliverable.

Creating Functional Areas and Functions

Functions and functional areas help identify the type of specialist within your company that
owns a deliverable, activity, workflow action, or gatekeeper position in a project. A function
typically identifies users by the user’s job title or position within a functional area; however, you
can use them to categorize users as you see fit for your company.

To create a functional area:

1. From the Systemmenu, select Security & Groups > Functions.

2. Do one of the following:

l To add a new functional area - Click Add Functional Area in the lower right
corner of the page.

l To edit an existing functional area - Click the field within the area that you want to
edit.

3. Complete the following information:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
functional area.

System Name Enter a unique, shorter name that identifies the functional
area in queries, reporting views, field codes, and other
places in Accolade.

The name must be unique among functional areas and can
contain only letters (English alphabet), numbers, and the
underscore.

Order Click on the arrows near the area's name to adjust its order.

The areas will display in other locations in the same order
that you arrange them on this page.

4. Click Apply to save your changes.
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To create a function within a functional area:

1. From the Systemmenu, select Security & Groups > Functions.

2. Click Add Function in the lower left corner of any functional area and complete the
following information:

Field Description

Name Enter a name that identifies the function.
System Name Enter a unique, shorter name that identifies the function in

queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among functions and can
contain only letters (English alphabet), numbers, and the
underscore.

Functional Area Select the functional area in which this function is
categorized.

For example, if you are creating a function for Mechanical
Engineer, the functional area might be Engineering.

Order Enter a number to specify the function's place when it
displays within a list of functions.

Lower numbered functions display higher in the list. This
also determines the order of functions listed for a project
team on the project's Team page.

If no order is specified, the function is added to the top of
the list within the assigned functional area.

Members Click to select the user(s) to assign to this function.

To filter the list of users, enter one or more search criteria to
filter by name, login name, email address, function, or
extended field.More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you are
assigning a user, however depending on the project
configuration, you can assign any user.

l Clicking the Show advanced filters check box displays
or hides the additional filter options.

l Clicking Clear removes the current user assignment and
displays [None] to indicate that no user is assigned.

Highlight the user name(s) in the Available Users window
and click Select, or double-click each user's name to move
them from the Available list to the Selected list.
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3. Select the Active check box when the function is ready to use in projects.

4. Click Apply to save your changes.

Notes:

l To delete a function, click the at the end of the function's row, and click Apply
to save your change. If the function is in use, you can select the function that
replaces the one you are deleting when prompted to move the users into the
selected function. Select None to manually move users to a different function
and manually modify document assignments, as necessary.

l To delete a functional area, click Delete Functional Area on the upper right
corner of a functional area. Any functions within the functional area are moved to
the Default functional area when you confirm the deletion.
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Merging Functions Together

If you find that you have duplicate or unnecessary job functions, merge the users from one
function into another function. After the users are merged into one function, the system deletes
the original function.

To merge a function into another function:

1. From the Systemmenu, select Security & Groups > Functions.

The current list of functions displays both by display name and system name.

2. Select the check boxes in theMerge column next to one or more functions that you
want to merge.

3. Select one check box in theMerge To column to identify the function that you want to
merge the other functions into.

4. Click Apply to merge the users in the merge from function to the merge to function.

The functions selected to merge from are removed from Accolade.
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Defining Data Points and Gathering
Methods

Accolade offers several methods to gather data about projects and current progress towards
completion. Use the information in this chapter to define the components used to gather
information from Accolade.

l Metrics

l Matrices

l Quick Grids

l Templates

l Portfolio Snapshots
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Metrics to Collect Project Data Overview
Ametric is a measure of an aspect of a project, or product, and is unique to each company that
implements Accolade. Metrics provide data and status and are available for inclusion in online
forms, charts, reports, documents, and other places within Accolade. Use metrics to capture
data, such as dates relative to project start and end dates, level of risk, or financial data such
as project costs. Each company has their own set of data points that are important to their
particular process flow. Use the various metric types to define and capture data points about all
projects in your system.

Process Designers create and define metrics and assign metrics to process models, which
then are available to projects based on those models. From there, Project Managers can
assign values within their projects, and document owners can update deliverables, or activities
within the project. A metric must be active and assigned to a model to be available for use
within projects based on that model.

Important! Administrators can view existing metric definitions, but cannot add or
modify metrics.

Accolade offers metric data types for entering text strings, dates, numbers, and single or
multiple selection lists. The type of data captured in each metric determines the data type
required for the metric, and the settings available to the metric.

In addition, increase the power and flexibility of metrics using the following:

l Calculated Metrics - The value of a calculated metric is defined using an expression
within the metric definition. Typically, this metric type is based on the values of one or
more metrics, which can themselves be calculated metrics. Valid expressions are
comprised of field codes and valid operators and functions.

l Cascading List Metrics - Cascading list metrics display different groups of list items
depending on a value selected in a different metric or in other project data. Use queries
within the metric definition to define the list constraints.

l Inherited Metrics - Inherited metrics display metric values that are defined in linked
projects, typically in a collection of projects called a portfolio. Inherited metrics are
defined using the Inherited Metric check box when creating the metric.

l Filter Metrics - Filter metrics describe attributes of a project, such as the project type,
and are used in searches and on various project access pages to narrow the project list.
Filter metrics are defined using the Filter Metric check box when creating a metric.

l Matrix Metrics - Matrix metrics are metrics that are grouped together in a matrix, which
is intended to model complex relationships between different data types. Matrix metrics
are defined using the Available to Matrix check box when creating a metric.

l Searchable Metrics - Searchability is available for metrics and matrix metrics.

Each of the above is defined as part of the basic metric setup.
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Metrics vary widely based on the type of information required at your company. The procedure below
discusses how to create the basis for any metric.

Planners can also create metrics when defining a planning element in Accolade Innovation Planning.
Metrics created in Innovation Planning contain a subset of options that are applicable to metric usage in
Innovation Planning.

To create a metric:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the metric list, search by the metric name, system name, or category.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page.

l To edit an existing metric - Click the name of the metric to open it for editing.

l To create a metric based on an existing metric - Click in the Copy column to create a
copy that can be used as a base to build a new metric.

To copy a metric, the user must have "Can Edit" for at least one access group in
the system and "Can View" for at least one access group on the metric. If you "Can
Edit" any of the access groups the metric belongs to, the copy will have those
groups. If you do not have "Can Edit" on any of the metric's access groups, the
copy inherits your highest access group you can edit.

3. Complete the following information to identify and describe the metric:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Display Name Enter a name, up to 64 characters long, which identifies the
metric.

System Name Enter a unique, shorter name that identifies the metric in
queries, reporting views, Accolade Office Extensions add-in,
Accolade online reports, and field codes, and other areas in
Accolade.

The name must be unique among metrics and can contain only
letters (English alphabet), numbers, and the underscore.

Note: Modifying system names of existing metrics is
not recommended. If you modify an existing
system name, you must also update the name
in each query, report, template, and so on that
references the metric.

Description Enter a description of the purpose or nature of the metric.



Field Description

This description helps other users identify the metric throughout
the system.

Category Enter or select the group to which this metric belongs.More...

Use categories to organize like metrics together. For example, if
there is a large number of metrics assigned to a process model,
a Project Manager can use a category selection to locate
metrics within their projects.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Order Enter a number to specify the metric's place when it displays in
a list of metrics. Lower numbered metrics display higher in the
list.

4. Select one or more of the "Available to" options to make the metric available in other portions of
Accolade.More...

Option Description

Available to Business
Intelligence Tools

Select this check box to enable the metric for use in your
organization's business intelligence application.

Note: If the Available to Planning check box is
selected, the Available to Business
Intelligence Tools and Available to
Reporting options will be automatically
added to the metric settings when the metric
is created.

If the metric is selected for inclusion in a portfolio
snapshot, you cannot clear this option.

Available to Matrix Select this check box to enable the metric for use in matrices.

Important! Ametric that is available to matrices
can only be used in matrices, and is not available
as a standard metric. This setting cannot be
changed after the metric is created.



Option Description

Metrics available to a matrix cannot be displayed individually
on project pages or in a standard quick grid. They can only be
displayed in a project document based on the matrix Excel
template or in a matrix grid within a quick grid.

This option is not available for metrics created
within Innovation Planning

Available to Phases Select this check box to allow the metric to be defined as a
phase metric for use with element types in Accolade
Innovation Planning.

This option is only available to select or modify from
within Innovation Planning.

Available to Planning Select this check box to allow the metric to be added to
element types in Innovation Planning.

If the Available to Planning check box is selected AND the
metric is defined as a date type, select a shape from the drop-
down list to represent a milestone date when included in a
planning view.

Note: If the Available to Planning check box is
selected, the Available to Business
Intelligence Tools and Available to
Reporting options will be automatically
added to the metric settings when the metric
is created.

If the metric is used as a setting for a public
planning view, you cannot clear this option.

Available to Portfolio
Optimizer

Select one of the following to indicate the metric availability
within Portfolio Optimizer:
l Not Available - Not available in Portfolio Optimizer.
l Reporting Only - Included in reports and in calculations,
but is not visible or editable in Portfolio Optimizer. This
option allows you to create metrics for reporting or
calculations that are available to other metrics in Portfolio
Optimizer without including the metric in the list of
available columns in Portfolio Optimizer.

l Edit - Visible and fully available in Portfolio Optimizer.
Metrics that display on a project’s Portfolio page should be
selected for Portfolio Optimizer for users to see the same



Option Description

metric data in Portfolio Optimizer as seen in the project.
Available to Reporting Select this check box to allow the metric in reports created

using the Accolade Office Extensions add-in, Accolade
Online Reporting, or reporting view, and within snapshots.

Note: If the Available to Planning check box is
selected, the Available to Business
Intelligence Tools and Available to
Reporting options will be automatically
added to the metric settings when the metric
is created.

If the metric is selected for inclusion in a portfolio
snapshot, you cannot clear this option.

Available to Resource
Editor

Select this check box to make the metric displayable in the
project details within Resource Editor, when associated with
a project's model.

Available to Workflow
Line-up

Select this check box to make the metric displayable in the
Workflow Line-up page.

Important! The number of metrics selected as
available to the workflow line-up has the potential
to exponentially slow down the Workflow Line-up
page load and navigation. Consider which metrics
require visibility on this page.

5. (Optional) If the Available to Planning check box is selected AND the metric is defined as a
date type, select a list metric with defined colors to set the color of a milestone date icon when
included in a planning view.

6. Select the Active check box when the metric is ready to use in projects.

To deactivate a metric that is not in use, clear the Active check box. Note that you can only
deactivate metrics that are not included on a model.

7. Check the metric options to determine how and where a metric displays throughout the system.
More...

Option Description

Allow Updates from
All My Work page

Select this check box to include the metric as part of updating
projects from the All My Work page.

Users must have Allow Updates from All My Work page
rights to update projects from the All My Work page.



Option Description

This option is not available for calculated metrics.

Filter Metric Select this check box to make this metric available as a filter
in Search and various other locations throughout Accolade.

A filter metric should contain values that clearly distinguish
different project types or project groups. By default, you can
create three filter metrics in Accolade, however the
Maximum Filter Metrics Allowed parameter can be
updated to allow for a maximum of 10. Although any type of
metric other than long string can be designated as a filter
metric, list metrics may be most usable for this purpose
because of the ease of selecting the exact value needed.
Using string metrics as filter metrics requires entering the
exact string when filtering projects using filter metrics.

Example
When a project contains descriptive metric data, such as
project type, select the same filter values Search and similar
pages to find the project. The pages list only those projects
with matching filter values.

Inherited Metric Select this check box to have this metric inherit its value from
an instance of the same metric in a project higher in a
portfolio structure.

Finish creating the base metric and continue with creating a
metric that inherits its value.

Track History Select this check box to save information such as when a
metric value changed, who made the change, when the
change was made, and the original value before the change
for historical reporting purposes.

Important! Tracking metric history has the
potential to create a large amount of history
information. Carefully consider which metrics
require history tracking, and track only those
needed for historical purposes.

Searchable Metric Select this check box to make the contents of the metric
searchable.

This applies to:
l String
l List
l Long String



Option Description

l Multi-Select List

8. In the Restrict to These Roles field, select one or more user roles to restrict the metric
availability to users with one of those roles.

9. In the Initialize From field, select the metric whose value you want to display in this metric before
another value is entered. This list contains other metrics of the same data type.

10. In the Data Type field, select the type of data this metric represents.

The Data Type selection determines what other options are available when configuring the
metric.

Data Type Description

String Creates a text box that accepts up to 500 characters.
Number Creates a text box that accepts only numerals, a decimal

point, and a dash.

Number metrics have a 15 character limit (including decimal
points and dashes).

Date Creates a calendar control that enables a date selection.

Date metrics can also be defined as milestone dates.
List Creates a drop-down list of items for a single selection.

The complete list has a 2500 character limit, and each entry
in the list has a 500 character limit for the list item display
name. If the list source is a query or reference table, the list
character limit does not apply.

Long String Creates a text box where the options and character limit
depends on if the Rich Text check box is enabled:
l If Rich Text is enabled - Allows users to format the text
using buttons in the toolbar of the text box. There is a 2
GB limit to data that can be entered.

l If Rich Text is not enabled - Allows users to enter plain
text that can be formatted using markdown formatting.
There is a 2000 character limit.

Long String metrics cannot be flagged as filter metrics.

If you require more than 2000 characters, enable
the Rich Text check box or enable one or more
Extended Project Data fields in the metadata in
the process model.

Multi-Select List Creates a drop-down list of items for multiple selections.

Data limits are the same as for an ordinary list. The complete
list has a 2500 character limit.



11. Complete the appropriate options for the metric type you are defining.

Number

Field Description

Number Format Enter a custom number format to specify how the value
displays in a Word or PowerPoint document, or in quick grids
when added to an Accolade field.

If you do not enter a number format, numbers display without
formatting.

Decimal Places Enter an integer from 0 to 14 to specify the number of decimal
places allowed in values for this metric.

This is also the number of places to which the value is
rounded in Accolade and in metric field codes. If you did not
create a number format for Microsoft Office documents, this
value also determines the value's decimal places when
displayed in Microsoft Word and PowerPoint.

Example
To display the metric value as an integer, enter 0. To display
its values with two decimal places, such as 3.14, enter 2.
Metrics do not show trailing zeroes except in Portfolio
Optimizer, project history, and Smart documents. For
example, metrics set to 3.20 will show as 3.2.

Date

Field Description

Relative Date Select this check box to specify a time period before or after
another date that serves as the metric reference date, such
as a project start date or another date metric.

The actual date is calculated and is displayed in reports in a
column named <metric name> Calculated.

Example
If Period is set toMonthly, Relative To is set Project End
Date, and the Project End Date is June 1, then a metric value
of 1 equals July 1, a metric value of 2 equals August 1, and so
on. You can also enter negative numbers to specify periods
before the Relative To date.

List



Field Description

List Source Select how to enter the list items, by entering a list manually,
by query, or by reference table column selection.

Finish creating the base metric and then continue with
creating the list for single and multi-select list metrics or
creating a cascading list metric.

Long String

Field Description

Rich Text Select this check box to enable rich text editing. When Rich
Text is selected, the following options are disabled:
l Business Intelligence Tools
l Planning
l Portfolio Optimizer
l Reporting
l Resource Editor
l Workflow Line-up
l Allow updates from All My Work page
l Filter Metric
l Inherited Metrics
l Track History
l Initialize From
l Snapshots
In addition to the above, all options on the Calculated
Formula and Events tab are disabled as rich text metrics
cannot be used in calculations. Additionally, long string
metrics and matrix metrics configured as rich text cannot
contain HTML script tags.

Note: Rich text metrics are available for use in the
following areas: PowerPoint field codes,
quick grids, advanced pods, and Web API.

Multi-Select List

Field Description

List Source Select how to enter the list items, by entering a list manually,
by query, or by reference table column selection.

Finish creating the base metric and then continue with
creating the list for single and multi-select list metrics or
creating a cascading list metric.



12. Associate the metric to multiple models.

13. On the Security tab, configure access group restrictions for the metric.

Click Process Model Usage on the Security tab to see the list of process models that the metric
is associated with. The list includes all process models the metric is included in, as well as links to
the process model's component tree pages that you have Edit access to.

14. Click Create to create the new metric or Apply to save changes to an existing metric.

15. (Optional) Continue with creating and scheduling metric calculations by selecting the
Calculated Formula and Events tab to calculate the metric value from an expression of one or
more metrics or Accolade fields and assign when the metric will calculate by based on a specific
event or designated time.

Notes:
l Administrators can view existing metric definitions, but cannot add or modify metrics.

l Accolade is installed with limits to the number of metrics available to reporting via the
Accolade Office Extensions add-in.

l Number - 900

l Date - 900

l List - 450

l Multi-Select List - 250

l String - 200

l Long String - 50

l Accolade Portfolio Optimizer, Innovation Planning and Roadmapping are optional
Accolade components that you may not have access to. To implement these solutions,
contact Sopheon Customer Support.

Creating Single and Multi-Select List Metrics

Create a metric that displays a list of drop-down items for selection, such as a metric used to define the
difficulty of a project using a defined list with the values Easy, Average, and Difficult. Define list metrics
for single or multiple selection of static list options that builds from selections in previous lists. To build a
list with dynamic list options, see the Creating Cascading List Metrics topic in the online Help.

List metrics can also be defined to select a value based on a calculated expression. For example, you
may have a cost metric that has list values of Under Cost, Actual Cost, and Over Cost. Instead of
allowing users to select the value of that metric within a project, define the metric to use an expression
that determines if a project is under, over, or at cost, and that sets the selection for the list metric. If the
calculated value is not available in the list, it is added and set for that project only. The value is always
set based on the calculation and is always read-only.



To create a list metric:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the metric list, search by the metric name, system name, or category.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page.

l To edit an existing metric - Click the name of the metric to open it for editing.

l To create a metric based on an existing metric - Click in the Copy column to create a
copy that can be used as a base to build a new metric.

3. Create the basic metric, selecting one of the following options in the Data Type field:
l List - Creates a list of options for a single selection.
l Multi-Select List - Creates a list of options for multiple selections.

4. In the List Source field, select the method to use to define the list:

Method Description

Defined List Select this option to define the list manually, creating a static list of items.
Enter each list item's data and click Add New to create a new item. Enter
the following for each item in the list:
l Name - The item's display name, up to 500 characters long. A
manually defined list can contain up to 2500 characters for the total of
all the item display names.

List item names cannot contain the pipe ( | ) character.
l System Name - (Optional) The item's unique ID, up to 64 characters
long. The system name must be unique within metrics, not within all of
Accolade. A system name may be required if this metric is integrated
with a 3rd party system.

l Order - The item's display order in the list.
l Color - If you are creating a list metric in Innovation Planning, assign a
color for use in legends within a Gantt view.

Reference
Table

Select this option to use columns within a reference table to populate the
list of items. Only reference tables set as Available to Metrics are
available for selection. Select the table and the column within the table
that contains the list item selections, noting that list item names cannot
contain the pipe ( | ) character. Only columns set as strings are available
for selection.

The items in a list generated from a reference table column display in the
same order as listed in the column within the reference table.

To create a cascading metric using a reference table, see the Creating
Cascading List Metrics topic in the online Help.



Method Description

Query Select this option to use queries and query codes to populate the list of
items. Items in the list change as the data that the query references
change in Accolade, creating a dynamic list. Each item in a list derived
from a query has a 500 character limit.

Example

To create a list that contain projects that are part of a class called
Marketing, use the following query:

SELECT ProjectName
FROM RVP_Projects WHERE (ClassName) = ('Marketing')

Select an existing query from the list or select Add New Query to create a
new query. Use the Edit and Preview options to modify and test the
query. See the Queries Overview topic in the online Help for information
about building queries.

5. To create a metric whose value is determined by a calculation, select the Calculated Formula
and Events tab and enter the expression in the Calculated Formula field. See the Calculated
Metric Expressions Reference topic in the online Help for guidelines when creating calculated
expressions, and the Scheduling Metric Calculations topic in the online Help to define when the
metric calculates.

6. Click Create to create the new metric or Apply to save changes to an existing metric.

Notes:
l If you modify the list items in the definition of a List or Multi-Select metrics, open and
closed projects retain the currently selected list value, even if that value has been
removed. However, if a list item is removed from the metric definition, that item is no
longer available for selection in new and open projects.

Creating Cascading List Metrics

Using the List data type, Process Designers can create a cascading metric, or constrained metric, that
displays different groups of list items depending on a data value. Creating the cascade requires a
combination metrics: a "reference" metric, whose list options are all available, and a "restricted" metric,
whose list options are limited to the values related to the reference metric's value.

For example, you could create the cascading metrics Business Unit, Brand, and Product Line, such that
the Business Unit selection limits the Brand list options to the brands that are appropriate to for the
currently selected Business Unit, and so on. In this way you can create a cascade, or series, of metrics
that will present the appropriate set of choices at each level of the cascade.



Creating a cascading list metric is the same as creating a normal List metric; however, instead of
creating a predefined list, either select columns from a reference table or write a query that constrains
the returned values using a query field code in a WHERE clause.

Using a reference table to constrain the list allows you to create the constrained list
without a custom reporting view and without needing knowledge of SQL.

To create a cascading list metric using a reference table:

Note: This process assumes that you have already created the "reference" metric, and its
values are also defined in a column within a reference table.

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the metric list, search by the metric name, system name, or category.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page.

l To edit an existing metric - Click the name of the metric to open it for editing.

l To create a metric based on an existing metric - Click in the Copy column to create a
copy that can be used as a base to build a new metric.

3. Create the list metric using the Reference Table option in the List Source field.

Only reference tables set as Available to Metrics are available for selection.

4. Create or select a reference table and indicate the column within the table that contains this
metric's list selections.

Only reference table columns with the data type set as String are available for selection.



5. In the Filter fields, select the reference table column that is used by the "reference" metric and
will be used to restrict the list, and enter a query code that defines the value used for the
restriction.

The value entered for the field can be one of the following:

l A query code that references another metric or a matrix metric within the project. Query codes
that reference a metric or matrix metric use the {*QME:<metricsystemName>*} format.

l A query code that references project metadata, such as {*QMD:ProjectAccessGroup*}. Query
codes that reference metadata use the {*QMD:<metadataName>*}. See "Query Field Codes
Reference" on page 762 for a list of valid metadata query codes.

Additional filters can be applied as necessary.

Example

For example, a user wants to categorize all of their Accolade projects by region and country that
they have business assets in. The user has created a reference table called Region List, which
contains a column list of regions and a corresponding column list of countries, and has created
the list metrics Region and Country to use in Accolade projects. Both metrics use the Region
List reference table as a list source, and use the corresponding table columns to define the list
options that can be selected when creating projects. Additionally, to minimize setup errors, the
user wants the list of countries available for selection to be restricted by the value selected for the
region.

To set up the reference table, the user has included the following rows for each metric
combination available for selection.

For this example, the user wants Region to be the "reference" metric. To set up the Region
metric, the user selects Region List as the List Source and Region as the Column to use as the
metric's list value options.



For this example, the user wants the Country metric to be the "restricted" metric. To set up the
Countrymetric, the user selects Region List as the List Source and Country as the Column to
use as the metric's list value options, but must add an additional filter in order to restrict the
available list selections based on the Region value. In the Filter fields, the user selects Region
as the column to be used as the filter to restrict the list, and enter {*QME:EX_Region*} as the
value of this filter.

As entered, the filter and query expression combination states that Country values that have a
matching Region value should be included in the list of options available for selection.

To further illustrate this: in the example below, the user has selected North America as the
Region value. Based on the applied filtering, the available country selections are restricted to
Country values that have corresponding North America Region values (which are Canada,
USA, and Mexico, based on the table setup).



Note that in the example above, the user could have created and applied additional list metrics,
for example creating a Citymetric in the reference table whose list options can be restricted both
by applying filters both to the Region value {*QME:EX_Region*} and to the Country value
{*QME:EX_Country*}.

6. Click Create to create the new metric or Apply to save changes to an existing metric.

To create a cascading list metric using a query:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the metric list, search by the metric name, system name, or category.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page.

l To edit an existing metric - Click the name of the metric to open it for editing.

l To create a metric based on an existing metric - Click in the Copy column to create a
copy that can be used as a base to build a new metric.

3. Create a list metric using theQuery option in the List Source field.

4. Create or select a query that uses a query field code included in a WHERE clause to restrict the
list.

At the highest level, a SQL query for a cascading list looks like:
SELECT Child Column
FROM View
WHERE Parent Column = {*QME:<metric system name>*}

Example

Consider the following SQL query that uses the GlobalRegions reference table, and
refines the city selections based on the selections made for the region, country, and state.
The city list only displays cities that are within the region/country/state area:



SELECT Distinct City
FROM CRV_Ref_GlobalRegions
Where Region = '{*QME:qblRegion*}' AND Country
= '{*QME:qblCountry*}' AND State
= '{*QME:qblState*}'

The top level of the cascade can be a list metric that is either populated by a query or defined
manually.

5. Click Create to create the new metric or Apply to save changes to an existing metric.

Notes:
l Administrators can view existing metric definitions, but cannot add or modify metrics.

l It is not necessary for the parent metric in a cascade to appear on the same page as the
child metric. The constraint is based on the selected value of the parent metric as found in
the database.

l You can create a constrained metric that is not part of a cascade. The query is
constrained by metadata rather than by another metric.

l If a cascading metric is selected as a filter metric, it does not cascade on the page where it
is used as a filter. All of its list items display as if it were an ordinary list.

l If a query contains a reference to a RVP_ or CRVP_ reporting view, the result displays
[Unavailable] when used on an external Idea Submission form. External users do not
have the security rights to see the data contained within those views.

l In Innovation Planning and Roadmapping, a cascading list metric included in a matrix
does not enforce the cascade. For example, if there is a state selection that restricts the
cities available for selection, the city list shows all cities and does not filter to the selected
state.

l Idea Submission (as a part of Accolade Ideation), Innovation Planning and Roadmapping
are optional Accolade components that you may not have access to. To implement these
solutions, contact Sopheon Customer Support.

Creating Metrics that Inherit Their Value

Inherited metrics display metric values that are defined in linked projects, typically in a collection of
projects called a portfolio. Within a portfolio, when information is entered in the metric in the parent
project, it displays in any instance of the same metric in the child projects within the portfolio. If those
projects also contain child projects, the same data is displayed in the metric in those projects as well,
and so on down through the portfolio structure.

If someone enters a different value in an inherited metric on a child project, that metric on that child
project and any project below it in the portfolio structure no longer inherit changes made to the metric
above it in the structure. Change the value in the metric in the child project to be the same value as the
metric in the parent project to restore the inheritance.



Administrators and Process Designers create the inherited metrics, and Process Designers associate
them with models. Process Managers and Project Managers create links between projects using the
Contains project link andMember Of Project links to create a portfolio structure where the metrics
inherit their values.

To create a metric that inherits its value:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the metric list, search by the metric name, system name, or category.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page.

l To edit an existing metric - Click the name of the metric to open it for editing.

l To create a metric based on an existing metric - Click in the Copy column to create a
copy that can be used as a base to build a new metric.

3. Create any metric type and select the Inherited Metric check box to indicate the metric inherits
its value.

4. Associate the metric with the models of both the top container project in the portfolio structure
and the projects in the portfolio that display the value.

It is not necessary for every project in a portfolio structure to have the same model.

5. Click Create to create the new metric or Apply to save changes to an existing metric.

Notes:
l Administrators can view existing metric definitions, but cannot add or modify metrics.

l You can also use inherited metrics outside of portfolios.

l Accolade Portfolio Management and Portfolio Optimization are optional Accolade
components that you may not have access to. To implement these solutions, contact
Sopheon Customer Support.



Initializing Metrics with Default Display Values

You can set up a metric so it displays a default value before a user enters data into the metric, rather
than initially displaying blank. After a user modifies the data in the metric, the link with the source metric
is broken, and the modified metric contains the data entered.

Important! Initializing a metric with a default value only displays the value in the target
metric within Accolade. The value does not transfer to Smart Excel documents or reports.

Metrics that pull a default display value from another metric cannot be on the same page within
Accolade as the metric from which they get their value. Therefore, a metric that is set to contain an initial
value from another metric should conform to the following rules:

l The metric should not be in the same category as its initializing metric.

l The metric should not be editable or appear together with its editable initializing metric on the
project creation page, Home, or Details pages within a project.

l The metric should not be in the same Smart Excel document or online form with its initializing
metric.

To initialize a metric with a default display value:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the metric list, search by the metric name, system name, or category.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page.

l To edit an existing metric - Click the name of the metric to open it for editing.

l To create a metric based on an existing metric - Click in the Copy column to create a
copy that can be used as a base to build a new metric.

3. Create any metric type.

4. In the Initialize From field, select the metric value to use in this metric until another value is
entered or selected.

If you are creating or modifying a metric that uses the List or Multi-Select List data type, select an
initializing metric that has an identical set of list items. If either metric is query based, ensure that
the initializing metric contains all the list items that could occur if both metrics are based on the
same query.

5. Click Apply to save your changes.

Notes:
l If the metric selected in the Initialize From field is deleted or made inactive, new
instances of the metrics that use it for their default value are blank.

l Metric initialization is affected by the Default Online Form Fields to Dirty parameter



available in the Administration Console.More...

If the parameter is enabled, metrics that are set for initialization behave in an online form
as if the initializing value is entered manually when the form is first opened. That is, the
initializing link is broken and no further automatic updates of the value occur. If the
parameter is disabled, the initialized metric continues to change when the source metric is
changed until the initialized metric is changed manually.

Creating Metrics Using Expressions (Calculated Metrics)

The value of a calculated metric is defined using an expression within the metric definition.

Typically, this metric type is based on the values of one or more metrics, which can themselves be
calculated metrics. Valid expressions are comprised of other metrics, metadata (field codes), valid
operators, and functions. Calculated metrics display as read-only values when displayed in a project,
and can be recalculated on scheduled events. See "Scheduling Metric Calculations" on page 163.

Security profiles cannot contain metrics with calculated values.

The procedure below describes how to define the expression within the metric definition. For
information about writing the expressions themselves, the components available, and considerations
for Portfolio Optimizer, see the calculated metrics information in the Accolade online Help.

To create a metric using an expression:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the metric list, search by the metric name, system name, or category.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page.

l To edit an existing metric - Click the name of the metric to open it for editing.

l To create a metric based on an existing metric - Click in the Copy column to create a
copy that can be used as a base to build a new metric.

3. Create the basic metric and select the Calculated Formula and Events tab.

4. In the Calculated Formula field, enter the expression following the guidelines in the Calculated
Metric Expressions Reference topic in the Accolade online Help.

5. Click Create to create the new metric or Apply to save changes to an existing metric.

Notes:
l If a metric's calculated value extends beyond the allowable characters for the metric type,
the data stored and displayed for that metric is truncated as follows:

l String - 500 characters

l Long String - 2000 characters



l Number - 15 characters

l Multi-Select List - 2500 characters

l List - 2500 characters

Calculated Metric Expressions Reference

Calculated metrics can contain references to other metrics, metadata in the form of field codes,
operators, and functions. The tables in the sections below contain the operators and the functions
available when writing expressions. See "Accolade Field Codes and Substitution Tokens" on page 771
for information about the metadata available within Accolade. Note that certain project data field codes
are not available for use in calculations. Use the equivalent function listed below instead.

Operators

Operators are process or mathematical parts of expressions, such as addition and multiplication, and
relationships such as greater than or less than. Use the operators below within your calculated metric
expressions.

Operator Example

Additive and Subtractive Operators

+ (plus, plus sign) {*METRIC:NPV*}+{*METRIC:fut*}

- (minus, dash) {*METRIC:NPV*}-{*METRIC:Cost*}

Multiplicative Operators

* (multiplied by, asterisk) 10*{*METRIC:NPV*}

/ (divided by, slash) {*METRIC:NPV*}/{*METRIC:fut*}

% (mod, percent sign) {*METRIC:NPV*}%10

Primary Operators

value (integers, text strings,
dates, functions)

('this is a text string')

While single quotes work for dates,
we recommend wrapping dates in
pound or hash signs instead to
ensure consistency of data types.
For example, (#2021-10-19#).

( ) (parentheses) 1000-(6*{*METRIC:NPV*})

Relational Operators

= (equals) {*METRIC:NPV*}=250



Operator Example

<> (does not equal) {*METRIC:NPV*}<>{*METRIC:fut*}

> (greater than, angle bracket) {*METRIC:NPV*}>250

>= (greater than or equal to) {*METRIC:NPV*}>=250

< (less than, angle bracket) {*METRIC:Cost*}<500

<= (less than or equal to) {*METRIC:Cost*}<=100

Logical Operators

or, || (double pipe) {*METRIC:Cost*}<{*METRIC:NPV*}||
{*METRIC:Cost*}<500

and, && {*METRIC:Cost*}<{*METRIC:NPV*}&&
{*METRIC:Cost*}<1000

Functions

The functions included in the calculated metric determine in part what is returned in the metric. Use the
functions described below within your calculated expressions to return data within a calculated metric.

Note: All functions are supported in calculated metrics in Accolade Portfolio Optimizer
unless otherwise noted.

Function Description Example Result

Abs Returns the absolute
value of a specified
number.

Abs(-1) 1

Acos Returns the angle
whose cosine is the
specified number.

Acos(1) 0

Asin Returns the angle
whose sine is the spe-
cified number.

Asin(0) 0

Atan Returns the angle
whose tangent is the
specified number.

Atan(45) 1

Avg Returns the average
of a set of values.

Avg(1, 5, 6) 4

Ceiling Returns the smallest
integer greater than or

Ceiling(1.5) 2



Function Description Example Result

equal to the specified
number.

CellValue Returns a value in the
matrix column spe-
cified by a defined met-
ric.

CellValue('Year') The value in the
matrix column
with the matrix
metric 'Year'.

CellValue Format: CellValue('MatrixMetricsystemName')

CellValue Parameters:
l MatrixMetricSystemName - the system name of the matrix metric to reference. This must
be the system name, and cannot be a substitution token.

This function is valid for use in the filter expression argument of the GetMatrixColumn function,
and will return values from the same row as the metric that uses the function.

CellValue can only be used in matrix metrics, and can only reference matrix metrics.

Concatenate Joins text strings into
a single string in the
specified order.

To include a delimiter
between values in the
concatenated string,
use the Join function
instead. You can
concatenate as many
strings together as
you need.

If a metric's calculated
value extends beyond
the allowable
characters for the
metric type, the data
stored and displayed
for that metric is
truncated as follows:

l String - 500
characters

l Long String -
2000
characters

l Number - 15
characters

Concatenate('text1',
{*METRIC:MyString*},
'text2', 'textN')

If the value of MyString =
abc, the concatenated
value would be
text1abctext2textN.

A continuous
text string



Function Description Example Result

l Multi-Select
List - 2500
characters

l List - 2500
characters

Contains Returns whether one
string is contained in
another.

Contains('Blue', 'My Blue
Heaven', 2, 7)

True

Contains Format: Contains('findString', 'withinString', [startIndex, length])

Contains Parameters:
l findString - The string to find.
l withinString - The string in which to search for the find.
l String startIndex - (Optional) Number of characters from the beginning of within.
Minimum value is 1.

l length - (Optional) Number of characters from the startIndex to search.

Con-
vertToCorporateCurrency

Returns the value of
the specified metrics
in the defined cor-
porate currency.

Con-
vertToCorporateCurrency
({*METRIC:Pro-
jectACurrency*})

The Pro-
jectACurrency
metric value
converted to
the corporate
currency

ConvertToCorporateCurrency Format: ConvertToCorporateCurrency
({*METRIC:systemName*})

ConvertToCorporateCurrency Parameters:
l Field code or integer value - The value being converted to the corporate currency. This
typically includes the metric system name or metadata field code assigned to the values
to convert and return as the corporate currency. It can also be an integer to convert.

l Valid currency code - (Optional) A valid currency code other than the corporate currency
to convert the specified values to. This can also be a metadata field code for a project
currency.

Additional ConvertToCorporateCurrency Examples:
l ConvertToCorporateCurrency(CellValue('MatrixMetricsystemName'))
l ConvertToCorporateCurrency(1000)
l ConvertToCorporateCurrency({*METRIC:systemName*}, 'EUR')
l ConvertToCorporateCurrency(1000, {*MD:ProjectCurrencyCode*})

Note that if using this formula, changes to the project currency code or the currency reference
table containing exchange rates and conversion factors will result in a recalculation of all
calculations using this formula.



Function Description Example Result

Cos Returns the cosine of
the specified angle.

Cos(0) 1

Count Returns the number of
elements in an expres-
sion.

'true' includes null
values of the specified
expression.
'false' excludes null
values.

Count(GetMatrixColumn
('mxFinancials', 'Cost',
Region = 'USA'), true)

A list of ele-
ments returned
by the GetMat-
rixColumn
expression
including null
values.

Count Format: Count(<function returning an array>, <true/false>)

Count Parameters:
l Function returning an array - A function that returns a list of values. Use
LinkedProjectValue and GetMatrixColumn as a best practice.

l true or false - Determines whether to include null values or not. The true or false value
must be lower case and not include quotes around it.

CurrentMatrixValue Returns the current
value of a metric. This
function is the same
as CurrentValue, but
used in a matrix.

The
CurrentMatrixValue
function does not
support nesting
calculations in
Accolade Portfolio
Optimizer.

This is a self-
referencing function
where the system
name must be the
system name of the
metric calling the
function.

CurrentMatrixValue
('Today')

The current
value of the
Today metric in
a matrix cell

CurrentMatrixValue Format: CurrentMatrixValue('systemName')

CurrentMatrixValue Parameters:
l systemName - The system name assigned to the metric calling the function to return the
current value.



Function Description Example Result

Combine with other functions. For example:

If({*METRIC:A*}='Current', Concatenate('Today', Now()), CurrentMatrixValue('Today'))

If metric A is set to Current, the value in the matrix cell is set to Today, concatenated with
today's date. For example, Today is 5/20/17. If metric A is set to anything other than Current,
the value remains the same.

Note that if using CurrentMatrixValue as a function in a matrix and updating the matrix in MS
Excel, you must uniquely identify the row by flagging matrix metrics as unique. If matrix
columns are not unique or the MS Excel workbook contains duplicate columns, the
CurrentMatrixValue function value cannot be updated. The Smart Excel template does not
update, upload, or publish back to Accolade.

CurrentValue Returns the current
value of a metric.

The CurrentValue
function does not
support nesting
calculations in
Accolade Portfolio
Optimizer.

This is a self-
referencing function
where the system
name must be the
system name of the
metric calling the
function.

CurrentValue('Con-
fidence')

The current
value of the
Confidence met-
ric

CurrentValue Format: CurrentValue('systemName')

CurrentValue Parameters:
l systemName - The system name assigned to the metric calling the function to return the
current value.

Combine with other functions. For example:

if({*METRIC:NPV*}<500, 'At Risk', CurrentValue('Confidence'))

If NPV is less than 500, the metric that contains this calculation is set to At Risk. If NPV is
greater than 500, it is set to the current value in the Confidence metric.

DateAdd Adds a number of time
periods to a date.

DateAdd('D', 5, Now()) 5 days added to
current date

DateAdd Format: DateAdd('type', number, #date#)

DateAdd Parameters:
l type - D: Day, H: Hour, MN: Minute, S:Second, M: Month, Y: Year.
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l number - An integer.
l date - The date to adjust, can be a date metric or the Now function.

DateDiff Returns the selected
difference between
two dates.

DateDiff
('D',ProjectNextGateDate
(), ProjectStartDate())

Days between
project start
and next gate

DateDiff Format: DateDiff('type', #endDate#, #startDate#)

DateDiff Parameters:
l type - D: Day, H: Hour, MN: Minute, S: Second, M: Month, Y: Year.
l endDate - The ending date.
l startDate - The starting date.

DateFormat Returns a date in the
specified date format
as a string.

DateFormat(Pro-
jectCreationDate(),
'M/d/yyyy')

Date the project
was created in
M/d/yyyy
format.

DateFormat Format: DateFormat(#date#, 'dateFormat')

DateFormat Parameters:
l date - A specified date or function indicating a date.
l dateFormat - Date format in which to return the value. The inputs allowed for this
parameter are strings using string-type metrics.

Supported date formats are those set in the Accolade user profile, included the following:
M/d/yyyy, MMM dd, yyyy, d/M/yyyy, dd/MM/yyyy, d.M.yyyy, d-M.yyyy, yyyy-MM-dd, yyyy/M/d,
yyyy.M.d.

Combine with other functions. For example:

DateFormat(Now(),'M/d/yyyy') returns today's date such as 10/15/2018.

DatePart Returns the selected
part of a date.

DatePart('M',
#5/15/2013#)

5

DatePart Format: DatePart('type', #date#)

DatePart Parameters:
l type: D - Day, H: Hour, MN: Minute, S: Second, M: Month, Y: Year.
l date - The date containing the part you want.

Exp Returns e raised to the
specified power

Exp(0) 1

Find Returns how far from
the start of a string a
contained string was
found. Case sensitive.

Find('Blue', 'My Blue
Heaven', 2, 20)

4
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Find Format: Find('findString', 'withinString', [startIndex, length])

Find Parameters:
l findString - The string to find.
l withinString - The string in which to search for the findString.
l startIndex - (Optional) Number of characters from the beginning of withinString to start
searching. Minimum value is 1.

l length - (Optional) Number of characters from the startIndex to search.

First Returns the first value
that is returned in a list
of values.

First(1, 5, 6) 1

Floor Returns the largest
integer less than or
equal to the specified
number.

Floor(1.5) 1

GateDecision Returns the decision
for the specified gate.

GateDecision(2) A string of the
decision for the
second gate in
the project

GateDecision Format: GateDecision('1-20') or GateDecision({*METRIC:systemName*})

Gate Decision Parameters:
l 1-20 - An integer value correlating to the gate on the project. 1 indicates the first gate on
the project.

l Metric field code system name - The referenced field code must return an integer value 1-
20.

GetMatrixColumn Returns an array from
a matrix.

This function must be
used with the Join,
Concatenate, Count,
Avg, First, Min, Max,
or Sum function to
perform a calculation
on the values returned
from the matrix
column.

Sum(GetMatrixColumn
('mxSales', 'Profit', (Mar-
ket = 'US' || Market =
'Europe') && Profit >
10000))

In the 'mxSales'
matrix, the func-
tion returns the
sum of profit for
the US and
Europe markets
greater than
10,000 USD.

GetMatrixColumn Format: GetMatrixColumn('matrixSystemName',
'targetColumnSystemName', filterExpression)

GetMatrixColumn Parameters:
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l matrixSystemName - The system name of the matrix. This must be the system name, and
cannot be a substitution token or nested function.

l targetColumnSystemName- The system name of the column to return values.
l filterExpression - (Optional) Inputs used to filter columns in the matrix. Elements that
meet the search criteria are returned as an array. Valid inputs include column system
names, metric and metadata tokens, IsNull, and hard-coded values. The expression must
equate to true or false. Use operators to join filter expressions for more complex filtering.

Additional GetMatrixColumn Examples:
l Count(GetMatrixColumn('mxSales', 'Profit', SalesYear >= 2010 && Profit < 0), true) -
Returns the number of sales years since 2010 that had a negative profit.

l Join(GetMatrixColumn('mxSales', 'Market', Profit > 0), ', ') - Returns all markets in the
'mxSales' matrix that made a profit.

l Sum(GetMatrixColumn('mxSales', 'Profit', IsNull(Costs, 0) > 1000)) - Returns the sum of
profit where the costs exceeded 1000.

l Sum(GetMatrixColumn(('mxSales', 'Cost', Year = CellValue(#Year#))) - Returns the total
costs by year.

IEEERemainder Returns the remainder
resulting from the divi-
sion of a specified
number by another
specified number.

IEEERemainder(13, 5) 3

If Returns a specified
string or value based
on a condition.

If({*METRIC:NPV*}>500,
'Go ahead', 'Stop')

Go ahead

In Returns whether an
element is in a set of
values.

In(1+1, 1, 2, 3) True

IRR Returns the Internal
Rate of Return value
for a series of cash
flows.

IRR(GetMatrixColumn
('mxFinancials', 'Cost',
Region = 'USA'))

Returns the
internal rate of
return value for
the cash flows
returned by the
GetMat-
rixColumn func-
tion.

IRR Format: IRR(value array, [guess])

IRR Parameters:
l Value Array - An array passed in as an object specifying cash flow values. The array must
contain at least one positive value (a receipt) and one negative value (a payment).



Function Description Example Result

GetMatrixColumn is currently the only function that can be passed in as an object and
return an array. If the data is not valid, the calculation will be skipped. Invalid data is
defined as the following:

l No values
l Array of strings or date values
l Only positive values
l Only negative values
l Only zeros

l Guess - (Optional) A value you estimate will be returned by IRR. If omitted, guess is 0.1
(10 percent). If the data is not valid, the calculation will be skipped. Invalid data is defined
as the following:

l Guess value of -1 or lower

IsNull Checks if the first para-
meter is an empty
value.

If the parameter value
is null, returns the
second parameter
value; otherwise,
returns the first
parameter value.

IsNull(ProjectEndDate(),
{*METRIC:Fin-
anceStartDate*})

Finance start
date if the pro-
ject end date is
not defined

IsNull Format: isNull({parameter1},{parameter2})

IsNull Parameters:
l parameter1 - The parameter to check for no value.
l parameter2 - If no value in parameter1, sets this parameter.

Join Joins text strings
together into a single
string in the specified
order, separated by a
delimiter.

For example, create a
metric using this
function to create a list
of the child projects for
a particular project,
sending in '|' as the
delimiter. Then create
a multi-select list that
uses the resulting

Join(LinkedProjectValues
('children', 'to', 'Code'), '|')

A list of values
separated by |.



Function Description Example Result

project names to
select from.

To join text strings
with other provided
values, use the
Concatenate function.

Join Format: Join(<function returning an array>, '<delimiter>')

Join Parameters:
l Function returning an array - A function that returns a list of values from the same object.
The LinkedProjectValues function and GetMatrixColumn are the only functions that return
an array.

l Delimiter - Any character to separate returned values, such as a pipe ( | ).

Length Returns the length of a
string.

Length
({*METRIC:myString*})

An integer

LinkedProjectValues Returns the values of
the specified metrics
for linked projects.

This function must be
used with the Join,
Concatenate, Count,
Avg, First, Min, Max,
or Sum function to
perform a calculation
on the values returned
from the linked
projects. Use this
function to calculate
roll up values in
projects that contain
one or more related
projects.

Metrics that contain
this calculation cannot
be used when creating
automatic project
linking rules. When
applying a metric that
uses this formula,
consider where

Sum(LinkedPro-
jectValues
('ABToCSG','To','NPV',-
5))

(see below for additional
examples)

Totals the val-
ues in the NPV
metric in pro-
jects that are
linked to the pro-
ject using the
ABToCSG link
type. This
example totals
values in pro-
jects up to five
levels deep.
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calculations take
place. For example, if
a parent project and
its child projects use
the same model that
contains a metric with
this calculation, the
calculated metric
recalculates for all
projects in the chain.

The
LinkedProjectValues
function is not
supported in Accolade
Portfolio Optimizer.
Metrics that contain
this function cannot be
set as matrix metrics.

LinkedProjectValues Format: LinkedProjectValues
('linkTypeSystemName','direction','returnMetricSystemName',traverseLevel)

LinkedProjectValues Parameters:
l linkTypeSystemName - The system name of the link type used to create the project links.
To specify the hierarchy link type, use HierarchyLinkDefault as the system name. This
must be the system name, and cannot be a substitution token.

l direction - The direction to or from the project that contains the calculation to gather and
return values. To traverses down the hierarchy; From traverses up the hierarchy. If your
values do not calculate correctly, ensure that the project links were created in the
appropriate direction.

l returnMetricSystemName - The system name of the metric value to return. This must be
the metric system name, and cannot be a substitution token.

l traverseLevel - (Optional) The number of levels from the project that contains the
calculation to gather and return values. If no value is included, values are returned for all
levels in the hierarchy.

Additional LinkedProjectValues Examples:
l Sum(LinkedProjectValues('ABToCSG','To','NPV')) - Returns the total of all values
entered in the NPV metric in projects that are linked to the parent project using the
ABToCSG link type.

l Avg(LinkedProjectValues('ABToCSG','To','NPV',3)) - Returns the average of the NPV
metric in projects that are linked up to three levels deep in the hierarchy to the parent
project using the ABToCSG link type.
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Log Returns the logarithm
of a specified number
for a specified base.

Log(1, 10) 0

Log10 Returns the logarithm
of a specified number
to base 10.

Log10(1) 0

Lower Returns a text string
with all lower case.

Lower('Hello') hello

LTrim Removes leading
spaces from a string.

LTrim
({*METRIC:myString*})

A string without
a leading space

Max Returns the largest of
the specified values.

Max(1, 5, 6) 6

Min Returns the smallest
of the specified val-
ues.

Min(1, 5, 6) 1

ModelName Returns the name of
the model.

ModelName()

MostRecentGateDecision Returns the gate
decision from the most
recent phase change.

MostRecentGateDecision
()

Now Returns the current
date and timestamp.

Now()

NPV Returns the net
present value of a
series of cash flows
based on a specified
discount rate.

NPV(.12, 10, 12, 8, 16) 34.4

NPV Format: NPV(rate, <series of cash flow values>)

NPV Parameters:
l Rate - The discount rate.
l Series of cash flow values - Series of values separated by a comma delimiter. Can also
be an array passed in as an object or a series of metric values.

Additional NPV Examples:
l NPV(.12, GetMatrixColumn('mxFinancials', 'Cost', Region = 'USA')) - Returns the net
present value of the cash flows returned by GetMatrixColumn based on a 12% discount
rate.

l NPV(.12, {*METRIC:Year1Financials*}, {*METRIC:Year2Financials*} - Returns net
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present value of Year1Financials and Year2Financials based on a 12% discount rate.

PaybackPeriod Returns the payback
period.

PaybackPeriod('cash_
flow', '~Net_Cash_Flow',
'~Cash_Flow_Relative_
Date')

A decimal
number
displaying the
payback period
in years.

If the payback
period cannot
be calculated,
the function
returns 0.

Payback Period Parameters:
l Financial matrix - Captures costs and revenue.
l Cash Flow - The difference between total revenue and total costs.
l Relative Date - The relative period of time in which costs and revenue are recorded.

Pow Returns the value of a
number raised to the
specified power.

Pow(3, 2) 9

ProjectAccessGroup Returns the name of
the project's access
group.

ProjectAccessGroup()

ProjectClass Returns the name of
the project's class.

ProjectClass()

ProjectClosed Returns the project's
closure status.

ProjectClosed()

ProjectCreatedByID Returns the ID of the
user that created the
project.

ProjectCreatedByID()

ProjectCreatedByName Returns the name of
the user that created
the project.

ProjectCreatedByName()

ProjectCreationDate Returns the date when
the referenced project
was created.

ProjectCreationDate()

ProjectCurrentPhase Returns the system ID
of the cur-
rent/stage/gate pair in

ProjectCurrentPhase()



Function Description Example Result

the referenced project.

The project current
phase is set to 0 if the
project ends in a gate,
and the gate's
decision is set toGo.

Pro-
jectCurrentStageName

Returns the name of
the current project
stage.

Pro-
jectCurrentStageName()

ProjectDescription Returns the descrip-
tion of the project from
the model.

ProjectDescription()

ProjectEndDate Returns the date the
project ended.

ProjectEndDate()

ProjectGateDate Returns the date of
the gate meeting of a
specific gate.

ProjectGateDate(1) The date for the
first gate meet-
ing in the pro-
ject

ProjectGateDate Format: ProjectGateDate('1-20') or ProjectGateDate
({*METRIC:systemName*})

ProjectGateDate Parameters:
l 1-20 - An integer value correlating to the gate on the project. 1 indicates the first gate on
the project.

l Metric field code system name - The referenced field code must return an integer value 1-
20. For example, ProjectGateDate('{*METRIC:NumberMetric*}') would return an integer
value between 1-20.

ProjectHealthScore Returns the project's
health score from the
connected Acclaim
Projects project.

ProjectHealthScore() The project
health score
from Acclaim
Projects.

ProjectID Returns the user-cre-
ated ID of the ref-
erenced project.

ProjectID()

ProjectMostRecentStatus Returns the text of the
most recent status
report on the ref-
erenced project.

ProjectMostRecentStatus
()
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Pro-
jectMostRe-
centStatusAuthor

Returns name of the
person who created
the project's most
recent status report.

Pro-
jectMostRe-
centStatusAuthor()

Pro-
jectMostRe-
centStatusDate

Returns the date the
project's most recent
status report was cre-
ated.

Pro-
jectMostRe-
centStatusDate()

ProjectName Returns the name of
the project.

ProjectName()

ProjectNextGateDate Returns the date of
the next gate meeting
in the project.

ProjectNextGateDate()

ProjectNextGateName Returns the name of
the next gate in the
project.

ProjectNextGateName()

Pro-
jectNex-
tGateOwnerName

Returns the name of
the gate owner of the
project's next gate.

Pro-
jectNex-
tGateOwnerName()

ProjectPreviousGateDate Returns the date of
the gate meeting
before the current
stage.

ProjectPreviousGateDate
()

ProjectStartDate Returns the date when
the project started.

ProjectStartDate()

ProjectTeamLeaderEmail Returns the email
address of this pro-
ject's Project Man-
ager.

ProjectTeamLeaderEmail
()

Pro-
jectTeamLeaderName

Returns the name of
this project's Project
Manager.

Pro-
jectTeamLeaderName()

ReferenceTable Returns the value
from the specified cell
of a reference table.

If a calculated metric
uses the
ReferenceTable

ReferenceTable('Cur-
rency', 'CurrencyCode',
'USD', 'Value2015')

The value from
the Value2015
column for the
given filter
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function, the reference
table must be marked
as Available to
Portfolio Optimizer
for the metric
calculation to work in
Portfolio Optimizer.

ReferenceTable Format: ReferenceTable('RefTableSystemName', 'sourceColumn1',
'sourceColumnValue1', 'sourceColumn2', 'sourceColumnValue2'...'targetColumn')

ReferenceTable Parameters:
l RefTableSystemName - The system name of the reference table. This must be the
system name, and cannot be a substitution token or nested function.

l sourceColumn1 - The system name of the column from which to find values.
l sourceColumnValue1 - The value within the column being pointed to. Must be added with
the sourceColumn1 parameter.

l sourceColumn2 - (Optional) The system name of the second column from which to find
values.

l sourceColumnValue2 - (Optional) The value within the second column being pointed to.
l targetColumn - The system name of the column to return values.

The formula returns back the first matching value ordered by row id.

The ReferenceTable function can include an infinite amount of column/value pairs in the
expression. Note that they must exist as a pair containing the column system name and the
associated value expression.

Replace Replaces every
instance of a text
found in a larger string
with a new text and
returns the string.
Case sensitive.

Replace('My Blue
Heaven', 'Blue', 'red')

My red heaven

Replace Format: Replace('originalString', 'oldMatch', 'newText')

Replace Parameters:
l originalString - The string that is searched.
l oldMatch - The string that is replaced.
l newText - The string that replaces the oldMatch.

ResourceDemands Returns all the
resource demands on
a project or all
demands between two
dates.

ResourceDemands(Pro-
jectGateDate (2), Pro-
jectGateDate (3))

Sum of all
demands
between these
dates, ignoring
units of meas-
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The
ResourceDemands
function is not
supported in Accolade
Portfolio Optimizer.

ure

ResourceDemands Format: ResourceDemands([#startDate#], [#endDate#])

ResourceDemands Parameters:
l startDate - (Optional) The date on which to begin counting demands.
l endDate - (Optional) The date on which to stop counting demands.

ResourceDe-
mandsForPool

Returns all of a pro-
ject's resource
demands for a spe-
cified pool.

If dates are included,
the sum is for demand
between the start and
end dates.

The
ResourceDemandsFo
rPool function is not
supported in Accolade
Portfolio Optimizer.

ResourceDe-
mandsForPool(5,
#4/1/2014#, #7/1/2014#)

Sum of
demands on
the specified
pool between
the specified
dates

ResourceDemandsForPool Format: ResourceDemandsForPool(poolID, [#startDate#,
#endDate#])

ResourceDemandsForPool Parameters:
l poolID - The ID of the pool to calculate demands on. You can view the ID in a report on the
RV_ResourcePools view.

l startDate - (Optional) The date on which to begin counting demands.
l endDate - (Optional) The date on which to stop counting demands.

ResourceDe-
mandsForUOM

Returns all of this pro-
ject's demands that
have the specified unit
of measure.

The
ResourceDemandsFo
rUOM function is not
supported in Accolade
Portfolio Optimizer.

ResourceDe-
mandsForUOM('FTE',
#4/1/2014#, #7/1/2014#)

Sum of
demands on
the pools with
the specified
UOM
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ResourceDemandsForUOM Format: ResourceDemandsForUOM('Unit of Measure',
[#startDate#, #endDate#])

ResourceDemandsForUOM Parameters:
l Unit of Measure - The unit of measure of the pools to include.
l startDate - (Optional) The date on which to begin counting demands.
l endDate - (Optional) The date on which to stop counting demands.

Round Rounds a value to the
nearest integer or spe-
cified number of
decimal places.

Round(3.257, 2) 3.26

RTrim Removes trailing
spaces from a string.

RTrim
({*METRIC:myString*})

A string without
trailing spaces

RowValue Returns a value in the
matrix column spe-
cified by the defined
offset parameter.

This function allows
you to prorate across
a matrix to identify
values in certain cells.

This is a self-
referencing function
that can only be used
in matrices.

RowValue(-
1,'mxYear2financials')

The value in the
cell prior to the
'mxYear2fin-
ancials' column
to which the
metric is
applied.

RowValue Format: RowValue('Offset', 'ColumnSystemName')

RowValue Parameters:
l Offset - An integer less than 0. Any negative value indicates the number of rows above
the current row to retrieve a value from. For example, if the formula is being evaluated for
row 4, and you need the value in row 3, use -1 as the offset value. Used to propagate
down a matrix column or across a row in inter-row dependencies. To reference the
current row, use a matrix metric token.

l Column System Name - The system name of the matrix column containing the cell to
reference.

These parameters cannot be nested functions or use substitution tokens.

Search Returns how far from
the start of a string a
contained string was
found. Case insens-

Search('blue', 'An attract-
ive Aqua Blue dye', 5,
30).

20
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itive.

Search Format: Search('findString', 'withinString', [startIndex, length])

Search Parameters:
l findString - The string to find.
l withinString - The string in which to search for the findString.
l startIndex - (Optional) Number of characters from the beginning of withinString to start
searching. Minimum value is 1.

l length - (Optional) Number of characters from the startIndex to search.

SecurityList Returns either the
security list value dis-
play name or the
security list value sys-
tem name at a spe-
cified level in the list.

SecurityList(1,3,2,2) Returns the first
two security list
display names
in the second
level of security
list three.

SecurityList Format: SecurityList(returnValueType,listNumber,listLevel,maxReturnCount)

SecurityList Parameters:
l returnValueType - Either 1 to return the security list display name, or 2 to return the
security list system name.

l listNumber - The security list to use. Acceptable values are 1, 2, 3, 4, or 5. The number
entered must correspond to an existing security list. For example, if your system
configuration only uses three security lists, acceptable values are 1, 2, or 3.

l listLevel - The level in the security list tree to return values from. If the returned value
exceeds 500 characters, the returned value includes as many complete security list level
names that fit within 500 characters. This cannot be a substitution token.

l maxReturnCount - The number of values to return in a delimited string, if more than one
value is found in the security list and level specified. A maximum of 500 characters is
returned. Only full security list level names are returned.

Additional SecurityList Examples:



Function Description Example Result

   ALL Locations
       Europe
            France
                  Paris
                  Lille
            England
                  London
                  Birmingham
       North America
            Canada
                  Montreal
                  Calgary
            USA
                  Denver
                  Houston

Using the security list defined above, for a project that is assigned Europe, Paris, and USA:
l SecurityList(1,1,2,2) - Returns Europe|North America
l SecurityList(1,1,3,2) - Returns France|USA

Sign Returns a value indic-
ating the sign of a num-
ber.

Sign(-13) -1

Sin Returns the sine of the
specified angle.

Sin(0) 0

Sqrt Returns the square
root of a specified num-
ber.

Sqrt(4) 2

SubString Returns a string begin-
ning a specified dis-
tance from the start of
the string that contains
it.

SubString('My Blue
Heaven', 4, 10)

Blue Heaven

SubString Format: SubString(withinString, startIndex, [length])

SubString Parameters:
l withinString - The string that contains the substring.
l startIndex - Number of characters from the beginning of withinString that the substring
begins. Minimum value is 1.

l length - (Optional) Number of characters to include in the returned substring. If not
present, returns all characters after start index.

Sum Totals the returned val- Sum(1, 5, 6) 12



Function Description Example Result

ues.

SysProjectID Returns the system ID
of the reference pro-
ject.

SysProjectID()

Tan Returns the tangent of
the specified angle.

Tan(0) 0

TeamMember Returns a teammem-
ber's name, function,
email address, or user
login.

TeamMember
(2,'FinanceLeader',3)

The teammem-
ber's name that
is assigned to
the Finance
Leader function
in the project.

TeamMember Format: TeamMember(lookupMethod,'lookupValue',returnValueType)

TeamMember Parameters:
l lookupMethod - The method used to match a teammember to return. 1: row Index, 2:
function system name.

l lookupValue - The value of the index or function you want to use to find the teammember.
If the lookupMethod is set to 1, enter an integer number representing the row in a list of
teammembers arranged in alphabetic order by teammember first name. Any functions
without a teammember assigned are sorted to the top of the list, and assigned team
members follow in alphabetical order. Therefore, the returned teammember could be
None, indicating no teammember is assigned at that row. If the lookupMethod is set to 2,
enter the function system name to return the value for the primary teammember for that
function. If no primary user is associated to the function, no value is returned.

l returnValueType - The information to return for the matched teammember. 1: Function
Name, 2: Email, 3: Name, 4: User Login.

Additional TeamMember Examples:
l TeamMember(1,3,3) - Returns the name of the teammember that is listed in the third
from of an alphabetical list of teammembers. If the third row is a function with no leader,
no name is returned. Note that the lookupValue does not have to be in enclosed in single
quotes when looking up by row index.

Trim Removes all spaces
from a string except
for single spaces
between words.

Trim
({*METRIC:myString*})

A string without
leading or trail-
ing spaces

Truncate Returns the integral
part of a number.

Truncate(1.7) 1

Upper Returns a text string
with all upper case.

Upper('Hello') HELLO



Custom Format for Number Metrics

A custom number format specifies how a number metric displays in an Accolade field code in a Word or
PowerPoint document, or in quick grids.

Metric values in Accolade or in Excel documents are not affected. Excel has its own number formatting
capabilities. Set the number format of the cell in which a field code applies to format numbers in
Accolade fields in Excel. For information about formatting numbers in an Excel document, see the Excel
online Help.

A metric with a custom number format that is attached to a quick grid will only use that format if the grid
cell is read only.

A custom number format creates masks or patterns that show how numbers display. If a user enters a
number in Accolade that differs from the pattern, the value displays according to the pattern. For
example, if a user enters 89.453 in a metric with the custom number format ##.##, the number displays
in Word as 89.45. The actual value, as entered and stored in Accolade remains the same.

To create a custom number format, use the guidelines and examples in the table below and enter the
format in the Number Format field when defining a number metric. Number metrics without a custom
format display exactly as they are stored in Accolade.

Use the following rules and guidelines to build a custom number format.

Characters, Notes, and Examples

To display significant digits
but not insignificant zeroes.

Character: #
For example: #.## displays the following:

6.357 as 6.36
125.3 as 125.3
125.300 as 125.3
0.678 as .68

To display insignificant
zeroes if a number has fewer
digits than there are zeroes
in the format.

Character: 0
For example: 00.000 displays the following:

.62 as 00.620
6.03 as 06.030
125.72000 as 125.720

Trailing zero formatting is only applicable to Portfolio Optimizer,
project history, and smart documents.

To mark the location of the
decimal placeholder.

Character: . (period)
Enter a period for the decimal placeholder even if you are
working in a region that uses a different symbol. Each user's
computer displays the symbol appropriate to their selected
region.

To place the location of the
thousands separator

Character: , (comma)
For example: #,### displays the following:



Characters, Notes, and Examples

1234 as 1,234
1234.56 as 1,235
1,234 as 1,234

Enter a comma as the thousands separator even if you are
working in a region that uses a different symbol. Each user's
computer displays the symbol appropriate to their selected
region.

To add standard text to the
number format

Character: 'text"'
Enclose the text in single quotation marks. Precede the
currency value with a variety of currency symbols or add text.

For example: #.00 'dollars' displays 17 as 17.00 dollars.
To add supported single
characters

Characters: $ + ( ) : ^ ' { } < > = - / ! & ~ (and the space
character)

Add these characters before or after the number format without
using double quotes.

For example: $#,###.## displays 1234.56 as $1,234.56
To add a single characters Character: \

Insert single characters, with some exceptions, preceding the
character with a backslash (\). Excluded characters include date
and time formatting characters (d, t, h, m, etc.), numeric
formatting characters described above (#, 0, comma, period,
etc.) and string formatting characters (@, &, <, >, and !).

To display a percentage Character: %
Enter % as the final character in the format. The value is
multiplied by 100, and then the formatting rules (for # and 0,
etc.) are applied.

For example: #.0% displays the following:

0.4567 as 45.6%
0.45 as 45.0%
1.453 as 145.3%

#.##% displays the following:

0.45678 as 45.68%
0.45 as 45%
0.456 as 45.6%

Building a Number Format with Multiple Sections

A number format can have up to three sections, separated by semi-colons.

l A one section format applies to all values. For example, $#,###.## displays positive and negative
values the same way.



l In a two-section format, the first section is for positive values and zeroes, and the second section
is for negative values. For example, $#,###.##; ($#,###.##) displays 16.50 as $16.50 and -16.50
as ($16.50).

l In a three-section format, the first section applies to positive values, the second to negative
values, and the third to zeros. For example: $#,###.##;($#,###.##);0.00 displays zero as 0.00. In
order to prevent a zero from appearing, place a single # in the third section.

Financial Data Metrics

Financial data metrics display metric values corresponding to a project's financial information, and are
typically used to assess the financial state of a project. To view the financial data metrics, navigate to
the System > Content Sources > Metrics page, click on the Category drop-down and select Core
Cash Flow.

In Accolade, financial data metrics are system generated, and hence, do not need to be created anew
and cannot be deleted. However, if required, these metrics' field information can be edited, with the
exception of the System Name and Data Type fields.

Note: All system generated metrics begin with a tilde (~).

Additionally, when a project is integrated with Acclaim Projects, actual and planned costs are sent back
and forth between the two applications. This allows the volumes of financial information stored in
Acclaim Projects to be subtotaled and sent to Accolade daily, where it can be rolled up into a single line
to make it easy to see monthly totals.

Note: Acclaim Projects is an optional Accolade component that you may not have access to.
To implement this solution, contact Sopheon Customer Support.

Tracking Metric Change History

For historical and tracking purposes, select metrics to track their history including when a metric value
changed, who made the change, where the change was made, and the value of the metric before and
after the change. Metric history is available for reporting purposes.

Important! Tracking metric history has the potential to create a large amount of history
information. Consider carefully which metrics require history tracking, and track only those
you need for historical purposes.

To set a metric for tracking history:

1. Create a metric.

2. Select the Track History check box.

3. Click Apply to save your changes.



Metric History Reporting

Metric history is available for reporting using theMetric Change History column set available in the
Projects subject in Accolade Online Reporting and in the functionality available in the Accolade Office
Extensions add-in. Use the columns available in the Trended Metric History column set available in
the Projects subject to trend metric values as gate decisions and project migration events occur. To
trend metric history for other system events, contact Sopheon Customer Support.

The columns available in the Trended Metric History column set provide the ID of the stage within a
project where the update was made. Stage IDs correspond to the placement of the stage in the Phase
Gate sequence in the project. For example, a Stage ID 1 indicates the first stage; 2 indicates the stage
pair that follows the first gate, and so on. Using a Stage ID column in the report provides insight into a
metric value at a particular stage in the project without having to map a date to a stage duration.

See "Creating Online Reports within Accolade" on page 272 and "Projects Subject" on page 672 for
information about creating a report and the columns available within the Projects subject to create a
trended view.

Capturing Large Data Strings in Accolade

Accolade provides the following ways to capture large pieces of data as free-form text within a project.

Long String Metrics

Long string metrics act the same as String metrics, but have a 2 GB data limit if Rich Text is enabled or a
2000 character limit if Rich Text is not enabled. Long String metrics can provide data and status and are
available for inclusion in forms, reports, templates, matrices, quick grids, and other places within the
application.

These metrics can contain rich text formatting to format text with elements such as bold, italics, and into
lists. Like other metrics, these metrics can be associated with a process model for display and updating
within a project, and be included in quick grids added to deliverables and activities.

Extended Project Data Fields

To capture data strings that exceed 2000 characters in length, enable one or more Extended Project
Data fields within the metadata in a process model. These fields are available to add to forms, reports,
templates, quick grids, and other places within the application. However, they are not available to a
matrix, matrix grid, or reference table. Use these fields for areas where you require additional
characters, such as an extended description or as part of a layout for an idea campaign.

Process Designers enable and name the Extended Project Data fields in each process model. Each
process model can have up to ten fields enabled, and each has a configurable display name and the
ability to set where the field is available and editable in a project.

As you implement Extended Project Data fields in templates and other places, understand that a large
number of fields with a large amount of data in a project can affect system performance when loading
and saving information. In addition, external applications (such as Word or Excel) and network
configurations may have their own size limits as well.

Securing Metrics by User Role



Your company may have confidential metrics, such as those that contain financial data, which you want
to keep secure, and ensure are only available to authorized users. Securing metrics allows you to
create metrics that are only visible to a specific set of user roles.

Consider the following when assigning user role visibility settings to metrics:

l If multiple roles are assigned to a metric, a user only needs one of the assigned roles to access
the metric.

l If a user does not have one of the assigned roles, the metric is hidden from any place it displays
within Accolade. For example project pages, status reports, quick grids, Planning views, and
Portfolio Optimizer. Consider using a combination of metrics restricted by user role and
deliverables restricted by user role to achieve the correct level of security within a project.

l If a user does not have one of the assigned roles and the metric is included in a report created
with the Accolade Office Extensions add-in or in Accolade Online Reporting, the metric value in
the report is blank. However, the metric value is available in reports created using Dashboards
for Accolade.

l If a metric is set as required on project creation, ensure that Process Managers are granted
visibility to the metric. Without visibility, the Process Manager is unable to create projects using
features that contain the required metric.

l Ensure metrics that are set to edit within a project are visible to the user roles that needs to
update those values.

To secure a metric by user role:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the metric list, search by the metric name, system name, or category.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page.

l To edit an existing metric - Click the name of the metric to open it for editing.

l To create a metric based on an existing metric - Click in the Copy column to create a
copy that can be used as a base to build a new metric.

3. Create any metric type.

4. In the Restrict to These Roles field, select the user roles that have visibility to the metric.

To leave the metric open to all user rules, leave all user roles unchecked or check all the user
roles.

5. Click Apply to save your changes.

Notes:
l If a quick grid is set to create and publish PDF versions and also contains secured
metrics, the PDF versions display the metrics regardless of the security settings. That is,



the generated PDFs do not respect metric security and can be viewed by users who may
not have the user roles to view specific metrics. Do not select Publish PDF in the quick
grid configuration if you want to ensure the security of certain metrics. See "Creating
Quick Grids" on page 173 for more information.

Scheduling Metric Calculations

To ensure metrics calculate and to prevent unnecessary recalculations, Process Designers have the
ability to assign events to define when and how often a metric will calculate. Assigning a metric to
calculate at a scheduled occurrence or a project event limits disruption to the system and minimizes
data buildup of metrics recalculated during other Accolade actions. While metrics may be assigned to
multiple events or occurrences be cautious when configuring metrics to prevent duplicating
calculations. Additionally, if metrics are assigned to calculate on any associated change, the metrics will
recalculate on specific actions or linked updates.

The procedure below describes how to assign metrics to calculate at a specific time or event. For
information about calculated metrics see "Creating Metrics Using Expressions (Calculated Metrics)" on
page 135.

To assign a metric calculation event:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the metric list, search by the metric name, system name, or category.

2. Do one of the following:

l To add a new metric - Click Add New in the upper right corner of the page.

l To edit an existing metric - Click the name of the metric to open it for editing.

l To create a metric based on an existing metric - Click in the Copy column to create a
copy that can be used as a base to build a new metric.

3. Create the basic metric and click the Calculated Formula and Events tab.

4. Select any of the following to set when calculations occur:

l Calculate on any associated change.

l On project events.More...

Event Description

Create Set a metric to calculate when a project is created in
Innovation Planning, a layout, from the Workspace menu
Add New, WebAPI, and Idea Submission.

Ensure metrics scheduled to calculate only on project
create do not reference team leader metadata if the default
project manager metric is set.



Event Description

Migrate Set a metric to calculate when a project migrates.

The calculation occurs on the original project at the time of
migration before the project is closed.

Re-Open Set a metric to calculate when a project that was previously
closed is reopened.

If a model has changed while the project was closed, a
metric may not calculate correctly when the project is active
again.

Close Set a metric to calculate when a project closes to ensure
metric values are finalized.

Once a project is closed metrics will not calculate again.
Phase Change Set a metric to calculate when a project moves forward or

backwards in phases. Project phases move forward when a
gate decision is set to Go or Conditional Go.

Project create does not constitute a phase change for
scheduled metric calculations.

Project complete constitutes a phase change for scheduled
metric calculations. When the final gate has been set to Go,
the scheduled phase change metric will recalculate.

l Schedule date and time events.More...

All dates and times are configured and based on the local time of the application server.

Event Description

Daily Schedule a metric to calculate at a specified time each day.

Consider the quantity of metrics selected to calculate daily.
Monthly Schedule a metric to calculate at the same time of day, on

the same day of each month.
End of Month Schedule a metric to calculate at the same time each

month.

The end of month date dynamically changes based on the
date each month falls on. For example, a metric will
calculate on March 31st and April 30th, as April 31st would
be invalid.

Quarterly Schedule a metric to calculate at the same time every three
months from a specified month.

Yearly Schedule a metric to calculate annually on the same date
and time.

5. Click Create to create the new metric or Apply to save changes to an existing metric.



Notes:
l More than one occurrence or event may be assigned to a single metric.

l Due to the disruption calculations may have to the system, schedule time intervals to
occur when traffic on the server is minimal.

l If a metric is assigned to calculate on project migrate and project close, the metric will only
calculate once.

Removing and Deactivating Metrics

As your company's needs for metrics change over time, Process Designers and Administrators can
remove or deactivate metrics that are no longer required for projects at your company. You can remove
metrics from projects while retaining their history, deactivate a metric, or remove a metric completely
from Accolade, which also removes any data associated with the metric.

For more information, see How Changing Process Models Affects Open and
Closed Projects to understand what changes are applied to open and closed
projects.

Removing Metrics from Projects While Retaining History

If you have a metric that is no longer in use but whose value and project history is important to retain,
hide the metric from displaying anywhere in the project where it could be confused as still being in use.

Important! If you want to retain the value and project history, do not deactivate the metric by
deleting it from the process model or by deleting the metric from Accolade.

To remove a metric from a project while retaining its value and project history:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the process model list, search by the process model name, system name, or class.

2. Click the name of the metric to open it for editing.

3. For each process model in the Models section, clear the drop-downs for each area of the project
so neither Edit nor Show display.

4. Click Apply to save your changes.

Deactivating Metrics

If you have a metric that is not ready for use in configuration or is not currently in use, you can deactivate
the metric. Deactivating the metric keeps the metric in Accolade and also maintains project history. 

Important! You can only deactivate metrics that are not in use on any process model,
including deleted models that still have projects associated with it. If you remove a metric
from a process model, its value and project history are removed from open projects, and the
metric is removed from any location where it displays in both open and closed projects.

../../../../../Content/ProcessFlow/Models/CON_HowChangingProcessModelsAffectsProjects.htm
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Metric values that were set in closed projects remain in Accolade and are available for
reporting purposes.

Do one of the following to determine if a metric is in use on a model:

l For active and inactive models - From the Systemmenu, select Content Sources > Metrics.
Click the name of the metric you want to deactivate and view theModels list. The models that
contain the metric display.

l For deleted models with associated projects - From theWorkspacemenu, select Charts &
Reports. Click Add New and create an online report that contains the following configuration:

l Columns - From the Models subject, add theModel Name,Model Deleted,Metric
Display Name, andMetric System Name columns. You can add additional columns to the
report, as necessary.

l Filters - Create a filter on theMetric Display Name orMetric System Name columns.

For example, to search for the Comments - R&Dmetric, create a filter that contains the
word "comments" or "R&D" to return a list of models that contain that specific metric. You
can also create a filter on theModel Deleted column to return only information about
metrics on deleted models.

To deactivate a metric:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the process model list, search by the process model name, system name, or class.

2. Click the name of the metric to open it for editing.

3. Clear the Active check box.

4. Click Apply to save your changes.

Removing Metrics Completely from Accolade

If a metric is no longer in use and the project history is no longer required, you can remove the metric
completely from Accolade.

Important!When a metric is deleted from Accolade, any project data associated with the
metric is also deleted.

To remove a metric from Accolade:

1. From the Systemmenu, select Content Sources > Metrics.

To narrow the process model list, search by the process model name, system name, or class.

2. Click the name of the metric to open it for editing.

3. Click Delete.



Notes:
l You cannot delete a system-generated metric or matrix metric.

l If deactivated and removed metrics are part of deliverables and activity conditions,
disable the condition and remove the condition assignment.

l Removing a metric that is included in reports prevents the data from refreshing. A report
with a deleted metric cannot be updated until the invalid metric is removed.

Matrices for Project Data Analysis Overview
Amatrix is a collection of metrics intended to model complex relationships between different data types.
For example, a matrix could show how several aspects of project performance change over time.
Matrices show how one or more metrics changes or is expected to change in relationship to changes in
critical factors such as time or location. A matrix can also be a project management tool. For example, to
assign action items to members of a project.

Administrators or Process Designers create metrics, flag them as being available to a matrix, and define
matrices. Process Designers assign matrices to deliverables or activities in process models. Project
Managers and document owners have access to matrices within projects through an MS Excel template
or on a grid within a deliverable or activity.

Combination Matrices

Amatrix added with a Smart Excel template is available to any quick grid that is associated with that
matrix in the project. That is, a Smart Excel template on one deliverable could be used to populate a set
of rows in the matrix in a quick grid in a different deliverable.

Filterable Matrices

You can create filterable matrices that are associated with multiple documents in the same project,
allowing multiple users to work on the same matrix without overwriting each other's entries. Using matrix
metric filters in deliverables and activities within a model, you can:

l Delegate the completion of a matrix to multiple teammembers through separate deliverables
and activities within a model.

l Set only portions of a matrix for viewing or editing.

l Provide additional safeguards against unintended matrix data updates.

Creating Matrices

Create a collection of metrics that allows users to track one project's metrics values through time or to
create other types of complex comparisons of a project's metrics.

To create a matrix:

1. From the Systemmenu, select Content Sources > Matrices.

To narrow the matrix list, search by the matrix name, system name, or category.



2. Do one of the following:

l To add a new matrix - Click Add New in the upper right corner of the page.

l To edit an existing matrix - Click the name of the matrix to open it for editing.

3. Complete the following to identify and describe the matrix:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Display Name Enter a name, up to 64 characters long, which identifies the
matrix.

System Name Enter a unique, shorter name that identifies the matrix in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among reference tables and can
contain only letters (English alphabet), numbers, and the
underscore.

Category Enter or select the group to which this matrix belongs.More...

Use categories to organize like matrices together. For
example, you may choose to group all the matrices used for
financials into the same category, in order to separate them
frommatrices used for other purposes.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the matrix. This
description helps other users identify the matrix throughout the
system.

Order Enter a number to specify the matrix's place when it displays in
a list of matrices. Lower numbered matrices display higher in
the list.

Active Select the check box when the matrix is ready to use in
projects.

Available to
Business Intelligence
Tools

Select this check box to enable the matrix for use in your
organization's business intelligence application.

If the matrix is selected for inclusion in a portfolio
snapshot, you cannot clear this option.

Rich text matrix metrics cannot be made available to Business
Intelligence Tools.



Field Description

Available to Reporting Select this check box to enable the matrix for use in reports
created using the Accolade Office Extensions add-in,
Accolade online reports, and within snapshots.

If the matrix is selected for inclusion in a portfolio
snapshot, you cannot clear this option.

If a matrix is made available to reporting, refer to the Included
in Reporting column in the Associated Metrics section to
see the included metrics. Rich text matrix metrics cannot be
made available to reporting.

Portfolio Optimizer Select one of the following to indicate the matrix availability
within Portfolio Optimizer. The selections in this field are
available only if one of the metrics in the matrix is set as
unique.
l Not Available - Not available in Portfolio Optimizer.
l Reporting Only - Can be included in reports but is not
visible in Portfolio Optimizer. This option allows you to
create matrices for reporting without having to add them to
the list of available columns in Portfolio Optimizer.

l Edit - Visible and fully available in Portfolio Optimizer.

4. In the Associated Metrics section, select the metrics to include in the matrix.

Click Add New to search for metrics to add to the matrix. Only metrics set to be available in a
matrix are available in theMetrics field. To filter the metric list, select a name in the Name field
and category in the Category field.

To define a new metric while building a matrix, select Add New Metric in the
Metric field. To reorder metrics after you have added them to the matrix, click a
row in the Associated Metrics section and drag it up or down to its new location.

5. Repeat step 4 as necessary to add additional metrics to the matrix.

6. Do the following for each metric, as appropriate for the matrix:

l To indicate that a metric should have a unique value in each row - Select the Unique
check box to enforce unique values for each metric contained in the matrix. Metrics correlate
to columns in Excel templates, and unique metrics ensure columns are not duplicated in the
workbook. If a matrix is set to edit in Portfolio Optimizer or Innovation Planning, only one
relative date metric can be set as unique. For Portfolio Optimizer matrices, also indicate the
order in which the unique metrics display from left to right in the Portfolio Column Header
field.

Multi-select lists and calculated metrics within the matrix cannot be set as unique.

If using the calculated metric expression CurrentMatrixValue in a matrix and updating the
matrix in Excel, you must uniquely identify other matrix rows by flagging metrics as unique. If



matrix columns are not unique or the Excel workbook contains duplicate columns, the Smart
Excel template does not update, upload, or publish back to Accolade.

l To indicate a metric as a filter for the matrix within a model - Select the Filterable check
box if the metric is a filter for a matrix to specify which rows of the matrix are editable or
displayed in a deliverable or activity. Making a metric filterable in a matrix makes it possible for
different document owners to edit different parts of the matrix based on the content of the filter
metric. Multiple metrics in the matrix can be filterable. This option is only available for List type
metrics.

7. Click Apply to save your changes.

8. (Optional) Follow the instructions listed in "Restricting Configuration for Matrices" on page 36 to
configure access group restrictions.

9. (Optional) Click Process Model Usage on the Security tab to see the list of process models
that the matrix is associated with. The list includes all process models the matrix is included in, as
well as links to the process model's component tree pages you have Edit access to.

Notes:
l To delete a matrix, display the matrix and click Delete. Take caution when deleting
matrices, as the data saved within those matrices, such as the system-generated Voting
Matrix or data in existing portfolio snapshots, is deleted with it.

l To delete a metric from a matrix, display the matrix and click next to the metric in the
Associated Metrics section.

l Accolade Portfolio Optimizer is an optional Accolade component that you may not have
access to. To implement this solution, contact Sopheon Customer Support.

l The Included in Reporting and Included in Snapshots columns in the Associated
Metrics section are read only.

Creating Matrices for Multiple Owners

Create a matrix that more than one person can work on without overwriting changes from other users.
The matrix is assigned as the template of more than one deliverable or activity, and each document is
filtered so that its owner can only upload edits on part of the matrix.

This process can also be used to create a matrix for a single owner in multiple stages.

To create a matrix for multiple owners:

1. Create a matrix with one or more filter metrics along with the metrics that contain the data to be
updated.

The filter metrics specify which parts of the matrix a given user can modify. Filter metrics can be
either list type or multi-select list type, and the list can be either entered manually or selected by
query. Select at least one Filterable check box on the Matrix page to enable that metric to filter
the matrix it is in.



2. Setup a Smart Excel document template to update a matrix.

3. Associate the matrix with the models that contain the deliverables or activities to update.

Select the same matrix template for all the documents that are used to update the matrix.

4. In the deliverable and activity definitions within the model, assign the metric filters for the matrix.

The filtering options allow document owners to update only the rows that contain a specific value
in the filter metric. One of the filtering options allows the owner to see all of the matrix while the
other allows the owner to see only the rows they can update.

Since each document is intended for a different member of the project team, it
would can be helpful to indicate in the document name or description what content
is editable within the matrix.

Notes:
l The Project Manager and Process Managers with Manage Process rights can change the
filtering options for deliverables and activities within in the project, and the deliverable
owner can change them for a deliverable's activities.

Creating Matrices for Use in Portfolio Optimizer

Create a collection of metrics to track a project's metrics values through time or to create other types of
complex comparisons of a project's metrics. For example, create a matrix to track the sales and costs of
a project across quarters or years. Portfolio Managers can then use Accolade Portfolio Optimizer to
view, filter, and chart matrix information across multiple projects at once. The matrix values are viewable
as columns (similar to metric values) in Portfolio Optimizer, for projects in a portfolio or in a scenario.

Verify your matrices as you create them, and existing matrices prior to enabling them for Portfolio
Optimizer, to ensure that a manageable number of columns are available within Portfolio Optimizer.

Important! Deleting metrics from a matrix that is in use in Portfolio Optimizer causes the
loss of scenario data based within that matrix. Use careful consideration prior to deleting
metrics from matrices, and matrices that are set as Available to Portfolio Optimizer.

To create a matrix for use in Portfolio Optimizer:

1. Create a matrix and ensure that the configuration meets following requirements:

l At least one metric within the matrix is set as Unique. If more than one metric is set as unique,
also indicate the order in which the unique metrics display from left to right in the Portfolio
Header Column field.

l The Available to Portfolio Optimizer option in the Portfolio Optimizer section is set to Edit.
This field is only enabled if a metric is marked as unique.

2. (Optional) To limit the metrics based on the matrix that are available in Portfolio Optimizer, select
the Filterable option for one or more list metrics. In theOnly Include Rows That Match field in

PROC_AssociatingMatricesToModels.htm
PROC_AssigningMatrixMetricFiltersToDelAndActInModels.htm
POPUP_ManagementRights.htm


the Portfolio Optimizer section, select which list item values to include when the matrix is
converted to metrics in Portfolio Optimizer.

3. Save the matrix and apply it to a deliverables as necessary using a Smart Excel template or a
quick grid.

Notes:
l Amatrix available to Portfolio Optimizer can have only one unique relative date metric.

l Multi-select list metrics cannot be set as unique.

l Rich text metrics are not available in Portfolio Optimizer.

l Accolade Portfolio Optimizer is an optional Accolade component that you may not have
access to. To implement this solution, contact Sopheon Customer Support.
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Quick Grids for Data Collection Overview
A quick grid is a collection of one or more customizable grids that is associated with a
deliverable or activity that provides another location to enter information during a project.
Quick grids are added to deliverables and activities in a process model, in much the same way
as a template.

Adding the appropriate metrics and other data collection points to a grid allows the assigned
deliverable or activity owner to conveniently manage the metrics and data collection directly on
the screen, without having to download a template, update the document and save the results
to Accolade. Quick grids also allow other members of the project to view the specific metrics
and data associated with each deliverable or activity in a read-only version of the grid.

A quick grid can contain one or more of the following grid types:

l Standard Grid - Standard grid that includes metrics to update and other components
such as buttons and fields to enter text.

l Matrix Grid - Matrix grids include columns of an existing matrix, rather than a cell-by-
cell grid definition and allow deliverable and activity owners to add additional rows to the
grid as necessary.

Process Designers associate quick grids to deliverables and activities in a process model. Any
metrics referenced within the quick grid, and the matrices in matrix grids, are associated
automatically with the model when the grid is added to a deliverable or activity. Quick grids are
only editable during the current project stage. It may require detailed planning to ensure the
necessary metrics can continue to be managed in quick grids throughout the project.

Creating Quick Grids

Administrators and Process Designers with the Template Access role can create quick grids
that Process Designers can add to deliverables and activities within a model. From there,
deliverable and activity owners can enter and track information directly within a deliverable or
activity in a project.

To create a quick grid:

1. From the Systemmenu, select Page Design > Quick Grids.

To narrow the quick grid list, search by the quick grid name, system name, or category.

2. Do one of the following:

l To add a new quick grid - Click Add New in the upper right corner of the page.

l To edit an existing quick grid - Click the name of the quick grid to open it for
editing.

l To create a quick grid based on an existing quick grid - Click in the Copy
column to create a copy that can be used as a base to build a new quick grid.
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l The access groups of the copied quick grid depend on the access groups of the
user and the access groups of the quick grid being copied.

l If the user has edit permission to one or more of the access groups of the quick
grid being copied, the result of that copy will have the access groups that both the
user can edit and the quick grid is a member of.

l If the user does not have edit permission for any access groups of the quick grid
being copied, the new quick grid will have the highest access group for which the
user has edit access. For more information, see "Designing the Access Group
Hierarchy" on page 25.

3. (Optional) - Select the Protected Quick Grid check box to prevent grid designers from
being able to open and modify the grid in Accolade when grid protection is turned on.
More...

The Enable Quick Grids Protected Mode parameter must be set at 1 and the check
box for the appropriate quick grid must be selected for the quick grid to be protected. To
edit a protected quick grid, Accolade Administrators must set the parameter back to 0.

4. (Optional) - Select the Create PDF check box to generate a PDF of the quick grid
contents associated to deliverables, activities, or layouts.More...

The quick grid automatically creates new, separate PDF versions every time a user
modifies and saves the quick grid. PDF versions of quick grids associated to
deliverables or activities automatically save as a deliverable or activity version. When a
quick grid is embedded in a page layout pod and displays as a project page, the PDF
version saves in the project's Related Docs page.

5. (Optional) - Select the Publish PDF check box to have PDFs of quick grids associated
with deliverables, activities, and layouts published throughout Accolade. This check box
is only available if you selected to create PDF versions above.More...

Publishing the PDF versions of quick grids allows project teammembers to search for
the PDF in Accolade. Unpublished versions do not display to users outside of the
project to which the quick grid is associated. This check box might already be checked if
the Default to New Versions system parameter is enabled. Deselecting the check box
overrides the parameter setting for the grid.

Important! If a quick grid is set to create and publish PDF versions and also
contains secured metrics, the PDF versions display the metrics regardless of the
security settings. That is, the generated PDFs do not respect metric security and
can be viewed by users who may not have the user roles to view specific metrics.
Do not select Publish PDF in the quick grid configuration if you want to ensure the
security of certain metrics.

6. Select the Active check box when the grid is ready to use in projects.

Leave this check box clear until you have completed the design of the grid.

174



Administrator's Guide

Sopheon Accolade Version 16.2

7. Complete the following information to identify and describe the grid:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which
identifies the quick grid.

System Name Enter a unique, shorter name that identifies the quick
grid in queries, reporting views, Accolade Office
Extensions, field codes, and other places in Accolade.

The name must be unique among quick grids and can
contain only letters (English alphabet), numbers, and
the underscore.

Description Enter a description of the purpose or nature of the
quick grid.

This description helps other users identify the grid
throughout the system.

Click and drag the lower left corner of the
Description field to view text appropriately.

Category Enter or select the category to which this quick grid
belongs.

Leave this field blank to add the quick grid to the
Default category. Use categories to organize like
grids together. For example, if there are a large
number of grids assigned to add to a deliverable that
collects financial analysis, a Process Designer can
use a category selection to locate the finance grids
when designing and creating models.

Configuration Access
Groups

Select the access groups to which the quick grid
belongs. Process Designers with matching
permissions will be able to edit and view quick grid or
the data within its grids. The access groups displayed
are based on the current user's access group
permissions and the access groups the quick grid
belongs to.

Process Model Usage Click the Process Model Usage button to see the list
of process models that the quick grid is associated
with. The list includes all process models the quick
grid is included in, as well as links to the process
model's component tree pages you have Edit access
to.
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8. Click Save in the lower right corner of the page to save changes, Save and Close to
save the configuration and close the editor, or Cancel to close the editor without saving
changes.

9. Continue with the following tasks, as necessary, to design the grid:

l "Designing Standard Grids" on page 176

l "Designing Matrix Grids" on page 177

l "Adding Software Controls and Metrics to Quick Grids" on page 177

l "Adding and Editing Quick Grid JavaScript Files" on page 180

l "Changing Grid and Cell Display Properties in Quick Grids" on page 181

Notes:

l To delete a quick grid, click in the Delete column. The grid is removed from
any process model and any deliverable or activity that uses the grid within a
project.

Designing Standard Grids

Add and configure one or more grids that combined make up a quick grid when added to a
deliverable or activity. Add multiple grids and matrix grids to a single quick grid. Standard grids
are built on a cell-by-cell basis and do not reference a matrix.

To create a new quick grid or to copy an existing grid, see "Creating Quick Grids" on page 173.

To design a standard grid:

1. From the Systemmenu, select Page Design > Quick Grids.

2. Create a new quick grid or open an existing quick grid.

3. Click the Drag to Design tab in the left panel of the Quick Grid Design dialog box.

4. Drag and drop [Grid] in the canvas.

5. Complete all required fields in the pop up dialog to set the initial grid design:

l Name - Enter the text that displays in the title bar when the quick grid displays in a
deliverable or activity. The title should provide enough information so deliverable and
activity owners can identify the grid.

l Rows - Enter the initial number of rows in the grid
l Columns - Enter the initial number of columns in the grid.

6. ClickOK to set the initial grid design.

7. (Optional) Drag and drop additional quick grids from the Drag to Design tab onto the
center canvas. Drag existing grids around the canvas to sort.
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8. Click Save in the lower right corner of the page to save changes, Save and Close to
save the configuration and close the editor, or Cancel to close the editor without saving
changes.

Designing Matrix Grids

Note: Users with the user roles listed to the right must also have the Template
Access user role.

Add a matrix grid in the quick grid design that contains some or all the columns of an existing
matrix. Matrix grids contain only two or three rows (depending on whether you choose to add a
totals row). Deliverable and activity owners can add additional rows to the grid, as necessary.

The right-most column in a matrix grid is added automatically and
contains a check box to allow deliverable and activity owners the option to
delete a row. Do not modify the control in these cells. You can add a
heading label and modify the shading of this column, as necessary.

To design a matrix grid:

1. From the Systemmenu, select Page Design > Quick Grids.

2. Create a new quick grid or open an existing quick grid.

3. Click the Drag to Design tab in the left panel of the Quick Grid Design dialog box.

4. Drag and drop [Matrix] in the canvas.

5. Complete all required fields in the pop up dialog to set the initial matrix grid design:

l Name - Enter the text that displays in the title bar when the quick grid displays in a
deliverable or activity. The name should provide enough information so deliverable
and activity owners can identify the grid.

l Category - Select the data category that populates the matrix grid.
l Matrix - Select the matrix this grid contains.

6. ClickOK to set the initial matrix grid design.

7. (Optional) Drag and drop additional quick grids from the Drag to Design tab onto the
center canvas. Drag existing grids around the canvas to sort.

8. Click Save in the lower right corner of the page to save changes, Save and Close to
save the configuration and close the editor, or Cancel to close the editor without saving
changes.

Adding Software Controls and Metrics to Quick Grids

Note: Users with the user roles listed to the right must also have the Template
Access user role.

To create a new quick grid or to copy an existing grid, see "Creating Quick Grids" on page 173.
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To add software controls and metrics to a quick grid:

1. From the Systemmenu, select Security & Groups > Quick Grids.

2. Click the name of the quick grid to open it for editing.

3. Click the Drag to Design tab in the left panel to display the data source options.

4. Indicate the data type to populate the grid cell by selecting eitherMetric orMetadata in
the Source Type field.

5. If you selectedMetric as the Source Type, select the appropriate metric category.

Metrics appear in the list if the user has "Can Edit" access to the metric,
the metric belongs to a child access group of the quick grid, or the metric
is already attached to the quick grid.

6. To add metrics and metadata to the grid, do any of the following.

l Drag and Drop - Drag a metric or metadata from the list in the left panel and drop it
into a grid cell. A control defaults based on the metric and metadata type.More...

Data Type Default Control

Metric String: Text Input

Number: Text Input

Long String: Multi-line Text Input

Multi-Select List: Paired List

List: Drop Down

Date: Date Selector
Metadata Project Name: Text Input, Text Label, or Multi-line Text Input

Project Description: Multi-line Text Box or Text Label

Idea Submitter Name: Text Input, Text Label, or Multi-line Text
Input

Idea Submitter Email: Text Input, Text Label, or Multi-line Text
Input

Extended Project Data 1-10: Multi-line Text Box

l Type Ahead - Type metric and metadata field codes directly into the grid cell. A
control defaults based on the metric or metadata. If the fast-entry input does not
match a valid metadata or metric field code, the control defaults to formatted text. For
a list of valid field codes, see "Accolade Field Codes and Substitution Tokens" on
page 771.

l Select a Control - Select a control type in the Properties tab on the right panel from
the Type field. Data type details populate and vary based on the selected control
type.
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7. Navigate to the Properties tab in the right panel and enter the following information to
further define or modify the data or control in the selected cell. Only certain fields
populate based on the control type selected.

For all control types, you must enter a unique system name, up to 64 characters long,
which identifies the cell across all grids in the Quick Grid editor.

Additionally, you can change the control for the selected cell from the Type field which
includes both the supported and unsupported controls associated with the metric or
metadata selected.

Note: Use custom number formats to specify how a number metric displays in an
Accolade field code in quick grid cells. Custom number formats only display
for Text Box (number) controls.

For more information on control types and necessary properties, see the online Help.

Note: Calculated metrics display as read-only within a quick grid. You cannot add
matrix metrics to non-matrix grids and the number format for matrix metrics is
not supported in Microsoft 365 applications.

8. Click Save in the lower right corner of the page to save changes, Save and Close to
save the configuration and close the editor, or Cancel to close the editor without saving
changes.

To add a new metric while designing a new quick grid:

1. Click New Metric located at the bottom of the Drag to Design tab.

2. Fill in the necessary information to create a new metric. Click in the right corner of
the dialog to learn more about "Creating Metrics" on page 117.

3. Click Create to add the new metric to the system. The new metric displays in the list of
metrics available to add to the grid.

4. Reference the table in Step 6 above to add the new metric to a quick grid.

5. Click Save in the lower right corner of the page to save changes, Save and Close to
save the configuration and close the editor, or Cancel to close the editor without saving
changes.

Notes:

l To delete cell contents, click the cell and click in the drop-down menu or
click the cell and press Delete.

l Metrics added to a quick grid do not need to be individually associated with
the grid's model. They are automatically added to the model when the
Process Designer adds the grid to a deliverable or activity within the model.
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l Controls within quick grids must have unique control system names when
using multiple quick grids and JavaScript functions. If a quick grid contains
duplicate control system names, the JavaScript function calls one at
random and may not operate as intended.

l The Enable Quick Grids Protected Mode parameter turns on and off grid
protection. To modify a protected grid, an Administrator must set the
parameter to 0.

Adding and Editing Quick Grid JavaScript Files

Using JavaScript, associate functions with cell events, such as on mouse over, within a quick
grid cell. Save the JavaScript functions used in quick grids in a JavaScript library file that is
saved for an individual grid if only one grid uses those functions, or at a global level if multiple
grids use the functions.

It may improve performance to put some functions only in the local file,
because if the global library file is large, it can affect the time it takes for
the deliverable in the project to load.

To add or edit a JavaScript library file for all grids:

1. From the Systemmenu, select Page Design > Quick Grids.

2. Do one of the following:

l To add an existing file - Click , select the JavaScript library file, and clickOpen.

l To edit an existing file or create a new file - Click to open the JavaScript
editor, write or update the code for the file directly in the editor, and click Save or
Save and Close.

To add or edit a JavaScript library file for an individual grid:

1. From the Systemmenu, select Page Design > Quick Grids.

2. Click the name of the quick grid to open it for editing.

The Enable Quick Grids Protected Mode parameter turns on and off
grid protection. To modify a protected grid, an Administrator must set the
parameter to 0.

3. In the JavaScript File field, do one of the following:

l To add an existing file - Click , select the JavaScript library file, and clickOpen.

l To edit an existing file or create a new file - Click to open the JavaScript
editor, write or update the code for the file directly in the editor, and click Save or
Save and Close.
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4. Click Save in the lower right corner of the page to save changes, Save and Close to
save the configuration and close the editor, or Cancel to close the editor without saving
changes.

Notes:
l To delete a JavaScript file associated with an individual quick grid, select the
quick grid to display its details. In the JavaScript File field, click andOK to
save changes.

l To delete a global JavaScript file, click at the top of the Quick Grids page.

Changing Grid and Cell Display Properties in Quick Grids

Note: Users with the user roles listed to the right must also have the Template
Access user role.

Once you have created the quick grid and populated it with data, alter the grid and cell
properties and appearance to help make them easier to navigate. For example, you may
choose a bold font for a totals row in a matrix grid.

Changing Grid Settings and Properties

Altering the appearance and layout of a quick grid allows you control of data and information
presentation. Quick grids are viewable in project deliverables and activities that various
Accolade users have access to view and edit, based on specific user roles. The procedure
below discusses options and functions for modifying a grid's structure and appearance.

To refine a grid structure, appearance, and functionality:

1. From the Systemmenu, select Page Design > Quick Grids.

2. Create a new quick grid or open an existing quick grid.

3. To add, delete, or move rows or columns click the number of the column or row header
to select the row or column and click the appropriate icon in the field.More...

- Add row above or below.

- Move row up or down.

- Delete grid row.

- Add column left or right.

- Move column left or right.

- Delete grid column.
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Matrix grids do not allow row functionality, meaning you cannot add,
delete, or move rows in a matrix grid. Additionally, merged cells disable
row functionality.

4. (Optional) To move a grid on the canvas, do one of the following:

l Click to the left of the grid header and drag it in the canvas.

l Click the grid header to select the entire grid and click either or in the drop-
down menu to move the grid.

5. Set the minimum or fixed height and width for grid rows and columns.

Click the corresponding column or row number to select it and navigate to the
Appearance tab in the right panel to modify. You cannot enable both minimum width
and fixed width for grid columns.

Field Description

Minimum
Width

Enter the minimum width of the column in pixels. The grid
column width adjusts according to the controls in the
cells; however it displays with a width no less than the
minimum set.

Fixed Width Enter the width of the column in pixels to have the
column display with a forced width, regardless of what
populates the cells.

Minimum
Height

Enter the minimum height of the row in pixels. The grid
row adjusts according to the controls and data that
populate the cells.

Fixed Height Enter the height of the row in pixels to have the row
display with a forced height, regardless of what
populates the cells.

6. Change what displays in the structure of the grid as necessary.

Click the grid header to select the grid and navigate to the Properties tab in the right
panel to modify.

Field Description

Name Edit the grid name.
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Field Description

System Name Edit the system name making it unique among quick
grids and identifiable in queries, reporting views, and
field codes. The name can contain only letters (English
alphabet), numbers, and the underscore, and defaults to
the grid name. On upgrade the system name defaults to
"Grid" plus a number, making it unique throughout the
system.

Tooltip Enter a description of the grid or brief instructions for
using the grid. The tooltip text is available for anyone
interacting with the grid throughout the system.

Tooltip
Alignment

Select the alignment of the tooltip icon within the cell.

Show Grid
Title

Select whether the title displays on the grid in
deliverables, activities, and layouts.

Show Footer
Row

Select to add a row to the bottom of the matrix that can
contain numeric totals and other buttons to perform
actions within the grid.

Hide Grid Select the check box to disable grids from displaying in
deliverables, activities, and layouts.

Collapsible Select the check box to allow deliverable and activity
owners to collapse the grid, and select how the grid
displays when a deliverable or activity is first displayed.

Default to
Expand or
Collapse

Select whether the grid displays as expanded or
collapsed in deliverables, activities, and layouts.

7. Modify appearance aspects for the grid as necessary.

To change grid background and border appearance, click the grid header to select the
grid and navigate to the Appearance tab in the right panel to modify.

Field Description

Background Select a background color, enter its hexadecimal color
code, or enter its RGB or HSV value in the Background
Color field.

Borders Select a border style in the Style field and enter a
border width. Select a border color, enter its
hexadecimal color code, or enter its RGB or HSV value
in the Border Color field.

8. Click Save in the lower right corner of the page to save changes, Save and Close to
save the configuration and close the editor, or Cancel to close the editor without saving
changes.
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Changing Cell Settings and Properties

Altering the appearance and layout of quick grid cell allows you control of data and information
presentation. Quick grids are viewable in project deliverables and activities that various
Accolade users have access to view and edit, based on specific user roles. The procedure
below discusses options and functions for modifying a grid cell's structure and appearance.

To refine a grid cell structure, appearance, and functionality:

1. From the Systemmenu, select Page Design > Quick Grids.

2. Click the name of the quick grid to open it for editing.

Use Tab to navigate between cells in a grid.

3. To merge or split merged cells click the cells you want to alter and click the appropriate
icon in the field.More...

- Merge cells. You cannot merge cells in a matrix grid.

- Split merged cells.

4. To alter the appearance of grid cells, select a single cell or multiple cells to edit at once
and navigate to the Appearance tab in the right panel to modify any of the following:

Appearance
Aspect Description

Text Select a text font such as Arial or Times New Roman in the
Font field and a text size in the Size field. Choose to bold,
italicize, or underline the text by selecting the appropriate
icons. Select a text color, enter its hexadecimal color code, or
enter its RGB or HSV value in the Text Color field. Cell text
defaults to 13pt Noto Sans font.

If a cell is editable, its text color is always black, regardless of
the color set here.

You can apply rich text elements to cells with
formatted text controls and long string metric values
by using markdown formatting.

Alignment Click one or multiple alignment icons to position text within the
cell. Cell text defaults left align and top align.More...

- Left Align

- Center Align

- Right Align

- Top Align
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Appearance
Aspect Description

- Middle Align

- Bottom Align

Background Select a background color, enter its hexadecimal color code,
or enter its RGB or HSV value in the Background Color field.
If a cell is editable and contains a control, the control's
background is always white, while the cell background color
displays as set here.

Borders Select a border style in the Style field and enter a border
width. Select a border color, enter its hexadecimal color code,
or enter its RGB or HSV value in the Border Color field.

5. Click Save in the lower right corner of the page to save changes, Save and Close to
save the configuration and close the editor, or Cancel to close the editor without saving
changes.
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Notes:
l If the Control Type is set to Rich Text, the Text and Alignment sections are
unavailable as users can customize the text directly from the rich text box.

l You cannot add matrix metrics to non-matrix grids and the number format for
matrix metrics is not supported in Microsoft 365 applications.

l To delete a quick grid from the canvas, click the quick grid header and click in
the drop-down menu.

l To delete cell contents, click the cell and click in the drop-down menu or click
the cell and press Delete.

l The Enable Quick Grids Protected Mode parameter turns on and off grid
protection. To modify a protected grid, an Administrator must set the parameter
to 0.

Adding Color Conditions to Quick Grid Cells

Use color to condition grid elements based on predefined metric values. This allows you to
visually represent metric values and ranges without using JavaScript. Additionally, cells
update live with selected color properties as users update and modify metrics and cell values
that meet conditions. For example, you may choose to condition cells with risk metrics greater
than 5 to display as red. Grid cells with risk values greater than 5 display as red in the project,
deliverable, or activity to which they are associated.

To add color-conditional formatting:

1. From the Systemmenu, select Page Design > Quick Grids.

2. Create a new quick grid or open an existing quick grid.

3. Select the cell containing the metrics and values you want to condition. Condition
values are evaluated against the selected cell's value in a case insensitive manner.

4. Navigate to the Appearance tab on the right panel and select the color picker for text,
background, or border color.

5. Click the Conditions tab and click to add a condition.

6. Select the color, enter its hexadecimal color code, or enter its RGB or HSV value in the
color field.

7. Select the condition operator and enter the criteria that sets the condition.

Enter a specific condition value matching the metric in the selected cell or enter a field
code.

Enter dates using the YYYY-MM-DD format.

8. Click away from the box to set the condition.

9. Repeat steps 5-8 to add additional conditions.
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If multiple conditions are entered, each condition is treated individually and respected
on a per-condition basis.

The cell displays the color of the first condition met and you can use the same color in
different conditions for the same element property. For example, a cell selected to
display as red if the value is greater than 0 can also be conditioned to display as red if
the cell value is less than 10.

If conditioned cells do not meet any conditions, the default background, text, or border
color displays.

10. Click Save in the lower right corner of the page to save changes, Save and Close to
save the configuration and close the editor, or Cancel to close the editor without saving
changes.

Notes:
l To delete a condition, open the color picker where the condition is set and
click the Conditions tab. Click for the specific condition.

Templates Overview
In Accolade, templates are the starting point for creating process documents for deliverables
and activities, Excel reports, Project schedules, and other documents. Using templates
provides consistency across similar documents across all the projects within your
organization. Templates can exist for the following:

l Deliverables and activities

l Gate documents

l Online forms

l Idea forms

l Microsoft Project plans)

l Display images (currently supported for page layouts)

l Any document that your company uses as a template outside of Accolade

Template Access

Anyone in your organization can create a document that you decide to use as a template.
However, only Administrators and Process Designers with the Template Access user role can
add templates to the Template Library, which is the repository for templates available within
Accolade. Anyone with Template Access can view the templates that align with their access
groups. Administrators and Process Designers that have Template Access have the ability to
add, remove, edit, or view templates that they share access groups with and have edit rights in
those access groups.
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Other roles have no access to the Template Library; however, they can download template
files when they start to work on their documents within a project.

Smart Templates

A "smart" template is an Excel, Word, or PowerPoint file that includes Accolade data in the
document, pulled from the Accolade database each time the template (or document version) is
downloaded. Rich text metrics do not display in Excel or Word smart templates but they do
display in PowerPoint.

Smart templates allow users to:

l Include the most up-to-date metric and project metadata values from the Accolade
database.

l Maintain project metrics in deliverables by uploading values from the document to the
database (Word files with specific-metric types only and specific Excel documents).

l Include the most up-to-date values from reference tables.

Accolade data is added to the document using Accolade field codes, which map data in the
Accolade database to a place within the document, or named ranges to add Accolade online
reports and other tables to Excel. Smart documents only work for documents that are uploaded
into Accolade. Data does not refresh if the document is created as a link to an external
document.

A document can be "smart" and not be added to Accolade as a template
in the Template Library.

The following document types can include field codes to become "smart" documents or
templates:

l Excel -.xlsx, .xlsm, .xltx, .xltm
l Word -.docx, .docm, .dotx, .dotm
l PowerPoint- .pptx, .pptm, .potx, .potm, .ppsx, .ppsm

Template Best Practices

Keep the following set of best practice recommendations in mind when creating templates:

l Use the Base Templates Provided from Sopheon - Each Accolade release contains
a group of base templates on the Base Templates Reference Page. Use these base
templates as starting points for templates specific to your organization.

l Use Descriptive and Unique Template Names - Users need to be able to clearly
distinguish the different template types and their uses. For example, Process Designers
building models need to distinguish between templates used for files and those for
online forms, and the difference between a Master Template such as the Excel Master
template and other Excel templates available.
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l Use Categories to Help Identify Templates - In addition to descriptive and unique
template names, place templates of similar usage in categories to help users identify
the correct template to use. For example, you may consider grouping templates by their
base functions such as reporting or marketing analysis. Create and assign templates to
categories when adding the template to the Template Library.

l Use Template File Name Extensions - Users who download a file deliverable from a
project can easily save it by mistake to a temporary folder where it may be difficult to
find again. If you ensure that file templates have the file extension of a template of the
related application (such as .dotx for Word documents or .xltx for Excel documents),
then users are prompted to save the file to an accessible location when they save the
downloaded template locally.

l Verify Field Codes in Templates Prior to Adding Templates to the Library - When
you upload a template containing field codes to the library, mistakes in the name, such
as {*MD:PorjectNam*} generate errors. However, mistakes in the pattern or source,
such as {*ProjectName*} or [*MD:ProjectName} simply display the field code itself in the
template rather than displaying the relevant data when opened in a project.

l Specify Which Worksheets in an Excel File Contain Field Codes - Accolade keeps
track of documents using custom document properties that are created automatically
when the template is first downloaded in an Accolade project. To improve the refresh
speed of some Excel templates, use the SGM_RefreshFieldsOnWorksheet custom
document property to specify which worksheets within the file contain Accolade field
codes. Refer to Microsoft's online Help for information about adding custom properties
to files.

l Use the Template Library for Templates Beyond Accolade - Use the Template
Library to store not just templates used within Accolade, but also for templates used for
documents not associated with the work you complete using Accolade. Add these types
of documents to the library using theOther type.

l Use Access Groups to restrict templates to subsets of Accolade users - Using
access groups, templates can be configured to only be accessible to a subset of users.

Sopheon recommends that you store the master Excel template (Report
- Excel <version>.xltx) in a separate category in the Template Library.

Adding Templates to the Template Library

The Template Library is the repository for templates available for use throughout Accolade.
Images added to the Template Library are available to image pods in page layouts.
Administrators and Process Designers can also use the Template Library as a repository for
templates that are useful across your organization, but that may not have a use as a
deliverable, activity, gate document, form, or report within Accolade.

To add a template to the Template Library:

1. From the Systemmenu, select Page Design > Template Library.

To narrow the list, search by the template name, system name, or category.
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2. Do one of the following:

l To add a new template to the library - Click Add New in the top right corner of the
page.

l To edit an existing template - Click the name of the template to display its details
page for editing.

3. Complete the following information to identify the template file:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a unique name, up to 64 characters long, which
identifies the template.

Template names and file names within the library must be
unique. The name entered here can be the same as the file
name, but each name and file name must be unique
across all templates.

System Name Enter a name that will uniquely identify this template.

This name must be unique from other template system
names, and can only contain letters (English alphabet),
numbers, and the underscore.

Type Select the type of template you are creating:
l Online Form - The basis for online forms for
deliverables, idea forms, and activity documents. These
templates are XML files that display text and software
controls in the client browsers, allowing users to work
with documents without uploading or downloading files.

l Process Document - The basis for creating file-based
deliverables, activities, or gate documents. These
templates can be any Microsoft Windows compliant file,
including Smart Excel templates. All gate document
templates must use this file type.

l Spreadsheet Report - The basis for reports viewable in
the Charts & Reports page or on the Reports page
within a project. These templates are spreadsheet files,
including those created using the Accolade Office
Extensions add-in.

l Presentation - The basis for creating a portfolio
presentations. These templates are Microsoft
PowerPoint files.

l Project Plan - The basis for creating Microsoft Project
plans for projects using Accolade integration with
Microsoft Project. Each model can have one or more
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Field Description

documents with an Microsoft Project template in which
gates, stages, deliverables, and activities are
represented as tasks. These templates must have a
.mpp.file extension.

Note: Accolade's integration with Microsoft
Project is an optional Accolade
component that you may not have access
to. To implement this solution, contact
Sopheon Customer Support. If you do not
have access, this template type will not be
an available option.

l Image - The basis for saving images for use in places
such as page layouts. To display as an image, an image
file must be one of the following file types: .bmp, .dib,
.gif, .jpg, .jpeg, .jpe, jfif, or .png. Project images that are
added as related documents do not need to be stored in
the Template Library.

l PDF, Email, Other - Use this type for template files
stored in the library for templates that may be useful
throughout your organization, but are not associated to
a deliverable, activity, or gate document.

Category Enter or select the group to which this template belongs.
More...

Use categories to organize similar templates together. For
example, create a category for deliverables and one for
reports, or create categories based on document type,
such as requirements and design.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the
template. This description helps other users identify the
template throughout the system.

Configuration
Access Groups

Select the access groups to which the template belongs.
Process Designers with matching permissions will be able
to edit and view templates. The access groups displayed
are based on the current user's access group permissions
and the access groups the template belongs to.
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Field Description

Process Model
Usage

Click the Process Model Usage button to see the list of
process models that the template is associated with. The
list includes all process models the templates is included
in, as well as links to the process model's component tree
pages you have Edit access to.

4. If you are adding a new template or replacing an existing template, click in the File
field, and select the template file to upload.

If you are editing an existing template, click the file icon next to the template name to
download the current template version for review and edits.

5. Click Create to add the new template or Apply to save changes to an existing template.

Notes:
l To delete a template from the Template Library, display the template in the
Template Library and click Delete. You cannot delete a template if it is used as
the idea deliverable in a model. Replace the template in the model or delete the
model prior to deleting the template from the library. You cannot delete an MS
Excel report template that is in use. Replace the template in all Excel reports that
use it or delete the Excel reports themselves (Process > Configuration >
Charts & Reports).

l To change the file name of a template, you must change the name of the file and
then upload the file as a new template.

l Accolade's integration with Microsoft Project is an optional Accolade component
that you may not have access to. To implement this solution, contact Sopheon
Customer Support.

Enabling Events for Microsoft Documents

Note: The information below assumes you have knowledge of programming in C#
and .NET, and in using Microsoft Visual Studio.

Accolade can perform various actions on documents with Microsoft file extensions in response
to the following events in Accolade:

l BeforeDocumentRefresh

l AfterDocumentRefresh

l BeforeDocumentSave

l AfterDocumentSave

192



Administrator's Guide

Sopheon Accolade Version 16.2

l BeforeDocumentDownload

l AfterDocumentDownload

To specify what action is taken in response to each event, create an assembly to respond to
the events and then edit the CustomEvents.config file to enable the assembly.

To create the assembly:

Important! The assembly must be created using a .NET language such as C# or
VB.NET.

1. Create a new class library project in Visual Studio with any assembly name and
namespace.

2. Create references to the following components:

l Sopheon.Accolade.Models.Domain

l Sopheon.Global.Utilities

l (Optional) Sopheon Global Utilities Logging (if logging)

3. Create public, non-static classes with default constructors.

You can create a single class to implement any or all of the following interfaces, or
create a class for each interface described below:

l Sopheon.Sgm.Accolade.Models.Domain.Interfaces.CustomEventing.
IDocumentRefresh - Contains signatures for methods for BeforeDocumentRefresh
and AfterDocumentRefresh events

l Sopheon.Accolade.Models.Domain.Interfaces.CustomEventing.
IDocumentSave - Contains signatures for methods for BeforeDocumentSave and
AfterDocumentSave events.

l Sopheon.Accolade.Models.Domain.Interfaces.CustomEventing.IDocumentDo
wnload - Contains signatures for methods for BeforeDocumentDownload and
AfterDocumentDownload events.

You can implement interfaces either implicitly or explicitly.

BLL classes can be instantiated from the Sopheon.Sgm.BusinessLayer namespace to
retrieve additional data as needed.

Find the data types for the interfaces in the following namespaces:

Data Type Namespace

SgmID Sopheon.Global.Utilities.IDs
EventDocument Sopheon.Accolade.Models.Domain.Entities.

CustomEventing
CustomEvent
Response

Sopheon.Accolade.Models.Domain.Entities.
CustomEventing

CustomEvent
Properties

Sopheon.Accolade.Models.Domain.Entities.
CustomEventing
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4. Compile the assembly and copy it to the following location on the application server:
C:\Program Files\Sopheon\Accolade\Website\Bin.

To enable the assembly:

1. On the application server, open the CustomEvents.config file located in C:\Program
Files\Sopheon\Accolade\Configuration.

2. Uncomment the customEvents element.

3. For each custom event that you want to be handled, ensure that the enabled attribute is
set to True. Change the attribute value to False for events that you do not want to
enable.

4. For each enabled event, enter the fully qualified class name into the event's Type
attribute.

The fully qualified class name uses the format <namespace.class name>, <assembly
name>

Notes:
l If you write code to save a PowerPoint presentation to the stream using
Aspose.Slides, you must call stream.SetLength(0) before saving to avoid file
corruption.

Writing Macros to Respond to Save Events in the Accolade Office
Extensions Add-In

You can write macros to respond to the Before Save and After Save events when saving
documents from the Accolade Office Extensions add-in to Accolade.

l Document Module - In the Visual Basic Editor, create a document module named
SGMEvents.

l Events and Signatures - In the module, create your macros using the following names
and signatures.

l SGMBeforeSave - This event occurs before the document is saved to Accolade.

The method that is called by this event has the signature:
Public Sub SGMBeforeSave()

l SGMAfterSave -This event occurs after the document is saved to Accolade.

The method that is called by this event has the signature:
Public Sub SGMAfterSave()

Smart Templates Overview

A "smart" template is an Excel, Word, or PowerPoint file that includes Accolade data in the
document, pulled from the Accolade database each time the template (or document version) is
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downloaded. Rich text metrics do not display in Excel or Word smart templates but they do
display in PowerPoint.

Smart templates allow users to:

l Include the most up-to-date metric and project metadata values from the Accolade
database.

l Maintain project metrics in deliverables by uploading values from the document to the
database (Word files with specific-metric types only and specific Excel documents).

l Include the most up-to-date values from reference tables.

Accolade data is added to the document using Accolade field codes, which map data in the
Accolade database to a place within the document, or named ranges to add Accolade online
reports and other tables to Excel. Smart documents only work for documents that are
uploaded into Accolade. Data does not refresh if the document is created as a link to an
external document.

A document can be "smart" and not be added to Accolade as a template
in the Template Library.

Updating Metrics in Accolade From Documents (Long String Metrics)

Note: Accolade Office Extensions is not required to use Accolade field codes.

You can add a metric field code to Microsoft Word documents that allows both the display of a
metric's current value and updates to the value. This feature is available only for metrics
whose data type is Long String without Rich Text enabled. Word changes these updating
codes into form fields when the document is refreshed.

Important! This feature does not apply to related documents.

The pattern for this special metric code is {*Metric:(system name) #Updateable*}.
"#Updateable" is an option to the basic metric pattern that allows this code to update the metric
value in Accolade. If the code contains all three of its options, its pattern would be {*Metric:
(system name) (option) (option) (option)*}. The pattern does not include the parentheses.

See "Metric Field Codes with Options" on page 794 for a list of all the available options.

Example

For a Long String type metric named BusiCase:

l The code {*Metric:BusiCase #Updateable*} allows the metric to be updated.

l The code {*Metric:BusiCase #Updateable #MaxLen=500 #DefaultValue=Enter the
business case*}:

l Would allow the metric to be updated.

l Would allow the user to enter up to 500 characters in the field.
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l Would display the text "Enter the business case" if the metric was empty when the
document was opened.

To allow users to enter data in the fields without deleting the codes, enter the codes in
protected sections. Other text, which authors can edit normally, and other field codes, which
are not editable, can be left in unprotected sections.

To add a long string metric to a Microsoft Word document:

1. Open the document to modify.

2. Enter all of the codes and other text in the document, using section breaks to separate
the updating long string metric codes from other content.

3. To protect the document, on the Review tab, in the Protect group, select Restrict
Editing.

4. In the Restrict Formatting and Editing options pane, under the Editing Restrictions
section, select the Allow only this type of editing check box and select Filling in
forms from the list.

5. Click the Select sections link and clear the check boxes for all sections that do not
contain updating metric codes, and clickOK.

6. In the Restrict Formatting and Editing options pane, click Yes, Start Enforcing
Protection to enable the protection features for the document.

Do not enter a password unless you want the document to be password protected.

7. Save your changes and save the document to Accolade.

Notes:
l Any user with access to a document can add Accolade field codes; however,
only Process Designers and Administrators with the Template Access role can
upload templates to the Accolade template library.

l If you type in an unprotected form field, the field and underlying code is deleted.

l Long string metrics can contain formatting to make text bold, italic, and so on.
You can enter the formatting notations from within Word and have it render
correctly if the metric is contained within a layout. See the main Accolade help for
more information about the notations.

l Administrators and Process Designers can remove protection from the
document and change content, if needed. The sections become locked again if
the document is refreshed.

Adding Images to Documents Using Accolade Field Codes

Note: Accolade Office Extensions is not required to use Accolade field codes.

196



Administrator's Guide

Sopheon Accolade Version 16.2

You can add project-related images to documents, spreadsheets, and presentations using
Accolade fields. Use image field codes to displays the images that are associated with the
codes for each project. Accolade contains the following standard image field codes. Your
company may have defined addition codes specific to your site.

l {*image:ProjectMain*} - Displays the image intended to represent the project in
documents.

l {*image:ProjectThumbnail*} - Displays the project’s thumbnail image.

l {*image:ProjectProcessGraphic*} - Displays the model graphic that shows the stages
and gates in the project.

To add an image to a document using an Accolade field code:

1. Open the document to modify.

2. On the Insert tab, clickObject in the Text Category.

3. In the Create New tab, select Bitmap Image and clickOK.

You can also insert a picture from a file rather than an Object.

4. In the document, click the space where the empty object was inserted, right-click the
object outline, and select Format Object.

5. Display the Alt Text options for the object.

This may be a tab in a dialog box, or in the Size & Properties options in a panel.

6. Enter the appropriate image field code in the Alternative Text box (in a document or
spreadsheet), or in the Description field (presentation).

7. Set the height, width, and rotation for the image.

If you do not know what size the image should be, you can set an approximate size, and
the document owner can set the exact size after the image has been selected in the
project.

To make the object window the same size as the image after it is inserted,
open the Format Picture dialog box. On the Size tab, clear the Lock
aspect ratio check box, then make sure that Height andWidth (under
Scale) equal 100% and that the Relative to original picture size check
box is selected. After the distortion is removed, select the Lock aspect
ratio check box again.

8. Save the version to Accolade and then download the new version to ensure the image
displays correctly.

Notes:
l The images initially display in a size that completely fills the object window in the
document, not in the dimensions shown in Accolade. Images may appear
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distorted.

l Images do not display in project documents until images are associated with the
appropriate field codes in the project.

Adding Reference Table Values to Documents

You can create templates for deliverables, activities, gate documents, and reports that contain
values or the entire table from reference tables available within Accolade. Embedding
references to reference tables allows you to pull additional data into templates, while updating
the values in only the reference table. The values in the template update with the current
reference table value when users download the template or document version and refresh the
data.

You can add reference table values using the Accolade Office Extensions add-in, or using
Accolade field codes. You can also add a reference table in its entirety using a specially named
worksheet within a spreadsheet file.

Note: Anyone in your organization can create a template that includes an
embedded reference table, if they have access to the reference table itself.
However, only Administrators and Process Designers with the Template
Access user role can add templates to the Template Library, which is the
repository for templates available within Accolade.

To add entire reference tables using specially named worksheets:

To include an entire reference table, you need to know the reference
table's system name as set in Accolade.

1. Open the spreadsheet and save the file to a convenient location on your computer using
a file name that clearly identifies the purpose of the document.

2. Rename the worksheet containing the reference table as SGM_RT_<system name>,
where <system name> is the system name of the reference table to display.

You can either hide the worksheet containing the reference table, or show it and add
other content to it. Note that the reference table's top left cell starts in cell A1. If you add
content outside the table's cell range, that content could be overwritten if later versions
of the table are larger. Accolade fields added to the worksheet are also refreshed.

3. Save the file to Accolade or add the file to the Template Library as a Process
Document type.

To add a reference table cell value using Accolade field codes:

1. Open the document and save the file to a convenient location on your computer using a
file name that clearly identifies the purpose of the document.
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2. Where needed, add the Accolade field code that points to the reference table and
column you want to include:

{*REFTABLE:<TableSystemName> #RowID=(row ID)
#ColumnID=<ColumnSystemName>*}

Example

{*REFTABLE:sgm_currency #RowID=USD #ColumnID=CurrencyName*}

Displays the value in the USD row of the CurrencyName column of the Currency
reference table.

Adding Workflow History to Excel Templates

Create an Excel template that contains workflow history for the associated deliverable or
activity. The workflow history is added as a separate worksheet in an Excel document,
containing refreshed data and completion history for audit purposes.

To add workflow history to Excel templates:

1. Create the Excel template with the display worksheets for the template.

2. Add a blank worksheet to the file and name it SGM_WF_History.

3. Save the file and add the template to the Template Library with the type Process
Document.

4. Add the template to a deliverable, activity, or gate document in a process model that
contains a workflow with an auto-generate PDF step.

Notes:
l If a template used in a deliverable or activity whose workflow contains a step to
auto-generate a PDF does not contain the SGM_WF_History worksheet, the
PDF generates without workflow history. Workflow history is also viewable in the
Deliverable details within the project.

l Collaborative Workflow is an optional Accolade component that you may not
have access to. To implement this solution, contact Sopheon Customer Support.

Templates to Update Project Data Overview (Smart Excel)

Smart Excel templates are special template files that deliverable and activity owners can use
to update project data. Rich text metrics do not display in Smart Excel templates.

Use a Smart Excel template with Accolade field codes representing Accolade data to do the
following:
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l Display metrics, matrices, and metadata in deliverable, activity, and gate documents.

l Update project metrics, matrices, and/or metadata when a version of a document is
published to Accolade.

l Use formulas to manipulate metric values and perform data validation checks.

l Edit deliverable or activity details, such as start dates and status notes.

l Add or remove activities attached to deliverables.

l Display a project's resource plan in a deliverable or activity document and request
project resources (if running the resource planning functionality in Accolade).

l Work offline and upload information to Accolade later.

Base Templates

Each Accolade release contains a set of base templates you can use to build templates for
your business.

The Process Document - Smart Excel <version>.xltx file is available or on the Base
Templates Reference Page. The template contains the basic worksheet structure required to
create Smart Excel templates to update project metric, matrix, and metadata values. The
worksheets you use in each template depends on the project data the template updates.

l Sheet1 - Contains the data that displays to the deliverable or activity owner and
eventual readers of documents based on the template. This is the only worksheet that
someone who is not building the Smart Template components interacts with. You can
add more display worksheets to the template, if necessary.

l SGM_MetricTransfer - Manages the display or update of metric data in a single
project.

l SGM_Metadata - Manages the display or update of project metadata.
l SGM_RelatedProjectMetrics - Manages the display or update of metric data in
projects related to the project the template is included in.

l SGM_DeliverablesActivities - Manages the addition or removal of activities, or the
edit of a deliverable or activity.

l SGM_Notes - Contains Sopheon recommendations and suggestions for using the file
to create Smart Excel templates.

The Resource Plan Template - Basic <version>.xlsx file, also available on the Base
Templates Reference Page, applies if you are running the resource planning functionality in
Accolade, and contains the worksheet required for a deliverable or activity owner to create a
resource plan request. A deliverable or activity owner with enough information can enter pool
names, resources, and so on, for each resource request. See "Creating Excel Templates to
Request Resources" on page 218.

Administrators and Process Designers use the worksheets in the template to build the display
and map the Accolade data. Deliverable and activity owners interact only with the display
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sheets to view and update project information and save it back to Accolade. Depending on the
template design, it is possible that deliverable and activity owners can update project data
using a Smart Excel template that they cannot update through the project pages within
Accolade.

Creating Excel Templates to Update Metrics in a Single Project

Create a Smart Excel template using the Process Document - Smart Excel <version>.xltx
base template and Accolade field codes to create a template that allows deliverable and activ-
ity owners to update metrics within their projects. Creating the template involves designing and
laying out the display worksheets that users of the template interact with, as well as creating
the appropriate mappings for any information that is pulled from Accolade.More...

Administrators and Process Designers create the templates, Process Designers add the
templates to models, and teammembers on projects use the template to complete and update
project data within Accolade.

Base Smart Excel templates on the Process Document - Smart Excel <version>.xltx file
available on the Base Templates Reference Page. See "Templates to Update Project Data
Overview (Smart Excel)" on page 199 for more information about the template.

The procedure below describes how to add metric fields to an Excel template that display and
update values when published to Accolade for a single project. A single template can also
contain project metadata, matrices, and metrics in related projects.

To setup an Excel template that updates metrics in a single project:

Note: The following procedure assumes you are familiar with basic Excel
functionality.

1. Open the Process Document - Smart Excel <version>.xltx file and save a copy to
your computer, using a file name that clearly identifies the purpose of the template.

Ensure that the master Process Document - Smart Excel
<version>.xltx file is kept in a safe place, such as the template library,
with no modifications to it.

2. (Optional) Hide the SGM_Metadata, SGM_RelatedProjectMetrics, SGM_
DeliverablesActivities, and SGM_Notes worksheets, as none are required for metrics
updates in a single project; however, do not delete them.

3. On Sheet1, create the display worksheet that users of the template interact with,
identifying and noting the purpose of the cells throughout the layout.More...
l Cells that only display data from Accolade. This can be metric data or project
metadata from Accolade.

l Cells that only upload metric values to Accolade.
l Cells that display a metric value when the document is first opened, and upload any
changes to the value to Accolade.
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l Cells that contain information and data that is not sent to or received from Accolade.
For example, label cells.

Enter all the labels, column headings, background color, formulas, and so on, into the
cells that do not receive or send data to Accolade to verify that the worksheet looks as
you intend it to for users.

It can be useful as you are laying out the display worksheet to name the
upload and download cells to more clearly identify them in the layout prior
to entering the field codes to establish the data connection with Accolade.

You can add additional display worksheets, as necessary.

4. Add a new worksheet and enter the Accolade field codes that represent the data to
display within the display worksheet.

Do not leave blank rows in the list of codes.

5. (Optional) Rename Sheet1 to an appropriate, meaningful name for the display
worksheet for users completing the template. For example, Post-Launch Review
Scorecard.

6. Create cell references between the display worksheet (originally Sheet1) and the
worksheet added in step 4.More...

Cell Purpose on Display
Worksheet Instructions

Cells that only display
downloaded data from
Accolade

On the display worksheet, create a cell reference
for each cell that displays data to the appropriate
cell on the worksheet that contains the field codes.
Protect and lock the cells on the display worksheet
that contain references to the field codes
worksheet.

Cells that display a metric
value when the document
is first opened, and
uploads any changes to
the value to Accolade

For each cell in the display worksheet that
displays a value when the document is first
opened, and uploads any changes to the value,
enter a metric field code that includes the
#OnceOnly option. For example, {*METRIC:NPV
#OnceOnly*}.

7. For each cell in the display worksheet that uploads a new metric value to Accolade,
complete the columns in the SGM_MetricTransfer worksheet.More...
l Metric System Name - Enter the system name of each metric that is updated using
the template.

l Metric Display Name - Enter the display name of the metric that is updated using
the template.

l Current Value String - The current value if the metric is a String or Long String
type.
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l Current Value Number - The current value if the metric is a Number type.
l Current Value Date - The current value if the metric is a Date type.
l Data Type - The metric data type. Acceptable values include String, Long String,
Number, List, Multi-Select List, and Date.

l List Values - The acceptable values if the metric is a List or Multi-Select List type.
l Publish will use New Value column - Enter Y in a metric row if the value entered
for this metric in the display worksheet uploads to Accolade or enter N if the value is
only displayed in the worksheet.

l New Value - Enter cell references to the cells in the display worksheet that users
use to enter new metric values. Do not type anything into this column after entering
the cell reference.

Do not place any intermediate formulas in the SGM_MetricTransfer worksheet, do not
delete the first two rows, and do not rename the worksheet.

8. Protect the display worksheet.

Protecting the display worksheet keeps users from overwriting cells that contain
references or formulas.

Important! Do not protect the entire workbook. The SGM_ worksheets must
remain unprotected for the download and upload between Accolade to work
correctly.

9. In the display worksheet, remove the lock on the cells that users use to update metric
values.

10. Hide the SGM_MetricTransfer worksheet and the worksheet you added that contains
the list of field codes, as these are worksheets that users interacting with the template
do not need to see.

Prior to saving, select the cell in the display worksheet where a template
user typically starts typing in the template to default the cursor to that cell
when the template is opened.

11. Save the file and add the template to the Template Library.

Notes:
l Sopheon recommends that all SGM_ worksheets should be hidden prior to
publishing for use in a process model, to prevent users from making inadvertent
changes. Do not rename these worksheets, and do not delete them from the file.

Creating Excel Templates to Update Metrics in Related Projects

Create a Smart Excel template using the Process Document - Smart Excel <version>.xltx
base template and Accolade field codes to create a template that allows deliverable and activ-
ity owners to update metrics in projects related to the project the template is included in.
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Updates are only made in projects to which the owner has access. Creating the template
involves designing and laying out the display worksheets that users of the template interact
with, as well as creating the appropriate mappings for any information that is pulled from Accol-
ade.More...

Administrators and Process Designers create the templates, Process Designers add the
templates to models, and teammembers on projects use the template to complete and update
related project data within Accolade.

Base Smart Excel templates on the Process Document - Smart Excel <version>.xltx file
available on the Base Templates Reference Page. See "Templates to Update Project Data
Overview (Smart Excel)" on page 199 for more information about the template.

The procedure below describes how to add metric fields to an Excel template that display and
update values in related projects when published to Accolade. A single template can also
contain project metadata, matrices, and metrics in a single project.

To setup an Excel template that updates metrics in related projects:

Note: The following procedure assumes you are familiar with basic Excel
functionality.

1. Open the Process Document - Smart Excel <version>.xltx file and save a copy to
your computer, using a file name that clearly identifies the purpose of the template.

Ensure that the master Process Document - Smart Excel
<version>.xltx file is kept in a safe place, such as the template library,
with no modifications to it.

2. (Optional) Hide the SGM_MetricTransfer, SGM_Metadata, SGM_
DeliverablesActivities, and SGM_Notes worksheets, as none are required for metrics
updates in related projects; however, do not delete them.

3. On Sheet1, create the display worksheet that users of the template interact with,
identifying and noting the purpose of the cells throughout the layout.More...
l Cells that only display data from Accolade. This can be metric data or project
metadata from Accolade.

l Cells that only upload metric values to Accolade.
l Cells that display a metric value when the document is first opened, and upload any
changes to the value to Accolade.

l Cells that contain information and data that is not sent to or received from Accolade.
For example, label cells.

Enter all the labels, column headings, background color, formulas, and so on, into the
cells that do not receive or send data to Accolade to verify that the worksheet looks as
you intend it to for users.
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It can be useful as you are laying out the display worksheet to name the
upload and download cells to more clearly identify them in the layout prior
to entering the field codes to establish the data connection with Accolade.

You can add additional display worksheets, as necessary.

4. Add a new worksheet and enter the Accolade field codes that represent the data to
display within the display worksheet.

Do not leave blank rows in the list of codes.

5. (Optional) Rename Sheet1 to an appropriate, meaningful name for the display
worksheet for users completing the template.

6. Create cell references between the display worksheet (originally Sheet1) and the
worksheet added in step 4.More...

Cell Purpose on Display
Worksheet Instructions

Cells that only display
downloaded data from
Accolade

On the display worksheet, create a cell reference
for each cell that displays data to the appropriate
cell on the worksheet that contains the field codes.
Protect and lock the cells on the display worksheet
that contain references to the field codes
worksheet.

Cells that display a metric
value when the document
is first opened, and
uploads any changes to
the value to Accolade

For each cell in the display sheet that displays a
value when the document is first opened, and
uploads any changes to the value, enter a metric
field code that includes the #OnceOnly option.
For example, {*METRIC:NPV #OnceOnly*}.

7. For each cell in the display worksheet that uploads a new metric value to Accolade,
complete the columns in the SGM_RelatedProjectMetrics worksheet.More...
l System Project ID - Enter the project ID of the project to update using the
template. This is the project ID, not the project name. When the file that uses the
template is uploaded, Accolade searches for the project IDs and determines if the
projects are related to the project in which the template is used, up to five levels
deep.

l Metric System Name - Enter the system name of each metric that is updated
using the template.

l Metric Display Name - Enter the display name of the metric that is updated using
the template.

l Current Value String - The current value if the metric is a String or Long String
type.

l Current Value Number - The current value if the metric is a Number type.
l Current Value Date - The current value if the metric is a Date type.
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l Data Type - The metric data type. Acceptable values include String, Long String,
Number, List, Multi-Select List, and Date.

l List Values - The acceptable values if the metric is a List or Multi-Select List type.
l Publish will use New Value column - Enter Y in a metric row if the value entered
for this metric uploads to Accolade or enter N if the value is only displayed in the
worksheet.

l New Value - Enter cell references to the cells in the display worksheet that users
use to enter new metric values. Do not type anything into this column after entering
the cell reference.

Do not place any intermediate formulas in the SGM_RelatedProjectMetrics
worksheet, do not delete the first two rows, and do not rename the worksheet.

8. Protect the display worksheet.

Protecting the display worksheet keeps users from overwriting cells that contain
references or formulas.

Important! Do not protect the entire workbook. The SGM_ worksheets must
remain unprotected for the download and upload between Accolade to work
correctly.

9. In the display worksheet, remove the lock on the cells that users use to update metric
values.

10. Hide the SGM_RelatedProjectMetrics worksheet and the worksheet you added that
contains the list of field codes, as these are worksheets that users interacting with the
template do not need to see.

Prior to saving, select the cell in the display worksheet where a template
user typically starts typing in the template to default the cursor to that cell
when the template is opened.

11. Save the file and add the template to the Template Library.

Notes:
l Sopheon recommends that all SGM_ worksheets should be hidden prior to
publishing for use in a process model, to prevent users from making inadvertent
changes. Do not rename these worksheets, and do not delete them from the file.
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Creating Excel Templates to Update Project Matrices

Create a Smart Excel template using the Process Document - Smart Excel <version>.xltx
base template and Accolade field codes to create a template that allows deliverable and activ-
ity owners to update a project matrix. Creating the template involves designing and laying out
the display worksheets that users of the template interact with, as well as creating the appro-
priate mappings for any information that is pulled from Accolade.More...

Administrators and Process Designers create the templates, Process Designers add the
templates to models, and teammembers on projects use the template to complete and update
project data within Accolade.

Base Smart Excel templates on the Process Document - Smart Excel <version>.xltx file
available on the Base Templates Reference Page. See "Templates to Update Project Data
Overview (Smart Excel)" on page 199 for more information about the template.

A matrix template can contain more than one matrix, but each matrix is typically managed by
the following two worksheets:

l Display worksheet - A worksheet within the template that template users use to enter
values on and that is formatted to make data entry obvious. This is typically Sheet1 in
the template. There can be more than one display worksheet.

l Matrix worksheet - A worksheet within the template that contains two copies of a
single matrix arranged side by side. The copy on the left contains the current,
downloaded metrics values. The copy on the right contains the values that the template
users enter to upload to Accolade. There can be more than one matrix in the template;
however, there can only be one matrix per matrix worksheet, and each matrix in the
template must be unique.

The procedure below describes how to add a matrix to an Excel template that displays and
updates values when published to Accolade. A single template can also contain metrics,
project metadata, and metrics in related projects.

Important! If using the calculated metric expression CurrentMatrixValue in a
matrix and updating the matrix in Excel, you must uniquely identify other matrix
rows by flagging metrics as unique. If matrix columns are not unique or the Excel
workbook contains duplicate columns, the Smart Excel template does not update,
upload, or publish back to Accolade.

To set up an Excel template to update a project matrix:

Note: The following procedure assumes that you have created the matrix within
Accolade, added its metrics, and associated it with the appropriate models.
The following procedure also assumes you are familiar with basic Excel
functionality.

1. Open the Process Document - Smart Excel <version>.xltx file and save a copy to
your computer, using a file name that clearly identifies the purpose of the template.
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Ensure that the master Process Document - Smart Excel
<version>.xltx file is kept in a safe place, such as the template library,
with no modifications to it.

2. (Optional) Hide the SGM_MetricTransfer, SGM_Metadata, SGM_
RelatedProjectMetrics, SGM_DeliverablesActivities, and SGM_Notes worksheets,
as none are required for a matrix update; however, do not delete them.

3. Add a new worksheet and name it SGM_MX_<matrix system name>.

This sheet is the matrix sheet. The matrix system name must match the system name
assigned to the matrix in Accolade exactly. Add additional sheets for each matrix, as
necessary.

4. Save the file, add it to the Template Library as a Process Document type, and add the
template to a deliverable or activity in a model that has the matrices associated to it.

5. Open a test project that uses the matrices for which you created worksheets for in step
3, navigate to the deliverable or activity it is assigned to, and download the template.

Downloading the template from a project populates the matrix worksheet with two
copies of the matrix.

6. On Sheet1, create the display worksheet that users of the template interact with,
identifying and noting the purpose of the cells throughout the layout.More...
l Cells that only display downloaded data from Accolade.
l Cells that only upload changed values to Accolade.
l Cells that contain information and data that is not sent to or received from Accolade.
For example, label cells.

Enter all the labels, column headings, background color, formulas, and so on, into the
cells that do not receive or send data to Accolade to verify that the worksheet looks as
you intend it to for users.

It can be useful as you are laying out the display worksheet to name the
upload and download cells to more clearly identify them in the layout prior
to entering the field codes to establish the data connection with Accolade.

You can add additional display worksheets, as necessary.

7. (Optional) Rename Sheet1 to an appropriate, meaningful name for the display
worksheet for users completing the template.

8. Create cell references between the display worksheet (originally Sheet1) and the matrix
worksheet(s) created in step 3, adding references to only cells in the right copy of the
matrix where values are loaded to Accolade.More...
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Cell Purpose on Display
Worksheet Instructions

Cells that only display
downloaded data from
Accolade

On the display worksheet, in the cells that display
the current metric value when the document is
downloaded and opened, create cell references to
the corresponding "current value" cells on the left
side of appropriate matrix worksheet.

Cells that document
owners change to upload
back to Accolade

On each matrix worksheet, in the "new value" cells
in right side of the worksheet, enter cell references
to the cells on the display worksheet where the
document owner enters new values to upload
back to Accolade.

Only add cell references to cells in the right copy
of the matrix where values are uploaded to
Accolade. Cell references or formulas added
below the cell references that make up the table in
the right copy cause NULL rows or invalid data to
be added to Accolade.

9. Protect the display worksheet.

Protecting the display worksheet keeps users from overwriting cells that contain
references or formulas.

Important! Do not protect the entire workbook. The SGM_ worksheets must
remain unprotected for the download and upload between Accolade to work
correctly.

10. In the display worksheet, remove the lock on the cells that users use to update metric
values.

11. Hide the SGM_MX_<matrix system name> worksheet created in step 3, as this is a
worksheet that users interacting with the template do not need to see.

Prior to saving, select the cell in the display worksheet where a template
user typically starts typing in the template, to default the cursor to that cell
when the template is opened.

12. Save the file and upload the new version to the template to the Template Library.

Matrix Sheet Layout

When you open the template from a test project, the matrix sheet is populated with two copies
of the matrix that manage the upload and download in the worksheet that matches the matrix
system name. The copy on the left contains "current" values that are downloaded to the
worksheet from Accolade. The copy on the right contains "new" values to update to Accolade.
The metric names are prefixed with New in the headers in the copy on the right.
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Each copy contains the following:

Column Description

Row ID The leftmost column of each matrix copy. The other columns
contain the metrics. The workbook does not use the numbers in
the RowID column to identify the rows. Rows are identified by
their position below the headings in the sixth row. You can enter
whatever row ID numbers or names are most useful to you to
orient yourself on the sheet.

Metrics The metrics contained in the matrix. Each metric contains the
following information.
l Row 1 - Display names of relative date metrics.
l Row 2 - Periods (month, quarter, or year) of relative date
metrics.

l Row 3 - Current relative to dates of relative date metrics.
l Row 4 - Indicates whether a metric is set to be unique within
the matrix. "Y" or "N" for all metrics. The template does not
enforce the uniqueness of a metric. The indicator is only a
reminder of which columns, or combinations of columns,
should contain unique values.

l Row 5 - List items for list metrics. The cell contains all of the
list values for the list metric in the column, including cascading
(filtered) lists.

l Row 6 - The system names for each metric.
l Row 7 - Column headings are the display names for each
metric.

l Row 8 and below - Metric values from the display sheet in the
left copy of the matrix. In the right copy, cell references to the
display worksheet.

Important! Do not edit or delete the "current" values in the copy on the left.
Removing these values will cause errors with your worksheet upload.

Notes:
l Sopheon recommends that all SGM_ worksheets should be hidden prior to
publishing for use in a process model, to prevent users from making inadvertent
changes. Do not rename these worksheets, and do not delete them from the file.

l The Process Document - Smart Excel <version>.xltx Smart Excel template
contains a necessary custom document property and five worksheets that are
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not used for matrices. If you use an ordinary Excel workbook rather than the
Smart Excel template, you must add the custom document property SGM_
SmartExcelVersion, whose value is the Accolade version number.

l The Database Reference Tables Command Timeout system parameter
governs the timeout, in seconds, for uploading each matrix from Excel to
Accolade.

Creating Excel Templates to Update Project Metadata

Create a Smart Excel template using the Process Document - Smart Excel <version>.xltx
base template and Accolade field codes to create a template that allows deliverable and activ-
ity owners to update project metadata, such as gate dates and project start and end dates,
within their projects. Creating the template involves designing and laying out the display work-
sheets that users of the template interact with, as well as creating the appropriate mappings for
any information that is pulled from Accolade.More...

Administrators and Process Designers create the templates, Process Designers add the
templates to models, and teammembers on projects use the template to complete and update
project data within Accolade.

Base Smart Excel templates on the Process Document - Smart Excel <version>.xltx file
available on the Base Templates Reference Page. See "Templates to Update Project Data
Overview (Smart Excel)" on page 199 for more information about the template.

The procedure below describes how to add project metadata to an Excel template that
displays and updates values when published to Accolade. A single template can also contain
metrics, matrices, and metrics in related projects.

To setup an Excel template that updates metadata:

1. Open the Process Document - Smart Excel <version>.xltx file and save a copy to
your computer, using a file name that clearly identifies the purpose of the template.

Ensure that the master Process Document - Smart Excel
<version>.xltx file is kept in a safe place, such as the template library,
with no modifications to it.

2. (Optional) Hide the SGM_MetricTransfer, SGM_RelatedProjectsMetrics, SGM_
DeliverablesActivities, and SGM_Notes worksheets, as none are required for a
metadata update; however, do not delete them.

3. On Sheet1, create the display worksheet that users of the template interact with,
identifying and noting the purpose of the cells throughout the layout.More...
l Cells that only display downloaded data from Accolade.
l Cells that only upload changed values to Accolade.
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l Cells that contain information and data that is not sent to or received from Accolade.
For example, label cells.

Enter all the labels, column headings, background color, formulas, and so on, into the
cells that do not receive or send data to Accolade to verify that the worksheet looks as
you intend it to for users.

It can be useful as you are laying out the display worksheet to name the
upload and download cells to more clearly identify them in the layout prior
to entering the field codes to establish the data connection with Accolade.

You can add additional display worksheets, as necessary.

4. In the SGM_Metadata worksheet, enter one or more of the following metadata field
names into the Name column. These metadata names represent project metadata that
users can update using the spreadsheet.More...
l ActivityDeadline
l ActivityPlannedFinishDate
l ActivityStart
l ActivityStatusID
l DeliverableDeadline
l DeliverablePlannedFinishDate
l DeliverableStart
l DeliverableStatusID
l ProjectStartDate
l ProjectEndDate
l ProjectGateDate-(gate number) **Enter a dash and the gate number (no spaces)
after the name.

l ProjectName
l ProjectID **This is the displayable project ID, not the SysProjectID
l ProjectDescription

You can add other metadata names to the Name column for display on the display
worksheet; however, only the metadata names listed above can be updated using the
template. For the complete list of metadata names, see Accolade field codes.

5. (Optional) Rename Sheet1 to an appropriate, meaningful name for the display
worksheet for users completing the template.

6. In the SGM_Metadata worksheet, enter Y or Yes in the Publish will use New Value
column to update the project with values in the New Value column when a new version
of the file that uses the template is published in Accolade.

7. Create cell references between the display worksheet (originally Sheet1) and the
SGM_Metadata worksheet.More...
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Cell Purpose on Display
Worksheet Instructions

Cells that only display
downloaded data from
Accolade

On the display worksheet, in the cells that display
the current metric value when the document is
downloaded and opened, create cell references to
the corresponding "current value" cells in the
SGM_Metadata worksheet.

Cells that document
owners change to upload
back to Accolade

On the SGM_Metadata worksheet, in the "new
value" cells, enter cell references to the cells on
the display worksheet where the document owner
enters new values to upload back to Accolade.

8. Protect the display worksheet.

Protecting the display worksheet keeps users from overwriting cells that contain
references or formulas.

Important! Do not protect the entire workbook. The SGM_ worksheets must
remain unprotected for the download and upload between Accolade to work
correctly.

9. In the display worksheet, remove the lock on the cells that users use to update metric
values.

10. Hide the SGM_Metadata worksheet, as this is a worksheet that users interacting with
the template do not need to see.

Prior to saving, select the cell in the display worksheet where a template
user typically starts typing in the template to default the cursor to that cell
when the template is opened.

11. Save the file and add the template to the Template Library.

Notes:
l Sopheon recommends that all SGM_ worksheets should be hidden prior to
publishing for use in a process model, to prevent users from making inadvertent
changes. Do not rename these worksheets, and do not delete them from the file.

l You can add the SGM_Metadata worksheet to any version of a Smart Excel
template. It is not necessary to update the template to the latest version to
update the listed types of metadata. Add columns headings in the first row of
the sheet from left to right: Name, Current Value String, Current Value Number,
Current Value Date, Publish will use New Value, New Value.
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Creating Excel Templates to Update Deliverables and Activities

Create a Smart Excel template using the Process Document - Smart Excel <version>.xltx
base template and Accolade field codes to create a template that allows deliverable and activ-
ity owners to complete deliverable and activity information such as adding or deleting activities,
and editing deliverable or activity details such as status and status notes, owners and func-
tions, or start and deadline dates. Creating the template involves designing and laying out the
display worksheets that users of the template interact with, as well as creating the appropriate
mappings for any information that is pulled from Accolade.More...

Administrators and Process Designers create the templates, Process Designers add the
templates to models, and teammembers on projects use the template to complete and update
project data within Accolade.

Base Smart Excel templates on the Process Document - Smart Excel <version>.xltx file
available on the Base Templates Reference Page. See "Templates to Update Project Data
Overview (Smart Excel)" on page 199 for more information about the template.

A template that updates activities and deliverable details must contain at least the following
worksheets:

l Display worksheet - A worksheet within the template that document owners use to
enter values and that is formatted to make data entry obvious. This is typically Sheet1 in
the template. There can be more than one display worksheet.

l SGM_DeliverablesActivities worksheet - A worksheet within the template that
contains two copies of the deliverable or activity details, arranged side by side. The
copy on the left contains the current values that are downloaded when the template is
downloaded from a project within Accolade. The copy on the right contains the values
that are added, edited, or deleted when the deliverable or activity is uploaded and
published.

Note that teammembers cannot update deliverables and activities that are conditioned to hide.
Additionally, activities cannot be added to hidden deliverables and hidden activities cannot be
deleted. Refreshed templates respect deliverable and activity conditions. See Conditioning
Deliverable and Activities Overview.

The following procedure provides basic information about how to setup the template. The
specific document and its function dictate the formulas and other operations to populate the
template. A single template can also contain project metadata and metrics. A single template
can also contain metrics, project metadata, and metrics in related projects.

Important! The template cannot add or delete deliverables.

To setup an Excel template that modifies deliverable or activity details:

Note: The following procedure assumes you are familiar with basic Excel
functionality.
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1. Open the Process Document - Smart Excel <version>.xltx file and save a copy to
your computer, using a file name that clearly identifies the purpose of the template.

Ensure that the master Process Document - Smart Excel
<version>.xltx file is kept in a safe place, such as the template library,
with no modifications to it.

2. (Optional) Hide the SGM_MetricTransfer, SGM_Metadata, SGM_
RelatedProjectMetrics, and SGM_Notes worksheets, as none are required for
deliverable or activity updates; however, do not delete them.

3. Save the file, add it to the Template Library as a Process Document type, and add the
template to a deliverable or activity in a model that uses the template.

4. Open a test project that uses the model and download the template to populate for the
deliverable or activity in the SGM_DeliverablesActivities worksheet for the specific
deliverable.

5. On Sheet1, create the display worksheet that users of the template interact with,
identifying and noting the purpose of the cells throughout the layout.More...
l Cells that only display downloaded data from Accolade.
l Cells that only upload changed values to Accolade.
l Cells that contain information and data that is not sent to or received from
Accolade. For example, label cells.

Enter all the labels, column headings, background color, formulas, and so on, into the
cells that do not receive or send data to Accolade to verify that the worksheet looks as
you intend it to for users.

It can be useful as you are laying out the display worksheet to name the
upload and download cells to more clearly identify them in the layout prior
to entering the field codes to establish the data connection with Accolade.

You can add additional display worksheets, as necessary.

6. (Optional) Rename Sheet1 to an appropriate, meaningful name for the display
worksheet for users completing the template.

7. Create cell references between the display worksheet (originally Sheet1) and the
SGM_DeliverableActivities worksheet.More...
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Cell Purpose on Display
Worksheet Instructions

Cells that only display
downloaded data from
Accolade

On the display worksheet, in the cells that display
the current metric value when the document is
downloaded and opened, create cell references to
the corresponding "current value" cells on the left
side of the SGM_DeliverableActivities
worksheet. You can also use field codes to pull
metadata and metrics into the document.

Cells that document
owners change to upload
back to Accolade

On the SGM_DeliverablesActivities worksheet,
in the "new value" cells on the right side of the
worksheet, enter cell references to the cells on the
display worksheet where the document owner
enters information that determines what
information is added, updated, or removed for the
deliverable and activities to which this template is
associated.

See step 8 for the columns on the right
side of the SGM_
DeliverablesActivities worksheet that
can update data.

8. In the Action column on the right side of the SGM_DeliverablesActivities worksheet,
ensure that a formula or mapped cell enters one of the following values:

l ADD - Adds a new activity to the deliverable identified in the Deliverable ID column.
The template can only add activities; it cannot add deliverables. If the Action column
is set to Add, the ID entered in the Activity ID column is ignored. You do not need to
enter a value for the template to add the activity.

l DELETE - Deletes the activity from the deliverable. The template can only delete
activities; it cannot delete deliverables. The document must be set in the process
model to allow deletions of versions.

l UPDATE - Updates the deliverable or activity information to match what is in the
columns on the right side of the worksheet when the document based on the
template is uploaded and published.More...

To update an existing deliverable or activity, the Deliverable ID and Activity ID must
match the original ID in column A and B for the corresponding deliverable or activity.
The template can update data contained in the following columns on the right side of
the SGM_DeliverablesActivities worksheet:

l Name
l OwnerLogin (see notes section below)
l Start
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l Deadline
l Function System Name (see notes section below)
l Status ID (see notes section below)
l Status Notes

If the Action field is blank or contains any other value, no action is taken on the
deliverable or activity identified in that row when the document is saved and published
to Accolade.

9. Protect the display worksheet.

Protecting the display worksheet keeps users from overwriting cells that contain
references or formulas.

Important! Do not protect the entire workbook. The SGM_ worksheets must
remain unprotected for the download and upload between Accolade to work
correctly.

10. In the display worksheet, remove the lock on the cells that users use to update metric
values.

11. Hide the SGM_DeliverablesActivities worksheet, as this is a worksheet that users
interacting with the template do not need to see.

Prior to saving, select the cell in the display worksheet where a template
user typically starts typing in the template to default the cursor to that cell
when the template is opened.

12. Save the file and add the template to the Template Library.

Notes:
l Valid status IDs are as follows:

l 1 - Completed.

l 2 - In Progress

l 3 - Not Started

l 5 - Not Required

l If the Enforce function on user selection option is selected for a deliverable or
activity within the process model the project follows, you cannot change the
function using this template. The owner in theOwnerLogin column must be
assigned the function in the Function System Name column when the enforce
option is set.

l TheWorkflow in Progress status can only be set through the Accolade website
or in Microsoft Project plans.
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l Enter all dates in dd-mmm-yy format. Dates that do not use this format are not
updated when the file is uploaded to Accolade.

l Sopheon recommends that all SGM_ worksheets should be hidden prior to
publishing for use in a process model, to prevent users from making inadvertent
changes. Do not rename these worksheets, and do not delete them from the file.

Creating Excel Templates to Request Resources

The resource planning template in Excel can be assigned to a deliverable or activity, allowing
the document owner to request project resources and manage the project's resource plan.

To set up an Excel template to request resources:

Note: The following procedure assumes you are familiar with basic Excel
functionality.

1. Save the Resource Plan Template - Basic <version>.xlsx file to your computer
using a file name that clearly identifies the purpose of the template.

Ensure that the master Resource Plan Template - Basic
<version>.xlsx file is kept in a safe place, such as the template library,
with no modifications to it.

The file contains one worksheet, SGM_ResourcePlan. You can add additional
worksheets to the resource plan template; however, the SGM_ResourcePlan
worksheet must exist.

2. Enter one or more custom properties in the template to define the template's behavior:

Property Description and Notes

SGM_RP_AutofitColumns Controls whether column widths of columns
containing data are automatically set wide
enough to display all of the data in the
column.

Type: Yes or No
Default Value: Yes

SGM_RP_PromptForPeriods Controls whether the Refresh Project Data
dialog box displays to a user downloading the
document.

The dialog box prompts the user to specify
which time periods in the document are
refreshed.
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Property Description and Notes

If this property is set to No, the user cannot
choose to refresh the document and you
should add the Date Range and End Period
Padding properties to the template to
configure automatic time period refreshing.

Type Yes or No
Default Value: Yes

SGM_RP_DateRange Controls how date ranges are refreshed.

If this property is set to Yes, this determines
which date range displays by default in the
Refresh Project Data dialog box, otherwise
this property determines which time period
window displays in the refreshed document.

Type: Text
Accepted Values: COMPLETE, FUTURE,
FIXED

Default Value: COMPLETE
l Complete is from the first day to the last
day of the projects current resource plan.
The last period can be modified.

l Future is from the current time period to
the last day of the project's resource plan.
The last period can be modified.

l Fixed is from the first day to the last day of
the project's current resource plan. The
first and last periods can be modified.

SGM_RP_EndPeriodPadding Specifies how many time periods are
automatically added to the end of the default
time period window.

This property is ignored if SGM_RP_
PromptForPeriods is set to Yes.
Type: numbers
Default value: 0

SGM_RP_Stages Identifies the project stages for which
resource data is imported or exported.

If the property is not defined, all resource plan
data is retrieved.

Type: Text
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Property Description and Notes

Accepted Values: The possible values
include a comma separated string of the
following:
l The string "[Project]" - Retrieves the
resource plan for the project as a whole.

l Whole numbers - Retrieve the resource
plan for each stage whose absolute
number is listed. For example, the number
3 retrieves the plan for the third stage in
the project.

l Positive or negative numbers - Number
such as +1 or -2 retrieve the resource plan
for each stage whose relative relationship
with the deliverable's stage is specified.
For example, "+1" would specify the stage
following the deliverable's stage.

SGM_RP_StartCell Controls where on the spreadsheet the data
is displayed.

The value specifies the top, leftmost
spreadsheet cell in which resource data
displays. The data includes the header row.

Type: Text
Accepted Values: The value must specify
the valid address of a single cell in Excel.

Default value: A1
SGM_RP_
GetRequestedResourcesOnly

Controls whether assigned demands are
excluded from the document on refresh, and
ignored on demand update as a result of
document publish.

If the property is not defined, both assigned
and requested resources are included and
updated on document publish.

Type: Yes or No
Default Value: No

For information about adding custom properties to an Excel document, see the Excel
online Help.

3. Save the file and add the template to the Template Library.

4. Add the plan to a deliverable or activity within a model.
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Adding Reference Table Values to Documents

You can create templates for deliverables, activities, gate documents, and reports that contain
values or the entire table from reference tables available within Accolade. Embedding
references to reference tables allows you to pull additional data into templates, while updating
the values in only the reference table. The values in the template update with the current
reference table value when users download the template or document version and refresh the
data.

You can add reference table values using the Accolade Office Extensions add-in, or using
Accolade field codes. You can also add a reference table in its entirety using a specially
named worksheet within a spreadsheet file.

Note: Anyone in your organization can create a template that includes an
embedded reference table, if they have access to the reference table itself.
However, only Administrators and Process Designers with the Template
Access user role can add templates to the Template Library, which is the
repository for templates available within Accolade.

To add entire reference tables using specially named worksheets:

To include an entire reference table, you need to know the reference
table's system name as set in Accolade.

1. Open the spreadsheet and save the file to a convenient location on your computer
using a file name that clearly identifies the purpose of the document.

2. Rename the worksheet containing the reference table as SGM_RT_<system name>,
where <system name> is the system name of the reference table to display.

You can either hide the worksheet containing the reference table, or show it and add
other content to it. Note that the reference table's top left cell starts in cell A1. If you add
content outside the table's cell range, that content could be overwritten if later versions
of the table are larger. Accolade fields added to the worksheet are also refreshed.

3. Save the file to Accolade or add the file to the Template Library as a Process
Document type.

To add a reference table cell value using Accolade field codes:

1. Open the document and save the file to a convenient location on your computer using a
file name that clearly identifies the purpose of the document.

2. Where needed, add the Accolade field code that points to the reference table and
column you want to include:

{*REFTABLE:<TableSystemName> #RowID=(row ID)
#ColumnID=<ColumnSystemName>*}

Example
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{*REFTABLE:sgm_currency #RowID=USD #ColumnID=CurrencyName*}

Displays the value in the USD row of the CurrencyName column of the Currency
reference table.

Creating Microsoft Project Plans as Templates

Insert a process model into a blank Microsoft Project plan to create the initial version of an
Microsoft Project template. You can modify the project plan to reflect only a part of the model,
such as a single stage, and use multiple project plans across a project.More...

Attaching the Microsoft Project plan to the process model allows the template to be available in
each project that uses this model, allowing the document owner to create an Microsoft Project
plan for the project, or portion of a project as reflected in the plan.

A model can contain as many deliverables or activities with Microsoft Project plans as needed.

To create an Microsoft Project plan as a template:

Note: The following procedure assumes you are familiar with basic Microsoft
Project functionality, and that a process model exists, including all its stages,
gates, deliverables, and activities.

1. Open a new file in Microsoft Project.

2. In the Microsoft Project ribbon, navigate to the Accolade menu and select Insert
Model.

3. In the Accolade Server URL field, select or enter the path to the Accolade server and
clickGo to connect to the server.

A list of active models displays in the Select Model list. To include inactive models in
the list, select the Show inactive models option.
To search for a model by model name, enter the name in the Search for Model field
and click Search.

4. Select the model to add to the project plan and clickOK.

All the stages, gates, deliverables, activities, and gate documents are added to the
project plan.

5. Modify the project plan, as necessary.

To tailor a template to reflect only part of the model, delete the stage and
gate summary tasks and any subtask that you do not want to include. If
you delete the summary task for a stage, the subtask deliverables and
activities will not be recreated when the plan is refreshed. However, if you
delete deliverables and activities, and the stage summary task remains in
the plan, the deleted subtasks are recreated when the plan is refreshed.

For information about working on the template in Microsoft Project, refer to the online
help in the Accolade menu in Microsoft Project or to Microsoft Project's own online Help.
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6. Save the file and add the project plan to the Template Library as a Project Plan
template.

7. In the model, select the Microsoft Project plan from the Template Library as the
template for the appropriate deliverable or activity.

When you select the template, only the Microsoft Project plans uploaded to the
Template Library that contain the model you are working in display for selection.

8. Save the changes to the model.

Notes:
l When a model that contains Microsoft Project templates is deleted, the template
is also deleted from the library.

l The Accolade menu in the add-in uses the custom name defined for Accolade.
See "Replacing Accolade Terminology" on page 397 for more information on
customizing terminology displayed in the application.

Online Form Templates Overview

Online forms are intended to allow users to work on their documents or submit new ideas
without having to download templates and upload document versions. Online forms are ideal
for documents that are brief and contain no graphics, such as executive summaries of
research, or for documents with a fixed structure, such as scorecards or idea forms.

An online form contains one more section with rows containing text boxes or list boxes that
users use to update metrics, to record user ideas, and to record and display information in
online deliverables or activity documents. Administrators build the structure of the online form
template. After the template is added to the Template Library, Process Designers can assign
the online form as a template to deliverables and activities within a model. Users open the
online form to complete information for projects based on the model.

Base Templates

Online form templates are written using XML. Create your own XML forms if you are
comfortable and knowledgeable in writing XML code. Each Accolade release contains a set of
base templates that you can use to build templates for your business, including the following
files specific to online forms:

l Process Document - Online Form Example<version>.xml - A base template that
Administrators unfamiliar with XML can use to copy and paste into a text editor.
Creating an online form by copying and pasting from this template file is appropriate in
most cases. The information in this section describes how to create an XML template
using this file as the base.
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l Process Document - Online Form Schema<version>.xsd - The Accolade online
form schema for Administrators who are familiar and comfortable using XML, and who
prefer to create online form templates using an XML editor.

See "Creating Online Form Templates" on page 224 for information about using the examples
to build your own templates.

Idea Forms

An idea form is an online form, and is created using XML and added to the Template Library as
an online form template. An idea form is different from other online forms in content and use.
Its content includes data controls designed to record new product ideas and is the template for
the idea deliverable in an idea model. The selection as the template of the idea deliverable
activates the idea form and makes it available through the Idea menu's Submit Idea option
with using Idea Submission and makes the idea model available for selection in a campaign
model when using Ideation.

Online Form Templates Best Practices

Keep the following set of best practice recommendations in mind when creating templates for
online forms:

l Use the Base Templates Provided from Sopheon - Each Accolade release contains
a group of base templates on the Base Templates Reference Page. Use these base
templates as starting points for templates specific to your organization.

l Design Online Form Content and Layout Before Building the XML File -
Determine what fields to include and how to group them with the form. Gather the
display and system names of any metrics to include with in the form.

l Create Well-Formed XML, following XML Code Practices - Use standard XML
coding practices when creating the XML files for online forms.

l Capitalization - Names of elements and attributes are case-sensitive.
l Angle Brackets - Ensure elements and their attributes are properly enclosed in
angle (< >) brackets.

l Make Your XML Easy to Read - Use indentation and levels to make the code within an
XML file easier to read.

l Test As You Go - Upload and test the form with Accolade as you build the form. XML
files that contain errors in the XML code do not upload to the Template Library
successfully. It is easier to catch errors and troubleshoot the file if you add a small
amount of code to the file and upload then if you create an entire form and upload at the
end.

l Verify the Form in Accolade - Load the file, assign it to a deliverable, and create a test
project that uses the form. Verify that the layout and entry fields have come through as
you intended, prior to adding it to models that your organization currently uses.

Creating Online Form Templates
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Online form templates are written and saved as XML files. You can create online forms using
an XML editor pointing to the Process Document - Online Form Schema<version>.xsd file
provided on the Base Templates Reference Page. Also, you can use the information on the
Base Templates Reference Page to build templates manually.

Each online form uses the following basic structure:

<?xml version="1.0" encoding="UTF-8"?>
<wd:web-document>
  <wd:group>
    <wd:metric-entry>
      <wd:type/>
    </wd:metric-entry>
  </wd:group>
</wd:web-document>

Design the flow of the online form, such as the metrics to include, in what order, and how to
group the items on the page. Metrics with rich text display as unavailable if included in online
forms. Create the form, save it as XML, upload it to the Template Library, and test it using a
test project in Accolade.

See XML for Online Forms for information about each element allowed in the XML file, values,
and acceptable attributes.

To create a template for an online form:

1. Save the Process Document - Online Form Example<version>.xml file to your
computer and open it in a text editor, such as Notepad.

Ensure that the master Process Document - Online Form Example<version>.xml
file is kept in a save place, such as the Template Library, with no modification to it.

2. Open a new, blank file in the text editor to use to create the new template, and save it
with a name that clearly identifies the purpose of the template, using an .xml extension.

Online form templates saved to the Template Library must have an .xml extension.

3. Copy the following elements from the example file into the new template file. These are
the basic building blocks to create the form.

XML Component Description

XML
Declaration

Copy the first line from the example file to the template:
<?xml version="1.0" encoding="UTF-8"?>

The XML declaration is required and should not be modified.
web-document
(start tag)

Copy theweb-document element start tag from the example
file and paste it in the template file below the XML Declaration:
<wd:web-document
  title="Document Title Text"
  xmlns:wd="urn:sopheon-com:sgm:webdoc:1"
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XML Component Description

  xmlns="urn:sopheon-com:sgm:webdoc:1">

Theweb-document element is the primary (root) element of
the online forms and contains all the other elements in the
form.More...

Change the text inside the quotes in the title attribute to reflect
the online form you are creating. In addition to entering text in
the titles of theweb-document and other elements, you can
use codes that display data from Accolade projects, such as
the project name and description.

The two lines after the title in theweb-document start tag
declare the document’s namespaces. The namespace
attributes are required and should not be modified.

web-document
(end tag)

Copy theweb-document element end tag from the example
file (the last line in the file) and paste it as the last line in your
template:
</wd:web-document>

This line is always the last line in an online form. Insert all
additional elements between theweb-document start and end
tags.

Your XML file should look similar to this.

4. Copy the following components from the example file and paste them into your template
file between theweb-document start and end tags to create the layout and content
entry points within the form:

XML Component Description

group
(start tag)

Copy the group element start tag from the example file and
paste it after theweb-document start tag in the template file:
<wd:group
  title="Grid Title Text"
  isCollapsible="true"
  isCollapsed="false">
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XML Component Description

The group element creates a group of rows (inserted using
themetric-entry element) in which users can enter data in the
form. Your online form can have multiple groups.More...

Change the text inside the quotes in the title attribute to reflect
the title of the group within the form. In addition to entering text
in the titles of the group and other elements, you can use
codes that display data from Accolade projects, such as the
project name and description.

group
(end tag)

Copy the group element end tag from the example file and
paste it as the last line of the group in the template file:
</wd:group>

The last line of a group indicates the end of that group of rows
in the form.

metric-entry
(start tag)

Copy themetric-entry element start tag from the example file
and paste it after the group start tag in the template file:
<wd:metric-entry

title="Display Title"
  name="template_ID1"
  metricName="Acc_Sys_Name_1"
  isRequired="false"

isEditable="true"
  inputControl="single-line-text-box">
  <wd:type base="string"/>

Themetric-entry element creates a row in a group in which
users can enter data in the form. Each group can have
multiplemetric-entry elements.More...

Change the text inside the quotes in the title attribute to reflect
the title of the field within the form. In addition to entering text in
the titles of themetric-entry and other elements, you can use
codes that display data from Accolade projects, such as the
project name and description.

metric-entry
(end-tag)

Copy themetric-entry end tag from the example file and paste
it after the last line in the metric-entry:
</wd:metric-entry>

The last line of ametric-entry indicates the end of that entry
field in the form.

type
(start and end
tag)

Copy the type element start and end tag from the example file
and paste them before themetric-entry end tag:
<wd:type base="number">
  <wd:leftDigits value="6"/>
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XML Component Description

  <wd:rightDigits value="2"/>
</wd:type>

Your XML file should look similar to this.

5. Add comments to explain the purpose of portions of the XML code.

The second line in the example form file contains comments used to explain and identify
the elements in the document. Copy the comments line from the example file to your
template file, anywhere you would like to add comments about the purpose of portions
of the XML code.
<!--This line contains a comment.-->

Comments begin with <!-- and end with -->. This pattern identifies the text in
between as a comment and not part of the actual XML code that is rendered to display
the form. To void misinterpretation, do not include “--” or “-” in your comments.

Your XML file should look similar to this.

6. Save the template file.

To test the template in Accolade:

1. After you have added all the groups and metric entries to the form, save the file and add
it to the Template Library.

If there are errors in the XML structure, the template fails to upload. Look for the
following common XML structure errors:

228



Administrator's Guide

Sopheon Accolade Version 16.2

l Missing angle brackets, especially at the end of a start tag.

l Missing end tags.

l Missing slash in an end tag.

l Errors in spelling and capitalization.

2. Assign the template to a deliverable or activity in a model and create a test project.

3. Open the template from a test project and verify the online form's format and entry
within the form.

The template example from the previous procedure creates an online form that looks
like this:

Notes:
l Names of elements and attributes are case-sensitive. For example,Web-
Document is not the same asweb-document.

Portfolio Snapshots Overview
Portfolio snapshots are saved records of project data at a specific point in time, creating a
history of metric and resource changes across projects.

A portfolio snapshot includes the following information:

l Project metadata, such as dates, descriptions, and names.

l Resource data.

l Matrix data

l Select metric data.

Metrics and matrices are the only type of snapshot data that is selected for inclusion or
exclusion from snapshots. All other content is included in each snapshot.

When you have a sufficient history of project metric values, reports can be created to show
how metric values and resources have changed over time.

Snapshot Database

Snapshots are saved in a separate database, usually named Accolade_Snapshots.
Snapshots create multiple records of each selected metric; therefore the snapshots database
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may need to be larger than what would be needed to store only the current metric values, and
the rate at which the database is filled will increase as well. Saving the snapshots in a separate
database helps to minimize the effect of saving and accessing this data on Accolade. It is
important to ensure that the snapshots database has enough storage capacity to handle the
needed data and to ensure that the number of saved snapshots, and the number of metrics
included in each snapshot, does not overwhelm the available space.

Selecting Metrics and Matrices to Include in Portfolio Snapshots

Each metric or matrix that is available to reporting can be selected for inclusion or exclusion in
a snapshot. All other content is included with no need to select the content.

Important! Every metric and matrix included in snapshots is saved to the
snapshots database each time a snapshot is taken. Select only the items that are
required for portfolio history purposes.

Process Designers select the metrics and matrices that are included in portfolio snapshots.

To select a metric for inclusion in a snapshot:

1. From the Systemmenu, select Content Sources > Metrics.

2. Click the name of the metric to edit.

3. Ensure the Available to Reporting option is selected.

4. From the Systemmenu, select Content Sources > Portfolio Snapshots.

5. Click Configure Snapshots and selectMetrics.

6. In Select Metric(s), select the metrics in the left list that you want to include in
snapshots and move them to the Selected list on the right.

Select a category to refine the list of displayed metrics.

7. Click Done to save your changes.

To select a matrix for inclusion in a snapshot:

1. From the Systemmenu, select Content Sources > Matrices.

2. Click the name of the matrix to edit.

3. Ensure the Available to Reporting option is selected.

4. From the Systemmenu, select Content Sources > Portfolio Snapshots.

5. Click Configure Snapshots and selectMatrices.

6. In Select Matrice(s), select the matrices in the left list that you want to include in
snapshots and move them to the Selected list on the right.

Select a category to refine the list of displayed matrices.

7. Click Done to save your changes.
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Notes:
l Rich text metrics cannot be added to snapshots. If a matrix containing a rich text
metric is added to a snapshot, the rich text metric is automatically excluded from
the matrix's snapshot data.

l Metric and matrix data is removed from saved snapshots if the metric or matrix is
deleted, made unavailable to reporting, or removed as a selected option in the
snapshot configuration. If a project is deleted, the project and all its data are
removed from saved snapshots.

l Adding metrics and matrices adds the values to all future snapshots. Existing
snapshots contain a placeholder for the metric or matrix with no value.

Creating Scheduled Snapshots

Use the Task Scheduler on the Accolade server to create a scheduled, timed snapshot.

To create scheduled snapshots you must have the following permissions and rights on the
Accolade and snapshots servers:

l Administrators with administrator rights to the Accolade server.

l A user account with SGM_Write or db_owner role on the Accolade and snapshots
databases.

The procedure below assumes that you are familiar with server and database management.

To start a snapshot series:

Note: You cannot start a series while another series is running.

1. On the Accolade server, in Administrative Tools, open Task Scheduler and create a
new task.

The Create Task dialog box displays.

2. On theGeneral tab, name the task, enter a description, and select the security options.

You can select an option to run the series whether the user account you select is logged
on or not.

3. On the Triggers tab, click New and select the frequency and time that the snapshots for
this series are taken.

4. In the list next to the Days option, select the last day of the month to create monthly and
quarterly snapshots.

Set the task to start during off hours when Accolade is not heavily used.

5. On the Actions tab, click New, leave Start a program selected in the Action list, and
select TakeSnapshot.exe in the following default location:

C:\Program Files\Sopheon\Accolade\Bin\TakeSnapshot.exe.
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The user running Task Scheduler must have administrative rights on the application
server to use TakeSnapshot.exe.

6. In the Add arguments field, enter the snapshot series' name.

Add optional arguments to display the series type and description within Accolade.

Enter the name and arguments in the following format: (snapshot name) /type:"(type
name)" /desc:"(description)" [without parentheses].

For example: Evening Snapshot /type:"Daily" /desc:"Records final data for the day."

7. Configure the task further on the Conditions tab and the Settings tabs, as necessary.

8. ClickOK to save the task.

Notes:
l To stop a scheduled snapshot, double-click the task in the Task Scheduler and
click Delete. To stop a series temporarily, create conditions that cannot be met.

l To remove individual snapshots taken in the series, display the snapshots in
Accolade (Process > Portfolio Snapshots), select the check box in the
column and click Delete.

Taking Individual Portfolio Snapshots

Administrators and Process Managers can take an individual portfolio snapshot to save a
record of portfolio data at a specific point in time.

To ensure that the server that stores the snapshot data maintains enough space, review the
snapshots currently saved and delete any, as necessary.

To take an individual portfolio snapshot:

1. From the Systemmenu, select Content Sources > Portfolio Snapshots.

2. Click Take Snapshot and enter the following information to identify the snapshot:

Field Description

Name Enter a name, up to 64 characters long, which identifies the
snapshot. For example, Q2 2015 Portfolio Summary.

Type Enter or select the type of snapshot. The type is a label to identify
a group of snapshots for reporting purposes.

Important! The SYS_Current type is considered a
reoccurring snapshot of the current set of portfolio data
at any given time. Snapshots of this selected type are
overwritten and not saved, as there can only be one
snapshot using the SYS_Current type.
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Field Description

Description Enter a description of the purpose or nature of snapshot. This
description helps other users identify the snapshot.

3. ClickOK to start the snapshot.

Notes:

l To delete snapshots, select the check box in the column of the snapshots to
delete and click Delete.

l Deleting one snapshot of a series has no effect on any other snapshot in a series
or on the series itself.

l Only one snapshot can be taken and saved at a time. To cancel a snapshot that
is in process, click Cancel Snapshot after the snapshot starts.

l The SYS_Current snapshot type cannot be renamed as it has dependencies
that use that name. These may include custom events scheduled to take
snapshots and reporting.
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Defining Process Flow Components

The goal when defining process flows and the components that make up those flows is to
create a repeatable, dependable process for company's needs. The components discussed in
this chapter, along with those in the previous chapter, are the building blocks for created a
repeatable product or service development process.

l Classes

l Workflows

l Reference Tables

Process Designers use the components described here and in the previous chapter when
defining process models, the starting point for projects in Accolade. For more information about
building process models and how each component fits into a model, see the Accolade online
Help.
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Classes to Group Process Models Overview
Classes help ensure that a group of process models have consistent characteristics and
categorize a selection of process models that share a similar process type. The class
designation allows Process Designers to create groups of models that share similar visibility
on Accolade pages, similar event reporting, and other similarities.

Classes set some features of projects based on process models that use the class, such as
whether the project is available on the All My Work page. Each project's basic framework at
creation is a combination of the class characteristics and the process model that uses the
class.

The primary difference between classes is the process model type:

l Gated - A model that follows the Phase Gate process, including one or more sets of
stages and gates.

l Non-Gated - A model that includes one stage but no gates. Non-gated models are
useful as static place-holders and information storage locations in larger systems.

l Idea - A model used for idea submissions. Idea models, like Gated models, can contain
one or more sets of stages and gates.

The accessibility of models can be affected by the access groups of the class it was created
from in the following ways:

l If a user does not have view access to a class, they do not have view access for models
created from that class.

l Models cannot be copied in UI if the class is read only for the user.

l In the model editor page, only classes that the user has edit access and have equal or
higher access groups to the model will be displayed.

Classes Best Practices

Keep the following set of best practice recommendations in mind when creating classes:

l Copy Existing Classes to Create New Classes - If you have a class with a large
number of reasons for events, and you need to create a class that is similar, copy a
class and modify its reason lists rather than creating new reasons manually.

l Use the Same Reason Codes for Event Reasons Across Classes - For reporting
purposes, define a set of reasons for events that may occur in projects that use models
based on each class, and ensure reasons for similar events are the same across
classes. For example, ensure the event reason code for the gate decision to kill a
project is the same for all classes. If the reason codes are different across classes, you
also need to create separate gate decision reports for each class.
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l Create Unique Event Reason Codes without Reusing Deleted Codes - If you
delete a reason that has not been selected in a project, the reason is deleted, and you
can reuse its code. However, if you delete a reason that has been associated with an
event in a project, the code is removed as an option from future projects, but remains
assigned to events in existing projects for reporting purposes. If you re-use the deleted
code, Accolade associates events previously linked to the deleted reason code with the
new reason code. For this reason, Sopheon recommends using only unique codes and
to avoid re-using deleted codes.

l Manage Classes for Accolade Innovation Planning Projects Appropriately -
Accolade creates classes and associated models for planning projects as Planners
create element types for planning and roadmapping. Changes to the class, such as
changing the name or deleting the class, are reflected in the element type. Ensure that
users with the Planner user role that are allowed to create element types and Process
Designers within your organization understand that the changes to a class also change
the element type.

Modifying Existing Classes

Consider how modifying an existing class changes projects and models based on that class.

Changes made to the following class details are reflected in models using the class and in
current and future projects that use those models. All class changes apply to projects created
after the class changes are saved.

l Display name

l System name

l Description

l Email notifications

l Project included on All My Work page

l Assignments included on All My Work page

l Include in Save to Accolade from Microsoft 365 applications.

l Changing Gate Line-up setting or the Reporting setting a default selection to an
'always' selection. Note that changing these settings enables the field in open
projects, but the setting is not automatically changed.

l Changing the Reporting flag from a default selection to an 'always' selection

l Class icon selection

l Class-specific terminology changes

l Adding, deleting, or modifying event reason lists change the lists in current and
future projects.

237



Chapter 3  Defining Process Flow Components

Administrator's Guide

Creating Classes

A class categorizes a selection of process models that share a similar process type, and
serves as a template for the models and projects created that are based on them.

To create a class:

1. From the Systemmenu, select Process > Classes.

To narrow the class list, search by the class name, system name, or category.

2. Do one of the following:

l To add a new class - Click Add New in the upper right corner of the page.

l To create a class based on an existing class - Click in the Copy column to
create a copy that can be used as a base to build a new class.

l To edit an existing class - Click the name of the class to open it for editing.

To copy a class to use as a base for a new class you must have "Can
Edit" for any access group in the system and "Can View" for at least one
access group on the class. If you "Can Edit" any of the access groups the
class belongs to, the copy will have those groups. If you do not have "Can
Edit" on any of the class' access groups, the copy will inherit your highest
access group you can edit.

3. Complete the following information to identify and describe the class:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
class.

System Name Enter a unique, shorter name that identifies the class in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among classes and can contain only
letters (English alphabet), numbers, and the underscore.

Process Type Select the type of process that models created using this class
follow:
l Gated - A model that follows the Phase Gate process,
including one or more sets of stages and gates.

l Non-Gated - A model that includes one stage but no gates.
Non-gated models are useful as static placeholders and
information storage locations in larger systems.

l Idea - The model used for idea submissions. Idea models,
like gated models, can contain one or more sets of stages
and gates.
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Field Description

The Idea option is only available if your company uses
the optional Idea Submission or Ideation components.

Note that this selection cannot be changed once the class is
created.

Icon Select the icon that projects based on this class use.

Icons help provide a visual indication of the class type where
projects are listed, including the All My Work and other similar
pages.

Description Enter a description of the purpose or nature of the class. This
description helps others identify the class throughout the
system.

Order Enter a number to specify the class’s place when it displays in a
list of classes.

Lower numbered classes display higher in the list.

4. Complete the additional class options as appropriate for the class you are defining.
More...

Field Description

Gate Line-Up Select whether the projects based on this class display in the
Gate-Lineup pages:
l Default to included - The Excluded from Line-up
check box within the project is initially set to include the
project in the line-up pages. Process Managers and
Project Managers can change the value within projects,
as necessary.

l Default to excluded - The Excluded from Line-up
check box within the project is initially set to exclude the
project from the line-up pages. Process Managers and
Project Managers can change the value within projects,
as necessary.

l Always included - The Excluded from Line-up check
box is set to include the project in the line-up pages and is
view only within the project.

l Always excluded - The Excluded from Line-up check
box is set to exclude the project from the line-up pages
and is view only within the project.

Reporting Select whether data from projects based on this class is
included in reports:
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Field Description

l Default to included - The Excluded from Reports
check box within the project is initially set to include the
project data in reports. Process Managers and Project
Managers can change the value within projects, if
necessary.

l Default to excluded - The Excluded from Reports
check box is initially set to exclude the project data from
reports. Process Managers and Project Managers can
change the value within products, if necessary.

l Always included - The Excluded from Reports check
box is set to include the project data in reports and is view
only within the project.

l Always excluded - The Excluded from Reports check
box is set to exclude the project data from reports and is
view-only within the project.

5. Select the Active check box when the class is ready to use in process models.

6. Select the Is portfolio check box to allow projects that use this model to be a parent
project in a collection of projects, called a portfolio.

Selecting this option displays the Portfolio page within projects, which lists projects that
are linked using the Member Of link type. See "Creating Project Link Types" on page
407 for more information on using project links.

7. Select the Enable email notifications check box to send notifications by default via
email about events in projects that use models that are based in this class.

8. Select one or more of the "Include in" options to make projects based on models that
use this class available throughout Accolade.More...

Field Description

Include in
Work Pod

Select this check box to allow projects as well as deliverables
and activities to display in the Work pod.

Include In
Portfolio
Optimizer

Select this check box to include projects in Accolade Portfolio
Optimizer.

Typically, projects that do not include resources, for example
projects that are only grouping mechanisms for other
projects, are excluded from Portfolio Optimizer.

This selection is only available if your company
uses the optional Portfolio Optimizer component.

Include In
Resource

Select this check box to include projects in Resource Editor.
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Field Description

Editor Typically, projects that do not include resources, for example
projects that are only grouping mechanisms for other
projects, are excluded from Resource Editor.

This selection is only available if your company
uses the optional Resource Planning component.

Include in
Save to
Accolade

Select this check box if you want users to be able to use Save
to Accolade functionality to save documents and project
plans to projects that use models that are based in this class.

Include in
Time Tracking

Clear this check box if projects created using this class do not
require time to be tracked against them.

Leave the check box selected if timesheet users can add
projects created in this class to their timesheets to record time
worked on that project.

This selection is only available if your company
uses the optional Time Tracking component.

Show in
Planning

Select this check box to display projects created using this
class as planning elements in planning and roadmapping.

This option only controls the display of projects as elements
and is available to all class types in Innovation Planning. See
"Creating Classes for Planning Element Types" on page 242
for more information.

This selection is only available if your company
uses the optional Innovation Planning and/or
Roadmapping components.

Create in
Planning

Select this check box and select a process model associated
with this class to make the class available as a planning
element type.

The Include in Planning option is selected by default when
you select this option, so elements created using this type in
Innovation Planning are also available to view within
Innovation Planning.

Note that this option is not available until after a gated or non-
gated class is created and at least one model is associated to
the class.

This selection is only available if your company
uses the optional Innovation Planning and/or
Roadmapping components.
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9. Click Create to create the new class or Apply to save changes to an existing class.

10. (Optional) After you create the class, continue with one or more of the following steps to
complete the class setup:

l Define reason codes for project events to log why certain events in these projects
occurred.

l Configure access group restrictions for the class.

l Set customized terminology to be applied to projects that use a model based in this
class.

Notes:
l To delete a class, display the class and ensure the Active check box is cleared.
Click Delete. If you delete a class that is used by one or more security profiles,
users with those profiles no longer have access rights to projects that use models
assigned to that class.

l Newly created classes are automatically added to the classes available in the
Child Relationship link type if all classes are set as available for that link type.
However, if other link types include all classes, a newly created class is not
automatically added. Update the link type to include the class, as needed.

l If you delete a class used in Accolade Innovation Planning and Roadmapping,
any planning element type based on that class is also deleted and planning
elements that use that type are removed from the planning board and all
planning views. However, models and projects based on that class are not
deleted.

l Resource Planning, Time Tracking, Portfolio Optimizer, Innovation Planning and
Roadmapping are optional Accolade components that you may not have access
to. To implement these solutions, contact Sopheon Customer Support.

Creating Classes for Planning Element Types

Classes can also correspond to planning element types in Accolade Innovation Planning.
When you create a planning class and its associated model with the appropriate options set, a
planning element type with the class name is added to Innovation Planning. The projects that
correspond to planning elements using the element type follow the model that is associated
with the class. If Accolade Innovation Planning is enabled, a default class and model (both
named [Innovation Planning Default] are included in Accolade, but you can create custom
classes for the projects that correspond to planning elements.

Only Gated and Non-gated classes can be element types in Innovation Planning. You can set
Idea classes to show projects associated with the class in Innovation Planning; however, you
cannot set an Idea class to be used as a planning element type to create planning elements
within Innovation Planning.
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To create a class that becomes a planning element type:

1. Create a class.

2. Create the model based on this class, selecting the class in the model.

The model must have at least one stage or gate defined within it. It cannot be an empty
placeholder model.

3. Re-open the class.

4. In the Planning section, select the Create check box.

The Create check box is not visible until after the class is created.
The Show option is selected by default when you select this option so elements created
using this type are also available to view within Innovation Planning.

5. In the Create drop-down list, select the process model created in step 2 to associate it
with the class.

6. Click Apply to save your changes.

Notes:
l The class with the default name of [Innovation Planning Default] is the default
class for projects created when planning elements are added to the planning
board. You cannot delete this class; however, you can rename it and update
some of its details.

l Innovation Planning and Roadmapping are optional Accolade components that
you may not have access to. To implement these solutions, contact Sopheon
Customer Support.

Defining Event Reason Codes in Classes

Reason codes allow detailed history of certain project events, such as changing a project
manager on a project or changing a gate date. For reporting purposes, define a set of reasons
for events that may occur in projects that use models based on each class, and ensure
reasons for similar events are the same across classes. For example, ensure the event reason
code for the gate decision to cancel a project is the same for all classes. If the reason codes
are different across classes, you also need to create separate gate decision reports for each
class.

Note: Event reason codes are not used for automated gate decisions set for gates
in the process model or through an automated workflow step.

To define an event reason code in a class:

1. From the Systemmenu, select Process > Classes. To narrow the class list, search by
the class name, system name, or category.
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2. Either select the class to edit.

3. Click the Event Reason List tab and select a project event type from the Event Type
field.

4. If necessary, click Add New to display a new line for the event code and complete the
following information:

Field Description

Order Enter a number to specify the reason's place when it displays
in a list of reasons.

Lower numbered reasons display higher in the list.
Code Enter a unique, shorter name that identifies the reason in

queries, reporting views, and in Accolade Office Extensions.

Codes help to maintain project history if changes are made to
the reason name.

Name Enter a name, up to 64 characters long, which identifies the
reason to users who assign it to events within projects.

5. Select the Active check box when the reason code is ready to use in projects.

6. Click Apply to save your changes.

Notes:

l To delete a reason code, click the at the end of the reason code's row, and
click Apply to save your change.

Workflows to Complete Documents Overview
Collaborative workflows, provided as an optional Accolade feature, provide a means to define
the sequence of steps and actions needed to create a complex deliverable or activity.
Workflows are useful for deliverables and activities that need to be coordinated in a specific
sequence. Workflows are primarily intended for the creation and review of documents, but they
can be used to manage the creation of other things as well, such as prototypes.

Administrators and Process Designers create workflows and add them to the Template Library
and to models, as necessary. Workflows added to the Template Library are available to add to
a deliverable or activity at the process model level and at the project level. Workflows added to
a model are required before a deliverable or activity's status can be set to Completed.
Workflows added at the project level are considered optional and do not require completion
prior the deliverable or activity's status being set to Completed.

Workflow Steps and Actions

Each step in a workflow is a single part of producing a document, such as creating a draft or
having a portion of a document reviewed. Each step contains one or more actions needed to
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complete the step, or is an automated action that is run after the previous step completes.
Each manual action has an owner who performs the action and a specified number of days
that the action is scheduled to take. When a project is started, the document owner, Project
Manager, or Process Manager starts the workflow. The owners of an action within a workflow
are assigned permissions that determine if they can edit, publish, or approve deliverables or
activities associated with the workflow.

Action owners can either approve a step, which moves the workflow to the action, or reject a
step and move it back to a previous action in the workflow.

After all the steps in a workflow are approved, the deliverable or activity status is set to
Completed.

Workflow Best Practices

Keep the following set of best practice recommendations in mind when designing and building
workflows:

l Communicate Workflow Changes to Project Teams - If changes are required to a
workflow that is saved in the Template Library, communicate those changes to the
project teams. Changes made to a workflow are not reflected in workflows that are in
process within a project. The workflow must be stopped for the changes to take effect.

l Project Level Changes Sometimes Take Precedence - Changes to the numbers of
days for an action completion and the owner assigned to an action within a step are not
overridden at the project level if changes have been made there.

l Use Workflows for Document Review Cycles - Workflows are an excellent method
to track a document through a review cycle. For example, if the document needs to go
through a series of peer reviews prior to the senior manager on a project reviewing it.

l Create Smart Workflows - Smart workflows contain separate sets of metric conditions
that determine the following for the workflow:

l If the actions within a workflow step are included or excluded with the project. See
"Adding Conditions That Determine Workflow Actions Availability" on page 252.

l When a workflow can start. See "Creating Workflows" on page 245.

l If a project is migrated to one or more other models after the workflow is completed.
See "Migrating Projects After Workflow Completion" on page 256.

l Create Master Workflows - Using Smart workflows that contain rules that determine
whether workflow actions are included in the workflow, you can create one or more
master workflows for use across multiple projects.

l Automate Your Workflows - Use automated steps within your workflow configurations
to save your project teams time and manual entry, and to ensure artifacts are recorded
and saved for audit purposes.

Creating Workflows
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Administrators and Process Designers can create workflows to design how several people can
cooperate to create and review a deliverable or activity. Steps and actions within steps can be
added to the workflow for each primary part of the workflow process.

To create a workflow:

1. From the Systemmenu, select Process > Workflows.

To narrow the workflow list, search by the workflow name or system name.

2. Do one of the following:

l To add a new workflow - Click Add New in the upper right corner of the page.

l To edit an existing workflow - Click the name of the workflow to open it for editing.

Edits made to an existing workflow are applied to the workflow in a project if the
workflow has not started, or when a workflow in progress is stopped.

3. Complete the following information to identify and describe the workflow:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies
the workflow.

System Name Enter a unique, shorter name that identifies the workflow in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among workflows and can
contain only letters (English alphabet), numbers, and the
underscore.

Description Enter a description of the purpose or nature of the
workflow.

This description helps other users identify the workflow
throughout the system.

Category Enter or select the group to which this workflow belongs.
More...

Use categories to organize like workflows together. For
example, you may choose to group all the workflows used
for financial approvals, in order to separate them from
workflows that are used for different purposes.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted automatically.
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Field Description

Active Select the check box when the workflow is ready to use in
projects.

Users cannot own
multiple actions

Select the check box to ensure that a single user cannot be
manually assigned to multiple actions in a workflow.

If a user is assigned to an action, their name is not
available for selection as an owner for other actions within
the workflow.

Note: Existing repeated workflow action
assignments are not affected if you select
this setting after a workflow is created.
Assignments for workflow actions on the
Team page of a project supersede this
setting.

Start Conditions Click to add metric conditions that determine when a
workflow can start.More...

Using start conditions helps to ensure that an approval flow
does not start before the defined conditions within a project
are met. The Start Workflow option within the project is
disabled until the project's metric settings meet the defined
conditions.
Click , select a metric to include as a condition, and

click Select. Use the Category and Search options to
refine the list of metrics.

For the added metric, select or enter the value the metric
must meet within the project before the workflow can start.
Add additional metrics, as necessary.

Migration Map Rules Click to add metric conditions that determine if a

project migration occurs using the selected map when the
workflow is completed.

4. Click Create to create the new workflow or Apply to save changes to an existing
workflow.

5. On the Steps tab, add manual or automated steps to the workflow process, for
example, to create PDFs or to set gate dates automatically.

You can also add conditions to determine workflow actions availability or set up
automatic project migration after a workflow is completed.

6. (Optional) On the Security tab, follow the instructions listed in "Restricting
Configuration for Workflows" on page 39 to configure access group restrictions.
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7. (Optional) On the Security tab, click Process Model Usage to see the list of process
models that the workflow is associated with. The list includes all process models the
workflow is included in, as well as links to the process model's component tree pages
you have Edit access to.

Notes:
l See the Adding Steps to Workflows topic in the online Help for information about
adding conditions to actions within workflow steps for Smart workflows.

l Collaborative Workflow is an optional Accolade component that you may not
have access to. To implement this solution, contact Sopheon Customer Support.

Adding Steps to Workflows

Workflows consist of a series of steps that mark each primary part of the workflow process. For
example, a step can represent a single person's review and approval within a chain of reviews
that must happen in order (peer review, team leader approval, and department or higher level
approval). Each step contains one or more actions that indicate something that an action
owners needs to complete to accomplish the step. Each action includes an owner and a time
frame, and can contain other details.

Add multiple actions to a step to enable several people to work on the deliverable at the same
time.

Workflow actions can also include conditions that determine if they are
included within the workflow in a project based on metric values with the
project.

To add manual steps to a workflow:

1. After creating the workflow, click the Steps tab, click Add Step in the lower right corner
of the page, and complete the following information to identify the manual step:

Field Description

Step Name Enter a name that identifies the workflow step.

This name displays to users in the project.
Step System
Name

Enter a unique, internal name the system uses to identify the
workflow step.

The system name must be unique across all workflows.
Proceed after
1 Decision

Select this check box if the first approval or "reject but continue"
decision in a multi-action step moves the workflow forward to the
next step without waiting for other reviews.
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Field Description

If this check box is not selected, the workflow does not move to
the next step until all reviewers in a multi-action step have
responded.

The first decision to reject and send the workflow back sends the
workflow back to the step that the reviewer selects whether this
check box is selected or not.

2. Add action details necessary to complete the step:

Field Description

Action Name Enter the name of the action performed during this step.

Workflow steps must have at least one action.

To add additional actions to a step, click Add
Action.

Action System
Name

Enter a unique, internal name the system uses to identify the
workflow action.

The system name must be unique within the step.
Description To add additional details about the action in a step, enter any

additional notes.
Function (Optional) Select the job function that the owner of this action

should have.

To enforce user selection based on function for all deliverables,
activities, workflow actions, and gatekeeper selections, use the
Enforce on user selection option for the model available on
the Pages & Layouts tab within the model editor.

Select this check box to limit the selection of users to those who
have the function defined. Selecting this option disables the
ability to change the function for the workflow action and is
enforced even if the function is inactive.

Owner (Optional) Click to select the user who owns this action.

To filter the list of users, enter one or more search criteria to
filter by name, login name, email address, function, or extended
field.More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
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Field Description

assign any user.
l Clicking the Show advanced filters check box displays or
hides the additional filter options.

l Clicking Clear removes the current user assignment and
displays [None] to indicate that no user is assigned.

If an action has no owner, no replacement owner can be
selected for the action in the project after the workflow has
reached the step containing that action. However, if an action
does have an owner selected, a different owner can be selected
for the action even after the step has started.

Changes to theOwner field are not propagated into existing
projects and can only be made by the deliverable owner,
Project Manager, and Process Manager at the project level for
workflows in existing projects.

Only users assigned the Document Reviewer role are available
for selection as an action owner.

Permissions Select what the owner can do in this workflow step:
l Can Edit and Publish - The owner can upload and publish
a version of a deliverable or activity associated with the
workflow for other Accolade users.

l Can Edit - The owner can upload, but not publish, a version
of a deliverable or activity associated with the workflow.

l Can Approve - The owner can approve the action in the
step for the workflow to move forward, but cannot upload or
publish a deliverable or activity.

Select the Can Skip check box if the action can be skipped
when there is no owner assigned.

If the step contains a single action with no owner, the step is
skipped as soon as the step is reached in the workflow process.
If the step contains multiple actions, some of which contain
owners, the step is not skipped immediately, and the
deliverable owner is able to select an action owner during the
step.

Auth Req* Select this check box if the owner of this action must enter
authorization credentials to enter a decision on the action.

# Days Enter the number of days from the start of the step until a
decision is due. A notification email is sent to the action owner
after this time has elapsed. Document owners, Project
Managers, and Process Managers can update the number of
days within the workflow in a project.
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Field Description

In the project, a step lasts until the required decisions have
either sent the workflow to the next step or returned it to a
previous action, step, or the deliverable owner.

Changes to the # Days field are not propagated into existing
projects and can only be made by the deliverable owner,
Project Manager, and Process Manager at the project level for
workflows in existing projects.

Conditions Click to add metric conditions that determine if an action is
included within the workflow in a project.

* If your workflow settings require re-authentication, and your Accolade implementation runs in a Windows
Authentication environment (not Single SIgn-On), consider changing the Authentication Provider on
Accolade.Asp under the RemoteAuth directory in the main website to NTLM only. Redirect all hostname
traffic to the fully qualified domain name of your server in IIS. This ensures consistency in the workflow
behavior across all supported browsers.

3. Repeat steps to add additional steps to the workflow.

4. Click Apply to save your changes.

To add automated steps to a workflow:

Note: Automated workflow steps should follow the step that activates the
automation upon completion. If an automated step is the first step within a
workflow, it activates when the workflow starts. If an automated step is the
last step within a workflow, the step completes the workflow.

1. After creating a workflow, click the Steps tab, click Add Automated Step in the lower
right corner of the page, and complete the following information to identify the
automated step:

Field Description

Automated
Step Name

Enter a name that identifies the automated workflow step.

Automated
Step System
Name

Enter a unique, internal name the system uses to identify the
workflow step. The system name must be unique across all
workflows.

2. Add action details necessary to complete the step:

Field Description

Automated
Action Type

From the drop-down list, select the automated action that occurs
during this step:
l Set Gate to Today's Date - Select this option to
automatically set the gate date to the current date when the
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Field Description

previous step within the workflow is completed. If the
workflow is in a stage that does not have a gate, the
automated step is skipped.

l Generate PDF from Template - Select this option to
automatically generate a PDF that is published as a
deliverable or activity version. A deliverable or activity can
contain a template assigned to the deliverable or activity, or a
template that is assigned specifically to use for generating a
PDF from a workflow step. Select which template to use for
the PDF generation.

l Set Gate Decisions - Select this option to automatically set
the gate decision for the upcoming gate based on the
calculation of metrics set in the project.

l Publish Latest Document Version - Select this option to
automatically publish the latest version of the deliverable or
activity, thus updating metric values on the project, which
provides gatekeepers visibility into the approved metrics. The
automated action updates metrics based on the update rights
of the previous workflow action owner. If there is no version
available, the workflow history indicates no action was taken.

Automated
Action System
Name

Enter a unique, internal name the system uses to identify the
workflow action. The system name must be unique within the
step.

Conditions Click to add metric conditions that determine if an action is
included within the workflow in a project.

3. Click Apply to save your changes.

Notes:
l To reorder steps in the workflow, click on the arrows next to the name to move
the step up or down.

l To delete a workflow step, delete all the actions within the step using the next
to each action. To delete an entire workflow, display the workflow, ensure that is
currently inactive, and click Delete.

l Updates to a workflow such as adding steps and actions and making changes to
Permissions and Can Skip fields are not copied into the project if a workflow is
in progress, but are added when the workflow is stopped and restarted.

l Collaborative Workflow is an optional Accolade component that you may not
have access to. To implement this solution, contact Sopheon Customer Support.

Adding Conditions That Determine Workflow Actions Availability
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Workflow actions can include a set of conditions that determine if they are included within the
workflow in a project based on the metric values set within that project. Use "smart" workflows
if you want to define one or master workflows for use across multiple projects.

Process Designers can add the "smart" workflow to one or more models, and the metrics
within the conditions in the workflow are automatically associated to the model. Document
owners can select a "smart" workflow to add to a deliverable or activity within a project. If the
metrics within the workflow are not part of the project, the workflow ignores the conditions and
the actions are included in the workflow. Workflow actions with no conditions defined are
always included with the workflow.

Example

Your company may have a workflow for budget proposals for projects or portions of projects.
You may choose to show or hide an action requiring someone's review and approval
depending on the total amount in the budget proposal. Smaller amounts may not require a
higher level of management or corporate approval, and the reviewers of a proposal across
regions may vary.

In this example, define metrics that reflect the budget proposal amount and the region set for
the project. Depending on your setup, these may be calculated metrics based on other values.
Within the workflow action configuration, define conditions that include the region and budget
proposal metrics and the values required for the action to be part of the workflow.

To add a condition that determines a workflow action's availability within a project:

Note: Prior to adding a workflow condition, determine the metric names and values
to use to create the conditions that show a workflow action.

1. From the Systemmenu, select Process > Workflows and select the workflow, or
create a new workflow.

2. Ensure the Is Smart option is selected, and create workflow steps as described above.

3. If necessary, click the Steps tab to display the steps and actions defined for the
workflow.

4. In the Conditions field for a manual or automated action, click Add New.

5. Click , select a metric to include as a condition, and click Select.

Use the Category and Search options to refine the list of metrics.

6. For the added metric, select or enter the value the metric must meet within the project
for the action to be included within the workflow.

If the project's metric setting does not meet this value, or the project does not include
the metric, the action is not included in the workflow within the project.

7. Repeat step 4 to add additional conditions that must be met for the workflow action to
show.
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If multiple conditions are entered, all conditions must be met for the action to be
included in the workflow within the project. If conditions dictate that no actions are
needed to complete the workflow, the workflow automatically runs to completion and
displays in the associated deliverable and workflow history as Completed.

To edit a condition, click to delete it and repeat step 4.

8. ClickOK to return to the workflow steps.

9. Click Apply to save your changes.

Notes:
l Collaborative Workflow is an optional Accolade component that you may not
have access to. To implement this solution, contact Sopheon Customer Support.
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Setting Gate Decisions Using Workflows

Workflows can include an automated step that sets the decision for the upcoming gate based
on metric values set within the project. The decision for the gate is automatically set according
to the metric conditions set within an automated step for each decision type, removing the
need for manual entry of gate decisions or gatekeeper voting.

Note: Process models can also be configured to automatically set a gate decision
based on a set of metric conditions. Sopheon recommends using the
Automated Gate Decision Rules settings within the process model or a
workflow automated step to automate gate decisions, but not both.

When a workflow reaches the automated step to set the gate decision, Accolade processes
the decisions in the following order and sets the decision to the first one that matches the
metrics assigned:

l Go

l Kill

l Hold

l Recycle

l Pending Decision

Gate decision names, such asGo and Hold are fully customizable and may differ for your
Accolade installation. See your company's Process Designer for the names your company
uses for these decisions.

A Conditional Go decision cannot be set using an automated gate decision and event reasons
are not captured for automated gate decisions.

Setting gate decisions to set automatically does not prevent a gate owner
from entering a decision manually and updating gate details. To ensure
that gate details are not modified after setting the gate decision, consider
setting the gate data to read-only using the Set Gates Page to read-
only option in the process model.

Each workflow can have only one automated step that sets the gate decision. An automated
gate decision step does not prevent steps after it from running. Additionally, if a project is set to
require gatekeeper approval to pass a gate, the gate decision is set to Proposed.

To set a gate decision using an automated step in a workflow:

Note: Prior to adding a gate decision automated step, determine the metric names
and values to use to create the conditions that set each decision type.

1. From the Systemmenu, select Process > Workflows and select the workflow, or
create a new workflow.
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2. If necessary, click the Steps tab to display the steps and actions defined for the
workflow.

3. Click Add Automated Step and select Set Gate Decision as the automated action.

4. For each gate decision listed, click the gate decision link and complete steps 5 to 7.

5. Click , select a metric to include as a condition, and click Select.

Use the Category and Search options to refine the list of metrics.

6. For the added metric, select or enter the value the metric must meet within the project
for the gate decision to be set, and clickOK.

7. Repeat step 5 to add additional conditions that must be met for the decision to be set.

If multiple conditions are entered, all conditions must be met to set the gate decision.

To edit a condition, click to delete it and repeat step 5.

8. ClickOK to return to the workflow steps.

9. Click Apply to save your changes.

Notes:
l Collaborative Workflow is an optional Accolade component that you may not
have access to. To implement this solution, contact Sopheon Customer Support.

Migrating Projects After Workflow Completion

Workflows can include rules that migrate a project to a different model after the workflow has
been completed and approved. When the workflow is completed, Accolade uses the metric
settings and the workflow migration rules set in the workflow configuration to determine which
migration maps to use and automatically migrates the project. Automating project migrations
using workflow migration rules removes the need to manually migrate a project after a
workflow has been completed.

Consider the following when configuring a workflow to start a project migration:

l Only approved workflows can start a project migration. Workflows that are completed
but rejected do not start the migration.

l A single workflow can contain multiple rules that result in a single project being migrated
multiple times.

l All other workflows in the project are stopped when the project migration starts. Ensure
that your configure is set correctly so that workflows that contain finish conditions, such
as setting gate decisions, are not stopped before those events take place.

l If a migration map is set to close the original project after the migration, all migrations
complete before the original project is set to Closed.
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l If a migration map does not contain the correct model setup, the migration does not
complete.

To migrate a project after a workflow has completed:

1. From the Systemmenu, select Process > Workflows and select the workflow, or
create a new workflow.

2. In theMigration Map Rules table, click , enter a unique name and system name to
identify the rule, and select the migration map that Accolade uses for the automatic
migration.

3. Click on the Conditions to define the metric conditions that must be met to migrate
using the selected map.

4. Click , select a metric to include as a condition, and click Select.

Use the Category and Search options to refine the list of metrics.

5. For the added metric, select or enter the value the metric must meet within the project
for the workflow approval to trigger the migration, and clickOK.

Repeat as necessary to add additional conditions that must be met for the workflow to
start the project migration. If multiple conditions are entered, all conditions must be met
for the project to migrate.

6. Repeat steps 2-5 to add migration rules for other migration maps.

You can define multiple rules for the same migration map.

7. ClickOK to return to the workflow configuration.

8. Click Apply to save your changes.

9.

Notes:

l To delete a migration rule, click next to the rule in theMigration Map Rules
field.

l Collaborative Workflow is an optional Accolade component that you may not
have access to. To implement this solution, contact Sopheon Customer Support.

l When workflow migration starts the Project Leader and WF Action Owner will
receive notifications that migration has begun, and when it completes these
users will receive a notification that migration has completed with information
about the migrated project.

Additional Reference Information Overview
Reference tables make a variety of reference information available to users through reports
and in documents for use as deliverables and activities. Reference tables are also used to
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import data, such as resources and project links into Accolade. Reference tables not only
contain standard reference information, such as cost tables and specification sheets, but can
contain currency conversion rates, strategic corporate targets or limits, and even custom terms
that you might want to expose in documents using the REFTABLE field code.

Administrators and Process Designers upload the initial version of a table to Accolade and
assign an owner to the table. The owner maintains the table and updates it as necessary. Later
versions of tables can be uploaded manually or automatically. Most reference tables are
spreadsheet files either created manually using the Accolade Office Extensions add-in, or
using online reports. Accolade also supports uploading reference tables in CSV and XML files,
both manually and automatically.

Using reference tables, you can:

l Import data into Accolade - Use a set of paired reference tables to import large
amounts of data into Accolade. Specifically, you can use named pairs of reference
tables to import resources, pools, capacities, and demands; projects and project links;
matrices; metric security; and security list information. See "Importing Project Data and
Configuration" on page 431 for more information.

l Maintain currency conversions - Create a reference table that contains the date-
specific exchange rates for the currencies your company uses. As exchange rates
change, the reference table manager can add additional rows to subsequent versions of
the table while still preserving the exchange rates for prior dates. See "Defining the
Currencies Used in Your Company" on page 416 for more information.

l Include data in deliverables and activities - Display individual reference table values
in deliverables or activities using Accolade field codes with the REFTABLE source. To
display correctly, these tables must have unique values in each row of the first column
of the table so that the row can be identified in the code. In addition, it is possible to
display an entire reference table in a deliverable or activity.

Reference Table Security

Each reference table is added to an access group so it uses that access group's security. Like
security for projects, security for reference tables affects the data that displays in reports and
what displays in Search results:

l Users can only refresh a report containing a reference table if they have the rights to the
table.

l Users can only see the content of reference table field code if they have access rights to
the table.

The access group security does not extend to the creation and ownership of a reference table.
It is possible for a Reference Table Managers to be assigned to tables that they do not have
access rights to, although this would usually be poor practice as the manager could not view
table contents in reports.
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If automatic uploading of reference table versions is enabled, the security of the ultimate
source of the new versions must be configured outside of Accolade, by controlling which users
have access to the local and remote file locations used for upload.

Requirements and Considerations for Reference Tables

Anyone in your organization can create a reference table. Users with full Reporting Rights can
use the Accolade Office Extensions add-in and online reports to create the table automatically
with the correct placement in a worksheet. You can also create tables manually. After a table is
created, Administrators and Process Designers add the table definition to Accolade and
upload the file.

Accolade supports reference tables as spreadsheet, CSV, and XML files through the
Reference Tables page, and through an auto-loader service. The information and examples
provided are in spreadsheet format.

Reference Table Requirements

A table within a workbook must meet the following requirements to be used as a reference
table in Accolade:

Component Requirements and Considerations

Size and Location l Have at least one column and two rows.
l Must start in cell A1 in the worksheet.
l The first blank cell in the top row determines the
right edge of the table.

l The first blank cell in the left most column
determines the bottom of the table.

Column Headings l Must be in the first row in the worksheet; therefore,
the first column heading is in cell A1.

l Can be named anything, and the name is used as
the column's display name within Accolade. Any
characters other than letters, numbers, and
underscore, and any numbers before the first letter
are removed to create the column's system name.

l Must be unique within the table, and are case
insensitive.

Data l Starts in the second row in the worksheet, directly
under the column headings.

l Is either a number, date, or string. Accolade
recognizes three types of data in table columns:
number, date, and string.

Accolade determines the data type of each column
using the initial contents of the column when the
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Component Requirements and Considerations

table is uploaded for the first time. To force a
column containing only numbers or only dates to be
defined as string type, add a letter in at least one
row of the column in the initial upload. You can
delete the letter from the next version, but the data
type remains "string".

l All dates are in mm/dd/yyyy format.
l The decimal separator in numbers must be a period
(.).

Accolade Field Codes To make the table's values display using Accolade
field codes, for example in documents or calculated
metrics, every value in the table's leftmost column
must meet the following criteria:
l Be unique (case insensitive) in the column.
l Begin with a letter.
l Contain only letters and numbers.
l Contain no more than 16 characters.
In addition, the Unique values in first column check
box must be selected on the Reference Table page
when the table is added in Accolade.

Reference Table Limitations

Reference tables contain the following limitations:

l There can be only one reference table per workbook. You can create templates and
documents using the Accolade Office Extensions add-in. However, when building a
reference table, the spreadsheet file can have only one table that is considered a
reference table.

l Versions after the first can have more columns than the first version, but cannot contain
fewer columns.

l Each cell in the table has a 500 character limit.

l The broken bar ( ¦ ) character is prohibited. Use the pipe ( | ) characters instead. Many
keyboards contain a key that displays a broken bar but that actually inserts a pipe.

Identifying the Worksheet that Contains the Reference Table

The reference table must exist on what is considered to be the first worksheet. In a file where
the worksheets have been renamed, rearranged, or hidden, and it is no longer which
worksheet is the first, create a custom document property called SGM_RefTableSheet and
enter the name of the worksheet that contains the reference table as the custom property's
value. Refer to Microsoft's online Help for information about adding custom properties to files.
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Adding Reference Tables

Anyone in your organization can create a reference table. However, only Administrators or
Process Designers can add the first version of a reference table to Accolade. After a reference
table is added to Accolade, its table owner can then upload later versions and set it for
automatic upload to maintain the contents of the table.

To add a reference table to Accolade:

1. From the Systemmenu, select Content Sources > Reference Tables.

To narrow the reference table list, search by the table name, system name, or category.

2. Do one of the following:

l To add a new reference table - Click Add New in the upper right corner of the
page.

l To edit the details of an existing reference table - Click the name of the
reference table to open it for editing.

3. Complete the following information to identify and describe the content of the reference
table:

Important! Reference tables used for project data or resources imports have
unique naming requirements.

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a unique name, up to 80 characters long, which
identifies the reference table.

System Name Enter a unique name that identifies the table in reporting
views, reports created using the Accolade Office Extensions
add-in, field codes, and other places in Accolade.

The name must be unique among reference tables and can
contain only letters (English alphabet), numbers, and the
underscore.

Description Enter a description of the purpose or nature of the reference
table.

This description helps other users identify the reference table
throughout the system.

Category Enter or select the group to which this reference table
belongs.More...
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Field Description

Use categories to organize like tables together. For example,
you may choose to group all the reference tables used to
import data into the same category, in order to separate them
from tables that provide additional reference information for
users.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Owner(s) Click and enter users that can own updating the details

and versions of this table.

To filter the list of users, enter one or more search criteria to
filter by name, login name, email address, function, or
extended field.More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you are
assigning a user, however depending on the project
configuration, you can assign any user.

l Clicking the Show advanced filters check box displays or
hides the additional filter options.

l Clicking Clear removes the current user assignment and
displays [None] to indicate that no user is assigned.

Table owners maintain the content of the reference table after
its initial upload.

Note: Only users with the Reference Table
Manager user role are available to select as
table owners.

Configuration
Access Groups

Select the access group to which the reference table setup
belongs. A user must be assigned to the same access group
as the reference table to edit details such as the name,
system name, etc.

Note: OnlyOwners are able to upload new
versions of files.

262



Administrator's Guide

Sopheon Accolade Version 16.2

Field Description

Access Group Select the access group to which the reference table content
is available to. A user must be assigned to the same access
group as the reference table to see the table and use the data
within it.
l To make the table and its contents available to all users,
select [None] - Accessible by all users.

l Select [None] - Accessible by all users when adding the
currency reference table.

Note: Administrators and Process Designers can
create reference tables that are outside their
access group rights; however they cannot
see or modify the tables after creation.

4. In the File field, click and select the spreadsheet, CSV, or XML file that contains the
reference table.

The columns from the table in the uploaded file are loaded and display in the Column
Definitions section of the page.

Column data types are automatically determined based on the reference
table information included in the initial upload, either when adding a new
reference table or when adding a new version with new columns to an
existing table. If desired, Number and Date data types for new columns
can be changed by clicking on the Data Type drop-down and selecting
String. Once the columns have been added and you click Create or
Apply, existing data types are not able to be changed in later versions of
the table.

5. Select the Unique Values in First Column check box if the table contains unique
values in each row of the table's leftmost column. Selecting this option allows cell
values to display using Accolade field codes and to reference a cell in the table in
calculated metrics.

Note: If selected, you cannot change this setting in later versions of the
table.

6. Complete the information about version limits and how the file is updated to Accolade.
More...

263



Chapter 3  Defining Process Flow Components

Administrator's Guide

Field Description

Versioning Select how many versions of the table to save in the
database. If you enter a maximum number instead of
selecting Unlimited, older versions of the table are
discarded as newer versions are added.

Sopheon recommends adding no more than
250 versions of a single reference table.

Loading
Schedule

If you want to enable automatic loading of new versions
of the document through either a directory on the
application server or an FTP website, select an option to
upload a version immediately or at a scheduled time each
day.
l Load immediately - Loads any files placed in the drop
box folder on the application server immediately.

l Daily at - Loads any files placed in the drop box folder
on the application server at the time you specify. Note
that this field is in 24-hour time. To upload all files at
10:00 pm, enter 22:00. The time entered is the time in
the application server's time zone, which may be
different than the time zone you are in when entering
the time in Accolade.

If the reference table is assigned to an access group, the
user assigned the Service Account user role must be
assigned the same access group for the reference table
to automatically upload.

If you are creating reference tables for data
import and the imports are large, schedule them
to run overnight. Reference tables for
information such as currency exchanges are
smaller and can load immediately.

If you do not want to enable automatic loading for the
reference table, selectOff.

7. Select one or more of the "Available to" options to make the contents of the table
available to other portions of Accolade.
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Field Description

Available to
Metrics

Select this check box to make the content within the table
available for use in metrics, for example, when defining
list values or to use in creating cascading list or calculated
metrics.

Available to
Portfolio
Optimizer

Select this check box to make the content within the table
available to Accolade Portfolio Optimizer, for example, for
strategic bucket charts or calculated metrics tables.

Available to
Reporting

Select this check box to allow the reference table to be
used in reports created in Accolade Online Reporting or
reports created using the Accolade Office Extensions
add-in. For example, select this check box for reference
tables that contain information that is valuable to report
and track for historical purposes, such as those used for
currencies or target information.

A reference table must also be added to
Accolade as an online report in order to be
available to use in reporting. The reference
table information is included by selecting the
Reference Tables option when selecting
columns to be included in the report. See
"Creating Online Reports within Accolade" on
page 272.

Clear this check box for reference tables used for
importing data into Accolade or for tables that hold values
for configuration, such as cascading list metric values.

8. Click Create to create the new reference table or Apply to save your changes to an
existing table.

9. Review and update the column definitions to provide additional information about the
columns in the reference table.More...

Field Description

Display
Name

Read-only The display name, based on the column
headings from the uploaded file.

System
Name

Confirm or modify the system name for each column.
Column system names must begin with a letter and
contain only letters, numbers, and the underscore
character. They can be abbreviated to make them easier
to use in queries, reports, and Accolade fields.

Data Type Read-only The data type for the column.
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Field Description

Number
Format

For columns that contain number metrics, enter a custom
number format to use when data in Number type columns
is displayed in Smart documents. See "Custom Format for
Number Metrics" on page 158 for more information.

10. Click Apply to save your changes.

Notes:
l To add version notes to a reference table, display the reference table details. In
the Versions of the Reference Table section of the table, click in the reference
table's Comments section to add comments, and click Apply to save your
changes.

l To delete a version of a reference table, display the reference table details. In the
Versions of this Reference Table section of the table, click for the version
that you wish to delete and click Apply to save your changes. You cannot delete
all versions of a reference table.

l To delete a reference table, display the reference table details and click Delete in
the lower left corner of the page. Reference tables that are used in list metric
definitions cannot be deleted until the metric no longer references the table.

266



Sopheon Accolade Version 16.2 267

Designing Charts and Reports

Reporting in Accolade provides a means to summarize and analyze project and other data
within your database, in a format and manner that is most applicable to your organization and
data needs. Reports can range from user login attempts to much more complicated reports
used to analyze projects and completion efficiency or financial information.

Reports can include:

l Metrics

l Project metadata

l System data, such as user information

l Accolade field codes

l Reference table fields

Creating and adding reports within Accolade requires that you complete the following:

1. Determine what report type to create.

2. Define the basis for the report. This is a shell or template structure. When reports are
viewed they are populated with data from Accolade.

3. For MS Excel and HTML Reports, add the report to Accolade. Online reports created
within Accolade are added automatically.

4. Assign who has access and where the report displays.
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Report Formats
Reports in Accolade can exist in the following formats:

l Accolade Online Reports - Online reports created within Accolade are built and
viewable directly within the application without having to write a SQL query. These
reports provide an on-demand reporting experience and can be used for the creation of
Accolade charts. The ability to create and modify online reports is available to any
Accolade user assigned All Reporting Rights, and anyone with Refresh Workbook Data
rights can view these reports. These reports can be added to the Charts & Reports
page within Accolade, and can be added to a pod within a layout in order to view them in
projects.

l HTML Reports - HTML reports can be built using a single SQL query to gather data
from the database, and display as a table in a secondary browser window. This format
has no additional formatting available, so can be useful for simplistic reports, for
example, to determine where process models are being used or to review user access
history. HTML reports are also available for users to send or receive via email. These
reports can be added to the Configuration > Charts & Reports tab within Accolade
and can be added to a process model for availability in a project.

l MS Excel Reports - MS Excel reports are built and viewable in Excel, provide flexibility
in formatting, and are created using the Accolade Office Extensions add-in application.
The add-in provides an interface to create a data report based on Accolade data. You
can also create MS Excel reports using a template and the Accolade query
infrastructure, creating reports based on data pulled into the spreadsheet using queries.
These reports can be added to the Configuration > Charts & Reports tab within
Accolade and can be added to a process model for availability within a project.

Each report type can contain the same data. The report type you choose to build depends on
where the report needs to display within Accolade, the means you want to use to build the
report, and the amount of formatting required to make the data within the report useful when
viewing.

Report Access
Anyone in your organization can design a report, and anyone with All Reporting Rights can
create and save an online report. However, only Administrators and Process Designers can
create MS Excel or HTML reports, or set online reports as available for all users to view within
Accolade. Only Process Designers can associate a report with a process model to display
within a project.

Users must have either Refresh Workbook Data or All Reporting Rights for access to view
shared reports in the Charts & Reports page and through the projects to which they have
access. If the report is restricted by role and/or by access group, users must have a system
user role that matches the report and/or be assigned to an access group that matches the
report.
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Additional rights are required to create and refresh report data using the Accolade Office
Extensions add-in.

Chart Formats
Charts in Accolade can be created using an Accolade online report as a source, and can exist
in the following formats:

l - Bar charts

l - Grouped bar charts

l - Stacked bar charts

l - Bubble charts

l - Line Chart by Columns charts

l - Line Chart Trends charts

l - Pie charts

l - Radar charts

l - Unknown or custom charts

The chart type you choose to build depends on the data to be displayed, so it is important to
select appropriate data types to render a meaningful chart.

Charts Access
Using Accolade online report data, users with All Reporting Rights can create charts on the
Charts & Reports page. Administrators and Process Designers can set charts as available
for sharing with other users, and can add a chart to a pod within a layout to display on a project
page or as a global link.

Users must have either Refresh Workbook Data or All Reporting Rights for access to view
shared charts in the Charts & Reports page and through the projects to which they have
access. If the chart is restricted by role and/or by access group, users must have a system
user role that matches the chart and/or be assigned to an access group that matches the chart.

Reports Best Practices

Keep the following set of best practice recommendations in mind when creating and planning
charts and reports:

l Consider Project and Data Security - Remember, reports respect the security
features such as access groups and security lists that Administrators have defined
within the system. For example, users who select to receive an HTML report through
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email receive a report that contains only information for projects to which they have
access. However, reports contained in emails, including those added as attachments,
can contain private information that should not be shared internally or externally. Use
the Report Privacy Warning Text system parameter to add a line of warning text to
Accolade Online reports, HTML reports, and reports created using Accolade Office
Extensions, to indicate the private or confidential nature of the report contents. The
parameter provides 500 characters for the message.

In addition, all reports created using Accolade Online Reporting and Accolade Office
Extensions contain a custom property that identifies the generated file as a file with
Accolade data. To help ensure sensitive data is not forwarded, use the filter options on
your email server to prevent files that contain the custom property from being forwarded
using email.

l Choose the Best Report Format and Creation Method - The report type you choose
to build depends on where the report needs to display within Accolade, the means you
want to use to build the report, and the amount of formatting required to make the data
within the report useful when viewing.

Method Advantages

Accolade Online
Reporting

Accolade Online reports use a reporting interface similar to
that provided with the Accolade Office Extensions, but
without having to leave Accolade and without having to
access Excel.

Accolade Online reports provide an on-demand, in-
application way to generate a report and ensure that the
report always displays the real-time data from Accolade.

Accolade Office
Extensions

Accolade supports .xlsx, .xlsm, .xltx, and. xltm file types for
MS Excel reports. Accolade Office Extensions provides an
interface to create a data report. Creating reports in Excel
also allows for Excel formatting, as necessary.

You can use reports created with Accolade Office
Extensions in your process documents, add them to related
documents, email them, use them for your own research, or
(if you are an Administrator or Process Designer) you can
activate them on the Configuration > Charts & Reports
tab or on the Reports List pod in projects.

SQL Queries Complicated tables may require the use of SQL queries, for
example, tables that require aggregations other than sum,
average, minimum, maximum, or standard deviation, or in
tables with filters joined with "or".
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Method Advantages

SQL queries leverage the reporting views to gather data
from the Accolade database and require some knowledge
about writing a successful query to gather the information
you want. You can also write your own custom reporting
views to retrieve information from the database.

When you create charts and reports based on SQL queries,
you can include them on the Charts & Reports page or on
the Reports List pod in projects, but you cannot add these
reports to documents or use them in the other ways that are
available to Excel reports.

Accolade Online Reporting Overview
Accolade Online Reporting provides an on-demand reporting option and can be added to the
Charts & Reports page within Accolade. Any Accolade user assigned All Reporting Rights
can create online reports within Accolade.

An online report consists of the following components:

l Data columns - Determines the area of the database, for example Projects or Access
Groups, that are available to retrieve information from.

l Filters - Specifies the criteria to match to include data in the report from specified
columns.

l Users - Indicates which Accolade users have access to view and edit the report. Each
selected user must have report refresh rights to see the report. Users with all Reporting
Rights also have access to change the selected columns and filters within the report
definition.
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Creating Online Reports within Accolade

Online reports provide an on-demand reporting option and can be added to the Charts &
Reports page within Accolade. Any Accolade user assigned All Reporting Rights can create
online reports. Generated content can be added as a report in a project by adding a Report pod
to a layout, and then adding the layout to a process model.

Use the Report Privacy Warning Text system parameter to add a
notification within the report to indicate the content is private or
confidential, and should not be forwarded to others.

To create an online report within Accolade:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the report name or category.

Note: Process Designers can also create or edit charts, reports, and related
configuration by navigating to the Systemmenu and selecting Content
Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new report - Click Add New and selectOnline Report from the drop-
down list.

l To copy an existing report - Locate the report you wish to copy on the Charts &
Reports page.

l

Click in the Copy column. Select, add, or rearrange the columns you
wish to keep. You can also add filters and advanced matrix settings. Click
OK to save changes and progress to the next step. Give your newly copied
report a name, a system name, a category, and a description. Decide if you
wish to transpose the column and row data. Click Save to create the report.

l To edit an existing report - Click the name of the report on the Charts & Reports
page to open it for editing, Click to edit the report columns, or click to edit the
report details.

Only users assigned as report owners and Process Designers with All
Reporting Rights can edit report columns and details.

3. Select a subject from the drop-down list, such as Projects or Users, to display the
column sets available within that subject.

4. Double-click or drag and drop the column names from the left side of the dialog to any
area in the Selected Columns tab to include the column in the report.
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l To search for a column, enter search criteria in the Find field after selecting the
subject.

l Use the and options to expand or collapse the subject data sets in order to
select specific column options.

l To include an entire column set, drag and drop the column set to the Selected
Columns tab.

l To change the column order of selected columns, drag and drop a column into a new
location within the list.

l To display the totals for number columns, check the Show Totals option to indicate
that you would like to sum up a number column into a Totals row at the bottom of the
report.

l To remove a column, click in the corresponding row.

5. (Optional) Refine the content of the report as necessary using one or more of the
following options.More...
l Rename columns - Click in one or more selected columns and enter a new column
name that is more appropriate for the report you are creating.

l Set column sorting - Click next to one or more selected columns to indicate
whether the column is sorted in ascending or descending order. If you select more
than one column to sort by, indicate the order in which the columns sort; 1 being the
primary sort, 2 the secondary sort, and so on.

l Create project links - If the Project Name report column is selected for inclusion
in the report, select the Is Link check box to make the project name in a report
linkable to the project's home page.

l Define column properties - In the Properties area, define the column display and
behavior including grouping items together to aggregate them and Excel date
intervals. Aggregate selections are only available for number metric columns.

For example, to summarize the total costs for all projects within a brand, select
Sum as the aggregate value in a column that represents the total costs for a
project. The aggregation displays automatically when the report is selected to
display in a chart.

l Data Format - If the column contains a date or a number, select how the data
should be displayed. The currency symbol that displays for numbers is defined in
the Currency Symbol system parameter.

l Hide columns - Make a selection in the Show check box to show or hide columns
within the displayed report.

l Add Count Column - If you select to summarize values within the report, click
Add Count Column to add a column that shows how many rows of source data
are combined in the summary row.
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You can order and rename the added column as you can other columns;
however, you can add only one Count column to the report.

l Add Calculated Column - Click Add Calculated Column to add a column to
the report that displays a calculation based on other column data.

6. (Optional) On the Selected Filters tab, double-click or drag and drop the column name
from the left side of the dialog to any area in the Selected Filters tab to use it as filter
criteria that data must match to be included in the report.

7. On the Advanced Matrix Settings tab, if more than one matrix was selected in the
report columns, click Add to add the matrix join definitions.

8. ClickOK to exit the dialog and return to the report settings.

9. Enter the following information to identify the report:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies
the report.

System Name Enter a unique, shorter name that identifies the report in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among online reports and
can contain only letters (English alphabet), numbers,
and the underscore.

Category Enter or select the group to which this report belongs.
More...

Use categories to organize like reports together. For
example, if there are a large number of reports that the
IT department uses to track user logins, use a category
to group those reports together.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Description Enter a description of the purpose or nature of the
report.

This description helps other users identify the report
throughout the system.

274



Administrator's Guide

Sopheon Accolade Version 16.2

Field Description

Transpose Select this check box to transpose the column and row
data when the report is rendered.

Owners Click and select the additional users who can edit

the report configuration.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
displays or hides the additional filter options.

l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
assigned.

An assigned owner with All Reporting Rights
can view, update, delete, or add additional
owners to the report. An assigned owner who
has Refresh Workbook Data rights will only be
able to view the report. To make the report
available for all users or for configuration
setup, you must have a Process Designers
with All Reporting Rights as an assigned
owner.

10. (All optional, available in configuration only) Enter the following information to make the
chart publicly available.More...

Field Description

Override project
filtering

Select this check box to include the entire report set
from within a project.

The report will not filter to project-specific data when
viewed from within a project, and will display all
projects in a portfolio regardless of security.
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Field Description

*Note* This check box will not be available for
selection if the Filter to Portfolio check box is
selected.

Filter to Portfolio Select this check box to display the Portfolio Levels To
Display slider.

*Note* This check box will not be available for
selection if Override Project Filtering check box is
selected. This check box is optional and is not
mandatory.

Portfolio Levels To
Display

Select this toggle as well as the Filter to Portfolio check
box so that the report will filter to that project Portfolio
Hierarchy instead of the default of filtering down to just
that project.

*Note* This toggle is optional and is not mandatory.
Available to Charts &
Reports

Select this check box to make the report publicly
available for users to access and view the report.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the report in the Shared
Charts & Reports section on the Charts & Reports
page.

Available to
Configuration

Select this check box to make the report available for
use in configuration.

Roles Select the user roles that have access to view the
report.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the report on the Charts &
Reports page.

Configuration
Access Groups

When either Available to check box is selected,
access groups must be defined for the report.

The access groups displayed are based on the
current user's access group permissions and the
access groups the report belongs to. Additionally,
Process Designers with matching permissions will be
able to edit and view the report.

Process Model
Usage

Click the Process Model Usage button to see a list
of process models that the online report is associated
with.
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Field Description

The list includes all process models the report is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the report in the
Shared Charts & Reports section of the Charts & Reports page. If
neither check box is selected, the report will only be available to the
assigned owners in theirMy Charts & Reports section.

11. (Optional, available in configuration only) Set up the report for export.

12. (Optional) Click in the upper right corner to display a preview of the report contents

prior to saving, or click to download the report to a spreadsheet file.

13. Click Save to create a new report, or to save changes to an existing report.
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Conditional Formatting in Reports

Accolade users need an easy way to focus users on the most critical information in the report.
Users can easily use conditional formatting on report columns such as date, number, or text to
focus attention on the key data to drive decisions on projects. Users can specify a formula that
tells the report how to color the background of the cells in a given column. For example, while
setting up the report, one can choose to highlight the project duration column which will show
the long-running projects as risks. The user would be specifying the criteria such as a project
running greater than 500 days will have the color red, projects running between 200 and 500
days will be yellow, and projects running less than 200 days will be green. This will effectively
highlight projects that have been running for a very long time.

1. Access the report you wish to configure.

2. Click the Settings icon at the top right of the report page. The Selected
Columns screen will appear.

3. Select the Settings icon in the Conditional Formatting column. The Conditional
Formattingmodal will appear.

4. Configure the fields. Click theOK button when finished.

5. Click the OK button on the Select Columns page to finalize preferences.
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How Do I Know the Feature is Working?

Users have the ability to input formulas into the Value fields of the Conditional Formatting
modal. Use Rational and Logical Operators to express what actions should take place when
the desired criteria is met. Follow the steps below to guide you through this feature. IF help is
needed, use the Valid Operators as a reference.

Relational Operators Logical Operators

= (Equals) Or, || (Double Pipe)
<> (Does Not Equal) And, &&
>= (Greater Than or Equal To)
<= (Less Than or Equal To)
> (Greater Than)
< (Less Than)

l To make a valid formula, you need at least one of the relational operators from the table
above, and at least one value.

l i.e. = Red

l i.e. >=0

l If you’re using any logical operators (i.e. &&) then you’ll need at least 2 relational
operators and at least 2 values per logical operator.

l i.e. >1 || <0

l Comparisons to Dates need to be specified in the YYYY-MM-DD format.

l i.e. < 2025-03-25, if you want all dates less than March 25th 2025 to be
formatted.

Notes:
l To delete a saved online report, click the name of the report on the Charts &
Reports page and click Delete at the bottom of the page. Only the report owner,
users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the report.

l To include a project's thumbnail image in the report, add the Project Thumbnail
column available in the Project Details column set.

l A reference table must also be added to Accolade as an online report in order to
be available to use in reporting. The reference table information is included by
selecting the Reference Tables option when selecting columns to be included in
the report.

l The process model determines whether the report is available at the project
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level. When viewed through a project, only data that pertains to that project
displays in the report, unlessOverride project filtering is set in the report
configuration. Non-project related information displays identically in both

locations. Click on the Reports page of the project to print the list of charts
and reports that display.

l Using filters that reference data with square brackets may not return correct
results. It is not recommended to use square brackets in naming projects or
other Accolade data, as these characters are not supported in filtering and
calculation functionality.

l Use the Currency Symbol system parameter to specify the currency symbol
that displays in the Data Format field when creating charts and reports.

l Users can now access the "Null or Empty" format when utilizing Conditional
Formatting.

Adding Calculated Columns to Online Reports

Reporting details can be contained in multiple sources within Accolade. To combined related
data values to be used for reporting or the creation of charts or presentations, users can create
reports that include calculated columns that calculate and/or display combined data, allowing
users to manipulate and analyze Accolade data values.

For example, a user may have several different project metrics that represent categories of
project costs such as Administrative, Operating, Marketing, etc. In order to calculate and
display the sum of these project costs within an Accolade report or chart, the user can include
a calculated column in their report setup.

Example

Writing a calculated column formula in Accolade is slightly different than writing an equation in
math class, or using formulas in Excel. The most notable difference is the use of the equal sign
(=).

For example, if you want to add the numbers 3 and 2:

l In math class, the equation would read 3+2=, with a calculated value of 5.
l In Excel, formulas start with the equal sign, so it would look like =3+2. When entered,
the value in the selected cell would return as 5. If you wanted to add two cell values, it
would look something like =A1+B1 or =SUM(A1:B1). Assuming the values in A1 and
B1 were 3 and 2 respectively, it would return the value 5.
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l In Accolade online reporting, the equal sign is assumed, so it does not need to be
included in the formula field. If you wanted to add the values of Column A and Column
B, it would look like [Column A] + [Column B] or Sum([Column A], [Column B]).
Assuming the first row values of Column A and Column B were 3 and 2 respectively, it
would return the value 5.

To add a calculated column to an online report:

Note: See below for a list of calculations that are currently supported for reporting.

1. Create a new report or open an existing report for editing.

2. On the Selected Columns tab, ensure the columns to be used in the calculation are
included in the report.

Report calculations are executed from left to right. In order for selected
columns to be used in a calculated column, they must a) be selected as a
column for the report, and b) be included before they are referenced by a
calculated column (this means they must appear to the left of the
calculated column when displayed, or above the calculated column when
selecting columns in the report setup).

3. Make a selection in the Show check box to show or hide columns within the displayed
report.

If you want to use the columns as a reference for calculated column formulas but do not
wish to display them in the report, clear the Show check box. Hidden columns can still
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be used as a reference for calculated columns, but will not appear in the report when
displayed.

4. Click Add Calculated Column.

The column is added with two fields - one for the display name for the column, and one
for the formula to be calculated.

5. In the top field, enter the column name to be displayed when the report is generated.

6. In the field, enter the formula to be calculated within the report.

When entering your formula, the columns are referenced by enclosing the column
display name inside of square brackets. In the example above, Column A is entered as
[Column A].

7. Select the appropriate datatype for the calculated column.

l Date - Select this option when you want the column data to display as a Date
datatype, for example when using the DateAdd function to project a future project
date.

l Number - Select this option when you want the column data to display as a Number
datatype, for example when using the Sum function to combine the values of two or
more columns of expense values.

l String - Select this option when you want the column data to display as a String
datatype, for example when using the Concatenate function to display user name
and functions combined in one column.

7. (Optional) Drag and drop the calculated column to a new location within the list.

Note that while the calculated column cannot be displayed in the report until after its
reference columns are displayed, you can have calculated columns that are displayed
between data columns as necessary. Using the example above, after the Sum column
we could add Column C and Column D to the report and then add another calculated
column, and so forth.

8. ClickOK to exit the dialog and return to the report settings.

9. Finish setting up the report, as necessary.

10. (Optional) Click in the upper right corner to display a preview of the report contents

prior to saving, or click to download the report to a spreadsheet file.

11. Click Save to create a new report, or to save changes to an existing report.

Available Formulas for Calculated Columns in Reporting

The following section details the operators and functions that are available for use when
creating your calculated column formulas.
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Important! Note that the examples use "Column A", "Column B", and "Column C"
to generically refer to the display names of different columns that are included in
the report data.

Operators

Operators are process or mathematical parts of expressions, such as addition and
multiplication, and relationships such as greater than or less than. Use the operators below
within your calculated column expressions.

Operator Example

Additive and Subtractive Operators

+ (plus, plus sign) [Column A]+[Column B]

- (minus, dash) [Column A]-[Column B]

Multiplicative Operators

* (multiplied by, asterisk) [Column A]*5

/ (divided by, slash) [Column A]/[Column B]

% (mod, percent sign) [Column A]%10

Primary Operators

value (integers, text strings,
dates, functions)

('this is a text string')

While single quotes work for
dates, we recommend wrapping
dates in pound or hash signs
instead to ensure consistency of
data types. For example,
(#2021-10-19#).

( ) (parentheses) 1000-(6*[Column A])

Relational Operators

= (equals) [Column A]=250

<> (does not equal) [Column A]<>[Column B]

> (greater than, angle
bracket)

[Column A]>250

>= (greater than or equal to) [Column A]>=250
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Operator Example

< (less than, angle bracket) [Column A]<500

<= (less than or equal to) [Column A]<=100

Logical Operators

or, || (double pipe) [Column A]<[Column B]||[Column A]<500

and, && [Column A]<[Column B]&&[Column
A]<1000

Functions

The functions included in the calculated column formula determine in part what is returned in
the column. Use the functions described below within your calculated expressions to return
data within a calculated column.

For more information on the description or formatting for the calculations below, see
"Calculated Metric Expressions Reference" on page 136.

Function Example Formula

Abs Abs([Column A])

Acos Acos([Column A])

Asin Asin([Column A])

Atan Atan([Column A])

Avg Avg([Column A], [Column B], [Column C])

Ceiling Ceiling([Column A])

Concatenate Concatenate('text1',[Column A], 'text2',
'textN')

Contains Contains([Column A], 'My Blue Heaven',
2, 7)

Cos Cos([Column A])

DateAdd DateAdd('D', 5, [Column A])

DateDiff DateDiff('D',[Column A], [Column B])

DatePart DatePart('M', [Column A])

Exp Exp([Column A])

Find Find([Column A], 'My Blue Heaven', 2, 20)
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Function Example Formula

First First([Column A], [Column B], [Column C])

Floor Floor([Column A])

IEEERemainder IEEERemainder([Column A], [Column B])

If If([Column A]>500, 'Go ahead', 'Stop')

In In([Column A], 1, 2, 3)

IsNull IsNull([Column A], [Column B])

Join Join([Column A], [Column B], [Column C]),
'|')

Length Length([Column A])

Log Log([Column A], 10)

Log10 Log10([Column A])

Lower Lower([Column A])

LTrim LTrim([Column A])

Max Max([Column A], [Column B], [Column C])

Min Min([Column A], [Column B], [Column C])

Now Now()

Pow Pow([Column A], 2)

Replace Replace([Column A], 'Blue', 'red')

Round Round([Column A], 2)

RTrim RTrim([Column A])

Search Search('blue', [Column A], 5, 30).

Sign Sign([Column A])

Sin Sin([Column A])

Sqrt Sqrt([Column A])

SubString SubString([Column A], 4, 10)

Sum Sum([Column A], [Column B], [Column C])

Tan Tan([Column A])

Trim Trim([Column A])
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Function Example Formula

Truncate Truncate([Column A])

Upper Upper([Column A])

Notes:
l To delete a calculated column from a report, click the name of the report on the
Charts & Reports page and click to display the report columns. Click the

Selected Columns tab, and click in the corresponding calculated column
row to delete it. ClickOK to close the dialog and click Save to save the changes
to the report.

Adding Dynamic Filters to Online Reports

Capture and filter report data using relative metric and metadata field codes to create dynamic
reports that display data according to the project it is viewed within. Filtering reports based on
relative metrics and metadata field codes allows you to narrow the returned data set while still
generating a higher-level view. Dynamic filters allow you to view a subset of data from within
different projects.

Important! Ensure theOverride project filtering check box is selected on the
report settings. This enables the report to include data across a subset of projects.

To add dynamic filters to an online report:

1. Create a new report, or open an existing report for editing.

2. Click in the upper right corner to view the report details, and click the Selected
Filters tab.

3. To add filters, double-click or drag and drop the column names from the left side of the
dialog to any area in the Selected Filters tab.
l To search for a column to add as a filter, enter search criteria in the Find field after
selecting the subject.

l To include an entire column set, drag and drop the column set to any area in the
Selected Filters tab.

If multiple filters are added to the report, data must meet ALL filter criteria
to be included in the report.

4. For each added filter, select the operator and filter criteria that report data must match to
be included.
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The filter operators are dependent on the column selected to filter by, and generally
include options such as =, is empty, is one of, does not contain, and more.

The filter type must be selected from one of the following, and the following field
identifies the criteria to be met:

l Metadata - Enter the field code display name and select from the returned list.
Ensure you enter a valid query field code. While some operators may work in global
level reports, this filter type is designed to only work in reports pulled into project
layouts via the Report pod (project level reports).

l Metric - Enter the metric display name and select from the returned list. While some
operators may work in global level reports, this filter type is designed to only work in
reports pulled into project layouts via the Report pod (project level reports).

l Text - Enter or select a static string or numeric value such as a date.
l Current User - Filters the report to data only applicable to the user logged in and
viewing the report. Current User is only available for numeric or ID data type
columns.

Type ahead to search for metrics and field codes when defining the filter
criteria. Only metrics and field codes that match the data type of the filter
display for selection. For example, if you select a date filter, you can only
select date metrics or field codes to define the relative filter.

For example, to create a report that returns a list of deactivated users, filter on the User
Active column to return only users where the active flag is set to No. To set up this filter,
the operator selected is =, the type selected is Text, and the criteria is No.

5. (Optional) Select the Runtime Filter check box to determine what filters are available
for users to apply when refreshing the data in the report.

6. ClickOK to exit the dialog and return to the report settings.

7. Finish setting up the report, as necessary.

8. (Optional) Click in the upper right corner to display a preview of the report contents

prior to saving, or click to download the report to a spreadsheet file.

9. Click Save to create a new report, or to save changes to an existing report.

Notes:
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l To delete a filter from a report, click the name of the report on the Charts &
Reports page and click to display the report columns. Click the Selected
Filters tab, and click in the corresponding filter row to delete it. ClickOK to
close the dialog and click Save to save the changes to the report.

l Filter icon will not appear if there are no filters available for users to apply.

l Long string and multi-select list metrics are currently not supported for use as
metric filters.

Adding Multiple Matrices to Online Reports

Reporting details can be contained in multiple sources within Accolade. To consolidate data
into a single source to be used for reporting or the creation of charts or presentations, users
can create reports to combine the data. Information from more than one project matrix can be
pulled into a report by including a common value that is included in the sources, for example,
using a Department or Region metric or a common Row ID.

In addition to selecting the matrix and metric columns to be included in the report, users must
create join statements that define how the matrix information is related.

To add multiple matrices to an Accolade online report:

1. Create a new report or open an existing report for editing.

2. On the Selected Columns tab, select the matrices and metrics to be included in the
report.

3. On the Advanced Matrix Settings tab, click Add to add the matrix join statements.

4. In each side of the dialog, select one of the matrices from the drop-down list, and select
an option to use as the common value to join the matrices.

The two selected matrices must be different, but the matrix/metric combination can be
any combination of metrics or row IDs, as long as the selected metrics share a common
value and are of the same data type.

Selecting a metric will define it as the common value between the two matrices. Note
that it can be the same metric if it is used in both matrices, or it can be different metrics
that will have the same value in both matrices. In addition, a metric used as a common
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value does not need to be added as a reporting column in order to be used to create the
join statement.

Selecting Row ID will compare matrices by rows, for example Row 1 in Matrix A will be
compared with Row 1 in Matrix B, and so on. This can be used when there are no
additional common values in the two matrices, and the matrices have a direct line-by-
line comparison.

Caution! Selecting Row ID as a common value can cause
inconsistencies in reporting. Since assigned Row IDs are not visible
within a matrix, report results can be incorrect if rows have been deleted
from a matrix or if there is a mismatch.

5. Repeat steps 3-4 to add additional matrix join statements as necessary.

All included matrices must have at least one related join statement, but a matrix can be
referenced in more than one statement. For example, if you choose to include metrics
from Matrix A, Matrix B, and Matrix C, you would need to create two statements to join
the information. You could create a statement that relates A to B, and one that relates B
to C, or you could have a statement that relates A to B, and one that relates A to C.

6. ClickOK to exit the dialog and return to the report settings.

7. Finish setting up the report, as necessary.

8. (Optional) Click in the upper right corner to display a preview of the report contents

prior to saving, or click to download the report to a spreadsheet file.

9. Click Save to create a new report, or to save changes to an existing report.
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Note: [EMPTY] or blank cells in your report may indicate a mismatch in the
common value linking the matrices. If the project value referenced in the join
statement is not defined in one of the matrices, for example if there is not a
matching value in both matrices, or a matrix contains empty rows, the report
will return partial or full rows that contain [EMPTY] values.

Example

For example, a user has two different matrices that contain information related to vendor
contracts for their projects, and needs to create a report containing relevant information from
both matrices. They have a matrix named Contract Information, which contains the start date
and duration of the specific contracts, and a second matrix named Contract Cost, which
contains the costs related to the specific contracts.

To pull this information into one report, the user has added the related columns to the
Columns tab, and created a join statement in the Advanced Matrix Settings tab that links the
two matrices using the Contract IDmetric that is a member of both matrices.

Once the user enters the remaining report details and clicksOK, the following report is
generated:

290



Administrator's Guide

Sopheon Accolade Version 16.2

Note the following:

The Contract ID field is the common identifier included in both matrices, and used to connect
the relevant information.

The left three columns contain information that is from the Contract Informationmatrix in the
related projects.

The right three columns contain information that is from the Contract Costmatrix in the
related projects.

The highlighted sections below show two different scenarios that may indicate missing or
incomplete data.

l Rows 2 & 3 of the report display [EMPTY] in some of the data cells, which indicates
Contract IDs values that are not found in both matrices. In row 2, the information for
contract A101 is only included in the Contract Information matrix, so the related
Contract Cost matrix fields are [EMPTY]. In row 3, the information for contract A110 is
only included in the Contract Cost matrix, so the related Contract Information matrix
fields are [EMPTY].

l Rows 10 & 11 display [EMPTY] cells in all of the data cells, which indicates that one or
more of the included matrices either does not have any rows added, or contains empty
rows.

Note: Although the [EMPTY] returned values are an indicator of potential issues,
the mismatched values reported are dependent on the datatype. String and
list metrics will display as [EMPTY]. As shown in the example below, a
number metric will display 0, and a date metric will represent the default
1/1/1900 date.
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Notes:
l To delete a matrix join statement from a report, click the name of the report on
the Charts & Reports page and click to display the report columns. Click the

Advanced Matrix Settings tab, and click in the corresponding definition row
to delete it. ClickOK to close the dialog and click Save to save the changes to
the report.

Downloading and Exporting Online Report Data

Users with access to a report can download the content of a saved online report directly from
Accolade. Report creators can also set a report to export to a network location on a scheduled
basis. Schedule a report for repeated exports if you save archive information on your network,
or to provide access to a report to someone who is not an Accolade user.

To download report configuration and settings for the purpose of
exporting reports between Accolade instances, see "Importing and
Exporting Accolade Online Reports" on page 598.

To download a saved online report:

1. From theWorkspacemenu, selectMy Workspace > Charts & Reports.

2. Click the name of the report you want to view.

identifies reports created using Accolade Office Extensions. To refine the list of
reports displayed, select a category from the Category field or use the Search field to
search on report names and descriptions. If the Category field is unavailable, all reports
are grouped within a single category.

3. Click in the top right corner of the report display page.

Accolade downloads the report contents to spreadsheet file and saves it to a temporary
internet files directory, using the report's system name as the file name. Save the file to
a more accessible location.
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4. If the document is a template, Administrators and Process Designers with the Template
Access role can save the file and add it to the Template Library as a process document.

If the document is a deliverable, activity, or gate document, the assigned document
owners can save a version of the file to project.

To schedule a report to export to a network location:

1. From the Systemmenu, select Content Sources > Charts & Reports Manager.

2. Do one of the following:

l To create a new report - Click Add New, selectOnline Report from the drop-down
list and create a new report.

l To edit the export settings of an existing report - Click the name of the report on
the Charts & Reports Manager page and click in the upper right corner of the
title in the displayed report.

3. In the Export Days field and the Export Time field, select the days of the week on
which Accolade should export and enter the time the export should take place.

You must select at least one day to schedule the export. The export takes place based
on the Accolade server's time, not your local time settings. If the Accolade server is
located in a different time zone, ensure you are scheduling the time accurately for the
export.

4. Complete the following to identify the export location and report name:

Field Description

Export File Path Enter the directory location where the exported file is
saved.

The Accolade timed task service must have access to
the network drive. Work with your system administrators
to understand what network shares are available for
use.

Filename Enter the file name for the report. To append a
timestamp to the file name, select the Include
timestamp check box.
Timestamps can be helpful to identify exactly when a
report was exported and saved to the network directory.

5. In the File Type field, select whether to download the file as a spreadsheet file, or as a
file with a .csv extension which can be opened in other spreadsheet programs.

If you select to download to CSV and have text set in the Report Privacy Warning
Text system parameter, the text is not included in the CSV file.

6. Click Save to save the report and the export settings.
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Notes:
l The Timed Task Service must be enabled and running on the Accolade server
for a scheduled export to save successfully. Contact your Accolade system
administrator to ensure the service is running.

l If a scheduled export fails to save, the report creator receives a notification email
about the failure.

l The colors defined in the Excel Header Background Color, Excel Header
Font Color, and Excel Header Is Bold system parameters determine the
formatting of the header rows within the spreadsheet file.

Adding Accolade Online Reporting Content to Templates

Add the content of a report created within Accolade to an existing document or template using
a specific named range. When downloading the report, template, or a document version with
the report content, the up-to-date Accolade data is included in the file.

A spreadsheet template containing content created within Accolade can
also be used as the template for a deliverable or activity. Administrators
and Process Designers with the Template Access role can save the file
and add it to the Template Library as a Process Document type template
instead of as a Report type.

To add content from an online report to an existing spreadsheet file:

1. Note the system name of the report in Accolade.

2. Select the cell within the spreadsheet where the report content should begin.

When the file is downloaded from Accolade, the report contents start at the cell with the
named range, and expands to the right and below for the required number of columns
and rows to accommodate the data.

Important! Any information in cells to the right of the one with named range could
be deleted based on the report's content. Any information below the cell with the
named range is pushed to below the report's content.

3. In the Name field for the cell, enter SGM_RG_<RGReportName> and press Enter.

For example, to include a report with the system nameModelsInUse, enter SGM_RG_
ModelsInUse as the cell name.
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Notes:
l Using this function to associate a spreadsheet workbook with report content to a
project does not display project level data.

Creating Charts from Report Data Overview
Online reports created within Accolade can be used to create new or copy existing charts that
represent all or a portion of the data that is returned in the report. Charting options vary, and a
wide variety of charts are included so you can create the best visual representation of the data
in your system as possible.

Creating Bar Charts Based on Report Data

Users can create charts to visually represent the data within Accolade. Bar charts use bars to
represent and compare categories of data in a format that can be displayed horizontally or
vertically. One axis will generally have numerical values, and the other will describe the types
of categories being compared. In bar charts, the user can cycle through different views, that is,
different categories of data to get a more comprehensive view of a portfolio's performance
using the cycle icon .

Using Accolade online report data, users with All Reporting Rights can create charts on the
Charts & Reports page. Administrators and Process Designers can set charts as available
for sharing with other users, and can add a chart to a pod within a layout to display on a project
page or as a global link.

Important! Select appropriate data types to render a meaningful chart. Numeric
data types will chart bars successfully. The system will not prevent you from
selecting different data types and will plot selected data as best as possible without
error.

To create a bar chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related
configuration by navigating to the Systemmenu and selecting Content
Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and
click the Bar Chart icon.

l To edit the details of an existing report - Click the name of the chart on the
Charts & Reports page and click to edit the report details. Only users assigned
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as chart owners and Process Designers with All Reporting Rights can edit chart
details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies
the chart.

To display this name as the chart's title, select
the Display as title option.

System Name Enter a unique, shorter name that identifies the chart in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among charts and can
contain only letters (English alphabet), numbers, and
the underscore.

Category Enter or select the group to which this chart belongs.
More...

Use categories to organize like charts together. For
example, you may choose to group all the charts used in
global layouts into the same category, in order to
separate them from charts that are used in process
model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on
the Charts & Reports page.

Owners Click and select the additional users who can edit

the chart details.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).
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Field Description

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
displays or hides the additional filter options.

l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
assigned.

An assigned owner with All Reporting Rights
can view, update, delete, or add additional
owners to the chart. An assigned owner who
has Refresh Workbook Data rights will only be
able to view the chart. To make the chart
available for all users or for configuration
setup, you must have a Process Designer with
All Reporting Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the
chart publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly
available for users to access and view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart in the Shared
Charts & Reports section on the Charts &
Reports page.

Available to
Configuration

Select this check box to make the chart available for
use in configuration.

Specific Roles Select the system user roles that have access to
view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart on the Charts &
Reports page.

Configuration
Access Groups

When either Available to check box is checked,
access groups must be defined for the chart.
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Field Description

The access groups displayed are based on the
current user's access group permissions and the
access groups the chart belongs to. Additionally,
Process Designers with matching permissions will
be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process
Model Usage button to see a list of process models
that the online chart is associated with.

The list displayed includes all process models the
chart is included in, as well as links to the process
model's component tree pages you have Edit
access to.

Note: Clicking either Available to check box will place the chart in the
Shared Charts & Reports section of the Charts & Reports page. If
neither check box is selected, the chart will only be available to the
assigned owners in theirMy Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the
chart. Only online reports created in Accolade are available for selection.

6. In theGrouping field, select the column from the report that represents the data and
measurement values to plot on the chart.

l (Optional) To use the column names as labels for each axis, select the Display Axis
Label option for one or both axes.

l (Optional) In the Number Format drop-down, select an option to indicate how
values for the selected grouping display.

7. In the Bar field, select the column from the report that represents the data and
measurement values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a
zero-value line. If charting only positive values, the chart draws bars as greater than
zero.

l If a column within the report contains a selected Aggregate value, the aggregation
displays automatically when the report column is selected to display in a chart.

l (Optional) To use the column names as labels for each axis, select the Display Axis
Label option for one or both axes.

l (Optional) To display grid lines for the vertical axis, select the Show Grid Lines
option.

l (Optional) To display values on the bars in the chart, select Display totals.
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l (Optional) In the Number Format drop-down, select an option to indicate how
values for the bars display.

8. In the Cycles field, select one or many cycles. Each cycle displays a different grouping
of data that the bars represent. The Grouping selection is automatically selected and
cannot be unselected.

9. Enter the following information to alter the chart display:

Field Description

Display Type Select whether the bars display horizontally or vertically.
The chart rotates according to the display type. Number
formats specified in the report will also rotate since they
apply to the data and not the axis.

If the contents of your report produces enough
bars that the labels along the horizontal axis
overlap, select the Rotate Horizontal Axis
Text option to display the labels at an angle
instead of horizontally to prevent overlapping.

Color Theme Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme
to accommodate each value measurement. Themes 2-5
allow for up to 20-25 plotted values.

10. (Optional) Add target lines to display on the chart.

11. (Optional) If you edited an existing chart, click in the upper right corner to view the
new chart.

12. Click Save to save your changes and create the chart.

Example - Creating Bar Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of
products over the last several years. The user has created a Product Line Revenues Report
for their report source, and selected the Product Lines, Revenue, Region, and Yearmetrics
to be included in the report.

To create a bar chart to display this information, the user has selected the Year for the
Grouping value and the Revenue as the Bar value. The bars represent the yearly sales
values of various products.

To create a bar chart to display this information and cycle through the metrics for different chart
views, the user has selected the Year for theGrouping, the Revenue for the Bar, and the
Product Lines, Revenue, and Region as the Cycles values. The Product Lines in the report
represent the business units of Desktop, Tablets, Peripherals, Servers, and Mobile. The bars
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represent the yearly sales values of the various products. Select the cycle icon to view the
different charts.

Notes:
l To delete a saved chart, display the chart from the Charts & Reports page, click

to display the chart settings, and click Delete at the bottom of the page. Only
the chart owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a
user must be an owner or have at least one matching user role for the chart to
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display in the layout.

l Before creating the chart, the user selects the sort order of the data in the
associated report.

l Use the Currency Symbol system parameter to specify the currency symbol
that displays in the Number Format field when creating charts and reports.

Creating Grouped Bar Charts Based on Report Data

Users can create charts to visually represent the data within Accolade. Grouped bar charts use
bars to represent and compare different categories of two or more sets of data in a format that
display horizontally or vertically. Because the categories are grouped and arranged side by
side, the grouped bar arrangement allows users to visually represent the differences inside a
group. The grouped bar chart can be used to showcase differences in the same category
across groups. Generally, in the chart, one axis has a value such as a product line, the other
axis has numerical values such as revenue, and the bar segments show categories to be
compared. In grouped bar charts, the user can cycle through different views, that is, different
categories of data to get a more comprehensive view of a portfolio's performance using the
cycle icon .

Using Accolade online report data, users with All Reporting Rights can create charts on the
Charts & Reports page. Administrators and Process Designers can set charts as available
for sharing with other users, and can add a chart to a pod within a layout to display on a project
page or as a global link.

Important! Select appropriate data types to render a meaningful chart. Numeric
data types will chart bars successfully. The system will not prevent you from
selecting different data types and will plot selected data as best as possible without
error.

To create a grouped bar chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related
configuration by navigating to the Systemmenu and selecting Content
Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and
click the Grouped Bar Chart icon.

l To edit the details of an existing report - Click the name of the chart on the
Charts & Reports page and click to edit the report details. Only users assigned
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as chart owners and Process Designers with All Reporting Rights can edit chart
details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies
the chart.

To display this name as the chart's title, select
the Display as title option.

System Name Enter a unique, shorter name that identifies the chart in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among charts and can
contain only letters (English alphabet), numbers, and
the underscore.

Category Enter or select the group to which this chart belongs.
More...

Use categories to organize like charts together. For
example, you may choose to group all the charts used in
global layouts into the same category, in order to
separate them from charts that are used in process
model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on
the Charts & Reports page.

Owners Click and select the additional users who can edit

the chart details.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).
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Field Description

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
displays or hides the additional filter options.

l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
assigned.

An assigned owner with All Reporting Rights
can view, update, delete, or add additional
owners to the chart. An assigned owner who
has Refresh Workbook Data rights will only be
able to view the chart. To make the chart
available for all users or for configuration
setup, you must have a Process Designer with
All Reporting Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the
chart publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly
available for users to access and view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart in the Shared
Charts & Reports section on the Charts &
Reports page.

Available to
Configuration

Select this check box to make the chart available for
use in configuration.

Specific Roles Select the system user roles that have access to
view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart on the Charts &
Reports page.

Configuration
Access Groups

When either Available to check box is checked,
access groups must be defined for the chart.
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Field Description

The access groups displayed are based on the
current user's access group permissions and the
access groups the chart belongs to. Additionally,
Process Designers with matching permissions will
be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process
Model Usage button to see a list of process models
that the online chart is associated with.

The list displayed includes all process models the
chart is included in, as well as links to the process
model's component tree pages you have Edit
access to.

Note: Clicking either Available to check box will place the chart in the
Shared Charts & Reports section of the Charts & Reports page. If
neither check box is selected, the chart will only be available to the
assigned owners in theirMy Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the
chart. Only online reports created in Accolade are available for selection.

6. In the Horizontal Axis field, select the column from the report that represents the data
and measurement values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a
zero-value line. If charting only positive values, the chart draws bars as greater than
zero.

l If a column within the report contains a selected Aggregate value, the aggregation
displays automatically when the report column is selected to display in a chart.

l (Optional) To use the column name as a label for the axis, select the Display axis
label option.

l (Optional) In the Number Format drop-down, select an option to indicate how
values for the selected column display.

7. (Optional) In the Vertical Axis field, select the column from the report that represents
the data and measurement values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a
zero-value line. If charting only positive values, the chart draws bars as greater than
zero.

l If a column within the report contains a selected Aggregate value, the aggregation
displays automatically when the report column is selected to display in a chart.
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l (Optional) To use the column name as a label for the axis, select the Display axis
label option.

l (Optional) In the Number Format drop-down, select an option to indicate how
values for the selected column display.

l The Bars field displays a drop-down list to select one column.

8. In the Bars field, the user can select one or more columns from the report that
represent each bar within a group.

l If the user selected a Vertical Axis, then the user must select one column only from
the Column drop-down list. The chart renders by rows.

l If the user did not select a Vertical Axis, then the user can select multiple columns
from the box. The chart renders by columns.

9. Enter the following information to alter the chart display:

Field Description

Bar Axis Units Enter text to display as the vertical axis label.
Cycle Segments Horizontal Axis and Bars determines how the cycles

are mapped on the chart.

Horizontal Axis uses the selected cycle as the basis
for the horizontal axis. Barsmaps the selected cycle to
the vertical bars.

Cycles Select one or many cycles.

Each cycle displays a different column of data that the
grouped bars represent. The Horizontal Axis selection is
automatically selected and cannot be unselected.

Display Type Select whether the bars display horizontally or vertically.
The chart rotates according to the display type. Number
formats specified in the report will also rotate since they
apply to the data and not the axis.

If the contents of your report produces enough
bars that the horizontal axis labels overlap,
select the Rotate Horizontal Axis Text
option to display the labels at an angle instead
of horizontally to prevent overlapping.

Number Format Select a number formatting option to indicate how
values within the chart are displayed.

Legend Select where in the chart to display the key that
identifies what the colors in the chart represent.

After the chart renders, toggle a key label in the legend
to hide and show data without changing the underlying
chart and report configuration.
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Field Description

Color Theme Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme
to accommodate each value measurement. Themes 2-5
allow for up to 20-25 plotted values.

10. (Optional) Add target lines to display on the chart.

11. (Optional) If you edited an existing chart, click in the upper right corner to view the
new chart.

12. Click Save to save your changes and create the chart.

Example - Creating Grouped Bar Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of
products over the last several years. The user has created a Product Line Revenues Report for
their report source, and selected the Product Lines, Region, Year, and Revenuemetrics to
be included in the report.

To create a grouped bar chart to display this information, the user has selected the Region for
the Horizontal Axis, the Revenue for the Vertical Axis, the Product Lines as the Bars
value, and Product Lines, Revenue, and Year as the Cycles values. The Product Lines in
the report represent the business units of Desktop, Mobile, Peripherals, Servers, and Tablets.
The bars represent the sales values of various products. Select the cycle icon to view the
different charts. Toggle a key label in the legend to hide and show data in the rendered chart.
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Notes:
l To delete a saved chart, display the chart from the Charts & Reports page, click

to display the chart settings, and click Delete at the bottom of the page. Only
the chart owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a
user must be an owner or have at least one matching user role for the chart to
display in the layout.

l Before creating the chart, the user selects the sort order of the data in the
associated report.

l Use the Currency Symbol system parameter to specify the currency symbol
that displays in the Number Format field when creating charts and reports.

Creating Stacked Bar Charts Based on Report Data

Users can create charts to visually represent the data within Accolade. Stacked bar charts use
a single bar to represent multiple categories of data in a format that display horizontally or
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vertically. Because the categories are arranged in a stack, the stacked bar arrangement allows
users to visually represent and compare total sizes of bars and relative differences in
categories. The stacked bar chart can be used to showcase when one category overtakes
another. Generally, in the chart, one axis has a value such as a product line, the other axis has
numerical values such as revenue, and the bar segments show categories to be compared. In
stacked bar charts, the user can cycle through different views, that is, different categories of
data to get a more comprehensive view of a portfolio's performance using the cycle icon .

Using Accolade online report data, users with All Reporting Rights can create charts on the
Charts & Reports page. Administrators and Process Designers can set charts as available for
sharing with other users, and can add a chart to a pod within a layout to display on a project
page or as a global link.

Important! Select appropriate data types to render a meaningful chart. Numeric
data types will chart bars successfully. The system will not prevent you from
selecting different data types and will plot selected data as best as possible without
error.

To create a stacked bar chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related
configuration by navigating to the Systemmenu and selecting Content
Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click
the Stacked Bar Chart icon.

l To edit the details of an existing report - Click the name of the chart on the
Charts & Reports page and click to edit the report details. Only users assigned
as chart owners and Process Designers with All Reporting Rights can edit chart
details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies
the chart.

To display this name as the chart's title, select
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Field Description

the Display as title option.

System Name Enter a unique, shorter name that identifies the chart in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among charts and can
contain only letters (English alphabet), numbers, and
the underscore.

Category Enter or select the group to which this chart belongs.
More...

Use categories to organize like charts together. For
example, you may choose to group all the charts used in
global layouts into the same category, in order to
separate them from charts that are used in process
model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on
the Charts & Reports page.

Owners Click and select the additional users who can edit

the chart details.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
displays or hides the additional filter options.

l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
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Field Description

assigned.

An assigned owner with All Reporting Rights
can view, update, delete, or add additional
owners to the chart. An assigned owner who
has Refresh Workbook Data rights will only be
able to view the chart. To make the chart
available for all users or for configuration
setup, you must have a Process Designer with
All Reporting Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the
chart publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly
available for users to access and view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart in the Shared
Charts & Reports section on the Charts &
Reports page.

Available to
Configuration

Select this check box to make the chart available for
use in configuration.

Specific Roles Select the system user roles that have access to
view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart on the Charts &
Reports page.

Configuration
Access Groups

When either Available to check box is checked,
access groups must be defined for the chart.

The access groups displayed are based on the
current user's access group permissions and the
access groups the chart belongs to. Additionally,
Process Designers with matching permissions will
be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process
Model Usage button to see a list of process models
that the online chart is associated with.
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Field Description

The list displayed includes all process models the
chart is included in, as well as links to the process
model's component tree pages you have Edit access
to.

Note: Clicking either Available to check box will place the chart in the
Shared Charts & Reports section of the Charts & Reports page. If
neither check box is selected, the chart will only be available to the
assigned owners in theirMy Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the
chart. Only online reports created in Accolade are available for selection.

6. In the Horizontal Axis field, select the column from the report that represents the data
and measurement values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a
zero-value line. If charting only positive values, the chart draws bars as greater than
zero.

l If a column within the report contains a selected Aggregate value, the aggregation
displays automatically when the report column is selected to display in a chart.

l (Optional) To use the column name as a label for the axis, select the Display axis
label option.

l (Optional) In the Number Format drop-down, select an option to indicate how
values for the selected column display.

7. (Optional) In the Vertical Axis field, select the column from the report that represents
the data and measurement values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a
zero-value line. If charting only positive values, the chart draws bars as greater than
zero.

l If a column within the report contains a selected Aggregate value, the aggregation
displays automatically when the report column is selected to display in a chart.

l (Optional) To use the column name as a label for the axis, select the Display axis
label option.

l (Optional) In the Number Format drop-down, select an option to indicate how
values for the selected column display.

l The Bar Segments field displays a drop-down list to select one column.

8. In the Bar Segments field, the user can select one or more columns from the report
that correlate to the stacked sections of the bars.
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l If the user selected a Vertical Axis, then the user must select one column only from
the Column drop-down list. The chart renders by rows.

l If the user did not select a Vertical Axis, then the user can select multiple columns
from the box. The chart renders by columns.

l Check one or both check boxes to display values.

l Select Stacked to 100% to display the bar segments as percentages of the
whole rather than integer values.

l Select Display totals to include the total value for the entire bar after the last
segment.

9. Enter the following information to alter the chart display:

Field Description

Bar Axis Units Enter text to display as the vertical axis label.
Cycle Segments Horizontal Axis and Bars determines how the cycles

are mapped on the chart.

Horizontal Axis uses the selected cycle as the basis for
the horizontal axis. Barsmaps the selected cycle to the
bar segments.

Cycles Select one or many cycles.

Each cycle displays a different segment of data that the
stacked bars represent. The Horizontal Axis selection is
automatically selected and cannot be unselected.

Display Type Select whether the bars display horizontally or vertically.
The chart rotates according to the display type. Number
formats specified in the report will also rotate since they
apply to the data and not the axis.

If the contents of your report produce enough
bars that the horizontal axis labels overlap,
select the Rotate Horizontal Text option to
display the labels at an angle instead of
horizontally to prevent overlapping.

Number Format Select a number formatting option to indicate how
values within the chart are displayed.

Legend Select where in the chart to display the key that
identifies what the colors in the chart represent.

After the chart renders, toggle a key label in the legend
to hide and show data without changing the underlying
chart and report configuration.

Color Theme Select the color palette to assign to the bars.
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Field Description

If plotting 10 or more data points, consider a color theme
to accommodate each value measurement. Themes 2-5
allow for up to 20-25 plotted values.

10. (Optional) Add target lines to display on the chart.

11. (Optional) If you edited an existing chart, click in the upper right corner to view the
new chart.

12. Click Save to save your changes and create the chart.

Example - Creating Stacked Bar Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of
products over the last several years. The user has created a Product Line Revenues Report
for their report source, and selected the Product Lines, Region, Year, and Revenuemetrics
to be included in the report.

To create a stacked bar chart to display this information and cycle through the metrics for
different chart views, the user has selected the Region for the Horizontal Axis, the Revenue
for the Vertical Axis, the Product Lines as the Bar Segments value, and Product Lines,
Revenue, and Year as the Cycles values. The Product Lines in the report represent the
business units of Desktop, Tablets, Peripherals, Servers, and Mobile. The bar segments
represent the various products by category across region and revenue over several years.
Select the cycle icon to view the different charts. Toggle a key label in the legend to hide
and show data in the rendered chart.
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Notes:
l To delete a saved chart, display the chart from the Charts & Reports page, click

to display the chart settings, and click Delete at the bottom of the page. Only
the chart owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a
user must be an owner or have at least one matching user role for the chart to
display in the layout.

l Before creating the chart, the user selects the sort order of the data in the
associated report.

l Use the Currency Symbol system parameter to specify the currency symbol
that displays in the Number Format field when creating charts and reports.

Creating Bubble Charts Based on Report Data
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Users can create charts to visually represent the data within Accolade. Bubble charts (also
known as bubble plots) are multi-dimensional graphs that are a cross between a scatter plot
and a proportional area chart, and can be useful for comparing the relationships between
projects in multiple dimensions. Data points are plotted against a horizontal and vertical axis,
and then have additional data values represented by the size and color of the bubble. In
bubble charts, the user can cycle through different views, that is, different categories of data to
get a more comprehensive view of a portfolio's performance using the cycle icon .

Using Accolade online report data, users with All Reporting Rights can create charts on the
Charts & Reports page. Administrators and Process Designers can set charts as available
for sharing with other users, and can add a chart to a pod within a layout to display on a project
page or as a global link.

Important! Select numeric data types for Bubble Represents values to render a
meaningful chart. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a bubble chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related
configuration by navigating to the Systemmenu and selecting Content
Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and
click the Bubble Chart icon.

l To edit the details of an existing report - Click the name of the chart on the
Charts & Reports page and click to edit the report details. Only users assigned
as chart owners and Process Designers with All Reporting Rights can edit chart
details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies
the chart.

To display this name as the chart's title, select
the Display as title option.
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Field Description

System Name Enter a unique, shorter name that identifies the chart in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among charts and can
contain only letters (English alphabet), numbers, and
the underscore.

Category Enter or select the group to which this chart belongs.
More...

Use categories to organize like charts together. For
example, you may choose to group all the charts used in
global layouts into the same category, in order to
separate them from charts that are used in process
model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on
the Charts & Reports page.

Owners Click and select the additional users who can edit

the chart details.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
displays or hides the additional filter options.

l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
assigned.
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Field Description

An assigned owner with All Reporting Rights
can view, update, delete, or add additional
owners to the chart. An assigned owner who
has Refresh Workbook Data rights will only be
able to view the chart. To make the chart
available for all users or for configuration
setup, you must have a Process Designer with
All Reporting Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the
chart publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly
available for users to access and view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart in the Shared
Charts & Reports section on the Charts &
Reports page.

Available to
Configuration

Select this check box to make the chart available for
use in configuration.

Specific Roles Select the system user roles that have access to
view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart on the Charts &
Reports page.

Configuration
Access Groups

When either Available to check box is checked,
access groups must be defined for the chart.

The access groups displayed are based on the
current user's access group permissions and the
access groups the chart belongs to. Additionally,
Process Designers with matching permissions will
be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process
Model Usage button to see a list of process models
that the online chart is associated with.
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Field Description

The list displayed includes all process models the
chart is included in, as well as links to the process
model's component tree pages you have Edit
access to.

Note: Clicking either Available to check box will place the chart in the
Shared Charts & Reports section of the Charts & Reports page. If
neither check box is selected, the chart will only be available to the
assigned owners in theirMy Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the
chart. Only online reports created in Accolade are available for selection.

6. In the Horizontal Axis and Vertical Axis fields, select the columns from the report that
represent the data and measurement values to plot on the chart.

l (Optional) To use the column names as labels for each axis, select the Display Axis
Label option for one or both axes.

l (Optional) To display grid lines for the horizontal and vertical axis, select the Show
Grid Lines option.

l (Optional) Select the Rotate Horizontal Axis Text option to display the labels at an
angle instead of horizontally to prevent overlapping.

l (Optional) In the Number Format drop-down, select an option to indicate how
values on the axis are displayed.

l (Optional) In Scale Control, change the scaling and size of the displayed chart by
selecting one of the following options:

l Select Automatic to set the chart range minimum and maximum values displayed
in the chart based on the data ranges in the report.

l Select Custom to manually set the chart Range Minimum and Range Maximum
values displayed in the chart.

7. Select the following information to define what the bubbles within the chart represent:

Field Description

Bubble Size Select a number metric from the report that determines
the size of each bubble in the chart.

Number Format Select how values display within the tooltip for the
bubbles in the chart.

Bubble Represents Select the information that displays within the tooltip for
the bubbles in the chart.

Selecting [None] displays only the bubble's value in the
tooltip.

318



Administrator's Guide

Sopheon Accolade Version 16.2

Field Description

Bubble Color Select the column that determines what each color
represents in the chart.

Bubble Opacity Select how solid to display the bubbles in the chart.

Using a smaller value displays the bubbles less opaque,
and can make each easier to see if bubbles overlap in
the chart.

Cycles Select one or many cycles. Each cycle displays a
different grouping of data that the bubbles represent.

The Bubble Color selection is automatically selected and
cannot be unselected.

Color Theme Select the color palette to assign to the bubbles in the
chart.

Legend Select where in the chart to display the key that
identifies what the bubble colors in the chart represent.

After the chart renders, toggle a key label in the legend
to hide and show data without changing the underlying
chart and report configuration.

8. (Optional) If you edited an existing chart, click in the upper right corner to view the
new chart.

9. Click Save to save your changes and create the chart.

Example - Creating Bubble Charts in Accolade

For example, a user wants to review and compare the financial reward and customer benefit
by region for a portfolio of products over the last several years. The user has created a Product
Line Revenues Report for their report source, and selected the Product Lines, Region,
Revenue, Year, Financial Reward, and Customer Benefitmetrics to be included in the
report.

To create a bubble chart to display this information and cycle through the metrics for different
chart views, the user has selected:

l Horizontal Axis - Customer Benefit
l Vertical Axis - Financial Reward
l Bubble Size - Revenue
l Bubble Represents - Region
l Bubble Color - Product Lines
l Cycles - Year and Region
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The Product Lines in the report represent the business units of Desktop, Tablets, Peripherals,
Servers, and Mobile. The bubbles represent the various products by category across region
and revenue over several years. The bubble location on the chart shows the high customer
benefit and financial reward in the upper right corner and low values in the lower left corner to
help you identify possible investments. Select the cycle icon to view the different charts.
Toggle a key label in the legend to hide and show data in the rendered chart.

Notes:
l To delete a saved chart, display the chart from the Charts & Reports page, click

to display the chart settings, and click Delete at the bottom of the page. Only
the chart owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a
user must be an owner or have at least one matching user role for the chart to
display in the layout.

l Use the Currency Symbol system parameter to specify the currency symbol
that displays in the Number Format field when creating charts and reports.

Creating Line Chart by Columns Charts Based on Report Data

320



Administrator's Guide

Sopheon Accolade Version 16.2

Users can create charts to visually represent the data within Accolade. Line Chart by Columns
charts are created by connecting a series of data points together with a solid line, and can be
used to display or analyze trends or patterns in data.

Using Accolade online report data, users with All Reporting Rights can create charts on the
Charts & Reports page. Administrators and Process Designers can set charts as available
for sharing with other users, and can add a chart to a pod within a layout to display on a project
page or as a global link.

Important! Select appropriate data types to render a meaningful chart. Numeric
data types will chart lines successfully. The system will not prevent you from
selecting different data types and will plot selected data as best as possible without
error.

To create a line chart by columns chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related
configuration by navigating to the Systemmenu and selecting Content
Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and
click the Line Chart by Columns icon.

l To edit the details of an existing report - Click the name of the chart on the
Charts & Reports page and click to edit the report details. Only users assigned
as chart owners and Process Designers with All Reporting Rights can edit chart
details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies
the chart.

To display this name as the chart's title, select
the Display as title option.

System Name Enter a unique, shorter name that identifies the chart in
queries, reporting views, field codes, and other places in
Accolade.
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Field Description

The name must be unique among charts and can
contain only letters (English alphabet), numbers, and
the underscore.

Category Enter or select the group to which this chart belongs.
More...

Use categories to organize like charts together. For
example, you may choose to group all the charts used in
global layouts into the same category, in order to
separate them from charts that are used in process
model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on
the Charts & Reports page.

Owners Click and select the additional users who can edit

the chart details.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
displays or hides the additional filter options.

l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
assigned.

An assigned owner with All Reporting Rights
can view, update, delete, or add additional
owners to the chart. An assigned owner who
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Field Description

has Refresh Workbook Data rights will only be
able to view the chart. To make the chart
available for all users or for configuration
setup, you must have a Process Designer with
All Reporting Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the
chart publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly
available for users to access and view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart in the Shared
Charts & Reports section on the Charts &
Reports page.

Available to
Configuration

Select this check box to make the chart available for
use in configuration.

Specific Roles Select the system user roles that have access to
view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart on the Charts &
Reports page.

Configuration
Access Groups

When either Available to check box is checked,
access groups must be defined for the chart.

The access groups displayed are based on the
current user's access group permissions and the
access groups the chart belongs to. Additionally,
Process Designers with matching permissions will
be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process
Model Usage button to see a list of process models
that the online chart is associated with.

The list displayed includes all process models the
chart is included in, as well as links to the process
model's component tree pages you have Edit
access to.
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Note: Clicking either Available to check box will place the chart in the
Shared Charts & Reports section of the Charts & Reports page. If
neither check box is selected, the chart will only be available to the
assigned owners in theirMy Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the
chart. Only online reports created in Accolade are available for selection.

6. In the Line Represents and Columns fields, select the columns from the report that
represent the data and measurement values to plot on the chart.

l If a column within the report contains a selected Aggregate value, the aggregation
displays automatically when the report column is selected to display in a chart.

l (Optional) Enter the Vertical Axis Label or Horizontal Axis Label option to display
labels for one or both axes.

l (Optional) In the Number Format drop-down, select an option to indicate how
values on the axes are displayed.

l (Optional) Select the Show Grid Lines option to display grid lines for one or both
axes.

l (Optional) To display the grid points, select the Display Point Marker check box.

7. Enter the following information to alter the chart display:

Field Description

Style Select whether to display lines only, or lines with fill
below.

If the contents of your report produces enough
lines that the labels along the horizontal axis
overlap, select the Rotate Horizontal Axis
Text option to display the labels at an angle
instead of horizontally to prevent overlapping.

Legend Select where in the chart to display the key that
identifies what the colors in the chart represent.

After the chart renders, toggle a key label in the legend
to hide and show data without changing the underlying
chart and report configuration.

Color Theme Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme
to accommodate each value measurement. Themes 2-5
allow for up to 20 plotted values.
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8. (Optional) If you edited an existing chart, click in the upper right corner to view the
new chart.

9. Click Save to save your changes and create the chart.

Example - Creating Line Chart by Columns Charts in Accolade

For example, a user wants to review and compare the past 3 years of sales numbers for
several projects. The user has created a Sales Performance report for their chart report
source, and selected the Project Name and Sales Year 1 - Year 3metrics to be included in
the report.

To create a line chart by columns chart to display this information, the user has selected
Project Name as the Line Represents value, and the Sales Year 1 - Year 3metrics as the
Columns values, to create lines that represent the comparative sales trends for each year by
project. Toggle a key label in the legend to hide and show data in the rendered chart.

Notes:
l To delete a saved chart, display the chart from the Charts & Reports page, click

to display the chart settings, and click Delete at the bottom of the page. Only
the chart owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.
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l Reporting Rights are not required to view the chart in a page layout; however a
user must be an owner or have at least one matching user role for the chart to
display in the layout.

l Use the Currency Symbol system parameter to specify the currency symbol
that displays in the Number Format field when creating charts and reports.

Creating Line Chart Trends Charts Based on Report Data

Users can create charts to visually represent the data within Accolade. Line Chart Trends
charts are created by connecting a series of data points together with a solid line, and layering
multiple lines within one chart to display or analyze trends or patterns in several related sets of
data. In line chart trends, the user can cycle through different views, that is, different categories
of data to get a more comprehensive view of a portfolio's performance using the cycle icon .

Using Accolade online report data, users with All Reporting Rights can create charts on the
Charts & Reports page. Administrators and Process Designers can set charts as available for
sharing with other users, and can add a chart to a pod within a layout to display on a project
page or as a global link.

Important! Select appropriate data types to render a meaningful chart. Numeric
data types will chart lines successfully. The system will not prevent you from
selecting different data types and will plot selected data as best as possible without
error.

To create a line chart trends chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related
configuration by navigating to the Systemmenu and selecting Content
Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click
the Line Chart Trends icon.

l To edit the details of an existing report - Click the name of the chart on the
Charts & Reports page and click to edit the report details. Only users assigned
as chart owners and Process Designers with All Reporting Rights can edit chart
details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.
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Field Description

Name Enter a name, up to 64 characters long, which identifies
the chart.

To display this name as the chart's title, select
the Display as title option.

System Name Enter a unique, shorter name that identifies the chart in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among charts and can
contain only letters (English alphabet), numbers, and
the underscore.

Category Enter or select the group to which this chart belongs.
More...

Use categories to organize like charts together. For
example, you may choose to group all the charts used in
global layouts into the same category, in order to
separate them from charts that are used in process
model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on
the Charts & Reports page.

Owners Click and select the additional users who can edit

the chart details.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
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Field Description

displays or hides the additional filter options.
l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
assigned.

An assigned owner with All Reporting Rights
can view, update, delete, or add additional
owners to the chart. An assigned owner who
has Refresh Workbook Data rights will only be
able to view the chart. To make the chart
available for all users or for configuration
setup, you must have a Process Designer with
All Reporting Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the
chart publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly
available for users to access and view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart in the Shared
Charts & Reports section on the Charts &
Reports page.

Available to
Configuration

Select this check box to make the chart available for
use in configuration.

Specific Roles Select the system user roles that have access to
view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart on the Charts &
Reports page.

Configuration
Access Groups

When either Available to check box is checked,
access groups must be defined for the chart.

The access groups displayed are based on the
current user's access group permissions and the
access groups the chart belongs to. Additionally,
Process Designers with matching permissions will
be able to edit and view the chart.
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Field Description

Process Model
Usage

(Available for existing charts) Click on the Process
Model Usage button to see a list of process models
that the online chart is associated with.

The list displayed includes all process models the
chart is included in, as well as links to the process
model's component tree pages you have Edit access
to.

Note: Clicking either Available to check box will place the chart in the
Shared Charts & Reports section of the Charts & Reports page. If
neither check box is selected, the chart will only be available to the
assigned owners in theirMy Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the
chart. Only online reports created in Accolade are available for selection.

6. In the Horizontal Axis section, make the following selections:
l (Optional) Enter a description in the Label field to display a label for the horizontal
axis.

l (Optional) Select the Rotate Horizontal Axis Text option to display the labels at an
angle instead of horizontally to prevent overlapping.

l (Optional) Select the Show Grid Lines option to display grid lines for one or both
axes.

l (Optional) Select the Start at Zero option to display the data range along the
horizontal axis in relation to 0.More...

When the Start at Zero check box is not selected, the data range for the
horizontal axis will be determined by the lowest and highest available data
values.

For example, you have data points that are all between the values of 6 and 10 that
are being graphed along the horizontal axis. Selecting the Start at Zero option will
display a graph that displays the value range of 0 to 10 along the horizontal axis to
show the relation of the data to the origin. If Start at Zero is not selected, the graph
will display the value range of 6 to 10 along the horizontal axis.

l (Optional) In the Number Format drop-down, select an option to indicate how
values on the axis are displayed.

l In the Column drop-down list, select the column from the report that represents the
data and measurement values to plot on the horizontal axis of the chart.

l If a column within the report contains a selected Aggregate value, the aggregation
displays automatically when the report column is selected to display in a chart.
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7. In the Vertical Axis section, make the following selections:
l (Optional) Enter a description in the Label field to display a label for the vertical axis.
l (Optional) Select the Show Grid Lines option to display grid lines for one or both
axes.

l (Optional) In the Number Format drop-down, select an option to indicate how
values on the axis are displayed.

l Select the Lines columns from the report that represent the data and measurement
values to plot on the vertical axis of the chart.

l If a column within the report contains a selected Aggregate value, the aggregation
displays automatically when the report column is selected to display in a chart.

8. (Optional) In theGroup By field, select columns from the report to apply line groupings
to the data presented in the graph.

Adding additionalGroup By selections introduces more lines to your
display which may impact chart use.

9. (Optional) Select the Display Point Marker check box to display the grid points.

10. In the Cycles field, select one or many cycles. Each cycle displays a different grouping
of data that the lines represent. The Horizontal Axis selection is automatically selected
and cannot be unselected.

11. Enter the following information to alter the chart display:

Field Description

Style Select whether to display lines only, or lines with fill
below.

Legend Select where in the chart to display the key that
identifies what the colors in the chart represent.

After the chart renders, toggle a key label in the legend
to hide and show data without changing the underlying
chart and report configuration.

Color Theme Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme
to accommodate each value measurement. Themes 2-5
allow for up to 20 plotted values.

12. (Optional) If you edited an existing chart, click in the upper right corner to view the
new chart.

13. Click Save to save your changes and create the chart.
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Example - Creating Line Chart Trends Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of
products over the last several years. The user has created a Product Line Revenues Report
for their report source, and selected the Product Lines, Region, Year, and Revenuemetrics
to be included in the report.

To create a line trends chart to display this information and cycle through the metrics for
different chart views, the user has selected the Year for the Horizontal Axis Label, the
Product Lines as the Column value, the Revenue for the Vertical Axis Label, the Revenue
for the Lines, the Region for theGroup By value, and Revenue, Region, and Year as the
Cycles values. The Product Lines in the report represent the business units of Desktop,
Tablets, Peripherals, Servers, and Mobile. The line segments represent the various products
by category across region and revenue over several years. Select the cycle icon to view
the different charts. Toggle a key label in the legend to hide and show data in the rendered
chart.

Notes:
l To delete a saved chart, display the chart from the Charts & Reports page, click

to display the chart settings, and click Delete at the bottom of the page. Only
the chart owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
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inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a
user must be an owner or have at least one matching user role for the chart to
display in the layout.

l Use the Currency Symbol system parameter to specify the currency symbol
that displays in the Number Format field when creating charts and reports.

Creating Pie Charts Based on Report Data

Users can create charts to visually represent the data within Accolade. Pie charts present
categories of data as slices of a pie, where each category is represented as a percentage of
the whole value of the chart. In pie charts, the user can cycle through different views, that is,
different categories of data to get a more comprehensive view of a portfolio's performance
using the cycle icon .

Using Accolade online report data, users with All Reporting Rights can create charts on the
Charts & Reports page. Administrators and Process Designers can set charts as available for
sharing with other users, and can add a chart to a pod within a layout to display on a project
page or as a global link.

Important! Select numeric data types for the Slice Represents values to render a
meaningful chart. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a pie chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related
configuration by navigating to the Systemmenu and selecting Content
Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click
the Pie Chart icon.

l To edit the details of an existing report - Click the name of the chart on the
Charts & Reports page and click to edit the report details. Only users assigned
as chart owners and Process Designers with All Reporting Rights can edit chart
details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.
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Field Description

Name Enter a name, up to 64 characters long, which identifies
the chart.

To display this name as the chart's title, select
the Display as title option.

System Name Enter a unique, shorter name that identifies the chart in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among charts and can
contain only letters (English alphabet), numbers, and
the underscore.

Category Enter or select the group to which this chart belongs.
More...

Use categories to organize like charts together. For
example, you may choose to group all the charts used in
global layouts into the same category, in order to
separate them from charts that are used in process
model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on
the Charts & Reports page.

Owners Click and select the additional users who can edit

the chart details.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
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Field Description

displays or hides the additional filter options.
l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
assigned.

An assigned owner with All Reporting Rights
can view, update, delete, or add additional
owners to the chart. An assigned owner who
has Refresh Workbook Data rights will only be
able to view the chart. To make the chart
available for all users or for configuration
setup, you must have a Process Designer with
All Reporting Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the
chart publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly
available for users to access and view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart in the Shared
Charts & Reports section on the Charts &
Reports page.

Available to
Configuration

Select this check box to make the chart available for
use in configuration.

Specific Roles Select the system user roles that have access to
view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart on the Charts &
Reports page.

Configuration
Access Groups

When either Available to check box is checked,
access groups must be defined for the chart.

The access groups displayed are based on the
current user's access group permissions and the
access groups the chart belongs to. Additionally,
Process Designers with matching permissions will
be able to edit and view the chart.
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Field Description

Process Model
Usage

(Available for existing charts) Click on the Process
Model Usage button to see a list of process models
that the online chart is associated with.

The list displayed includes all process models the
chart is included in, as well as links to the process
model's component tree pages you have Edit access
to.

Note: Clicking either Available to check box will place the chart in the
Shared Charts & Reports section of the Charts & Reports page. If
neither check box is selected, the chart will only be available to the
assigned owners in theirMy Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the
chart. Only online reports created in Accolade are available for selection.

6. Select the following information to define the slices within the pie chart and how they
display:

Field Description

Slice Represents Select the data column that contains the row items that
the slices in the pie represent.

Slice Size Select the numeric data column that determines the size
of the slices in the pie.

Cycles Select one or many cycles.

Each cycle is a data column that contains the row items
that the slices in the pie represent. The Slice Represents
selection is automatically selected and cannot be
unselected.

Slice Name Select to include the name of the pie slice as part of the
slice's label.

Slice Value or Slice
Percentage

Select whether to label the pie slices by value or
percentage of the pie included in the slice.

You can select one or both, or select neither to display
the slices with no values.

7. Select the following attributes to define the pie chart's style:

Field Description

Doughnut Displays the pie with an empty space in the middle.
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Exploded Displays the pie with space between each piece.

Number Format Select a number formatting option to indicate how the
values in the chart are displayed. 

Color Theme Select the color palette to assign to the pie sections of
the chart.

If plotting 10 or more data points, consider a color theme
to accommodate each value measurement. Themes 2-5
allow for up to 20-25 plotted values.

Legend Select where in the chart to display the key that
identifies what the colors in the chart represent.

After the chart renders, toggle a key label in the legend
to hide and show data without changing the underlying
chart and report configuration.

8. (Optional) If you edited an existing chart, click in the upper right corner to view the
new chart.

9. Click Save to save your changes and create the chart.

Example - Creating Pie Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of
products over the last several years. The user has created a Product Line Revenues Report for
their report source, and selected the Product Lines, Region, Year, and Revenuemetrics to
be included in the report.
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For example, a user wants to review and compare last year's sales revenue numbers for
several projects. The user has created a Sales Performance report for their chart report
source, and selected the Project Name and Sales Year 1metrics to be included in the report.

To create a pie bar chart to display this information and cycle through the metrics for different
chart views, the user has selected the Product Lines for the Slice Represents, the Revenue
for the Slice Size, and the Region, Year, and Revenue as the Cycles values. The Product
Lines in the report represent the business units of Desktop, Tablets, Peripherals, Servers, and
Mobile. The slices represent the various products by category across region and revenue over
several years. Select the cycle icon to view the different charts. Toggle a key label in the
legend to hide and show data in the rendered chart.

To create a pie chart to display this information, the user has selected Project Name as the
Slice Represents value, and Sales Year 1 as the Slice Size value, to create slices that
represent each project's sales revenue as a portion of the company's overall sales total.

Notes:
l Percentages in pie charts truncate after the first decimal place therefore the total
may not always equal 100%. For example, 27.786% will display as 27.7%.

l Negative values are not included in the pie chart.

l To delete a saved chart, display the chart from the Charts & Reports page, click
to display the chart settings, and click Delete at the bottom of the page. Only

the chart owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
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inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a
user must be an owner or have at least one matching user role for the chart to
display in the layout.

l Before creating the chart, the user selects the sort order of the data in the
associated report.
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Creating Radar Charts Based on Report Data

Users can create charts to visually represent the data within Accolade. Radar charts are multi-
dimensional graphs that display data values based on a shared center axis, and can be useful
for comparing properties of a single component, or for performance analysis and determining
when one variable is performing differently than the rest.

Using Accolade online report data, users with All Reporting Rights can create charts on the
Charts & Reports page. Administrators and Process Designers can set charts as available
for sharing with other users, and can add a chart to a pod within a layout to display on a project
page or as a global link.

Important! Select spokes with numeric data types to render a meaningful chart.
The system will not prevent you from selecting different data types and will plot
selected data as best as possible without error.

To create a radar chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related
configuration by navigating to the Systemmenu and selecting Content
Sources > Charts & Reports Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and
click the Radar Chart icon.

l To edit the details of an existing report - Click the name of the chart on the
Charts & Reports page and click to edit the report details. Only users assigned
as chart owners and Process Designers with All Reporting Rights can edit chart
details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies
the chart.

To display this name as the chart's title, select
the Display as title option.
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Field Description

System Name Enter a unique, shorter name that identifies the chart in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among charts and can
contain only letters (English alphabet), numbers, and
the underscore.

Category Enter or select the group to which this chart belongs.
More...

Use categories to organize like charts together. For
example, you may choose to group all the charts used in
global layouts into the same category, in order to
separate them from charts that are used in process
model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on
the Charts & Reports page.

Owners Click and select the additional users who can edit

the chart details.

To filter the list of users, enter one or more search
criteria to filter by name, login name, email address,
function, or extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
displays or hides the additional filter options.

l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
assigned.
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Field Description

An assigned owner with All Reporting Rights
can view, update, delete, or add additional
owners to the chart. An assigned owner who
has Refresh Workbook Data rights will only be
able to view the chart. To make the chart
available for all users or for configuration
setup, you must have a Process Designer with
All Reporting Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the
chart publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly
available for users to access and view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart in the Shared
Charts & Reports section on the Charts &
Reports page.

Available to
Configuration

Select this check box to make the chart available for
use in configuration.

Specific Roles Select the system user roles that have access to
view the chart.

Users with one or more matching user roles and
either Refresh Workbook Data or All Reporting
Rights will be able to view the chart on the Charts &
Reports page.

Configuration
Access Groups

When either Available to check box is checked,
access groups must be defined for the chart.

The access groups displayed are based on the
current user's access group permissions and the
access groups the chart belongs to. Additionally,
Process Designers with matching permissions will
be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process
Model Usage button to see a list of process models
that the online chart is associated with.
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Field Description

The list displayed includes all process models the
chart is included in, as well as links to the process
model's component tree pages you have Edit
access to.

Note: Clicking either Available to check box will place the chart in the
Shared Charts & Reports section of the Charts & Reports page. If
neither check box is selected, the chart will only be available to the
assigned owners in theirMy Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the
chart. Only online reports created in Accolade are available for selection.

6. In the Polygons field, select the column from the report that represents the data and
measurement values to plot on the chart.

l If a column within the report contains a selected Aggregate value, the aggregation
displays automatically when the report column is selected to display in a chart.

7. In the Spokes field, select the columns from the report that represent the data and
measurement values to plot as groupings or areas of the values.

8. Enter the following information to alter the chart display:

Field Description

Scale Control Select the scaling and size of the displayed chart.
l Select Automatic to set the chart range minimum
and maximum values displayed in the chart based on
the data ranges in the report.

l Select Custom to manually set the chart Range
Minimum and Range Maximum values displayed in
the chart.

Number Format Select a number formatting option to indicate how the
values in the chart are displayed.

Style Select how the polygon shapes charting the data
display.

If you select Lines and Fill or Fill Only, select how solid
to display the shapes in the chart in the Polygon
Opacity field. Using a smaller value displays the
polygons less opaque, and can make each easier to see
if polygons overlap in the chart.

Legend Select where in the chart to display the key that
identifies what the colors in the chart represent.
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Field Description

After the chart renders, toggle a key label in the legend
to hide and show data without changing the underlying
chart and report configuration.

Color Theme Select the color palette to assign to the regions.

9. (Optional) If you edited an existing chart, click in the upper right corner to view the
new chart.

10. Click Save to save your changes and create the chart.

Example - Creating Radar Charts in Accolade

For example, a user wants to review their portfolio of projects, and identify which ones
continue to best fit their company's overall strategy based on a set of current gate scores. The
user has created a Business Opportunity Report for their chart report source, and selected the
Project Name,Market Strategy Alignment, Customer Need,Market/Customer
Attractiveness, Technical Strategy Alignment, and Customer Benefitmetrics to be
included in the report.

To create a radar chart to display this information, the user has selected Project Name as the
Polygons value, and theMarket Strategy Alignment, Customer Need,Market/Customer
Attractiveness, Technical Strategy Alignment, and Customer Benefitmetrics as the
Spokes values to create shapes that compare the gate scores for various projects. Toggle a
key label in the legend to hide and show data in the rendered chart.
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Notes:
l To delete a saved chart, display the chart from the Charts & Reports page, click

to display the chart settings, and click Delete at the bottom of the page. Only
the chart owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a
user must be an owner or have at least one matching user role for the chart to
display in the layout.
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Adding Target Lines to Bar Charts

In order to characterize Accolade data more completely, it can be helpful to include a threshold
line or target value indicators to your chart. Bar charts include an option to display and hide
target data for a project or portfolio. Users can add target lines to grouped, stacked, and
vertical bar charts to visually represent a benchmark line and add context for the viewer.
Adding interpretation to the data visualization helps the viewer understand the information
being presented in the chart.

To add target lines to a bar, grouped bar, or stacked bar chart:

1. From the Project > Charts & Reports page, click the name of the chart and click to
edit the chart details.

2. In the Target Line Report Source field, select the online report to be referenced.

The Target Line Report Source does not have to be the same report as
used for the chart's Report Source. If the Report Source and the Target
Line Report Source are different reports, the values in the Target Line
Report Key column should match the values in theGrouping column.

3. In the Target Line Report Key and Target Line Report Value fields, select the report
columns from the selected source above that will be referenced to create target lines.

The Target Line Report Value controls what values the targets lines display in the
chart.

l If the Target Line Report Source column selected contains rows with unique
values, the Target Line Report Value will display the relative metric value as the
target line.

l If the Target Line Report Source column selected contains rows with duplicate
values, the target line will display as the aggregated totals of the Target Line Report
Valuemetric values from each row of data.

l When Cycle Segments is set to Horizontal Axis, the target lines will only be
applied to the original value, as defined for the horizontal axis.

Examples 1 & 2 discuss how to create a chart with target lines using one or multiple chart
sources, and the Target Line Report Source column contains unique values per project.
Example 3 discusses how to create a chart with target lines using aggregated metric totals.

Example 1 - Bar Charts Using One Report Source

For example, a user has several different projects that are all reporting yearly sales numbers,
and wants to review how each project performed against their individual sales target. For the
report, the user has created a Project Sales Report that includes the Project Name, and
selected the Total Sales and Sales Forecastmetrics to be included in the report.

Using the Project Sales Report as the source for both the chart and the target lines, make the
following selections for a bar chart:
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l For the chart setup, select Project Name as theGrouping value and Total Sales as
the Bar value, to create bars that represent the total sales for each project.

l For the targets setup, select Project Name as the Target Line Report Key value and
Sales Forecast as the Target Line Report Value, to create target lines that represent
the sales targets for each project.

The user could include additional sales data metrics in the chart and report in order to create
grouped bar and stacked bar charts to represent additional comparison views.

Example 2 - Bar Charts Using Different Report Sources

Using the same scenario from Example 1, the user is again reviewing how each project
performed against their individual sales target. In this example, the user will still create a report
to gather the yearly sales numbers from the projects, however the sales targets are defined in
a reference table stored in Accolade, so they will need to create a second report to use this
table information to create target lines.

For the chart report, the user has created a Project Sales Report that includes the Project
Name, and selected the Total Salesmetric to be included in the report. For the target line
report, the user has created a Sales Reference Table report that uses the reference table data
for its information source.

Using the Project Sales Report as the source for the chart, and the Sales Reference Table as
the source for the target lines, make the following selections for a bar chart:

l For the chart setup, select Project Sales Report as the Report Source, Project
Name as theGrouping value and Total Sales as the Bar value, to create bars that
represent the total sales for each project.

l For the targets setup, select Sales Reference Table as the Target Line Report
Source, Project as the Target Line Report Key value and Sales Goal as the Target
Line Report Value, to create target lines that represent the sales targets for each
project.

As with the single source grouped bar and stacked bar examples, the user can include
additional metrics in their chart and reports in order to visually represent the comparisons.

Example 3 - Bar Charts Using Aggregated Metric Totals

In this scenario, the user has several regions that are being reviewed against their regional
yearly sales targets. There are multiple projects within each region, so the user needs to
aggregate both the sales numbers and the total sales forecast for each region. For the report,
the user has created a Regional Sales Report that includes data for all of the projects in the
region, and selected the Sales Region, Total Sales, and Projected Salesmetrics to be
included in the report.
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Using the Regional Sales Report as the source for both the chart and the target lines, make the
following selections for a bar chart:

l For the chart setup, select Regional Sales Report as the Report Source, Sales
Region as theGrouping value and Total Sales as the Bar value, to create bars that
represent the total sales numbers for each region. Since there are multiple projects in
each region, the bar will display the aggregated Total Sales value.

l For the targets setup, select Regional Sales Report as the Target Line Report
Source, Sales Region as the Target Line Report Key value and Projected Sales as
the Target Line Report Value, to create target lines that represent the total sales
targets for each region, Again since there are multiple projects in each region, the target
line will display the aggregated Projected Sales value.

As with the previous examples, the user can include additional metrics in their chart and
reports in order to visually represent the comparisons.

Important!When adding targets to bar charts, keep the following guidelines in
mind:

l Select appropriate data types and values to render a meaningful chart and
targets. The system will not prevent you from selecting different data types
and will plot selected data as best as possible without error.

l Target lines can be turned on and off by clicking on the Targets legend
within the chart.

l Target lines are only valid for use in bar charts that are displayed vertically.

l In stacked bar charts, target lines will not display if Stacked to 100% is
selected.

Notes:
l To delete a saved chart, display the chart from the Charts & Reports page, click

to display the chart settings, and click Delete at the bottom of the page. Only
the chart owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a
user must be an owner or have at least one matching user role for the chart to
display in the layout.

Creating HTML Reports

347



Chapter 4  Designing Charts and Reports

Administrator's Guide

An HTML report uses a single SQL query to gather data and can be accessible from the
Charts & Reports page or from within a project. Users who have the role assignment selected
in the report can also select to receive the report in the body of an email.

Use the Report Privacy Warning Text system parameter to add a
notification within the report to indicate the content is private or
confidential, and should not be forwarded to others.

Consider the following when designing HTML reports:

l An HTML report displayed on the Charts & Reports page may display information
about multiple projects. That same report displayed within a project contains only the
data for that project. Data that is not project-related is displayed the same in both
locations.

l HTML reports can range in size. Ensure your company's email server accommodates
the file size and volume required to send required reports to all the selected users

l HTML reports display in a set, non-editable format. To create a report using formatting,
create an MS Excel report and format it as necessary.

Prior to creating an HTML report, create and save the SQL Query on which the HTML report is
based.

Note: The queries that are available for selection are based on your access group
permissions as defined in your user profile. Only queries that the user has
"Can Edit" access for will be available for selection. Additionally, access
group settings for the query must match the user permissions of other
Process Designers in order to display for them.

To create an HTML report:

1. From the Systemmenu, select Content Sources > Charts & Reports Manager.

To narrow the list, search by the report name or category.

2. Do one of the following:

l To add a new report - Click Add New and select HTML Report from the drop-down
list.

l To edit an existing report - Click the name of the report to edit and click to edit
the report details.

3. Complete the following information to identify and define the data included in the report:

Required fields display with red text and an asterisk * if the field is empty.
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Field Description

Name Enter a name, up to 64 characters long, which identifies the
report.

System Name Enter a unique, shorter name that identifies the report in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among reports, and can contain
only letters (English alphabet), numbers, and the
underscore.

Description Enter a description of the purpose or nature of the report.

This description helps other users identify the report
throughout the system.

Category Enter or select the group to which this report belongs.
More...

Use categories to organize like reports together. For
example, if there are a large number of reports that the IT
department uses to track user logins, use a category to
group those reports together.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted automatically.

Query Select a saved query.

The report displays data gathered from the database for the
defined query.

When defining the query for the report, using
LinkableName instead of the ProjectName
column makes the project's name a hyperlink to
the project from the generated email.

Notification Select the Notifications option from the following:
l Hide - The report is not available for selection on theMy
Profile page.

l Show - Displays the report as an option to schedule,
share, or receive immediately on theMy Profile page for
users with the roles selected in the Roles field.

l Required - Makes the report required and lists it on the
My Profile page for users with the roles selected in the
Roles field. Select the days of the week that the report is
sent to the selected users. Users can modify the day
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Field Description

selections or choose to not receive required reports on
theirMy Profile page.

Configuration
Access Groups

Select the access groups to which the report belongs.

Process Designers with matching permissions will be able
to edit and view the report. The access groups displayed are
based on the current user's access group permissions and
the access groups the report belongs to.

Process Model
Usage

Click the Process Model Usage button to see a list of
process models that the HTML report is associated with.

The list includes all process models the report is included in,
as well as links to the process model's component tree
pages you have Edit access to.

Active In Select where the report is available within Accolade.
l Charts & Reports - Displays the report on the Charts &
Reports page. Clicking this check box will place the
report in the Shared Charts & Reports section of the
Charts & Reports page. If unchecked, the report will
only be available to the assigned owners in theirMy
Charts & Reports section.

l Projects - Displays the report within a project. For a
report to be available for association with a process
model, it must be active in projects.

If the report is not ready for viewing, clear all the check
boxes.

Transpose Select the check box to display reports that contain only one
project as a vertical column rather than a row.

If you select to transpose a report that contains reports for
multiple projects, the transposed result displays data for
only the first project in the report.

Roles Select the system user roles that have access to view the
report.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the report on the Charts & Reports page, as well as
select to receive the report through an email if the report is
available for notifications.

4. Click in the Report Details to ensure the report pulls the correct data and is working

as you intended. Click to return to the Report Details after previewing the report.

5. Click Create to create the new report or Apply to save changes to an existing report.
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Notes:
l To display an HTML report within a project, the report must added at the process
model level, either by adding it to the Reports List pod, or by adding it to a pod
within a layout that is assigned to the process model.

l To delete an HTML report, display the report from the Charts & Reports page,
click to display the report settings, and click Delete at the bottom of the page.
Only the report owner, users assigned as owners with All Reporting Rights, and
Process Designers with All Reporting Rights can delete the report. Deleting a
report does not delete the query on which the report is based. To remove a
report from view but keep its definition for use later, clear the selections in the
Active in field.

l Categories created for queries, HTML reports, or MS Excel reports are saved in
common and apply to all three. To remove a category from the list, ensure that
no queries, HTML reports, or MS Excel reports are assigned to the category.
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Accolade Excel Reports Overview
Accolade Excel reports can be added to the Charts & Reports page within Accolade and/or to
a process model for availability within a project. These reports are built and viewable in Excel,
provide flexibility in formatting, and can be created using the Accolade Office Extensions add-
in application. The application provides an interface to create a data report based on Accolade
data.

Creating Accolade Excel Reports using Accolade Office Extensions

With the Accolade Office Extensions add-in, anyone in your organization with All Reporting
Rights can create a report in Excel using the add-in.

Reports created via the Accolade Office Extensions add-in provides the following advantages:

l No SQL knowledge is required. You can select Accolade data directly from the report
interface without writing SQL queries.

l Reports can be refreshed when downloaded from Accolade to contain up-to-date
information and formatted for distribution or review, query-based tables cannot.

Use the Report Privacy Warning Text system parameter to add a
notification within the report to indicate the content is private or
confidential, and should not be forwarded to others.

The information below assumes you are using the Accolade Office Extensions add-in to create
reports and assumes you are familiar with basic Excel functionality. For more information
about manipulating the data in a report, see the online Help available from within the add-in.

To create an Accolade Excel report:

1. Open Excel and navigate to the Accolade menu in the Excel ribbon.

This allows Excel to pull data from Accolade into the report and allows reports to be
created or refreshed to display current Accolade information.

If necessary, connect to the appropriate server by clicking Server and
entering the server URL.

2. Click Data Reports and do one of the following:
l To add a new report - Click Add New.

l To create a report based on an existing report - Click to copy the report.

l To edit an existing report - Click the name of the report to open it for editing.

3. Select a subject from the drop-down list, such as Projects or Users, to display the
column sets available within that subject.
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4. Double-click or drag and drop the column names from the left side of the dialog to any
area in the Columns tab to include the column in the report.
l To search for a column, enter search criteria in the Find field after selecting the
subject.

l Use the and options to expand or collapse the subject data sets in order to
select specific column options.

l To include an entire column set, drag and drop the column set to the Columns tab.
l To change the column order of selected columns, drag and drop a column into a new
location within the list.

l To remove a column, click in the corresponding row.

5. (Optional) Refine the content of the report as necessary.More...
l Rename columns - Click in one or more selected columns and enter a new column
name that is more appropriate for the report you are creating.

l Set column sorting - Click next to one or more selected columns to indicate
whether the column is sorted in ascending or descending order. If you select more
than one column to sort by, indicate the order in which the columns sort; 1 being the
primary sort, 2 the secondary sort, and so on.

l Determine column properties - For number and date columns, click or in
the Properties area to group data together by aggregation or select date formats.
Select the aggregate method or date format and click away to apply the changes.
All selected aggregate methods are added to the report columns list with the
aggregate method appended to the column name.

For example, to summarize the total costs for all projects within a brand, select
Sum as the aggregate value in a column that represents the total costs for a
project.

l Add Count Column - If you select to summarize values within the report, click
Add Count Column to add a column that shows how many rows of source data
are combined in the summary row.

You can order and rename the added column as you can other columns;
however, you can add only one Count column to the report.

l Add Calculated Column - Click Add Calculated Column to add a column to
the report that displays a calculation based on other column data.

6. (Optional) On the Filters tab, double-click or drag and drop the column name from the
left side of the dialog to any area in the Filters tab to use it as filter criteria that data
must match to be included in the report.

7. (Optional) On the Report Details tab, add the following information:
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Field Description

Report Name Enter a name which identifies the report.
Report Location Select one of the following options for the location to

place the report:
l Existing worksheet - Select this check box to add
the report to an existing worksheet that does not
already contain a report, and select the appropriate
existing worksheet name from the drop-down list.

l New worksheet - Select this check box to create and
add the report to a new worksheet, and enter the
name for the new worksheet.

Override Project
Filtering

Select this check box to include the entire report set
from within a project.

The report will not filter to project-specific data when
viewed from within a project, and will display all projects
in a portfolio regardless of security.

Transpose Select this check box to transpose the column and row
data when the report is rendered.

8. On the Advanced Matrix Settings tab, if more than one matrix was selected in the
report columns, click Add to add the matrix join definitions.

9. Click Done to apply your changes and generate the report.

10. Save the report to an accessible location.

Notes:
l Click Refresh Columns in the lower left of the dialog to refresh the columns. Any
columns modified in the Accolade application while the user is creating or editing
the report will be updated. Deleted columns will be removed from list of available
columns and will display red in the Columns tab and Filters tab. Delete the
selections in red to correct the report.

l To delete a saved report created in Excel, click Data Reports in the Accolade
menu on the Excel ribbon and click next to the corresponding report. Deleting
a report created using the Accolade Office Extensions add-in deletes report data
being pulled from Accolade into the workbook. Deleting a report directly from the
worksheet does not delete the data associated with the report.
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Adding Calculated Columns to Accolade Excel Reports

Reporting details can be contained in multiple sources within Accolade. To combined related
data values to be used for reporting or the creation of charts or presentations, users can create
reports that include calculated columns that calculate and/or display combined data, allowing
users to manipulate and analyze Accolade data values.

For example, a user may have several different project metrics that represent categories of
project costs such as Administrative, Operating, Marketing, etc. In order to calculate and
display the sum of these project costs within an Accolade report or chart, the user can include
a calculated column in their report setup.

Example

Writing a calculated column formula in Accolade is slightly different than writing an equation in
math class, or using formulas in Excel. The most notable difference is the use of the equal sign
(=). For example, if you want to add the numbers 3 and 2:

l In math class, the equation would read 3+2=, with a calculated value of 5.
l In Excel, formulas start with the equal sign, so it would look like =3+2. When entered,
the value in the selected cell would return as 5. If you wanted to add two cell values, it
would look something like =A1+B1 or =SUM(A1:B1). Assuming the values in A1 and
B1 were 3 and 2 respectively, it would return the value 5.

l In an Accolade Excel report created using the Accolade Office Extensions add-in, the
equal sign is assumed, so it does not need to be included in the formula field. If you
wanted to add the values of Column A and Column B, it would look like [Column A] +
[Column B] or Sum([Column A], [Column B]). Assuming the first row values of
Column A and Column B were 3 and 2 respectively, it would return the value 5.
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To add a calculated column to an Accolade Excel report:

Note: See below for a list of calculations that are currently supported for reporting.

1. Create a new report or open an existing report for editing.

2. On the Columns tab, ensure the columns to be used in the calculation are included in
the report.

Report calculations are executed from left to right. In order for selected
columns to be used in a calculated column, they must a) be selected as a
column for the report, and b) be included before they are referenced by a
calculated column (this means they must appear to the left of the
calculated column when displayed, or above the calculated column when
selecting columns in the report setup).

3. Click Add Calculated Column.

The column is added with two fields - one for the display name for the column, and one
for the formula to be calculated.

4. In the left field, enter the column name to be displayed when the report is generated.

5. In the field, enter the formula to be calculated within the report.

When entering your formula, the columns are referenced by enclosing the column
display name inside of square brackets. In the example above, Column A is entered as
[Column A].

6. Click to select the appropriate datatype for the calculated column.

l Date - Select this option when you want the column data to display as a Date
datatype, for example when using the DateAdd function to project a future project
date.
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l Number - Select this option when you want the column data to display as a Number
datatype, for example when using the Sum function to combine the values of two or
more columns of expense values.

l String - Select this option when you want the column data to display as a String
datatype, for example when using the Concatenate function to display user name
and functions combined in one column.

7. (Optional) Drag and drop the calculated column to a new location within the list.

Note that while the calculated column cannot be displayed in the report until after its
reference columns are displayed, you can have calculated columns that are displayed
between data columns as necessary. Using the example above, after the Sum column
we could add Column C and Column D to the report and then add another calculated
column, and so forth.

8. Finish setting up the report, as necessary.

9. Click Done to apply your changes and generate the report.

10. Save your changes to the report.

Available Formulas for Calculated Columns in Reporting

The following section details the operators and functions that are available for use when
creating your calculated column formulas.

Important! Note that the examples use "Column A", "Column B", and "Column C"
to generically refer to the display names of different columns that are included in
the report data.

Operators

Operators are process or mathematical parts of expressions, such as addition and
multiplication, and relationships such as greater than or less than. Use the operators below
within your calculated column expressions.

Operator Example

Additive and Subtractive Operators

+ (plus, plus sign) [Column A]+[Column B]

- (minus, dash) [Column A]-[Column B]

Multiplicative Operators

* (multiplied by, asterisk) [Column A]*5

/ (divided by, slash) [Column A]/[Column B]

% (mod, percent sign) [Column A]%10
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Operator Example

Primary Operators

value (integers, text strings,
dates, functions)

('this is a text string')

While single quotes work for
dates, we recommend wrapping
dates in pound or hash signs
instead to ensure consistency of
data types. For example,
(#2021-10-19#).

( ) (parentheses) 1000-(6*[Column A])

Relational Operators

= (equals) [Column A]=250

<> (does not equal) [Column A]<>[Column B]

> (greater than, angle
bracket)

[Column A]>250

>= (greater than or equal to) [Column A]>=250

< (less than, angle bracket) [Column A]<500

<= (less than or equal to) [Column A]<=100

Logical Operators

or, || (double pipe) [Column A]<[Column B]||[Column A]<500

and, && [Column A]<[Column B]&&[Column
A]<1000

Functions

The functions included in the calculated column formula determine in part what is returned in
the column. Use the functions described below within your calculated expressions to return
data within a calculated column.

For more information on the description or formatting for the calculations below, see
"Calculated Metric Expressions Reference" on page 136.

Function Example Formula

Abs Abs([Column A])

Acos Acos([Column A])
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Function Example Formula

Asin Asin([Column A])

Atan Atan([Column A])

Avg Avg([Column A], [Column B], [Column C])

Ceiling Ceiling([Column A])

Concatenate Concatenate('text1',[Column A], 'text2',
'textN')

Contains Contains([Column A], 'My Blue Heaven',
2, 7)

Cos Cos([Column A])

DateAdd DateAdd('D', 5, [Column A])

DateDiff DateDiff('D',[Column A], [Column B])

DatePart DatePart('M', [Column A])

Exp Exp([Column A])

Find Find([Column A], 'My Blue Heaven', 2, 20)

First First([Column A], [Column B], [Column C])

Floor Floor([Column A])

IEEERemainder IEEERemainder([Column A], [Column B])

If If([Column A]>500, 'Go ahead', 'Stop')

In In([Column A], 1, 2, 3)

IsNull IsNull([Column A], [Column B])

Join Join([Column A], [Column B], [Column C]),
'|')

Length Length([Column A])

Log Log([Column A], 10)

Log10 Log10([Column A])

Lower Lower([Column A])

LTrim LTrim([Column A])

Max Max([Column A], [Column B], [Column C])

Min Min([Column A], [Column B], [Column C])
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Function Example Formula

Now Now()

Pow Pow([Column A], 2)

Replace Replace([Column A], 'Blue', 'red')

Round Round([Column A], 2)

RTrim RTrim([Column A])

Search Search('blue', [Column A], 5, 30).

Sign Sign([Column A])

Sin Sin([Column A])

Sqrt Sqrt([Column A])

SubString SubString([Column A], 4, 10)

Sum Sum([Column A], [Column B], [Column C])

Tan Tan([Column A])

Trim Trim([Column A])

Truncate Truncate([Column A])

Upper Upper([Column A])

Notes:
l To delete a calculated column from an Accolade Excel report, click Data
Reports in the Accolade menu on the Excel ribbon and click the name of the
report to open it for editing. Expand the Columns tab, and click in the
corresponding calculated column row to delete it. Click Done to apply your
changes and generate the report and save your changes to the report.
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Adding Dynamic Filters to Accolade Excel Reports

Capture and filter report data using relative metric and metadata field codes to create dynamic
reports that display data according to defined filters within the report. Filtering reports based on
relative metrics and metadata field codes allows you to narrow the returned data set while still
generating a higher level view. Dynamic filters allow you to view a subset of data from within
different projects.

Important! Ensure theOverride project filtering check box is selected on the
report settings. This enables the report to include data across a subset of projects.

To add dynamic filters to an Accolade Excel report:

1. Create a new report, or open an existing report for editing.

2. Click and expand the Filters tab.

3. To add filters, double-click or drag and drop the column names from the left side of the
dialog to any area in the Filters tab.
l To search for a column to add as a filter, enter search criteria in the Find field after
selecting the subject.

l To include an entire column set, drag and drop the column set to any area in the
Filters tab.

If multiple filters are added to the report, data must meet ALL filter criteria
to be included in the report.

4. For each added filter, select the operator and filter criteria that report data must match
to be included.

The filter operators are dependent on the column selected to filter by, and generally
include options such as =, is empty, is one of, does not contain, and more.

The filter type must be selected from one of the following, and the following field
identifies the criteria to be met:

l Metadata - Enter the field code display name and select from the returned list.
Ensure you enter a valid query field code.

l Metric - Enter the metric display name and select from the returned list.

l Text - Enter or select a static string or numeric value such as a date.
l Current User - Filters the report to data only applicable to the user logged in and
viewing the report. Current User is only available for numeric or ID data type
columns.
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Type ahead to search for metrics and field codes when defining the filter
criteria. Only metrics and field codes that match the data type of the filter
display for selection. For example, if you select a date filter, you can only
select date metrics or field codes to define the relative filter.

For example, to create a report that returns a list of deactivated users, filter on the User
Active column to return only users where the active flag is set to No.

5. (Optional) Select the Prompt on Refresh check box to prompt the user to review
and/or update the filters when refreshing the data in the report.

6. Finish setting up the report, as necessary.

7. Click Done to apply your changes and generate the report.

8. Save your changes to the report.

Notes:
l To delete a filter from an Accolade Excel report, click Data Reports in the
Accolade menu on the Excel ribbon and click the name of the report to open it for
editing. Expand the Filters section, and click in the corresponding filter row to
delete it. Click Done to apply your changes and generate the report, and save
your changes to the report.

l Long string and multi-select list metrics are currently not supported for use as
metric filters.

Adding Multiple Matrices to Accolade Excel Reports

Reporting details can be contained in multiple sources within Accolade. To consolidate data
into a single source to be used for reporting or the creation of charts or presentations, users
can create reports to combine the data. Information from more than one project matrix can be
pulled into a report by including a common value that is included in the sources, for example,
using a Department or Region metric or a common Row ID.

In addition to selecting the matrix and metric columns to be included in the report, users must
create join statements that define how the matrix information is related.
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To add multiple matrices to an Accolade Excel report:

1. Create a new report or open an existing report for editing.

2. On the Advanced Matrix Settings tab, select the matrices and metrics to be included
in the report.

3. Click Add to add the matrix join statements.

4. In each side of the dialog, select one of the matrices from the drop-down list, and select
an option to use as the common value to join the matrices.

The two selected matrices must be different, but the matrix/metric combination can be
any combination of metrics or row IDs, as long as the selected metrics share a common
value and are of the same data type.

Selecting a metric will define it as the common value between the two matrices. Note
that it can be the same metric if it is used in both matrices, or it can be different metrics
that will have the same value in both matrices. In addition, a metric used as a common
value does not need to be added as a reporting column in order to be used to create the
join statement.

Selecting Row ID will compare matrices by rows, for example Row 1 in Matrix A will be
compared with Row 1 in Matrix B, and so on. This can be used when there are no
additional common values in the two matrices, and the matrices have a direct line-by-
line comparison.

Caution! Selecting Row ID as a common value can cause
inconsistencies in reporting. Since assigned Row IDs are not visible
within a matrix, report results can be incorrect if rows have been deleted
from a matrix or if there is a mismatch.
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5. Repeat steps 3-4 to add additional matrix join statements as necessary.

All included matrices must have at least one related join statement, but a matrix can be
referenced in more than one statement. For example, if you choose to include metrics
from Matrix A, Matrix B, and Matrix C, you would need to create two statements to join
the information. You could create a statement that relates A to B, and one that relates B
to C, or you could have a statement that relates A to B, and one that relates A to C.

6. Finish setting up the report, as necessary.

7. Click Done to apply your changes and generate the report.

Note: [EMPTY] or blank cells in your report may indicate a mismatch in the
common value linking the matrices. If the project value referenced in the join
statement is not defined in one of the matrices, for example if there is not a
matching value in both matrices, or a matrix contains empty rows, the report
will return partial or full rows that contain [EMPTY] values.

Example

For example, a user has two different matrices that contain information related to vendor
contracts for their projects, and needs to create a report containing relevant information from
both matrices. They have a matrix named Contract Information, which contains the start date
and duration of the specific contracts, and a second matrix named Contract Cost, which
contains the costs related to the specific contracts.

To pull this information into one report, the user has added the related columns to the
Columns tab, and created a join statement in the Advanced Matrix Settings tab that links the
two matrices using the Contract IDmetric that is a member of both matrices.
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Once the user enters the remaining report details and clicks Done, the following report is
generated.

Note the following:

The Contract ID field is the common identifier included in both matrices, and used to connect
the relevant information.

Columns B-D contain information that is from the Contract Informationmatrix in the related
projects.

Columns E-G contain information that is from the Contract Costmatrix in the related projects.

The highlighted sections below show two different scenarios that may indicate missing or
incomplete data.
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l Rows 5 & 6 of the report display [EMPTY] in some of the data cells, which indicates
Contract IDs values that are not found in both matrices. In row 5, the information for
contract A101 is only included in the Contract Information matrix, so the related
Contract Cost matrix fields are [EMPTY]. In row 6, the information for contract A110 is
only included in the Contract Cost matrix, so the related Contract Information matrix
fields are [EMPTY].

l Rows 13 & 14 display [EMPTY] cells in all of the data cells, which indicates that one or
more of the included matrices either does not have any rows added, or contains empty
rows.

Note: Although the [EMPTY] returned values are an indicator of potential issues,
the mismatched values reported are dependent on the data type. String and
list metrics will display as [EMPTY]. As shown in the example below, a
number metric will display 0, and a date metric will represent the default
1/1/1900 date.

Notes:
l To delete a matrix join statement from an Accolade Excel report, click Data
Reports in the Accolade menu on the Excel ribbon and click the name of the
report to open it for editing. Click the Advanced Matrix Settings tab, and click

in the corresponding definition row to delete it. Click Done to apply your
changes and generate the report and save your changes to the report.

Excel Report Templates Overview
Add MS Excel report teplates to the Charts & Reports page within Accolade and to a process
model for availability within a project. These reports are built and viewable in MS Excel,
provide flexibility in formatting, and can be created using the Accolade Office Extensions add-
in application. The application provides an interface to create a data report based on Accolade
data. You can also create MS Excel reports using a template and the Accolade query
infrastructure, creating charts and tables based on data pulled into the spreadsheet using
queries.
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Creating Excel Report Templates using Accolade Office Extensions

Create an online report within Accolade instead of in Excel using the
Accolade Office Extensions add-in to create a refreshable report without
having to leave Accolade and without having to install the Accolade Office
Extensions add-in.

Anyone in your organization with All Reporting Rights can create an Excel report using the
Accolade Office Extensions add-in. Created reports via the add-in provides the following
advantages:

l No SQL knowledge is required. You can select Accolade data directly from the report
interface without writing SQL queries.

l Reports can be refreshed when downloaded from Accolade to contain up-to-date
information and formatted for distribution or review, query-based tables cannot.

l A spreadsheet template containing a report created via the add-in can also be used as
the template for a deliverable or activity. The template is created the same way as a
report template, and is added to the Template Library as a Process Document type
template instead of as a Report type.

Use the Report Privacy Warning Text system parameter to add a
notification within the report to indicate the content is private or
confidential, and should not be forwarded to others.

The information below assumes you are using the Accolade Office Extensions add-in to create
reports and assumes you are familiar with basic Excel functionality. For more information
about manipulating the data in a report, see the online Help available from within the add-in.

To create an MS Excel report:

1. Open Excel and navigate to the Accolade menu in the Excel ribbon.

This allows Excel to pull data from Accolade into the report and allows reports to be
created or refreshed to display current Accolade information.

If necessary, connect to the appropriate server by clicking Server and
entering the server URL.

2. Click Data Reports and do one of the following:
l To add a new report - Click Add New.
l To edit an existing report - Click the name of the report to open it for editing.

l To create a report based on an existing report - Click to copy the report.

Use the arrow in the Report Name heading to sort reports in ascending
or descending order.
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3. Select a subject from the drop-down list, such as Projects or Users, to display the
column sets available within that subject.

4. Double-click or drag and drop the column names from the left side of the dialog to any
area in the Columns tab to include the column in the report.
l To search for a column, enter search criteria in the Find field after selecting the
subject.

l Use the and options to expand or collapse the subject data sets in order to
select specific column options.

l To include an entire column set, drag and drop the column set to the Columns tab.
l To change the column order of selected columns, drag and drop a column into a new
location within the list.

l To remove a column, click in the corresponding row.

5. (Optional) Refine the content of the report as necessary.More...
l Rename columns - Click in one or more selected columns and enter a new column
name that is more appropriate for the report you are creating.

l Set column sorting - Click next to one or more selected columns to indicate
whether the column is sorted in ascending or descending order. If you select more
than one column to sort by, indicate the order in which the columns sort; 1 being the
primary sort, 2 the secondary sort, and so on.

l Determine column properties - For number and date columns, click or in
the Properties area to group data together by aggregation or select date formats.
Select the aggregate method or date format and click away to apply the changes.
All selected aggregate methods are added to the report columns list with the
aggregate method appended to the column name.

For example, to summarize the total costs for all projects within a brand, select Sum
as the aggregate value in a column that represents the total costs for a project.

l Add Count Column - If you select to summarize values within the report, click
Add Count Column to add a column that shows how many rows of source data are
combined in the summary row.

You can order and rename the added column as you can other columns;
however, you can add only one Count column to the report.

l Add Calculated Column - Click Add Calculated Column to add a column to
the report that displays a calculation based on other column data.

6. (Optional) On the Filters tab, double-click or drag and drop the column name from the
left side of the dialog to any area in the Filters tab to use it as filter criteria that data must
match to be included in the report.

7. (Optional) On the Report Details tab, add the following information:
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Field Description

Report Name Enter a name which identifies the report.
Report Location Select one of the following options for the location to

place the report:
l Existing worksheet - Select this check box to add
the report to an existing worksheet that does not
already contain a report, and select the appropriate
existing worksheet name from the drop-down list.

l New worksheet - Select this check box to create
and add the report to a new worksheet, and enter the
name for the new worksheet.

Override Project
Filtering

Select this check box to include the entire report set
from within a project. The report will not filter to project-
specific data when viewed from within a project, and will
display all projects in a portfolio regardless of security.

Transpose Select this check box to transpose the column and row
data when the report is rendered.

8. On the Advanced Matrix Settings tab, if more than one matrix was selected in the
report columns, click Add to add the matrix join definitions.

9. Click Done to apply your changes and generate the report.

10. Save the report to an accessible location.

11. Add the report to the Template Library using the Report type for access within
Accolade.

Notes:
l To modify an existing Excel report, download the file from the Template Library,
make the necessary changes and re-upload the file to the Template Library.

l If the report is set to display within a project, and if you want the report to display
project data from projects other than the one it displays in, for example, related
projects, create the custom property SGM_SYS_
UnconstrainedProjectLevelReport in the document.

Creating Excel Report Templates Using Queries

Note: Although the Report - Excel <version>.xltx base template is still available,
Sopheon recommends creating online reports available fromWorkspace >
My Workspace > Charts & Reports, or using the Accolade Office
Extensions add-in.
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If you are comfortable writing SQL queries, or if you need to create a report that requires an
advanced database query, add a workbook to an Excel file that is populated with data from
queries created within Accolade. To use queries within an Excel report, use the Report -
Excel <version>.xltx base template available on the Base Templates Reference Page. This
file is set with the workbooks and structure required for creating Excel reports that contain quer-
ies.More...

You can create a file based on Report - Excel <version>.xltx and save it to the Template
Library to use as a base template for similar reports. However, in doing so:

l Do not delete, insert, or rearrange the data columns on the data worksheets. The
column structure on these worksheets must match that of their queries. Rewrite queries
to match the data worksheets.

l Do not add Excel pivot tables or other sets of data to the data worksheets.

l Do not add formulas to the columns of the data tables on the data worksheets. You can
add formulas to the columns to the right of the rightmost query-populated column. The
import automatically propagates the formulas across the imported data.

l Include only numbers, letters, underscores, and periods in the heading of a formula
column. Other characters cause an "Invalid Name" error when the workbook is opened
in Accolade.

The information below describes how to add queries to an Excel file. For information about the
Accolade query infrastructure, see the Queries Overview topic in the online Help.

Note: The queries that are available for selection are based on your access group
permissions as defined in your user profile. Only queries that the user has
"Can Edit" access for will be available for selection. Additionally, access
group settings for the query must match the user permissions of other
Process Designers in order to display for them.

To create an MS Excel report using a query:

Note: The following procedure assumes that you have created the appropriate
queries for the report and that you are familiar with basic Excel functionality.

1. Add an Excel report to Accolade.

Select the queries to use in the report and select either the Report - Excel
<version>.xltx file or a template based on it as the template file.

2. Click Preview to populate Accolade data into the file and save the preview file to your
computer.

Save the file using a name that identifies the nature and purpose of the report. This is
the file that becomes the template that is added back to the Template Library.

3. Check the first data worksheet to confirm that the data is what you want and to identify
the cell range it occupies.
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For the workbook to refresh correctly, the worksheet must contain at least two rows of
data. If the query only retrieved one row, add a second row of data manually on the data
worksheet and identify both rows in data ranges.

4. (Optional) To manipulate the data with formulas, add the formulas to the right or left of
the table.

5. Continue to format the workbook by inspecting the next data worksheet, adding a new
worksheet, and creating a report. You can create one or more reports for each data
worksheet in the workbook.

6. Hide the data worksheets and any other worksheets that users of the report should not
modify.

7. Save the completed Excel workbook to your computer and add the template to the
Template Library.

8. From the Systemmenu, select Content Sources > Charts & Reports Manager, and
click the name of the report you created in step 1.

9. In the Template field, select the MS Excel file you added to the Template Library in step
8.

10. Click Update to save the changes to the report.

Notes:
l When a query refreshes the data set, it can retrieve more, or fewer rows, but it
cannot retrieve a different number of columns from the database.

Creating MS Excel Reports in Project Currencies

By default, currency values included in MS Excel reports are shown in the corporate currency.
However, some projects may track their values in a local currency that is different than the
corporate currency. To convert values into the project currency, use the Currency Report
Template <version>.xltm base template available on the Base Templates Reference Page,
or in the Template Library, as a starting point to build the report.

Note: The information in this topic details how to create MS Excel reports if your
currencies are defined using the general currency conversions and
Corporate Currency system parameter method. If you use the recommended
date-specific currency conversions method, you can create a report in a
project currency using calculations based on the metrics defined to capture
the project's currently selected currency. Before creating a report that uses a
project's currency, define the currency conversions.

To add a currency conversion to a project report template, add a conversion table to a
worksheet within the file and set cross references from the report cells to the conversions. You
can also select the format in which currencies display.
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Note: An Administrator or Process Designer must also have All Rights to Reporting
for access to create the Accolade Office Extensions report using the
currency conversions reference table.

To create an MS Excel report in a project's currency:

Note: The procedure below assumes that you have Accolade Office Extensions
installed.

1. Save the Currency Report Template <version>.xltm file to your computer and open
the file in Excel.

2. Within Accolade Office Extensions, click Data Reports and click Add New to add a
report.

3. Select the Reference Tables subject.

4. Select Currency Conversions from the Available Reference Tables list, and select
to include the Currency Code and Conversion Factor columns in the table.

These two columns enable you to select the correct conversion factor to convert the
corporate currency values in the database into the project currency values you want to
display in the report. You can select additional columns that may be helpful in identifying
the currencies available.

5. Continue through the dialog options, select the worksheet and provide a table name
that identifies the table as the currency conversion table, and click Finish to add the
table.

Conversion tables are typically included on a separate worksheet so you
can hide the worksheet before adding the report template to the Template
Library.

6. Create the rest of the report, including the currency metrics to convert.

7. In the cell where you want to convert a currency value, enter the following formula:

=ConvertToCurrency(cell, "code")

where

l cell is the reference to cell containing the value to convert

l code is the three-digit currency code of the currency to convert to. The code must be
contained in quotes.

For example, =ConvertToCurrency(A2, "JPY") to convert the currency from the
corporate currency to Japanese Yen.

To format the value, see the procedure below.
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8. Copy the formula down the right side of the table to every row containing values to be
converted to the project currency and hide the column that contains the values to be
converted.

Adding the formulas to the column to the right of the column containing the corporate
currency values leaves the column of converted values in the original position of the
now hidden column

9. Save the file with a name that clearly identifies the nature and purpose of the report.

10. Add the file to the Template Library.

To format a currency value in an MS Excel report:

1. Open a report that contains a currency conversion table (as created in the procedure
above).

2. Open the Accolade menu in the MS Excel ribbon, select the conversion table you
created in the procedure above and clickModify.

3. Select to include Format 1 and Format 2 and click Finish.

4. In the cells that contain the =ConvertToCurrency(cell, "code") formula (see
step 6 above), add the format column heading parameter.

=ConvertToCurrency(cell, "code", "format column heading")

This parameter is either Format1 or Format2 in the Currency Conversion table you
modified in step 3 that contains the numeric format to display.

Example

Note the formula displayed in the formula field.

5. Save the file and add it to the Template Library.

Adding Excel Report Templates to Accolade

For an Excel report to be viewable in the Charts & Reports page or in projects within
Accolade, an Administrator or Process Designer must add the report to Accolade.

To add an Excel report to Accolade:

Note: You must have a report template with the type Spreadsheet Report saved in
the Template Library prior to adding an Excel report using the instructions
below.

1. From the Systemmenu, select Content Sources > Charts & Reports Manager.

To narrow the list, search by the report name or category.
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2. Do one of the following:

l To add a new report - Click Add New and selectMS Excel Report from the drop-
down list.

l To edit an existing report - Click the name of the report to open it for editing.

3. Complete the following information to identify and describe the report:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which
identifies the report.

System Name Enter a unique, shorter name that identifies the report
in queries, reporting views, field codes, and other
places in Accolade.

The name must be unique among reports, and can
contain only letters (English alphabet), numbers, and
the underscore.

Description Enter a description of the purpose or nature of the
report.

This description helps other users identify the report
throughout the system.

Category Enter or select the group to which this report belongs.
More...

Use categories to organize like reports together. For
example, if there is a large number of financial reports,
a Project Manager can use a category selection to
locate only financial reports.
l Leave this field blank to add to the Default
category.

l To define a new category, select New Category
and enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted
automatically.

Query If the report is created using the Accolade query
infrastructure, select up to five queries to create tables
in the report.

Each query copies its data to the indicated Excel
worksheet.

Configuration Access
Groups

Select the access groups to which the report belongs.
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Field Description

Process Designers with matching permissions will be
able to edit and view the report. The access groups
displayed are based on the current user's access
group permissions and the access groups the report
belongs to.

Process Model Usage Click the Process Model Usage button to see a list of
process models that the MS Excel report is associated
with.

The list includes all process models the report is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Active In Select where the report is available within Accolade.
l Charts & Reports - Displays the report on the
Charts & Reports page. Clicking this check box
places the report in the Shared Charts & Reports
section of the Charts & Reports page. If
unchecked, the report will only be available to the
assigned owners in theirMy Charts & Reports
section.

l Projects - Displays the report within a project.
Clicking this check box will make the report
available for association with a process model.

If the report is not ready for viewing, clear all the check
boxes.

Template Select the file from the Template Library that serves as
the basis for the report.

Roles Select the system user roles that have access to view
the report.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be
able to view the report on the Charts & Reports page,
as well as select to receive the report through an email
if the report is available for notifications.

4. Click Create to create a new report or Apply to save changes to an existing report.

Notes:
l To delete an Excel report, display the report from the Charts & Reports page,
click to display the report settings, and click Delete at the bottom of the page.
Only the report owner, users assigned as owners with All Reporting Rights, and
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Process Designers with All Reporting Rights can delete the report. Deleting a
report does not delete the query or the file in the Template Library on which the
report is based. To remove a report from view but keep its definition for use later,
clear the selections in the Active in field.

l Categories created for queries, HTML reports, or MS Excel reports are saved in
common and apply to all three. To remove a category from the list, ensure that
no queries, HTML reports, or MS Excel reports are assigned to the category.

Setting Custom Excel Report Template Properties

Using the Accolade Office Extensions add-in to create Excel reports, you can add and modify
custom properties based on your report and template needs. Use the custom Excel document
properties described below for Excel reports attached to a deliverable or activity or available
from the Charts & Reports page. Custom properties include how data is refreshed, server
information, and where log files are saved.

Note: Accolade does not refresh the data for non-document owners, regardless of
the settings in the file.

Refresh on Open

Microsoft templates contain a custom property, SGM_SYS_RefreshOnOpen, which
determines how the document's content is refreshed when it is opened in Accolade.

If the report is used as a template in a deliverable or activity, when a document owner
downloads the template from the Deliverable or Activity dialog within a project, the data is
refreshed, regardless of the SGM_SYS_RefreshOnOpen setting. For document versions,
document owners are prompted to refresh the data.

To set the refresh on open properties in an Excel report template:

1. Create the Excel report template and save it to Accolade.

2. Download the document and open it in Excel.

Downloading the document from Accolade saves Accolade-specific properties to the
document.

3. Display the document's advanced properties.

How to display the advanced properties varies across applications and versions.
Typically, property options are located under the Filemenu. Refer to the Excel online
Help for the specific location in the version you are using.

4. In the Properties dialog box, click the Custom tab.

5. From the properties list, select SGM_SYS_RefreshOnOpen.

6. In the Value field, enter one of the following options:
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l ALWAYS - Refreshes the template automatically on open from Charts & Reports.
l PROMPT - Displays a prompt to select whether to refresh the data.

7. Save the template and add it to the Template Library.

Refresh Fields on Worksheets

Add the custom SGM_RefreshFieldsOnWorksheet property to an Excel report template to
specify which worksheets are scanned for Accolade field codes. Specifying worksheets using
this parameter can improve the performance of large reports.

To set which worksheets to scan for field code refresh:

1. Create the Excel report template and save it to Accolade.

2. Download the document and open it in Excel.

Downloading the document from Accolade saves Accolade-specific properties to the
document.

3. Display the document's advanced properties.

How to display the advanced properties varies across applications and versions.
Typically, property options are located under the Filemenu. Refer to the Excel online
Help for the specific location in the version you are using.

4. In the Properties dialog box, click the Custom tab.

5. In the Name field, enter the case sensitive name SGM_RefreshFieldsOnWorksheet.

6. From the Type list, select Text.

7. In the Value field, enter the names of the worksheets that contain Accolade field codes,
separating the names with a backslash (\).

8. Click Add.

9. Save the template and add it to the Template Library.

Enable Output Log Files

Add the custom SGM_LOG_DIRECTORY property to an Excel report template to create an
output file that collects log files from the Accolade Office Extensions add-in. Use the generated
logs file when troubleshooting server call issues.

1. Create the Excel report template and save it to Accolade.

2. Download the document and open it in Excel.

Downloading the document from Accolade saves Accolade-specific properties to the
document.

3. Display the document's advanced properties.

4. In the Properties dialog box, click the Custom tab.

5. In the Name field, enter the case sensitive name SGM_LOG_DIRECTORY.
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6. From the Type list, select Text.

7. In the Value field, enter a file folder path where the logs will collect.

8. Click Add.

9. Save the template and add it to the Template Library. Save the workbook with the
added custom property to enable the add-in to collect logs to the specified directly.

To disable the add-in from collecting logs, remove the custom property and save the
workbook.
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Queries Overview
Any one in your organization that is familiar with SQL and writing database queries can write a
query to retrieve data from the Accolade database. However, only Administrators and Process
Designers can add those queries to Accolade for use in metrics, charts and reports.

Note: Although a working knowledge of SQL is required to formulate complex
queries, you may be able to gather the information needed with a basic
query, or by using the available reporting features with Accolade.

Queries select data from reporting views, which map data into logical groupings by concept,
such as projects or classes. For information about the reporting types, see "Reporting Views
Overview" on page 634. Each reporting view and its contents is listed in "Project Reporting
Views (RVP_) Reference" on page 649 and "Non-Project Reporting Views (RV_) Reference"
on page 637. You can also create and preview the following query:

SELECT * from RV_ReportingViews

Adding Database Queries

Use queries to retrieve project data and other data from the Accolade database to display in a
query-based list metric. Accolade provides views into the database in the form of reporting
views. Reporting views group like data together that you can use to write a query. For
example, RV_Classes contains the data that is relevant to classes within Accolade, and RV_
ProcessModels contains information you can use to report on process models and their usage
within Accolade.

After you have identified the type of data you want to retrieve, review the RV_ and RVP_
reporting views to determine which view contains the data you need.

To quickly view the list of all reporting views in Accolade, from the
System > Content Sources > Queriesmenu, create and preview the
following query: SELECT * from RV_ReportingViews. Substitute
the RV_ReportingViews portion of the query with any reporting view
name to see the list of all columns within that view.

To create a database query:

1. From the Systemmenu, select Content Sources > Queries.

To narrow the query list, search by the query name, system name, or category.

2. Do one of the following:

l To add a new query - Click Add New in the upper right corner of the page.

l To edit an existing query - Click the name of the query to open it for editing.
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3. Complete the following information to identify the query:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies
the query.

System Name Enter a unique, shorter name that identifies the query in
reporting views, field codes, and other places in
Accolade.

The name must be unique among queries, and can
contain only letters (English alphabet), numbers, and the
underscore.

Description Enter a description of the purpose or nature of the query,
and the data it returns.

This description helps other users identify the query
throughout the system.

Category Enter or select the group to which this query belongs.
More...

Use categories to organize like queries together. For
example, you may choose to group all the queries used
for financial analysis into the same category, in order to
separate them from queries that are used for different
purposes.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and
enter the category name.

l To delete a category, remove every item from the
category. Empty categories are deleted automatically.

Configuration Access
Groups

Select the access groups to which this query belongs.

Process Designers with matching permissions will be
able to edit and view the query. The access groups
displayed are based on the current user's access group
permissions and the access groups the query belongs to.

Process Model Usage Click the Process Model Usage button to see a list of
process models that the query is associated with.

The list includes all process models the query is included
in, as well as links to the process model's component tree
pages you have Edit access to.
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4. In the SQL field, enter the code for the query.

5. Click Preview to ensure the query pulls the correct data and is working as you intended.

6. Click Create to create a new query or Apply to save changes to an existing query.

Notes:
l You may intend a query to display a chart or report either on the Charts &
Reports Manager page within a project, or in both locations. When charts and
reports display on the Charts & Reports Manager page, they can display
information about multiple projects. However, the same chart or report is
restricted within a project to show only data related to the project it is viewed in.
Data not related to projects, such as data from RV_ views, is not affected.

l If a query contains a reference to a RVP_ or CRVP_ reporting view, the result
displays [Unavailable] when used on an external Idea Submission form.
External users do not have the security rights to see the data contained within
those views.

l To delete a query, click in the Delete column on the Queries page.
l Categories created for queries, HTML reports, or MS Excel reports are saved in
common and apply to all three. To remove a category from the list, ensure that
no queries, HTML reports, or MS Excel reports are assigned to the category.

Query Examples

See the sections below for examples of common, basic queries that you may use in your
business. If you require a more complex query, review external resources about writing SQL
queries, or contact Sopheon Customer Support.

l Selecting Data from a Single View

l Restricting Data Returned

l Selecting Data from Multiple Views

l Arranging Results

l Replacing Default Column Headings

l Including Links to Accolade Projects

l Tallying Results

l Personalizing Results

Selecting Data from a Single View

The most basic query retrieves selected columns of data from a reporting view.

SELECT TeamLeaderName, TeamLeaderEmail
FROM RVP_Projects
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The query above returns all project managers and their email addresses from the RVP_
Projects report view, which reports on all opened and closed Accolade projects.

Restricting Data Returned

To restrict the results to only those records that have specific properties, filter the query using a
WHERE clause. For example, you could write a query to retrieve records of projects devoted to
a specific market, or records of projects where a metric identifies the project as behind
schedule.

SELECT ProjectName
FROM RVP_Projects
WHERE DateCreated > '01/01/2014'

The above query returns a list of all projects created since January 1, 2014.

Selecting Data from Multiple Views

Queries can return data from more than one view.

SELECT P.ProjectName, PM.ProcessModelName
FROM RVP_Projects P, RV_ProcessModels PM
WHERE P.ProcessModelID = PM.ProcessModelID

The query above returns the project name and model name for all records where the model’s
ID is the same in the RVP_Projects and RV_ProcessModels reporting views. The query
produces a report showing the model used for each project.

In this query, the “P” is defined as an alias for the RVP_Projects view and “PM” is defined as an
alias for RV_ProcessModels. In the FROM clause, the aliases ensure that each field is selected
from the correct view. The WHERE clause ensures that each data pair is drawn from rows
containing the same model ID.

Arranging Results

To arrange the items returned by the query, add the ORDER BY keyword to the end of the
query.

SELECT TeamLeaderName, ProjectName
FROM RVP_Projects
WHERE ProjectClosed = 0
ORDER BY TeamLeaderName

The query above returns the names of the assigned project managers and the names of
projects, listed alphabetically by the project manager’s name.

Replacing Default Column Headings

Each query returns data using default column headings, which might not be as meaningful as
you need them to be in the returned results. Replace the Accolade default column headings in
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reports with more understandable expressions using AS to substitute the name of your choice
for the default column name.

SELECT ProjectName AS Project, TeamLeaderName AS Project_
Leader, CurrentStageName AS Current_Project_Stage
FROM RVP_Projects
WHERE ProjectClosed = 0
ORDER BY ProjectName

The above query returns three columns that display as “Project,” “Project Leader,” and
“Current Project Stage” in the results. Accolade replaces the underscore character in aliases
with a space. In this example, the WHERE filter limits the results to open projects.

Including Links to Accolade Projects

Make the project names in a report behave as hyperlinks to each project’s initial page, as
defined in its model to provide quick access to a project's details directly from a report.

To create a report that shows project names as hyperlinks, replace the ProjectName column in
the query with the text LinkableName.

SELECT LinkableName from RVP_Projects

The query above returns a list of all open or closed projects with each project name as a link to
the project details.

SELECT TeamLeaderName, LinkableName
FROM RVP_Projects
WHERE ProjectClosed = 0
ORDER BY TeamLeaderName

The query above returns the names of the assigned project managers and the names of
projects, listed alphabetically by the project manager’s name, with the project name as a link to
the project details.

Tallying Results

Tally the number of items returns in a query using COUNT clause.

SELECT TeamLeaderName AS Leader,
COUNT(*) AS Leaders_Projects FROM RVP_Projects
WHERE ProjectClosed = 0
GROUP BY TeamLeaderName
ORDER BY TeamLeaderName

The query above returns a list of project managers of active projects in alphabetical order with
a count of the number of active projects assigned to each project manager. The count displays
in a column named Leaders Projects.
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Personalizing Results

Create queries that display information specific to the user viewing the report using the
$USERID$ substitution token in a WHERE clause in the query.

SELECT * FROM RVP_ProjectDelivActivities
WHERE ActivityOwnerID = $USERID$

The query above displays a list of all activities that the user is currently assigned.

The $USERID$ token must be set equal to a column that contains a user ID, such as
TeamLeaderID, DeliverableOwnerID, and so on.
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Configuring the Accolade Site

Accolade provides the option to configure portions of the site so it better fits with your company
terminology, location, and general application use. Administrators and Process Designers can
update the following components of the Accolade web site:

l Menu Items

l Logos, Splash Screens, and Page Header and Footer Text

l Translating Application Text to Another Language

l System-wide Application Terminology

l Class-level Terminology

l Extended Fields

l Deliverable and Activity Details Display Options

l Project Link Types

l Currencies

l Time Tracking Components
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Adding Menu Items for Multiple Users (Global Links)
Administrators and Process Designers can add additional menus, or items within existing
menus for all users, or all users that have a specific role assignment. Use these global links to
link to websites, FTP sites, email, local intranet sites, or files available on the company's net-
work.More...

Menus and menu items added using global links display in the following order:

l Menu items added to a menu display in the assigned Category, in the order in which
they appear in the Global Links configuration page.

l Newmenus display to the right of the default menu options in the Accolade menu bar, in
the order from left to right that they display in the Global Links configuration page. For
example, if Menu C is listed above Menu A in the list, Menu C displays to the left of
Menu A in the menu bar.

l If a global link is added to theMy Linksmenu, which contains links set for individual
users within their user account or profile, theMy Linksmenu follows the order
described in the previous bullet item. If theMy Linksmenu contains no global link
items, it displays as a default menu at the right of the default Accolade menu bar.

Items added as URL-type global links (http, https, and relative path links) are available to
embed in a pod within a page layout, which then renders the contents of the link. Defining
global links for this purpose can be helpful when building dashboard pages for projects.

To define a link that is available to a single user, see "Adding User-Specific Menu Items" on
page 95.

To add a menu item for multiple users:

1. From the Systemmenu, select Page Design > Global Links.

2. Do one of the following:

l To add a new global link - Click Add New in the upper right corner of the page.

l To edit an existing global link - Click the name of the global link top open it for
editing.

3. Complete the following information about the link:

Field Description

Name Enter a name, up to 64 characters long, which identifies
the global link.

This text is also displayed above the linked page if the
page is embedded.

System Name Enter a system name that uniquely identifies the global
link.
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Field Description

The name must be unique among classes and can
contain only letters (English alphabet), numbers, and the
underscore.

Display in Menu Check to turn on the display of the link in the Accolade
menu. If on is selected, check to make Menu and Category
required fields that cannot be set to none.

Note: This defaults to unchecked when adding
a global link. Defaults to checked when a
new global link is added from Planning
View.

Menu Select the Menu location.
l Select New Menu to create a new menu for the link.
l Select an existing menu, such asWorkspace or
Resource, to add the global link to an existing menu.

To create a global link that is only available to add to a
pod within a layout, leave this option blank.

Category Select the Category location.
l Select New Category to create a new category for the
link.

l Select an existing category such asMy Workspace,
My Pages or Planning, to add the global link to an
existing category.

To create a global link that is only available to add to a
pod within a layout, leave this option blank.

Link In the Link field, select the link type to create.
l http - A URL to a Web page.
l https - A URL to a secure Web page.
l ftp - A link to an FTP download site.
l file - A link to a file or executable on your company's
intranet.

l qvp - A link to a Dashboards for Accolade chart if
using the Dashboards viewer.

l mailto - Opens the user's email application and
displays a blank email addressed to this email
address.

l callto - Opens your selected chat and collaboration
tool, which invites the person at the address you
define to a chat.
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Field Description

In the adjacent field, enter the path to complete the link.
For example, if you select http:// from the Link field,
enter the remainder of the web site address,
www.google.com.

Based on your server setup, http, https, and file
global link types are available to add as the
content of a pod within a page layout.

The Disable Link to File and Disable Link to Website
parameter settings determine if you can link to web site or
file.

Embed Select this check box to display the linked destination
within the Accolade application window. Clear the check
box to open the linked page in a new browser window or
tab.

Important! Accolade respects web browser
and web page security features for embedded
global links. The linked web page may include
certain security settings that prevent the web
page from loading within the Accolade
application window.

Landing Select this check box to display the linked destination first
for the users with the selected role, instead of the users'
Home pages.

If a role has more than one link defined as a landing link,
Accolade displays the first landing link in the list of global
links.

Default Home Select this check box to have a designated home page
for the selected users.

For users with multiple roles, the first link with a role
match in the list of defined global links determines the
users' default home page.

A home page defined by the user profile
settings will take precedence over the global
link home page setting.

Roles Select one or more user roles for whom the global link
displays.
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Field Description

Users who are not assigned the selected roles do not
have access to the global link in the menu, and the
content of the link within a pod in a layout does not
display.

4. Click Apply to save your changes, or Cancel to exit without saving.

To change the order that added menus display from left to right in the
Accolade menu bar, display the Global Links Configuration page
(System > Page > Global Links), select a link description, and drag and
drop it to its new location in the list.

Notes:
l To delete a global link, display the link in the Global Links Configuration page
(System > Page Design > Global Links) and click next to the link to delete.
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Configuring System Consent
To comply with policies or regulations, your organization may need to provide employees an
intelligible and easily accessible consent form, including for GDPR compliance. The General
Data Protection Regulation (GDPR) is a regulation set by the European Commission to
strengthen the protection of European resident personal data used by organizations as part of
the Data Protection Act.

Administrators upload text files to be used as consent forms that prompt users to read and
submit the form upon login. Users who do not submit a consent form will not be able to access
Accolade.

Important! Do not enable or upload versions when users are actively working in
the system to prevent losing unsaved work. Enabling system consent or uploading
new versions will redirect users immediately after clicking Apply.

To configure consent forms:

1. From the System menu, select System > Consent.

2. To add a consent form version, do one of the following:

l Upload a new consent form - Click Upload New Version and Load File to upload
a new consent form.

l Create a version from the existing version - Click the file name to download the
version and upload the file as a new version.

3. Select the text file (.txt) containing the consent form verbiage and content, and click
Open.

4. Click Upload File.

5. Select the Enable System Consent Prompt check box to enable the consent prompt
for all users.

The consent page will not display for users unless this check box is checked.

Important! Only the latest version prompts users at login when Enable System
Consent Prompt is set.

6. Click Apply to save your changes.

Maintaining the System Consent page

As part of maintaining system consent, you may need to view and modify users who have
previously given consent or users who have withdrawn consent. A list of uploaded text
documents displays with the version number, the user who uploaded the file, the date the file
was uploaded, and a field to leave comments for each version.
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To view user consent history:

1. From the Systemmenu, select System > Consent.

2. Click User Consent History to monitor users that have given consent.

The User Consent History dialog provides the user's name and login, the date of
acknowledgment, and the consent version.

3. (Optional) Click Download to view the User Consent History offline.

Additionally, if a user withdraws consent, your organization may need to manually remove all
personal data associated to that user per legal directives and requirements. The system will
not automatically remove the user when consent is withdrawn. Removing a user does not
delete the user name from the system. For historical record and auditing purposes, projects
and other areas of the system will still reference the original user name even when that user is
removed. To mask the user name, change the user's name to a generic placeholder like Bob
M######. A name with a strike-through indicates a deleted user (i.e., Bob M######)
throughout the system.

Note: Renamed deleted users are not removed as the owner of deliverable or
activities in either completed or currently in progress documents. Originally
named owners will show in history data.

Removing a user deletes the following user data:

l User Image

l User Email

l Chat Address

l User extended field values

Understand that deleting a user is a permanent action and the user cannot be restored.

Note: If your organization uses Active Directory, manually update or remove a user
from the Active Directory.

Notes:

l To delete a consent file, check the box under the correlating to the desired
version to be removed. Click Apply to save your changes.

l Making changes to an existing version will not replace the original version.
Upload the file as a new version to apply the changes.

l The consent prompt does not display for add-ins or external idea submissions.

Configuring System Settings for Collaboration Integration
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Administrators and Process Designers can select Microsoft Teams or Slack for collaboration.
Microsoft Teams options include chat, call and schedule meetings with individual and multiple
users. Slack includes chat. This allows users the ability to launch these communication tools
within Accolade based on your organization's settings.

Note: In order for the "Connect Accolade Project to Teams Channel" feature to
work, the Microsoft Teams Integration parameters must be arranged. Learn
more about the Microsoft Teams Integration parameters here.

To set Microsoft Teams integration:

Important! You must have the Microsoft Teams connection functionality installed
before proceeding. See the Accolade Installation Guide > Installing the Accolade
Application > Configuring Accolade, for more.

1. From the Systemmenu, select System > Settings, then select the Collaboration
Integration tab.

2. In the Select Integration drop-down menu, selectMicrosoft Teams.

3. Under Functionality, select from the following that are checked by default.

l Teams Chat

l Teams Call

l Teams Schedule Meeting

l Connect Accolade Project to Teams Channel

l Create New Channel for Project

l Create New Team for Project

4. Click Apply.

To enable OneDrive integration:

Important! You must have the Microsoft 365 Web Apps & OneDrive integration
installed before proceeding. See the Accolade Installation Guide > Installing the
Accolade Application > Configuring Accolade, for more.

1. From the Systemmenu, select System > Settings, then select the Collaboration
Integration tab.

2. SelectMicrosoft 365 integration options.

3. Check the Integrate with OneDrive checkbox to activate this option.

4. Click Apply.
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To enable MS Teams Files integration:

Important! You must have the Microsoft Teams connection functionality installed
before proceeding. See the Accolade Installation Guide > Installing the Accolade
Application > Configuring Accolade, for more.

1. From the Systemmenu, select System > Settings, then select the Collaboration
Integration tab.

2. SelectMicrosoft 365 integration options.

3. Check the Integrate with MS Teams Files checkbox to activate this option.

4. Click Apply.

To set Slack Integration:

1. From the Systemmenu, select System > Settings, then select the Collaboration
Integration tab.

2. In the Select Integration drop-down menu, select Slack.

3. Enter the Slack Bot Token and click User Load.

A new load is needed to add or remove users from Slack. If the Slack token is changed,
the integration will not work and needs to be updated in Accolade.

4. Under Functionality, select from the following checked by default.

l Slack Chat

5. Click Apply.

Note: If the Slack token is changed, it must be updated in Accolade.

Replacing the Accolade Logo and Adding Header or
Footer Text

Administrators can configure the look and feel of Accolade to be more in line with company
standards by modifying or replacing or adding the following items:

l The Accolade logo.

l Text that displays at the top of the application window above the main menu bar, or at
the bottom of the page. This may be corporate or legal directives, or any text all
employees in your company need to see.

It may be necessary to clear the cache in the web browser to see the new graphics after
completing the steps below.

Notes: If you are using the preview version of Accolade, you may also upload a logo
to display.
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To replace the Accolade logo:

1. Navigate to System > Settings from the Systemmenu.

2. Choose the Parameters tab.

3. SelectGeneral Parameters.

4. Click the Search icon next toWebsite Logo Image or Preview Website Logo Image
to begin the process of uploading a new logo.

5. Choose the desired logo image file.

6. Upload file.

Notes:
l Accepted file types include: .bmp, .dib, .gif, .jpg, .jpeg, .jpe, .jfif, .png, and .svg.

l Recommended dimensions are up to 250 px width by 30 px height. An image that
exceeds these dimensions will be resized automatically .

l Upon uploading, the logo will be saved. To see the newly saved logo in your
General Parameters section, refresh the page.

To add text to top or bottom of the application window:

1. Open the Accolade Administration Console on the application server.

2. Click Standard Parameters in the Navigation pane.

3. In the Category field, select System and select the Show Advanced option.

4. Set the Accolade Page Header Text or Accolade Page Footer Text parameters as
HTML or text that displays accordingly on all Accolade pages.

5. Click Apply to save your changes.

Notes:
l If your company uses a load balanced configuration, you will need to restart the
Accolade Cache Service and reset IIS on all application servers in order to see
the logo changes.

Translating Accolade Text into Another Language
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Accolade provides the flexibility to translate the text displayed in the application into several
different languages. When a user selects the language in which to view the application in their
user profile, the application uses the translation entered for that language. You can add
languages as required for your implementation.

Use the procedure below to configure text, such as display messages,
window title, and menu names. Select the appropriate language and
enter the customized phrasing.

Translatable text includes:

l Field names

l Page titles

l Menu names

l Messages and notifications

The display and entry of dates for each user within Accolade is determined by the date format
set in each user's account or their personal selection in their user profile, not by the language
selection.

To ensure the names used in notifications, reports, some configuration
pages, and some other locations are consistent with your translation or
modifications, you must also enter the new names in the entity names
and/or class terminology pages.

Important! Terminology and language changes will require you to restart the
Accolade Cache Service and reset IIS on all application servers in order to display
the changes. Be mindful when making these updates, as users will temporarily be
unable to access Accolade during the reset process.

To import or export Accolade text, see Importing and Exporting Languages for more
information on creating and using the import process.

To translate Accolade text:

1. On the Systemmenu, select Configuration > Languages.

2. In the Language field drop-down, do one of the following:
l Select the language to which you want to translate.

l Select Add New to add a language to the list, select the language to add in the New
Language dialog box, and click Add.

3. (Optional) To narrow the list of translatable items, enter search criteria in the Filter By
field and click Filter.

Only items with the criteria you enter display in the list. Leave the field empty to display
all available translatable items. Note that some items may not be translatable.
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To find a specific term or phrase and replace one instance or all
instances, use the Find What and Replace With fields to complete a
search and replace throughout the translatable items.

4. In the Current Value column, enter the translated text, or the text to use instead of the
text in the Default Value field.

Note that some items may display as read-only depending on your access group admin
rights

To create multi-line text strings, press Enter to start the next line.

5. To finish work on a string, click outside the Current Value field that you are editing.

Edited fields display highlighted to help you track the changes you have made.

Important! In text strings that include a token (for example, {0}) that inserts text
into the string, you must include the token in the appropriate place in the translated
version. The explanations in the Required Tokens and Explanation column
indicate where to place the token.

Some tokens are enclosed in single quotes, ', or angle brackets, < >. These marks
are part of the text, not part of the token. You can leave, remove, or change them,
as appropriate.

6. Click Apply to save your changes.

Notes:
l If your company uses a load balanced configuration, you will need to restart the
Accolade Cache Service and reset IIS on all application servers if you make any
terminology or language changes.

l The content of the online help references the English translation of the default
value for all the items listed above, and is not customizable or translatable at this
time. The changes made to the entity names page (System > Configuration >
Entity Names), the system language page (System > Configuration >
Languages) or the class terminology page (System > Configuration > Class
Terminology) will not currently change the references in the help content.

l Translatable options do not include text in Portfolio Optimizer or in the Portfolio
Optimizer help.
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Replacing Accolade Terminology
Accolade contains several terms that you can update to better fit your industry and the
terminology used within your company. For example, Accolade uses the default terms Stage
and Gate to reflect the elements of the classic Phase Gate process model. However, your
company may prefer the terms Phases and Milestones to indicate those components of the
process. 

Accolade provides the flexibility to use custom terms for the following items within the
application:

l Assignment statuses, such as In Process or Not Started.

l Gate decisions, such as Go and Hold.

l Process entities, such as Stage, Gate, and Deliverable.

l Review decisions, such as Approve, Reject, and Decline.

l Review events, such as In Review, Approved, or Not Started.

l Accolade user role names, such as Project Manager or Process Designer.

l Workflow events, such as Started, Stopped, or Updated (if your company uses the
Collaborative Workflow feature).

l The Accolade application name and Accolade menu items within the Accolade Office
Extensions add-in applications.

To configure or translate system-wide items such as entire notification messages, see the
Translating Text into Another Language topic in the online Help.

Important! Terminology and language changes will require you to restart the
Accolade Cache Service and reset IIS on all application servers in order to display
the changes. Be mindful when making these updates, as users will temporarily be
unable to access Accolade during the reset process.

To replace an Accolade term within the application:

1. On the Systemmenu, select Configuration > Entity Names.

2. Expand the section that contains the names to change.

3. In the Custom Name column, enter the names for each item that you prefer to use.

4. Click Apply to save your changes.

Clicking Apply on this page saves your changes to all the parameter settings, not just
custom names. Review your changes as necessary prior to clicking Apply.

5. Make the same updates within the system language page (System > Configuration >
Languages) and/or the class terminology page (System > Configuration > Class
Terminology).
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To ensure the names used in notifications, reports, some configuration pages, and
some other locations are consistent with your translation or modifications, you must
also enter the new names in the system language and/or class terminology pages.

6. Restart the Accolade Cache Service and reset IIS on all application servers.

To change the Accolade menu name in the Accolade Office Extensions add-in:

1. On the Systemmenu, select Configuration > Entity Names.

2. Expand the Process Entity Names section and update the name in the Accolade
field.

3. Click Apply to save your changes.

4. On the Systemmenu, select Configuration > Languages and make the same
updates within the language file.

To ensure the names used in notifications, reports, some configuration pages, and
some other locations are consistent with your translation or modifications, you must
also enter the new name in the system language page.

5. Restart the Accolade Cache Service and reset IIS on all application servers.

To change the Save to Accolade menu option in the Accolade Office Extensions add-
in:

1. On the Systemmenu, select Configuration > Languages.

2. Select a language and filter by Accolade.

3. Find Save To Accolade in the list and enter the phrase to use instead in the Current
Value column.

4. Click Apply to save your changes.

5. Restart the Accolade Cache Service and reset IIS on all application servers.

To see the changes to the Save To Accolademenu, download a
document from Accolade and open it in its respective application.

Notes:
l If your company uses a load balanced configuration, you will need to restart the
Accolade Cache Service and reset IIS on all application servers if you make any
terminology or language changes.

l The content of the online help references the English translation of the default
value for all the items listed above, and is not customizable or translatable at this
time. The changes made to the entity names page (System > Configuration >
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Entity Names), the system language page (System > Configuration >
Languages) or the class terminology page (System > Configuration > Class
Terminology) will not currently change the references in the help content.

l Translatable options do not include text in Portfolio Optimizer or in the Portfolio
Optimizer help.

Configuring Class Terminology
Accolade provides the flexibility to configure text displayed in a project based on a process
model. Administrators and Process Designers can make changes at the class level to project-
related terms such as Project ID or Project Manager, which are applied to all process models
in that class.

For example, your company may have a division where projects are called "Features" and the
role of project leader is defined as a "Feature Owner". For process models that are used by
this division, you can change the Accolade field Project Manager to display Feature Owner to
match this role definition, to help users align company and Accolade roles and assignments.

Class terminology can be configured in all languages that are enabled in
your implementation. When a user selects the language in which to view
the application in their user profile, the application uses the configuration
entered for that language.

Class configurable text includes project-related terms such as:

l Field names

l Page titles

l Menu names

l Confirmation messages

Important! Terminology and language changes will require you to restart the
Accolade Cache Service and reset IIS on all application servers in order to display
the changes. Be mindful when making these updates, as users will temporarily be
unable to access Accolade during the reset process.

To configure the terminology for a specific class:

1. From the Systemmenu, select Process > Classes and select the class to edit.

To narrow the class list, search by the class name, system name, or category.

2. Click the Class Terminology tab.

3. In the Language field drop-down list, select the language to which you want to make
changes.
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4. (Optional) To narrow the list of translatable items, enter search criteria in the Filter By
field and click Filter.

Only items with the criteria you enter display in the list. Leave the field empty to display
all available translatable items. Note that some items may not be translatable.

To find a specific term or phrase and replace one instance or all
instances, use the Find What and Replace With fields to complete a
search and replace throughout the translatable items.

5. In the Current Value column, enter the translated text, or the text to use instead of the
text in the Default Value field.

Note that some items may display as read-only depending on your access group admin
rights

To create multi-line text strings, press Enter to start the next line.

6. To finish work on a string, click outside the Current Value field that you are editing.

Edited fields display highlighted to help you track the changes you have made.

Important! In text strings that include a token (for example, {0}) that inserts text
into the string, you must include the token in the appropriate place in the translated
version. The explanations in the Required Tokens and Explanation column
indicate where to place the token.

Some tokens are enclosed in single quotes, ', or angle brackets, < >. These marks
are part of the text, not part of the token. You can leave, remove, or change them,
as appropriate.

7. Click Apply to save your changes.

Configuring Terminology for Multiple Classes

The System > Configuration > Class Terminology page can also be used to view, edit, and
export/import changes to terminology for multiple classes at once. See Importing and
Exporting Class Terminology for more information on creating and using the import process.

To configure the terminology for a specific class:

1. From the Systemmenu, select Configuration > Class Terminology.

2. Click the Class Terminology tab.

3. In the Language field drop-down list, select the language to which you want to make
changes.

4. In the Class field drop-down list, select the class to which you want to make the
changes.
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5. (Optional) To narrow the list of translatable items, enter search criteria in the Filter By
field and click Filter.

Only items with the criteria you enter display in the list. Leave the field empty to display
all available translatable items. Note that some items may not be translatable.

To find a specific term or phrase and replace one instance or all
instances, use the Find What and Replace With fields to complete a
search and replace throughout the translatable items.

6. In the Current Value column, enter the translated text, or the text to use instead of the
text in the Default Value field.

Note that some items may display as read-only depending on your access group admin
rights

To create multi-line text strings, press Enter to start the next line.

7. To finish work on a string, click outside the Current Value field that you are editing.

Edited fields display highlighted to help you track the changes you have made.

Important! In text strings that include a token (for example, {0}) that inserts text
into the string, you must include the token in the appropriate place in the translated
version. The explanations in the Required Tokens and Explanation column
indicate where to place the token.

Some tokens are enclosed in single quotes, ', or angle brackets, < >. These marks
are part of the text, not part of the token. You can leave, remove, or change them,
as appropriate.

8. Click Apply to save your changes.

Notes:
l New language options must be first added to the system through the System >
Configuration > Languages tab in order for the language to be available for
configuration at the class level.

l If your company uses a load balanced configuration, you will need to restart the
Accolade Cache Service and reset IIS on all application servers if you make any
terminology or language changes.

l The content of the online help references the English translation of the default
value for all the items listed above, and is not customizable or translatable at this
time. The changes made to the entity names page (System > Configuration >
Entity Names), the system language page (System > Configuration >
Languages) or the class terminology page (System > Configuration > Class
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Terminology) will not currently change the references in the help content.

l Translatable options do not include text in Portfolio Optimizer or in the Portfolio
Optimizer help.

Adding Custom Details Throughout Accolade
Create custom data fields, called extended fields, which can record data about deliverables,
activities, resource pools, timesheets, and/or users. You can define the type of data recorded,
indicate what the content should relate to, and specify whether the data applies to deliverables,
activities, resource pools, timesheets, users, or some combination. Extended fields are also
included in report contents.

If you synchronize and add Accolade users using Active Directory, you can define custom
string fields within Accolade to map data into from Active Directory. See "Synchronizing Users
with Active Directory Overview" on page 104 for more information about this option.

To add an extended field:

1. From the Systemmenu, select Configuration > Extended Fields.

2. Expand the section that contains the field type you want to define.

Each data type can have a maximum of ten fields in use. Select from the following
options:

l Date - Creates date controls where you can select a calendar date.
l List - Creates single-select list boxes that you can populate either by a query or by
entering the list items manually.

l Long String - Creates multi-line text boxes that accept numbers and letters.
l Multi-Select List - Creates multiple selection list boxes that you can populate either
by a query or by entering the list items manually.

l Number - Creates number boxes that accept only numbers.
l String - Creates single-line text boxes that accept numbers and letters.
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3. Modify the following columns to add an extended field with a control:

Field Description

Name Enter the name that identifies the content of the field.

The name displays as the row or column label where the
field displays.

List Source (for List and Multi-List fields only) Create a query-based list
or define a list manually.

You define the options for the list much like you do for a list
or multi-select list metric.
l To create a query generated list, selectQuery and select
a query from the box. Click Edit to modify the query or
click Preview to test it.

l To manually create a list, select Defined List and enter
the list items separated by a pipe ( | ) character, just as if
creating a list for a list metric.

Note: To manually create a list, select Defined
List and enter the list items separated by a
pipe (|) character, just as if creating a list for
a list metric. Do not use spaces between the
list item and the pipe character (a|b|c).

Active Select one or more of the following options to make the
extended field in the following:
l Activities - Select the check box to make this field
available in theMore Details section within an activity.

l Deliverables - Select the check box to make this field
available in theMore Details section within a deliverable.

l Pools - Select the check box to make this field available
when adding resource pools. List-type extended fields
that are associated with pools can be used to filter
resources on the Resource Editor page.

l Timesheets - Select the check box to add this field to
Timesheet Entry. See "Time Tracking Overview" on page
420 for more information on using timesheets in
Accolade.

Resources and timesheets are available in optional features
available for Accolade.

Users Select one ore more of the following options to define
additional details when you create user accounts:
l Active - Select to add this field to the User Admin page
used to define user accounts.
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Field Description

l Required - Select to require a value for this field when
creating new Accolade users or updating an existing
user.

l Searchable - Select to add this field as a filter to the
Select User dialog box. Date fields cannot be selected for
user search. TheMaximum Searchable Extended
Fields system parameter defines the maximum number
of fields that you can select for user search. The default
value is five fields.

Create a report using the Users subject to
determine which users are missing values for
required extended fields.

l AD Sync - Select if you have Active Directory enabled
and want to pull data from Active Directory to this
extended field. This check box only displays if the Active
Directory functionality is enabled.

If the extended field is set to required and a value is not
set for a user for the field in Active Directory, the user is
set to inactive when the directory synchronization occurs.

Order Enter a number to define the vertical order of the field rows
in relation to each other.

4. Click Apply to save your changes.

Mapping Extended Field System Names

If your company uses extended fields, you may have the need to retrieve the related system
names for use when importing data or for reporting purposes.

The general syntax for the system name is ExtendedField<datatype><number>, where
number is the sequential number of the extended field. For example, in the Date Fields section,
the first field is ExtendedFieldDate1, the second field is ExtendedFieldData2, and so forth.

Extended field system names are automatically assigned, and cannot be changed.

To view the extended fields mapping specific to your company's
configuration, Sopheon recommends downloading the list of all fields
using the Download option on the configuration page. Note that all fields
will be downloaded, regardless of whether or not they are in use.

Notes:
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l To remove an existing field, clear the selected check boxes for the field.

l After a detail row has been added to a project, its data cannot be simply deleted
from the project. If the row is completely changed in the extended field definition,
its data remains in projects until a user deletes the data or enters new data.

Defining Deliverable and Activity Details Display Options
Administrators and Process Designers can define which metadata fields are included when
displaying deliverable and activity details and which information displays when initially opening
a deliverable or activity. Use these options to show or hide fields that are not applicable in your
process flow or to display information in the Summary pane or within More Details in
deliverables and activities.

Important! The configuration settings define the display options for all deliverables
and activities in all projects in Accolade.

To define what options display in the Deliverable/Activity Details dialog box:

1. From the Systemmenu, select Configuration > Assignments.

2. In the Default Main Window field, select what type of content to display when the
Deliverable or Activity Details dialog box initially displays.

l Quick Grids or Versions - Displays quick grids if they are available, or versions if
the deliverable or activity has no quick grid assigned.

l More Details - Displays the additional details about a deliverable or activity, which
includes the extended fields defined to display for deliverables or activities and the
options you set to include in More Details below.
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3. In the Deliverable / Activity Data table, select which fields to display in either the
Summary Pane, inMore Details, both, or neither location.

As you make selections, be careful not to hide fields that are needed that cannot be
updated elsewhere. For example, if your company has enabled the Allow Team
Members to Share Assignments system parameter to enable collaborative documents,
and you hide the Allow shared ownership from both the Summary pane and More
Details, the assigned project manager or a Process Manager no longer has the means
to make a document collaborative.

4. Click Apply to save your changes.

Notes:
l Clicking on the In Trouble check box for a Deliverable / Activity whose status is
not In Progress, will then set it's status to In Progress.
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Controlling Uploaded File Types
Accolade uses a blocklist to prevent the upload of listed file extensions as a security measure.
This blocklist, stored in the SQL table ACC_DomainExtensionsProhibitedForUpload, specifies
.exe files by default.

To have additional extensions added to this table for blocking, contact Sopheon Customer
Support.

Creating Project Link Types
Create project link types to express the different relationship types that can exist between
projects. For example, your company may link technology projects to both the product they are
applied to and to a market strategy component in your overall portfolio. Or, you may define
relationships that include a dependency to indicate that one project must finish before another
starts. Create project link types that indicate those relationships.

Administrators and Process Designers create the link types, which are available to Process
Managers, Idea Managers, and Project Managers to create the actual link between projects.
Links created between projects are viewable a project's Related Projects page, and in Portfolio
Browser (if enabled) and Accolade Innovation Planning.

Note: If Portfolio Management components or Accolade Innovation Planning is
installed, Accolade includes a Child Relationship link type (Hierarchy Link
Default) that manages the parent-to-child relationships to create project
portfolios. This link type uses a default Link From Name of Contains to
establish a link from a parent project to a child project, and a Link to Name
ofMember Of, to establish links from a child project to a parent project. Use
the Child Relationship link type to create a project hierarchy.
Administrators and Process Designers can modify this type; however, it
cannot be deactivated or deleted.

To create a project link type:

1. From the Systemmenu, select Process > Link Types.

2. Do one of the following:

l To add a new project link type - Click Add New in the top right corner of the page.

l To edit an existing project link type - Click the name of the link to edit.

3. Enter the following information to identify and describe the link type:

Required fields display with red text and an asterisk * if the field is empty.
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Field Description

Name Enter a name, up to 64 characters, which identifies the project
link type. This is also the name that displays as the link label if
the link has zero or two arrowheads.

System Name Enter a unique, shorter name that identifies the link type in
queries, reporting views, field codes, and other places in
Accolade.

The name must be unique among link types and can contain
only letters (English alphabet), numbers, and the underscore.

Description Enter a description of the purpose or nature of the link type.

This description helps other users identify the link type
throughout the system.

Order Enter a number to specify the link type's place when it displays
in a list of types. Lower numbered metrics display higher in the
list.

Restrict to
These Roles

Select the user roles that are required to create, edit and delete
a link using this link type.

If restricted, only Process Managers, Idea Managers, and
Project Managers that also have one of the selected user roles
can create, edit, and delete links between projects using this link
type. The link type is not available for other users without the
assigned roles.

Note: These restrictions do not apply to automatic link
type creation.

Link From
Name and
Link To Name

Some links can be visualized as pointing from one project
towards another project.
l Link From Name is the name of the link as it is described
from the point of view of the "From" project in the link.

l Link To Name is the name of the link as it would be
described from the point of view of the "To" project.

For example, a link named "Component" might have a Link
From Name of Is Component Of and a Link To Name of Has
Component.
If a link is non-directional, or if it points both ways (bidirectional),
then the Link From Name is likely the same as the Link To
Name.

Process
Model
Mappings

Define the process models available for the link type:
l From Process Models - Select the process models that this
link can link from. The link type is only available in projects
that use the selected model.
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Field Description

l To Process Models - Select one or more process models
that this link can link to. Only the projects that use one of the
selected process models are available to select when
creating a project link. To make the link type available to all
projects, select all the process models in the list.

l Max Project Links - Enter the maximum number of parent
links that a project link can have that is created using the
From/To process model combination. If project links exist
before setting this value, and are in violation of the number
set here, you must manually remove the links between
projects to respect the max value before creating any
additional links (either manually or using automatic link
rules).

CheckMap all process models to all process models to link
any process model to any process model.

To make the link type available to link from multiple models, click
to add an additional rule.

Active Select the check box when this link type is ready for use.

Note: The Child Relationship link type cannot be
deactivated.

* Read-only in the Child Relationship link type.

4. Enter the display characteristics for the lines drawn between projects in Portfolio
Browser and Innovation Planning.

Field Description

Line Color Select the color of this link's displayed line.
Arrow
Direction

Select the direction an arrow points between projects for
this link.

If this link points in one direction, the direction should be
coordinated with the Link From Name and Link To
Name. An arrow that points in one direction has the
perspective of the project at the base of the arrow. For
example, an arrow that points towards the "link from"
project has the perspective of the "link to" project and
displays the "link to" name in the browser, and vice versa.
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Field Description

The natural configuration of a link with one arrow would
be with the arrow pointing toward the To project in the link.
Such a link would display the Link From Name in the
Portfolio Browser.

5. In the Dependency Type field, select the relationship type if the link type represents a
dependent relationship based on project start and finish.
l None - No dependency.
l Start - Start - The source project must start before the target project can start.
l Finish - Finish - The source project must finish before the target project can finish.
l Finish - Start - The source project must finish before the target project can start.
l Date - Date - A date in the source project must be before a date in the target
project.

Planners creating links between elements in Accolade Innovation Planning using a
Date - Date link type can select a date, such as the project's start date, end date, a gate
date, or a date metric available within the element, when creating the link or
relationship. To show relationships between milestones the start and end milestone
metrics must first be set as visible in Roadmapping. To set milestone metrics as visible
open the data type from the element type menu on the left and click on the diamond
next to the relevant metric.

For project links created in the project pages and through Accolade Portfolio Optimizer,
the link is created using a set of default dates defined in the link type configuration.
Select the default dates from the Source Default Date and Target Default Date fields
that are used for these links.

Note: If you are updating an existing link type, links created prior to the
change maintain their settings.

6. In theManage Links type field, select the starting point that a link can be created,
edited, or deleted from. See Link Type Examples below. Note that these restrictions do
not apply to automatic link type creation.

7. Click Create to create the new link type or Apply to save changes to an existing link
type.

Link Type Examples

The following sections provide example of potential link type configurations. The following
examples assume the user has the correct user roles to create projects using the described
links.

Example 1

Consider the following link type configuration:
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Mappings

Link From
Name

Link To
Name

Manage
Links From Process Models To Process

Models

Contains Member Of From --> To NPD Portfolio Model NPDModel

Project A uses the NPD Portfolio Model and is considered the parent project in a parent/child
relationship.

From Project A, the user can:

l Create a link to projects that use the NPDModel.

l Select Contains as the link type name.
l Edit or delete the link from Project A.

The user cannot create the link from a project that uses the NPDModel, because theManage
Links field is set to From --> To.

Example 2

Consider the following link type configuration.

Mappings

Link From
Name

Link To
Name

Manage
Links From Process Models To Process

Models

Contains Member Of To --> From NPD Portfolio Model NPDModel

Project B uses the NPDModel and is considered a child project in a parent/child relationship to
Project A.

From Project B, the user can:

l Create a link to Project A.

l SelectMember Of as the link type name.
l Edit or delete the link from Project B.

The user cannot create the link from a project that uses the NPD Portfolio Model, because the
Manage Links field is set to To --> From.

Example 3

Mappings

Link From
Name

Link To
Name

Manage
Links From Process Models To Process

Models

Contains Member Of Both
Directions

NPD Portfolio Model NPDModel
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Project A uses the NPD Portfolio Model and is considered the parent project in a parent/child
relationship. Project B uses the NPDModel is child of Project A.

From Project A, the user can:

l Create a link to projects that use the NPDModel.

l Select Contains as the link type name.
l Edit or delete the link from Project A.

From Project B, the user can:

l Create a link to Project A.

l SelectMember Of as the link type name.
l Edit or delete the link from Project B.

The user can create the link from either side of the link relationship, because theManage
Links field is set to Both Directions.

Notes:
l To delete a link type, display the link type and click Delete. Any existing links are
that use the type are removed from projects.

l Innovation Planning and Roadmapping are optional Accolade components that
you may not have access to. To implement these solutions, contact Sopheon
Customer Support.

Creating Links to Accolade Items
Create links that display in the Accolade menu bar that point directly to deliverables, activities,
reports, and pages within Accolade. Use these links as short cuts to areas that you or users
access most often. Similar to creating a favorites list in a web browser. Users can define their
own links in their profiles, and Administrators can assign links globally or per user in user
accounts.

You can create links to Accolade items in one of the following ways:

l Navigate to a page or item within Accolade, copy the URL in the browser Address field,
and paste it when creating links.

l Navigate to a page or item within Accolade and bookmark the page in the web browser.

l Creating links using the formats described below that reference IDs within the Accolade
database.

The advantage of creating links using the formats described below is that if Sopheon
changes the URL format in a future release, the reference IDs to the data in the
database does not change. Therefore, the link references remain intact, even if the web
page address to reach a particular page changes.
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When creating a link using the link formats below, replace the <website URL> with the URL of
the Accolade website, which is typically the URL to the server, and replace later segments in <
> with the object IDs from your database. The < > symbols are not included in the link.More...

l If the website has a port number other than the default of 80, the port number must be
included in the <website URL> portion of the link. For example,
http://MyServer:443/?P=DOC&PID=242&DID=12

l To determine the values of the website URL and of the system IDs such as DID,
(deliverable ID), navigate to the document or page in Accolade and note the IDs
displayed in the web browser's Address bar.

Example

http://MyServer/?P=DOC&PID=242&DID=12

This link when added a user link or a global link creates a link to:

l A deliverable on a server named MyServer.

l In a project with an ID of 242.

l With a deliverable ID of 12.

Use the following formats when creating links to items within Accolade:

Link Type Description Format and Example

Deliverable
Details

Links to the
Deliverable
Details
dialog box
for the
deliverable
specified.

<website URL>/?P=DD&PID=<project
ID>&DID=deliverable ID>

Example: http://MyServer/?P=DD&PID=14&DID=25

Deliverable
Document

Links to the
Deliverable
Details for
the
deliverable
specified,
and opens
the
Open/Save
dialog box
for a
deliverable
version.

<website URL>)/?P=DOC&PID=<project
ID>&DID=<deliverable ID>

Example: http://MyServer/?P=DOC&PID=14&DID=25

Only use this link type if there is currently a
version of the deliverable.
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Link Type Description Format and Example

Deliverable
Version
Details

Links to the
deliverable
version
detail.

<website URL>/?P=DVD&PID=<project
ID>&DID=<deliverable ID>&DVID=<version ID>

Example:
http://MyServer/?P=DVD&PID=14&DID=25&DVID=2

Deliverable
Online Form

Links to the
online form
defined for
the specified
deliverable.

<website URL>/?P=FRM&PID=<project
ID>&DID=<deliverable ID>

Example: http://MyServer/?P=FRM&PID=3&DID=74

Activity
Details

Links to the
Activity
Details
dialog box
for the
activity
specified.

<website URL>/?P=AD&PID=<project
ID>&AID=<activity ID>

Example: http://MyServer/?P=AD&PID=158&AID=7

Activity
Document

Links to the
Activity
Details and
opens the
Open/Save
dialog box
for an activity
version.

<website URL>/?P=DOC&PID=<project
ID>&AID=<activity ID>

Example: http://MyServer/?P=DOC&PID=158&AID=7

Only use this link type if there is currently a
version of the activity.

Activity
Online Form

Links to the
online form
defined for
the specified
activity.

<website URL>/?P=FRM&PID=<project
ID>&AID=<activity ID>

Example: http://Online
Forms/?P=FRM&PID=3&AID=1

Related
Document

Links to the
Related
Document
details for
the specified
document.

<website URL>/?P=DOC&PID=<project
ID>&RFID=<related document ID>

Example:
http://MyServer/?P=DOC&PID=62&RFID=22

Gate
Document

Links to the
Gate
Document
details for
the specified
document.

<website URL>/?P=DOC&PID=<project
ID>&GDID=<gate document ID>

Example:
http://MyServer/?P=DOC&PID=257&GDID=2
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Link Type Description Format and Example

Initial
Project
Page
Specified in
a Model

Links to the
page that
was set in
the model as
the initial
page to
display when
opening a
project that
uses that
model.

<website URL>/?P=PH&PID=<project ID>

Example: http://MyServer/?P=PH&PID=78

HTML
Report

Links to the
display of the
specified
HTML
report.

<website URL>/?P=HRPT&RPTID=<report ID>

Example: http://MyServer/?P=HRPT&RPTID=12

MS Excel
Report

Links to the
download of
an MS Excel
Report.

<website URL>/?P=XRPT&RPTID=<report ID>

Example: http://MyServer/?P=XRPT&RPTID=33

Single Idea
Form

Links to an
idea form,
rather than
to the Submit
Idea page.

<website URL>/?P=SI&IID=<idea model’s ID>

Example: “http://MyServer:91/?P=SI&IID=6”

The default port site for the Idea web site is
91.

Notes:
l As an Administrator, it is possible to create a URL that a user cannot follow
because they do not have access to the page due to project security rights
or role assignments. In that situation, a new browser window or tab opens,
and the user is prompted to log in, and the log in fails.

l To create a link directly to an idea form, the form the link calls must be
identified as an idea deliverable for its model.
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Company Currencies Overview
Accolade uses the following currency types:

l Corporate Currency - The currency in which your company keeps its financial records
and conducts corporate transactions. This currency is typically set once during
installation.

l Project and Report Currencies - All currency values are stored in terms of the
corporate currency. However, you may have multiple offices and projects within your
company that track costs, estimates, and other financial information in the project's local
currency. To enable Accolade to convert back and forth between the corporate currency
and the project currencies, for example, in project-level reports, create a conversion
table containing the conversion factors for each currency you use.

If all projects use the corporate currency as their local currency, you do not need to
create a conversion table.

Defining the Currencies Used in Your Company

The currency your company uses for financial records and corporate transactions is your
company's base currency, or your corporate currency. Your company may have multiple
geographic locations and thus may do business in currencies other than the corporate
currency. If your company conducts business in other currencies, use one of the methods
below to define the currency conversion for projects and reports.

Use the ConvertToCorporateCurrency calculation function to convert project currencies,
metric values, or integer values to the corporate currency. This is the recommended method to
convert project currencies and other values to the corporate currency.

Use the Currency Symbol system parameter to update the currency
symbol that displays when creating and viewing charts and online reports.

Currency Method 1 - Date-Specific Currency Conversions

The currency configuration method described below references
exchange rates on specified dates, and is the recommended method to
define project currencies.

To define date-specific currency conversions:

l Create a reference table that contains the date-specific exchange rates for the
currencies your company uses. As exchange rates change, the reference table
manager can add additional rows to subsequent versions of the table, while still
preserving the exchange rates for prior dates.

l Create a list metric that contains the currencies available, such as Euro and USD, and
add that metric to the appropriate process models for selection in a project.
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l Create a calculated metric that performs the currency conversion. Use this metric for
display in projects and reports that use a currency other than the base currency.

To create the reference table that contains the date-specific exchange rates:

1. Create a spreadsheet file that includes the following columns:

l Date

l One column for each currency in use, for example EUR, USD, and CAN.

Reference the ANSI 4217 Currency list <version>.xlsx file available on the Base
Templates Reference Page for currency codes, as needed. Do not modify the codes.
Selected codes should be identical to codes found in the ISO 4217 currency
standard.

2. Within the file, enter the calendar date, and the multipliers for each currency in the file:

l Enter 1 in all rows for the base currency, as this currency is not converted.
l For each remaining currency, enter the appropriate multipliers for the exchange
rates on that date.

3. Save the spreadsheet file.

4. Add a reference table to Accolade using a name that identifies it as the table that
contains the currency exchanges, for example, Currency. Select the saved file in the
Filename field.

5. Click Create to save the reference table.

To create a list metric that contains the currencies available to projects:

1. From the Systemmenu, select Content Sources > Metrics.

2. Click Add New and create the basic metric as described in "Creating Metrics" on page
117, selecting List in the Data Type field.

Provide a display and system name that identifies the metric as a project-level
selection. For example, ProjectCurrency.

3. In the List Source field, enter each currency available for selection in a project as an
item in the list. See "Creating Single and Multi-Select List Metrics" on page 125.

4. Select the Active check box when the metric is ready to use in projects.

5. Click Create to create the metric.

6. Click theModels tab and associate the metric with the process models used for
projects that require a currency selection.

Ensure that the metric is set to Edit on at least one page so it can be set in a project.

7. Click Apply to save your changes.
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To create a calculated metric that performs the currency conversion:

1. From the Systemmenu, select Content Sources > Metrics.

2. Click Add New and create the basic metric as described in "Creating Metrics" on page
117, selecting Number in the Data Type field.

Provide a display and system name that identifies the metric as the currency conversion
calculation. For example, ProjectCurrencyConversion.

3. In the Calculated Expression field, create an expression that references the reference
table you added above, and the project currency metric.

Example

Consider the following calculation:

ReferenceTable('Currency', '9/1/2016' ,{*Metric:ProjectCurrency*})

This calculation references the exchange rate provided in the Currency reference table
for 9/1/2016 for the currency selected in the ProjectCurrency metric in the project.

4. Select the Active check box when the metric is ready to use in projects.

5. Click Create to create the metric.

Use this metric in other calculations, as necessary.

Currency Method 2 - General Currency Conversions and Corporate
Currency System Parameter

Note: The currency configuration method described below is also an acceptable
way to configure currencies; however, it does not provide a date-specific
reference for a currency exchange rate. If the reference table that defines the
exchange rates is updated, all references to the table are also updated,
possibly providing an inaccurate conversion for a project.

To define currency conversions using the Corporate Currency parameter and a
general conversion table:

l Set the Corporate Currency system parameter. The corporate currency is typically set
during installation. You can verify the currency setting and set a currency, if necessary.

l Create a reference table using the ANSI 4217 Currency list <version>.xlsx base
template available on the Base Templates Reference Page to store the currency
exchange rates.

To select a corporate currency:

1. On the Accolade application server, open the Administration Console.

2. ClickGeneral Parameters and verify the current corporate currency setting in the read-
only Corporate Currency parameter.
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3. If a currency is not set, click Currency Configuration in the Navigation pane.

4. Select the currency to set as the corporate currency and click Apply.

Important! If you change the existing corporate currency if one displays in the
Corporate Currency parameter, you must manually modify the conversion factors
for projects and reports and repair any reports that use the previous currency.

To create the reference table that contains the exchange rates:

Note: Ensure that the corporate currency is set as described above prior to
defining the currency conversions.

1. Save the ANSI 4217 Currency list <version>.xlsx base template to your computer
using a file name that identifies it as the currency conversion file.

Ensure that the master ANSI 4217 Currency list <version>.xlsx file is kept in a safe
place, such as the Template Library, with no modifications to it.

2. Open the saved file and delete the currency rows your company does not need.

Do not change the column headings in the ANSI 4217 Currency list <version>.xlsx
template file or the files you base on it. Doing so breaks the currency conversion macro
in the Currency Report Template <version>.xltm template file and in reports based
on it.

Do not modify the codes in the Currency Codes column. Selected codes must be
identical to codes found in the ISO 4217 currency standard. You can change the
currency names; however, you must also modify the names in any reports that use the
name as a filter.

3. In the Conversion Factor column, enter the multipliers for each currency:
l In the currency row of the corporate currency, enter a multiplier of 1, as this currency
is not converted.

l For each remaining project currencies, enter the appropriate multipliers to convert
the currencies.

4. In the Format 1 and Format 2 columns, enter the primary and secondary display
formats when the currency is included in Office documents using Accolade field codes.
More...

The Number Format column when adding a reference table to Accolade governs how
the conversions display. For example, having two formats allows the document
designer, to display more decimal places for small amounts than for large amounts. See
"Custom Format for Number Metrics" on page 158.

Do not add additional columns to the left of existing columns in the worksheet. You can
add additional columns to the right, if needed. The upper left corner of the table must be
in cell A1 of the worksheet.
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5. Save the spreadsheet file.

6. Add a reference table to Accolade using the system name SGM_Currency, which
indicates the file is the currency conversion file, and select the saved file in the
Filename field.

Also set where currency is displayed and editable within a project using the metadata
settings in a process model.

Notes:
l As currency exchange rates change, update the saved reference table file with
the new currency exchange rates. Currency rates are updated in all open
projects. The rate does not change in closed projects.

Time Tracking Overview
Using the optional Time Tracking feature, Accolade users can enter time spent working on
Accolade projects, to track the actual time spent versus the time originally planned for projects.
Tracking the actual time teammembers have spent on a project allows comparisons between
estimates for a project to the actual time worked, providing insight to improve planning
strategies and execution over the course of future projects.

Project Managers have access to approve or reject a user's timesheet entries for the projects
that they own, and Timesheet Approvers have access to approve time for resources that report
directly to them but are assigned using resource pools.

Setting Up Time Tracking

Before Accolade users can enter or approve time, Administrators and Process Designers must
setup Timesheet Entry, including the following:

l Defining the unit of measure used in timesheets.

l Defining custom Timesheet Entry fields.

l Granting access to Timesheet Entry.

l Defining which projects allow timesheet entry.

l Defining who can approve timesheet entries.

l Creating resource pools and assigning timesheet approvers.

Timesheet Units of Measure

The day fields within timesheets accept whole and partial numbers between 0 and 99.99. To
ensure that each user is entering time in the same unit of measure, set your own definition
about how users track their time. For example, are users to track time by hours or by the
percentage of the day they spent working on a project. This is a standard you should set within
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your projects and across your company. There is not a parameter or setting within Accolade
that controls the unit of measure.

Timesheet Tracking Fields

To properly record timesheet information, use Accolade extended fields to add additional data
columns that are specific to your company's time tracking requirements to the Timesheet Entry
page. For example, your company may require that time that is billable to a customer be
tracked separately than non-billable time, or that time worked in a different state or country be
tracked separately for tax filing purposes.

To add additional fields to the Timesheet Entry page:

1. From the Systemmenu, select Configuration > Extended Fields.

If necessary, create an extended field, or expand the section that contains the field you
want to make available in timesheets.

2. In the Timesheet column for each extended field to include, select the Active check
box.

3. Click Apply to save your changes.

Timesheet Entry Access

The Timesheet User role is required for a user to have access to Timesheet entry.

To grant access for timesheet entry:

1. From the Systemmenu, select Security & Groups > User Admin.

2. In the Users list, click the name of the user to open the user details for editing .

3. Select Roles and Rights and select Timesheet User.

4. Click to save your changes.

Timesheet Project Availability

Your company may have projects that you include in Accolade that do not have time tracked
against them. You can restrict timesheet entry at the class level, or at the project level.

l Class Level - Process Designers and Administrators can define which classes allow
timesheet entry for the projects created for models within that class. Only projects within
a class that allows timesheet entry are available for selection within users' timesheets.
Classes are set to be included in Time Tracking by default.

l Project Level - At the individual project level, Process Managers and the assigned
project manager can select whether the project is available for all timesheet users, only
those on the team, or not available at all for timesheet entry. The entry selected is saved
with the project team for use in other projects. Projects are set to be available to all
timesheet users by default.
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To define a class to allow timesheet entry:

1. From the Systemmenu, select Process > Classes.

2. Click the name of the class you want to edit or create a class.

3. In the class definition, select Include in Time Tracking to include projects within this
class in timesheets.

Clear the check box if projects in this class do not require time tracked to them.

4. Click Apply to save your changes.

Timesheet Approval Access

The Timesheet Approver user role is required for a user to be assigned to a resource pool as
its timesheet approver. Users assigned as the Timesheet Approver in a resource pool approve
all timesheets for users within that pool.

Note: Assigned Project Managers have access to approve time for their projects
without the addition of the Timesheet Approver role.

To assign users the Timesheet Approver role:

1. From the Systemmenu, select Security & Groups > User Admin.

2. In the Users list, click the name of the user to open the user details for editing .

3. Select Roles and Rights and select Timesheet Approver.

4. Click to save your changes.

Notes:
l TheWeekly Start Day system parameter determines the day of the week on
which a time period starts. This parameter is set so a time period starts on
Sunday and ends on Saturday. If you require a different time period start day,
contact Sopheon Customer Support.

l Time Tracking is an optional Accolade component that you may not have access
to. To implement this solution, contact Sopheon Customer Support.

Creating Resource Pools for Time Tracking

Resource Pools are groups of similar resource types, or groups of resources that report to a
single person for time tracking purposes. Administrators and Resource Pool Administrators
can create and modify resource pools. How you group your resources into pools and how you
manage your resource pools depends on the processes defined in your organization. For time
tracking purposes, define resource pools and add resources to those pools based on who
approves the timesheet for the users that belong to the pool.
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If you use Time Tracking and Resource Planning, you can use the same pools for timesheet
approval as you use for resource planning purposes.

To create a resource pool for time tracking:

1. From the Resourcemenu, select Pools.

2. Do one of the following:

l To create a new pool - Click Add Pool in the upper right corner of the page.
l To modify an existing pool - Click the name of the pool to open it for edition.

3. Complete the following information about the pool:

Field Description

Name Enter a name, up to 64 characters long, which identifies
the pool.

Active Select this check box if the pool is ready to use for time
tracking.

Security Lists If security lists are in use, select items in every list to
specify which Pool Administrators can add resources to
this pool if it is does not have an owner.

Unit of Measure Enter the units in which this resource is counted for
Resource Planning.

The unit of measure you select here does not need to
match the unit of measure that users enter their time in
timesheet entry. Timesheet entry is based on your
company's internal, decided upon convention.

Timesheet Approver Click to select the user that approves all timesheets

for resources within the pool.

To filter the list of users, enter one or more search criteria
to filter by name, login name, email address, function, or
extended field.More...
l Clicking Select current user will assign the role to
the current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display
available users that are assigned to the function. The
current selection defaults to the function to which you
are assigning a user, however depending on the
project configuration, you can assign any user.

l Clicking the Show advanced filters check box
displays or hides the additional filter options.

l Clicking Clear removes the current user assignment
and displays [None] to indicate that no user is
assigned.
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Field Description

If a pool does not have an assigned Timesheet Approver,
timesheets for users within that pool are not sent through
the timesheet approval process. If a resource pool does
not have a user selected here, timesheets for users
within that pool do not require Timesheet Approver
approval.

Only users assigned the Timesheet Approver
user role are available for selection.

Extended Fields If one or more extended fields have been configured for
resource pools, select the appropriate values for this
pool. Fields are used to identify pool contents on the
Resource Pools page.

Extended fields must be set to apply to resource pools. If
extended fields are set only for timesheets, the fields do
not display here.

4. Click Create to create the pool or Apply to save changes to an existing pool.

Notes:
l If security lists are enabled, Administrators can create or modify a pool with any
security setting, but a Resource Pool Administrator can only create or modify
pools that the Pool Administrator can access.

l Resource Pool Administrators can only assign security to a pool to which they
have security access. Administrators can assign any item in a security list to a
new pool.

l Resource Planning is an optional Accolade component that you may not have
access to. To implement this solution, contact Sopheon Customer Support.

l Time Tracking is an optional Accolade component that you may not have access
to. To implement this solution, contact Sopheon Customer Support.

Enabling Time Tracking for Projects

Your company may have projects that you include in Accolade that do not have time tracked
against them. You can restrict timesheet entry at the class level, or at the project level.

l Class Level - Process Designers and Administrators can define which classes allow
timesheet entry for the projects created for models within that class. Only projects within
a class that allows timesheet entry are available for selection within timesheets.
Classes are included in Time Tracking by default. .
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l Project Level - At the individual project level, Process Managers and the assigned
Project Manager can select whether the project is available for all timesheet users, only
those on the team, or not available at all for timesheet entry. The entry selected is saved
with the project team if you choose to save the team for use in other projects. Projects
are set to be available to all timesheet users by default.

The project team includes users assigned to the project on the project's Team page and
those assigned as action owners in workflows within the project. Workflow action
owners can access the project in Timesheet Entry if the project is available to timesheet
entry and if they have approved or rejected a workflow action, or if the workflow is
currently in process but they have not yet entered an action decision. This project
access also applies to delegated action owners.

To set a project's timesheet availability:

1. Display the project and select the Team page.

2. Expand the Manage Team panel and click Settings.

3. In the Timesheet Availability field, select one of the following options:
l Enable for all Timesheet Users - The project is available for selection to all users
who have the Timesheet User role.

l Enable for Team only - The project is available for selection to only users who have
the Timesheet User role who are members of the project team.

l Disable for all users - The project is unavailable for selection within timesheet
entry.

4. Click Apply to save your changes.

Notes:
l Time Tracking is an optional Accolade component that you may not have access
to. To implement this solution, contact Sopheon Customer Support.
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Integrating with Other Applications

Accolade integrates with and links to other third party applications. This chapter includes
information about integrating Accolade to the following:

l Microsoft applications, such as Excel and Word.

l Microsoft Project.

l Your default email application.

In addition, Accolade provides a server-side API to allow third-party applications to
programmatically access Accolade data and functions. For information about using the API,
refer to the API Reference available at http://<server name>/help/apihelp or contact Sopheon
Customer Support.
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Integrating with Microsoft Applications
The Accolade Office Extensions add-in provides an integration between Accolade and the
desktop versions of Word, Excel, PowerPoint, and Outlook applications. Users can download
documents directly to a Microsoft application, open and complete the necessary information,
and then save the documents directly to an Accolade project without having to navigate back
to Accolade. To enhance reporting functionality, Accolade Office Extensions allows users to
create global or project-level reports in Excel that can be free-standing, or can be added to
Accolade for reporting purposes.

The Accolade Office Extensions add-in must be installed on every user's computer in order to
use any or all of the integration functionality. Additionally, if your company's Accolade users
are using these applications as part of the Microsoft 365 suite, they must have the applications

l All reports created in Accolade as online reports, or using Accolade Office Extensions
contain a custom MS Excel document property called ACCOLADE_REPORT, which
identifies the report as one with Accolade data. To help ensure sensitive data is not
forwarded, use the filter options on your email server to prevent files that contain the
custom property from being forwarded using email.

Integrating With Microsoft Project

In addition, the Accolade Office Extensions add-in provides an integration that allows Microsoft
Project Professional or Project Standard users to create Microsoft Project plan templates and
use them to manage projects in conjunction with a related Accolade project, for example, when
adding or removing teammembers, assigning documents, or creating new Project tasks.

l If you modify or install any third-party software that also communicates with Microsoft
Project, you may need to modify certain Accolade parameters. Accolade integrates
data using seven of the Microsoft Project custom text fields, Text24 through Text30.
The add-in does not work properly if any other program is also trying to access those
fields.

l In addition, Accolade's integration with Microsoft Project provides access to view
projects in a Gantt view called the My Projects Gantt. To enable users to view the My
Projects Gantt, ensure the feature is enabled and complete the following additional
setup:

l Assign the Planner user role to each user who needs access to the My Projects
Gantt. The Planner role grants access to the menu that display the My Projects
Gantt. For more information, see "User Roles Reference" on page 80.

l Ensure the Innovation Planning Default class is set to Include in Planning, even if
your company does not run Innovation Planning. For more information, see "Creating
Classes" on page 238.
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Important! Use of the Microsoft Project functionality may require additional
licensing. Contact Sopheon Customer Support for more information.

For information regarding the specific features within a Microsoft application, see the Accolade
online Help, and the Help available within from the Accolade menu in the Microsoft application.

Selecting an Email Application
If you want to use any email application, such as IBM Notes (formerly Lotus Notes) or an
application other than the Windows default (Outlook or Outlook Express), use the steps below
to map the email application as the default within the browser used to view Accolade.

Complete the appropriate procedure below on each client machine.

To map a default email application:

1. Ensure that the email application is installed as the default email system on the client
machines of all users who want to use it for their email.

2. From the Windows Control Panel, select Programs > Default Programs, and then
select Set your default programs.

3. In the Programs list, select the program to use as email and click Set this program as
default.

To customize the list of file types opened with the program, select Choose defaults for
this program and follow the onscreen instructions.

4. ClickOK to save your changes.

5. If the email application you select has a 255 character limit in its mailto protocol, ensure
that the Enable Simple Email Support system parameter is set to 1 (true) in the
Administration Console.
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Importing Project Data and
Configuration

Accolade allows you to import and update project data by creating data spreadsheets for
objects such as projects, resource information, and metrics for import into the system.
Importing data is helpful when first implementing your system to transfer data and to get up and
running quickly with Accolade, and can assist with mass project updates as business and
information needs change.

In addition, Accolade allows you to export and import configuration components for movement
from one Accolade environment into another Accolade environment. Importing configuration
across environments can be helpful when your company uses a test environment for
development of new models or components.

Accolade supports reference tables as spreadsheet, CSV, and XML files through the
Reference Tables page, and through an auto-loader service. The information and examples
provided are in spreadsheet format.
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Importing Project and Resource Data Overview
Create, modify, or delete multiple projects in a mass import of project data into Accolade using
two specially named reference tables. The import process creates and updates project data,
but does not create new metrics, access groups, or models.

Note: To import this type of data to Accolade, you must have the Process Designer,
Project Importer, and Reference Table Manager user roles. To import a new
version of an existing file, you must be assigned as the owner of the
reference table file used for the import.

The following types of data can be imported:

Import Options

Data Type Spreadsheet without
Reference Tables

Data/Config Reference Table Pairs
(as spreadsheet, CSV, or XML)

Matrices X

Projects X

Project Links X

Resource Pools X

Resources X

Resource Capacities X

Resource Demands X

Resource Demand
Curves

X

Resource Demand Val-
ues

X

Metrics X

Users X

Importing project data requires the following steps:

l Create a file that contains the data to import (Data table).

l Map the data to fields in the Accolade database (Config table).

l Validate and run the data import.

l Troubleshoot the import as necessary.
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Accolade supports reference tables as spreadsheet, CSV, and XML files through the
Reference Tables page, and through an auto-loader service. The information and examples
provided are in spreadsheet format.

Importing and Exporting Data Best Practices

Keep the following set of best practice recommendations in mind when importing and
exporting data:

l For reference table pairs that import data (Data/Config reference table pairs), every
column referenced in the Config table must be present in the Data table, or the upload
does not proceed. However, if there are extra columns in the Data table that are not
referenced in the Config table, those columns are added to the new version of the
reference table, but validation checks prevent the data from being imported.

l For reference table pairs that update data (Data/Config reference table pairs), if there is
a change to the data, such as a metric column removed from the Data table, you must
save the Config table containing that change to Accolade, before uploading the
corresponding Data table. However, if the configuration remains unchanged, you can
load multiple versions of the Data table in succession without the accompanying Config
table.

Creating Matrix Data Import Files

Import updates to metric values in a matrix into Accolade using two specially named reference
tables. The reference table pair begins with ACC_PMI_, which identifies the tables as
reference tables that contain matrix update import data. Include only one matrix in a
data/configuration file pair. Each matrix you want to update requires its own pair of reference
tables.

Note: To import this type of data to Accolade, you must have the Process
Designer, Project Importer, and Reference Table Manager user roles. To
import a new version of an existing file, you must be assigned as the owner
of the reference table file used for the import.

Create a File That Contains the Matrix Update Data to Upload (Data
Table)

Important! The matrix import deletes an existing matrix referenced in the data
table and completely replaces it with the values you provide in the file. Therefore,
you must provide values for all the rows in the matrix. If a row is missing or a value
is left blank, the existing values in the matrix are replaced with a blank value on
import.

The data table contains the data to import to Accolade. Administrators and Process Designers
add the initial versions of the ACC_PMI data table. The assigned table owner, which requires
the Reference Table Manager user role, can add new versions of the table as needed.
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Create the matrix data table as a spreadsheet, CSV, or XML file, ensuring that the contents of
the file meets the following requirements:

Component Requirements

File Name Matrix updates must be in a file named ACC_PMI_
<MatrixSystemName>_Data, where <MatrixSystemName
matches the <MatrixSystemName> in the matrix update
configuration table and is unique within Accolade. For
example, ACC_PMI_ConsumerElectronics_Data.
There must be only one pair of tables that contain a given
matrix system name. Accolade can contain multiple different
data/config reference table pairs to update multiple matrices.

Rows Each row in the file represents a row in the matrix.
Column Names and
Position

Column headings are in the first row of the worksheet. You can
name columns as you see fit for your installation. Each metric
within the matrix must be in a separate column, and the file
must contain all the metrics within the matrix. Note that rich
text metrics cannot be imported.

Name the columns that contain metric data with their
metric name and their data type. For example,
ProjRisk_List, or Milestone_Date. This helps to
identify the type of data required in the column.

The configuration table described below maps the columns in
the data table to the respective fields in the Accolade
database.

Data The following columns and data are required for each matrix
to update:
l Project ID orMetric Name - Either the Project ID that
displays on the project header, or a string metric that
identifies the project.

l Process Model Name - Depending on your system's
configuration, this may display on the Project Home page.

l One column for each non-calculated metric in the matrix. It
is not necessary to include a blank column for a calculated
metric included in the matrix.

The data type of each metric has to match the data type of
its reference table column in the Data table except that list
metrics are in string type columns. The data type of a
reference table column is created automatically when the
first version of the table is created, but it can be edited by
the table owner.
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Example

Note the following in the example above:

l Each metric contained in the matrix contains its own column.

l The import updates the metric values in a single matrix (based on the data/configuration
file name) that is updated in both Project A and Project B, with the values for the
respective projects.

Map the Matrix Data to the Accolade Database (Config Table)

The configuration table contains the data mapping information so Accolade knows what type
of data to expect in the accompanying data file. Administrators and Process Designers add the
initial versions of the ACC_PMI config table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table, as needed.

Create the matrix configuration table as a spreadsheet, CSV, or XML file, ensuring that the file
meets the following requirements:

Component Requirements

File Name The matrix update configuration must be in a file named ACC_
PMI_<MatrixSystemName>_Config, where the
<MatrixSystemName>matches the matrix updates data file
and is unique within Accolade. For example, ACC_PMI_
ConsumerElectronics_Config.
There must be only one pair of tables that contain a given
matrix system name. Accolade can contain multiple different
data/config reference table pairs to update multiple matrices.

Rows Each row maps a column in the data table to a metric or a
metadata item.

Column Names
and Position

The matrix update configuration must have the following
column names, from left to right as listed below:
l Export Column Name - Enter each column heading that is
included in the data table.
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l Metric System Name - Enter the system name of the metric
whose column heading is in the same row.

l Project Metadata Name - Enter the metadata name below
that identifies the data included is in each column in the data
table.

l Unique Identifier - Enter TRUE in the either the
ProjectCode row or a row that contains a string metric that
specifies which column in the data table contains the data
that identifies the project in which to update the matrix
values. Only one string metric can serve as the identifier for
the import.

Accolade
Metadata Names

Use the following metadata names in the Project Metadata
Name column of the configuration table to map the data to the
appropriate locations in the Accolade database:
l ProjectCode
l ProcessModelName - Required whether ProjectCode or a
string metric is used.

Example

Note the following about the example above:
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l Each item in the Export Column Name column is a column heading in the data table.
l TheMetric System Namemust match the metric system name exactly for the value to
update.

l The names listed in the Project Metadata Name column must match the metadata
names listed above exactly for the import to process successfully. Enter the metadata
name for each column that matches, or maps, the data in the data file to the Accolade
database to ensure the data is imported to the correct location.

l The TRUE setting in the Unique Identifier column indicates that project code is used to
uniquely identify projects.

Creating Project Data Import Files

To create or conduct mass edits on project data, import project data into Accolade. Before
running the import, create two specially named reference tables that will create a file that
contains the data to import and map the data to fields in the Accolade database. The reference
table pair begins with ACC_PI_, which identifies the tables as reference tables that contain
project import data.

Note: To import this type of data to Accolade, you must have the Process
Designer, Project Importer, and Reference Table Manager user roles. To
import a new version of an existing file, you must be assigned as the owner
of the reference table file used for the import.

Create a File That Contains the Project Data to Import (Data Table)

The data table contains the data to import to Accolade. Administrators and Process Designers
add the initial versions of the ACC_PI data table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.

Create the project data table as a spreadsheet, CSV, or XML file, ensuring that the contents of
the file meets the following requirements:

Important! Enter all dates in mm/dd/yyyy format, and enter the decimal separator
in numbers as a period (.).

Component Requirements

File Name Project data must be in a file named ACC_PI_<pair
identifier>_Data, where <pair identifier>matches the <pair
identifier> in the project importer configuration table and is
unique within Accolade. For example, ACC_PI_
ConsumerElectronics_Data.

Rows Each row contains a different project, and each project exists
in only one row.
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Column Names and
Position

Column headings are in the first row of the worksheet. You can
name columns as you see fit for your installation.

The configuration table described below maps the columns in
the data table to the respective fields in the Accolade
database.

Data The following column and data is required to create an
imported project or to update an existing project:
l Project ID - Either the Project ID displayed on the project
header, not the system ID, or a string metric that is used to
identify the project. No special characters or spaces are
allowed. If the project code does not match any project on
the importing server, the import creates a new project. If the
project code does match, the data in the import is used to
modify the matching project.

Important! If project IDs for existing projects are
calculated by a metric or created automatically by
the Auto-Generate Project IDs system parameter,
use a string metric as the unique identifier in the
imported data. If you set the unique identifier to
Project Code the projects import successfully, but
create duplicate projects. Use a string metric as the
unique identifier to avoid duplicating projects.

You can ensure that projects are added by giving them
project codes that you are certain do not match those of any
existing projects in Accolade, such as a, b, c, etc.

Project Codes entered as numbers strip all leading and
trailing zeros, unless you first import with a reference table
of the same name without data that sets the project code to
a String data type.

The following columns and data are required to create an
imported project, but optional when updating an existing
project:
l Project Name - The name, up to 64 characters long, that
identifies the project's purpose. If the project name is
generated using a calculated metric, this field can be blank
and is not required.

l Model Name - The name of the model the project follows
for completion. You can update projects that use an in-
active process model.
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l Access Group Name - The name of the access group that
determines which users have access to this project. The
access group must already exist in Accolade, the import
process does not create access groups.

The following columns and data are optional when creating or
updating projects:
l Metrics - Each metric field is in a separate column. When
importing values for multi-select list metrics, enter each
selection for the metric in a single cell in a pipe ( | ) delimited
list. For example, Value-A|Value-B.

The data type for each imported metric must match the data
type of its reference table column in the Data table. List
metrics are in string type columns. To set the data types of
the reference table columns, see "Requirements and
Considerations for Reference Tables" on page 259. Rich
text metrics cannot be imported.

l Delete Project - Enter Yes, Y, True, or 1 to delete the
project. All other values are treated as No.

l Team Leader - The login of the Accolade user that is
assigned as the project's project manager. Only users with
the Project Manager user role can be assigned as team
leaders. If you create a project without designating a project
manager, you can select one later.

l Team Leader Can Manage - Enter Yes, Y, True, or 1 if the
user in the Team Leader field also is given the rights to
assign and replace teammembers on the project. All other
values are treated as No.

l Team Members - The user login and system name of the
function the user is assigned, using the following format:
<domain>\<UserLogin1>:<systemNameFunction1>.
Separate users with a pipe ( | ) character to create a
delimited list. If the colon is not specified, all text between
the pipes ( | ) is considered a user login.

l Auto Migrate Rules - The system name of the workflow
containing rules to migrate a project to a different model.
The workflow does not need to be in a certain state or
associated with a model. If the import contains projects with
migrations, a slight delay in migrating the projects could
occur after the import completes.

l Enforce Project Security - Enter Yes, Y, True, or 1 if the
teammembers and the project manager must have access
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to the project through access groups, security lists, or
security profiles. All other values are treated as No.
Any users that do not have the same security as the project
are not added to the team. Existing users on projects that
are being updated are removed accordingly.

l Project Description - Enter the project description.
l Project Start Date - Enter the project start date in
mm/dd/yyyy format.

l Metadata Fields - Each metadata field is in a separate
column. Enter Yes, Y, True, or 1 for metadata fields that
are either on or off, such as VisibleToReports. See
"Allowed Project Metadata" on page 443 for a list of allowed
metadata.

l Security Lists - For the project's security list access,
create a column for each security list in the system. For
each project, enter the ID numbers of the project's selected
security list items in a pipe delimited list that begins and
ends with a pipe ( | ) character. The pipes ensure that each
security list column is created as a String type in the
reference table.

If the lists were created manually, the IDs can be
found in the database. If the lists were created in
reference tables, the IDs are found in the ID column.

Example

Note the following in the example above:

l The import includes the required information - project code, project name, model name,
and access group name.

l The import does not delete any projects, because the Delete column is blank.
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l The import does not add any Team Leaders (Project Managers) because the column is
blank.

l The import adds user jane.user to ProjectA as a teammember.

Map the Project Data to the Accolade Database (Config Table)

The configuration table contains the data mapping information so Accolade knows what type
of data to expect in the accompanying data file. Administrators and Process Designers add the
initial versions of the ACC_PI config table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.

Create the projects configuration table as a spreadsheet, CSV, or XML file, ensuring that the
file meets the following requirements:

Component Requirements

File Name The project configuration must be in a file named ACC_PI_
<pair identifier>_Config, where the <pair identifier>matches
the project data file and is unique within Accolade. For
example, ACC_PI_ConsumerElectronics_Config.

Rows Each row maps a column in the data table to a specific type of
project data.

Column Names and
Position

The project configuration must have the following column
names, from left to right as listed below:
l Export Column Name - Enter each column heading that is
included in the data table.

l Metric System Name - Contains the system name of the
metric whose column in the data table is in the same row.

l Project Metadata Name - Identifies the data in the data
table whose name is in the same row.

l Unique Identifier - Specifies the column containing the
data that uniquely identifies the projects. The column can
be either the metadata ProjectCode or a string metric. Only
one string metric can serve as the identifier for the import.
Enter TRUE in the row that contains the identifier column
heading name.

Important! If project IDs for existing projects are
calculated by a metric or created automatically by
the Auto-Generate Project IDs system parameter,
use a string metric as the unique identifier in the
imported data. If you set the unique identifier to
Project Code the projects import successfully, but
create duplicate projects. Use a string metric as the
unique identifier to avoid duplicating projects.
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A unique identifier is required to run a successful import. If
Accolade is set to auto-generate project IDs, use a string
metric as the unique identifier in the imported data. New
projects are created with an auto-generated ID.

Accolade Metadata
Names

Use the metadata names as listed in Allowed Project
Metadata in theMetadata Name column of the configuration
table to map the data to the appropriate locations in the
Accolade database.
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Example

Note the following about the example above:

l Each item in the Export Column Name column is a column heading in the data table.
l TheMetric System Namemust match the metric system name exactly for the value to
update.

l The names listed in the Project Metadata Name column must match the metadata
names listed above exactly for the import to process successfully. Enter the metadata
name for each column that matches, or maps, the data in the data file to the Accolade
database to ensure the data is imported to the correct location.

l The TRUE setting in the Unique Identifier column indicates that project code is used to
uniquely identify projects.

Allowed Project Metadata

Use the metadata names as listed in below the Project Metadata Name column of the
configuration table to map the data to the appropriate locations in the Accolade database.
Unless otherwise noted, if an item is missing or invalid, the import ignores the data and
makes no updates in Accolade.

Column Name Accepted
Values Additional Notes

ProjectCode String
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Column Name Accepted
Values Additional Notes

ProjectName String

ProcessModelName Valid
Process
Model
display
name

AccessGroup Valid
Access
Group
display
name

DeleteProject Yes, Y,
True, 1*

TeamLeaderLogin user login As it displays for the user on
the User Admin page.

TeamLeaderCanManageTeam Yes, Y,
True, 1*

AllowTeamMemberDeletion Yes, Y,
True, 1*

TeamMemberLogins user login As it displays for the user on
the User Admin page.

Login and function
combinations are in a pipe-
delimited string:
<domain>
\
<UserLogin1>
:
<systemNameFunction1>
|
<domain>
\
<UserLogin2>
:<systemNameFunction2>.

Invalid teammember logins
are skipped but the rest of the
project is created.
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Values Additional Notes

AutoMigrateRules Configure
d
migration
rule name

Values can be found on the
workflow details page.

The workflow must be checked
as Is Smart with a migration
rule.

EnforceProjectSecurity Yes, Y,
True, 1*

ProjectDescription Any

ProjectStartDate Date

ProjectEndDate Date

ProjectClosed Yes, Y,
True, 1*

ProjectClosedNotes Any Only updated if the project is
closed.

VisibleToReports Yes, Y,
True, 1*

ExcludeFromLineUp Yes, Y,
True, 1*

LastGateNumber Numeric Requires
LastGateDecisionName in the
table.

Important!
LastGateNumber
and
LastGateDecisionN
ame changes can
only be applied to
current or future
gates. If you are
updating a project
and the
LastGateNumber is
set to a gate that has
already past, the
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Values Additional Notes

import does not
update the gate
information.

For example, you
have an existing
project that had gate
decisions of Go for
gates 1 & 2, and is
currently
approaching gate 3.
If your project import
has a
LastGateNumber of
2 and a
LastGateDecision
Name value of
Conditional Go, the
import does not
update the changes
for the gate 2.

LastGateDecisionName String Requires LastGateNumber in
the table.

Values are available on the
Configuration > Entity
Names page.

IdeaSubmitterLogin user login As it displays for the user on
the User Admin page.

IdeaSubmitterEmail String Must be in a valid email format
(with the@ and . in the
address, for example,
name@sopheon.com)

IdeaSubmitterName String

NotifySubmitter Yes, Y,
True, 1*

InTrouble Yes, Y,
True, 1*
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InTroubleReason String

InTroubleNotes String

TeamLeaderChangeReason Event
Reason
Code

Event reason code is
configured on the Event
Reason List tab of the Class
definition page.

GateDate01,
GateDate02,...GateDate20

Date Updates to gate dates through
an import are considered
manually entered dates for the
project. If gate dates for a
project are set using a metric
defined in the model, any
updates to the gate date
through an import override the
date set by the metric.

Each gate date must be
represented in individual
columns.

ProjectCurrencyCode three
character
currency
code
value

Currency codes are configured
using the currency reference
table.

ProjectSecurityList1...ProjectSecur
ityList 5

Security
List value
ID

If security lists are disabled in
your system, or you provide a
security list that does not exist,
the project is created without a
security list designation.

To include more than one
security list use a ( | ) pipe
character.

* For any column that accepts Yes, Y, True, or 1, you can also enter No, N, False, or 0 if it helps you when entering
data in the spreadsheet. All values other than Yes, Y, True, or 1 are treated as No when you upload the spreadsheet.

Notes:
l If you want to use a saved team for projects created through the import process,
these teams must be manually assigned on the project's Team page.
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Creating Project Link Data Import Files

Import project link data into Accolade using two specially named reference tables. The
reference table pair begins with ACC_PLI_, which identifies the tables as reference tables that
contain project link import data.

Note: To import this type of data to Accolade, you must have the Process Designer,
Project Importer, and Reference Table Manager user roles. To import a new
version of an existing file, you must be assigned as the owner of the
reference table file used for the import.

Create a File That Contains the Project Link Data to Import (Data Table)

The data table contains the data to import to Accolade. Administrators and Process Designers
add the initial versions of the ACC_PLI data table. The assigned table owner, which requires
the Reference Table Manager user role, can add new versions of the table as needed.

Create the project links data table as a spreadsheet, CSV, or XML file, ensuring that the
contents of the file meets the following requirements:

Component Requirements

File Name Project link data must be in a file named ACC_PLI_<pair
identifier>_Data, where <pair identifier>matches the <pair
identifier> in the project links configuration table and is unique
within Accolade. For example, ACC_PLI_BabyCare_Data.

Rows Each row contains a different project link, and each project link
exists in only one row.

Column Names and
Position

Column headings are in the first row of the worksheet. You can
name columns as you see fit for your installation.

The configuration table described below maps the columns in
the data table to the respective fields in the Accolade
database.

Data The following columns and data are required for each project
link:
l Link System Name - The system name of the link type that
this project link is based on. The HierarchyLinkDefault link
type creates a project portfolio (adds child projects to a
portfolio project). Importing this link type adds the Link To
project (child) to the portfolio of the Link From project
(parent). Additional link system names at your company can
be found on the Link Type page (Process > Configuration
> Link Types).

l From Project Code - The Project Code displayed on the
project header to identify the project the link points from (for
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hierarchy links, this is the code of the parent project). No
special characters or spaces are allowed.

l From Process Model Name - The name of the model of
the project the link points from.

l From Date - Required only for project links that use the
Date - Date link type. The From Date can be any milestone
on the project. Enter one of the following:

l Milestone date metric - METRIC:<metric system
name>

l Project start date - MD:ProjectStartDate
l Project end date - MD:ProjectEndDate
l Gate - MD:ProjectNextGateDate,
MD:ProjectPreviousGateDate,
MD:ProjectFollowingGateDate, MD:ProjectGateDate-
<gate number>, or METRIC:<metric system name>

l To Project Code - The Project Code displayed on the
project header to identify the project the link points to (for
hierarchy links, this is the child project). No special
characters or spaces are allowed.

l To Process Model Name - The name of the model of the
project the link points to.

l To Date - Required only for project links that use the Date -
Date link type. The To Date can be any milestone within a
project. Enter one of the following:

l Milestone date metric - METRIC:<metric system
name>

l Project start date - MD:ProjectStartDate
l Project end date - MD:ProjectEndDate
l Gate - MD:ProjectNextGateDate,
MD:ProjectPreviousGateDate,
MD:ProjectFollowingGateDate, MD:ProjectGateDate-
<gate number>, or METRIC:<metric system name>

The projects identified in the From Project Code and To
Project Code data columns must use process models that are
selected for the link type identified in the Link System Name
column. If the process models are not included in the link type
definition, the import does not create the links.
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The following columns and data are optional for each project
link:
l Delete Link - Enter Yes, Y, True, or 1 to delete the link.
Enter 0 or leave blank to add or modify the link.

l Comments - Enter a description of the link.
l Rank - Sets the rank of the Link To project in the portfolio of
the Link From project. Used when the Link System Name
is HierarchyLinkDefault.

Example

Note the following in the example above:

l The import creates a link between the project with code Project2 and Project 102 using
the LinkTypeB link type.

l The import creates a parent-child hierarchy link between Project3 (the parent) and
Project103 and Project113 (the children) using the HierarchyLinkDefault link type.

l The import creates a link with a dependency on Project4 project end date and the Initial
market Launch date metric.

l The import removes the link between the projects in row two.

Map the Project Link Data to the Accolade Database (Config Table)

The configuration table contains the data mapping information so Accolade knows what type of
data to expect in the accompanying data file. Administrators and Process Designers add the
initial versions of the ACC_PLI config table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.

Create the project links configuration table as a spreadsheet, CSV, or XML file, ensuring that
the file meets the following requirements:
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File Name The project link configuration must be in a file named ACC_
PLI_<pair identifier>_Config, where the <pair identifier>
matches the project link data file and is unique within
Accolade. For example, ACC_PLI_BabyCare_Config.

Rows Each row maps a column in the data table to a specific type of
project data.

Column Names and
Position

The project links configuration must have the following column
names, from left to right as listed below:
l Export Column Name - Enter each column heading that is
included in the data table.

l Metadata Name - Enter the metadata name below that
identifies the data included is in each column in the data
table.

Accolade Metadata
Names

Use the following metadata names in theMetadata Name
column of the configuration table to map the data to the
appropriate locations in the Accolade database:
l LinkSystemName
l FromProjectCode
l FromProcessModelName
l ToProjectCode
l ToProcessModelName
l Date1
l Date2
l DeleteLink
l Comments
l Rank

Example
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Note the following about the example above:

l Each item in the Export Column Name column is a column heading in the data table.
l The names listed in theMetadata Name column must match the metadata names
listed above exactly for the import to process successfully. Enter the metadata name for
each column that matches, or maps, the data in the data file to the Accolade database
to ensure the data is imported to the correct location.

Creating Resource Pool Import Files

Import resource pool data to add new pools and to modify existing pools using two specially
named reference tables. The reference table pair begins with ACC_RPI_, which identifies the
tables as reference tables that contain resource pool import data.

Note: To import this type of data to Accolade, you must have the Process Designer,
Project Importer, and Reference Table Manager user roles. To import a new
version of an existing file, you must be assigned as the owner of the
reference table file used for the import.

Create a File That Contains the Resource Pool Data to Import (Data
Table)

The data table contains the data to import to Accolade. Administrators and Process Designers
add the initial versions of the ACC_RPI data table. The assigned table owner, which requires
the Reference Table Manager user role, can add new versions of the table as needed.

Create the resource pools data table as a spreadsheet, CSV, or XML file, ensuring that the
contents of the file meets the following requirements:
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File Name Resource pool data must be in a file named ACC_RPI_<pair
identifier>_Data, where <pair identifier>matches the <pair
identifier> in the resource pools configuration table and is
unique within Accolade. For example, ACC_RPI_
GlobalPools_Data.

Rows Each row contains a different resource pool, and each
resource pool exists in only one row.

Column Names and
Position

Column headings are in the first row of the worksheet. You can
name columns as you see fit for your installation.

The configuration table described below maps the columns in
the data table to the respective fields in the Accolade
database.

Data The following columns and data are required for each
resource pool:
l Pool Name - Identifies the resource pool in the system. The
pool name must be unique.

l Pool Unit of Measure - The chosen unit of measure in
which requests are made for resources that belong in this
pool. For example, FTE for a full time employee.

The following columns and data are optional for each
resource pool:
l Pool Owner Login - The user login of the Resource
Planner who manages the pool. If left blank for a pool any
Resource Planner is able to manage the pool.

To add additional owners to a pool using the
import, run the import once with the additional
owner user login listed in the Pool Owner
column. Run the import a second time, updating
the Pool Owner column to the user login of the
primary pool owner. The import moves the
original owner of the pool to an additional owner,
and imports the new owner as the primary pool
owner.

Note: If the Pool Owner column is not
included in the import files, the Pool
Owner is set to NONE, and any existing
assigned owner is set as an Additional
Owner.

l Pool Requested - Enter Yes, Y, True, or 1 to set the pool's
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demand type to Requested (all other values indicate
False). If a value is present in this column, a value is also
required in the Assigned column. A pool can be
Requested, Assigned, or both. Defaults to TRUE if the
column is not provided on initial pool creation.

l Pool Assigned - Enter Yes, Y, True, or 1 to set the pool's
demand type to Assigned (all other values indicate False).
If a value is present in this column, a value is also required
in the Requested column A pool can be Requested,
Assigned, or both. Defaults to TRUE if the column is not
provided on initial pool creation.

l Pool Parent - For assigned-only pools, enter the pool
name of the requested-only pool to which the assigned pool
is linked. You can associate assigned-only pools with a
parent requested-only pool to establish an associated
between the pools, which allows Resource Planners to
know which group of resources they can assign to certain
requests. Assigned-only pools can be linked to multiple
parent pools if the Allow Multiple Links For an Assigned
Pool system parameter is enabled. If disabled, an
assigned-only pool can be linked to only one requested-
only pool. List multiple parents using a pipe ( | ) delimited
list.

Important!When linking assigned-only and
requested-only pools, the pool named in the Pool
Parent column must exist and must be a requested-
only pool. Each pool in the link must contain the
same Pool Unit of Measure. If you are linking
pools, complete the import in two stages: one to
import the requested-only pools, and one to import
the assigned-only pools. Completing the import in
two stages helps to ensure that the pool names
listed in the Pool Parent column are established
prior to trying to establish a link.

To make demand type or unit of measure changes
to a pool that is linked to another pool, you must first
remove the link before making any changes to either
pool.

l Pool Security List (1-5) - The security list system name for
each list applied to a pool. Security Lists IDs are unique,
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listed in a pipe ( | ) delimited list.
l Pool Extended Fields - One or more columns containing
the values in extended fields set to apply to pools.

l Active - Enter Yes, Y, True, or 1 to activate the pool. Other
values or an empty cell sets the status of the pool to
Inactive.

Note: If the Active column is not included in the import
files, the status of the pool is set to Inactive as well.

l Delete - Enter Yes, Y, True, or 1 to delete the resource
pool. The importer will delete all pools even if it has
resources within it with existing, active demands against it.
As a best practice, delete or move the demands to another
pool before running the importer.

l Pool ID - To rename an existing pool, provide the existing
pool's system ID in a Pool ID column, and the new pool
name in the Pool Name column. You can find existing pool
IDs with the System Resource Pool ID column using
reports.

Example

Note the following in the example above:

l The import renames the existing resource pool in row three to R&D Engineers.

l The import creates a link between the Manufacturing and Project Managers pools.

l The import assigns a value to the Location extended field that is available to pools for
each of the pools listed.

Map the Resource Pools Data to the Accolade Database (Config Table)

The configuration table contains the data mapping information so Accolade knows what type
of data to expect in the accompanying data file. Administrators and Process Designers add the
initial versions of the ACC_RPI config table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.
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Create the resource pools configuration table as a spreadsheet, CSV, or XML file, ensuring
that the file meets the following requirements:

Component Requirements

File Name The resource pools configuration must be in a file named
ACC_RPI_<pair identifier>_Config, where the <pair
identifier>matches the resource pools data file and is unique
within Accolade. For example, ACC_RPI_GlobalPools_
Config.

Rows Each row maps a column in the data table to a specific type of
resource pool data in Accolade.

Column Names and
Position

The resource configuration must have the following column
names, from left to right as listed below:
l Export Column Name - Enter each column heading that is
included in the data table.

l Metadata Name - Enter the metadata name below that
identifies the data included is in each column in the data
table.

Accolade Metadata
Names

Use the following metadata names in theMetadata Name
column of the configuration table to map the data to the
appropriate locations in the Accolade database:
l PoolName
l PoolOwner
l PoolUnitOfMeasure
l PoolRequested
l PoolAssigned
l PoolParent
l SecurityList(1-5) - For example, SecurityList2
l ExtendedField(DefaultName) - Name is "Extended Field"
plus the default display name of the field. For example,
ExtendedFieldMultiSelect6, ExtendedFieldNumber2,
ExtendedFieldString3, and so on.

l Delete
l Active
l PoolID

Example
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Note the following about the example above:

l Each item in the Export Column Name column is a column heading in the data table.
l The names listed in theMetadata Name column must match the metadata names
listed above exactly for the import to process successfully. Enter the metadata name for
each column that matches, or maps, the data in the data file to the Accolade database
to ensure the data is imported to the correct location.

Notes:
l If an assigned pool that is linked to a requested pool is deleted and auto-
calculated capacities are set for the requested pool, the system auto-calculates
capacities accordingly.
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Creating Resource Import Files

Import resources data into Accolade using two specially named reference tables. The
reference table pair begins with ACC_RI_, which identifies the tables as reference tables that
contain resource import data.

Note: To import this type of data to Accolade, you must have the Process Designer,
Project Importer, and Reference Table Manager user roles. To import a new
version of an existing file, you must be assigned as the owner of the
reference table file used for the import.

Create a File That Contains the Resource Data to Import (Data Table)

The data table contains the data to import to Accolade. Administrators and Process Designers
add the initial versions of the ACC_RI data table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.

Create the resources data table as a spreadsheet, CSV, or XML file, ensuring that the contents
of the file meets the following requirements:

Component Requirements

File Name Resource data must be in a file named ACC_RI_<pair
identifier>_Data, where <pair identifier>matches the <pair
identifier> in the resources configuration table and is unique
within Accolade. For example, ACC_RI_ResourcesImport_
Data.

Rows Each row contains a different resource, and each resource
exists in only one row.

Column Names and
Position

Column headings are in the first row of the worksheet. You can
name columns as you see fit for your installation. For example,
AutoCalcmight be better column name for you than
Calculated Capacity to indicate what data is required in that
column.

The configuration table described below maps the columns in
the data table to the respective fields in the Accolade
database.

Data The following columns and data are required for each
resource:
l Pool Name - The name of the pool to which the resource
belongs. This important does not create new resource
pools; if the pool name entered does not exist, the row is
skipped during import.

l Resource Type - Set to either User orGeneral to identify
the resource as a user in the system or a general resource,
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such as Any Engineer.
l Resource System Name - A unique, shorter name that
identifies the resource in queries, reporting views, Accolade
Office Extensions, and field codes. You can define the
system names for both User and General resources.

l Resource Name - Required if the resource type is
General. For example, Any Engineer or Any Chemist.

l Resource User Login - Required if resource type is User.
If the user login does not exist, or exists as a resource with
existing demands, the row is skipped during import. If the
user login exists, and is currently not part of the pool, the
user is added as a resource to the specified pool.

The following columns and data are optional for each
resource:
l Delete - Enter Yes, Y, True, or 1 to delete the resource
from the pool. You cannot delete a resource from a pool if it
has existing demands against it. The demands must either
be deleted or moved to another resource first.

l Calculated Capacity - Typically set for a General resource.
If you use requested-only pools and relate them to
assigned-only pools, enter Yes, Y, True, or 1 for one
resource in a pool to indicate that resource as the one that
auto-calculates the resource capacity for the pool. As
resources are added or removed from a pool that has auto-
capacities set, the system recalculates the pool capacity
accordingly.

Only one resource in a pool can be set to
automatically calculate capacity for the pool. If
multiple resources are set for auto-calculation, the
import fails.

An existing resource is updated if the Pool Name and either the Resource System Name or
Resource User Loginmatch.

Example
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Note the following in the example above:

l The import adds resources to the Senior Engineers pool. A single file can include
updating and adding resources to more than one pool.

l The import adds Jane Doe (row 3) as a member of the Senior Engineers pool.

l The import removes John Doe (row 4) as a member of the Senior Engineers pool.

Map the Resources Data to the Accolade Database (Config Table)

The configuration table contains the data mapping information so Accolade knows what type of
data to expect in the accompanying data file. Administrators and Process Designers add the
initial versions of the ACC_RI config table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.

Create the resources configuration table as a spreadsheet, CSV, or XML file, ensuring that the
file meets the following requirements:

Component Requirements

File Name The resource configuration must be in a file named ACC_RI_
<pair identifier>_Config, where the <pair identifier>
matches the resources data file and is unique within
Accolade. For example, ACC_RI_ResourcesImport_
Config.

Rows Each row maps a column in the data table to a specific type
of resource data.

Column Names and
Position

The resource configuration must have the following column
names, from left to right as listed below:
l Export Column Name - Enter each column heading that
is included in the data table.

l Metadata Name - Enter the metadata name below that
identifies the data included is in each column in the data
table.
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Accolade Metadata
Names

Use the following metadata names in theMetadata Name
column of the configuration table to map the data to the
appropriate locations in the Accolade database:
l ResourceType
l ResourceSystemName
l ResourceName
l ResourceUserLogin
l PoolName
l Delete
l CalculatedCapacity

Example

Note the following about the example above:

l Each item in the Export Column Name column is a column heading in the data table.
l The names listed in theMetadata Name column must match the metadata names
listed above exactly for the import to process successfully. Enter the metadata name for
each column that matches, or maps, the data in the data file to the Accolade database
to ensure the data is imported to the correct location.

Creating Resource Demand Curve Import Files
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Import resource demand curves data into Accolade using two specially named reference
tables. The reference table pair begins with ACC_RDCI_, which identifies the tables as
reference tables that contain demand curve import data.

Note: To import this type of data to Accolade, you must have the Process Designer,
Project Importer, and Reference Table Manager user roles. To import a new
version of an existing file, you must be assigned as the owner of the
reference table file used for the import.

Create a File That Contains the Demand Curve Data to Import (Data
Table)

The data table contains the data to import to Accolade. Administrators and Process Designers
add the initial versions of the ACC_RDCI data table. The assigned table owner, which requires
the Reference Table Manager user role, can add new versions of the table as needed.

Create the resource demand curve data table as a spreadsheet, CSV, or XML file, ensuring
that the contents of the file meets the following requirements:

Component Requirements

File Name Demand curve data must be in a file named ACC_RDCI_<pair
identifier>_Data, where <pair identifier>matches the <pair
identifier> in the demand curve configuration table and is
unique within Accolade. For example, ACC_RDCI_
GlobalDemandCurves_Data.

Rows Each row contains a different demand curve, and each
demand curve exists in only one row.

Column Names and
Position

Column headings are in the first row of the worksheet. You can
name columns as you see fit for your installation.

The configuration table described below maps the columns in
the data table to the respective fields in the Accolade
database.

Data The following columns and data are required for each demand
curve:
l Curve Name - A name that identifies the demand curve.
Demand curve names are not required to be unique;
however, for import they must be unique for a pool-model
combination.

l Pool Name - The resource pool to which the demand curve
applies. Works in conjunction with the model identified in
the Model Name column to identify the projects to which the
curve applies.

l Model Name - The model to which the demand curve
applies. Works in conjunction with the pool identified in the
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Pool Name column to identify the projects to which the
curve applies.

Only one pool-model name combination can exist in the
import per demand curve.

l Stage - The demand value for each stage in the model. It
might be most helpful to name these columns using the
stage name within the model. Use the configuration file to
map the stages to their appropriate stage number.

l Last Stage Duration - If the model ends in a stage, the
number of time periods in that stage. This data is not
required for models ending in a gate.

The following columns and data are optional for each demand
curve:
l Active - Enter Yes, Y, True, or 1 to activate the demand
curve. Other values or an empty cell sets the status of the
curve to Inactive.

l Delete Curve - Enter Yes, Y, True, or 1 in a row to delete
the demand curve. Any other values do not delete the
curve.

Example

Note the following in the example above:

l The file uses the stage names as column headings (Discovery, Development,
Validation, etc), to more clearly identify the stages within the model.

l The import adds demand curves to the R&D Senior Engineers pool and the
Manufacturing pool for projects based on the Phase Gate Process model.
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l The Phase Gate Process model ends in a gate, therefore data to define the duration of
the final stage (Last Stage Duration) is not included in the file.

l The import deletes the Average demand curve for the Manufacturing pool.

Map the Demand Curve Data to the Accolade Database (Config Table)

The configuration table contains the data mapping information so Accolade knows what type of
data to expect in the accompanying data file. Administrators and Process Designers add the
initial versions of the ACC_RDCI config table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.

Create the resource demand curve configuration table as a spreadsheet, CSV, or XML file,
ensuring that the file meets the following requirements:

Component Requirements

File Name The demand curve configuration must be in a file named
ACC_RDCI_<pair identifier>_Config, where the <pair
identifier>matches the demand curve data file and is unique
within Accolade. For example, ACC_RDCI_
GLobalDemandCurves_Config.

Rows Each row maps a column in the data table to a specific type of
demand curve data.

Column Names and
Position

The demand curve configuration must have the following
column names, from left to right as listed below:
l Export Column Name - Enter each column heading that is
included in the data table.

l Metadata Name - Enter the metadata name below that
identifies the data included is in each column in the data
table.

Accolade Metadata
Names

Use the following metadata names in theMetadata Name
column of the configuration table to map the data to the
appropriate locations in the Accolade database:
l DemandCurveName
l PoolName
l ProcessModelName
l Stage01, Stage02...Stage20

If the model starts with a gate instead of a stage, the first
stage in the model is Stage02, not Stage01, even though it
appears as the first stage in the model.

l LastStageDuration
l Active
l Delete
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Note the following about the example above:

l Each item in the Export Column Name column is a column heading in the data table.
l The names listed in theMetadata Name column must match the metadata names
listed above exactly for the import to process successfully. Enter the metadata name for
each column that matches, or maps, the data in the data file to the Accolade database
to ensure the data is imported to the correct location.

l Stage names, such as Discovery, are mapped to their stage number in theMetadata
Name column.

Notes:
l Modifying or deleting a curve does not change project demand. The curve must
be reapplied to projects through the Resource Editor to update project demand.

Creating Resource Capacity Import Files

Import resource capacity data into Accolade using two specially named reference tables. The
reference table pair begins with ACC_RCI_, which identifies the tables as reference tables that
contain resource capacity import data.
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Note: To import this type of data to Accolade, you must have the Process Designer,
Project Importer, and Reference Table Manager user roles. To import a new
version of an existing file, you must be assigned as the owner of the
reference table file used for the import.

Create a File That Contains the Capacity Data to Import (Data Table)

The data table contains the data to import to Accolade. Administrators and Process Designers
add the initial versions of the ACC_RCI data table. The assigned table owner, which requires
the Reference Table Manager user role, can add new versions of the table as needed.

Create the resource capacity data table as a spreadsheet, CSV, or XML file, ensuring that the
contents of the file meets the following requirements:

Important! Enter all dates in mm/dd/yyyy format, and enter the decimal separator
in numbers as a period (.).

Component Requirements

File Name Resource capacity data must be in a file named ACC_RCI_
<pair identifier>_Data, where <pair identifier>matches the
<pair identifier> in the resource capacity configuration table
and is unique within Accolade. For example, ACC_RCI_
GlobalCapacities_Data.

Rows Each row contains a different capacity, and each capacity
exists in only one row.

Column Names and
Position

Column headings are in the first row of the worksheet. You can
name columns as you see fit for your installation.

The configuration table described below maps the columns in
the data table to the respective fields in the Accolade
database.

Data The following columns and data are required for each
resource:
l Resource System Name - Required if the resource is a
General resource, such as Any Engineer. Use reporting to
determine the system name of aGeneral resource.

l Resource User Login - Required if the resource type is
User.

l First Time Period Start Date - The first day of the time
period to which the capacity applies. Enter the date in
mm/dd/yyyy format.

l Last Time Period Start Date - The last day of the time
period to which to which the capacity applies. Enter the date
in mm/dd/yyyy format.
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If there are data rows that contain capacities that overlap time
periods, the last row in the import determines the capacity
value for the resource for that time period.

The following columns and data are optional for each
resource:
l Resource Capacity Value - The capacity value applied for
the resource for all time periods including the first and last.
Enter the decimal separate as a period (.), for example, 1.5.

You cannot set capacities for resources that set to auto-
calculate capacities for a request-only pool. If a capacity
value is set to auto-calculate capacity for a request-only
pool, the import fails.

If the capacity value is 0, the capacity displays empty in
Accolade.

l Unavailable - Values to subtract from capacity to account
for temporary capacity reductions, for example, vacations.

Example

Note the following in the example above:

l The import enters capacity in terms of full time employees (FTE). For example, Jane
Doe is full time employee, therefore her capacity is 1 FTE.
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l The import sets Jane Doe's capacity at 1 FTE from January 1, 2020 to December 31,
2020. However, Jane is unavailable in July of 2020, therefor her capacity is reduced
from July 1 to July 31 by 1 FTE.

l The import sets the general resource AnySeniorEngineer to a capacity of 5 FTEs for
2020 and 2021.

l The import sets the general resource AnyQAAnalyst to 2 FTEs for the first half of 2020;
however, the company is gaining a QA Analyst for the second half of 2020, so the
capacity is set to 3 FTEs.

Map the Resource Capacity Data to the Accolade Database (Config Table)

The configuration table contains the data mapping information so Accolade knows what type of
data to expect in the accompanying data file. Administrators and Process Designers add the
initial versions of the ACC_RCI config table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.

Create the resource capacity configuration table as a spreadsheet, CSV, or XML file, ensuring
that the file meets the following requirements:

Component Requirements

File Name The resource capacity configuration must be in a file named
ACC_RCI_<pair identifier>_Config, where the <pair
identifier>matches the resource capacity data file and is
unique within Accolade. For example, ACC_RCI_
GlobalCapacities_Config.

Rows Each row maps a column in the data table to a specific type of
capacity data.

Column Names and
Position

The resource capacity configuration must have the following
column names, from left to right as listed below:
l Export Column Name - Enter each column heading that is
included in the data table.

l Metadata Name - Enter the metadata name below that
identifies the data included is in each column in the data
table.

Accolade Metadata
Names

Use the following metadata names in theMetadata Name
column of the configuration table to map the data to the
appropriate locations in the Accolade database:
l ResourceSystemName
l ResourceUserLogin
l FirstTimePeriodStartDate
l LastTimePeriodStartDate
l Capacity
l Unavailable
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Example

Note the following about the example above:

l Each item in the Export Column Name column is a column heading in the data table.
l The names listed in theMetadata Name column must match the metadata names
listed above exactly for the import to process successfully. Enter the metadata name for
each column that matches, or maps, the data in the data file to the Accolade database
to ensure the data is imported to the correct location.

Notes:
l As capacity values change for resources within pools that are set to auto-
calculate capacity, the pool's total capacity is recalculated accordingly.

Creating Resource Demand Import Files

Import resource demand data into Accolade and apply the demands to projects using two
specially named reference tables. The reference table pair begins with ACC_RDI_, which
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identifies the tables as reference tables that contain resource demand import data. This import
creates demands, but does not import the demand values.

Note: To import this type of data to Accolade, you must have the Process Designer,
Project Importer, and Reference Table Manager user roles. To import a new
version of an existing file, you must be assigned as the owner of the
reference table file used for the import.

Create a File That Contains the Demand Data to Import (Data Table)

The data table contains the data to import to Accolade. Administrators and Process Designers
add the initial versions of the ACC_RDI data table. The assigned table owner, which requires
the Reference Table Manager user role, can add new versions of the table as needed.

Create the resource demands data table as a spreadsheet, CSV, or XML file, ensuring that the
contents of the file meets the following requirements:

Component Requirements

File Name Resource demand data must be in a file named ACC_RDI_
<pair identifier>_Data, where <pair identifier>matches the
<pair identifier> in the resource demand configuration table
and is unique within Accolade. For example, ACC_RDI_
NorthAmericaDemands_Data.

Rows Each row contains a different demand, and each demand
exists in only one row.

Column Names and
Position

Column headings are in the first row of the worksheet. You can
name columns as you see fit for your installation.

The configuration table described below maps the columns in
the data table to the respective fields in the Accolade
database.

Data The following columns and data are required for each
resource demand:
l Project ID or Identifier String Metric Name - Either the
Project ID that displays on the project header, or a string
metric that identifies the project to which the demand
applies. Only one is required to identify the project.

Important! If the Auto-Generate Project IDs
system parameter is enabled, use a string metric as
the identifier for the project.

l Process Model Name - Depending on your system's
configuration, this may display on the Project Home page.
Used to further identify the projects to which the demand
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applies.
l Resource System Name - The unique, shorter name that
identifies the resource in queries, reporting views, Accolade
Office Extensions, and field codes. Required if the demand
is for a General resource.

l Resource User Login - The domain and Accolade login of
the specific user for the demand. Required if resource type
is User and not aGeneral resource.

l Demand System Name - For the initial import, enter a
system name to identify a demand row in Resource Editor.
A demand row contains all the demands for a single
resource in a specific project.

The following columns and data are optional for each
resource demand:
l Demand Curve Name - The demand curve name, if the
demand is part of a demand curve. Only required if the
resource is part of a pool that contains a demand curve
assigned to the model.

l Demand Multiplier - The amount by which the demand
curve is multiplied for the demand. Defaults to 1.

l Demand Curve Effective Date - The first time period that
the demands in a demand curve are applied. Defaults to the
current time period.

l Demand Phase ID - The sequence number of the stage in
the model to which the demand applies.

If the model starts with a gate instead of a stage, the first
stage in the model is Stage02, not Stage01, even though it
appears as the first stage in the model.

l Demand Type - Requested or Assigned. Defaults to
Assigned.
If an assigned demand is associated with a request
demand, you cannot change the demand type through an
import.

l Delete - Enter Yes, Y, True, or 1 to delete the demand. Any
other values do not delete the demand.

Example
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Note the following in the example above:

l Projects in this import are identified using the combination of the project code and
process model name, not by an identifier string metric.

l Demands that are part of a demand curve apply to stages in the process model as
defined in the Phase ID column.

l Demands are added to Project A for Any Senior Engineer and for John Smith.

l Demands are added to Project B for Any QA Analyst and for Jane Doe.

l No demands are deleted in this import.

Map the Resource Demand Data to the Accolade Database (Config Table)

The configuration table contains the data mapping information so Accolade knows what type of
data to expect in the accompanying data file. Administrators and Process Designers add the
initial versions of the ACC_RDI config table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.

Create the resource demands configuration table as a spreadsheet, CSV, or XML file,
ensuring that the file meets the following requirements:

Component Requirements

File Name The resource demand configuration must be in a file named
ACC_RDI_<pair identifier>_Config, where the <pair
identifier>matches the resource demand data file and is
unique within Accolade. For example, ACC_RDI_
NorthAmericaDemands_Config.

Rows Each row maps a column in the data table to a specific type of
resource demand data.

Column Names and
Position

The resource demand configuration must have the following
column names, from left to right as listed below:
l Export Column Name - Enter each column heading that is
included in the data table.

l Metric System Name - If a string metric is used to identify
the projects in the data file, enter the system name of the
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metric used to identify the projects. If the Project ID is used
to identify projects, include this column but leave it blank.

l Metadata Name - Enter the metadata name below that
identifies the data included is in each column in the data
table.

l Unique Identifier - Enter TRUE in the row with the Export
Column Name that uniquely identifies the projects within
the import. Can be set for either the ProjectCode or a string
metric. The import uses what you identify to match the
demands to their respective projects.

Accolade Metadata
Names

Use the following metadata names in theMetadata Name
column of the configuration table to map the data to the
appropriate locations in the Accolade database:
l ProjectCode
l ProcessModelName
l DemandSystemName
l ResourceSystemName
l ResourceUserLogin
l DemandTypeSystemName
l DemandCurveName
l DemandMultiplier
l DemandCurveEffectiveDate
l DemandPhaseID
l DeleteDemand

Example
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Note the following about the example above:

l Each item in the Export Column Name column is a column heading in the data table.
l TheMetric System Namemust match the metric system name exactly for the value to
update.

l The names listed in theMetadata Name column must match the metadata names
listed above exactly for the import to process successfully. Enter the metadata name for
each column that matches, or maps, the data in the data file to the Accolade database
to ensure the data is imported to the correct location.

l The TRUE setting in the Unique Identifier column indicates that project code is used to
uniquely identify projects to which the demands apply.
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Creating Resource Demand Value Import Files

Import resource demand values data into Accolade using two specially named reference
tables. The reference table pair begins with ACC_RDVI_, which identifies the tables as
reference tables that contain demand value import data.

Note: To import this type of data to Accolade, you must have the Process
Designer, Project Importer, and Reference Table Manager user roles. To
import a new version of an existing file, you must be assigned as the owner
of the reference table file used for the import.

Create a File That Contains the Demand Value Data to Import (Data
Table)

The data table contains the data to import to Accolade. Administrators and Process Designers
add the initial versions of the ACC_RDVI data table. The assigned table owner, which requires
the Reference Table Manager user role, can add new versions of the table as needed.

Create the resource demand values data table as a spreadsheet, CSV, or XML file, ensuring
that the contents of the file meets the following requirements:

Important! Enter all dates in mm/dd/yyyy format, and enter the decimal separator
in numbers as a period (.).

Component Requirements

File Name Resource demand value data must be in a file named ACC_
RDVI_<pair identifier>_Data, where <pair identifier>
matches the <pair identifier> in the demand value
configuration table and is unique within Accolade. For
example, ACC_RDVI_ResourceDemandValues_Data.

Rows Each row contains a different demand values, and each
demand value exists in only one row.

Column Names and
Position

Column headings are in the first row of the worksheet. You can
name columns as you see fit for your installation.

The configuration table described below maps the columns in
the data table to the respective fields in the Accolade
database.

Data The following columns and data are required for each
demand value:
l Project ID or Identifier String Metric Name - Either the
Project ID that displays on the project header, or a string
metric that identifies the project to which the demand value
applies. Only one is required to identify the project.
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Important! If the Auto-Generate Project IDs
system parameter is enabled, use a string metric as
the identifier for the project.

l Process Model Name - Depending on your system's
configuration, this may display on the Project Home page.
Used to further identify the projects to which the demand
value applies.

l Resource System Name - The unique, shorter name that
identifies the resource in queries, reporting views, and field
codes. Required if the demand is for a General resource.

l Demand System Name - Required if a Resource System
Name is provided. If the field is blank or missing, the import
generates a demand system name automatically. To edit
existing values for a demand whose system name you do
not know, query the database using the Accolade Office
Extensions add-in.

l First Time Period Start Date - The first time period to
which the demand value applies. Enter the date in
mm/dd/yyyy format.

l Last Time Period Start Date - The last time period to
which the demand value applies. Enter the date in
mm/dd/yyyy format.

The import loads to Accolade in the order the rows appear
in the Data table. If the Data table contains resource
demand values for overlapping time periods, the last row in
the table for the time period is the row that displays in
Accolade after the import.

l Demand Value - The value to apply to all time periods
between and including the dates specified in the First Time
Period Start Date and the Last Time Period Start Date
columns. The value can be between 0 and 100,000. If the
field is blank, no value is added for the demand. If the value
is 0, the demand is updated to a value of zero. Enter the
decimal separator in numbers as a period (.).

The following columns and data are optional for each demand
value:
l Demand Type - Requested or Assigned. If the field is
blank or missing, the demand type is set to Assigned. If an
assigned demand is associated with a requested demand,
you cannot change the demand type for either request
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through an import.

Example

Note the following in the example above:

l Projects in this import are identified using the combination of the project code and
process model name, not by an identifier string metric.

l The import assigns demands to Project A, B, and C, for varying dates.

Map the Resource Demand Value Data to the Accolade Database (Config
Table)

The configuration table contains the data mapping information so Accolade knows what type
of data to expect in the accompanying data file. Administrators and Process Designers add the
initial versions of the ACC_RDVI config table. The assigned table owner, which requires the
Reference Table Manager user role, can add new versions of the table as needed.

Create the resource demand values configuration table as a spreadsheet, CSV, or XML file,
ensuring that the file meets the following requirements:

Component Requirements

File Name The resource demand value configuration must be in a file
named ACC_RDVI_<pair identifier>_Config, where the
<pair identifier>matches the demand value data file and is
unique within Accolade. For example, ACC_RDVI_
ResourceDemandValues_Config.

Rows Each row maps a column in the data table to a specific type of
demand value data.

Column Names and
Position

The demand value configuration must have the following
column names, from left to right as listed below:
l Export Column Name - Enter each column heading that is
included in the data table.

l Metric System Name - If a string metric is used to identify
the projects in the data file, enter the system name of the
metric used to identify the projects. If the Project ID is used
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Component Requirements

to identify projects, include this column but leave it blank.
l Metadata Name - Enter the metadata name below that
identifies the data included is in each column in the data
table.

l Unique Identifier - Enter TRUE in the row with the Export
Column Name that uniquely identifies the projects within
the import. Can be set for either the ProjectCode or a string
metric. The import uses what you identify to match the
demand values to their respective projects.

Accolade Metadata
Names

Use the following metadata names in theMetadata Name
column of the configuration table to map the data to the
appropriate locations in the Accolade database:
l ProjectCode
l ProcessModelName
l ResourceSystemName
l DemandTypeSystemName
l DemandSystemName
l FirstTimePeriodStartDate
l LastTimePeriodStartDate
l DemandValue

Example

Note the following about the example above:
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l Each item in the Export Column Name column is a column heading in the data table.
l TheMetric System Namemust match the metric system name exactly for the value to
update.

l The names listed in theMetadata Name column must match the metadata names
listed above exactly for the import to process successfully. Enter the metadata name for
each column that matches, or maps, the data in the data file to the Accolade database
to ensure the data is imported to the correct location.

l The TRUE setting in the Unique Identifier column indicates that project code is used to
uniquely identify projects to which the demand values apply.
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Validating and Running Data File Imports

Process Designers can validate files before importing the data to Accolade to view potential
errors and a summary of project changes that would occur on import.

Note: Prior to importing project data to Accolade, ensure that all configuration
components referenced in the data tables already exist in the database. The
data import process does not create configuration components.

To validate a data import:

1. Add both reference tables to Accolade, using the file names as the reference table
names.

2. From theWorkspacemenu, select Import > Data.

To narrow the list by importer name or type, add the criteria to filter by in the appropriate
filter text box.

3. In the Actions column, click Validate next to the importer file containing the reference
table pair.

Click the import name in the Name column to view the data reference
table.

Validating an import returns a list of potential errors and outcomes that will occur on
import. It does not import data or commit changes back to Accolade. The first five
numbered rows detail the data that will be imported if run. These include the number of
data types created, updated, and deleted, and the number of invalid rows and total rows
if the data is imported. If the reference tables fail, the validate results will not display the
project outcomes. Print validation results from the dialog by clicking Print.

To import data to Accolade:

1. Add both reference tables to Accolade, using the file names as the reference table
names.

Administrators and Process Designers add the initial versions of the reference table
pairs. From there, the table owner can update the existing files as needed. The file
name prefix identifies the tables as reference tables that contain import data.

2. From theWorkspacemenu, select Import > Data.

3. In the Actions column, click Run next to the importer file containing the reference table
pair.

Click the import name in the Name column to view the data reference
table.

4. (Optional) Click in the Status/Result column to access last run results and history
including errors, warnings, and abort and cancel information. Correct the errors or
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warnings to import the data successfully. Print import results and action history from the
dialog by clicking Print.

Note: After the initial import, updated data and configuration mappings can be
uploaded using the method above, replacing the existing files, or using
automatic loading. If you have a large amount of data to import, Sopheon
recommends using a reference table import via automatic loading to perform
the import after hours, as large imports can result in system slowness while
the import is running.

Canceling and Aborting Imports

Once you've selected to run the import, you can cancel or abort at any time during the import
process. This will terminate the import and stop project data from being imported into
Accolade.

To cancel or abort an import:

1. From theWorkspacemenu, select Import > Data.

2. Click Abort to stop and roll back a currently running import, or to remove a pending
import.

Note: Only one project import can run at a time. Each import runs in the order it
was selected to run either manually or by an automatic reference table
upload. The Autoloader Service that uploads reference tables automatically
adds files to the import queue based on the time selected for them to upload.
Additionally, the Autoloader service only adds one set of import files at a time
and will not add additional files into the queue until the import has completed.
However, you can add import files to the queue manually when the
Autoloader service has automatically added a file. Use cancel and abort
functions to remove imports from the lineup.

Troubleshooting Project Data Imports

Ensure the data you are entering in the data table and the config table is accurate. An import
can fail as a whole, or only single lines within the data table can fail to import.

If the import fails to run for any lines in the data table, verify that your data and config tables
meet the following requirements:

l The config table has one row identified as TRUE or YES in the Unique Identifier
column.

l If you are using Last Gate Number or Last Gate Decision Name, confirm that either
they both exist or both do not exist.
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l AllMetric System Names that are specified in the config table exist in the data table,
even if they contain no data in their columns.

If the import runs, but you receive errors about some lines not being imported, verify that the
data and config tables meet the following requirements:

l The Unique Identifier is truly unique. For example, if the config table sets the Project
Code as the Unique Identifier, and the data table contains two projects named Project
A, the second Project A does not import.

l All required metrics for a process model are included in each project creation row in the
data table. If a required metric is missing, the project fails to import.

l All required metadata fields for a process model, such as Start Date or End Date, are
included in each project creation row in the data table.

l The Project Code is included in each row.
l The date in theGateDateXX column for a project in the data table is a gate number
within the process model. For example, if the process model has 5 gates, and the data
table contains data in aGateDate06 column, the import fails because that process
model does not contain a 6th gate.

l Accolade expects project codes to be imported as strings. If the project codes are
numbers, or the Auto-Generate Project IDs system parameter is enabled (which
creates numeric project codes), you must first upload a data table following the format
described above that contains a single row of data with a project code entered as a
string. After uploading the data table with a single row, upload subsequent versions of
the data table that contain the true project data information.

l Project links imported using the Date - Date link type are set to the default settings for
the link type if the project does not contain the date information entered for the From
and To dates.

Enabling Automatic File Upload

You can configure Accolade to automatically upload reference table versions and related
documents when new files are placed in a designated directory.

To enable automatic upload, Administrators must first complete the following:

l Configure the upload directory.

l Setup the Autoloader Service User and define the upload directories in Accolade.

After the location and service user are created:

l Process Designers and reference table owners can enable individual reference tables
for automatic uploading.

l Project Importers can setup the related documents upload and schedule the upload to
run.
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Configure the Upload Directory Location

Administrators must create a folder that acts as the drop box location. On the application
server, create or identify the following directories:

l The input directory to use as the drop box location. For reference tables, this can be a
network directory or an FTP site. For related documents, this can only be a network
directory.

l The output directory used to store service error messages and logs.

These can be the same folder.

Set Up the Autoloader Service User and Autoloader Service

The Accolade Autoloader Service requires a user account to upload new document versions
or reference tables to Accolade, and can be used for importing project and resource data.
Create the user account for the autoloader service in Accolade and assign it the following roles
and access groups:

l Service Account user role. This is automatically assigned when the user is created.

l Project Importer user role, which is automatically assigned when the user is created.
This user role is only a requirement when importing project or resource data.

l Appropriate Access Groups with access permission selected. This is only a
requirement if loading Reference Tables that contain a specified Access Group.

After setting the user as the autoloader service account (on the server), the user is
automatically granted the Logon as a Service right.

Important! If you created the Accolade database login using Windows
Authentication, you must add the user login to the database after adding the user to
the Autoloader Service. Follow the instructions outlined in the Accolade Installation
Guide to create the Accolade database login and add users.

To ensure that reference tables assigned to a specific access group are
uploaded successfully when enabled for automatic upload, assign the
user with the System Service user role in Accolade access to all access
groups defined in the system. See "Granting Access Group Permissions
to Users" on page 91.

In addition, Accolade needs to know the directory or FTP location it should look in for new files
to upload.

To setup the Autoloader Service User on the application server:

1. On the application server, from the Startmenu, select Administrative Tools > Local
Security Policy.

2. Open the Local Policies folder and open the User Rights Assignment folder.
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3. Right-click the Log on as a service policy and select Properties.

4. In the Local Security Setting tab, add a service user for the upgrade service.

5. ClickOK to save your changes.

After you have defined the service user on the application server, configure the
Accolade Autoloader Service in the Accolade Administration Console. Additionally,
after setting up the autoloader service user, add the user login to the database if you
created the Accolade login using Windows Authentication.

To configure the Autoloader Service:

1. In the Accolade Administration Console, select Autoloader Configuration in the
Navigation pane.

2. In the Service Account User field, add the service account user you created above
and enter its password.

This user is added to Accolade as a user with the Service Account user role.

3. Select the Enabled Service check box and enter a Retry Delay on Error time period
in milliseconds to set the retry rate if the service encounters errors.

4. In the File Locations section, enter the input (the location with files to upload) and
output (the place Accolade saves any log files regarding the upload) locations for the
directory or FTP site in the fields appropriate for your setup.

Accolade supports both FTP and FTPs for file uploads. However, if you are using the
Autoloader Service for related documents uploads, designate a directory location.

5. Click Apply to save your changes.

To modify the Autoloader Service in a load balance environment:

Note: Reference the Accolade Installation Guide for information on setting up load
balance environments.

1. Stop any running Autoloader Windows Service instances on all load balanced servers.

2. Make the same change on each load balance server on the Autoloader Configuration
page on the Administration Console.

3. Re-enable any previously active Autoloader Windows Service instances on all load
balanced servers.

Importing Related Documents

As you implement Accolade, you may have a large number of related document files from your
previous innovation management system or process that you want to include with projects and
initiatives when you start using Accolade. Use a filestore and the Accolade Autoloader Service
to upload the related documents efficiently to Accolade.
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Note: Users with the Project Importer user role can import related documents.
However, an Administrator must enable automatic uploading of files within
Accolade. See "Enabling Automatic File Upload" on page 482.

Related Project Filestore Folder Structure

Accolade uploads related documents using a specific directory structure defined within a drop
box location. The drop box location used to store the related documents prior to uploading can
be anywhere on your network that Accolade has access to. The Autoloader Service uses the
folder structure within the directory to match the related documents to the correct projects in
Accolade. Administrators tell Accolade where to find the files in the Autoloader Configuration
section of the Accolade Administration Console. See "Enabling Automatic File Upload" on
page 482.

Define the folder structure as follows, where IndividualRelatedDocumentFile is one or more
files to upload as related documents:

Keep the following in mind as you are creating and copying files to the filestore location:

l The filestore cannot be an FTP site.

l The highest folder in the structure must be named RelatedDocumentsFileStore
so the Autoloader Service recognizes the contents of the directory as a related
documents upload.

l The filestore can have multiple ProjectSystemID folders representing different projects
within Accolade.

l Each ProjectSystemID folder can have multiple DeliverableSystemName folders
representing different deliverables within a project.

l Individual files added to the filestore are uploaded as follows:

l Files in the ProjectSystemID are uploaded as project-level related documents with
the Default category assignment.

l Files in the ProjectSystemID > DeliverableSystemName are uploaded as
deliverable-level related documents and are attached to the deliverable identified in
the folder name.
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l Files in a category folder, either within the DeliverableSystemName folder or in the
ProjectSystemID folder are uploaded and assigned that category.

l If a file already exists, a new version is created on upload. If multiple files exist with
the same name in the same location, the individual files do not upload.

Important! Ensure files you copy to the filestore directory are not set to Read Only
and ensure that the file names, including extensions, do not exceed 64 characters.
Files with a name longer than 64 characters do not upload.

Files uploaded using the filestore contain the following details after successful upload to
Accolade:

l The related document name is the individual file name as it existed in the filestore
directory.

l The uploaded by name is the Service Account used for the upload service.

l The author is the Microsoft Windows author of the file.

Uploading the Related Documents Filestore to Accolade

Consider the following prior to uploading related documents:

l If there is a large number of files to upload, consider running the upload after hours.

l If there is active training or other activity happening within Accolade, consider running
the upload after the activity has ended.

l Files larger than the limit set in theMaximum File upload Size system parameter do
not upload.

To upload the related document in the filestore:

1. Ensure files are not set as Read Only and are in the correct directory in the filestore as
indicated above, and ensure that the filestore is in the drop box location defined in the
Administration Console.

2. From theWorkspacemenu, select Import > Related Documents.

3. Do one of the following:

l To schedule the upload to run within the next 24 hours - In the Scheduled at
fields, enter the time within the next 24 hours to upload the files in the filestore
location, and click Apply. For example, to upload all files at 10:00 pm, enter 22:00.
The time entered is the time in the application server's time zone, which may be
different than the time zone you are in when entering the time in Accolade. After the
upload runs, the time is cleared, indicating that an upload is not scheduled.

l To run the upload to run immediately - Select Now and click Apply.

After a file is processed and uploaded, it is removed from the import directory. A log file
is generated and saved in the Outbox Path as defined in the Administration Console
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that contains the number of files successfully uploaded and information about any files
that encountered an error during the upload process.

Importing and Exporting Configuration Components
Overview

Accolade provides Administrators and Process Designers the ability to transport configuration
components between environments by exporting and importing via spreadsheets.

Process design and system configuration components can be downloaded from one Accolade
environment and then uploaded into a different Accolade environment, and some mass
configuration changes can be made using these processes.

Importing and Exporting Configuration Components Best Practices

Keep the following set of best practice recommendations in mind when importing and
exporting configuration components:

l If you have spreadsheets that were downloaded from a previous release, Sopheon
recommends completing a download after upgrading to the latest release, to ensure
your spreadsheet contains any new configuration settings added to the release.

l Using the import and export tools to update or remove configuration within the same
environment can result in errors or unintended changes if information is missing in the
import or an error occurs during the process.

The following guidelines are recommended when creating or updating files for import:

l Apply available Accolade filters to limit the export to the information for the
components you wish to change.

l Include all file worksheets in the file to be uploaded.

l The columns in the spreadsheets must be in the same order for changes to upload
successfully. All columns must be present, however the value in a column can be
blank if appropriate.

l When uploading changes to component configuration, such as changes to quick
grids or layouts, the existing configuration will be replaced with the imported
version in the workbook. If existing components, such as a pod within a layout or
an individual grid within a quick grid, are not included in the file, they will be
removed.

Sopheon recommends creating a backup version of the original file prior to making any
changes.

l Component system names cannot be changed using the export/import functionality.
Although not recommended, component system names can be changed in the user
interface, as necessary.
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l Be mindful when changing Process Model configuration through the Import Process
Models functionality. For example, if you are changing the number of stages or gates on
an inactive process model, this change should be made in the Process Model definition
page, or the current model should be obsoleted and a new model created. The Import
tool will prompt an error message and will not accept the change if not allowed.
Additionally, if the configuration changes are significant or will impact a large number of
existing projects, you may experience additional system impacts.

l The user performing the new configuration imports should have the highest
configuration access group required by the components being loaded. This will
minimize the conflicts associated with configuration access group errors related to the
user's access levels and will reduce the chances of an incomplete upload.

l If you are transporting new configuration between environments, for example from a
test environment to a production environment, components should be loaded in a
sequence in order to increase efficiency and minimize load errors. Independent
components should be loaded into the Accolade environment first, followed by
dependent components, and complex components should be loaded last.

Sopheon recommends the following order when importing components:

Important! The steps below are the steps to move a full configuration from
one system to another. The order of these steps may vary depending on
what is being moved or changed, and the existing configuration in the
destination environment. For complex deployments or configuration
changes, please contact Sopheon Customer Support prior to starting, to
ensure that you protect the integrity of the data and don't inadvertently
cause problems.

Configuration
Item Dependencies* Notes

Independent Components

Parameters None These should generally only be changed for
an initial deployment.

Access
Groups

None

Security Lists None Sopheon recommends using the reference
table setup method for new security lists.
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Configuration
Item Dependencies* Notes

Users None Note that if the User import references new
functions or functional areas that have not
been created, they will cause errors when
loading. The User importer will need to be
reloaded after the functions and functional
areas are imported.

Additionally, if your company uses
Resource Planning and the User importer
references new resource pools that have
not been created, they will cause errors
when loading. This can be corrected when
running the Resource Pool and Resource
importers after the configuration import
process is complete.

Reference
Tables

None Note that the Reference Table importer
does not import the reference table data,
only the table configuration, so the table
version must also be manually uploaded at
this time.

Queries None

Classes None If any new classes have the Create Model
in Planning defined as Yes, change these
fields to No prior to upload in order to
prevent errors.

To apply this setting after the initial upload,
these fields will need to be changed back to
Yes on the workbook, and the workbook will
need to be reloaded after the process
models are imported.

Dependent Components

Functional
Areas and
Functions

User logins** If this import contains new functions or
functional areas to be created, and these
are referenced by the user import
performed earlier, you will need to re-run
the Users import after the Functional Area
and Functions import is completed.

Extended
Fields

Queries
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Configuration
Item Dependencies* Notes

HTML Reports Queries

Metrics Reference
Tables**

Calculated
metrics may
include additional
component
dependencies as
noted.

When exported from an environment, the
metrics workbook will contain associations
to all related process models or related
metrics. If these metrics or process models
have not be created yet, the associations
will cause errors when loading. Additionally,
if metrics include associations via their
calculation expressions, these associations
might cause errors when loading the import.

Important! To minimize errors when
creating new metrics, Sopheon
recommends users create and load a
truncated version of the workbook with all
process model associations columns
deleted, the Is Calculated field defined as
No for all metrics, and the calculated
expressions and triggers details removed
as necessary.

To apply these settings after the initial
upload, a version of the workbook including
all of these settings will need to be reloaded
after the process models are imported. This
will capture any metrics associations that
were missing on the initial upload.

Matrices Metrics

Matrices that
include
calculated
metrics may
include additional
component
dependencies as
noted.

When exported from an environment, the
matrices workbook will contain associations
to all related process models or related
metrics. If these metrics or process models
have not be created yet, the associations
will cause errors when loading. Additionally,
if metrics include associations via their
calculation expressions, these associations
might cause errors when loading the import.
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Configuration
Item Dependencies* Notes

Important! To minimize errors when
creating new metrics, Sopheon
recommends users create and load a
truncated version of the workbook with all
process model associations columns
deleted, the Is Calculated field defined as
No for all metrics, and the calculated
expressions and triggers details removed
as necessary.

To apply these settings after the initial
upload, a version of the workbook including
all of these settings will need to be reloaded
after the process models are imported. This
will capture any metrics associations that
were missing on the initial upload.

Accolade
Online
Reports

Metrics**
User IDs**

Note that ownership can only be changed
as necessary on the initial import of a new
report.

Accolade
Charts

Accolade Online
Report source
User logins**
Reference
Tables**

Templates Metrics

Quick Grids Metrics
Matrices**

Workflows Metrics
Templates**
Functions**
Users**

Security
Profiles

Classes
Metrics

MS Excel
Reports

Queries**
Templates**
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Configuration
Item Dependencies* Notes

Layouts Metrics
Online Reports
Charts
Quick Grids

If layouts contain new planning views that
have not been created yet, they will cause
errors when loading. These planning views
will have to be manually created in the new
environment prior to uploading the layout
configuration.

If any new layouts have theGenerate
Global Link defined as Yes, the upload will
automatically generate the global link,
however you may need to review and/or
edit the link settings manually if they are not
included in the Global Links import.

Complex Components

Process
Models

Dependencies
can include any
combination of
independent and
dependent
components

Important! After completing the Process
Models import, re-import the following
workbooks as necessary:
l The Metrics workbook should be
reloaded with the process model
associations and calculations included.

l The Matrices workbook should be
reloaded with the calculations included.

l The Classes workbook should be
reloaded with the Create Model in
Planning defined as Yes as necessary
for classes/process models that are to be
available for creating in Innovation
Planning.

Migration
Maps

Process Models
Metrics

If you have made manual changes to a
process model's gate name that is
referenced in the file, it can cause errors
with the Migration Map import. These
migration maps will have to be manually
created in the new environment.

Project Link
Types

Process Models
Metrics
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Configuration
Item Dependencies* Notes

Global Links Layouts**
Process Models**

If global links contain new planning views
that have not been created yet, they will
cause errors when loading. These planning
views will have to be manually created in
the new environment prior to uploading
global links configuration.

If the Layout import included new layouts
with theGenerate Global Link defined as
Yes, the associated global link has been
created. The settings for these links can
either be updated manually, or can be
included in the Global Link import.

* Dependencies listed are only if the component being imported is mentioned in the configuration.

** The dependency only exists if the component is referenced within the configuration.

Importing and Exporting Process Models

Accolade provides Administrators and Process Designers the ability to export process model
information from one Accolade environment and import it into another Accolade environment.
For example, your company may have a test environment set up during your implementation,
or you may have company branches that are new to Accolade that are hosted in a separate
environment. Instead of having to recreate process models in each environment, download the
information and import it into the new environment.

The download exports the process model configuration information into a spreadsheet file with
the parts of the process model grouped into tabs.

Note: The download does not include metric associations. If you are using the
process described below to create new models, ensure that templates are in
place in the Template Library, import the models, and then associate metrics
for each individual model or for multiple models at one time using the metric
export/import utility.

To export model settings:

Note: If you wish to download a process model, you may select up to 20
gatekeepers. If you add more than 20 gatekeepers, the model cannot be
downloaded.

1. From the Systemmenu, select Process > All Models.

2. Select the models that you want to download.
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To narrow the list by process model name or system name, add the criteria to filter by in
the appropriate filter text box. These filters are case insensitive.

To narrow the list by class, select a class to display in the Class list. To download all
process models, select All.

3. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save the
file a more accessible location.

Note: Only process models to which you have view and/or edit configuration
access group rights will download. Process models and components you can
only view may be included in the file, but you can only upload changes to
models and components to which you have explicit edit permission.

To import model settings into Accolade:

1. Ensure the data within the spreadsheet file meets the requirements for a successful
import.

2. Remove any models from the spreadsheet that you do not want to include in the upload
and save the file.

3. From the Systemmenu, select Process > All Models.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the models in the spreadsheet, and adds any new
models with unique system names.

7. (Optional) Click Print to print the import results for your records.

Note: Process models that are imported are subject to access group configuration
rules. The user may assign components to a process model parent in a way
that the configuration access groups are not consistent. This behavior is not
allowed in the UI, and mismatches in either the user's access rights or the
component's access group restrictions may result in warning or error
messages during the upload, and may result in an incomplete model upload.
Once the upload is complete, component access groups can be reviewed
and edited from the process model's component tree tab.
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Model Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each process model,
including stage and gate configuration, in the order listed below. For a description of each
model setting, see the online Help for Creating Gated and Non-Gated Process Models or
Creating Idea Process Models (if creating an Idea model).

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Process Models

Column Name Accepted Values on
Upload* Additional Notes

System Name Alphanumeric
characters,
underscore**

Must start with an A -
Z or a - z character.

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

If a new, unique system name
exists in the file when uploaded, a
new model is created.

Display Name Any If blank, the model does not
upload.

Active Yes, Y, True, 1, X* All other values are treated as No
on upload.

Disable Add
New

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Hide From Add
New

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Default
Portfolio Model

Valid process model
system name

Applies to models used for Idea
campaigns.

Default
Accolade Team
Leader User

Valid login information
for an Accolade user

If blank or invalid, set to None or to
the metric value set in the Default
Accolade Team Leader Metric
column.

Default
Accolade Team
Leader Metric

Valid metric system
name

If blank or invalid, set to None or to
the Accolade user defined in the
Default Accolade Team Leader
User column.
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Column Name Accepted Values on
Upload* Additional Notes

If a value is also available in the
Default Accolade Team Leader
User column, the upload uses that
column's value.

Class System
Name

Valid class system
name that matches a
valid process type

The class and process type must
match. If not, the model changes
do not upload.

If the class does not exist, the
upload creates a new class.

Process Type Gated
Non-Gated
Idea

All other values are treated as
blank and the row does not
upload.

You cannot change an
existing model's process
type.

Allow Mid-
Process Project
Start for
Creation

Select by Stage
Select by Gate
No

All other values are treated as No
on upload.

Allow Mid-
Process Project
Start for
Migration

Select by Stage
Select by Gate
No

All other values are treated as No
on upload.

Description Any Can be blank.
Related
Document
Categories

Any Separate categories using the
pipe ( | ) character.

Can be blank.
Initial Tab Valid project page

name or valid layout
system name

Indicated value must be listed on
the Pages tab in the Page
System Name column.

Default Access
Group

Valid access group
system name

Blank or invalid values do not set
an access group.

Idea
Deliverable
System Name

Valid name of a web
document assigned to
a deliverable within an
idea model

Applies to idea models only.

Disable Idea
File

Yes, Y, True, 1, X* Applies to idea models only.
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Column Name Accepted Values on
Upload* Additional Notes

Attachments All other values are treated as No
on upload.

Hide The Idea
Type Row

Yes, Y, True, 1, X* Applies to idea models only.

All other values are treated as No
on upload.

Hide Gate
Decision
Option For Idea
Submitter

Yes, Y, True, 1, X* Applies to idea models only.

All other values are treated as No
on upload.

Process Model
Display Type

Compact
Traditional

All other values are treated as
Compact on upload.

Set Gates Page
to read-only

Yes, Y, True, 1, X* Applies to gated models and idea
models with gates only.

All other values are treated as No
on upload.

Restricted
Access Groups

Valid access group
system name

Separate names using the pipe
( | ) character.

Default Access
Group Metric

Valid metric system
name of a String, List,
Long String, or
Number metric

All other values do not assign a
metric to set the access group.

Project Name
Metric

Valid metric system
name

If blank or invalid, the project
name is not determined by a
metric value.

Enforce
Function for
Team Selection

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Enforce Project
Security

Yes, Y, True, 1, X* All other values are treated as No
on upload.

If you enable this option,
existing projects using
this model that contain
users assigned outside
their security access are
not automatically
removed from the
project.
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Column Name Accepted Values on
Upload* Additional Notes

Protect
Document
Versions from
Deletion

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Project ID
Metric

Valid metric system
name

If blank or invalid, the project ID is
not determined by a metric value.

Require Project
Manager on
Create

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Configuration
Access Group

Valid access group
display name

Separate names using the pipe ( |
) character.

If blank, the model does not
upload.

Extend Project
Edit Rights

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Start Date
Display Name

Any If blank, the model does not
upload.

Show Creation Hide
Required
Edit

If blank, the model does not
upload.

Show Migration Hide
ReadOnly
Edit

If blank, the model does not
upload.

Show Process
Graphic

Hide
ReadOnly
Edit

If blank, the model does not
upload.

Show Resource
Editor

Hide
ReadOnly

If blank, the model does not
upload.

End Date
Display Name

Any If blank, the model does not
upload.

Show Creation Hide
Required
Edit

If blank, the model does not
upload.

Show Migration Hide
ReadOnly
Edit

If blank, the model does not
upload.

Show Process
Graphic

Hide
ReadOnly
Edit

If blank, the model does not
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Show Resource
Editor

Hide
ReadOnly

If blank, the model does not
upload.

Currency Show
Creation

Hide
Edit

If blank, the model does not
upload.

Show Migration Hide
ReadOnly
Edit

If blank, the model does not
upload.

Extended
Project Data
1...10 Display
Name***

Any If blank, the model does not
upload.

Show
Creation***

Hide
Edit

If blank, the model does not
upload.

Show
Migration***

Hide
ReadOnly
Edit

If blank, the model does not
upload.

Show
Planning***

Hide
Edit

If blank, the model does not
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

*** Each Extended Project Data field in the spreadsheet has a set of columns to set the display name and
hide, edit, and read-only details as described here. For example Extended Project Data 1, Extended Project
Data 2, and so on up to a maximum of 10.

l Pages

Column Name Accepted Values on
Upload Additional Notes

Process
Model System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Page System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a page exists, its settings are
changed with the values in the
uploaded file.
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Column Name Accepted Values on
Upload Additional Notes

Visible Yes, Y, True, 1, X* All other values are treated as No
on upload.

Order Number Is set to 0 on upload if no value is
entered or the value is not a
number.

Visibility
Layout Rule
System Name

Valid system name of a
layout rule established
on the Layout Rules
worksheet

All other values are set to None
on upload.

Delete Yes, Y, True, 1, X* All other values are treated as No
on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Link Rules

Column Name Accepted Values on
Upload Additional Notes

Process
Model System
Name

Alphanumeric
characters, underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Link Rule
System Name

Alphanumeric
characters, underscore**

Used for matching for upload.

If a link exists, its settings are
changed with the values in the
uploaded file.

Link Rule
Name

Any

Link Type
System Name

Alphanumeric
characters, underscore**

Used for matching for upload.

If a link exists, its settings are
changed with the values in the
uploaded file.

Link Process
Model System
Names

Alphanumeric
characters, underscore**

Separate model names using the
pipe ( | ) character.

Order Number Is set to 0 on upload if no value is
entered or the value is not a
number.
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** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Link Rule Metrics

The Link Rule Metrics worksheet contains the metric conditions that must be met for a
rule defined at the model-level to take effect. The contents of this worksheet works with
the rules defined in the Link Rules worksheet. Each row in the worksheet represents a
single condition for a link rule.

Column Name Accepted Values on
Upload Additional Notes

Process
Model System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Link Rule
Name

Valid name of a link rule
established on the Link
Rules worksheet

Metric System
Name

Valid metric system
name

If blank or invalid, the condition
does not upload.

Metric Value The value the metric
must be set to for the
project link to be created

Ensure the value entered here is
appropriate for the metric type.

For example, a Date metric
should have a date as a value.

Source Metric
System Name

Valid metric system
name

If blank or invalid, the condition
does not upload.

Order Number Is set to 0 on upload if no value is
entered or the value is not a
number.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Phases

The Phases worksheet contains the information about each stage/gate combination
within the model. After a model is used in a project (open or closed) you can no longer
add or reorder a stage or a gate in that model. However, you can update the details
within the model as described below.

Column Name Accepted Values on
Upload* Additional Notes

Process Model
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.
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Column Name Accepted Values on
Upload* Additional Notes

If a model exists, its settings are
changed with the values in the
uploaded file.

Phase ID Number The number that identifies the
placement of the phase within
the Phase Gate sequence. For
example, a Phase ID of 1
indicates the first stage/gate pair
within the model. Phase ID of 2
indicates the stage/gate pair that
follows the first stage/gate pair
within the model, and so on.

A model can have a single stage
or a single gate.

Stage Name Any Can be blank if at least oneGate
Name is included.

Stage
Description

Any Can be blank.

Gate Name Any Can be blank if at least one
Stage Name is included.

Gate
Description

Any Can be blank.

Default Gate
Manager

Project Manager
Project Creator
None

All other values are set to None
on upload.

Set Gate Date
Metric

Valid metric system
name

All other values are treated as
blank on upload.

Set Gate Date
At Project
Creation

None
Show
Required

All other values are set to None
on upload.

Require
Gatekeeper
Voting

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Set Gate
Decision On
Approval

Yes, Y, True, 1, X* If Set Gate Decision On
Approval is defined as Yes, Y,
True, 1, X*, the Require
Gatekeeper Voting column
must also be Yes, Y, True, 1, X*.
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Column Name Accepted Values on
Upload* Additional Notes

All other values are treated as No
on upload.

Gate Owner
Can Skip

Yes, Y, True, 1, X* IfGate Owner Can Ship is
defined as Yes, Y, True, 1, X*,
the Require Gatekeeper Voting
column must also be Yes, Y,
True, 1, X*.

All other values are treated as No
on upload.

Set Go
Restriction
Message
Metric

Valid metric system
name

All other values are treated as
blank on upload.

Gatekeeper
Function***

Valid function system
name

All other values are set to None
on upload.

Gatekeeper
Login***

Valid login information
for an Accolade user

All other values are set to None
on upload.

Gatekeeper
Enforce
Function on
User
Selection***

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Min Gate Date
Metric

Valid metric system
name

All other values are treated as
blank on upload.

Max Gate Date
Metric

Valid metric system
name

All other values are treated as
blank on upload.

Gate Layout Valid layout system
name

Can be blank if no layouts are
selected.

All other values are set to None
on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

***Gatekeeper Function, Gatekeeper Login andGatekeeper Enforce Function on User Selection
columns are included for each gatekeeper listed in the model.
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l Gate Documents

Column Name Accepted Values on
Upload* Additional Notes

Process Model
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Phase ID Number Used for matching for upload.

If a phase exists, its settings are
changed with the values in the
uploaded file.

Document
Name

Any If blank, the document does not
upload.

Document
System Name

Alphanumeric
characters,
underscore**

If blank, the document does not
upload.

Description Any Can be blank.
Template Any Can be blank.
Template
System Name

Valid template system
name of a template
available in the
Template Library

The template won’t be added if
the user does not have the
appropriate configuration access
group rights to edit the template
and a warning will be produced
but the deliverable/activity will still
be uploaded without the template.

If the template does not share the
appropriate access group with the
deliverable/activity then a warning
will be produced but the template
will still be added to the
deliverable/activity.

All other values upload with no
template attached.

If updating to a new template and
the new name is not valid, the
system will default and retain the
current template.

Order Number Is set to 0 on upload if no value is
entered or the value is not a
number.
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Column Name Accepted Values on
Upload* Additional Notes

Allow Version
Delete

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Configuration
Access Group

Valid access group
display name

Separate names using the pipe ( |
) character.

If blank, the document does not
upload.

Delete Yes, Y, True, 1, X* All other values are treated as No
on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Deliverables and Activities

Deliverables and activities are exported onto separate worksheets within the
ProcessModelWorkbook.xlsx file. However, the content within each worksheet that
defines a deliverable or an activity is the same as described below.

Column Name Accepted Values on
Upload* Additional Notes

Process Model
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Phase ID Number Used for matching for upload.

If a phase exists, its settings are
changed with the values in the
uploaded file.

System Name Alphanumeric
characters,
underscore**

If blank, the deliverable/activity
does not upload.

Name Any If blank, the deliverable/activity
does not upload.

Description Any Can be blank.
Template Any Can be blank.
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Column Name Accepted Values on
Upload* Additional Notes

Template
System Name

Valid template system
name of a template
available in the
Template Library

The template won’t be added if
the user does not have the
appropriate configuration access
group rights to edit the template
and a warning will be produced
but the deliverable/activity will
still be uploaded without the
template.

If the template does not share the
appropriate access group with
the deliverable/activity then a
warning will be produced but the
template will still be added to the
deliverable/activity.

All other values upload with no
template attached.

If updating to a new template and
the new name is not valid, the
system will default and retain the
current template.

Quick Grids Valid quick grid system
name

Separate categories using the
pipe ( | ) character.

Can be blank.
Workflow Valid workflow system

name
Can be blank.

Workflow
Options

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Link to Phase Valid phase ID within
the model

Used in combination with Link to
Phase Name and Link to
Assignment System Name to
determine the stage and
assignment to link to.

All other values upload with no
link.

Link to
Assignment
System Name

Valid deliverable or
activity system name

Used in combination with Link to
Phase Name and Link to Phase
ID to determine the stage and
assignment to link to.
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Column Name Accepted Values on
Upload* Additional Notes

All other values upload with no
link.

Link to
Assignment
Type

Deliverable, Activity All other values upload with no
link.

Link to Only
Publish

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Function Valid function system
name

All other values are set to None
on upload.

Default Start
Date Type

Manual
Days
Percent

All other values are set to
Manual on upload.

Default Start
Date Value

Number Leave blank if Default Start
Date Type is set toManual.

Default
Deadline Type

Manual
Days
DaysAfterStart
Percent

All other values are set to
Manual on upload.

Default
Deadline Value

Number Leave blank if Default Deadline
Date Type is set toManual.

Default Finish
Date Type

Manual
Days
DaysAfterStart
Percent

All other values are set to
Manual on upload.

Default Finish
Date Value

Number Leave blank if Default Finish
Date Type is set toManual.

Process
Assistance URL

Any Can be blank.

Order Number Is set to 0 on upload if no value is
entered or the value is not a
number.

Allow Version
Deletion

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Allow Project
Manager and
Owner to Delete
Activities

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Allow Not
Required Status

Yes, Y, True, 1, X* All other values are treated as No
on upload.
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Upload* Additional Notes

Allow Default
Shared
Ownership

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Hide Related
Documents

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Disable
Complete
Status When No
Published
Version Exists

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Disable
Complete
Status When
Quick Grid
Required
Values are
Missing

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Workflow
Template

Any Can be blank.

Workflow
Template
System Name

Valid template system
name of a Process
Document template
available in the
Template Library

The template won’t be added if
the user does not have the
appropriate configuration access
group rights to edit the template
and a warning will be produced
but the deliverable/activity will
still be uploaded without the
template.

If the template does not share the
appropriate access group with
the deliverable/activity then a
warning will be produced but the
template will still be added to the
deliverable/activity.

All other values upload with no
template attached.

If updating to a new template and
the new name is not valid, the
system will default and retain the
current template.
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Column Name Accepted Values on
Upload* Additional Notes

Restricted
Access User
Roles

Valid user role system
name

Separate system roles using a
semicolon ( ; ) character.

Can be blank.
Publish On
Upload

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Enforce
Function on
User Selection

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Configuration
Access Group

Valid access group
display name

Separate names using the pipe ( 
| ) character.

If blank, the deliverable/activity
does not upload.

Visibility Rule
System Name

Valid conditional rule
system name

All other values are set to None
on upload.

Delete Yes, Y, True, 1, X* All other values are treated as No
on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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l Matrix Metric Filters

Column Name Accepted Values on Upload Additional
Notes

Process
Model
System
Name

Alphanumeric characters, underscore** Used for
matching
for upload.

If a model
exists, its
settings are
changed
with the
values in
the
uploaded
file.

Deliverable
System
Name

Valid deliverable system name Used for
matching
for upload.

If a
deliverable
exists, its
settings are
changed
with the
values in
the
uploaded
file.

Activity
System
Name

Valid activity system name Used for
matching
for upload.

If an activity
exists, its
settings are
changed
with the
values in
the
uploaded
file.
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Column Name Accepted Values on Upload Additional
Notes

Display in
Project

Yes, Y, True, 1, X* All other
values are
treated as
No on
upload.

Matrix
System
Name

Valid matrix system name Used for
matching
for upload.

If a matrix
exists, its
settings are
changed
with the
values in
the
uploaded
file.

Metric
System
Name

Valid metric system name Must be an
existing
value in the
matrix
defined in
Matrix
System
Name, and
must be a
list metric
with a
defined list.

Filter DisplayAndUpdateAllRows
DisplayAndUpdateOnlyRowsContaining
DisplayAllRowsAndUpdateOnlyRowsContaining

If blank, the
filter does
not upload.

Filter Value Valid list value for the metric defined inMetric
System Name

Separate
values
using the
pipe ( | )
character.

Can be
blank.
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* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Dependencies

Column Name Accepted Values on
Upload Additional Notes

Process Model
System Name

Alphanumeric
characters, underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Source Type Activity
Deliverable

If blank, the dependency does
not upload.

Source System
Name

Valid activity/deliverable
source system name

If blank, the dependency does
not upload.

Target Type Activity
Deliverable

If blank, the dependency does
not upload.

Target System
Name

Valid activity/deliverable
target system name

If blank, the dependency does
not upload.

Dependency
Type

Start-Start
Start-Finish
Finish-Start
Finish-Finish

If blank, the dependency does
not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Process Graphic Style

Column Name Accepted Values on
Upload* Additional Notes

Process Model
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Phase ID Number Used for matching for upload.

If a phase exists, its settings are
changed with the values in the
uploaded file.

Stage Icon Valid icon name The icon assigned to the stage
within the phase.
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Column Name Accepted Values on
Upload* Additional Notes

Valid icon names are listed with
each icon's picture when you
click Icon in the Process Graphic
definition page.

Stage Past
Color

Valid hex color code If left blank, defaults to
#EFEFEF.

Stage Current
Color

Valid hex color code If left blank, defaults to
#C9E1AC.

Stage Future
Color

Valid hex color code If left blank, defaults to
#D6D6D6.

Gate Current
Shape

arrow
chevron
circle
diamond
gear
hexagon
parallelogram
plus
quarterCircle

The icon assigned to the next
gate.

All other values upload with the
default diamond shape.

Gate Current
Color

Valid hex color code If left blank, defaults to #417491.

Gate Future
Shape

arrow
chevron
circle
diamond
gear
hexagon
parallelogram
plus
quarterCircle

The icon assigned to future
gates.

All other values upload with the
default diamond shape.

Gate Future
Color

Valid hex color code If left blank, defaults to #B0B0B0.
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Column Name Accepted Values on
Upload* Additional Notes

Gate Go Shape arrow
chevron
circle
diamond
gear
hexagon
parallelogram
plus
quarterCircle

The icon assigned to gates with a
Go decision entered.
All other values upload with the
default diamond shape.

Gate Go Color Valid hex color code If left blank, defaults to #417491.
Gate Go
Decision
Badge

ConditionalGo
Go
Hold
Kill001
Kill002
Recycle001
Recycle002

The icon overlay assigned to
gates with aGo decision entered.
All other values upload with the
default Go overlay.

Gate
Conditional Go
Shape

arrow
chevron
circle
diamond
gear
hexagon
parallelogram
plus
quarterCircle

The icon assigned to gates with a
Conditional Go decision
entered.

All other values upload with the
default diamond shape.

Gate
Conditional Go
Color

Valid hex color code If left blank, defaults to #417491.

Gate
Conditional Go
Decision
Badge

ConditionalGo
Go
Hold
Kill001
Kill002
Recycle001
Recycle002

The icon overlay assigned to
gates with a Conditional Go
decision entered.

All other values upload with the
default Conditional Go overlay.
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Column Name Accepted Values on
Upload* Additional Notes

Gate Suspend
Shape

arrow
chevron
circle
diamond
gear
hexagon
parallelogram
plus
quarterCircle

The icon overlay assigned to
gates with a Hold decision
entered.

All other values upload with the
default diamond shape.

Gate Suspend
Color

Valid hex color code If left blank, defaults to #417491.

Gate Suspend
Decision
Badge

ConditionalGo
Go
Hold
Kill001
Kill002
Recycle001
Recycle002

The icon overlay assigned to
gates with a Hold decision
entered.

All other values upload with the
default Hold overlay.

Gate Cancel
Shape

arrow
chevron
circle
diamond
gear
hexagon
parallelogram
plus
quarterCircle

The icon assigned to the gates
where a project is canceled.

All other values upload with the
default diamond shape.

Gate Cancel
Color

Valid hex color code If left blank, defaults to #417491.

Gate Cancel
Decision
Badge

ConditionalGo
Go
Hold
Kill001
Kill002
Recycle001
Recycle002

The icon overlay assigned to
gates with a Kill decision
entered.

All other values upload with the
default Kill overlay.

515



Chapter 7  Importing Project Data and Configuration

Administrator's Guide

Column Name Accepted Values on
Upload* Additional Notes

Gate Recycle
Shape

arrow
chevron
circle
diamond
gear
hexagon
parallelogram
plus
quarterCircle

The icon assigned to the gates
with a Recycle decision entered.
All other values upload with the
default diamond shape.

Gate Recycle
Color

Valid hex color code If left blank, defaults to #417491.

Gate Recycle
Decision
Badge

ConditionalGo
Go
Hold
Kill001
Kill002
Recycle001
Recycle002

The icon overlay assigned to
gates with a Recycle decision
entered.

All other values upload with the
default Recycle overlay.

* Valid hex color codes include any combination of six characters between a and f, and 0 and 9. For example,
#227755 is a shade of green, #000000 is black, and #ffff00 is yellow. The # is implied in the spreadsheet and
not required in the upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Auto Gate Decision Rules

Column Name Accepted Values on
Upload Additional Notes

Process
Model
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Phase ID Number Used for matching for upload.

If a phase exists, its settings are
changed with the values in the
uploaded file.

Gate
Decision
Code***

Number The number that identifies the gate
decision type.
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Column Name Accepted Values on
Upload Additional Notes

Go = 1
Kill = 2
Hold = 3
Recycle = 4
Pending Decision = 6

A Conditional Go decision cannot
be set using an automated gate
decision.

If you have configured
your gate decision names
to use different
terminology, the numbers
apply to the configured
names that mapped to the
defaults names listed
above.

Metric
System Name

Valid metric system
name

All other values do not assign a
metric condition to the gate.

Metric Value The value the metric
must be set to for the
gate decision to be set.

Blank or invalid values do not set a
metric condition.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

*** To set more than one metric condition per gate decision type, create additional rows using the sameGate
Decision Code.
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l Required Conditions for Go

Column Name Accepted Values on
Upload Additional Notes

Process
Model System
Name

Alphanumeric
characters, underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Phase ID Number Used for matching for upload.

If a phase exists, its settings are
changed with the values in the
uploaded file.

Metric System
Name

Valid metric system
name

All other values do not assign a
metric condition to restrict the
gate decision to the gate.

Metric Value The value the metric
must be set to for the
gate decision to be set to
Go or Conditional Go.

Blank or invalid values do not set
a metric condition.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Team Page Configuration

Column Name Accepted Values on Upload Additional Notes

Process Model
System Name

Alphanumeric characters,
underscore**

Used for matching for
upload.

If a model exists, its settings
are changed with the values
in the uploaded file.

Control ID gatekeepergrid
gatekeepergrid_function
gatekeepergrid_gates
gatekeepergrid_name

Identifies the grid and
columns within each grid to
assign accessibility and
order attributes.
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Column Name Accepted Values on Upload Additional Notes

teammembergrid
teammembergrid_
createstatusreports
teammembergrid_function
teammembergrid_name
teammembergrid_primary
teammembergrid_stages

workflowactionownergrid
workflowactionownergrid_
actions
workflowactionownergrid_
function
workflowactionownergrid_
name

Accessibility Available
Unavailable

All other values are treated
as Available on upload.

Order Number Is set to the default order if no
order is provided.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Visibility Rules

Column Name Accepted Values on
Upload Additional Notes

Process
Model System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

System Name Alphanumeric
characters,
underscore**

Used for matching for upload.

If a condition rule exists, its
settings are changed with the
values in the uploaded file.

Name Any
Metric System
Name

Valid metric system
name

All other values do not assign a
metric condition.

Value String The value the metric must equal
in order to show the deliverable or
activity.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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l Layout Rules

Column Name Accepted Values on
Upload Additional Notes

Process
Model System
Name

Alphanumeric
characters, underscore**

Used for matching for upload.

If a model exists, its settings are
changed with the values in the
uploaded file.

Layout
System Name

Alphanumeric
characters, underscore**

Used for matching for upload.

If a layout exists, its settings are
changed with the values in the
uploaded file.

Role Name Valid Accolade user role Include a separate row for each
role

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Migration Maps

Accolade provides Administrators and Process Designers the ability to export migration maps
from one Accolade environment and import it into another Accolade environment. For
example, your company may have a test environment set up during your implementation, or
you may have company branches that are new to Accolade that are hosted in a separate
environment. Instead of having to recreate migration maps in each environment, download the
information and import it into the new environment.

The download exports the migration map configuration information into a spreadsheet file with
the parts grouped into tabs.

To export migration maps:

1. From the Systemmenu, select Process > Migration Maps.

2. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.

To import migration maps into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any migration maps that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Process > Migration Maps.

4. Click Upload in the top right corner of the page.
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Accolade uploads the changes to the migration maps in the spreadsheet, and adds any
new migration maps with unique system names.

5. (Optional) Click Print to print the import results for your records.

Migration Map Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each migration map in
the order listed below. For a description of each migration map setting, see the Creating
Migration Maps topic in the online Help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.
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l Migration Map

Column Name Accepted Values on
Upload* Additional Notes

Migration
Map System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a migration map exists, its settings are
changed with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new migration map is
created.

Migration
Map Name

Any If blank, the migration map does not upload.

From Model Any valid process
model name

If blank, the migration map does not upload.

To Model Any valid process
model name

If blank, the migration map does not upload.

Next Gate Any If blank, the migration map does not upload.
Retain
Project
Manager

Yes, Y, True, 1, X* All other values are treated as No on upload.

Retain
Project
Access
Group

Yes, Y, True, 1, X* All other values are treated as No on upload.

Retain
Project
Team

Yes, Y, True, 1, X* All other values are treated as No on upload.

Retain
Project
History

Yes, Y, True, 1, X* All other values are treated as No on upload.

Copy
Project
Links

Yes, Y, True, 1, X* All other values are treated as No on upload.

Close
Source
Project

Yes, Y, True, 1, X* All other values are treated as No on upload.

Active Yes, Y, True, 1, X* All other values are treated as No on upload.
Delete Yes, Y, True, 1, X* All other values are treated as No on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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Importing and Exporting Templates

Accolade provides Administrators and Process Designers the ability to export templates
configuration from one Accolade environment and import them into another Accolade
environment. For example, your company may have separate test and production
environments or company branches hosted in separate Accolade instances. Instead of having
to recreate templates in each environment, download the information and import into a
different environment.

The download exports the templates configuration information into a spreadsheet file with the
parts of the templates grouped into tabs.

To export template settings:

1. From the Systemmenu, select Page Design > Template Library.

2. Select the templates that you want to download.

To narrow the list by template name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all templates, select All.

3. Click Download in the top right corner of the page.

Accolade downloads the templates into a zip file which contains a workbook file with all
of the template system details, as well as an individual file folder containing each
template document, and saves it to a temporary internet files directory. Save the file to a
more accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import template settings into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any templates that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Page Design > Template Library.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the existing templates in the spreadsheet, and adds
any new templates with unique system names.
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7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.

Template Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the system settings for each template in
the order listed below. For a description of each template setting, see the Adding Templates to
the Template Library topic in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Template Details

Column Name Accepted Values
on Upload* Additional Notes

Template
System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a template exists, its settings are
changed with the values in the uploaded
file.

If a new, unique system name exists in the
file when uploaded, a new template is
created.

Template
Name

Any If blank, the template does not upload.

Category Alphanumeric
characters

If a new, unique category name exists in
the file when uploaded, a new category is
created.

If left blank, the template is placed in the
Default category.

Description Any Can be blank.
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Column Name Accepted Values
on Upload* Additional Notes

Type Online Form
Process
Document
Spreadsheet
Report
Presentation
Project Plan
Image
PDF, Email,
Other

If blank, the template does not upload.

Delete Yes, Y, True, 1,
X*

All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Security

Column Name Accepted Values
on Upload Additional Notes

Template
System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a template exists, its settings are changed
with the values in the uploaded file.

Access
Group

Valid access
group system
name

Include a separate row for each access
group.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Quick Grids

Accolade provides Administrators and Process Designers the ability to export quick grid
information from one Accolade environment and import it into another Accolade environment.
For example, your company may have a test environment set up during your implementation,
or you may have company branches that are new to Accolade that are hosted in a separate
environment. Instead of having to recreate quick grids in each environment, download the
information and import into the new environment.

The download exports the quick grid configuration information into a spreadsheet file with the
parts of the quick grid grouped into tabs.
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To export quick grids:

1. From the Systemmenu, select Page Design > Quick Grids.

2. In the Category field, select the category containing the quick grids you want to
download.

To narrow the list by quick grid name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all quick grids, select All.

3. Click Download in the top right corner of the page.

Accolade downloads the quick grids into a zip file which contains a workbook file with all
of the quick grid system details, as well as an individual file folder containing any related
JavaScript files, and saves it to a temporary internet files directory. Save it to a more
accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import quick grids into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any quick grids that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Page Design > Quick Grids.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the quick grids in the spreadsheet, and adds any new
quick grids with unique system names.

7. (Optional) Click Print to print the import results for your records.

To upload JavaScript files, save the JavaScript file in a folder. Match the
folder name with the quick grid system name, as defined in the
spreadsheet file for uploading the quick grids. Save the folder and the
completed upload file to a zipped folder. Upload the zipped folder to
import the quick grids and JavaScript files.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
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either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.

Quick Grid Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each quick grid in the
order listed below. For a description of quick grid settings, see the Creating Quick Grids or
Adding Software Controls and Metrics to Quick Grids topics in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Quick Grid

The Quick Grid worksheet contains the settings for the quick grids being uploaded or
downloaded.

Column Name Accepted Values on
Upload* Additional Notes

Quick Grid
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a quick grid exists, its settings
are changed with the values in the
uploaded file.

If a new, unique system name
exists in the file when uploaded, a
new quick grid is created.

Quick Grid
Name

Any If blank, the quick grid does not
upload.

Description Any Can be blank.
Quick Grid
Category

Alphanumeric
characters

If a new, unique category name
exists in the file when uploaded, a
new category is created.

If blank, the quick grid is placed in
the Default category.

Protected
Grid

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Create PDF Yes, Y, True, 1, X* All other values are treated as No
on upload.
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Column Name Accepted Values on
Upload* Additional Notes

Publish PDF Yes, Y, True, 1, X* All other values are treated as No
on upload.

Active Yes, Y, True, 1, X* All other values are treated as No
on upload.

Delete Yes, Y, True, 1, X* All other values are treated as No
on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Grid Properties

The Grid Properties worksheet contains the settings for the individual grids being
uploaded or downloaded.

Column Name Accepted Values on
Upload* Additional Notes

Quick Grid
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a quick grid exists, its settings
are changed with the values in the
uploaded file.

Quick Grid
Grid System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a grid exists, its settings are
changed with the values in the
uploaded file.

If a new, unique system name
exists in the file when uploaded, a
new grid is created.

Quick Grid
Grid Name

Any If blank, the grid does not upload.

Grid Type Matrix
Standard

If blank, the grid does not upload.

Matrix
System Name

Valid matrix system
name

IfGrid Type is selected asMatrix,
enter a valid matrix system name.

Otherwise, leave blank.
Number of
Columns

Any number The number of columns in the grid.

If blank, the grid does not upload.
Number of Any number The number of rows in the grid.
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Column Name Accepted Values on
Upload* Additional Notes

Rows If blank, the grid does not upload.
Rank Any number The order of the individual grids

within the quick grid.

If blank, the grid does not upload.
Tooltip Any Can be blank.
Show Grid
Title

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Hide Grid Yes, Y, True, 1, X* All other values are treated as No
on upload.

Collapsible Yes, Y, True, 1, X* All other values are treated as No
on upload.

Default To Collapsed
Expanded

If blank, defaults to Expanded.

Background
Color

Valid hex color code If blank, defaults to color code
#ffffff.

Border Style None
Dotted
Dashed
Solid
Double
Groove
Ridge
Inset
Outset

If blank, defaults to None.

Border Width Valid pixel values If blank, defaults to 1.
Border Color Valid hex color code If blank, defaults to color code

#ededed.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Columns

Column Name Accepted Values on
Upload Additional Notes

Quick Grid
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.
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Column Name Accepted Values on
Upload Additional Notes

If a quick grid exists, its settings are
changed with the values in the
uploaded file.

Quick Grid
Grid System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a grid exists, its settings are
changed with the values in the
uploaded file.

If a new, unique system name
exists in the file when uploaded, a
new grid is created.

Column Any number The column number must be less
than or equal to the number of
columns defined in the quick grid.

If blank, the grid does not upload.
Minimum
Width

Any number Can be blank.

Fixed Width Any number Can be blank.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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l Rows

Column Name Accepted Values on
Upload Additional Notes

Quick Grid
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a quick grid exists, its settings are
changed with the values in the
uploaded file.

Quick Grid
Grid System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a grid exists, its settings are
changed with the values in the
uploaded file.

If a new, unique system name
exists in the file when uploaded, a
new grid is created.

Row Any number The row number must be less than
or equal to the number of rows
defined in the quick grid.

If blank, the grid does not upload.
Minimum
Height

Any number Can be blank.

Fixed Height Any number Can be blank.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Cell Properties

The Cell Properties worksheet contains the settings for the individual cells being
uploaded or downloaded.

Column Name Accepted Values on
Upload* Additional Notes

Quick Grid
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a quick grid exists, its settings
are changed with the values in
the uploaded file.

Quick Grid
Grid System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a grid exists, its settings are
changed with the values in the
uploaded file.
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Column Name Accepted Values on
Upload* Additional Notes

Quick Grid
Cell System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a cell exists, its settings are
changed with the values in the
uploaded file.

If a new, unique system name
exists in the file when uploaded,
a new cell is created.

Quick Grid
Column

Any number The cell's column location within
the grid.

If blank, the cell does not upload.
Quick Grid
Row

Any number The cell's row location within the
grid.

If blank, the cell does not upload.
Column Span Any number If a merged cell, the number of

columns that the cell spans.

If blank, defaults to 1.
Row Span Any number If a merged cell, the number of

rows that the cell spans.

If blank, defaults to 1.
Control Type Aggregate

Button
Checkbox
CheckboxGroup
ComboBox
DateInput
DropdownBox
EmailTextBox
FormattedText
ListBox
MetricLabel
MultilineTextBox
NumericTextBox
PairedListBox
RadioButtonGroup
RelativeDate
RichText
TemplateImage
TextBox
UserSelector

If Aggregate, Button,
FormattedText, or
TemplateImage are selected,
the Source Type should be
defined as LocalElement.
If blank, the cell does not upload.
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Column Name Accepted Values on
Upload* Additional Notes

Source Type LocalElement
Metric
Metadata
Nothing

If Aggregate, Button,
FormattedText, or
TemplateImage are selected as
the Control Type, this must be
defined as LocalElement.
If blank, the cell does not upload.

Metadata Valid metadata
system name

If Source Type is selected as
Metadata, enter the metadata
system name.

Otherwise, leave blank.
Default Value Any Can be blank.
Tooltip Any Can be blank.
List Source Any Separate each list option by a

pipe ( | ) character.
Empty Item
Text

Any Can be blank.

Control
Width

Valid pixel values If blank, defaults to None.

Sort Ascending
Descending
NoSorting

If blank, defaults to No Sorting.

Enable
Markdown

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Link To None
Layout
Project Page
URL

If blank, defaults to None.

Link To
Destination

Valid link address Can be blank.

Link To Index Any number, up to 10
digits

Can be blank.

Open in New
Tab

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Metric Data
Type

Valid metric data type If Source Type is selected as
Metric, enter the metric's data
type.

Otherwise leave blank.
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Column Name Accepted Values on
Upload* Additional Notes

Metric
System
Name

Valid metric system
name

If Source Type is selected as
Metric, enter the metric's system
name.

Otherwise leave blank.
Size Any number If blank, defaults to 0.
Max Length Any number If blank, defaults to 0.
Prefix Any Can be blank.
Suffix Any Can be blank.
Allow
Negative

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Read Only Yes, Y, True, 1, X* All other values are treated as No
on upload.

Required Yes, Y, True, 1, X* All other values are treated as No
on upload.

User Roles Valid Accolade user
role

Separate each role by a pipe ( | )
character.

Text Any Can be blank.
Rows Any number If blank, defaults to 0.
Columns Any number If blank, defaults to 0.
Project
Image
Content

Valid image file in
Accolade

Can be blank.

Template
Image
Content

Valid image file in
Accolade

Can be blank.

Show
Remaining
Character
Count

Yes, Y, True, 1, X* All other values are treated as No
on upload.

Inline Editing Yes, Y, True, 1, X* All other values are treated as No
on upload.

Font Valid font name If blank, defaults to Noto Sans.
Font Size Valid pixel values If blank, defaults to pixel size 13.
Bold Yes, Y, True, 1, X* All other values are treated as No

on upload.
Italic Yes, Y, True, 1, X* All other values are treated as No

on upload.
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Column Name Accepted Values on
Upload* Additional Notes

Underline Yes, Y, True, 1, X* All other values are treated as No
on upload.

Text Color Valid hex color code If blank, defaults to color code
#404040.

Alignment Left
Center
Right

Top
Center
Bottom

Separate each alignment
selection with a pipe ( | )
character.

If blank, defaults to Left | Top
alignment.

Background
Color

Valid hex color code If blank, defaults to #ffffff.

Border Style None
Dotted
Dashed
Solid
Groove
Ridge
Inset
Outset

If blank, defaults to None.

Border Width Valid pixel values If blank, defaults to no
border/none.

Border Color Valid hex color code If blank, defaults to no
border/none.

Tooltip
Alignment

Top
Middle
Bottom

If blank, defaults toMiddle
alignment.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Text Conditions

The Text Conditions worksheet contains the conditional text settings for the individual
cells being uploaded or downloaded. If the quick grid does not have conditional text
settings, this worksheet can be left blank.
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Column Name Accepted Values on
Upload* Additional Notes

Quick Grid
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a quick grid exists, its settings
are changed with the values in
the uploaded file.

Quick Grid
Grid System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a grid exists, its settings are
changed with the values in the
uploaded file.

Quick Grid
Cell System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a cell exists, its settings are
changed with the values in the
uploaded file.

RGB Valid hex color code If blank, the condition does not
upload.

Compare
Type

Equal
GreaterThan
GreaterThanOrEqual
LessThan
LessThanOrEqual
NotEqual

If blank, the condition does not
upload.

Value Any If blank, the condition does not
upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Border Conditions

The Border Conditions worksheet contains the settings for the individual cells being
uploaded or downloaded. If the quick grid does not have conditional border settings, this
worksheet can be left blank.

Column Name Accepted Values on
Upload* Additional Notes

Quick Grid
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a quick grid exists, its settings
are changed with the values in
the uploaded file.

Quick Grid
Grid System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.
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Column Name Accepted Values on
Upload* Additional Notes

If a grid exists, its settings are
changed with the values in the
uploaded file.

Quick Grid
Cell System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a cell exists, its settings are
changed with the values in the
uploaded file.

RGB Valid hex color code If blank, the condition does not
upload.

Compare
Type

Equal
GreaterThan
GreaterThanOrEqual
LessThan
LessThanOrEqual
NotEqual

If blank, the condition does not
upload.

Value Any If blank, the condition does not
upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Background Conditions

The Background Conditions worksheet contains the settings for the individual cells
being uploaded or downloaded. If the quick grid does not have conditional background
settings, this worksheet can be left blank.

Column Name Accepted Values on
Upload* Additional Notes

Quick Grid
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a quick grid exists, its settings
are changed with the values in
the uploaded file.

Quick Grid
Grid System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a grid exists, its settings are
changed with the values in the
uploaded file.

Quick Grid
Cell System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a cell exists, its settings are
changed with the values in the
uploaded file.
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Column Name Accepted Values on
Upload* Additional Notes

RGB Valid hex color code If blank, the condition does not
upload.

Compare
Type

Equal
GreaterThan
GreaterThanOrEqual
LessThan
LessThanOrEqual
NotEqual

If blank, the condition does not
upload.

Value Any If blank, the condition does not
upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups

Column Name Accepted Values on
Upload Additional Notes

Quick Grid
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a quick grid exists, its settings are
changed with the values in the
uploaded file.

Access
Group

Valid access group
system name

Include a separate row for each
access group.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing Matrix Grids

Matrix grids will be included in the import or export data; however, the matrix and its metrics
are not imported or exported with the quick grid. You will need to import the matrix and its
metrics on the import server before importing the quick grid. The matrix and metrics should
have the same system names as they had on the export server.

If a matrix grid is imported onto a server that does not have the matrix or metrics loaded, the
metrics are removed from the grid cells. You will need to re-associate them with the grid
columns after the matrix and metrics are created on the import server.

Notes:
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l Before importing a quick grid, make sure that all related metrics have been
imported. A quick grid's metrics are not imported along with the grid, so the
metrics must be imported independently.

Importing and Exporting Workflows

Accolade provides Administrators and Process Designers the ability to export workflows from
one Accolade environment and import it into another Accolade environment. For example,
your company may have a test environment set up during your implementation, or you may
have company branches that are new to Accolade that are hosted in a separate environment.
Instead of having to recreate workflows in each environment, download the information and
import it into the new environment.

The download exports the workflow configuration information into a spreadsheet file with the
parts grouped into tabs.

To export workflows:

1. From the Systemmenu, select Process > Workflows.

2. Select the workflows that you want to download.

To narrow the list by workflow name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

3. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import workflows into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any workflows that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Security & Groups > Workflows.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the workflows in the spreadsheet, and adds any new
workflows with unique system names.
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7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.

Workflow Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each workflow in the
order listed below. For a description of each workflow setting, see the Creating Workflows
topic in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Details

Column Name Accepted Values on
Upload* Additional Notes

Workflow
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.

If a new, unique system name exists in
the file when uploaded, a new workflow
is created.

Workflow
Name

Any If blank, the workflow does not upload.

Description Any Can be blank.
Category Alphanumeric

characters
If a new, unique category name exists in
the file when uploaded, a new category
is created.

If left blank, the workflow is placed in the
Default category.

Active Yes, Y, True, 1, X* All other values are treated as No on
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Users
cannot own
multiple
actions

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

The workflow cannot be deleted if in
use.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Start Conditions

Start conditions are optional when importing workflows. The worksheet must be
included in the spreadsheet file, and has the following guidelines:

l If the workflows have new start condition requirements, enter the new
information to upload.

l If the workflows have existing start condition requirements that are not being
changed, leave the existing information in the spreadsheet. Clearing out the
information will cause the upload to delete the requirement.

l If the workflows do not have start condition requirements, the worksheet can be
left blank.

Column
Name

Accepted Values on
Upload Additional Notes

Workflow
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.

Metric
System
Name

Valid metric
system name

If blank, the start condition requirement
does not upload.

Start condition requirements
can include multiple metrics.
Enter a separate row for each
metric being added.
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Column
Name

Accepted Values on
Upload Additional Notes

Metric
Value

Valid metric value Ensure the value entered here is
appropriate for the metric type. For
example, a Date metric should have a
date as a value.

If blank, the start condition requirement
does not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Migration Map Rules

Migration maps are optional when importing workflows. The worksheet must be
included in the spreadsheet file, but can be left blank if the workflows do not have
migration map requirements.

Column Name Accepted Values on
Upload* Additional Notes

Workflow
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.

Rule
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.

If a new, unique system name exists in
the file when uploaded, a new rule is
created.

Rule Name Any If blank, the rule does not upload.
Map System
Name

Valid migration map
system name

If blank, the rule does not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Migration Map Rule Conditions

Migration maps are optional when importing workflows. The worksheet must be
included in the spreadsheet file, and has the following guidelines:

l If the workflows have new migration map condition requirements, enter the new
information to upload.
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l If the workflows have existing migration map condition requirements that are not
being changed, leave the existing information in the spreadsheet. Clearing out
the information will cause the upload to delete the requirement.

l If the workflows do not have migration map condition requirements, the
worksheet can be left blank.

Column
Name

Accepted Values on
Upload Additional Notes

Workflow
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.

Rule
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.

If a new, unique system name exists in
the file when uploaded, a new rule is
created.

Map
System
Name

Valid migration
map system name

If blank, the migration map condition
requirement does not upload.

Metric
System
Name

Valid metric
system name

If blank, the migration map condition
requirement does not upload.

Migration map condition
requirements can include
multiple metrics. Enter a
separate row for each metric
being added.

Metric
Value

Valid metric value Ensure the value entered here is
appropriate for the metric type. For
example, a Date metric should have a
date as a value.

If blank, the migration map condition
requirement does not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Steps
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Column
Name

Accepted Values on
Upload* Additional Notes

Workflow
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.

Step
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a step exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in
the file when uploaded, a new step is
created.

The Step and Automated Step
system names must be unique
within their related workflow.

Step Name Any If blank, the step does not upload.
Proceed
after 1
decision

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Order Any number The field is set to 0 on upload if no value is
entered or the value is not a number.

The Step and Automated Steps
order values must be unique
within their related workflow.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Action

Column Name Accepted Values on
Upload* Additional Notes

Workflow
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the
uploaded file.
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Column Name Accepted Values on
Upload* Additional Notes

Action
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow step exists, its settings are
changed with the values in the
uploaded file.

If a new, unique system name exists in
the file when uploaded, a new action is
created.

Action Name Any If blank, the action does not upload.
Step System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a step exists, its settings are changed
with the values in the uploaded file.

Description Any Can be blank.
Function Valid function

system name
If Function is defined, Enforce on
User Selection should be set to Yes.
Can be blank.

Enforce On
User
Selection

Yes, Y, True, 1, X* If Yes is selected, Functionmust be
defined.

All other values are treated as No on
upload.

Owner Valid Accolade user Can be blank.
Permissions Can Approve

Can Edit
Can Edit and
Publish

If blank, the action does not upload.

Can Skip Yes, Y, True, 1, X* All other values are treated as No on
upload.

Auth Req Yes, Y, True, 1, X* All other values are treated as No on
upload.

# Days Any number The field is set to 0 on upload if no value
is entered or the value is not a number.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Action Conditions

Action conditions are optional when importing workflows. The worksheet must be
included in the spreadsheet file, and has the following guidelines:
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l If the workflows have new action condition requirements, enter the new
information to upload.

l If the workflows have existing action condition requirements that are not being
changed, leave the existing information in the spreadsheet. Clearing out the
information will cause the upload to delete the requirement.

l If the workflows do not have action condition requirements, the worksheet can be
left blank.

Column
Name

Accepted Values on
Upload Additional Notes

Workflow
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.

Step
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a step exists, its settings are changed
with the values in the uploaded file.

Action
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If an action exists, its settings are
changed with the values in the uploaded
file.

Metric
System
Name

Valid metric
system name

If blank, the action condition requirement
does not upload.

Action condition requirements
can include multiple metrics.
Enter a separate row for each
metric being added.

Metric
Value

Valid metric value Ensure the value entered here is
appropriate for the metric type. For
example, a Date metric should have a
date as a value.

If blank, the action condition requirement
does not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Automated Step

Automated steps are optional when importing workflows. The worksheet must be
included in the spreadsheet file, but can be left blank if the workflows do not have
automated steps.
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Column Name Accepted Values on Upload Additional Notes

Workflow
System
Name

Alphanumeric characters,
underscore**

Used for matching for
upload.

If a workflow exists, its
settings are changed with
the values in the uploaded
file.

Step
System
Name

Alphanumeric characters,
underscore**

Used for matching for
upload.

If an automated step exists,
its settings are changed
with the values in the
uploaded file.

If a new, unique system
name exists in the file when
uploaded, a new
automated step is created.

The Step and
Automated Step
system names
must be unique
within their
related workflow.

Step Name Any If blank, the step does not
upload.

Automated
Action
System
Name

Alphanumeric characters,
underscore**

Used for matching for
upload.

If an automated action
exists, its settings are
changed with the values in
the uploaded file.

If a new, unique system
name exists in the file when
uploaded, a new
automated action is
created.

Automated
Action Type

CreatePDF
PublishLatestDocumentVersion
SetGateDate
SetGateDecision

If blank, the automated
action does not upload.
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Column Name Accepted Values on Upload Additional Notes

Template
Source

DeliverableTemplate
WorkflowTemplate

If Automated Action Type
is selected as CreatePDF,
a value must be entered.
Use DeliverableTemplate
as the template source for
both deliverables and
activities.

Otherwise leave blank.
Order Any number The field is set to 0 on

upload if no value is
entered or the value is not a
number.

The Step and
Automated Steps
order must be
unique within
their related
workflow.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Automated Action Conditions

Automated action conditions are optional when importing workflows. The worksheet
must be included in the spreadsheet file, and has the following guidelines:

l If the workflows have new automated action condition requirements, enter the
new information to upload.

l If the workflows have existing automated action condition requirements that are
not being changed, leave the existing information in the spreadsheet. Clearing
out the information will cause the upload to delete the requirement.

l If the workflows do not have automated action condition requirements, the
worksheet can be left blank.

Column
Name

Accepted Values on
Upload Additional Notes

Workflow
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.
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Column
Name

Accepted Values on
Upload Additional Notes

Step
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a step exists, its settings are changed
with the values in the uploaded file.

Metric
System
Name

Valid metric
system name

If blank, the automated action condition
requirement does not upload.

Automated action condition
requirements can include
multiple metrics. Enter a
separate row for each metric
being added.

Metric
Value

Valid metric value Ensure the value entered here is
appropriate for the metric type. For
example, a Date metric should have a
date as a value.

If blank, the automated action condition
requirement does not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Automated Gate Decision Rules

Automated gate decisions are optional when importing workflows. The worksheet must
be included in the spreadsheet file, and has the following guidelines:

l If the workflows have new automated gate decision condition requirements,
enter the new information to upload.

l If the workflows have existing automated gate decision condition requirements
that are not being changed, leave the existing information in the spreadsheet.
Clearing out the information will cause the upload to delete the requirement.

l If the workflows do not have automated gate decision condition requirements,
the worksheet can be left blank.

Column Name Accepted Values on
Upload Additional Notes

Workflow
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.
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Column Name Accepted Values on
Upload Additional Notes

Step System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a step exists, its settings are changed
with the values in the uploaded file.

Automated
Gate
Decision
Rule

Go
Kill
Hold
Recycle
Pending Decision

If Automated Action Type on the
Automated Step worksheet is selected
as SetGateDecision, a value must be
entered.

Otherwise leave blank.
Metric
System
Name

Valid metric system
name

If blank, the decision rule condition
requirement does not upload.

Metric Value Valid metric value Ensure the value entered here is
appropriate for the metric type. For
example, a Date metric should have a
date as a value.

If blank, the decision rule condition
requirement does not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups

Column Name Accepted Values on
Upload Additional Notes

Workflow
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a workflow exists, its settings are
changed with the values in the uploaded
file.

Access
Group

Valid access group
system name

Include a separate row for each access
group.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Layouts

Accolade provides Administrators and Process Designers the ability to export layouts from one
Accolade environment and import it into another Accolade environment. For example, your
company may have a test environment set up during your implementation, or you may have
company branches that are new to Accolade that are hosted in a separate environment.
Instead of having to recreate layouts in each environment, download the information and
import it into the new environment.
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The download exports the layout configuration information including all pods and layout
settings into a spreadsheet file with the parts grouped into tabs.

When importing layouts into Accolade, the thumbnail image for a layout
displays with the message "No Image Available." All updated pods and
layout settings are saved. Click to edit the layout to view the pods and
settings. Saving and closing the layout regenerates a corresponding
thumbnail image.

To export layout settings and pods:

1. From the Systemmenu, select Page Design > Layouts.

2. Select the layouts that you want to download.

To narrow the list by layout name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all layouts, select All.

3. Click Download in the top right corner of the page.

Accolade downloads the layouts into a zip file which contains a workbook file with all of
the layout system details, as well as an individual file folder containing any related
JavaScript and HTML files, and saves it to a temporary internet files directory. Save the
file to a more accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import layout settings and pods into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any layouts that you do not want to include in the upload from the spreadsheet
and save the file.

3. From the Systemmenu, select Page Design > Layouts.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the existing layouts in the spreadsheet, and adds any
new layouts with unique system names.

7. (Optional) Click Print to print the import results for your records.
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To upload JavaScript files and HTML files, save the JavaScript or HTML
file in a folder. Match the folder name with the Advanced Platform pod
system name, as defined in the spreadsheet file for uploading the layouts
and pods. Save the folder and the completed upload file to a zipped
folder. Upload the zipped folder to import the layouts and pods, and
JavaScript and HTML files to their associated Advanced Platform pods.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.

Layout Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each layout in the order
listed below. For a description of layout settings and pod types, see the Creating Page Layouts
and/or Available Pod Types topics in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Layouts

The Layouts worksheet contains the settings for the layouts being uploaded or
downloaded.

Column Name Accepted Values on
Upload* Additional Notes

System Name Alphanumeric
characters,
underscore**

Used for matching for upload.

If a layout exists, its settings are
changed with the values in the
uploaded file.

If a new, unique system name
exists in the file when uploaded,
a new layout is created.

Display Name Any If blank, the layout does not
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Active Yes, Y, True, 1, X* All other values are treated as
No on upload.

Description Any Can be blank.
Category Alphanumeric

characters
If a new, unique category name
exists in the file when uploaded,
a new category is created.

If blank, the layout is placed in
the Default category.

Order Any number The field is set to 0 on upload if
no value is entered or the value
is not a number.

Project Header
Visible

Yes, Y, True, 1, X* All other values are treated as
No on upload.

Process
Graphic
Visible

Yes, Y, True, 1, X* All other values are treated as
No on upload.

Horizontal
Alignment

Left
Center
Right

If blank, the layout uploads with
the default of Left.

Background
Color

Valid hex color code Can be blank and defaults to
color code #fffff.

Margin Color Valid hex color code Can be blank and defaults to
color code #fffff.

Page Width Valid pixel values Can be blank in which the layout
uploads with the default of left
aligned.

Icon Valid alphanumeric
icon id

If blank, the layout does not
upload. Icon id value displays in
icon selection dialog when
creating layouts.

Has Master
Button

Yes, Y, True, 1, X* All other values are treated as
No on upload.

Layout Filters Yes, Y, True, 1, X* All other values are treated as
No on upload.

Fill Remaining
Height

Yes, Y, True, 1, X* All other values are treated as
No on upload.

Add to New
Gated Process
Models

Yes, Y, True, 1, X* All other values are treated as
No on upload.
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Column Name Accepted Values on
Upload* Additional Notes

Add to New
Non-Gated
Process
Models

Yes, Y, True, 1, X* All other values are treated as
No on upload.

Add to New
Idea Process
Models

Yes, Y, True, 1, X* All other values are treated as
No on upload.

Hide Action
Menu

Yes, Y, True, 1, X* Applies to idea models only.
All other values are treated as
No on upload.

Generate
Global Link

Yes, Y, True, 1, X* All other values are treated as
No on upload.

Configuration
Access
Groups

Valid access group
display name

Separate each access group
name using the pipe ( | )
character.

Layout Cycles Yes, Y, True, 1, X* All other values are treated as
No on upload.

Icon Color Valid hex color
codes: #932121,
#C76614, #10611E,
#36297B, #A21E79,
#417491 (blue,
default)

All other values including blank
are treated as #417491 on
upload.

Hide Hierarchy Yes, Y, True, 1, X* All other values are treated as
No on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Pods

The Pods worksheet includes the individual pods and pod settings within the layouts
being uploaded or downloaded.
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Column
Name

Accepted
Values on
Upload*

Additional Notes

Layout
System
Name

Alphanume
ric
characters,
underscor
e**

Used for matching for upload.

If a layout exists, its settings are changed with the
values in the uploaded file.

System
Name

Valid pod-
specific
system
name

Used for matching on upload.

If a pod exists, its settings are changed with the
values in the uploaded file.

If a new, unique system name exists in the file
when uploaded, a new pod is created and added
to the layout.

Name Any Can be blank.
Type AdvancedP

latform
Buttons
Chart
Documents
Gates
GlobalLinks
HTMLRepo
rt
Metric
PlanningVi
ew
Plugin
PortfolioOpt
imization
Productivity
ProjectIma
ge
ProjectInfor
mation
QuickGrids
Report
ReportGrou
ps
TemplateIm
age
Voting

If a layout contains the Advanced Platform pod,
Accolade downloads the JavaScript files and
HTML files in individual file folder along with the
spreadsheet file.

Long string metrics with the Rich Text check box
enabled are not supported in pods and cannot be
imported.

Can be blank.
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Column
Name

Accepted
Values on
Upload*

Additional Notes

Conten
t

Valid pod
content
name

Do not include spaces between words and the
content must be appropriate for the pod Type.
Can be blank.

X Integer
value
greater than
or equal to 0

Determines where the pod displays horizontally
in the layout.

Coordinates (0,0) correlate to the top left corner
of the layout.

Y Integer
value
greater than
or equal to 0

Determines where the pod displays vertically in
the layout.

Coordinates (0,0) correlate to the top left corner
of the layout.

Height Integer
value
greater than
0

If blank or invalid, the pod does not upload.

Width Integer
value
greater than
0

If blank or invalid, the pod does not upload.

Advan
ced
Setting
s

A valid
expression

Applies to pods with advanced settings.

For example, note a Data Form pod with Project
Name, Project ID, and Description selected and
one column defined in the advanced settings as
follows:

{"Columns":1,"Items":[

{"Order":null,"IsReadOnly":false,"ObjectTypeID":
2,"SystemName":"ProjectName"},
{"Order":null,"IsReadOnly":false,"ObjectTypeID":
2,"SystemName":"Description"},
{"Order":null,"IsReadOnly":false,"ObjectTypeID":
2,"SystemName":"ProjectId"}]}

If the expression is invalid, the row does not
upload.

Plugin
Type

Valid
configured
plugin name

This setting only applies for pods containing
plugins.
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Column
Name

Accepted
Values on
Upload*

Additional Notes

Filter
To
Project

Yes, Y,
True, 1, X*

This setting only applies to global link and
planning view pods.

All other values are treated as No on upload.

Title

Text
Alignm
ent

left
right
center

If blank, the pod uploads with the default of left
aligned.

Font
Color

Valid hex
color code

If blank, defaults to color code #fffff.

Font
Size

Valid pixel
values

If blank, defaults to a pixel size 11.

Content

Font
Color

Valid hex
color code

If blank, defaults to color code #fffff.

Font
Size

Valid pixel
values

If blank, defaults to a pixel size 11.

Backgr
ound
Color

Valid hex
color code

If blank, defaults to color code #fffff.

Vertical
Bar
color

Valid hex
color code

If blank, defaults to color code #054353.

Border

Size Valid pixel
values

If blank, defaults to a pixel size 11.

Style none
dotted
dashed
solid
groove
ridge
inset
outset

If blank, defaults to solid.

Color Valid hex
color code

If blank, defaults to color code #fffff.
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Column
Name

Accepted
Values on
Upload*

Additional Notes

Allow
Maximi
zation

Yes, Y,
True, 1, X*

All other values are treated as No on upload.

Compa
rison
Set
System
Name

Valid
comparison
set system
name

Can be blank.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Comparison Set

The Comparison Set worksheet includes the comparison set settings within the layouts
being uploaded or downloaded. This worksheet must be included in the spreadsheet
file, but can be left blank if the layouts do not include comparison sets.

Column Name Accepted Values on
Upload* Additional Notes

Layout
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a layout exists, its settings are
changed with the values in the
uploaded file.

Comparison
Set System
Name

Valid comparison
set system name

Used for matching on upload.

If a pod exists, its settings are
changed with the values in the
uploaded file.

If a new, unique system name
exists in the file when uploaded, a
new set is created and added to
the layout.

Comparison
Set Name

Any If blank, the set does not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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Importing and Exporting Reference Tables

Accolade provides Administrators and Process Designers the ability to export reference tables
configuration from one Accolade environment and import them into another Accolade
environment. For example, your company may have separate test and production
environments or company branches hosted in separate Accolade instances. Instead of having
to recreate reference tables in each environment, download the information and import into a
different environment.

The download exports the reference tables configuration information into a spreadsheet file
with the parts of the templates grouped into tabs.

To download reference table settings:

1. From the Systemmenu, select Content Sources > Reference Tables.

2. Select the reference tables you want to download.

To narrow the list by reference table name or system name, add the criteria to filter by in
the appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all reference tables, select All.

3. Click Download in the top right corner of the page.

Accolade downloads the reference tables into a zip file which contains a workbook file
with all of the reference table system details, as well as an individual file folder
containing each reference table spreadsheet, and saves it to a temporary internet files
directory. Save the file to a more accessible location.

Note: The individual reference table spreadsheets ONLY contain column
information required for the table configuration. The reference table data files
must be downloaded and moved to the new environment manually.

To import reference table settings into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any reference tables that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Content Sources > Reference Tables.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the existing reference tables in the spreadsheet, and
adds any new reference tables with unique system names.

7. (Optional) Click Print to print the import results for your records.
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Reference Table Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the system settings for each reference
table in the order listed below. For a description of each reference table setting, see the Adding
Reference Tables topic in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Reference Table

Column Name Accepted Values
on Upload* Additional Notes

Reference
Table
System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a reference table exists, its settings are
changed with the values in the uploaded
file.

If a new, unique system name exists in the
file when uploaded, a new reference table
is created.

Reference
Table
Display
Name

Any If blank, the reference table does not
upload.

Unique
Values in
First Column

Yes, Y, True, 1,
X*

All other values are treated as No on
upload.

Description Any Can be blank.
Category Alphanumeric

characters
If a new, unique category name exists in the
file when uploaded, a new category is
created.

If left blank, the reference table is placed in
the Default category.

Owner Valid user
system ID

Use the format with which the user accessed
Accolade, such as domain\username or
username@domain.com.

If blank, the owner defaults to None.
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Column Name Accepted Values
on Upload* Additional Notes

Access
Group

Valid access
group system
name

Include a separate row for each access
group.

Available to
Metrics

Yes, Y, True, 1,
X*

All other values are treated as No on
upload.

Available to
Reporting

Yes, Y, True, 1,
X*

All other values are treated as No on
upload.

Available to
Portfolio
Optimizer

Yes, Y, True, 1,
X*

All other values are treated as No on
upload.

Maximum
Number of
Versions

Any number If blank, defaults to unlimited.

Enable
Automatic
Loading

Yes, Y, True, 1,
X*

All other values are treated as No on
upload.

Automatic
Load
Schedule
Hours

Valid hour in 24-
hour time format

If Enable Automatic Loading is defined
as Yes, a value can be entered or this field
can be left blank. If blank, defaults to Load
immediately.
If Enable Automatic Loading is defined
as No, leave blank.

Automatic
Load
Schedule
Minutes

Valid minutes in
24-hour time
format

If Enable Automatic Loading is defined
as Yes, a value can be entered or this field
can be left blank. If blank, defaults to Load
immediately.
If Enable Automatic Loading is defined
as No, leave blank.

Delete Yes, Y, True, 1,
X*

All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Column Definition

561



Chapter 7  Importing Project Data and Configuration

Administrator's Guide

Column Name Accepted Values
on Upload Additional Notes

Reference
Table
System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a reference table exists, its settings are
changed with the values in the uploaded
file.

Column
System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a column exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new reference table is
created.

Column
Display
Name

Any Used for matching in the upload.

Number
Format

Alphanumeric
characters

Can be blank.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups

Column Name Accepted Values
on Upload Additional Notes

Reference
Table
System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a reference table exists, its settings are
changed with the values in the uploaded
file.

Access
Group

Valid access
group system
name

Include a separate row for each access
group.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Access Groups

Accolade provides Administrators and Process Designers the ability to export access groups
from one Accolade environment and import it into another Accolade environment. For
example, your company may have a test environment set up during your implementation, or
you may have company branches that are new to Accolade that are hosted in a separate
environment. Instead of having to recreate access groups in each environment, download the
information and import it into the new environment.
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The download exports the access groups configuration information into a spreadsheet file with
the parts grouped into tabs.

To export access groups:

1. From the Systemmenu, select Security & Groups > Access Groups.

2. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.

To import access groups into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any access groups that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Security & Groups > Access Groups.

4. Click Upload in the top right corner of the page.

Accolade uploads the changes to the access groups in the spreadsheet, and adds any
new access groups with unique system names.

5. (Optional) Click Print to print the import results for your records.

Access Groups Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each access group in the
order listed below. For a description of each access group setting, see the Creating Access
Groups topic in the online Help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.
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l Access Group

Column
Name

Accepted Values on
Upload* Additional Notes

Access
Group
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If an access group exists, its settings are
changed with the values in the uploaded
file.

If a new, unique system name exists in
the file when uploaded, a new access
group is created.

Access
Group
Name

Any If blank, the access group does not
upload.

Parent
Access
Group
System
Name

Any If blank, the access group does not
upload.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Security Profiles

Accolade provides Administrators and Process Designers the ability to export security profiles
from one Accolade environment and import it into another Accolade environment. For
example, your company may have a test environment set up during your implementation, or
you may have company branches that are new to Accolade that are hosted in a separate
environment. Instead of having to recreate security profiles in each environment, download the
information and import it into the new environment.

The download exports the security profiles configuration information into a spreadsheet file
with the parts grouped into tabs.

To export security profiles:

1. From the Systemmenu, select Security & Groups > Security Profiles.

2. Select the security profiles you want to download.

To narrow the list by category, select a category to display in the Category list. To
download all security profiles, select All.
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3. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.

To import security profiles into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any security profiles that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Security & Groups > Security Profiles.

4. Click Upload in the top right corner of the page.

Accolade uploads the changes to the security profiles in the spreadsheet, and adds any
new security profiles with unique system names.

5. (Optional) Click Print to print the import results for your records.

Security Profiles Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each security profile in
the order listed below. For a description of each security profile setting, see the Creating
Security Profiles topic in the online Help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Security Profile Summary

Column Name Accepted Values on
Upload* Additional Notes

Security
Profile
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a security profile exists, its settings are
changed with the values in the uploaded
file.

If a new, unique system name exists in
the file when uploaded, a new security
profile is created.

Security
Profile Name

Any If blank, the security profile does not
upload.

Description Any Can be blank.
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Column Name Accepted Values on
Upload* Additional Notes

Category Alphanumeric
characters

If a new, unique category name exists in
the file when uploaded, a new category
is created.

Visible Yes, Y, True, 1, X* All other values are treated as No on
upload.

Order Any number The field is set to 0 on upload if no value
is entered or the value is not a number.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Classes

Column
Name

Accepted Values on
Upload* Additional Notes

Security
Profile
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a security profile exists, its settings are
changed with the values in the uploaded
file.

Class Valid class system
name

Include separate row for each class. To
allow access to all classes, leave this
worksheet blank.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Metrics

Column Name Accepted Values on
Upload* Additional Notes

Security
Profile
System

Alphanumeric
characters,
underscore**

Used for matching for upload.
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Column Name Accepted Values on
Upload* Additional Notes

Name If a security profile exists, its settings are
changed with the values in the uploaded
file.

Metric
System
Name

Valid metric system
name

Must be a List, Multi-Select List, or String
type and be associated with at least one
model in a class selected in the security
profile.

Metric
Value

Any

Metric
Extended
Access

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Functional Areas and Functions

Accolade provides Administrators and Process Designers the ability to export functional areas
and functions configuration from one Accolade environment and import it into another
Accolade environment. For example, your company may have a test environment set up
during your implementation, or you may have company branches that are new to Accolade
that are hosted in a separate environment. Instead of having to recreate functional areas and
functions in each environment, download the information and import it into the new
environment.

The download exports the functional areas and functions configuration information into a
spreadsheet file with the parts of the functions grouped into tabs.

To export functional areas and functions:

1. From the Systemmenu, select Security & Groups > Functions.

2. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
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in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import functional areas and functions into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any functional areas and functions that you do not want to include in the upload
from the spreadsheet and save the file.

3. From the Systemmenu, select Security & Groups > Functions.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the functional areas and functions in the spreadsheet,
and adds any new functional areas and functions with unique system names.

7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.

Functional Areas and Functions Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each functional area and
function in the order listed below. For a description of each function setting, see the Creating
Functional Areas and Functions topic in the online Help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Functional Areas
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Column Name Accepted Values on
Upload* Additional Notes

Functional
Area System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a functional area exists, its settings are
changed with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new functional area is
created.

Function
Area Name

Any If blank, the functional area does not upload.

Order Any number The field is set to 0 on upload if no value is
entered or the value is not a number.

Delete
Functional
Area

Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Functions

Column Name Accepted Values on
Upload* Additional Notes

Functional
Area System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a functional area exists, its settings are
changed with the values in the uploaded file.

Function
System
Name

Alphanumeric
characters,
underscore**

Must be unique. If blank, the function does
not upload.

Function
Name

Any If blank, the function does not upload

Active Yes, Y, True, 1, X* All other values are treated as No on
upload.

Order Any number The field is set to 0 on upload if no value is
entered or the value is not a number.

Merge To
Functional
System
Name

Alphanumeric
characters,
underscore**

Used for merging functions. Enter the
system name of the function being merged
to. See "Merging Functions Together" on
page 114.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.
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* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups

Column Name Accepted Values on
Upload Additional Notes

Function
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a function exists, its settings are changed
with the values in the uploaded file.

Access
Groups

Valid access group
system name

Include a separate row for each access
group.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Members

Column Name Accepted Values on
Upload Additional Notes

Function
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a function exists, its settings are changed
with the values in the uploaded file.

Members Valid user system
ID

Use the format with which the user accessed
Accolade, such as domain\username or
username@domain.com.

Include a separate row for each member.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Accolade Charts

Accolade provides Administrators and Process Designers the ability to export charts settings
and configuration from one Accolade environment and import them into another Accolade
environment. For example, your company may have separate test and production
environments or company branches hosted in separate Accolade instances. Instead of having
to recreate online charts in each environment, download the information and import into a
different environment.

The download exports the chart configuration information into a spreadsheet file with the parts
of the charts grouped into tabs.
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To export chart settings:

1. From the Systemmenu, select Content Source > Charts & Reports Manager.

2. Select the charts and reports that you want to download.

To narrow the list by chart name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all charts and reports, select All.

3. Click Download in the top right corner of the page.

Accolade downloads all configured charts and reports in four separate spreadsheet
files within a zip file, and saves it to a temporary internet files directory. Charts settings
are downloaded to a workbook titled CHART_Workbook.xlsx and reports are
downloaded separately in a workbook titled RPT_Workbook.xlsx. Save the file to a
more accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import chart settings into Accolade:

Important! In order to successfully import a chart, the report source the chart is
built upon must exist in the environment prior to upload.

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any charts that you do not want to include in the upload from the spreadsheet
and save the file.

3. From the Systemmenu, select Content Source > Charts & Reports Manager.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load. The file name must be prefixed
with 'CHART_' in order to successfully upload.

6. Click Upload File.

Accolade uploads the changes to the existing charts in the spreadsheet, and adds any
new charts with unique system names.

7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
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may result in warning or error messages during the upload, and may result in
an incomplete upload.

Chart Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each chart in the order
listed below. For a description of each chart setting, see the individual chart topic links in in the
Creating Charts from Report Data Overview topic in the online Help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l General Settings

The General Settings worksheet contains the settings for all charts being imported. The
columns correlate to the specific chart configuration fields upon chart creation.

Column
Name Accepted Values on Upload* Additional Notes

System
Name

Alphanumeric characters, underscore** Used for matching
in the upload.

If a chart exists, its
settings are
changed with the
values in the
uploaded file.

If a new, unique
system name
exists in the file
when uploaded, a
new chart is
created.

Name Any If blank, the chart
does not upload.
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Column
Name Accepted Values on Upload* Additional Notes

Chart
Type

Sopheon.Accolade.Models.Domain.Charts.Bar
Chart
Sopheon.Accolade.Models.Domain.Charts.Bub
bleChart
Sopheon.Accolade.Models.Domain.Charts.Gro
upedBarChart
Sopheon.Accolade.Models.Domain.Charts.Line
ChartByColumns
Sopheon.Accolade.Models.Domain.Charts.Line
ChartTrends
Sopheon.Accolade.Models.Domain.Charts.Pie
Chart
Sopheon.Accolade.Models.Domain.Charts.Stac
kedBarChart
Sopheon.Accolade.Models.Domain.Charts.Rad
arChart

If blank, the chart
does not upload.

Report
Source

Valid online report system name If blank, the chart
does not upload.

Display
Title

Yes, Y, True, 1, X* All other values are
treated as No on
upload.

Category Alphanumeric characters If a new, unique
category name
exists in the file
when uploaded, a
new category is
created.

If left blank, the
chart is placed in
the Default
category.

Descriptio
n

Any Can be blank.
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Column
Name Accepted Values on Upload* Additional Notes

Owners Valid user system ID Use the format
with which the user
accessed
Accolade, such as
domain\username
or
username@domai
n.com. Separate
each additional
owner with a pipe ( 
| ) character.

If blank, the chart
does not upload.

Roles Valid Accolade user role Separate each role
with a pipe ( | )
character.

Can be blank.
Available
to Charts
& Reports

Yes, Y, True, 1, X* All other values are
treated as No on
upload.

Available
to
Configura
tion

Yes, Y, True, 1, X* All other values are
treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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l Bar Chart

The Bar Chart worksheet contains the settings for the bar charts being imported. The
columns correlate to the specific bar chart configuration fields.

Column Name Accepted Values on
Upload* Additional Notes

System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a chart exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new chart is created.

Grouping Valid report column
system name

If blank, the chart does not upload.

Display
Grouping
Axis Label

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Bar Valid report column
system name

If blank the chart does not upload.

Display Bar
Axis Label

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Show Grid
Lines

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Display
Type

Vertical
Horizontal

If blank, the value defaults to Vertical on
upload.

Rotate
Horizontal
Axis Text

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Color
Theme

Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on
upload.

Target Line
Report
Source

Valid online report
system name

Can be blank.

Target Line
Report Key

Valid report column
system name

Can be blank.

Target Line
Report
Value

Valid report column
system name

Can be blank.
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Column Name Accepted Values on
Upload* Additional Notes

Number
Format
Horizontal
Axis

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

Number
Format Bars

#;(#)
#,###;(#,###)
$#,###;($#,###)

Indicates how values within the chart are
displayed.

If blank, the value defaults to #;(#) on
upload.

Display
Totals

Vertical
Horizontal

Can be blank.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Pie Chart

The Pie Chart worksheet contains the settings for the pie charts being imported. The
columns correlate to the specific pie chart configuration fields.

Column Name Accepted Values on
Upload* Additional Notes

System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a chart exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new chart is created.

Slice
Represents

Valid report column
system name

If blank, the chart does not upload.

Slice Size Valid report column
system name

If blank, the chart does not upload.

Slice Name Yes, Y, True, 1, X* All other values are treated as No on
upload.

Slice Value Yes, Y, True, 1, X* All other values are treated as No on
upload.

Slice
Percentage

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Doughnut Yes, Y, True, 1, X* All other values are treated as No on
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Exploded Yes, Y, True, 1, X* All other values are treated as No on
upload.

Number
Format

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

Color Theme Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on
upload.

Legend None
Right
Left

If blank, the value defaults to None on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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l Bubble Chart

The Bubble Chart worksheet contains the settings for the bubble charts being imported.
The columns correlate to the specific bubble chart configuration fields.

Column Name Accepted Values on
Upload* Additional Notes

System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a chart exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new chart is created.

Horizontal
Axis

Valid report column
system name

If blank, the chart does not upload.

Display
Horizontal
Axis Label

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Show
Horizontal
Grid Lines

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Rotate
Horizontal
Axis Text

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Horizontal
Axis Scale

Automatic
Custom

If blank, defaults to Automatic.

Horizontal
Axis Range
Min

Any number If Horizontal Axis Scale is defined as
Custom, enter a value for the chart range
minimum value.

Otherwise leave blank.
Horizontal
Axis Range
Max

Any number If Horizontal Axis Scale is defined as
Custom, enter a value for the chart range
maximum value.

Otherwise leave blank.
Vertical Axis Valid report column

system name
If blank, the chart does not upload.

Display
Vertical Axis
Label

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Show
Vertical Grid
Lines

Yes, Y, True, 1, X* All other values are treated as No on
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Vertical Axis
Scale

Automatic
Custom

If blank, defaults to Automatic.

Vertical Axis
Range Min

Any number If Vertical Axis Scale is defined as
Custom, enter a value for the chart range
minimum value.

Otherwise leave blank.
Vertical Axis
Range Max

Any number If Vertical Axis Scale is defined as
Custom, enter a value for the chart range
maximum value.

Otherwise leave blank.
Bubble Size Valid report column

system name
If blank, the chart does not upload.

Bubble
Represents

Valid report column
system name

Can be blank.

Bubble
Color

Valid report column
system name

Can be blank.

Bubble
Opacity

0.1
0.2
0.3
0.4
0.5
0.6
07
0.8
0.9

If blank, the chart does not upload.

Color Theme Theme 1
Theme 2
Theme 3
Theme 4
Theme 5
All the same color

If blank, the value defaults to Theme 1 on
upload.

Legend None
Right
Left

If blank, the value defaults to None on
upload.

Number
Format
Horizontal
Axis

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Number
Format
Vertical Axis

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

Number
Format
Bubble Size

#;(#)
#,###;(#,###)
$#,###;($#,###)

Indicates how values within the bubble's
tooltips are displayed.

If blank, the value defaults to #;(#) on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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l Grouped Bar Chart

The Grouped Bar Chart worksheet contains the settings for the grouped bar charts
being imported. The columns correlate to the specific grouped bar chart configuration
fields.

Column Name Accepted Values on
Upload* Additional Notes

System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a chart exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new chart is created.

Horizontal
Column

Valid report column
system name

If blank, the chart does not upload.

Display
Grouping
Label
Horizontal

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Bars Valid report column
system name

Separate each additional bar with a pipe ( | )
character.

If Vertical Column has a value, then only
one bar segment allowed.

If blank, the chart does not upload.
Bar Axis
Units

Any Can be blank.

Display
Type

Vertical
Horizontal

If blank, the value defaults to Vertical on
upload.

Rotate
Horizontal
Axis Text

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Number
Format Bars

#;(#)
#,###;(#,###)
$#,###;($#,###)

Indicates how values within the chart are
displayed.

If blank, the value defaults to #;(#) on
upload.

Legend None
Right
Left

If blank, the value defaults to None on
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Color
Theme

Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on
upload.

Target Line
Report
Source

Valid online report
system name

Can be blank.

Target Line
Report Key

Valid report column
system name

Can be blank.

Target Line
Report
Value

Valid report column
system name

Can be blank.

Vertical
Column

Valid report column
system name

Can be blank.

Display
Grouping
Label
Vertical

Yes, Y, True, 1, X* Can be blank.

Number
Format
Horizontal
Axis

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

Number
Format
Vertical Axis

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Stacked Bar Chart

The Stacked Bar Chart worksheet contains the settings for the stacked bar charts being
imported. The columns correlate to the specific stacked bar chart configuration fields.
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Column Name Accepted Values on
Upload* Additional Notes

System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a chart exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new chart is created.

Horizontal
Column

Valid report column
system name

If blank, the chart does not upload.

Display Axis
Label
Horizontal

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Bar
Segments

Valid report column
system name

Separate each bar with a pipe ( | ) character.

If Vertical Column has a value, then only
one bar segment allowed.

If blank, the chart does not upload.
Stacked to
100%

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Display
Totals

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Bar Axis
Units

Any Can be blank.

Display
Type

Vertical
Horizontal

If blank, the value defaults to Vertical on
upload.

Rotate
Horizontal
Axis Text

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Number
Format Bars

#;(#)
#,###;(#,###)
$#,###;($#,###)

Indicates how values within the chart are
displayed.

If blank, the value defaults to #;(#) on
upload.

Legend None
Right
Left

If blank, the value defaults to None on
upload.

Color
Theme

Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Target Line
Report
Source

Valid online report
system name

Can be blank.

Target Line
Report Key

Valid report column
system name

Can be blank.

Target Line
Report
Value

Valid report column
system name

Can be blank.

Vertical
Column

Valid report column
system name

Can be blank.

Display Axis
Label
Vertical

Yes, Y, True, 1, X* Can be blank.

Number
Format
Horizontal
Axis

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

Number
Format
Vertical Axis

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Radar Chart

The Radar Chart worksheet contains the settings for the radar charts being imported.
The columns correlate to the specific radar chart configuration fields.

Column Name Accepted Values on
Upload Additional Notes

System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a chart exists, its settings are changed with
the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new chart is created.

Polygons Valid report column
system name

If blank, the chart does not upload.
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Column Name Accepted Values on
Upload Additional Notes

Spokes Valid report column
system name

Separate each spoke with a pipe ( | )
character.

If blank, the chart does not upload.
Spoke Axis
Scale

Automatic
Custom

If blank, defaults to Automatic.

Spoke Axis
Range Min

Any number If Spoke Axis Scale is defined as Custom,
enter a value for the chart range minimum
value.

Otherwise leave blank.
Spoke Axis
Range Max

Any number If Spoke Axis Scale is defined as Custom,
enter a value for the chart range maximum
value.

Otherwise leave blank.
Number
Format

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

Style Lines Only
Lines and Fill
Fill Only

If blank, the value defaults to Lines Only on
upload.

Opacity 0.1
0.2
0.3
0.4
0.5
0.6
07
0.8
0.9
1

If Lines Only is selected as the style, set the
opacity to 1 on upload.

Legend None
Right
Left

If blank, the value defaults to None on
upload.

Color
Theme

Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on
upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Line Chart by Columns Chart
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The Line Chart by Columns Chart worksheet contains the settings for the line charts
being imported. The columns correlate to the specific line chart by columns chart
configuration fields.

Column Name Accepted Values on
Upload* Additional Notes

System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a chart exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new chart is created.

Lines Valid report column
system name

If blank, the chart does not upload.

Horizontal
Axis Title

Alphanumeric
characters

Can be blank.

Show
Horizontal
Grid Lines

Yes, Y, True, 1, X* All other values are treated as No on upload.

Columns Valid report column
system name

Separate column names using a pipe ( | )
character.

If blank, the chart does not upload.
Vertical Axis
Title

Alphanumeric
characters

Can be blank.

Show Grid
Lines

Yes, Y, True, 1, X* All other values are treated as No on upload.

Rotate
Horizontal
Axis Text

Yes, Y, True, 1, X* All other values are treated as No on upload.

Display
Point Marker

Yes, Y, True, 1, X* All other values are treated as No on upload.

Style Lines Only
Lines and Fill
Fill Only

If blank, the value defaults to Lines Only on
upload.

Legend None
Right
Left

If blank, the value defaults to None on
upload.

Color
Theme

Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on
upload.

586



Administrator's Guide

Sopheon Accolade Version 16.2

Column Name Accepted Values on
Upload* Additional Notes

Number
Format
Horizontal
Axis

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

Number
Format
Vertical Axis

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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l Line Chart Trends Chart

The Line Chart Trends Chart worksheet contains the settings for the line series charts
being imported. The columns correlate to the specific line chart trends chart
configuration fields.

Column Name Accepted Values on
Upload* Additional Notes

System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a chart exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new chart is created.

Horizontal
Axis Label

Alphanumeric
characters

Can be blank.

Rotate
Horizontal
Axis Text

Yes, Y, True, 1, X* All other values are treated as No on upload.

Show
Horizontal
Grid Lines

Yes, Y, True, 1, X* All other values are treated as No on upload.

Start at Zero Yes, Y, True, 1, X* All other values are treated as No on upload.
Horizontal
Number
Format

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

Horizontal
Axis
Columns

Valid report column
system name

If blank, the chart does not upload.

Vertical Axis
Label

Alphanumeric
characters

Can be blank.

Show
Vertical Grid
Lines

Yes, Y, True, 1, X* All other values are treated as No on upload.

Vertical
Number
Format

#;(#)
#,###;(#,###)
$#,###;($#,###)

If blank, the value defaults to #;(#) on
upload.

Vertical Axis
Columns

Valid report column
system name

Separate column names using a pipe ( | )
character.

If blank, the chart does not upload.
Group By
Columns

Valid report column
system name

Separate column names using a pipe ( | )
character.

If blank, the chart does not upload.
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Column Name Accepted Values on
Upload* Additional Notes

Display
Point Marker

Yes, Y, True, 1, X* All other values are treated as No on upload.

Line Style Lines Only
Lines and Fill
Fill Only

If blank, the value defaults to Lines Only on
upload.

Legend None
Right
Left

If blank, the value defaults to None on
upload.

Color
Theme

Theme 1
Theme 2
Theme 3
Theme 4
Theme 5

If blank, the value defaults to Theme 1 on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups

The Access Groups worksheet includes the access groups for the charts being
uploaded or downloaded.

Column
Name

Accepted Values on
Upload Additional Notes

Chart
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a chart exists, its settings are changed with
the values in the uploaded file.

Access
Group

Valid access group
system name

Include a separate row for each access
group.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Cycles

The Cycles worksheet includes the chart cycles for the charts being uploaded or
downloaded. The columns correlate to specific chart types to cycle through.

589

OVW_ViewChartsAndReportsOverview.htm


Chapter 7  Importing Project Data and Configuration

Administrator's Guide

Column
Name Accepted Values on Upload Additional

Notes

Chart
System
Name

Alphanumeric characters, underscore** Used for
matching
for upload.

If a chart
exists, its
settings
are
referenced
in the
uploaded
file.

If blank, no
cycles
upload.

Chart
Type

Sopheon.Accolade.Models.Domain.Charts.BarChart
Sopheon.Accolade.Models.Domain.Charts.BubbleChart
Sopheon.Accolade.Models.Domain.Charts.GroupedBarC
hart
Sopheon.Accolade.Models.Domain.Charts.LineChartTren
ds
Sopheon.Accolade.Models.Domain.Charts.PieChart
Sopheon.Accolade.Models.Domain.Charts.StackedBarCh
art

If blank,
the
referenced
chart does
not upload.

Cycles References columns in the charts that are designated as a
cycle.

Used for
matching for
upload.

If chart
settings
exist, the
referenced
chart is in
the upload
file.

If blank, no
cycles
upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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Importing and Exporting HTML Reports

Accolade provides Administrators and Process Designers the ability to export HTML reports
settings and configuration from one Accolade environment and import them into another
Accolade environment. For example, your company may have separate test and production
environments or company branches hosted in separate Accolade instances. Instead of having
to recreate HTML reports in each environment, download the information and import into a
different environment.

The download exports the HTML reports configuration information into a spreadsheet file with
the parts of the reports grouped into tabs.

To export report settings:

1. From the Systemmenu, select Content Sources > Charts & Reports Manager.

2. Select the HTML reports that you want to download.

To narrow the list by report name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all charts and reports, select All.

3. Click Download in the top right corner of the page.

Accolade downloads all configured charts and reports in four separate spreadsheet
files within a zip file, and saves it to a temporary internet files directory. HTML report
settings are downloaded to a workbook titled HTML_Workbook.xlsx. Save the file to a
more accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import report settings into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any reports that you do not want to include in the upload from the spreadsheet
and save the file.

3. From the Systemmenu, select Content Sources > Charts & Reports Manager.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load. The file name must be prefixed
with 'HTML_' in order to successfully upload.

6. Click Upload File.

Accolade uploads the changes to the existing reports in the spreadsheet, and adds any
new reports with unique system names.
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7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.

HTML Report Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings and filters for each report in
the order listed below. For a description of each report setting, see the Creating HTML Reports
topic in the online Help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l HTML Report

The HTML Report worksheet contains the settings for the reports being uploaded or
downloaded.

Column Name Accepted Values on
Upload* Additional Notes

HTML Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a report exists, its settings are changed
with the values in the uploaded file.

If it is new, a unique system name exists in
the file when uploaded, a new report is
created.

HTML Report
Display
Name

Any If blank, the report does not upload.

Description Any Can be blank.
Category Alphanumeric

characters
If a new, unique category name exists in the
file when uploaded, a new category is
created.

If left blank, the report is placed in the
Default category.

592



Administrator's Guide

Sopheon Accolade Version 16.2

Column Name Accepted Values on
Upload* Additional Notes

Query Valid query system
name

If blank, the report does not upload.

Transpose Yes, Y, True, 1, X* All other values are treated as No on
upload.

Active in
Charts &
Reports

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Active in
Projects

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Required Notifications

The Required Notifications worksheet includes the notification settings of the reports
being uploaded or downloaded.

Column Name Accepted Values on
Upload Additional Notes

HTML
Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a report exists, its settings are changed
with the values in the uploaded file

Notification Show
Hide
Required

If blank, report does not upload.

Notification
Day

Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
Sunday

If Notification is set to Required, at least
one valid day of the week must be entered.
Include a separate row for each day.

Otherwise, leave blank.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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l Roles

The Roles worksheet includes the roles restriction settings of the report being uploaded
or downloaded. The values can be blank, resulting in a report uploaded that does not
contain role restrictions.

Column
Name

Accepted Values on
Upload Additional Notes

HTML
Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a report exists, its settings are changed
with the values in the uploaded file

Roles Valid Accolade user
role

Include a separate row for each role.

Can be blank.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups

The Access Groups worksheet includes the access groups for the reports being
uploaded or downloaded.

Column
Name

Accepted Values on
Upload Additional Notes

HTML
Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a report exists, its settings are changed
with the values in the uploaded file

Access
Group

Valid access group
system name

Include a separate row for each access
group.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting MS Excel Reports

Accolade provides Administrators and Process Designers the ability to export MS Excel
reports settings and configuration from one Accolade environment and import them into
another Accolade environment. For example, your company may have separate test and
production environments or company branches hosted in separate Accolade instances.
Instead of having to recreate MS Excel reports in each environment, download the information
and import into a different environment.

The download exports the MS Excel reports configuration information into a spreadsheet file
with the parts of the reports grouped into tabs.
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To export report settings:

1. From the Systemmenu, select Content Sources > Charts & Reports Manager.

2. Select the MS Excel reports that you want to download.

To narrow the list by report name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all charts and reports, select All.

3. Click Download in the top right corner of the page.

Accolade downloads all configured charts and reports in four separate spreadsheet
files within a zip file, and saves it to a temporary internet files directory. MS Excel report
settings are downloaded to a workbook titled EXCEL_Workbook.xlsx. Save the file to a
more accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import report settings into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any reports that you do not want to include in the upload from the spreadsheet
and save the file.

3. From the Systemmenu, select Content Sources > Charts & Reports Manager.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load. The file name must be prefixed
with 'EXCEL_' in order to successfully upload.

6. Click Upload File.

Accolade uploads the changes to the existing reports in the spreadsheet, and adds any
new reports with unique system names.

7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.
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MS Excel Report Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings and filters for each report in
the order listed below. For a description of each report setting, see the Adding MS Excel
Reports to Accolade topic in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Excel Report

The Excel Report worksheet contains the settings for the reports being uploaded or
downloaded.

Column Name Accepted Values on
Upload* Additional Notes

MS Excel
Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a report exists, its settings are changed
with the values in the uploaded file.

If it is new, a unique system name exists in
the file when uploaded, a new report is
created.

MS Excel
Report
Display
Name

Any If blank, the report does not upload.

Description Any Can be blank.
Category Alphanumeric

characters
If a new, unique category name exists in the
file when uploaded, a new category is
created.

If left blank, the report is placed in the
Default category.

Query
Worksheet
1-5

Valid query system
name

Can be blank.

Active
Charts &
Reports

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Active
Projects

Yes, Y, True, 1, X* All other values are treated as No on
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Template Valid template
system name of a
template available in
the Template Library

Template must be uploaded prior to being
added to the report.

If blank, the report does not upload.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Roles

The Roles worksheet includes the roles restriction settings of the reports being
uploaded or downloaded. The values can be blank, resulting in a report uploaded that
does not contain role restrictions.

Column
Name

Accepted Values on
Upload Additional Notes

MS Excel
Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a report exists, its settings are changed
with the values in the uploaded file

Roles Valid Accolade user
role

Include a separate row for each role.

Can be blank.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups

The Access Groups worksheet includes the access groups for the reports being
uploaded or downloaded.

Column
Name

Accepted Values on
Upload Additional Notes

MS Excel
Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a report exists, its settings are changed
with the values in the uploaded file

Access
Group

Valid access group
system name

Include a separate row for each access
group.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).
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Importing and Exporting Accolade Online Reports

Accolade provides Administrators and Process Designers the ability to export Accolade online
reports settings and configuration from one Accolade environment and import them into
another Accolade environment. For example, your company may have separate test and
production environments or company branches hosted in separate Accolade instances.
Instead of having to recreate online reports in each environment, download the information
and import into a different environment.

The download exports the online reports configuration information into a spreadsheet file with
the parts of the reports grouped into tabs.

To export report settings:

1. From the Systemmenu, select Content Sources > Charts & Reports Manager.

2. Select the reports that you want to download.

To narrow the list by report name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all charts and reports, select All.

3. Click Download in the top right corner of the page.

Accolade downloads all configured charts and reports in four separate spreadsheet files
within a zip file, and saves it to a temporary internet files directory. Online report settings
are downloaded to a workbook titled RPT_Workbook.xlsx. Save the file to a more
accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import report settings into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any reports that you do not want to include in the upload from the spreadsheet
and save the file.

3. From the Systemmenu, select Content Sources > Charts & Reports Manager.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load. The file name must be prefixed
with 'RPT_' in order to successfully upload.

6. Click Upload File.
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Accolade uploads the changes to the existing reports in the spreadsheet, and adds any
new reports with unique system names.

7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.

Online Report Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings and filters for each report in
the order listed below. For a description of each report setting, see the Creating Online
Reports within Accolade topic in the online Help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Report Settings

The Report Settings worksheet contains the settings for the reports being imported.

Column Name Accepted Values on
Upload* Additional Notes

System Name Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a report exists, its settings are changed
with the values in the uploaded file.

If it is new, a unique system name exists in
the file when uploaded, a new report is
created.

Display Name Any If blank, the report does not upload.
Category Alphanumeric

characters
If a new, unique category name exists in
the file when uploaded, a new category is
created.

If left blank, the report is placed in the
Default category.

Subject
System Name

Valid report subject
system name

Used for matching for upload.
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Column Name Accepted Values on
Upload* Additional Notes

If the Subject System Name specifies
Project Snapshot History, a value must
be entered in the Is Snapshot field on the
Columns and Filters worksheet.

If blank, the report does not upload.
Owner Valid user system

ID
Use the format with which the user
accessed Accolade, such as
domain\username or
username@domain.com.

If you are uploading a new report, the
downloaded file can be changed to a new
owner in order to transfer initial ownership
when loading the file. If this field is left
blank or has an invalid user ID entered, the
system will assign the user completing the
upload as the owner of the report.

If you are making changes to an existing
report via upload, theOwner column is
ignored and will not update.

If a downloaded report was
created by a user that has been
deleted, this file will reflect
[None] as the report owner.

Additional
Owners

Valid user system
ID

Use the format with which the user
accessed Accolade, such as
domain\username or
username@domain.com.

Separate each additional owner by a pipe ( 
| ) character.

Can be blank.
Roles Valid Accolade

user role
Separate each role by a pipe ( | ) character.

Can be blank.
Description Any Can be blank.
Override
Project
Filtering

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Export Days Integers Can be blank.
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Column Name Accepted Values on
Upload* Additional Notes

Export Time Time value in Can be blank.
Export File
Path

Valid file path for
the export to

Can be blank.

Export File
Name

Alphanumeric
characters,
underscore**

Can be blank.

Export Include
Timestamp

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Export File
Type

Excel
CSV

If blank, the setting defaults to Excel.

Available to
Charts &
Reports

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Available to
Configuration

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Transpose Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Columns and Filters

The Columns and Filters worksheet includes the report column settings of the reports
being imported.

Column Name Accepted Values on
Upload* Additional Notes

Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a report exists, its settings are changed
with the values in the uploaded file.

Unique
Group
System
Name

Valid reference
table system name
Valid matrix system
name

Can be blank if Reporting Column Type is
defined as Standard orMetric.
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Column Name Accepted Values on
Upload* Additional Notes

Reporting
Column
Type

Standard
Reference Table
Metric
Matrix
Calculated

The value is related to the Reporting Data
Type value, and must match in terms of
appropriate data types.

If blank, the report does not upload.

Reporting
Data Type

String
Image
List
Number
Date
Boolean
ID
Multilist

The value is related to the Reporting
Column Type value, and must match the
column type.

If blank, the report does not upload.

Column
System
Name

Valid report column-
specific system
name**

Used for matching for upload.

If a report column exists, its settings are
changed with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new column is
created.

Display
Name

Any Can be blank.

Sort Order Any number The field is set to 0 on upload if no value is
entered or the value is not a number.

Sort
Ascending

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Property Aggregation Method
None
Avg
Min
Max
StDev
Sum
Date Mask
Excel Dates
Days
Months
Quarters
Years
Link

Link is only available for the Project Name
report column.

Can be blank.
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Column Name Accepted Values on
Upload* Additional Notes

Column
Order

Any number Must be a unique value for each column
included in a report.

Display
Column On
Report

Yes, Y, True, 1, X* Set the value to No, N, False, 0 if the
column is only used as a filter and not a
report column. Otherwise, set the value to
Yes, Y, True, 1, X and specify the Filter ID
if applicable.

All other values are treated as No on
upload.

Filter ID Any number Must be a unique value for each filter
included in a report.

Can be blank if the report does not include
filters and the Display Column On Report
is set to Yes.

Filter Type equal
not equal
greater than
less than
greater than or
equal to
less than or equal to
is empty
is not empty
between
contains
does not contain
is one of
between days
between dates
days before
days after

If a Filter ID is specified, the Filter Type
must be defined. and values must be
entered on the Filter Values worksheet.

Can be blank if the report does not include
filters and the Display Column On Report
is set to Yes.

Is Snapshot Yes, Y, True, 1, X* If the Subject System Name on the Report
Settings worksheet is set to Project
Snapshot History, this field determines if
the metric or matrix is part of the snapshot,
and must have a value entered. Otherwise,
can be blank.

All other values are treated as No on
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Is Link Yes, Y, True, 1, X* All other values are treated as No on
upload.

Formula A valid expression If Reporting Column Type is defined as
Calculated, the Formulamust be defined
for the calculated column.

Otherwise, can be blank.
Data Format For columns

containing dates:

Days
Months
Quarters
Years
Excel Dates
Timestamp

For columns
containing numbers:

#;(#)
#,###;(#,###)
$#,###;($#,###)

Data Format only applies for columns that
contain date or number values and specifies
how the data displays when the report is
run.
l Date columns - If blank, the value
defaults to Excel Dates on upload.

l Number columns - If blank, the value
defaults to #;(#) on upload.

Show Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Filter Values

The Filters Values worksheet includes the values of the filters defined on the reports
being imported. This worksheet can be blank if the reports do not include filters.

Column Name Accepted Values on
Upload Additional Notes

Filter ID Any number Used for matching for upload.

If a filter exists, its settings are changed with
the values in the uploaded file.

If a new, unique system name exists in the file
when uploaded, a new filter is created.
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Column Name Accepted Values on
Upload Additional Notes

Can be blank if the report does not include
filters.

Filter Value
Rank

Any number Can be blank if only one filter is included in the
report.

Filter Value
Type

Text
Field code
Metadata
Metric
Current User

If the report includes filters and this field is
blank, the filter does not upload.

Filter Value Valid metric system
name or field code

If the Filter Type on the Columns and Filters
worksheet is defined as is one of, separate
the metric or field code system name values
with a pipe ( | ) character.

If the Filter Type on the Columns and Filters
worksheet is defined as between, the
worksheet includes additional rows for each
filter value. Additionally, concatenate an
integer to the field code system name to
further specify the field code. For example, a
gate date field code would include an integer
to specify if it is referencing gate date 1, 2, 3,
etc.

Can be blank.
Filter
Runtime
Filter

Yes, Y, True, 1, X* All other values are treated as No on upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups

The Access Groups worksheet includes the access groups for the reports being
uploaded or downloaded.

Column
Name

Accepted Values on
Upload Additional Notes

Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a report exists, its settings are changed
with the values in the uploaded file.

Access
Group

Valid access group
system name

Include a separate row for each access
group.
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** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Matrix Join Definitions

The Matrix Join Definitions worksheet includes the join definitions for reports being
uploaded or downloaded that include multiple matrices. This worksheet can be blank if
the reports do not include multiple matrices.

Column
Name

Accepted Values on
Upload Additional Notes

Report
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a report exists, its settings are changed
with the values in the uploaded file.

Source
Matrix
System
Name

Valid matrix system
name

Used for matching for upload.

Cannot be the same matrix referenced in the
Target Matrix System Name field.
If the report contains matrices and this field is
blank or invalid, the definition does not
upload.

Source
Matrix
Metric
System
Name

Valid matrix metric
system name

Must be a metric that is included in the matrix
defined in the Source Matrix System Name
field.

If this field is blank or invalid, the definition
does not upload.

Target
Matrix
System
Name

Valid matrix system
name

Used for matching for upload.

Cannot be the same matrix referenced in the
Source Matrix System Name field.
If the report contains matrices and this field is
blank or invalid, the definition does not
upload.

Target
Matrix
Metric
System
Name

Valid matrix metric
system name

Must be a metric that is included in the matrix
defined in the Target Matrix System Name
field.

If this field is blank or invalid, the definition
does not upload.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Queries

Accolade provides Administrators and Process Designers the ability to export queries from
one Accolade environment and import it into another Accolade environment. For example,
your company may have a test environment set up during your implementation, or you may
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have company branches that are new to Accolade that are hosted in a separate environment.
Instead of having to recreate queries in each environment, download the information and
import it into the new environment.

The download exports the query configuration information into a spreadsheet file with the parts
of the query grouped into tabs.

To export queries:

1. From the Systemmenu, select Content Sources > Queries.

2. Select the queries that you want to download.

To narrow the list by query name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all queries, select All.

3. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import queries into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any queries that you do not want to include in the upload from the spreadsheet
and save the file.

3. From the Systemmenu, select Content Sources > Queries.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the queries in the spreadsheet, and adds any new
queries with unique system names.

7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
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may result in warning or error messages during the upload, and may result in
an incomplete upload.

Queries Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each query in the order
listed below. For a description of each query setting, see the Adding Database Queries topic in
the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Queries

Column Name Accepted Values on
Upload Additional Notes

Query
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a query exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new query is created.

Query Name Any If blank, the query does not upload.
Description Any Can be blank.
Category Alphanumeric

characters
If a new, unique category name exists in the
file when uploaded, a new category is
created.

If blank, the query is placed in the Default
category.

SQL Valid query Enter the query code.
Delete Yes, Y, True, 1, X* All other values are treated as No on

upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups
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Column
Name

Accepted Values on
Upload Additional Notes

Query
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a query exists, its settings are changed
with the values in the uploaded file.

Access
Groups

Valid access group
system name

Include a separate row for each access
group.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Metrics

Accolade provides Administrators and Process Designers the ability to export metrics from
one Accolade environment and import it into another Accolade environment. For example,
your company may have a test environment set up during your implementation, or you may
have company branches that are new to Accolade that are hosted in a separate environment.
Instead of having to recreate metrics in each environment, download the information and
import it into the new environment.

The download exports the metrics configuration information into a spreadsheet file with the
parts grouped into tabs.

To export metric settings:

1. From the Systemmenu, select Content Sources > Metrics.

2. Select the metrics that you want to download.

Use theMetric ID search field to find the metrics you wish to download. A partial search
entry pulls up a list of all matching metric IDs containing those numeric characters.

You can also enter a category, name, and/ or system name when searching by metric
ID to find the metrics that match all criteria entered. These filters are case insensitive.

To narrow the list by metric name or system name, add the criteria to filter by in the
appropriate filter text box.

To narrow the list by category, select a category to display in the Category list. To
download all metrics, select All.

3. Click Download in the top right corner of the page.

Accolade downloads the metrics to a spreadsheet file and saves it to a temporary
internet files directory. Save the file to a more accessible location.

Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.
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To import metric settings into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any metrics that you do not want to include in the upload from the spreadsheet
and save the file.

3. From the Systemmenu, select Content Sources > Metrics.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

Accolade uploads the changes to the metrics in the spreadsheet, and adds any new
metrics with unique system names.

6. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.

Metric Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each metric in the order
listed below. For a description of each metric setting, see the Creating Metrics topic in the
online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Metrics

If you want to import metric settings without associating the metric to a process model,
complete this section of the spreadsheet only. You will need to include the Additional
Model Settings columns listed below, but they can be left blank.

Column Name Accepted Values on
Upload* Additional Notes

System Name Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a metric exists, its settings are
changed with the values in the
uploaded file.
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Column Name Accepted Values on
Upload* Additional Notes

If a new, unique system name exists
in the file when uploaded, a new
metric is created.

Display Name Any If blank, the metric does not upload.
Order Any number The field is set to 0 on upload if no

value is entered or the value is not a
number.

Metric ID (Read Only) The metric ID is included in the download file,
but is not editable on upload.

Description Any Can be blank.
Category Alphanumeric

characters
If a new, unique category name exists
in the file when uploaded, a new
category is created.

If left blank, the metric is placed in the
Default category.

Data Type String
Number
Date
List
Long String
Multi-Select List

Can only upload changes for rows
that create new metrics.

Existing metrics must match their
Data Type along with System Name
and Display Name.

If the Data Type selected is
List orMulti-Select List
and the list is manually
defined within the metric,
enter the list values on the
List Values spreadsheet
tab.

Decimal
Places

Any number Applies only to Number type metrics.

Is set to 0 on upload if no value is
entered or the value is not a number.

Is Filter Yes, Y, True, 1, X* All other values are treated as No on
upload.

Is Matrix Yes, Y, True, 1, X* All other values are treated as No on
upload.

Available to
Reporting

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Available to
Portfolio

Yes, Y, True, 1, X* All other values are treated as No on
upload.
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Column Name Accepted Values on
Upload* Additional Notes

Optimizer
Available to
Planning

Yes, Y, True, 1, X* This setting is only changeable on
upload if the setting on download is
No.
All other values are treated as No on
upload.

Milestone
Shape

Arrow
Bar
Checkmark
InvertedTriangle
Marker
Pin
Rocket
Starburst
Target

Applies only to Date type metrics that
have Available to Planning selected
as Yes.
If blank, defaults to
InvertedTriangle.

Available to
Resource
Editor

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Is Inherited Yes, Y, True, 1, X* All other values are treated as No on
upload.

Is Calculated Yes, Y, True, 1, X* All other values are treated as No on
upload.

Calculated
Expression

A valid expression Applies only to metrics with Is
Calculated set to Yes.
The row does not upload if the
expression is invalid.

Calculated
Event Triggers

AssociatedChange

ProjectCreate

ProjectMigrate

ProjectClose

ProjectReOpen

Applies only to metrics with Is
Calculated set to Yes.
To apply more than one trigger,
separate events using a pipe ( | )
character.

If the metric value is invalid, the
trigger will not be assigned.

Calculated
Timed
Triggers

Daily
Weekly
Monthly
EndOfMonth
Quarterly
Yearly

Applies only to metrics with Is
Calculated set to Yes.
Use the format
<type>;<yyyy/MM/dd> <hh:mm:ss>

For example, Daily;2018/06/18
10:00:00.
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Column Name Accepted Values on
Upload* Additional Notes

Only one interval of the same type
may be assigned. If more than one
interval is uploaded the first displayed
will be set. For example, two-day
events cannot be assigned, but day
and month can be assigned.

To apply more than one trigger,
separate timed events using a pipe ( |
) character.

Timed event accepted values use
international dates, and 24 hour
times. EndOfMonth dynamically
changes based on the date each
month falls on.

If the metric value is invalid, the
trigger will not be assigned.

Initialized
From

Valid metric system
name

The row does not upload if the
indicated system name is not a valid
system name for an existing metric.

Metric Query Valid SQL query
expression

Applies only to List and Multi-Select
List metrics that use a query to
determine the list values.

The row does not upload if the
expression is invalid.

Office Format #, 0 Applies only to Number type metrics
in Microsoft Word or PowerPoint.

Track History Yes, Y, True, 1, X* All other values are treated as No on
upload.

Reference
Table

Valid reference
table system name

Applies only to List and Multi-Select
List metrics that use a reference table
column to determine the list values.

Reference
Table Column

Valid column
system name within
the table

Applies only to List and Multi-Select
List metrics that use a reference table
column to determine the list values.

Reference
Table
Constraints

Valid reference
table column value
or valid query code

Applies only to List and Multi-Select
List metrics that use a reference table
column to determine the list values.

Separate list items using a pipe ( | )
character.
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Column Name Accepted Values on
Upload* Additional Notes

Active Yes, Y, True, 1, X* All other values are treated as No on
upload.

Milestone
Shape Color
Metric System
Name

Valid metric system
name

Applies only to Date type metrics that
have Available to Planning selected
as Yes.
The row does not upload if the
indicated system name is not a valid
system name for an existing metric.

If blank, defaults to [None].
Restrict to
These Roles

Valid Accolade user
role

Separate roles using a pipe ( | )
character.

Allow Updates
from All My
Work page

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Available to
Workflow
Lineup

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Configuration
Access
Groups

Valid access group
display name

Separate access groups using a pipe
( | ) character.

Available to BI Yes, Y, True, 1, X* All other values are treated as No on
upload.

Available to
Search

Yes, Y, True, 1, X* Applies only to String, Long String,
and Multi-Select List metrics.

All other values are treated as No on
upload.

Rich Text Yes, Y, True, 1, X* Applies only to Long String metrics.

All other values are treated as No on
upload.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

In addition, the Metrics spreadsheet includes the association setting for each process
models (active and inactive) to which each metric is associated. Each process model to
which the metric is associated contains the following set of columns, and each set of
columns is identified by the process model name.
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l Additional Model Settings

For a description of each metric association setting, see the Associating Metrics to
Models topic in the online Help.

Note: The columns in this portion of the spreadsheet are used for
associating a metric with a model, and do not create new process
models in Accolade.

Column Name
Accepted
Values on
Upload

Additional Notes

Associated Yes, Y, True, 1,
X*

This column defaults to Yes if any of the
related model columns are defined.

All other values are treated as No on upload.
Project
Creation

Edit
Show

Can be blank.

Project
Metrics

Edit
Show

Can be blank.

Status
Report

Edit
Show

Can be blank.

Portfolio Edit
Show

Can be blank.

Planning
Favorite

Yes, Y, True, 1,
X*

The Available to Planning column for the
metric must be set to Yes, Y, True, 1, X* if
this column is set to Yes, Y, True, 1, X*.
All other values are treated as No on upload.

Milestone Yes, Y, True, 1,
X*

Applies only to Date type metrics.

The Available to Planning column on the
metric must be set to Yes, Y, True, 1, X* if
this column is set to Yes, Y, True, 1, X*.
All other values are treated as No on upload.

Required Yes, Y, True, 1,
X*

All other values are treated as No on upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

l List Values

If the Data Type selected is List orMulti-Select List and the list is manually defined
within the metric, the list values should be entered on this tab. For a description of each
list value setting, see the Creating Single and Multi-Select List Metrics topic in the online
help.
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This worksheet must be included in the spreadsheet file, but can be left blank if the
metrics do not include defined lists.

Column
Name

Accepted Values
on Upload Additional Notes

Metric
System
Name

Alphanumeric
characters,
underscore**

Used for matching in the upload.

If a metric exists, its settings are changed
with the values in the uploaded file.

List Value
Name

Any If blank, the list value does not upload.

List Value
System
Name

Alphanumeric
characters,
underscore**

Can be blank.

Order Any number The field is set to 0 on upload if no value is
entered or the value is not a number.

Color Valid hex color
code

Can be blank.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Matrices

Accolade provides Administrators and Process Designers the ability to export matrices from
one Accolade environment and import it into another Accolade environment. For example,
your company may have a test environment set up during your implementation, or you may
have company branches that are new to Accolade that are hosted in a separate environment.
Instead of having to recreate matrices in each environment, download the information and
import it into the new environment.

The download exports the matrices configuration information into a spreadsheet file with the
parts grouped into tabs.

To export matrices:

1. From the Systemmenu, select Content Sources > Matrices.

2. Select the matrices that you want to download.

To narrow the list by matrix name or system name, add the criteria to filter by in the
appropriate filter text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list. To
download all matrices, select All.

3. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.
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Note: Only components to which you have view and/or edit configuration access
group rights will download. Components you can only view may be included
in the file, but you can only upload changes to areas to which you have
explicit edit permission.

To import matrices into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any matrices that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Content Sources > Matrices.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the matrices in the spreadsheet, and adds any new
matrices with unique system names.

7. (Optional) Click Print to print the import results for your records.

Note: Components that are imported are subject to group configuration rules. The
user may assign components in a way that the configuration access groups
are not consistent. This behavior is not allowed in the UI, and mismatches in
either the user's access rights or the component's access group restrictions
may result in warning or error messages during the upload, and may result in
an incomplete upload.

Matrix Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each matrix in the order
listed below. For a description of each matrix setting, see the Creating Matrices topic in the
online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Details
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Column Name Accepted Values on
Upload* Additional Notes

Matrix
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a matrix exists, its settings are
changed with the values in the uploaded
file.

If a new, unique system name exists in
the file when uploaded, a new matrix is
created.

Matrix Name Any If blank, the matrix does not upload.
Description Any Can be blank.
Category Alphanumeric

characters
If a new, unique category name exists in
the file when uploaded, a new category
is created.

If left blank, the matrix is placed in the
Default category.

Order Any number The field is set to 0 on upload if no value
is entered or the value is not a number.

Active Yes, Y, True, 1, X* All other values are treated as No on
upload.

Available to
Reporting

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Portfolio
Optimizer

Not Available
Reporting Only
Edit

If blank, the matrix does not upload.

Available to
BI

Yes, Y, True, 1, X* All other values are treated as No on
upload.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

The workflow cannot be deleted if in
use.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Metrics
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Column Name Accepted Values on
Upload Additional Notes

Matrix
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a matrix exists, its settings are
changed with the values in the uploaded
file.

Metric
System
Name

Valid metric system
name

If blank, the metric does not upload.

Category The metric's
category

If blank, the metric does not upload.

Data Type The metric's
datatype

If blank, the metric does not upload.

Unique Yes, Y, True, 1, X* All other values are treated as No on
upload.

Multi-select lists and calculated metrics
within the matrix cannot be set as
unique.

Portfolio
Header
Columns

Any number Can be blank.

Filterable Yes, Y, True, 1, X* All other values are treated as No on
upload.

Portfolio
Optimizer
Filter
Values

Valid list value for
the metric

Separate each filter value with a pipe ( | )
character.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Models

Column
Name

Accepted Values on
Upload* Additional Notes

Matrix
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a matrix exists, its settings are changed
with the values in the uploaded file.
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Column
Name

Accepted Values on
Upload* Additional Notes

Model Valid process
model system name

If blank, matrix does not upload.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Access Groups

Column
Name

Accepted Values on
Upload Additional Notes

Matrix
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a matrix exists, its settings are changed
with the values in the uploaded file.

Access
Group

Valid access group
system name

Include a separate row for each access
group.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Extended Fields

Accolade provides Administrators and Process Designers the ability to export custom details,
called extended fields, from one Accolade environment and import it into another Accolade
environment. For example, your company may have a test environment set up during your
implementation, or you may have company branches that are new to Accolade that are hosted
in a separate environment. Instead of having to recreate extended fields in each environment,
download the information and import it into the new environment.

The download exports the extended fields configuration information into a spreadsheet file with
the parts grouped into tabs.

To export extended fields:

1. From the Systemmenu, select Configuration > Extended Fields.

2. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.
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To import extended fields into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any extended fields that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Configuration > Extended Fields.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the extended fields in the spreadsheet.

7. (Optional) Click Print to print the import results for your records.

Extended Fields Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each extended field in the
order listed below. For a description of each extended field setting, see the Adding Custom
Details Throughout Accolade topic in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Extended Fields

Column Name Accepted Values on
Upload* Additional Notes

Extended
Field System
Name

Valid extended
field system name

Used for matching for upload.

If an extended field exists, its settings are
changed with the values in the uploaded file.

If invalid, the extended field does not upload.
Extended
Field Name

Any If blank, the extended field does not upload.

Extended
Field ID

Valid system field
ID

If blank, the extended field does not upload.
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Column Name Accepted Values on
Upload* Additional Notes

Datatype Date Fields
List Fields
Long String Fields
Multi-Select List
Fields
Number Fields
String Fields

If blank, the extended field does not upload.

Query Valid query in
Accolade

EitherQuery or Defined Listmust be
entered if the Data Type is a List Field or
Multi-List Field.
If not a list field, leave blank.

Defined List Any Separate list items using the pipe ( | )
character.

EitherQuery or Defined Listmust be
entered if the Data Type is a List Field or
Multi-List Field.
If not a list field, leave blank.

Activities Yes, Y, True, 1, X* All other values are treated as No on upload.
Deliverables Yes, Y, True, 1, X* All other values are treated as No on upload.
Pools Yes, Y, True, 1, X* All other values are treated as No on upload.
Timesheets Yes, Y, True, 1, X* All other values are treated as No on upload.
User Active Yes, Y, True, 1, X* All other values are treated as No on upload.
User
Required

Yes, Y, True, 1, X* All other values are treated as No on upload.

User
Searchable

Yes, Y, True, 1, X* All other values are treated as No on upload.

Order Any number The field is set to 0 on upload if no value is
entered or the value is not a number.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

Importing and Exporting Project Link Types

Accolade provides Administrators and Process Designers the ability to export link types from
one Accolade environment and import it into another Accolade environment. For example,
your company may have a test environment set up during your implementation, or you may
have company branches that are new to Accolade that are hosted in a separate environment.
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Instead of having to recreate link types in each environment, download the information and
import it into the new environment.

The download exports the link types configuration information into a spreadsheet file with the
parts grouped into tabs.

To export project link types:

1. From the Systemmenu, select Process > Link Types.

2. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.

To import project link types into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any link types that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Process > Link Types.

4. Click Upload in the top right corner of the page.

Accolade uploads the changes to the link types in the spreadsheet, and adds any new
link types with unique system names.

5. (Optional) Click Print to print the import results for your records.

Project Link Types Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each link type in the order
listed below. For a description of each link type setting, see the Creating Project Link Types
topic in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.
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l Link Types

Column Name Accepted Values on
Upload* Additional Notes

Link Type
System Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a link type exists, its settings are
changed with the values in the
uploaded file.

If a new, unique system name exists in
the file when uploaded, a new link type
is created.

Link Type
Display Name

Any If blank, the link type does not upload.

Link From
Name

Any If blank, the link type does not upload.

Link To Name Any If blank, the link type does not upload.
Description Any Can be blank.
Line Color Any color. If blank, defaults to Black.
Arrow
Direction

Neither Direction
To --> From
From --> To
Both Directions <--
>

If blank, defaults to Neither Direction.

Dependency
Type

Start - Start
Finish - Finish
Finish - Start
Date - Date
None

If blank, defaults to None.
If Date - Date is selected, Source
Default Date and Target Default Date
need to be defined.

Source
Default Date

Project Start Date
Project End Date
Gate 1...20
any available
project date metric

Leave blank unless Dependency Type
is defined as Date - Date.

Target
Default Date

Project Start Date
Project End Date
Gate 1...20
any available
project date metric

Leave blank unless Dependency Type
is defined as Date - Date.

Manage
Links

To --> From
From --> To
Both Directions <--
>

If blank, defaults to Both Directions <--
>.
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Column Name Accepted Values on
Upload* Additional Notes

Order Any number The field is set to 0 on upload if no value
is entered or the value is not a number.

Active Yes, Y, True, 1, X* All other values are treated as No on
upload.

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Roles

Column
Name

Accepted Values on
Upload Additional Notes

Link Type
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a link type exists, its settings are
changed with the values in the uploaded
file.

Restrict to
These
Roles

Valid Accolade role Separate roles using the pipe ( | )
character.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Mappings

Column
Name

Accepted Values on
Upload* Additional Notes

Link Type
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a link type exists, its settings are
changed with the values in the uploaded
file.

From
Process
Model

Valid process
model system name

If blank, the link type does not upload.

To Process
Model

Valid process
model system name

If blank, the link type does not upload.

Max Project
Links

Any number Can be blank.
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Column
Name

Accepted Values on
Upload* Additional Notes

Delete Yes, Y, True, 1, X* All other values are treated as No on
upload.

* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Global Links

Accolade provides Administrators and Process Designers the ability to export custommenu
item configuration (global links) from one Accolade environment and import it into another
Accolade environment. For example, your company may have a test environment set up
during your implementation, or you may have company branches that are new to Accolade that
are hosted in a separate environment. Instead of having to recreate global links in each
environment, download the information and import it into the new environment.

The download exports the global links configuration information into a spreadsheet file with the
parts of the links grouped into tabs.

Note: The Disable Link to File and Disable Link to Website parameter settings
determine if you can link to web site or file.

To export global links:

1. From the Systemmenu, select Process > Global Links.

2. Click Download in the top right corner of the page.

By default, the file exports automatically to a temporary internet files directory. Save it to
a more accessible location.

To import global links into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any global links that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select Process > Global Links.

4. Click Upload in the top right corner of the page.

Accolade uploads the changes to the global links in the spreadsheet, and adds any new
global links with unique system names.

5. (Optional) Click Print to print the import results for your records.
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Global Links Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the settings for each global link in the
order listed below. For a description of each global link setting, see the Adding Menu Items for
Multiple Users (Global Links) topic in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Global Links

Column Name Accepted Values on
Upload* Additional Notes

Global Link
System
Name

Alphanumeric
characters,
underscore**

Used for matching for upload.

If a global link exists, its settings are changed
with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new global link is
created.

Global Link
Name

Any If blank, the global link does not upload.

Link Prefix Valid link prefix Enter the prefix for the global link being
created.

Accolade supports the following link types:
l http - A URL to a Web page.
l https - A URL to a secure Web page.
l ftp - A link to an FTP download site.
l file - A link to a file or executable on your
company's intranet.

l qvp - A link to a Dashboards for Accolade
chart if using the Dashboards viewer.

l mailto - Opens the user's email
application and displays a blank email
addressed to this email address.

l callto - Opens your selected chat and
collaboration tool, which invites the
person at the address you define to a
chat.
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Column Name Accepted Values on
Upload* Additional Notes

Based on your server setup, http,
https, and file global link types are
available to add as the content of a
pod within a page layout.

Link Valid link address Enter the address for the global link being
created. For example, www.google.com.

If blank, the global link does not upload.
Menu Alphanumeric

characters
Used for matching for upload.

If a display menu exists, its settings are
changed with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new display menu is
created.

To create a global link that is only available to
add to a pod within a layout, leave this option
blank.

Embed Yes, Y, True, 1, X* All other values are treated as No on upload.
Landing
Page

Yes, Y, True, 1, X* All other values are treated as No on upload.

Default
Home Page

Yes, Y, True, 1, X* All other values are treated as No on upload.

Order Any number The field is set to 0 on upload if no value is
entered or the value is not a number.

Display in
menu

Yes, Y, True, 1, X* All other values are treated as No on upload.

Category Alphanumeric
characters

Used for matching for upload.

If a display category exists, its settings are
changed with the values in the uploaded file.

If a new, unique system name exists in the
file when uploaded, a new display category is
created.

To create a global link that is only available to
add to a pod within a layout, leave this option
blank.

Category is required on the global link to
Display in menu.

Delete Yes, Y, True, 1, X* All other values are treated as No on upload.
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* For any column that accepts Yes, Y, True, 1, or X, you can also enter No, N, False, or 0 if it helps you when
entering data in the spreadsheet. All values other than Yes, Y, True, 1, or X are treated as No when you
upload the spreadsheet.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

l Roles

Column
Name

Accepted Values on
Upload Additional Notes

Global Link
System
Name

Alphanumeric
characters,
underscore**.

Used for matching for upload.

If a global link exists, its settings are changed
with the values in the uploaded file.

Roles Valid Accolade user
role

Include a separate row for each role.

** Limited to characters between a - z, A - Z, and 0 - 9, and the underscore ( _ ).

Importing and Exporting Parameters

Accolade provides Administrators and Process Designers the ability to export parameter
settings from one Accolade environment and import it into another Accolade environment. For
example, your company may have a test environment set up during your implementation, or
you may have company branches that are new to Accolade that are hosted in a separate
environment. Instead of having to reconfigure parameters in each environment, download the
information and import it into the new environment.

To export parameters settings:

1. From the Systemmenu, select System > Settings, then select the Parameters tab.

2. Click Download in the top right corner of the page.

3. In the Download dialog box, select the parameter settings that you want to download.

The dialog box automatically includes all parameters that can be set on
this page, and additional selections can be added or removed as
necessary.

To narrow the list by parameter name, add the criteria to filter by in the appropriate filter
text box. These filters are case insensitive.

To narrow the list by category, select a category to display in the Category list.
Accolade downloads all selected parameters settings in alphabetical order in a
spreadsheet file, and saves it to a temporary internet files directory. Save the file to a
more accessible location.
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To import parameters settings into Accolade:

1. Ensure the data within the spreadsheet meets the requirements for a successful import.

2. Remove any parameter settings that you do not want to include in the upload from the
spreadsheet and save the file.

3. From the Systemmenu, select System > Settings, then select the Parameters tab.

4. Click Upload in the top right corner of the page.

5. Click Load File and select the spreadsheet file to load.

6. Click Upload File.

Accolade uploads the changes to the parameters in the spreadsheet, and adds any new
parameters settings.

7. (Optional) Click Print to print the import results for your records.

Parameter Settings Included in the Spreadsheet File

The columns in the downloaded spreadsheet include the parameter display name and the
value from the system. For a description of each parameter, see the Accolade Parameters
topic in the online help.

Important! Using the import and export tools to update configuration can result in
unintended changes if information is missing or creates an error during the import
process. Sopheon recommends reviewing Importing and Exporting Configuration
Best Practices in the online help before making changes in a production
environment.

l Parameters

Column Name Accepted Values on
Upload Additional Notes

Parameter
System
Name

Valid parameter
system name

Used for matching for upload.

If a parameter exists, its settings are
changed with the values in the uploaded file.

Display
Name

Parameter display
name

This is included for identification purposes
only and is treated as read-only on upload.

Value Dependent on
parameter being
uploaded

If invalid, the parameter does not upload.

Description Description of
parameter

This is included for identification purposes
only and is treated as read-only on upload.
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Backing Up the Databases

Sopheon does not recommend any specific frequency of backing up your data. You should
back up your data as frequently as is indicated by your company’s policies and needs.

Back up the following Accolade databases.

l Main Accolade Database - Accolade uses a SQL Server database to organize and
persist the major structural elements of the system. By default, this database is named
Accolade, but it can be given a different name during installation.

The Accolade database contains the templates and documents that were stored in
directories on the application server in previous versions of Accolade.

l Snapshots Database - The snapshots database contains snapshots of metrics values
and project metadata and is named <main database name>_Snapshots. For example,
Accolade_Snapshots.

Back up any custom data, such as custom views, custom DLLs, ASP pages, or icon sets, at
least once and each time they are modified. You should also back up your custom data just
before upgrading Accolade.

Icon sets are installed by default in the following directory:

C:\Program Files\Sopheon\Accolade\Etc\IconSets
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Accolade Reporting Views

This appendix lists the standard Accolade reporting views and the contents of each. A reporting
view is a collection of Accolade database fields that relate to a specific Accolade concept, such
as users, projects, or resource pools, or that show the relationship between two objects, such
as templates and deliverables.

Use this appendix as a reference to determine which fields are available in each standard view.
In addition, use the information in this appendix to create custom reporting views.

Appendix A
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Reporting Views Overview
A reporting view is a collection of database fields that relate to a specific Accolade concept,
such as users, projects, or resource pools, or that show the relationship between two objects,
such as templates and deliverables. Insert the database field references in queries to create
Accolade reports.

Accolade contains the following reporting view types:

l Project Reporting Views - Reporting views that contain database fields with project
information begin with RVP_. Reports created with these views use respect the security
set with access groups and security profiles. Users view a chart or report, or previewing
a query, see only data that relates to projects in access groups to which they have
access.

l Non-Project Reporting Views - Reporting views that contain only database fields that
do not relate directly to project begin with RV_. The content in these reporting views is
not affected by access group or security profile access.

l Custom Views - Custom reporting views begin with CRVP_ and CRV_.

To quickly view the list of all reporting views in Accolade, from the System
> Content Sources > Queriesmenu, create and preview the following
query: SELECT * from RV_ReportingViews. Substitute the RV_
ReportingViews portion of the query with any reporting view name to see
the list of all columns within that view.

Standard Accolade Reporting Views
The following table lists and links to the reporting views that are included in the standard
version of Accolade.

Some views, such as RVP_Projects contain information to answer a variety of questions about
a single object, such as a project. Other views, such as RV_ExcelReportQueries are intended
to show the relationships between two object types. You can use them to determine, for
example, which MS Excel workbooks use a particular query or which queries are used by a
particular MS Excel workbook.

Reporting View See Description

RV_ActivityTemplateUse page 637 Cross-references activity templates and their
models.

RV_Classes page 637 Contains class details.
RV_ClassResonLists page 638 Cross-references classes and their lists of

events and reasons.
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Reporting View See Description

RV_
DeliverableTemplateUse

page 638 Cross-references templates and their use in
deliverables.

RV_ExcelReportQueries page 638 Cross-references MS Excel workbooks and
their associated queries.

RV_ExcelTemplateUse page 639 Cross-references MS Excel workbooks and
their associated templates.

RV_GateDocument
TemplateUse

page 639 Contains information about the templates used
in gate documents.

RV_ModelMetrics page 640 Cross-references metrics with the models that
are associated to.

RV_PMDelivActivities page 640 Contains model details about activities,
including deliverable details.

RV_PMDeliverables page 641 Contains model details about deliverables.
RV_PMGateDocuments page 641 Contains gate document details for models.
RV_PMPhases page 642 Contains stage and gate details for models.
RV_ProcessModels page 642 Contains process model details.
RV_Queries page 643 Contains the name and contents of each SQL

Query.
RV_QueryUsage page 643 Cross-references queries with charts, reports,

and MS Excel workbooks.
RV_ReferenceTables page 644 Contains reference table details.
RV_ReportingViews page 644 Lists the reporting views available within

Accolade.
RV_ReportQueries page 644 Cross-references reports and queries.
RV_ResourceAvailabilities page 645 Contains availability details for all Resource

Pools.
RV_ResourcePools page 645 Contains a list off resource pools with their

details and owners.
RV_ResourcePoolOwners page 645 Contains a list of the resource pool owners and

the pools they own.
RV_Resources page 646 Contains resource details.
RV_UserAccessLastLogin page 646 Contains a record of each user's last

successful log on to Accolade.
RV_UserAccessLog page 646 Contains data about user log ons to Accolade.
RV_Users page 648 Contains details about Accolade users.
RV_UsersByGroup page 648 Cross-references users and their access

groups.
RV_UsersByProfile page 648 Cross-references users and their security

profiles.
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Reporting View See Description

RVP_DelegateAssignments page 649 Shows all assignments delegated to users and
who originally owned them.

RVP_MostRecentStatus page 649 Shows the project's manager (team leader) and
most recent status message of each project
with at least one status message.

RVP_MSProjectTasks page 650 Contains tasks created in MS Project.
RVP_ProcessModelUse page 650 Cross-references projects and models.
RVP_ProjectDelivActivities page 651 Cross-references projects with the details of

their deliverables and activities.
RVP_ProjectDeliverables page 652 Cross-reference projects with their

deliverables' details.
RVP_
ProjectGateDocuments

page 653 Cross-references gate documents and their
projects.

RVP_ProjectHistory page 654 Contains project events, reasons, and status
messages.

RVP_ProjectMetrics page 655 Cross-references metric values and project
details.

RVP_
ProjectMigrationHistory

page 655 Identifies which projects were migrated and the
projects they were migrated to.

RVP_ProjectPhases page 656 Contains the stage and gate details for
projects. Gates with more than one gatekeeper
are repeated withonly the gatekeeper details
changing.

RVP_
ProjectResourcePlans

page 657 Contains details about the resource plan for
each project.

RVP_Projects page 658 Contains project details about open and closed
projects.

RVP_ProjectsByGroup page 659 Shows which projects are in each access
group.

RVP_ProjectStatusHistory page 660 Contains status history for projects that have at
least one status message.

RVP_
ProjectTeamMembers

page 661 Contains details about project teammembers
assigned to projects.

RVP_RelatedProjects page 661 Contains details about relationship conflicts
between projects.

RVP_StageLength page 661 Contains the number of days it takes to
complete each stage in each project.

RVP_TimesheetEntries page 662 Contains timesheet entry and approval details.

636



Administrator's Guide

Sopheon Accolade Version 16.2

Reporting View See Description

RVP_UserAssignments page 663 Contains information about which assignments
each user is assigned to.

RVP_UserProjects page 663 Contains user details for each project.
RVP_WorkflowHistory page 664 Contains the workflow history for deliverables

and activities within projects.

Non-Project Reporting Views (RV_) Reference

The following tables list the database columns within the standard Accolade reporting views
that access information not related to projects.

RV_ActivityTemplateUse - Cross references activity templates to their models.

Column Name Data Type Notes

TemplateID Number
TemplateName String
TemplateType String
Category String
TemplateCreatedOn Date
TemplateCreatedBy String
TemplateUploadedOn Date
TemplateUploadedBy String
ProcessModelID Number
ProcessModelName String
PMActivityID Number
PMActivityName String
TemplateSourceName String

RV_Classes - Contains details about classes and where they are available.

Column Name Data Type Notes

ClassID Number
ClassName String
ClassSystemName String
ClassDescription String
ProcessType String
ClassEmailNotification Number 1
ClassInMyProjects Number 1
ClassInMyAssignments Number 1
ClassInMSOffice Number 1
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Column Name Data Type Notes

ClassInGateLineup Number 2
ClassRank Number
IsActive Number 1

RV_ClassReasonLists - Cross references classes with their lists of events and reasons.

Column Name Data Type Notes

ClassID Number
ClassName String
ClassSystemName String
EventID Number
EventName String
ReasonCode String
ReasonName String
IsActive Number 1

RV_DeliverableTemplateUse - Cross references templates and deliverables.

Column Name Data Type Notes

TemplateID Number
TemplateName String
Category String
TemplateType String
TemplateCreatedOn Date
TemplateCreatedBy String
TemplateUploadedOn Date
TemplateUploadedBy String
ProcessModelID Number
ProcessModelName String
PMDeliverableID Number
PMDeliverableName String
TemplateSourceName String

RV_ExcelReportQueries - Cross references Excel workbooks and their queries.

Column Name Data Type Notes

ExcelReportID Number
ExcelReportName String
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Column Name Data Type Notes

Category String
Query1ID Number
Query1Name String
Query2ID Number
Query2Name String
Query3ID Number
Query3Name String
Query4ID Number
Query4Name String
Query5ID Number
Query5Name String
ExcelReportIsActive Number 1
ProjectLevelIsActive Number 1

RV_ExcelTemplateUse - Cross references Excel workbooks and their templates.

Column Name Data Type Notes

TemplateID Number
TemplateName String
Category String
TemplateType String
TemplateCreatedOn Date
TemplateCreatedBy String
TemplateUploadedOn Date
TemplateUploadedBy String
ExcelReportID Number
ExcelReportName String
ExcelReportCategory String
ExcelReportIsActive Number 1
ProjectLevelIsActive Number 1

RV_GateDocumentTemplateUse - Cross references gate documents and the templates they
use.

Column Name Data Type Notes

TemplateID Number
TemplateName String
TemplateCategoryName String
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Column Name Data Type Notes

TemplateType String
TemplateCreatedOn Date
TemplateCreatedBy String
TemplateUploadedOn Date
TemplateUploadedBy String
ProcesModelID Number
ProcessModelName String
PMGateDocumentID Number
PMGateDocumentName String

RV_ModelMetrics - Cross references models and their associated metrics.

Column Name Data Type Notes

ModelID Number
ModelName String
ModelDescription String
ModelIsActive Number 1
MetricID Number
MetricName String
MetricSystemName String
MetricIsRequred Number 1
MetricOnCreationPage Number 3
MetricOnMetricsPage Number 3
MetricOnStatusReport Number 3

RV_PMDelivActivities - Contains model details about activities, including deliverable details.

Column Name Data Type Notes

ProcessModelID Number
ProcessModelName String
ProcessModelDescription String
ProcessModelIsActive Number 1
PhaseID Number
StageName String
StagePurpose String
StageExists Number 1
GateName String
GatePurpose String

640



Administrator's Guide

Sopheon Accolade Version 16.2

Column Name Data Type Notes

GateExists Number 1
DeliverableID Number
DeliverableName String
DeliverableDescription String
DeliverableIsCollaborative Number 1
ActivityID Number
ActivityName String
ActivityDescription String
ActivityIsCollaborative Number 1
ProcessType String
DeliverableRank Number
ActivityRank Number
AccessRoles Sting

RV_PMDeliverables - Contains model details about deliverables.

Column Name Data Type Notes

ProcessModelID Number
ProcessModelName String
ProcessModelDescription String
ProcessModelIsActive Number 1
PhaseID Number
StageName String
StagePurpose String
StageExists Number 1
GateName String
GatePurpose String
GateExists Number 1
DeliverableID Number
DeliverableName String
DeliverableDescription String
DeliverableIsCollaborative Number 1
ProcessType String
Rank Number
AccessRoles String

RV_PMGateDocuments - Contains model details about gate documents.
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Column Name Data Type Notes

ProcessModelID Number
ProcessModelName String
ProcessModelDescription String
ProcessModelIsActive Number 1
PhaseID Number
StageName String
StagePurpose String
StageExists Number 1
GateName String
GatePurpose String
GateExists Number 1
GateDocumentID Number
GateDocumentName String
GateDocumentDescription String
ProcessType String
Rank Number

RV_PMPhases - Contains model details about stages and gates.

Column Name Data Type Notes

ProcessModelID Number
ProcessModelName String
ProcessModelDescription String
ProcessModelIsActive Number 1
PhaseID Number
StageName String
StagePurpose String
StageExists Number 1
GateName String
GatePurpose String
GateExists Number 1
ProcessType String

RV_ProcessModels - Contains details about models.

Column Name Data Type Notes

ProcessModelID Number
ProcessModelName String
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Column Name Data Type Notes

ProcessModelDescription String
DateCreated Date
CreatedBy String
DateUpdated Date
UpdatedBy String
IsActive Number 1
ProcessType String
ClassID Number
ClassName String
CreationProcessStartType String
MigrationProcessStartType String
InitialTab String
DefaultOwner String 4
DefaultAccessGroup String 4
DefaultCurrencyCode String
DefaultCurrencyName String
IdeaDeliverable String 4
Categories String
SnapshotProcessModelID Number
SnapshotVersion Number

RV_Queries - Contains the name and contents of each query.

Column Name Data Type Notes

QueryID Number
QueryName String
QueryText String
QueryDescription String
Category String

RV_QueryUsage - Cross references queries with charts, reports, and Excel workbooks.

Column Name Data Type Notes

QueryID Number
QueryName String
ObjectType String
ObjectID Number
ObjectName String

643



Appendix A  Accolade Reporting Views

Administrator's Guide

Column Name Data Type Notes

IsActive Number 1
Category String
ProjectLevelIsActive Number 1

RV_ReferenceTables - Contains details about reference tables.

Column Name Data Type Notes

RTableID Number
RTableName String
RTableSystemName String
RTableEnabledFieldCodes Number
RTableOwner String
RTOwnerEmail String
RTOwnerVMAddress String
RTOwnerID Number
RTableDescription String
RTableCategory String
RTableAccessGroup String
RTUploadedOn Date
RTColumnNumber Number
RTColumnName String
RTColumnHeading String

RV_ReportingViews - Lists the reporting views available in Accolade.

Column Name Data Type Notes

ViewName String

RV_ReportQueries - Cross references reports and queries.

Column Name Data Type Notes

ReportID Number
ReportName String
Category String
QueryID Number
QueryName String

644



Administrator's Guide

Sopheon Accolade Version 16.2

Column Name Data Type Notes

ReportIsActive Number 1
ProjectLevelIsActive Number 1

RV_ResourceAvailabilities - Contains availability details for resource pools.

Column Name Data Type Notes

ResourceID Number
ResourceName String
UserID Number 6
UserEmailAddress String 6
UserVMAddress String 6
TimePeriodNumber Number
TimePeriodStartDate Date
TimePeriodEndDate Date
Capacity Number
Unavailable Number
NetCapacity Number
PoolID Number
PoolName String
PoolIsActive Number 1

RV_ResourcePools - Contains a list of resource pools with their details and owners.

Column Name Data Type Notes

PoolID Number
Name String
Units String
OwnerID Number
OwnerName String
OwnerEmailAddress String
OwnerVMAddress String
IsActive Number 1

RV_ResourcePoolOwners - Contains a list of resource pool owners and the pools they own.

Column Name Data Type Notes

UserID String
UserName String
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Column Name Data Type Notes

UserEmailAddress String
UserVMAddress String
PoolID Number
PoolName String
PoolIsActive Number 1

RV_Resources - Contains details about resources.

Column Name Data Type Notes

ResourceID Number
ResourceName String
UserID Number
UserEmailAddress String
UserVMAddress String
PoolID Number
PoolName String
PoolIsActive Number 1

RV_UserAccessLastLogin - Contains a record of each user's last successful log in to
Accolade.

Column Name Data Type Notes

UserLogin String
UserID Number
Name String
LastLoginDate Date
IPAddress String
Language String
UserAgent String

RV_UserAccessLog - Contains data about user logins to Accolade.

Column Name Data Type Notes

LoginDate String
UserLogin String
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Column Name Data Type Notes

UserID Number
Name String
LoginResult String
IPAddress String
Language String
UserAgent String
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RV_Users - Contains details about user accounts defined in Accolade.

Column Name Data Type Notes

UserID Number
UserLogin String
Name String
EmailAddress String
ChatAddress String
Deleted Number 1
Is Active Number 1
RoleCode String
RoleName String

RV_UsersByGroup - Cross references users to access groups.

Column Name Data Type Notes

UserID Number
UserLogin String
Name String
AccessGroupName String
ParentGroupName String
EmailAddress String
ChatAddress String
Deleted Number 1

RV_UsersByProfile - Cross references users to security profiles.

Column Name Data Type Notes

UserID Number
UserLogin String
UserName String
SecurityProfileName String
SecurityProvideActive Number 1
Deleted Number 1

Notes:

1. If querying these fields in a WHERE clause, you must specify 1 for True and
0 for False.
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Example: WHERE ClassInMSOffice = 1

The value is returned as True or False.

2. 1 is Always Excluded; 2 is Always Included; 3 is Default to Excluded; 4 is
Default to Included.

3. 0 is Neither; 1 is Show; 2 is Edit.

4. Field is populated only in Idea models.

5. Columns whose names begin with “Sys” are maintained for internal
Sopheon use and may be re-formatted as necessary in future revisions of
Accolade.

6. Only populated when the resource is a user defined in the system, versus a
general resource.

Project Reporting Views (RVP_) Reference

The following tables list the database columns within the standard Accolade reporting views
that access project information.

RVP_DelegateAssignments - Shows all assignments delegated to users and who originally
owned them.

Column Name Data Type Notes

SysProjectID 2
ProjectName String
AssignmentID Number
AssignmentName String
AssignmentType String
DelegatorID Number
DelegatorName String
DelegateID Number
DelegateName String
DueDate Date

RVP_MostRecentStatus - Shows the project’s manager (team leader) and most recent status
message of each project with at least one status message.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
ProjectClosed Number 1
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Column Name Data Type Notes

TeamLeaderID Number
TeamLeaderName String
TeamLeadeEmail String
TeamLeaderVM String
StatusHistoryDate Date
StatusHistoryComment String

RVP_MSProjectTasks - Contains details about Microsoft Project tasks and the tasks' project.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
ProjectClosed Number 1
TeamLeaderID Number
TeamLeaderName String
CurrentPhaseID Number
CurrentStageName String
CurrentStageLocked Number 1
InTrouble Number 1
MSProjTaskID Number
MSProjTaskName String
MSProjTaskDescription String
MSProjTaskStatusCode Number
MSProjTaskStatusName String
MSProjTaskStatusComment String
MSProjTaskOwner Number
MSProjTaskOwnerName String
MSProjTaskOwnerEmail String
MSProjTaskOwnerVMAddress String
MSProjTaskPlannedStartDate Date
MSProjTaskPlannedFinishDate Date
MSProjTaskDeadline Date
MSProjTaskRowNumber Number
ProcessType String

RVP_ProcessModelUse - Cross references projects and models.

Column Name Data Type Notes

SysProjectID 2
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Column Name Data Type Notes

ProjectID Number
ProjectName String
ProjectClosed Number 1
ProcessModelID Number
ProcessModelName String
ProcessType String
ProcessModelIsActive Number 1
ProcessModelDeleted Number 1

RVP_ProjectDelivActivities - Cross references projects with the details of their deliverables
and activities.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
ProjectClosed Number 1
TeamLeaderID Number
TeamLeaderName String
CurrentPhaseID Number
CurrentStageName String
CurrentStageLocked Number 1
InTrouble Number 1
StageName String
StageLocked Number 1
DeliverableID Number
DeliverableName String
DeliverableDescription String
DeliverableIsCollaborative Number 1
DeliverableStatusCode Number
DeliverableStatusComment String
DeliverableStatusName String
DeliverableOwnerID Number
DeliverableOwnerName String
DeliverableOwnerEmail String
DeliverableOwnerVMAddress String
DeliverablePlannedFinishDate Date
DeliverableDeadline Date
DeliverableContentSource Number

651



Appendix A  Accolade Reporting Views

Administrator's Guide

Column Name Data Type Notes

DeliverableContentSourceName String
ActivityID Number
ActivityName String
ActivityDescription String
ActivityIsCollaborative Number 1
ActivityOwnerID Number
ActivityOwnerName String
ActivityOwnerEmail String
ActivityOwnerVMAddress String
ActivityStatusCode Number
ActivityStatusName String
ActivityStatusNote String
ActivityPlannedFinishDate Date
ActivityDeadline Date
ActivityContentSource Number
ActivityContentSourceName String
PredecessorName String
PredecessorTypeName String
PredecessorStageName String
ProcessType String
DeliverableRank Number
ActivityRank Number

RVP_ProjectDeliverables - Cross references projects with the details of their deliverables.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
ProjectClosed Number 1
TeamLeaderID Number
TeamLeaderName String
CurrentPhase Number
CurrentStageName String
CurrentStageLocked Number 1
InTrouble Number 1
StageName String
StageLocked Number 1

652



Administrator's Guide

Sopheon Accolade Version 16.2

Column Name Data Type Notes

DeliverableID Number
DeliverableName String
DeliverableDescription String
DeliverableIsCollaborative Number 1
DeliverableStatusCode Number
DeliverableStatusComment String
DeliverableStatusName String
DeliverableOwner Number
DeliverableOwnerName String
DeliverableOwnerEmail String
DeliverableOwnerVMAddress String
PlannedFinishDate Date
DeliverableDeadline Date
DeliverableContentSource Number
DeliverableContentSourceName String
PredecessorName String
PredecessorTypeName String
PredecessorStageName String
ProcessType String
Rank Number

RVP_ProjectGateDocuments - Cross references gate document and their projects.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
ProjectClosed Number 1
TeamLeaderID Number
TeamLeaderName String
TeamLeaderEmail String
TeamLeaderVMAddress String
CurrentPhase Number
CurrentStageName String
CurrentStageLocked Number 1
InTrouble Number 1
StageName String
StageLocked Number 1
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Column Name Data Type Notes

GateOwnerID Number
GateOwnerName String
GateOwnerEMail String
GateOwnerVMAddress String
GateName String
GateDocumentID Number
GateDocumentName String
GateDocumentDescription String
GateDocumentContentSource Number
GateDocumentContentSourceName String
ProcessType String
Rank Number

RVP_ProjectHistory - Contains project events, reasons, and status messages.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
ProjectClosed Number 1
EventDate Date
EventType String
EventText String
Reason String
ReasonCode String
ReasonName String
EventUserName String
EventUserLogin String
StageName String
EventGateNumber Number 1
EventGateName String
FunctionID Number
FunctionName String
ChangeFromDate Date
ChangeToDate Date
ChangeFromDecision String
ChangeToDecision String
ChangeFromName String

654



Administrator's Guide

Sopheon Accolade Version 16.2

Column Name Data Type Notes

ChangeToName String
ChangeFromCurrency String
ChangeToCurrency String
ChangeToInTrouble Number 1

RVP_ProjectMetrics - Cross references metric values with project details.

Important! If Accolade contains more than 5000 projects, you must use a custom
view instead of RVP_ProjectMetrics to report on metric values, or use another
reporting method, such as Accolade Office Extensions or Accolade Online
Reporting.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
TeamLeaderID Number
TeamLeaderName String
TeamLeaderEmail String
TeamLeaderVM String
InTrouble Number 1
ProjectClosed Number 1
MetricID Number
DisplayName String
MetricName String 3
Category String
MetricType Number
CurrencyMetric Number 1
MetricValue String
MetricDisplaySequence Number
FilterMetric Number 1
MetricLastUpdatedDateTime Date
ProcessType String

RVP_ProjectMigrationHistory - Identifies which projects were migrated to other projects.

Column Name Data Type Notes

SysProjectID 2
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Column Name Data Type Notes

ProjectID Number
ProjectName String
ProjectDesc String
ProjectDateCreated Date
ProjectDateClosed Date
ProjectClosed Number 1
PromectPMID Number
ProjectPMName String
ProjectMigratedToID String
ProjectMigratedToName String
ProjectMigratedToDesc String
ProjectMigratedToDateCreated Date
ProjectMigratedToDateClosed Date
ProjectMigratedToClosed Number 1
ProjectMigratedToPMID Number
ProjectMigratedToPMName String
ProjectMigratedFromID String
ProjectMigratedFromName String
ProjectMigratedFromDesc String
ProjectMigratedFromDateCreated Date
ProjectMigratedFromDateClosed Date
ProjectMigratedFromClosed Date
ProjectMigratedFromPMID Number
ProjectMigratedFromPMName String
Reason String
MigratedToDate Date

RVP_ProjectPhases - Contains the stage and gate details for projects. Gates with more than
one gatekeeper are repeated with only the gatekeeper details changing.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
InTrouble Number 1
TeamLeaderID Number
ProcessModelID Number
ProcessModelName String
PhaseID Number
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Column Name Data Type Notes

IsCurrentPhase Number 1
StageName String
StagePurpose String
StageExists Number 1
StageLocked Number 1
GateName String
GatePurpose String
GateExists Number 1
GateDate Date
GateMeetingPlace String
GateDecisionCode Number
GateComment String
GateConditions String
GatePlanDate Date
GateDecisionName String
GateKeeperPMID Number
GateKeeperID Number
GateKeeperUserID Number
GateKeeperUserName String
GateKeeperUserEmail String
GateKeeperVMAddress String
GateKeeperVote String
DateCreated Date
ProjectClosed Number 1
ProcessType String

RVP_ProjectResourcePlans - Contains details about resource plans defined for each
project.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
ProjectResourcePlanIsActive Number 1
ProjectPhaseID Number
ProjectStageName String
StageLocked Number 1
PoolID Number
PoolName String
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Column Name Data Type Notes

ResourceID Number
ResourceName String
UserID Number
TimePeriodNumber Number
TimePeriodStartDate Date
TimePeriodEndDate Date
DemandID Number
DemandTypeID Number
DemandType String
DemandDateCreated Date
DemandValue Number
DemandIsActive Number 1

RVP_Projects - Contains details about open and closed projects.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
Description String
ProjectCurrencyCode String
ProjectCurrencyName String
ConversionFactor Number
TeamLeaderID Number
TeamLeaderName String
TeamLeaderEmail String
TeamLeaderVM String
TeamLeaderCanManageTeam Number 1
InTrouble Number 1
DateCreated Date
CreatedBy String
DateClosed Date
ProjectClosed Number 1
CurrentPhaseID Number
CurrentStageName String
StageLocked Number 1
ProcessModelID Number
ProcessModelName String

658



Administrator's Guide

Sopheon Accolade Version 16.2

Column Name Data Type Notes

NextGateID Number
NextGateName String
NextGateMeetingPlace String
NextGatePurpose String
NextGateDate Date
GatePlanDate Date
ProcessType String
ClassID Number
ClassName String
IdeaSubmittersName String
IdeaSubmittersEMail String
AvailableForResubmission Number 1
DateReturnedToSubmitter Date
ExcludeFromLineUp Number 1
LastGateDecision String
LastGateDecisionCode Number
LastGateDecisionsComment String
PreviousGoConditional Number 1
ProjectSysIDMigratedFrom Number
ProjectSysIDMigratedTo Number

RVP_ProjectsByGroup - Details which projects are in each access group.

Column Name Data
Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
AccessGroupName String
ParentGroupName String
Description String
TeamLeaderID Number
TeamLeaderName String
TeamLeaderEmail String
TeamLeaderVM String
InTrouble Number 1
DateCreated Date
DateClosed Date
ProjectClosed Number 1
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Column Name Data
Type Notes

CurrentPhaseID Number
CurrentStageName String
StageLocked Number 1
ProcessModelID Number
ProcessModelName String
NextGateID Number
NextGateName String
NextGateMeetingPlace String
NextGatePurpose String
NextGateDate Date
GatePlanDate Date
ProcessType String
ClassID Number
ClassName String
IdeaSubmittersName String
IdeaSubmittersEMail String
AvailableForResubmission Number 1
DateReturnedToSubmitter Date
ExcludeFromLineUp Number 1

RVP_ProjectStatusHistory - Contains the history of status messages for projects that have at
least one status message.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
ProjectClosed Number 1
TeamLeaderID Number
TeamLeaderName String
TeamLeaderEmail String
TeamLeaderVM String
InTrouble Number 1
StatusHistoryDate Date
StatusHistoryComment String
ProcessType String
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RVP_ProjectTeamMembers - Contains details about the members of each project team.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
CurrentPhase Number
CurrentStageName String
StageLocked Number 1
InTrouble Number 1
TeamMemberUserID Number
TeamMemberName String
TeamMemberEmail String
TeamMemberVMAddress String
TeamMemberDeleted Number 1
TeamMemberFunction String
ProcessType String
ProjectClosed Number 1

RVP_RelatedProjects - Contains details about relationships between projects.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
LinkType String
DependencyType String
InConflict Number 1
ConflictCreatedOn Date
ConfictCreatedBy String
SysRelatedProjectID Number 2

RVP_StageLength - Contains the number of days it takes to complete each stage in a project.

Column Name Data Type Notes

SysProjectID 2
ProjectID Number
ProjectName String
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Column Name Data Type Notes

ProjectClosed Number 1
ProcessModelID Number
ProcessModelName String
PhaseID Number
StageName String
StageLocked Number 1
StageLength Number 4
GateDate Date
GatePlanDate Date
PreviousGateDate Date
PreviousGateDecision String
PreviousGateDecisionCode Number

RVP_TimesheetEntries - Contains information about timesheet entries and approvals.

Column Name Data Type Notes

TimesheetID Number
StartDate Date
EndDate Date
OwnerID Number
OwnerLogin String
OwnerName String
StatusID Number
[Status] String
StatusComment String
UpdatedByID Number
UpdatedByLogin String
UpdatedByName String
UpdatedDate Date
ApproverID Number
ApproverLogin String
ApproverName String
ApprovalDate Date
OriginalApproverID Number
OriginalApproverLogin String
OriginalApproverName String
RowID Number
SysProjectID Number 2
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Column Name Data Type Notes

ProjectName String
RowApproverID Number
RowApproverLogin String
RowApproverName String
RowApprovalDate Date
RowOriginalApproverID Number
RowOriginalApproverLogin String
RowOriginalApproverName String
EFS1 to EFS10 String 5
EFN1 to EFN10 Number 5
EFD1 to EFD10 Date 5
EFL1 to EFL10 String 5
EFLS1 to EFLS10 String 5
EFM1 to EFM10 String 5
EntryDate Date
EntryValue Number

RVP_UserAssignments - Contains information about the assignments assigned to each
user.

Column Name Data Type Notes

UserID Number
UserName String
SysProjectID 2
ProjectID Number
ProjectName String
ProjectClosed Number 1
AssignmentName String
Deadline Date
PlannedFinishDate Date
Status String
StatusComment String
AssignmentType String

RVP_UserProjects - Cross references user details with the projects to which they are a
member.
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Column Name Data Type Notes

UserID Number
UserLogin String
Name String
EmailAddress String
ChatAddress String
Deleted Number 1
SysProjectID 2
ProjectID Number
ProjectName String
ProjectClosed Number 1
ProcessType String
ClassID Number
ClassName String

RVP_WorkflowHistory - Contains the history of workflows for each deliverable and activity.

Column Name Data Type Notes

SysProjectID Number
ProjectID Number
ProjectName String
ProjectClosed Number 1
PhaseID Number
StageName String
DeliverableID Number
DeliverableName String
ActivityID Number
ActivityName String
Reauthenticated Number 1
FunctionName String
OwnerID Number
OwnerName String
EventDate Date
EventID Number
EventName String
DecisionID Number
DecisionName String
Step String
Action String
VersionID Number
Explanation String
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Notes:

1. If querying these fields in a WHERE clause, you must specify 1 for True and
0 for False.

Example: WHERE ClassInMSOffice = 1

The value is returned as True or False.

2. Columns whose names begin with “Sys”, such as SysProjectID, are
maintained for internal Sopheon use and may be re-formatted as necessary
in future revisions of Accolade.

3. This is the system name of the metric.

4. Value equals days between previous gate meeting and next gate meeting.

5. Extended fields flagged as available to Timesheet Entry. EFS = String
fields, EFN = Number fields, and so on.

Custom Reporting Views
Create custom views into Accolade data to supplement the standard Accolade views.

To create stable custom views, base each view on existing RV_ and RVP_ views rather than
SGM tables. RV_ and RVP_ views are more stable across Accolade releases, which
SGM tables are more likely to change with each Accolade version.

Caution! If you create views based on SGM tables, understand that
these views might fail when Accolade is upgraded. Sopheon
recommends that you create any custom view from an SGM view or MD
view.

Custom Reporting View Requirements

Ensure that your custom views meet the following requirements:

Requirements Description

File Name All custom views begin with either CRV_ or CRVP. Custom views
using the RV_, RVP_, or other prefixes are dropped during an
Accolade upgrade.
l CRV_ - Use this prefix for views that do not require access group
security.

l CRVP_ - Use this prefix for views that require access group
security, for example, views into project-level data.

Accolade
Permission

Views must have GRANT SELECT ON [dbo].[Name of View]
TO [SGM_Write] at the bottom of the view. This allows Accolade
permission to access the view.
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Requirements Description

For example:
  Create View dbo.CRVP_ProjectsExample as

SELECT ProjectName,

Description

FROM RVP_Projects with (NOLOCK)

GO

SET QUOTED_IDENTIFIER OFF SET ANSI_NULLS ON

GO

GRANT SELECT ON [dbo].[CRVP_ProjectsExample]
TO [SGM_Write]

GO

Lock Prevention You must specify with (NOLOCK) after each view or table
declaration. This prevents the view or table from being locked when a
user accesses the custom view. A locked view or table may prevent
another user from using Accolade.

For example:
  Create View dbo.CRVP_ProjectsExample as

SELECT ProjectName,

Description

FROM RVP_Projects with (NOLOCK)

GO

SET QUOTED_IDENTIFIER OFF SET ANSI_NULLS ON

GO

GRANT SELECT ON [dbo].[CRVP_ProjectsExample]
TO

[SGM_Write]

GO

Aliases

If the custom view requires that any of the returned columns need to be aliased, then the
aliased columns must be aliased without quotes. If they are aliased with quotes, users are not
able to use them in their queries in Accolade.

For example:

Create View dbo.CRVP_ProjectsExample as

SELECT ProjectName,

Description as ProjectDescription

FROM RVP_Projects with (NOLOCK)

GO
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SET QUOTED_IDENTIFIER OFF SET ANSI_NULLS ON

GO

GRANT SELECT ON [dbo].[CRVP_ProjectsExample] TO

[SGM_Write]

GO

Linkable Names

If you want a CRVP_ view to support project names that appear in reports as links to their
project (linkable names), return SysProjectID and the project's name. These fields are
already included in all existing RVP_ views, and a SELECT statement returns the column.

For example:

Create View dbo.CRVP_ProjectsExample as

SELECT SysProjectID, ProjectName,

Description

FROM RVP_Projects with (NOLOCK)

GO

SET QUOTED_IDENTIFIER OFF SET ANSI_NULLS ON

GO

GRANT SELECT ON [dbo].[CRVP_ProjectsExample] TO

[SGM_Write]

GO

To support linkable names in a CRVP_ view based on SGM tables, alias ProjectID in the
SGM_Projects table as SysProjectID. This ProjectID is an internal Accolade ID, not the
ID entered at project creation.

For example:

Create View dbo.CRVP_ProjectsExample as

SELECT P.ProjectID as SysProjectID,

P.ProjectName,

P.Description

FROM SGM_Projects P with (NOLOCK),

SGM_AccessNodes AN with (NOLOCK)

WHERE P.AccessNodeID = AN.AccessNodeID

GO

SET QUOTED_IDENTIFIER OFF SET ANSI_NULLS ON

GO

GRANT SELECT ON [dbo].[CRVP_ProjectsExample] TO

[SGM_Write]

GO
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ProjectID

If the CRVP_ view requires the ProjectID that the user enters at project creation, get the
ProjectID in an existing RVP_ view. As SysProjectID and ProjectID are already
included in most RVP_ Views.

For example:

Create View dbo.CRVP_ProjectsExample as

SELECT SysProjectID,

ProjectID,

ProjectName,

Description

FROM RVP_Projects with (NOLOCK)

GO

SET QUOTED_IDENTIFIER OFF SET ANSI_NULLS ON

GO

GRANT SELECT ON [dbo].[CRVP_ProjectsExample] TO

[SGM_Write]

GO

To get the ProjectID in a CRVP_ view based on SGM tables use the ProjectCode column
in the SGM_Projects table. Alias ProjectCode as ProjectID to be consistent with how it is
returned everywhere else.

For example:

Create View dbo.CRVP_ProjectsExample as

SELECT P.ProjectID as SysProjectID,

P.ProjectCode as ProjectID,

P.ProjectName as ProjectName,

P.Description as Description

FROM SGM_Projects P with (NOLOCK),

SGM_AccessNodes AN with (NOLOCK)

WHERE P.AccessNodeID = AN.AccessNodeID

GO

SET QUOTED_IDENTIFIER OFF SET ANSI_NULLS ON

GO

GRANT SELECT ON [dbo].[CRVP_ProjectsExample] TO

[SGM_Write]

GO

668



Administrator's Guide

Sopheon Accolade Version 16.2

Custom Views for Metrics

A custom view that you can query using the substitution token *{metric:P:<metric name>}*
must include the columns MetricID, MetricName, and MetricValue. These columns can
be found in the RVP_ProjectMetrics view and can be joined to a custom view.

Note: If you must base a metrics view on SGM tables, contact Sopheon Customer
Support.

The following example is for a custom view based on the RVP_ProjectMetrics standard view.

For example:

Create View dbo.CRVP_ProjectsExample as

SELECT SysProjectID,

ProjectID,

ProjectName,

MetricID,

MetricName,

MetricValue

FROM RVP_ProjectMetrics with (NOLOCK)
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Reporting Columns by Subject

This section lists the column sets and columns in each Subject available for reports containing
Accolade data using any of the following reporting methods:

l Reports created in MS Excel with the Accolade Office Extensions add-in.

l Online reports created within Accolade.

The standard Subjects that are available include the following:

l Projects

l Related Projects

l Reference Tables

l Resources

l Users

l Classes

l Models

l Access Groups

l Metric Definitions

l Reference Table Definitions

l Matrix Definitions

l Time Tracking

l Project Snapshot History

l Project Resource Snapshot History

l Resource Snapshot History
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l Scenario Projects

l Scenario Resource Plans

Each Subject is divided into several groups of columns that contain similar information. Some
column sets may be unavailable if the associated Accolade modules have not been installed.

If the standard Subjects are not sufficient, Sopheon Client Services can create customized
Subjects for you

Projects Subject
The Projects subject in reporting contains data on project assignments, metric values, project
details, teammembers, matrices, and other project information.

Project Access Group Information

Column Name Data Type

Access Group Name String

Parent Access Group Name String

System Access Group ID ID

Project Activities

Column Name Data Type

Project Activity Name String

Project Activity Owner Name String

Project Activity Owner Changed By String

Project Activity Owner Changed Date Date

Project Activity Start Date Date

Project Activity Start Date Type List

Project Activity Start Date Offset Number

Project Activity Deadline Date

Project Activity Deadline Type List

Project Activity Deadline Offset Number

Project Activity Plan Date Date

Project Activity Function String

Project Activity Functional Area String

Project Activity Functional System Name String

Project Activity Last Published Date Date
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Column Name Data Type

Project Activity Status List

Project Activity Status Notes String

Project Activity Status Changed By String

Project Activity Status Change Date Date

Project Activity Published Boolean

Project Activity Order Number

Project Activity Is Collaborative Boolean

Project Activity Predecessor Name String

Project Activity Predecessor Type String

Project Activity Predecessor Stage Name String

Project Activity <extended field name> Varied, based on field type

System Project Activity ID ID

System Project Activity Owner ID ID

System Project Activity Status Code ID

Project Deliverables

Column Name Data Type

Project Deliverable Name String

Project Deliverable Owner Name String

Project Deliverable Owner Changed By String

Project Deliverable Owner Changed Date String

Project Deliverable Start Date Date

Project Deliverable Start Date Type List

Project Deliverable Start Date Offset Number

Project Deliverable Deadline Date

Project Deliverable Deadline Type List

Project Deliverable Deadline Offset Number

Project Deliverable Plan Date Date

Project Deliverable Function String

Project Deliverable Functional Area String

Project Deliverable Last Published Date Date

Project Deliverable Status List

Project Deliverable Status Notes String
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Column Name Data Type

Project Deliverable Status Changed By String

Project Deliverable Status Change Date Date

Project Deliverable Published Boolean

Project Deliverable Order Number

Project Deliverable Is Collaborative Boolean

Project Deliverable Predecessor Name String

Project Deliverable Predecessor Type String

Project Deliverable Predecessor Stage Name String

Project Deliverable <extended field name> Varied, based on field type

System Project Deliverable ID ID

System Project Deliverable Owner ID ID

System Deliverable Status Code ID

Project Details

Column Name Data Type

Project Name String

Project Thumbnail Image

Project Description String

Project Currency Code List

Project Currency Name List

Project Currency Conversion Factor Number

Project ID ID

Project Process Type List

Project Class List

Project Model Name String

Project Creation Date Date

Project Created By String

Project Manager Name String

Project Manager Can Manage Team Boolean

Project Start Date Date

Project End Date Date

Project Duration Number

Project Last Gate Decision List
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Column Name Data Type

Project Current Stage Name String

Project Is In Trouble Boolean

Project Most Recent Status Report Date Date

Project Most Recent Status Report Submitter
Name

String

Project Most Recent Status Report Text String

Project Excluded from Line-ups Boolean

Project Closed Boolean

Project Closed Date Date

Project Enforce Project Security Boolean

Idea Submitter Name String

Migrated-from Project Name String

System Project ID ID

System Project Rank ID

System Project Manager ID ID

System Project Current Phase ID ID

System Project Last Gate Decision Code ID

System Project Model ID ID

System Migrated-from Project ID ID

Project Extended Project Data

Column Name Data Type

Extended Project Data 1...10* String

* A single column for each Extended Project Data metadata field available in the project. For example,
Extended Project Data 1, Extended Project Data 2, etc. The name set for the column in the process model the project
uses is used in the compiled report.

Project Gate Documents

Column Name Data Type

Project Gate Document Name String

Project Gate Document Published Boolean

Project Gate Document Order Number
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Project Gatekeepers

Column Name Data Type

Project Gatekeeper Name String

Project Gatekeeper Function (String) String

Project Gatekeeper Function (List) List

Project Gatekeeper Vote String

Project Gatekeeper Vote Comments String

System Project Gatekeeper ID ID

Project History

Column Name Data Type

Event Date Date

Event Type List

Event Reason List

Event Reason Code List

Event Reason Name List

Event User Name String

Event User Login String

Event Stage Number Number

Event Stage Name String

Event Gate Number Number

Event Gate Name String

Event Text String

Event Function Name List

Change-from Date Date

Change-to Date Date

Change-from Decision List

Change-to Decision List

Change-from Project Name String

Change-to Project Name String

Change-from Name String

Change-to Name String

Change-from Currency Code List
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Column Name Data Type

Change-to Currency Code List

Change-to In Trouble Flag Boolean

System Event User ID ID

System Change-from User ID ID

System Change-to User ID ID

Project Link Rules

Column Name Data Type

Rule Name String

Rule Link Type List

Rule Model List

Rule Condition Metric List

Rule Condition Metric Value String

Rule Condition Source Metric List

System Link Type ID ID

System Model ID ID

System Rule Metric ID ID

System Rule Source Metric ID ID

Project Related Projects

Column Name Data Type

Related Project System Project ID ID

Related Project System Link Type ID ID

Related Project Link Type Name List

Related Project In Conflict Boolean

Related Project Conflict Created On* Date

Related Project Conflict Created By* String

Related Project Dependency Left Date Type
Name

String

Related Project Dependency Left Date Name String

Related Project Dependency Right Date Type
Name

String
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Column Name Data Type

Related Project Dependency Right Date Name String

Related Project Dependency Left Date Date

Related Project Dependency Right Date Date

* Indicates who created the original conflict, and when. If a correction is made to try to resolve the conflict, but a conflict
still exists, only the original conflict information is reported.

Project Resource Plans

Column Name Data Type

Project Resource Pool Name String

Project Resource Name String

Project Period Start Date Date

Project Period End Date Date

Project Resource Demand Type List

Project Resource Demand Curve List

Project Resource Demand Multiplier Number

Project Resource Demand Value Number

Project Resource Demand Is Active Boolean

System Project Resource Pool ID ID

System Project Resource ID ID

System Project Resource Period ID ID

System Project Resource Demand Type ID ID

Resource Plan Effective Time Period ID ID

Resource Plan Effective Time Period String

Project Security List - <security list name>

There can be up to five security lists.

Column Name Data Type

<list name> Selected Value Name String

<list name> Selected Level Name List

<list name> <level 1 name> List (from 1 to 10 levels)
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Project Stages and Gates

Column Name Data Type Additional Notes

Project Stage Exists Boolean

Project Stage Name String

Project Stage Relative Position List For each stage in the report,
shows the relationship to the cur-
rent stage by returning an item
from the list: Past, Previous, Cur-
rent, Next, Future.

Project Stage Duration Number Days from the last gate date to
the next gate date.

Project Stage Locked Boolean

Project Gate Exists Boolean

Project Gate Name String

Project Gate Owner Name String

Project Gate Date Date

Project Gate Date Metric Name String Gate date metric name will only
display in the report if the gate is
calculated by its associated met-
ric.

Project Gate Decision List

Project Gate Meeting Place String

Project Gate Notes String

Project Gate Conditions String

Project Gate Plan Date Date

Project Gate Relative Position List For each gate in the report,
shows the relationship to the next
gate by returning an item from the
list: Past, Previous, Next, Future.

System Project Phase ID ID

System Project Gate Owner ID ID

System Gate Decision Code ID

Project Team Members

Column Name Data Type

Project TeamMember Name String
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Column Name Data Type

Project TeamMember Function (String) String

Project TeamMember Function (List) List

System TeamMember ID ID

Project TeamMember Is Primary Boolean

MS Project Tasks

Column Name Data Type

MS Project Task Name String

MS Project Task Owner Name String

MS Project Task Description String

MS Project Task Deadline Date

MS Project Task Planned Start Date Date

MS Project Task Planned Finish Date Date

MS Project Task Status List

MS Project Task Status Notes String

MS Project Task Status Changed By String

MS Project Task Change Date Date

MS Project Task Row Number Number

System MS Project Task ID ID

System MS Project Task Owner ID ID

System MS Project Task Status Code ID

Metric Change History

Column Name Data Type

Metric Name String

Metric System Name String

Metric Category String

Updated By String

Updated On Date

Update Source String

Value Before Update Varied, based on metric type

Value After Update Varied, based on metric type
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Column Name Data Type

SystemMetric ID ID

System Updated By ID ID

System Updated Source ID ID

Trended Metric History

Column Name Data Type

Change Source Name String

Change Event Date Date

Stage ID ID

Trended - <Metric Name>* String

* Each metric that is set to Track History and is set as Available to Reporting is listed as an available column in the
Trended Metric History column set.

Matrix - <matrix name>

Each Matrix column set contains the metrics columns that are in the matrix. More than one
matrix may be listed. Matrices are specific to each company; therefore, there is not a standard
set of column names.

<metric category names>

Metrics that are available to the Table Wizard are listed under subheadings that reflect the
metric categories. Metrics are specific to each company; therefore, there is not a standard set
of column names.

Related Projects Subject
The Related Projects subject in reporting contains the names of each project link type and any
conflicts for those that dependent on another project.

Column Name Data Type

System Link Type ID ID

Link Type Name List

System Link From Project ID ID

System Link to Project ID ID

Related Project in Conflict Boolean

Related Project Conflict Created On* Date
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Column Name Data Type

Related Project Conflict Created By* String

Dependency Left Date Type Name String

Dependency Left Date Name String

Dependency Right Date Type Name String

Dependency Right Date Name String

Dependency Left Date Date

Dependency Right Date Date

* Indicates who created the original conflict, and when. If a correction is made to try to resolve the conflict, but a conflict
still exists, only the original conflict information is reported.

Reference Tables Subject
The Reference Tables subject in reporting contains columns within each reference table.
Reference tables are unique to each company; therefore, there is not a standard set of column
names.

Note: The Reference Tables subject is not available in the Report Generator.

To determine what tables and columns have been created in your company, either go to the
Reference Tables page in Accolade or create a report selecting the Reference Tables
Definitions subject.

Resources Subject
The Resources subject in reporting contains data about Resource Planning.

Pool Security List: (security list name)

Column Name Data Type

<list name> Selected Value Name String

<list name> Selected Level Name List

<list name> <level name> List (from 1 to 10 levels)

Resource Capacities

Column Name Data Type

Resource Capacity Start Date Date

Resource Capacity End Date Date
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Column Name Data Type

Resource Capacity Number

Resource Capacity Unavailable Number

System Resource Period ID ID

Resource Demands

Column Name Data Type

Resource Demand Project Name String

Resource Demand Project Stage Name String

Resource Demand Start Date Date

Resource Demand End Date Date

Resource Demand Type List

Resource Demand Curve String

Resource Demand Multiplier Number

Resource Demand Value Number

Resource Demand Is Active Boolean

System Resource Demand Project ID ID

System Resource Demand Project Phase ID ID

System Resource Demand Type ID ID

Resource Demand Effective Time Period ID ID

Resource Demand Effective Time Period String

Resource Pools

Column Name Data Type

Resource Pool Name String

Resource Pool Owner Name String

Resource Pool Is Active Boolean

Resource Pool Unit of Measure String

System Resource Pool ID ID

System Resource Pool Owner ID ID

<extended field name> Varied, based on field type
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Resources

Column Name Data Type

Resource Name String

Resource System Name String

Resource Account Status* See footnote

System Resource Pool Member ID ID

System Resource Pool Member User ID ID

* The Resource Account Status column is obsolete. It is included only for backwards compatibility and will be
removed in a future Accolade release.

Users Subject
The Users subject in reporting contains information about user accounts, their setup, and their
project assignments.

User Details

Column Name Data Type

User Name String

User Login String

User Email Address String

User Chat Address String

User Default View Name String

Language String

Date Format Code String

Enable Auto Search Boolean

User Account Status Boolean

User Active Boolean

Delegate Name String

Delegate Email Address String

Delegate Chat Address String

Can Update All My Work Boolean

User Default View Name String

Delegate Start Date Date

Delegate End Date Date
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Column Name Data Type

Expiration Date Date

System User ID ID

System User Default View ID ID

<extended field name> Varied, based on field type

User Project Assignments

Column Name Data Type

User Project Name String

User Assignment Type List

User Assignment Name String

User Assignment Status String

User Assignment Deadline Date

User Assignment Project Closed Boolean

System User Project ID ID

User Roles

Column Name Data Type

User Role Name List

System User Role ID ID

User Security List: <security list name>

Column Name Data Type

<list name> Selected Value Name String

<list name> Selected Level Name List

<list name> <level name> List (from 1 to 10 levels)

Classes Subject
The Classes subject in reporting contains data on class attributes used to organize process
models.
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Class Details

Column Name Data Type

Class Name String

Class System Name String

Class Description String

Class Process Type List

Class Order Number

Class Active Boolean

Enable Email Notifications Boolean

Include in Work Pod Boolean

Include in Save to Accolade Boolean

Include in Resource Editor Boolean

Include in Portfolio Optimizer Boolean

Include in Planning Boolean

Reporting Visibility List

Class Icons String

IsPlanning Boolean

IsPortfolio Boolean

System Class ID ID

System Planning Process Model ID ID

Class Reason Codes

Column Name Data Type

Event Name List

Event Reason Code List

Event Reason Name List

Event Reason Active Boolean

System Event ID ID

Models Subject
The Models subject in reporting contains data about model details, stages and gates,
deliverables, activities, and gatekeepers assigned to the model.
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Model Activities

Column Name Data Type

Model Activity Name String

Model Activity Description String

Model Activity Enforce Function on User Selec-
tion

Boolean

Model Activity Function List

Model Activity Function System Name List

Model Activity Functional Area List

Model Activity Start Date Type List

Model Activity Start Date Offset Number

Model Activity Deadline Type List

Model Activity Deadline Offset Number

Model Activity Template Name String

Model Activity Template Created On Date

Model Activity Template Created By String

Model Activity Template Uploaded On Date

Model Activity Template Uploaded By String

Model Activity Linked TO String

Model Activity Publish On Upload List

Model Activity Access Roles List

Model Activity Workflow Template Name String

Model Activity Workflow Template Created On Date

Model Activity Workflow Template Created By String

Model Activity Workflow Template Uploaded On Date

Model Activity Workflow Template Uploaded By String

Model Activity Allows Version Deletion Boolean

Model Activity Order Number

Model Activity Is Collaborative Boolean

Model Parent Deliverable Name String

System Activity ID ID

System Activity Template Creator ID ID

System Activity Template Uploader ID ID
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Model Deliverables

Column Name Data Type

Model Deliverable Name String

Model Deliverable Description String

Model Deliverable Enforce Function on User
Selection

Boolean

Model Deliverable Function List

Model Deliverable Function System Name List

Model Deliverable Functional Area List

Model Deliverable Start Date Type List

Model Deliverable Start Date Offset Number

Model Deliverable Deadline Type List

Model Deliverable Deadline Offset Number

Model Deliverable Template Name String

Model Deliverable Template Created On Date

Model Deliverable Template Created By String

Model Deliverable Template Uploaded On Date

Model Deliverable Template Uploaded By String

Model Deliverable Linked TO String

Model Deliverable Publish On Upload List

Model Deliverable Access Roles List

Model Deliverable Workflow Template Name String

Model Deliverable Workflow Template Created
On

Date

Model Deliverable Workflow Template Created
By

String

Model Deliverable Workflow Template Uploaded
On

Date

Model Deliverable Workflow Template Uploaded
By

String

Model Deliverable Is Required Boolean

Model Deliverable Allows Version Deletion Boolean

Model Deliverable Routing Method List

Model Deliverable Order Number
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Column Name Data Type

Model Deliverable Is Collaborative Boolean

System Deliverable ID ID

System Deliverable Template Creator ID ID

System Deliverable Template Uploader ID ID

Model Details

Column Name Data Type

Model Name String

Model Description String

Model Process Type List

Model Class List

Model Active Boolean

Model Deleted Boolean

Model Related Document Categories String

Model Default Project Manager Required On
Create

Boolean

Model Default Project Manager Metric Name List

Model Default Access Group Metric Name List

Model Project Name Metric Name String

Model Project ID Metric Name String

Model Default Idea Manager String

Model Default Idea Access Group String

Model Default Idea Currency Code List

Model Default Idea Currency Name List

Model Enforce Project Security Boolean

Model Gates Page set to read-only Boolean

Model DTIC Support Enabled Boolean

System Model ID ID

System Class ID ID

System Model Default Idea Manager ID ID

System Model Default Access Group ID ID

System Model Default Project Manager Metric ID ID
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Column Name Data Type

SystemModel Default Portfolio Model ID ID

System Model Default Access Group Metric ID ID

Enforce Function For Team Selection Boolean

Prevent Delete Versions Boolean

Model Gate Documents

Column Name Data Type

Model Gate Document Name String

Model Gate Document Description String

Model Gate Document Template Name String

Model Gate Document Allows Version Deletion Boolean

Model Gate Document Order Number

System Gate Document ID ID

Model Link Rules

Column Name Data Type

Rule Name String

Rule Link Type Li\st

Rule Model List

Rule Condition Metric List

Rule Condition Metric Value String

Rule Condition Source Metric List

System Link Type ID ID

System Model ID ID

System Rule Metric ID ID

System Rule Source Metric ID ID

Model Gatekeepers

Column Name Data Type

Model Gatekeeper Name String

Model Gatekeeper Function (String) String

Model Gatekeeper Function (List) List
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Column Name Data Type

Model Gatekeeper Enforce Function on User
Selection

Boolean

System Gatekeeper ID ID

Model Metrics

Column Name Data Type

Metric Name String

Metric System Name String

Metric Required Boolean

Metric Show In Planning Boolean

Metric Usage - Creation List

Metric Usage - Metrics List

Metric Usage - Status Report List

Metric Usage - Portfolio List

System Metric ID ID

Model Reports

Column Name Data Type

Report Name String

Report Type List

System Report ID ID

Model Restricted Access Groups

Column Name Data Type

Restricted Access Group ID ID

Restricted Access Group Name String

Model Stages and Gates

Column Name Data Type

Model Stage Exists Boolean

Model Stage Name String

Model Stage Description String
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Column Name Data Type

Model Gate Exists Boolean

Model Gate Name String

Model Gate Description String

Model Gate Date Set on Project Creation Boolean

Model Gate Date Required on Project Creation Boolean

Model Gate Date Metric Name String

Model Gate Date MinimumMetric ID ID

Model Gate Date MinimumMetric Name String

Model Gate Date MaximumMetric ID ID

Model Gate Date MaximumMetric Name String

Model Gate Layout Name String

System Phase ID ID

System Model Gate Layout ID ID

Model Layouts

Column Name Data Type

SystemModel Layout ID ID
Model Layout Name String

Access Groups Subject
The Access Groups subject in reporting contains data about projects and users within each
access group.

Access Group Details

Column Name Data Type

Access Group Name String

Parent Access Group Name String

System Access Group ID ID

Project Details

Column Name Data Type

Project Name String
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Column Name Data Type

Project Thumbnail Image

Project Description String

Project Currency Code List

Project Currency Name List

Project Currency Conversion Factor Number

Project ID ID

Project Process Type List

Project Class List

Project Model Name String

Project Creation Date Date

Project Created By String

Project Manager Name String

Project Start Date Date

Project End Date Date

Project Duration Number (of days)

Project Last Gate Decision List

Project Current Stage Name String

Project is In Trouble Boolean

Project Most Recent Status Report Date Date

Project Most Recent Status Report Submitter
Name

String

Project Most Recent Status Report Text String

Project Excluded from Line-Ups Boolean

Project Closed Boolean

Project Closed Date Date

Idea Submitter Name String

Migrated-from Project Name String

System Project ID ID

System Project Rank Number

System Project Manager ID ID

System Current Phase ID ID

System Last Gate Decision Code ID

System Project Model ID ID

System Migrated-from Project ID ID
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Reference Table Details

Column Name Data Type

Table Display Name String

Table System Name String

Table Description String

Table Category Name String

Table Owner Name String

Unique Row Identifiers Boolean

Is Globally Visible Boolean

System Table ID ID

System Table Owner ID ID

User Details by Group

Column Name Data Type

User Name String

User Login String

User Email Address String

User Chat Address String

System User ID ID

Metric Definitions Subject
The Metric Definitions subject in reporting contains details about the metrics defined in the
system. It does not contain metric values.

Metric Details

Column Name Data Type

Metric Display Name String

Metric System Name String

Metric Description String

Metric Category String

Metric Data Type List

Metric Relative Date Period List

Metric Relative to Date String
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Column Name Data Type

Is Filter Metric Boolean

Is Searchable Boolean

Is Report Metric Boolean

Is Matrix Metric Boolean

Is Rich Text Boolean

Available to Portfolio Editor Boolean

Portfolio Optimizer Usage String

Initialized from Metric Name String

Metric Order Number

Metric Active Boolean

Metric Query String

Tracking History Boolean

Reference Table String

Reference Table Column String

Reference Table Filters String

Metric List Values String

Available To MyWork Boolean

Available ToWorkflow Lineup Boolean

System Metric ID ID

Model Details

Column Name Data Type

Model Name String

Model Process Type List

Model Class List

Model Active Boolean

Metric Required Boolean

Model Show In Planning Boolean

Model Usage - Creation List

Model Usage - Metric List

Model Usage - Status Report List

Model Usage - Portfolio List

System Model ID ID
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Metric Restricted Roles

Column Name Data Type

System Role ID ID

Role Name String

Matrix Details

Column Name Data Type

Matrix Name String

Matrix Description String

Matrix Category String

Matrix Active Boolean

System Matrix ID ID

Reference Table Definitions Subject
The Reference Table Definitions subject in reporting contains details about reference tables,
their columns, and metric identifiers that may be defined within a reference table.

Reference Table Access Group Information

Column Name Data Type

Access Group Name String

Parent Access Group Name String

System Access Group ID ID

Reference Table Columns

Column Name Data Type

Column Number Number

Column Display Name String

Column System Name String

Column Data Type List

Column Numeric Mask String
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Reference Table Details

Column Name Data Type

Table Display Name String

Table System Name String

Table Description String

Table Category Name String

Table Owner Name String

Unique Row Identifiers Boolean

Is Globally Visible Boolean

Available To Reporting Boolean

System Table ID ID

System Table Owner ID ID

Matrix Definitions Subject
The Matrix Definitions subject in reporting contains details about a matrix and its associated
metrics and models.

Matrix Details

Column Name Data Type

Matrix Display Name String

Matrix System Name String

Matrix Description String

Matrix Category String

Matrix Order Number

Available to Reporting Boolean

Matrix Active Boolean

System Matrix ID ID

Portfolio Optimizer Usage String

Metric Details

Column Name Data Type

Metric Name String

Metric Description String

697



Appendix B  Reporting Columns by Subject

Administrator's Guide

Column Name Data Type

Metric Category String

Metric Active Boolean

Metric Unique Boolean

System Metric ID ID

Model Details

Column Name Data Type

Model Name String

Model Process Type List

Model Class List

Model Active Boolean

System Model ID ID

Time Tracking Subject
The Time Tracking subject in reporting contains details about timesheets and approvals.

Timesheet Details

Column Name Data Type

Timesheet Owner Name String

Timesheet Start Date Date

Timesheet End Date Date

Timesheet Status String

Timesheet Status Comment String

Timesheet Last Updated By Name String

Timesheet Last Updated Date Date

Timesheet Approver Name String

Original Timesheet Approver Name String

Timesheet approval Date Date

System Timesheet ID ID

System Timesheet Owner ID ID

System Timesheet Status ID ID

System Timesheet Last Updated By ID ID
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Column Name Data Type

System Timesheet Approver ID ID

System Timesheet Original Approver ID ID

Timesheet Rows

Column Name Data Type

Timesheet Row Project Name String

Resource Pool Name String

Timesheet Row Approver Name String

Timesheet Row Original Approver Name String

Timesheet Row Approval Date Date

*Timesheet Row String Fields (1-10) String

*Timesheet Row List Fields (1-10) String

*Timesheet Row Date Fields (1-10) Date

*Timesheet Row Multi-Select Fields (1-10) String

*Timesheet Row Long String Fields String

*Timesheet Row Number Fields (1-10) String

System Timesheet Row ID ID

System Timesheet Row Project ID ID

System Timesheet Row Approver ID ID

System Timesheet Row Original Approver ID ID

* Columns for extended fields display use the Extended Field Display Name and are only available when they are
active in timesheets.

Timesheet Entries

Column Name Data Type

Timesheet Entry Date Date

Timesheet Entry Value Number

Project Snapshot History Subject
The Project Snapshot History subject in reporting contains details about snapshots, current
project details and details in snapshots, metric values selected for inclusion in snapshots, and
current metric values. To include resource snapshot history, use the Project Resource
Snapshot History subject instead.
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Snapshot Details

Column Name Data Type

Snapshot Name String

Snapshot Date Date

Snapshot Description String

Snapshot Type String

Snapshot Position - Type Number

Snapshot Position - Global Number

System Snapshot ID ID

Snapshot Project Details

Column Name Data Type

Snapshot Project Name String

Snapshot Project Thumbnail Image

Project Snapshot Date Date

Snapshot Project Description String

Snapshot Project Currency Code List

Snapshot Project Currency Name List

Snapshot Project Currency Conversion Factor Number

Snapshot Project ID ID

Snapshot Project Process Type List

Snapshot Project Type List

Snapshot Project Class List

Snapshot Project Model Name String

Snapshot Project Creation Date Date

Snapshot Project Created By String

Snapshot Project Manager Name String

Snapshot Project Last Gate Decision List

Snapshot Project Current Stage Name String

Snapshot Project is In Trouble Boolean

Snapshot Project Most Recent Status Report
Date

Date

Snapshot Project Most Recent Status Report
Submitter Name

String
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Column Name Data Type

Snapshot Project Most Recent Status Report
Text

String

Snapshot Project Start Date Date

Snapshot Project End Date Date

Snapshot Project Excluded from Line-ups Boolean

Snapshot Project Closed Boolean

Snapshot Project Closed Date Date

Snapshot Project Idea Submitter Name String

Snapshot Migrated-from Project Name String

Snapshot System Project ID ID

Snapshot System Project Manager ID ID

Snapshot System Current Phase ID ID

Snapshot System Last Gate Decision Code ID

Snapshot System Migrated-from Project ID ID

Current Project Details

Column Name Data Type

Current Project Name String

Current Project Thumbnail Image

Current Project Description String

Current Project Currency Code List

Current Project Currency Name List

Current Project Currency Conversion Factor Number

Current Project ID ID

Current Project Process Type List

Current Project Type List

Current Project Class List

Current Project Model Name String

Current Project Creation Date Date

Current Project Created By String

Current Project Manager Name String

Current Project Last Gate Decision List
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Column Name Data Type

Current Project Current Stage Name String

Current Project is In Trouble Boolean

Current Project Most Recent Status Report Date Date

Current Project Most Recent Status Report Sub-
mitter Name

String

Current Project Most Recent Status Report Text String

Current Project Start Date Date

Current Project End Date Date

Current Project Excluded from Line-ups Boolean

Current Project Closed Boolean

Current Project Closed Date Date

Current Project Idea Submitter Name String

Current Migrated-from Project Name String

Current System Project ID ID

Current System Project Manager ID ID

Current System Current Phase ID ID

Current System Process Model ID ID

Current System Last Gate Decision Code ID

Current System Migrated-from Project ID ID

Snapshot Project Stages and Gates

Column Name Data Type

Snapshot Project Stage Exists Boolean

Snapshot Project Stage Name String

Snapshot Project Stage Relative Position List

Snapshot Project Stage Duration Number

Snapshot Project Gate Exists Boolean

Snapshot Project Gate Name String

Snapshot Project Gate Date Date

Snapshot Project Gate Decision List

Snapshot Project Gate Meeting Place String

Snapshot Project Gate Notes String
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Column Name Data Type

Snapshot Project Gate Plan Date Date

Snapshot Project Gate Relative Position List

Snapshot System Project Phase ID ID

Snapshot System Gate Decision Code ID

Snapshot Project Gate Conditions String

Snapshot Project Gateowners Name String

Snapshot System Project Gateowners ID ID

Snapshot Project Stage Locked Boolean

Snapshot Project Gate Date Metric Name String

Current Project Stages and Gates

Column Name Data Type

Current Project Stage Exists Boolean

Current Project Stage Name String

Current Project Stage Relative Position List

Current Project Stage Duration Number

Current Project Gate Exists Boolean

Current Project Gate Name String

Current Project Gate Date Date

Current Project Gate Decision List

Current Project Gate Meeting Place String

Current Project Gate Notes String

Current Project Gate Plan Date Date

Current Project Gate Relative Position List

Current System Project Phase ID ID

Current System Gate Decision Code ID

Current Project Gate Conditions String

Current Project Gateowners Name String

Current System Project Gateowners ID ID

Current Project Stage Locked Boolean

Current Project Gate Date Metric Name String
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Snapshot <metric category>

Contains snapshots of metric values for metrics in the selected category.

Current <metric category>

Contains the current values of metrics in the selected category.

Matrix <matrix name>

Each Matrix column set contains the metrics columns that are in the matrix. More than one
matrix may be listed. Matrices are specific to each company; therefore, there is not a standard
set of column names.

Project Resource Snapshot History Subject
The Project Resource Snapshot History subject in reporting contains current project details
and details in snapshots, current resource information and snapshot resource information.

Snapshot Details

Column Name Data Type

Snapshot Name String

Snapshot Date Date

Snapshot Description String

Snapshot Type String

Snapshot Position - Type Number

Snapshot Position - Global Number

System Snapshot ID ID

Snapshot Project Details

Column Name Data Type

Snapshot Project Name String

Snapshot Project Thumbnail Image

Project Snapshot Date Date

Snapshot Project Description String

Snapshot Project Currency Code List

Snapshot Project Currency Name List

Snapshot Project Currency Conversion Factor Number

Snapshot Project ID ID
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Column Name Data Type

Snapshot Project Process Type List

Snapshot Project Type List

Snapshot Project Class List

Snapshot Project Model Name String

Snapshot Project Creation Date Date

Snapshot Project Created By String

Snapshot Project Manager Name String

Snapshot Project Last Gate Decision List

Snapshot Project Current Stage Name String

Snapshot Project is In Trouble Boolean

Snapshot Project Most Recent Status Report
Date

Date

Snapshot Project Most Recent Status Report
Submitter Name

String

Snapshot Project Most Recent Status Report
Text

String

Snapshot Project Start Date Date

Snapshot Project End Date Date

Snapshot Project Excluded from Line-ups Boolean

Snapshot Project Closed Boolean

Snapshot Project Closed Date Date

Snapshot Project Idea Submitter Name String

Snapshot Migrated-from Project Name String

Snapshot System Project ID ID

Snapshot System Project Manager ID ID

Snapshot System Current Phase ID ID

Snapshot System Last Gate Decision Code ID

Snapshot System Migrated-from Project ID ID

Current Project Details

Column Name Data Type

Current Project Name String

Current Project Thumbnail Image
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Column Name Data Type

Current Project Description String

Current Project Currency Code List

Current Project Currency Name List

Current Project Currency Conversion Factor Number

Current Project ID ID

Current Project Process Type List

Current Project Type List

Current Project Class List

Current Project Model Name String

Current Project Creation Date Date

Current Project Created By String

Current Project Manager Name String

Current Project Last Gate Decision List

Current Project Current Stage Name String

Current Project is In Trouble Boolean

Current Project Most Recent Status Report Date Date

Current Project Most Recent Status Report Sub-
mitter Name

String

Current Project Most Recent Status Report Text String

Current Project Start Date Date

Current Project End Date Date

Current Project Excluded from Line-ups Boolean

Current Project Closed Boolean

Current Project Closed Date Date

Current Project Idea Submitter Name String

Current Migrated-from Project Name String

Current System Project ID ID

Current System Project Manager ID ID

Current System Current Phase ID ID

Current System Process Model ID ID

Current System Last Gate Decision Code ID

Current System Migrated-from Project ID ID
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Snapshot Project Resource Plans

Column Name Data Type

Snapshot Project Resource Pool Name String

Snapshot Project Resource Name String

Snapshot Project Period Start Date Date

Snapshot Project Period End Date Date

Snapshot Project Resource Demand Type String

Snapshot Project Resource Demand Curve String

Snapshot Project Resource Demand Multiplier Number

Snapshot Project Resource Demand Value Number

Snapshot Project Resource Demand Is Active String

Snapshot System Project Resource Pool ID ID

Snapshot System Project Resource ID ID

Snapshot System Project Resource Period ID ID

Snapshot System Project Resource Demand
Type ID

ID

Snapshot Resource Demand Effective Time
Period ID

ID

Snapshot Resource Demand Effective Time
Period

Date

Current Project Resource Plans

Column Name Data Type

Current Project Resource Pool Name String

Current Project Resource Name String

Current Project Period Start Date Date

Current Project Period End Date Date

Current Project Resource Demand Type String

Current Project Resource Demand Curve String

Current Project Resource Demand Multiplier Number

Current Project Resource Demand Value Number

Current Project Resource Demand Is Active String

Current System Project Resource Pool ID ID

Current System Project Resource ID ID
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Column Name Data Type

Current System Project Resource Period ID ID

Current Snapshot System Project Resource
Demand Type ID

ID

Current Resource Demand Effective Time
Period ID

ID

Current Resource Demand Effective Time
Period

Date

Reporting Columns - Resource Snapshot History
The Resource Snapshot History subject in reporting contains details about resource
snapshots, resource pools, pool owners, current resources, resource capacities, and resource
demands.

Snapshot Details

Column Name Data Type

Snapshot Name String

Snapshot Date Date

Snapshot Description String

Snapshot Type String

Snapshot Position - Type Number

Snapshot Position - Global Number

System Snapshot ID ID

Snapshot Resource Pools

Column Name Data Type

Snapshot Resource Pool Name String

Snapshot Resource Pool Owner Name String

Snapshot Resource Pool Is Active Boolean

Snapshot System Resource Pool ID ID

Snapshot System Resource Pool Owner ID ID

Snapshot Resource Pool Unit of Measure String

<extended name> Selected Snapshot String Value String (from 1 to 10 )

<extended field name> Selected Snapshot Number Number (from 1 to 10)
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Column Name Data Type

<extended field name> Selected Snapshot Date
Value

Date (from 1 to 10)

<extended field name> Selected Snapshot List
Value

List (from 1 to 10)

<extended field name> Selected Snapshot Long
String Value

Long String (from 1 to 10)

<extended field name> Selected Snapshot Multi-
Select List Value

String (from 1 to 10)

Current Resource Pools

Column Name Data Type

Current Resource Pool Name String

Current Resource Pool Owner Name String

Current Resource Pool Is Active Boolean

Current System Resource Pool ID ID

Current System Resource Pool Owner ID ID

Current Resource Pool Unit of Measure String

<extended name> Selected Snapshot String Value String (from 1 to 10 )

<extended field name> Selected Snapshot Number Number (from 1 to 10)

<extended field name> Selected Snapshot Date
Value

Date (from 1 to 10)

<extended field name> Selected Snapshot List
Value

List (from 1 to 10)

<extended field name> Selected Snapshot Long
String Value

Long String (from 1 to 10)

<extended field name> Selected Snapshot Multi-
Select List Value

String (from 1 to 10)

Snapshot Pool Owners

Column Name Data Type

Snapshot Pool Owner Name String

Snapshot System Pool Owner ID ID
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Current Pool Owners

Column Name Data Type

Current Pool Owner Name String

Current System Pool Owner ID

Snapshot Resources

Column Name Data Type

Snapshot Resource Name String

Snapshot Resource System Name String

Snapshot Resource Account Status Boolean

Snapshot System Resource Pool Member ID ID

Snapshot System Resource Pool Member User
ID

ID

Current Resources

Column Name Data Type

Current Resource Name String

Current Resource System Name String

Current Resource Account Status Boolean

Current System Resource Pool Member ID ID

Current System Resource Pool Member User ID ID

Snapshot Resource Capacities

Column Name Data Type

Snapshot Resource Capacity Start Date Date

Snapshot Resource Capacity End Date Date

Snapshot Resource Capacity Number

Snapshot Resource Capacity Unavailable Number

Snapshot System Resource Period ID ID

Current Resource Capacities

Column Name Data Type

Current Resource Capacity Start Date Date
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Column Name Data Type

Current Resource Capacity End Date Date

Current Resource Capacity Number

Current Resource Capacity Unavailable Number

Current System Resource Period ID ID

Snapshot Resource Demands

Column Name Data Type

Snapshot Resource Demand Project Name String

Snapshot Resource Demand Project Stage
Name

String

Snapshot Resource Demand Start Date Date

Snapshot Resource Demand End Date Date

Snapshot Resource Demand Type List

Snapshot Resource Demand Curve String

Snapshot Resource Demand Multiplier Number

Snapshot Resource Demand Value Number

Snapshot Resource Demand Is Active Boolean

Snapshot Resource Demand Project ID ID

Snapshot System Resource Demand Project
Phase ID

ID

Snapshot System Resource Demand Type ID ID

Snapshot Resource Demand Effective Time
Period ID

ID

Snapshot Resource Demand Effective Time
Period

String

Snapshot Resource Demand System Name String

Current Resource Demands

Column Name Data Type

Current Resource Demand Project Name String

Current Resource Demand Project Stage Name String

Current Resource Demand Start Date Date

Current Resource Demand End Date Date
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Column Name Data Type

Current Resource Demand Type List

Current Resource Demand Curve String

Current Resource Demand Multiplier Number

Current Resource Demand Value Number

Current Resource Demand Is Active Boolean

Current Resource Demand Project ID ID

Current System Resource Demand Project
Phase ID

ID

Current System Resource Demand Type ID ID

Current Resource Demand Effective Time
Period ID

ID

Current Resource Demand Effective Time
Period

String

Current Resource Demand System Name String

Scenario Projects Subject
The Scenario Projects subject in reporting contains data on scenario projects.

Scenario Details

Column Name Data Type

Scenario Name List

Scenario Public Boolean

Scenario Creation Date Date

Scenario Created By String

Scenario Updated Date Date

Scenario Updated By String

Scenario Last Committed Date Date

Scenario Last Committed By String

System Scenario ID ID

Scenario Project Details

Column Name Data Type

Scenario Project Name String
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Column Name Data Type

Scenario Project Thumbnail Image

Scenario Project Description String

Scenario Project Project ID String

Scenario Project Process Type List

Scenario Project Class List

Scenario Project Model Name String

Scenario Project Creation Date Date

Scenario Project Created By String

Scenario Project Manager Name String

Scenario Project Start Date Date

Scenario Project End Date Date

Scenario Project Last Gate Decision List

Scenario Project Current Stage Name String

Scenario Project is In Trouble Boolean

Scenario Project Most Recent Status Report
Text

String

Scenario Project Closed Boolean

Scenario Project Is Active Boolean

Scenario Project Scenario Rank Number

Scenario Project Access Group Name String

Scenario Project Parent Access Group Name String

System Scenario Project ID ID

System Scenario Project Manager ID ID

System Scenario Current Phase ID ID

System Scenario Last Gate Decision ID ID

System Scenario Project Class ID ID

System Scenario Project Model ID ID

System Scenario Project Rank ID

System Scenario Access Group ID ID

System Scenario Parent Access Group ID ID

Acclaim Projects Integration Enabled Boolean

Acclaim Projects Health Score Number

Acclaim Projects Project ID Number
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Column Name Data Type

Schedule Health Number

Financial Health Number

Scenario Project Stages and Gates

Column Name Data Type

Scenario Project Stage Exists Boolean

Scenario Project Stage Name String

Scenario Project Gate Exists Boolean

Scenario Project Gate Name String

Scenario Project Gate Date Date

Scenario System Project Phase ID ID

Scenario Portfolio Plans

Column Name Data Type

Portfolio Planner ID ID

Portfolio Planner Name String

Portfolio Planner Description String

Updated By User ID ID

Updated By String

Updated On Date

Target Metric ID ID

Target Metric Name String

Target Metric Goal Number

Constraint Metric 1 ID ID

Constraint Metric 1 Name String

Constraint Metric 1 Limit Number

Constraint Metric 1 Total Number

Constraint Metric 2 ID ID

Constraint Metric 2 Name String

Constraint Metric 2 Limit Number

Constraint Metric 2 Total Number
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Scenario Editors

Column Name Data Type

Scenario Editor Name String

Scenario Checked Out Boolean

System Scenario Editor ID ID

Matrix - <matrix name>

Each Matrix column set contains the metrics columns that are in the matrix. More than one
matrix may be listed. Matrices are specific to each company; therefore, there is not a standard
set of column names.

<metric category names>

Metrics that are available to reporting are listed under subheadings that reflect the metric
categories. Metrics are specific to each company; therefore, there is not a standard set of
column names.
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Scenario Resource Plans Subject
The Scenario Resource Plans subject in reporting contains data on scenario resource plans.

Scenario Details

Column Name Data Type

Scenario Name List

Scenario Public Boolean

Scenario Creation Date Date

Scenario Created By String

Scenario Updated Date Date

Scenario Updated By String

Scenario Last Committed Date Date

Scenario Last Committed By String

System Scenario ID ID

Scenario Resource Pools

Column Name Data Type

Scenario Resource Pool Name String

Scenario Resource Pool Unit of Measure String

System Scenario Resource Pool ID ID

Extended Field String 1 - 10 String

Extended Field Number 1 - 10 Number

Extended Field Date 1 - 10 Date

Extended Field Long String 1 - 10 String

Extended Field Multi-Select List 1 - 10 String

Scenario Resources

Column Name Data Type

Scenario Resource Name String

System Resource Pool Member ID ID
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Scenario Resource Capacities

Column Name Data Type

Scenario Resource Capacity Start Date Date

Scenario Resource Capacity End Date Date

Scenario Resource Capacity Number

Scenario Resource Capacity Unavailable Number

System Scenario Resource Period ID ID

Scenario Resource Demands

Column Name Data Type

Scenario Resource Demand Project Name String

Scenario Resource Demand Start Date Date

Scenario Resource Demand End Date Date

Scenario Resource Demand Curve String

Scenario Resource Demand Multiplier Number

Scenario Resource Demand Value Number

Scenario Resource Demand Is Active Boolean

Scenario Resource Demand Effective Time
Period

String

System Scenario Resource Demand Project ID ID

System Scenario Resource Demand Effective
Time Period ID

ID

Scenario Editors

Column Name Data Type

Scenario Editor Name String

Scenario Checked Out Boolean

System Scenario Editor ID ID
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Accolade Parameters

Following installation, configure Accolade using the Sopheon Accolade Administration Console
available on the application server, which contains a set of configuration parameters that
defines Accolade behavior.

Note: Some parameters are also available within Accolade on the Configuration >
Parameters page. If you configure parameters within Accolade, recycle the
application pool for the changes to take effect. Changing parameters using
the Administration Console recycles the pool automatically.

To update a parameter:

1. From the application server's Startmenu, select the Sopheon folder and then select
Accolade Administration Console.

2. Select Standard Parameters in the Administration Console navigation pane.

3. Select a category to filter the list.

4. Select the Show Advanced check box to display all parameters.

Important! Advanced parameters are more likely to damage your system if you
make an error. Sopheon recommends that you not modify advanced parameters
unless you have expert knowledge of Accolade. Parameters marked Read Only in
the description are included with the advanced parameters but cannot be modified
in the console.

5. For each parameter you want to modify, click in the Value column to change the value.

You can drag the Name column (and the console itself) wider to make
overlapping parameter names easier to read.
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The sections within this appendix describe the parameters available within each category.

License Keys
Use the license key parameters to enter the keys for optional add-on Accolade features.
Sopheon provides these license keys to you or enters them for you in the Administration
Console:

l Collaborative Workflow License Key

l Data Analytics License Key

l Extended Project Edit Rights License Key

l Idea Submission License Key

l Innovation Planning License Key

l MS Project Integration Key

l Portfolio Center License Key

l Resource Planning License Key

l Time Tracking License Key

Mail and Notifications
The following parameters apply to the internal emailing capability within Accolade, including
sending notifications about system events by email:

Display Name Description Default Value

Enable Notifications* Enables or disables notifications through
email for events such as deliverables not
being ready for an upcoming date.

1

Enable Simple Email Sup-
port

Enables or disables Simple Email through
Accolade.

0

Email Separator The separator character to use for emails
addressed to multiple recipients.

;
(semicolon)

Send Empty Schedule
Email Notification

Whether or not to send a scheduled email,
even if no events have occurred.

0

Send Emails for Late
Assignments in Stages
Set to Conditional Go

Enables or disables sending emails for
assignments that are late in stages that
have a corresponding gate decision set to
Conditional Go. Conditional Go is available
as a gate decision if the Disable Condi-

0
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Display Name Description Default Value

tional Go Gate Decision parameter is set
to 0.

Send Scheduled HTML
Report Notifications

Enable scheduled send of HTML report noti-
fications.

1

Advanced Parameters

Email Address to Send
License Information

The email address to which to send license
information. Typically an internal support
address.

N/A

Last Status Report Send
Date

The day of the month that notification status
reports were last processed.

N/A

Notification Delivery
Return Address*

The email address used to send notification
emails from Accolade.

N/A

SMTP Connection String (Read Only) The SMTP connection string for
sending email notifications.

N/A

Allow usage of
CallStoredProcedure

Enable usage of CalledStoredProcedure
function in Metric Formulas.

0

* This parameter can also be set within Accolade in Process > Configuration > Parameters.

Privacy
The following parameter applies to reports generated from Accolade and Accolade Office
Extensions:

Display Name Description Default
Value

Report Privacy Warn-
ing Text*

The text included at the top of each report to indic-
ate privacy of the report content (500 characters).
Enter the warning text in the language you would
like it to display.

Blank

Advanced Parameters

Enable System Con-
sent Prompt

Whether or not to show the User Consent prompt
if users have not previously consented.

Blank

* This parameter can also be set within Accolade in Process > Configuration > Parameters.
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Process
The following parameters apply to flow of projects from creation through their model structure:

Display Name Description Default
Value

Allow Document Owners
to Set Deadline

Enables or disables document owner's ability to
set the deadline date for documents they own.
When disabled, Project Managers or Process
Managers can set the deadline date for doc-
uments within projects.

0

Allow Document Owners
to Set Function

Enables or disables document owner's ability to
set the function for document they own. When
disabled, Project Managers or Process Man-
agers must set the function for documents.

0

Allow Document Owners
to Set Start Date

Enables or disables document owner's ability to
set the start date for documents they own.
When disabled, Project Managers or Process
can set the start date for documents within pro-
jects.

0

Allow Project Owner to
Set Gate Dates

Enables or disables project owner's ability to
update a gate date from the progress graphic
on a current or future gate that has the status of
Pending Decision.

0

Allow TeamMembers to
Share Assignments

Enables or disables teammember's ability to
assign themselves as a document owner within
a project.

1

Auto-Generate Project
IDs*

Enables or disables automatic system gen-
erated project IDs. If set to 0, project creators
enter their own project ID when creating a pro-
ject.

0

Automatically Publish
Submitted Ideas*

Enables or disables the automatic publication of
documents attached to submitted ideas.

0

Default New Versions to
Published*

Enables or disables the automatic publication of
new versions of an existing document.

1
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Display Name Description Default
Value

Important! Process Designers can
set publish options for individual
deliverables and activities in
process models that override this
system parameter. Project
deliverables and activities with
different publish settings than the
system parameter, respect the
setting in the process model.
Activities added to deliverables in
projects, however, respect the
system parameter.

Disable Conditional Go
Gate Decision

Enables or disables the ability to set a gate
decision to Conditional Go. When a decision is
set to Conditional Go, one or more condition
must be met before the next gate meeting
decision. When disabled, Go is the only gate
decision that provides approval to proceed to
the next project stage.

0

Disable Link to File Enables or disables the ability to link a doc-
ument's source to an external document stored
outside of Accolade.

0

Disable Link to Website Enables or disables the ability to link a doc-
ument's source to a website.

0

Enforce Project Security
for Add TeamMember

Determines if the User Select dialog box on a
project only includes users who have security
access to the project through access group,
security list, and security profile settings. This
setting applies to adding teammembers and
project managers to a project or planning ele-
ment. The default setting of 0 allows the addi-
tion of users to a project by exception, outside
their security access.

Important! If you enable this
parameter, existing projects that
contain users assigned outside their
security access are not
automatically updated. Correct any

0
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Display Name Description Default
Value

projects with security concerns
manually.

Number of Days for Gate
Meeting Warning*

The number of days prior to a gate meeting to
consider assignments incomplete.

7

Restrict Discussions Tab
to Project Team

When enabled, restricts the project discussions
feature to only the Project Manager and project
teammembers.

0

Show Conditional Go
Assignments as Current

Determines if gates set to Conditional Go are
shown as current gate in the Word pod.

1

ShowWeek Number in
Calendar Controls*

When enabled, the calendar selection control
includes the week number as the first column,
and the week starts on Monday instead of
Sunday.

Note: When changing the
parameter value, clear
distributed cache if you have
distributed cache configured
on your system and then reset
IIS to prompt the system to
inherit the parameter change.

0

Advanced Parameters

Allow Last Status Report
to be Deleted

Enables or disables a user's ability to delete the
last status report they submitted.

0

Default Deliv-
erable/Activity Details
Dialog Main Content

(Read Only) The default display content when
opening the Deliverable/Activity Details dialog
box. The default setting displays quick grids if
they are available, or versions if the deliverable
or activity has no quick grid assigned.

0

Disable Workflow
Decline Decision

Enables or disables the ability to decline a
decision within a workflow. When set to 1, the
Decline request to review deliverable option
is not available for workflow action owners enter-
ing decisions for their workflow actions.

0

Display Extended Fields
on User Selector Default

Enables or disables the display of extended
fields on the User Selector dialog. When set to

1
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Display Name Description Default
Value

1, the extended fields will be displayed.

Enable Quick Grids Pro-
tected Mode

Enables or disables grids that are set to be pro-
tected (view only).

0

* This parameter can also be set within Accolade in Process > Configuration > Parameters.

Product Enhancement
The following parameters apply to the product enhancement system:

Display Name Description Default
Value

Enable Product
Enhancement System
Icon

Hides or shows Product Enhancement System
Icon. When set to 1, it is enabled. When set to 0,
it is disabled.

1

Product Enhancement
System Visibility

Shows Product Enhancement System Icon for
specific roles. Enter the role codes. A blank
default value will include all roles.

Blank

* This parameter can also be set within Accolade in Process > Configuration > Parameters.

Organization Information
The following parameters apply to organizational information:

Display Name Description Default
Value

Advanced Parameters

Organization Name When configuring Accolade or upgrading to ver-
sion 14.2 or higher, this field must be populated
with the name of your organization.

Important! Once a name is entered
and saved, the information becomes

Blank
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Display Name Description Default
Value

read-only and cannot be changed.

Integration ID Customer integration ID for Accolade to connect
to Acclaim Projects. This must only be populated
if your organization has purchased integration
with Acclaim Projects.

Blank

Acclaim Projects URL Fully qualified URL to the Acclaim Projects web-
site. This must only be populated if your organ-
ization has purchased integration with Acclaim
Projects.

Blank

* This parameter can also be set within Accolade in Process > Configuration > Parameters.

Security
The following parameters apply to security settings:

Display Name Description Default
Value

Advanced Parameters

Encrypt Distributed
Cache Entries

If set to 1, values stored in the Distributed Cache
will be encrypted. When changing the value,
restart IIS on all application servers in the load
balanced configuration then clear the cache on
the Distributed Cache page of the Administration
console.

Important! Enabling this parameter
impacts application performance.

0

Login Metric The system name of the metric used for the loc-
ation login selection list, if you are prompting
users for a location when they log in. This metric
is a list or multi-select list metric. The con-
figuration of the metric entered here becomes
read-only; therefore, Sopheon recommends
using a metric whose list values are defined in a
reference table, so you can update the metric's
values as needed.

Blank
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Display Name Description Default
Value

Restrict Administrators
From Updating Their
Account

If set to 1, Administrators cannot update their
account through the User Administration page or
by importing users when setting up Accolade
user accounts.

0

Task Service Pass-
word

(Read Only) Encrypted password used when the
task service makes a web service call. The cre-
dentials are used for authenticating users.

Blank

Task Service User (Read Only) Username used when the task ser-
vice makes a web service call. The credentials
are used for authenticating users.

Blank

System
The following parameters apply to system-level settings, such as database and network, and
are typically set once at installation:

Display Name Description Default
Value

Active Directory
Enabled

User extended fields sync with Active Directory. 0

Enable Plug-ins Whether users can load browser plug-ins. 0

Enable User Profile
Images*

Enables the ability to add an image to a user
account or user profile that displays with a
user's name in various locations in Accolade.

1

Maximum Number of
Recent Items

The maximum number of entries that display in
the Recent Items list displayable from the Accol-
ade title bar.

50

Maximum Searchable
Extended Fields

The maximum number of extended fields can be
set for user searches.

5

Metrics Recalculation
Chunk Size (Integer)

The number of distinct projects to include when
completing metric recalculations.

Contact Sopheon Customer Support before

100
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Display Name Description Default
Value

changing this setting.

Number of Days to
Retain Error Logs

The number of days to save logs that contain
system error information.

365

Number of Days to
Retain User Access
Logs

The number of days to save logs that contain
user access information.

390

Project Thumbnail
Image Height

The height of the project thumbnail image, in
pixels.

80

Project Thumbnail
ImageWidth

The width of the project thumbnail image, in
pixels.

80

Replace Empty Val-
ues

Whether or not null values in Accolade reporting
results are returned with values indicating blank
or empty results such as [empty]. If this para-
meter is set to 0, number, date, and string met-
rics that contain no value display as blank in
reporting results.

1

Reporting Office
Extensions Record
Limit

The maximum number of rows returned in a
report created using Accolade Office Exten-
sions Query. Must be set to a whole, positive
number.

50,000

Advanced Parameters

Accolade Footer Text The text displayed in the Accolade page footers.
This may be corporate or legal directives, or any
text all employees in your company need to see.

Blank

Accolade Header Text The text displayed above the Accolade main
menu bar. This may be corporate or legal dir-
ectives, or any text all employees in your com-
pany need to see.

Blank

Accolade Process
Manager Version

(Read Only) The current version and build num-
ber for Accolade Process Manager.

x.x.x

Accolade Process
Manager Website
URL

The website address for Accolade Process Man-
ager.

Blank

Allow Default Landing
Page

Allows personalized landing pages to be selec-
ted by users.

1
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Display Name Description Default
Value

Allow Restricted Pro-
ject Names to be Vis-
ible

Indicates whether project names for projects
selected to be hidden, display in Resource
Editor and on timesheets for all users regard-
less of if they are on the project team or have
rights to view the project.

0

Anonymous Idea Sub-
mission URL

The website address for Idea Submission.

Application Insights
Key

Defines the resource used to aggregate tele-
metry data.

Blank

Cancel Snapshot in
Process

(Read Only) Indicates 1 if a snapshot is in the
process of being canceled. Use for troubleshoot-
ing purposes.

0

Currency Symbol Corporate currency symbol displayed in AOR
charts and reports.

Important! If users upload files into
Accolade that contain different
currency symbols not listed here, the
value in this parameter will be used
instead.

$

Customization
Installed

(Read Only) Indicates if your instance of Accol-
ade is a customized version. Standard versions
display 0.

0

Database Filestore
Buffer Size

The database filestore buffer size, in bytes. 1024000

Default Domain for
Users

The default domain for login when one is not
provided.

Blank

Default Search Lan-
guage ID

The Local ID (LCID) the Accolade search uses. 1033

Enable Autofit Cells
on Smart Excel Down-
load

Enables or disables Smart Excel met-
ric/metadata fields to be autofit when down-
loading Smart Excel document

1

Enable Autoloader
Service

(Read Only) Indicates whether the automatic
upload service is enabled.

0

Enable Client Macro
Events for MS Office

Enables or disables the support of client-side
macros for the Accolade Office Extensions add-

0

729



Appendix C  Accolade Parameters

Administrator's Guide

Display Name Description Default
Value

Add-In in. For example, events that happen before or
after saving a document.

Enable Customization
Extensions

Enables or disables the support for cus-
tomizations that use the Extension Object.

1

Enable MS Docs Date
Time Stamp

Enables or disables using a date/time stamp to
distinguish versions of MS Office documents
that are opened more than once.

0

Enable Smart Power-
Point Documents

Enables the "smart" functionality in MS Power-
Point documents downloaded from and
uploaded to Accolade. If set to 0, users can
download and upload MS PowerPoint files; how-
ever, if the file contains Accolade data, such as
field codes, those values do not update.

1

Enable Stakeholders Whether or not to enable information to be
shared with outside stakeholders.

1

Enable Windows
Authentication

Enables or disables Windows for user login
authentication.

1

Enforce List Value Val-
idation

Indicates if list and multilist values should be val-
idated before saving.

0

Event Log Types to
Display on Error

The types of Windows event log entries to dis-
play when an error is triggered.

Application
System

Fiscal Year Start
Month

The number correlating to the first month of your
company's fiscal year. 1 = January, 12 = Decem-
ber. A value of 1 defaults time intervals to cal-
endar year by beginning with January.

Note: This setting does not affect
metric or date calculations. It
only determines the time
intervals in Gantt views,
allowing users to align
timelines according to fiscal
year or calendar year.

1

Hidden Reference
Table Category Name

The name of the category that contains hidden
reference tables.

Idea Management (Read Only) The path to the directory where
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Display Name Description Default
Value

Transfer Directory
Location

idea submission document transfers occur.

Max Levels in Port-
folio Center

The maximum levels of project relationships to
show in Dashboards for Accolade.

3

Max Process
MultiThreading

The maximum number of threads the Accolade
Timed Task Server uses per application server.
For example, in an implementation with three
application servers, if set to 4, up to four threads
are created for each application server, for a
total of 12. Set to 0 to automatically set the
threads based on the number of cores in the
application server.

The optimum setting for your Accolade
implementation is dependent on your data and
your application server/database server
configuration. In a load balanced configuration,
all servers must be included in the value.
Changing this setting can affect other
applications running on the database server if
the server is a shared resource.

If this value is changed after the initial
configuration, all application servers will need
their IIS reset, as well as the Accolade Timed
Task Service restarted to update the new
setting.

Contact Sopheon Customer Support before
changing this setting.

0

Maximum File Upload
Size

The maximum uploaded file size allowed (in
bytes). When uploading multiple files, this limit
is imposed on each file in the group upload, not
the upload as whole.

209715200

Maximum Filter Met-
rics Allowed

The maximum number of metrics allowed to be
designated as filter metrics.

3

Number of Event Logs
to Display on Error

The number of Windows Event Log entries to
display when an error is triggered.

20

Password Change
URL

The URL to a custom web page where users are
able to change their local Accolade password.

Blank
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Display Name Description Default
Value

Leave the parameter blank to prevent users
from changing their password.

Pre-Check Office File
Readability

Enables or disables the check for the readability
of MS Office files before adding them to the sys-
tem.

0

Project Recalculation
Notification Chunk
Size

Sets the amount of projects to notify users of
processing pending metric calculations from the
Task Service. This setting is in bytes, and
determines when a project indicates that cal-
culations are processing, and when the Recal-
culate All button within metric configuration
indicates that metric calculations are still pro-
cessing.

Contact Sopheon Customer Support before
changing this setting.

100

Related Document
Import Load Schedule

(Read Only) The scheduled time for importing
related documents using the automatic upload
service.

Blank

Rich Text Size Warn-
ing

Metric Size to warn the user when they are get-
ting close to the maximum allowed metric size
(in MB).

Important! The value cannot
exceed 2 GB as metrics with Rich
Text enabled cannot contain more
than 2 GB of data.

75

SignalR Transport The SignalR transport mechanism. Separate
entries using a pipe ( | ) delimiter. Options
include:webSockets, foreverFrame, server-
SentEvents, and longPolling. Note that the
capitalization must match exactly to set the para-
meter. This parameter is only used in cross
domain environments.

Contact Sopheon Customer Support before
changing this setting.

Blank

System Delimiter for
Lists

The character used to separate items in a list
metric when stored as a string.

| (pipe)
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Display Name Description Default
Value

Transfer Directory
Location

(Read Only) The path to the directory in the file
system where document transfers occur.

User Session Data
Latency

The amount of time to wait after the Web ses-
sion has timed out to delete the user session
data.

5

* This parameter can also be set within Accolade in Process > Configuration > Parameters.

Online Forms
The following parameters apply to forms that users fill out online, without having to download a
file and upload it with updates:

Display Name Description Default
Value

Default Online Form
Fields to Dirty

Whether or not to treat fields in online forms as
always modified.

1

Disable Sharing of
Online Forms*

Enables or displays shared authoring of online
deliverables and activities.

0

Update Online Form
Metric Data on Save

Enables or displays the automatic updating of
metrics in online forms when saving unpublished
versions.

0

* This parameter can also be set within Accolade in Process > Configuration > Parameters.

Accolade Portfolio Optimizer
The following parameters apply to the Portfolio Optimizer optional component:

Display Name Description Default
Value

Portfolio Optimizer
Load Requested
Demands

Enables or displays requested demands from dis-
playing in Portfolio Optimizer, along with
assigned demands.

0

Portfolio Optimizer
Waterline Threshold
Percent*

The percentage at which to show a warning as
resource demand approaches capacity.

90

Prefix for Generic The prefix that begins the name of every generic Any
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Display Name Description Default
Value

Placeholder
Resources*

resource to prevent overbooked icons from dis-
playing in Portfolio Optimizer.

Warn User When
Uploading Data Older
than (Days)*

The number of days since data was downloaded
to trigger a warning to Portfolio Optimizer users
uploading changes from Portfolio Optimizer.

30

Advanced Parameters

Portfolio Optimizer
Data Contract Version

(Read Only) Data contract version for Portfolio
Optimizer communication.

x.x

Portfolio Optimizer Min-
imum Client Version

(Read Only)Minimum Portfolio Optimizer client
version compatible with the server.

x.x

* This parameter can also be set within Accolade in Process > Configuration > Parameters.

Resource Planning
The following parameters apply to the Resource Planning optional component for Accolade
Portfolio Center.

Display Name Description Default
Value

Allow Multiple Links
for an Assigned Pool

Enables or disables whether a single assigned-
only pool has links to multiple requested-only
pools.

0

Disable Editing on Pro-
ject Resources Tab

Enables or disables whether the Resources page
within a project is read-only.

0

Enable Extended
Demand Constraints

Enables or disables Resource Editor filters that
match projects to pools when adding demands.

0

Maximum Resource
Demand History

The maximum number of demands that can be
shown in resource demand history.

0

Maximum Time Peri-
ods to Download

The maximum number of time periods that can be
downloaded into a Resource Planning Smart
Excel document.

200

Minimum Time Peri-
ods to Download

The minimum number of time periods that can be
downloaded into a Resource Planning Smart
Excel document.

12

Resource Planning (Read Only) The number by which capacity and 1
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Display Name Description Default
Value

Total Divisor demand totals should be divided to show average
monthly capacity or demand over the entire plan-
ning period.

Advanced Parameters

Number of Buffered
Time Periods Back
from the Current
Period

The number of time periods before the current
period that have data loaded into resource plan-
ning pages like Resource Editor when the page
loads.

Important! Set the value equal to or
less than the Periods Back value on
the Admin Console when configuring
Resource Planning time periods. See
the Accolade Installation Guide for
more information on setting Resource
Planning time periods.

12

Number of Buffered
Time Periods Forward
from the Current
Period

The number of time periods after the current
period that will have data loaded into resource
planning pages like Resource Editor when the
page loads.

60

Resource Planning
Time Interval Type

(Read Only) Time interval in each resource plan-
ning cell (0 = weeks, 1 = months, 2 = quarters, 3 =
years).

1

Integrations
The following parameters apply to the MS Teams Integration optional component:

Display Name Description Default Value

MS Teams Applic-
ation (client) ID

The Application (client) ID of the application
registered in Microsoft Azure Active Directory.

Blank

MS Teams Directory
(tenant) ID

The Directory (tenant) ID of the application
registered in Microsoft Azure Active Directory
(see above). The tenant ID can be a GUID (the
ID of your Azure AD instance), for single-
tenant applications, or a domain name
associated with your Azure AD instance (also
for single-tenant applications)

organizations

735



Appendix C  Accolade Parameters

Administrator's Guide

Display Name Description Default Value

Placeholders can also be used as a tenant ID
in place of the Azure AD authority audience
enumeration:

l Organizations for a multitenant
application

l Consumers to sign in users only with
their personal accounts

l Common to sign in users with their
work and school accounts or their
personal Microsoft accounts

MS Teams Prompt
Type

Specifies how the user should be prompted to
authenticate. The prompt parameter can be
used to make sure that the End-User is still
present for the current session or to bring
attention to the request.

Space delimited, case sensitive list of ASCII
string values that specifies whether the End-
User is prompted for reauthentication and
consent.

Defined values are:

l none - Do not display any
authentication or consent user interface
pages. An error is returned if an End-
User is not already authenticated or the
Client does not have pre-configured
consent for the requested Claims or
does not fulfill other conditions for
processing the request. Cannot be
used in combination with other values.

l login - Prompt the End-User for
reauthentication. If it cannot
reauthenticate the End-User, an error is
returned.

l consent - Prompt the End-User for
consent before returning information to
the Client. If it cannot obtain consent,
an error is returned.

select_account
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Display Name Description Default Value

l select_account - Prompt the End-User
to select a user account. This enables
an End-User who has multiple
accounts to select amongst the multiple
accounts that they might have current
sessions for. If an account selection
choice made by the End-User cannot
be obtained, an error is returned.

MS Teams Domain
Hint

Domain hints are directives that are included
in the authentication request from an
application. They can be used to accelerate
the user to their federated IdP sign-in page. Or
they can be used by a multi-tenant application
to accelerate the user straight to the branded
Azure AD sign-in page for their tenant. If
included, leads to a more streamlined user
experience. An example of a domain hint
would be a domain name such as
sopheon.com.

Empty

MS Teams
URI Scheme

The default URI Scheme to use for the MS
Teams integration. This indicates the user
experience when transitioning between
Accolade and MS Teams.

0 = use the launcher (the Microsoft
intermediate step which allows the user to
select whether to use the MS Teams App or
the web app),

1 = msteams scheme (use the MS Teams
app),

2 = https scheme (use the web app).

1

MS Project Integration
The following parameters apply to the MS Project Integration optional component:

Display Name Description Default
Value

MS Project Field for
Misc Data

The name of the custom field in MS Project used
to store miscellaneous data.

Text26
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Display Name Description Default
Value

MS Project Field for
Status

The name of the custom field in MS Project used
to store status data.

Text28

MS Project Filed for
Status Notes

The name of the custom field in MS Project used
to store status notes data.

Text27

MS Project Field for
Task ID

The name of the custom field in MS Project used
to store task ID data.

Text30

MS Project Field for
Task Owner

The name of the custom field in MS Project used
to store task owner data.

Text29

MS Project Field for
User ID

The name of the custom field in MS Project used
to store user ID data.

Text24

MS Project Field for
User Login

The name of the custom field in MS Project used
to store user login data.

Text25

Currency
The following parameters apply to the currency in which you do business:

Display Name Description Default
Value

Advanced Parameters

Corporate Currency (Read Only) Currently selected corporate cur-
rency code. Projects can run in a difference cur-
rency.

N/A

Corporate Currency
Previously Set

(Read Only) Indicates if the corporate currency
has been changed.

0

Timeouts
The following parameters apply the number of seconds the application waits before timing out
in various scenarios. These settings are typically only changed for troubleshooting purposes or
to accommodate certain hardware implementation:

Display Name Description Default
Value

Calculated Metric Pro-
cess Timeout (minutes)

The number of minutes before a running cal-
culation process times out.

60
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Display Name Description Default
Value

Web Session Timeout
(minutes)*

The number of minutes of inactivity allowed
before a user's Accolade session times out and
requires the user to re-enter their user name and
password.

60

Advanced Parameters

Database Default Com-
mand Timeout
(seconds)

The number of seconds before an ordinary data-
base command times out.

30

Database Filestore
Command Timeout
(seconds)

The number of seconds before a database
filestore command times out.

120

Database Import Com-
mand Timeout
(seconds)

The number of seconds before a data import
times out.

1200

Database Import Trans-
action Timeout (hh:m-
m:ss)

The amount of time before a data import data-
base transaction times out.

0:20:00

Database Portfolio
Optimizer Command
Timeout (seconds)

The number of seconds before a Portfolio Optim-
izer database command times out.

300

Database Reference
Tables Command
Timeout (seconds)

The number of seconds before a reference table
database command times out.

600

Database Reference
Tables Transaction
Timeout (hh:mm:ss)

The number of seconds before a reference table
transaction command times out.

0:20:00

Database Transaction
Timeout (hh:mm:ss)

The amount of time before a database trans-
action times out.

0:05:00

Distributed Cache Com-
mand Timeout
(seconds)

The number of seconds before a distributed
cache command times out. If you change this
setting reset IIS and restart the Accolade Win-
dows Services, except for the cache service.

30

Document Refresh
Timeout (seconds)

The number of seconds before the refresh of a
document containing field codes times out.

1200

Report Cache Sliding The amount of time a report will remain in cache 0:00:10
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Display Name Description Default
Value

Expiration Timeout
(hh:mm:ss)

after the last time it is accessed.

Reporting Office Exten-
sions Database
Timeout (seconds)

The number of seconds before the SQL data-
base for reporting in Accolade Office Extensions
queries time out.

30

Reporting Office Exten-
sions Timeout
(minutes)

The number of minutes before reporting in Accol-
ade Office Extensions queries time out.

10

Save to Accolade
Timeout (seconds)

The number of seconds before the document
being saved via the Accolade Office Extensions
times out.

1200

Web API Client Cre-
dential Session
Timeout (minutes)

The number of minutes before a web API client's
session will time out due to inactivity.

60

Database Data Api
Command Timeout
(seconds)

The number of seconds before a data API com-
mand times out.

900

* This parameter can also be set within Accolade in Process > Configuration > Parameters.

Time Tracking
The following parameters apply to the Time Tracking optional component:

Display Name Description Default
Value

Advanced Parameters

Time Tracking Max
Daily Units

The maximum daily value not to be exceeded on
a given day when entering time on timesheets.

0

Time Tracking Warn or
Block Input Greater
than Max Daily Units

Enables or disables the ability to enter time
exceeding the daily limit. When set to 0, a warn-
ing displays when users enter a value greater
than the allotted max daily value. When set to 1,
the system clears cells that contain values
greater than the max daily limit, and prevents
users from submitting timesheets.

0

Time Tracking Warn or Enables or disables the ability to enter time on 0
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Display Name Description Default
Value

Block Input on Restric-
ted Days

restricted days. When set to 0, a warning dis-
plays when users enter time on restricted days.
When set to 1, the system prevents users from
entering time on restricted days.

Weekly Restricted
Days

Day(s) of the week which time cannot be entered
on timesheets. 0 = Sunday, 6 = Saturday. Separ-
ate entries using a pipe ( | ) delimiter.

Blank

Weekly Start Day (Read Only) The day of the week on which
timesheets start. 0 = Sunday, 6 = Saturday.

0

Dashboards
The following parameters apply to the Dashboards for Accolade optional component:

Display Name Description Default
Value

Dashboards Server
URL

URL of the Accolade Dashboards Server Blank

Advanced Parameters

Dashboard Users
Group

Name of the User Group used for Dashboards
document permissions.

Blank

Dashboards Web
Ticket Password

Password of the user used for retrieving the
Dashboards web ticket.

Blank

Dashboards Web
Ticket User Name

Name of the user used for retrieving the Dash-
boards web ticket.

Blank

Excel
The following parameters apply to downloading content such as online reports, metrics, and
process model data from Accolade to MS Excel:

Display Name Description Default
Value

Excel Header Back-
ground Color

The background color of the header rows in
online reports downloaded to MS Excel.

0276FD

Excel Header Font The font color of the text in header rows in online FFFFFF
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Display Name Description Default
Value

Color reports downloaded to MS Excel.

Excel Header Is Bold Sets whether the header text is bold or regular
weight in online reports downloaded to MS
Excel.

0

AutoLoader
The following parameters apply to setting the autoloader configuration, and are all read only
within the Standard Parameters list. To update autoloader settings, use the Autoloader
Configuration pane within the Administration Console:

Display Name Description Default
Value

Advanced Parameters

FTP Inbox Path (Read Only) Path to the FTP inbox folder. Blank

FTP Outbox Path (Read Only) Path to the FTP outbox folder Blank

FTP Password (Read Only) Password for the FTP site. Blank

FTP Username (Read Only) Username for the FTP site. Blank

Local Inbox Path (Read Only) File path to the local inbox folder. Blank

Local Outbox Path (Read Only) File path to the local outbox folder. Blank

Relay Delay on Error (Read Only) Length of time in seconds that the
service waits before retrying on error.

Blank

Service Broker
The following parameters apply to the Microsoft SQL Server Service Broker:

Display Name Description Default
Value

Advanced Parameters

Service Broker Con-
versation Lead Time

The number of seconds, prior to the con-
versation lifetime, before the Service Broker
stops sending messages on the conversation.
Set the lead time value as less than the lifetime
value, as it is intended to warn when approach-

14400
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Display Name Description Default
Value

ing the lifetime time out.

Service Broker Con-
versation Lifetime

The maximum number of seconds before the
SQL Service Broker ends the conversation.
The lifetime value must exceed the timeout
value and should be significantly longer than
the time out value to avoid breaching the life-
time conversation end.

86400

Service Broker Con-
versation Timeout

The number of seconds a conversation is
allowed to run before the conversation times
out and fires another conversation. For each
new message sent on the conversation prior to
reaching the time out, Accolade extends the
allotted time for the conversation by this value.

60

Service Broker Retry
Attempts

The number of retries the Service Broker
attempts to complete a request after receiving
an error.

10

Service Broker Retry
Delay

The amount of time to wait between Service
Broker retries (in hh:mm:ss format).

000:00:15
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XML for Online Forms

This appendix provides information about the XML elements used to create online forms. The
information within the following XML reference assumes that you are familiar with XML and its
accepted format.
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XML for Online Forms
This appendix provides information about the XML elements used to create online forms. The
information within the following XML reference assumes that you are familiar with XML and its
accepted format.

Requirements for Online Forms XML
An XML file must contain the appropriate declaration and namespace information for Accolade
to recognize the file as an online form.

XML Declaration

The XML Declaration is the first line in every Accolade\ XML template. This code allows
Accolade and other software to recognize the file as an XML document. It is required and must
be exactly as stated below:

<?xml version="1.0" encoding="UTF-8"?>

XML Namespace

A namespace is the name of the collection of named elements in the document. It uniquely
identifies the element names used in this document. The root element,web-document,
contains two namespaces declared in the following text:

xmlns:wd="urn:sopheon-com:sgm:webdoc:1"

xmlns="urn:sopheon-com:sgm:webdoc:1"

The start tag of the web-document element declares the namespaces using the following
format:

<wd:web-document
title="Document Title Text"

   xmlns:wd="urn:sopheon-com:sgm:webdoc:1"
   xmlns="urn:sopheon-com:sgm:webdoc:1">

Do not omit or modify the namespace declarations.

The practical effect of having two declarations is that element tags can be written either as
<wd:group> or as <group>.

web-document
The root element of an online form. Contains all the other elements.

Number of occurrences Once per document
Parent elements None
Child elements group
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Format

<wd:web-document
title="Title of the Online Form"

   xmlns:wd="urn:sopheon-com:sgm:webdoc:1"
   xmlns="urn:sopheon-com:sgm:webdoc:1"
</wd:web-document>

Attributes

Attribute Editable Description

title Yes The source for the title of the online
form. Can contain substitution
tokens to display Accolade data.

namespace No Written as a declaration, "xmlns="
or "xmlns:wd=" followed by the
namespace.

Example

The following example is of an online form that contains an empty group:

<wd:web-document
   title="A Simple Online Form"
   xmlns:wd="urn:sopheon-com:sgm:webdoc:1"

xmlns=”urn:sopheon-com:sgm:webdoc:1”>
      <wd:group
          title="This Grid is Empty">
      </wd:group>
</wd:web-document>

group
Creates a grid of data entry rows. A group element can contain any mix of local-entry and
metric-entry elements. A form can have more than one grid within it to group like items
together.

Parent elements web-document
Child elements local-entry, metric-entry

Format

<wd:group
   title="Title of Grid"
   isCollapsible="true"
   isCollapsed="false">
</wd:group>
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Attributes

Attribute Description

title The source for the grid title. Can contain substitution
tokens to display Accolade data.

isCollapsible Determines if the group contains an
Expand/Collapse button in the title row.

Defaults to true if not specified.
isCollapsed Determines if the grid displays as collapsed when

the form is opened. This attribute has no effect
unless the isCollapsible attribute is set to true.
Defaults to false if not specified.

Example

The following example defines an online form with a grid titled "Project-Critical Metrics" that
contains containing a single metric entry:

<wd:web-document
   title="A Simple Online Form"
   xmlns:wd="urn:sopheon-com:sgm:webdoc:1"
   xmlns=”urn:sopheon-com:sgm:webdoc:1”>
      <wd:group
         title="Project-critical Metrics"
         isCollapsible="false">
         <wd:metric-entry>
             name="marketShare"
             title="Market Share"
             metricName="MktShr">
             <wd:type base="number"/>
         </wd:metric-entry>
      </wd:group>
</wd:web-document>

metric-entry
Creates a data entry row within a grid that is linked to a project metric. The row can both
display the metric’s value and accept a new value to update the metric.

Parent element group
Child elements type
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Format

<wd:metric-entry
   title="Label of This Row"
   name="metricentry_ID"
   metricName="Accolade_metric’s_system_name"
   isRequired="false"
   isEditable="true"
   inputControl="input-control-type"
</wd:metric-entry>

Attributes

Attribute Description

title The row title as it displays in the online form within
Accolade. Sopheon recommends you use the
metric's display name as the title. Can contain
substitution tokens to display Accolade data.

Defaults to a blank row title if not specified.
name The source for the row title in the online form XML

file. Just be unique within the XML file. Sopheon
recommends you use the metric's display name as
the title. Can contain substitution tokens to display
Accolade data.

Defaults to a blank row title if not specified.
metricName (Required) The project metric system name to which

this field is linked.
isRequired Determines if an entry within this field in the online

form is required before saving the form.

Defaults to false if not specified.
isEditable Determines if the field is editable within the online

form.

Defaults to true if not specified.
inputControl Determines the type of field, such as a check box or

drop-down list. The selection here depends on the
data type, for example, a list metric lends itself well
to a drop-down list selection field. See "XML Input
Controls" on page 757 information about the type of
inputs available.

Example

The following example defines a required, editable metric entry for a metric namedMktShare.
The name of the entry, which acts as its ID in the online form, ismarketShare, and its title is
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Estimated Market Share. The field is typed as a number. After the user enters data in the
form and saves a working copy, Accolade creates an additional element that stores the data.

<wd:group
   title="Market Info"
   isCollapsible="false">
   <wd:metric-entry
      title="Estimated Market Share"
      name="marketShare"
      MetricName="MktShare" 
      isRequired="true"
      isEditable="true">
         <wd:type base="number"/>
   </wd:metric-entry>
</wd:group>

local-entry
Creates a data entry row within a grid for data that is not connected to a metric or metadata
within the database. Instead, the data is saved as part of the online form.

Parent element group
Child elements type, initial-value

Format

<wd:local-entry
   title="Label for This Row"
   name="element_ID"
   isRequired="false"
   isEditable="true"
   inputControl="input-control-type"
      <wd:type base="datatype"/>
         <wd:initial-value>Literal string</wd:initial-value>
</wd:local-entry>

Attributes

Attribute Description

title The source for the row title in the online form.
Sopheon recommends you use the metric's
display name as the title. Can contain substitution
tokens to display Accolade data.

Defaults to a blank row title if not specified.
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Attribute Description

name The source for the row title in the online form.
Sopheon recommends you use the metric's
display name as the title. Can contain substitution
tokens to display Accolade data.

Defaults to a blank row title if not specified.
isRequired Determines if an entry within this field in the online

form is required before saving the form.

Defaults to false if not specified.
isEditable Determines if the field is editable within the online

form.

Defaults to true if not specified.
inputControl Determines the type of field, such as a check box

or drop-down list. The selection here depends on
the data type, for example, a list metric lends itself
well to a drop-down list selection field. See "XML
Input Controls" on page 757 information about the
type of inputs available.

Example

The following example shows a local entry containing a string of text with substitution tokens.
When the online form is created from the template, the substitution tokens are replaced with
actual names of the deliverable and the project.

<wd:group
   title="*{DeliverableName}*">
   <wd:local-entry
      title="Description of *{DeliverableName}*"
      name="PrimaryDescript1"
      isRequired="true"
      isEditable="true"
      inputControl="multi-line-text-box">
         <wd:type base="long-string"/>
         <wd:initial-value>Some information about *
{DeliverableName}* for *{ProjectName}* showing substitution.
         </wd:initial-value>
   </wd:local-entry>
</wd:group>

type
Identifies the data type of ametric-entry or local-entry elements.
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Parent elements metric-entry, local-entry
Child elements enumeration, leftdigits, rightDigits

Format

<wd:type base="boolean"/>

or

<wd:type base="enum">
   <wd:enumeration value="High"/>
   <wd:enumeration value="Medium"/>
   <wd:enumeration value="Low"/>
</wd:type>

Attributes

Attribute Description

base Identifies the data type for this entry. Can be one
of the following:
l string - Accepts a sequence of alpha-numeric
characters. Use for string type metrics.

l long-string - Accepts a long sequence of
alpha-numeric characters. Use for long-string
type metrics.

l number - Accepts any digit and the decimal
point. Use for number type metrics.

l date - Accepts a date, such as 01/01/2014.
Use with date type metrics.

l enum - Accepts a single selection from a list of
options. Use with list type metrics.

l boolean - Accepts true or false. Applies to
local-entry elements only.

l multi-enum - Accepts multiple selections from
a list of options. Applies to local-entry elements
only.

Example

The following example defines an entry as a string type:

<wd:local-entry
   title="Activity Notes"

name=”ActivityNotes”>
      <wd:type base=”string”/>
</wd:local-entry>
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enumeration
Specifies the list items when a local-entry element's type is set to enum ormuli-enum. This
element applies to only local-entry elements.

Parent elements type
Child elements N/A

Format

<wd:type base="enum">
   <wd:enumeration value="High"/>
   <wd:enumeration value="Medium"/>
   <wd:enumeration value="Low"/>
</wd:type>

Attributes

Attribute Description

value Contains a list item as string enclosed in quotes.

Example

<wd:local-entry
   title="Meteorological Risk"
   name="WeatherAtLaunch"
   input-control="multi-select-list">
      <wd:type base="multi-enum">
         <wd:enumeration value="snow"/>
         <wd:enumeration value="sleet"/>
         <wd:enumeration value="hail"/>
         <wd:enumeration value="heat"/>
         <wd:enumeration value="All the above"/>
</wd:type>

leftDigits
Specifies the maximum number of digits allowed to the left of the decimal point in a field that
accepts a number. For example, if leftDigits is set to 4, users can enter the number 12.3 or
1234.56, but not 12345.67. This element applies only tometric-entry and local entry parents
that are set to use a type of number.

Parent elements type
Child elements N/A
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Format

<wd:type base="number"/>
   <wd:leftDigits value="6"/>
</wd:type>

Attributes

Attribute Description

value Contains a positive, whole integer.

Example

<wd:metric-entry
   title="Total Materials"
   name="TotMatrCost"
   metricName="TMC">
      <wd:type base="number">
         <wd:leftDigits value="5"/>
      </wd:type>
</wd:metric-entry>

rightDigits
Specifies the maximum number of digits allowed to the right of the decimal point in a field that
accepts a number. For example, if rightDigits is set to 3, users can enter 12.1 or 0.123, but not
5.1234.

Parent elements type
Child elements N/A

Format

<wd:type base="number">
    <wd:rightDigits value="2"/>
</wd:type>

Attributes

Attribute Description

value Contains a positive, whole integer.
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Example

<wd:metric-entry
   title="Net Present Value"
   name="NPV"
   metricName="NPV">
      <wd:type base="number">
         <wd:leftDigits value="5"/>
         <wd:rightDigits value="2"/>
      </wd:type>
</wd:metric-entry>

initial-value
Displays a value in a local-entry field before the document owner enters any data. When the
document owner later modifies the entry, the new data replaces the initial displayed value.

Set the local-entry element to read-only to display an initial value without it be being editable.

Number of occurrences Once for each containing entry.
Parent elements local-entry
Child elements sub-value

Format

<wd:initial-value>Text string.</wd:initial-value>

Note: The text in an initial-value element is not enclosed in quotes as is the text in
attributes and must be identical to one of the enumeration values.

Attributes

None.

Example

The following example shows an initial-value element for a local-entry that is a type of
string:

<wd:local-entry
   name=”comment 1”
   title=”Stage Comment”>
      <wd:type base=”string”/>
      <wd:initial-value>Enter comments on progress since the last
gate meeting.
      </initial-value>
   </wd:local-entry>

The following example shows an initial-value for a local-entry that is a type of date:
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<wd:local-entry
   title=”Market Launch”>
   name=”Mkt Launch”
      <wd:type base=”date”/>
      <wd:initial-value>07/04/2014
      </wd:initial-value>
</wd:local-entry>

The following example shows an initial-value for a local-entry that is a type of enum:

<wd:local-entry
   title=”Tensile Quality”>
   name=”Tear_Strength”
   input-control="radio-button-group">
      <wd:type base=”enum”/>
         <wd:enumeration value="Easy"/>
         <wd:enumeration value="Difficult"/>
         <wd:enumeration value="Impossible"/>
         <wd:initial-value>Easy</wd:initial-value>
</wd:local-entry>

sub-value
Displays an initial value when a local-entry field is a type ofmulti-enum. It must contain as its
value one of the enum items specified by an enumeration.

Parent elements initial-entry
Child elements None

Format

<wd:sub-value>Text string</wd:sub-value>

Attributes

None.
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Example

<wd:local-entry
   title="Most Active Markets"
   name="ActiveMkts"
      <wd:type base="multi-enum">
         <wd:enumeration value="Select two most active"/>
         <wd:enumeration value="USA"/>
         <wd:enumeration value="China"/>
         <wd:enumeration value="South America"/>
         <wd:enumeration value="Europe"/>
       </wd:type>
       <wd:initial-value>
       <wd:sub-value>Select two most active</wd:sub-value>
       </wd: initial-value>
</wd:local-entry>

XML Input Controls
Themetric-entry and local-entry elements contain an inputControl attribute that specifies
the type of software control the entry field uses in the form.

The entry's software control must be appropriate to the type of data entered. in that field. For
example, a date field needs to use the date inputControl. Each data type has a default input
control, but where a different control is allowed you can override the default using the
inputControl attribute. For example, to specify a multi-line text box for a string type entry,
include the following code within the entry element.

inputControl="multi-line-text-box"

inputControl Description Default for
Data Type

single-line-text-box A text box with one line that
accepts text. Suitable for entering
short strings of text, such as
names.

string

number-box A text box with one line that
accepts number. Suitable for
entering decimal numbers.

number

multi-line-text-box A text box with multiple lines.
Suitable for entering longer strings,
such as descriptions.

long
string

check-box A check box. Suitable for recording
a yes/no or true/false value.

boolean
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inputControl Description Default for
Data Type

radio-button-group A set of mutually-exclusive options
buttons. Suitable for choosing a
single value from a list.

single-select-list A list box that accepts one
selection. Suitable for choosing a
single value from a list.

drop-down-list A drop-down list of options that
accepts one selection. Suitable for
choosing a single value from a list.

enum

multi-select-list A list box that accepts more than
one selection. Suitable for
choosing several values from a
single list.

multi-
enum

check-box-group A set of check boxes. Suitable for
choosing several values from a
single list.

date A calendar. Suitable for selecting a
date.

date

Data Substitution Tokens in XML
Within in an online form's XML, include substitution tokens that are replaced with Accolade
project information, such as the project name, from the project in which the form is being used.
Substitution tokens are Accolade field codes, but formatted for use in XML code.

In the following example, the *{DeliverableStageName}* token is replaced with the stage that
the deliverable is in when the online form is accessed from a project.

<wd:local-entry
   title="Primary Goals in *{DeliverableStageName}*"
   name="Goals_Purpose"
   isRequired="false"
   ...

When the deliverable is opened, the substitution process finds all substitution tokens and
replaces them with the appropriate data. If a substitution token is part of an initialvalue, the
token will be overwritten when the document owner enters data into the entry. Modifying the
initial value ends the substitution.

See "Accolade Field Codes and Substitution Tokens" on page 771 for a list of available
substitution tokens.
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Queries and Query Codes

This appendix provides guidance around writing successful database queries, and a list of
each of the query field codes available to pull Accolade project data into a query result.
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Writing Successful Database Queries
Keep the following general points in mind when writing queries in SQL to retrieve data from the
Accolade database:

l In Accolade, queries are limited to the SELECT statement. A basic query has the
following form:

SELECT ColumnName, ColumnName, ...
FROM ViewName

l Only one FROM statement is allowed in each query and it must be following by a
reporting view name with the appropriate prefix. A single query can reference multiple
reporting views.

l Queries can also contain a WHERE clause:

SELECT ColumnName, ColumnName, ...
FROM ViewName
WHERE ColumnName < ColumnName2, ...

l Queries in Accolade are not case sensitive, with the exception of the LinkableName
query token.

l Use ANSI style SQL syntax in your query to ensure that it works correctly.

l Accolade queries are designed to prevent the corruption of data or the alteration of the
database structure. To ensure database integrity, the following keywords can only be
used within a WHERE clause:

l DELETE

l DROP

l CREATE

l INSERT

l UPDATE

l GO

l When writing queries for list metrics, to filter the items in the list, insert query field codes
into a WHERE clause in the query. If you use a query that returns multiple columns in a
list metric, the metric displays only the first column. For the list of query field codes, see
"Query Field Codes Reference" on page 762.

Substitution Tokens

Queries can contain tokens that insert data, such as a link to a project, into the results of the
query. The following tokens are allowed in Accolade queries:
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l Query field codes - A field code, much like an Accolade field code, that you can insert
into a WHERE clause to restrain the list items in a query-based list metric. See "Query
Field Codes Overview" on page 761.

The list metrics created can be either single select or multi-select and either individual
or cascading, where the values displayed in the child metric in a cascading list depend
on what was selected in the parent metric. The list metrics can be designated as filter
metrics and used to filter projects, for example on the Resource Editor, Search, and
other pages.

l LinkableName - Inserted instead of the ProjectName column displays the project's
name as a link to the Accolade project.

l $USERID$ - Inserted in a WHERE clause, restricts the information the query returns to
only data to which the user viewing the report has access.

Query Field Codes Overview
Add query field to WHERE clauses in database queries to constrain the list items in the list
metric generated by the query. The list metrics created can be either single select or multi-
select and either individual or cascading, where the values displayed in the child metric in a
cascading list depend on what was selected in the parent metric. The list metrics can also be
designated as filter metrics and used to filter projects, for example on the Resource Editor,
Search, and other pages.

Using query codes when creating a query, you can retrieve the following information types:

l Project metadata - Returns current information about a project. For example, project
name and description, gate dates, gate decisions, and so on.

l Metrics - Returns current values for metrics used throughout your system.
l Extended Fields for Resource Pools - Returns a comma delimited list of the selected
security list item IDs for a resource pool.

Field Code Format

Query fields have the following basic pattern: {*source:name*}, where source identifies the
general type of data displayed, and name identifies the specific data. Query codes for
metadata and extended fields use sourceQMD. Query Codes for metrics use sourceQME.
Codes are not case sensitive.

Example

l {*QMD:ProjectCreationDate*} - Returns the date the project was created.

l {*QME:NPV*} - Returns the value for the metric whose system name is NPV.

See "Query Field Codes Reference" on page 762 for a complete list of query codes available.
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Query Field Codes Reference

Use the following query field codes to retrieve project data from the database for display in a
query-based list metric. You can copy and paste the codes from this topic directly into your
queries. For information about creating queries, see "Adding Database Queries" on page 379.

l "QMD Codes (metadata)" on page 762

l "Extended Fields for Resource Pool Codes" on page 769

QMD Codes (metadata)

The following table contains the list of query codes that return project metadata, such as a
project's current and next gate information. Codes are grouped into categories. For example,
all the codes that return information about the next gate for a project start with
ProjectNextGate.

Code Description

Supported
in

Portfolio
Optimizer

{*QMD:AsOfDate*} When the query was last
run.

Y

Ideas

{*QMD:DateReturnedToIdeaSubmitter*} The date on which this
idea was returned to the
idea submitter.

{*QMD:IdeaSubmitterID*} The idea submitter's user
ID.

{*QMD:IdeaSubmitterName*} The idea submitter's
name.

Process Model and Class

{*QMD:ModelID*} The system ID of the pro-
ject's model.

Y

{*QMD:ModelName*} The name of the project's
process model.

Y

{*QMD:ProcessType*} The process type of the
project's process model.
For example, Gated.

Y

{*QMD:ProcessTypeID*} The system ID of the pro-
cess type of the project's
model.

Y
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Code Description

Supported
in

Portfolio
Optimizer

{*QMD:ProjectClass*} The project's class. Y

Access Group

{*QMD:ProjectAccessGroup*} The name of the project's
access group.

Y

{*QMD:ProjectAccessGroupID*} The system ID of the pro-
ject's access group

Y

Security List

{*QMD:ProjectSecurityListID1*} The system ID of the first
security list.

Y

{*QMD:ProjectSecurityListID2*} The system ID of the
second security list.

Y

{*QMD:ProjectSecurityListID3*} The system ID of the third
security list.

Y

{*QMD:ProjectSecurityListID4*} The system ID of the
fourth security list.

Y

{*QMD:ProjectSecurityListID5*} The system ID of the fifth
security list.

Y

{*QMD:ProjectSecurityListSystemName1*} The system name of the
first security list.

Y

{*QMD:ProjectSecurityListSystemName2*} The system name of the
second security list.

Y

{*QMD:ProjectSecurityListSystemName3*} The system name of the
third security list.

Y

{*QMD:ProjectSecurityListSystemName4*} The system name of the
fourth security list.

Y

{*QMD:ProjectSecurityListSystemName5*} The system name of the
fifth security list.

Y

General Project Information

{*QMD:ProjectClosed*} The project's closed
statues. Returns 1 if the
project is closed.

Y

{*QMD:ProjectCreationDate*} The date when the pro- Y
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Code Description

Supported
in

Portfolio
Optimizer

ject was created in the
system.

{*QMD:ProjectDescription*} The project's description. Y

{*QMD:ProjectEndDate*} The project's defined end
date.

Y

{*QMD:ProjectID*} The user-created ID of
this document's project.

Y

{*QMD:ProjectIsGateFirst*} Returns 1 if the process
model used for the pro-
ject begins with a gate
instead of a stage.

Y

{*QMD:ProjectGateDate-(gate number)*} The date of the gate
meeting of a specific
gate.

Y

{*QMD:ProjectName*} The project's name. Y

{*QMD:ProjectStartDate*} The project's start date. Y

{*QMD:SysProjectID*} The project's system ID.

Currency

{*QMD:ProjectConversionFactor*} The factor to convert the
project currency to the
corporate currency.

{*QMD:ProjectCurrencyCode*} The currency code of the
currency used in the pro-
ject. This may differ from
your corporate currency.

{*QMD:ProjectCurrencyName*} The name of the currency
used in the project.

Current Phase or Stage

{*QMD:ProjectCurrentPhase*} The phase the project is
currently in.

Y

{*QMD:ProjectCurrentStageDescription*} The current stage's
description.
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Code Description

Supported
in

Portfolio
Optimizer

{*QMD:ProjectCurrentStageName*} The current stage's
name.

Y

Previous Gate Information

{*QMD:ProjectPreviousGateConditions*} The conditions if the pre-
vious gate decision was
Conditional Go.

Y

{*QMD:ProjectPreviousGateDate*} The gate date of the pre-
vious gate.

Y

{*QMD:ProjectPreviousGateDescription*} The description of the pre-
vious gate.

{*QMD:ProjectPreviousGateLocation*} The location of the pre-
vious gate meeting.

{*QMD:ProjectPreviousGateName*} The name of the previous
gate.

Y

{*QMD:ProjectPreviousGateNotes*} The gate notes of the pre-
vious gate.

Most Recent Gate and Status Information

{*QMD:ProjectMostRecentGateDecisionCode*} The gate decision code
of the project's previous
gate.

Y

{*QMD:ProjectMostRecentGateDecisionName*} The name of the project's
previous gate.

Y

{*QMD:ProjectMostRecentStatus*} The text of the most
recent project status mes-
sage.

{*QMD:ProjectMostRecentStatusAuthor*} The user name of the
author of the project's
most recent status mes-
sage.

{*QMD:ProjectMostRecentStatusDate*} The date of the project's
most recent status mes-
sage.
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Code Description

Supported
in

Portfolio
Optimizer

Next Gate or Stage

{*QMD:ProjectNextGateDate*} The date of the next pro-
ject gate

Y

{*QMD:ProjectNextGateDescription*} The description of the
next project gate

{*QMD:ProjectNextGateLocation*} The location of the next
project gate meeting.

{*QMD:ProjectNextGateName*} The name of the next pro-
ject gate.

Y

{*QMD:ProjectNextGateOwnerEmail*} The email address of the
gate owner of the next
project gate.

{*QMD:ProjectNextGateOwnerID*} The system ID of the gate
owner of the next project
gate.

{*QMD:ProjectNextGateOwnerName*} The name of the gate
owner of the next project
gate.

{*QMD:ProjectNextGateOwnerVMAddress*} The chat address of the
gate owner of the next
project gate.

{*QMD:ProjectNextStageName*} The name of the next pro-
ject stage.

Gate After the Next Gate

{*QMD:ProjectFollowingGateDate*} The date of the gate after
the next gate in the
model.

Y

{*QMD:ProjectFollowingGateDescription*} The description of the
gate after the next gate.

{*QMD:ProjectFollowingGateLocation*} The location of the gate
meeting after the next
gate.

{*QMD:ProjectFollowingGateName*} The name of the gate Y
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Code Description

Supported
in

Portfolio
Optimizer

after the next gate.

Next Stage

{*QMD:ProjectNextStageDescription*} The description of the
next project stage.

{*QMD:ProjectNextStageName*} The name of the next pro-
ject stage.

Y

Project Manager (Team Leader)

{*QMD:ProjectTeamLeaderEmail*} The email address of the
project's manager.

{*QMD:ProjectTeamLeaderID*} The ID of the project's
manager.

Y

{*QMD:ProjectTeamLeaderName*} The name of the project's
manager.

Y

{*QMD:ProjectTeamLeaderVMAddress*} The chat address of the
project's manager.

Project Status

{*QMD:ProjectWarningStatus*} Returns 1 through 8:
l 1 - One or more
deliverables in the
current stage are
marked in trouble.

l 2 - Next gate is within
warning period and
some deliverables
are incomplete.

l 3 - Some
deliverables in
current stage are
incomplete.

l 4 - Project is ready
for next gate.

l 5 - One or more
deliverables in the
current stage are
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Code Description

Supported
in

Portfolio
Optimizer

marked in trouble
and there are unmet
conditions in the
previous gate.

l 6 - Next gate is within
warning period,
some deliverables
are incomplete, and
there are unmet
conditions in the
previous gate.

l 7 - Some
deliverables are
incomplete, and
there are unmet
conditions in the
previous gate.

l 8 - Project is ready
for next gate but
there are unmet
conditions in the
previous gate.

{*QMD:ProjectInTrouble*} Returns 1 if the project is
marked as In Trouble.

Y

Project Resources

{*QMD:RequestorIsProjectOwner*} Returns 1 if the user
requesting a resource is
the project manager of
the project.

Y

Exclusions

{*QMD:ProjectExcludeFromLineup*} Returns 1 if the project is
prevented from appear-
ing on the Gate Lineup
page.

{*QMD:ProjectExcludeFromReports*} Returns 1 if the project's
data is prevented from
appearing in reports.
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Extended Fields for Resource Pool Codes

You can create a query-based, list-type field whose query contains a field code like the QMD
query field codes for list metrics. The code's pattern is {*QMD:(metadata name)*}. The code
returns a comma delimited list of the selected security list item IDs for the pool.

Code Description

{*QMD:PoolSecurityListID1*} Code for secur-
ity list 1.

{*QMD:PoolSecurityListID2*} Code for secur-
ity list 2.

{*QMD:PoolSecurityListID3*} Code for secur-
ity list 3.

{*QMD:PoolSecurityListID4*} Code for secur-
ity list 4.

{*QMD:PoolSecurityListID5*} Code for secur-
ity list 5.

{*QMD:PoolSecurityListSystemName1*} System name
for security list
1.

{*QMD:PoolSecurityListSystemName2*} System name
for security list
2.

{*QMD:PoolSecurityListSystemName3*} System name
for security list
3.

{*QMD:PoolSecurityListSystemName4*} System name
for security list
4.

{*QMD:PoolSecurityListSystemName5*} System name
for security list
5.
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Accolade Field Codes and
Substitution Tokens

Use Accolade field codes and substitution tokens to pull data from Accolade into a document
upon download or an online form upon open. For example, enter a code that represents the
date of the next gate in project. When the document or online form is opened, the code is
replaced with the date for the next gate as it is entered in the project, without having to
manually update the information.

You can use field codes in documents, spreadsheets, and presentations (and in online forms,
however, the format is different). Most Accolade fields also work in project-level reports.

The tables in the sections below contain the complete codes for the MD, CONFIG, IMAGE,
REFTABLE, CHART, QUICK GRID, QUICK GRID ELEMENT, REPORT, POD, and FLAG
sources, and their online form equivalents where applicable. Metrics use the metric system
name as the code name and they can be unique to each company, so a list of complete codes
is not provided for the METRIC source.

You can copy and paste codes from this topic directly into your documents
or forms. To find the code you need, first identify the source of the data.
For example, to add a piece of data from a project, you need metadata.
From there, determine what type of document you are creating;
deliverable, activity, or gate document. Narrowing down the source and
subcategory within the source can help find the name of the item in the
information below.
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Metadata (MD)
Use the MD source to display metadata, additional data about the project or document that the
code is in, such as the author's name. The following tables contain data relating to projects,
deliverables, activities, and gates. Some codes are restricted as to the document type.
Additionally, not all codes can be used in metric calculations. Use the code's equivalent
function formula in calculations. See "Calculated Metric Expressions Reference" on page 136
for a list of functions.

A code used in the wrong type of document does display any information when the document
is refreshed.

Project Data Codes

Project codes display information about the current state of the project at the time the field is
refreshed. These fields can be used in any Accolade document, project-level report, or online
form.More...

For example, if the project is currently in Stage 2, the "next gate name" code shows the name
of Gate 2, whether the code is in a deliverable in Stage 1 or an Activity in Stage 5. That is,
project metadata is not related to the stage or gate the document is stored in, but to the stage
that the project is currently in. Project metadata codes works in all project documents
(including related documents). For example, if the project is currently in Stage 2, the "next gate
name" code shows the name of Gate 2, whether the code is in a deliverable in Stage 1 or an
Activity in Stage 5. That is, project metadata is not related to the stage or gate the document is
stored in, but to the stage that the project is currently in. Project metadata codes works in all
project documents (including related documents)

File-Based Code Online Form Code Description

{*MD:AsOfDate*} *{AsOfDate}* When the
data was
last
refreshed
with the cur-
rent data
from the
server.**

{*MD:ProjectName*} *{ProjectName}* The name of
this doc-
ument's pro-
ject.**

{*MD:ProjectID*} *{ProjectID}* The user-cre-
ated ID of
this doc-
ument's pro-
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File-Based Code Online Form Code Description

ject.**

{*MD:SysProjectID*} *{SysProjectID}* The Accol-
ade system
ID number of
this doc-
ument's pro-
ject.**

{*MD:ProjectDescription*} *{ProjectDescription}* The descrip-
tion of the
project from
the model.**

{*MD:ProjectClass*} *{ProjectClass}* The name of
this project's
class.**

{*MD:ProjectCreatedByID*} *{ProjectCreatedByID}* The ID of the
user that cre-
ated the pro-
ject.**

{*MD:ProjectCreatedByName*} *{ProjectCreatedByName}* The name of
the user that
created the
project.**

{*MD:ProjectStartDate*} *{ProjectStartDate}* The date
when the
project star-
ted.**

{*MD:ProjectEndDate*} *{ProjectEndDate}* The date
when the
project
ended.**

{*MD:ProjectCreationDate*} *{ProjectCreationDate}* The date
when this
project was
created.**

{*MD:ProjectTeamLeaderName*} *{ProjectTeamLeaderName}* The name of
this project's
Project Man-
ager.**
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File-Based Code Online Form Code Description

{*MD:ProjectTeamLeaderEmail*} *{ProjectTeamLeaderEmail}* The email
address of
this project's
Project Man-
ager.**

{*MD:ProjectTeamLeaderVMAddress*} *{ProjectTeamLeaderVMAddress}* The chat
address of
this project's
Project Man-
ager.

{*MD:IdeaSubmitterName*} *{IdeaSubmitterName}* The name of
the person
who sub-
mitted the
idea.

{*MD:ProjectAccessGroup*} *{ProjectAccessGroup}* The name of
this project's
access
group.**

{*MD:ProjectCurrentPhase*} *{ProjectCurrentPhase}* The system
ID number of
the current
stage/gate
pair in the
project. The
project cur-
rent phase is
set to 0 if the
project ends
in a gate,
and the
gate's
decision is
set toGo.**

{*MD:ProjectCurrentStageName*} *{ProjectCurrentStageName}* The name of
the current
project
stage.**

{*MD:ProjectCurrentStageDescription*} *{ProjectCurrentStageDescription}* The descrip-
tion of the
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File-Based Code Online Form Code Description

current pro-
ject stage.

{*MD:ProjectNextStageName*} *{ProjectNextStageName}* The name of
the next pro-
ject stage.

{*MD:ProjectNextStageDescription*} *{ProjectNextStageDescription}* The descrip-
tion of the
next project
stage.

{*MD:ProjectNextGateName*} *{ProjectNextGateName}* The name of
the next gate
in the pro-
ject.**

{*MD:ProjectNextGateDescription*} *{ProjectNextGateDescription}* The descrip-
tion of the
next gate in
the project.

{*MD:ProjectNextGateDate*} *{ProjectNextGateDate}* When the
next gate
meeting of
this project
will occur.**

{*MD:ProjectNextGateLocation*} *{ProjectNextGateLocation}* The location
of the next
gate meet-
ing.

{*MD:ProjectNextGateOwnerName*} *{ProjectNextGateOwnerName}* The name of
the gate
owner of the
project's
next gate.**

{*MD:ProjectNextGateOwnerID*} *{ProjectNextGateOwnerID}* The system
ID of the
gate owner
of the pro-
ject's next
gate.

{*MD:ProjectNextGateOwnerEmail*} *{ProjectNextGateOwnerEmail}* The email
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File-Based Code Online Form Code Description

address of
the gate
owner of the
project's
next gate.

{*MD:Pro-
jectNextGateOwnerVMAddress*}

*{Pro-
jectNextGateOwnerVMAddress}*

The chat
address of
the gate
owner of the
project's
next gate.

{*MD:ProjectPreviousGateName*} *{ProjectPreviousGateName}* The name of
the gate
before the
current
stage.

{*MD:ProjectPreviousGateDescription*} *{Pro-
jectPreviousGateDescription}*

The descrip-
tion of the
gate before
the current
stage.

{*MD:ProjectPreviousGateDate*} *{ProjectPreviousGateDate}* The date of
the gate
meeting
before the
current
stage.**

{*MD:ProjectPreviousGateLocation*} *{ProjectPreviousGateLocation}* The location
of the pre-
vious gate
meeting.

{*MD:ProjectPreviousGateNotes*} *{ProjectPreviousGateNotes}* Notes taken
at the pre-
vious gate
meeting.

{*MD:ProjectPreviousGateConditions*} *{ProjectPreviousGateConditions}* The descrip-
tion of con-
ditions, if
any, entered
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File-Based Code Online Form Code Description

in the last
approved
gate.

{*MD:ProjectFollowingGateName*} *{ProjectFollowingGateName}* The name of
the gate fol-
lowing the
next gate.

{*MD:Pro-
jectFollowingGateDescription*}

*{Pro-
jectFollowingGateDescription}*

The descrip-
tion of the
gate fol-
lowing the
next gate.

{*MD:ProjectFollowingGateDate*} *{ProjectFollowingGateDate}* The date of
the gate
meeting
after the
next gate.

{*MD:ProjectFollowingGateLocation*} *{ProjectFollowingGateLocation}* The location
of the gate
meeting
after the
next gate.

{*MD:ProjectGateDate-<gate
number>*}

*{ProjectGateDate-<gate
number>*}

The date of
the gate
meeting of a
specific
gate. For
use in an MS
Excel-based
template
using the
SGM_
Metadata
worksheet.**

{*MD:ProjectMostRecentStatus*} {*ProjectMostRecentStatus*} The text of
the project's
most recent
status
report.**
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File-Based Code Online Form Code Description

{*MD:ProjectMostRecentStatusAuthor*} {*Pro-
jectMostRecentStatusAuthor*}

The name of
the person
who created
the project's
most recent
status
report.**

{*MD:ProjectMostRecentStatusDate*} {*ProjectMostRecentStatusDate*} When the
project's
most recent
status report
was cre-
ated.**

{*MD:ModelName*} *{ModelName}* The name of
the model
this project
is using.* **

{*MD:ProcessType*} *{ProcessType}* The type of
model this
project is
using, for
example,
Gated.*

{*MD:ProjectCurrencyCode*} *{ProjectCurrencyCode}* The cur-
rency code
of the project
currency.*

{*MD:ProjectCurrencyName*} *{ProjectCurrencyName}* The name of
the project
currency.*

{*MD:ProjectConversionFactor*} *{ProjectConversionFactor}* The mul-
tiplier used
to convert
the project
currency to
the cor-
porate cur-
rency.*

{*MD:ProjectClosed*} *{ProjectClosed}* The project's
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File-Based Code Online Form Code Description

closure
status.**

* Available to idea forms.

** Invalid metadata code in calculated metrics. Use the equivalent formula function in calculations instead.

Deliverable Data Codes

Deliverable codes display information about the deliverable or about the parent deliverable if
they are in an activity document. Use deliverable codes only in deliverables and activity
documents.

File-Based Code Online Form Code Description

{*MD:DeliverableName*} *{DeliverableName}* The deliv-
erable's
name.*

{*MD:DeliverableID*} *{DeliverableID}* The deliv-
erable's sys-
tem ID
number.

{*MD:DeliverableDescription*} *{DeliverableDescription}* The deliv-
erable's
descrip-
tion.*

{*MD:DeliverableOwnerName*} *{DeliverableOwnerName}* The name
of the deliv-
erable's
owner.

{*MD:DeliverableOwnerEmail*} *{DeliverableOwnerEmail}* The email
address of
the deliv-
erable's
owner.

{*MD:DeliverableOwnerVMAddress*} *{DeliverableOwnerVMAddress}* The chat
address of
the deliv-
erable's
owner.

{*MD:DeliverableStageName*} *{DeliverableStageName}* The name
of the deliv-
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File-Based Code Online Form Code Description

erable's
stage.*

{*MD:IsStageLocked*} *{IsStageLocked}* Returns a 1
if the deliv-
erable's
stage is
locked, 0 if
unlocked.

{*MD:DeliverableStart*} *{DeliverableStart*} The deliv-
erable's
start date.

{*MD:DeliverableDeadline*} *{DeliverableDeadline}* The date
entered in
Accolade by
which this
deliverable
should be
completed.

{*MD:DeliverablePlannedFinishDate*} *{DeliverablePlannedFinishDate}* The date
entered in
MS Project
on which
this deliv-
erable
should be
completed.

{*MD:DeliverableStatusID*} *{DeliverableStatusID}* The current
status, such
as In Pro-
cess, of this
deliverable.

{*MD:DeliverableFunctionalArea*} *{DeliverableFunctionalArea}* The deliv-
erable's
functional
area.

{*MD:De-
liverableFunctionalAreaSysName*}

*{Deliv-
erableFunctionalAreaSysName}*

The system
name of the
deliv-
erable's
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File-Based Code Online Form Code Description

function.

{*MD:DeliverableNextGateName*} *{DeliverableNextGateName}* The name
of the next
gate, rel-
ative to the
stage that
contains the
deliverable.

{*MD:DeliverableFollowingGateName*} *{DeliverableFollowingGateName}* The name
of the gate
following
the next
gate, rel-
ative to the
stage that
contains the
deliverable.

{*MD:DeliverableFunctionalArea*} *{DeliverableFunctionalArea}* (Obsolete)
This code is
included
only for
backwards
com-
patibility
and will be
removed in
a future
release.

* Available to idea forms.

Activity Data Codes

Activity codes display information about the activity they are in. Use activity codes only in
activity documents.

File-Based Code Online Form Code Description

{*MD:ActivityName*} *{ActivityName}* The activity's
name.

{*MD:ActivityID*} *{ActivityID}* The activity's
system ID
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File-Based Code Online Form Code Description

number.

{*MD:ActivityDescription*} *{ActivityDescription}* The activity's
description.

{*MD:ActivityOwnerName*} *{ActivityOwnerName}* The name of
this activity's
owner.

{*MD:ActivityOwnerEmail*} *{ActivityOwnerEmail}* The email
address of
the activity's
owner.

{*MD:ActivityOwnerVMAddress*} *{ActivityOwnerVMAddress}* The chat
address of
the activity's
owner.

{*MD:ActivityStageName*} *{ActivityStageName}* The name of
the activity's
stage.

{*MD:IsStageLocked*} *{IsStageLocked}* Returns a 1
if the activ-
ity's stage is
locked, 0 if
unlocked.

{*MD:ActivityStart*} *{ActivityStartID}* The activity's
start date.

{*MD:ActivityDeadline*} *{ActivityDeadline}* The date,
entered in
Accolade,
for when this
activity
should be
completed.

{*MD:ActivityPlannedFinishDate*} *{ActivityPlannedFinishDate}* The date
entered in
MS Project
on which this
activity
should be
completed.
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File-Based Code Online Form Code Description

{*MD:ActivityStatusID*} *{ActivityStatus}* The current
status, such
as In Pro-
cess, of this
activity.

{*MD:ActivityFunctionalArea*} *{ActivityFunctionalArea}* The activity's
functional
area.

{*MD:ActivityFunctionalAreaSysName*} *{Activ-
ityFunctionalAreaSysName}*

The system
name of the
activity's
functional
area.

Gate Data Codes

Gate codes display information about the gate that their document is stored in. Use gate codes
only in gate documents.

Code Description

{*MD:GateName*} The name of the gate that document is
stored in.

{*MD:GateDescription*} The gate's description.

{*MD:GateDocumentName*} The gate document's name.

{*MD:GateDocumentID*} This gate document's system ID number.

{*MD:GateDocumentDescription*} This gate document's description.

{*MD:GateOwnerName*} The name of the gate owner of this gate.

{*MD:GateOwnerID*} The user ID of this gate's owner.

{*MD:GateOwnerEmail*} The email address of this gate's owner.

{*MD:GateOwnerVMAddress*} The chat address of this gate's owner.

Extended Project Data Codes

Extended project data codes display and update information that is entered in up to ten fields
to enter extended strings that are added to a project at the process model level. These fields
can be used in any Accolade document; however, ensure that the document format accepts
the amount of data added to the field. See "Capturing Large Data Strings in Accolade" on page
161.
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Code Description

{*MD:ExtendedProjectData<field number>*} The data entered in the specified Extended
Project Data field in the project. For
example, {*MD:ExtendedProjectData1*},
{*MD:ExtendedProjectData2*}, etc.

Idea Form Codes
The following Idea form codes are substitution tokens specific to idea online forms and display
information about the idea model. Note that other options are available to idea forms, as
indicated by 1 in the previous tables.

Idea Online Form Code

*{DeliverableRoutingType}*

*{PMDeliverableID}*

*{PMDeliverableName}*

*{PMDeliverabledDescription}*

*{ProcessModelID}*

*{ProcessName}*

*{ProcessOwnerEmail}*

*{ProcessOwnerName}*

*{ProcessOwnerVMAddress}*

*{ProcessDescription}*

*{PhaseName}*

CONFIG
Accolade provides the option to change the names for certain terms used throughout the
system. For example, stages, gates, and deliverables can be renamed to fit your company's
nomenclature. Use the CONFIG codes below to display custom names that your company
uses instead of Accolade terms. The Administrator or Process Designer must have already
entered the preferred name on the Parameters tab of the Configuration page for these fields
to work correctly. This source also includes two codes for currencies.

Code Description

{*CONFIG:CompanyName*} The name of your company.
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Code Description

{*CONFIG:Accolade*} The custom name for "Accolade."

{*CONFIG:CorporateCurrencyCode*} The code for your corporate currency. This
field code is not used to display a custom
name.

{*CONFIG:CorporateCurrencyName*} The name of your corporate currency. This
field code is not used to display a custom
name.

{*CONFIG:Stage*} The custom name for "stage."

{*CONFIG:Stages*} The custom name for "stages."

{*CONFIG:Gate*} The custom name for "gate."

{*CONFIG:Gates*} The custom name for "gates."

{*CONFIG:GateDocument*} The custom name for "gate document."

{*CONFIG:GateDocuments*} The custom name for "gate documents."

{*CONFIG:GateOwner*} The custom name for "gate owner."

{*CONFIG:Deliverable*} The custom name for "deliverable."

{*CONFIG:Deliverables*} The custom name for "deliverables."

{*CONFIG:Activity*} The custom name for "activity."

{*CONFIG:Activities*} The custom name for "activities."

IMAGE
Use to display Accolade project images. When a template is opened in a project, selected
images from that project display in the document. Your implementation of Accolade may
include other, custom image codes in addition to the standard codes listed here.

Unlike other codes, IMAGE codes are not pasted into the document text but into theWeb tab
of the Format Picture dialog box where the image is inserted.

Code Description

{*IMAGE:ProjectThumbnail*} The image selected as the Project Thumb-
nail.

{*IMAGE:ProjectMain*} The image selected as the Project Main.

{*IMAGE:ProjectProcessGraphic*} The model graphic shown on Home and
other project pages. Includes text and stage
and gate icons.
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REFTABLE
Use the REFTABLE code to display the value from a single reference table cell. It has an
extended pattern that is required to specify the table, row, and column of the cell.

{*REFTABLE:<TableSystemName> #RowID=<row ID>
#ColumnID=<ColumnSystemName>*}

The value for the Row ID is the value in the first column of the row. In a currency table, it would
be the currency code. The value of the Column ID is the column's system name. The only
spaces in this pattern occur just before each # character. The order of the #RowID and
#ColumnID options in the pattern does not matter. Like the other codes, the REFTABLE code
is not case sensitive.

Example

{*REFTABLE:sgm_currency #RowID=USD #ColumnID=CurrencyName*} displays the value
in the "USD" row of the "CurrencyName" column of the "Currency" table.

CHART
Use the CHART field code to display a chart created in Accolade. The CHART field code is
only valid in presentations. The source is always "Chart", and the name identifies which chart
to display by the chart system name.

{*CHART:<ChartSystemName>*}

Example

{*Chart:<ChartSystemName>*} is the basic naming pattern. For example, {*CHART:TCost*}
displays the chart with a system name of "TCost."

QUICK GRID
Use the QUICK GRID field code to display a quick grid created in Accolade. The QUICK GRID
field code is only valid in presentations and has an extended pattern required to specify the
grid contained in the quick grid. Only one grid can be specified per quick grid field code.

{*QUICKGRID:<QuickGridSystemName> #Grid=<GridSystemName>*}

Example

{*QuickGrid:<QuickGridSystemName> #Grid=<GridSystemName>*} is the basic naming
pattern. For example, {*QuickGrid:RegionalProjections #Grid=QuarterOne*} displays the
individual grid "QuarterOne" that is a component of the quick grid "RegionalProjections."
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QUICK GRID ELEMENT
Use the QUICK GRID ELEMENT field code to display a specific cell from a quick grid created
in Accolade. The QUICK GRID ELEMENT field code is only valid in presentations and has an
extended pattern required to specify the specific cell and grid contained in the quick grid. Only
one cell and grid can be specified per quick grid element field code.

Note: Matrix quick grids are not supported with the Quick Grid Element field code.

{*QUICKGRIDELEMENT:<QuickGridSystemName> #Grid=<GridSystemName>
#Element=<ElementSystemName>*}

Example

{*QuickGridElement:<QuickGridSystemName> #Grid=<GridSystemName>
#Element:<ElementSystemName>*} is the basic naming pattern. For example,
{*QuickGridElement:RegionalProjections #Grid=QuarterOne #Element=COGS*} displays
COGS cell data from the individual grid "QuarterOne" that is a component of the quick grid
"RegionalProjections."

REPORT
Use the REPORT field code to display an online report created in Accolade. The field code
does not support HTML reports or reports created in the Accolade Office Extensions add-in.
The REPORT field code is only valid in presentations. The source is always "Report", and the
name identifies which report to display by the report system name.

{*REPORT:<ReportSystemName>*}

Example

{*Report:<ReportSystemName>*} is the basic naming pattern. For example,
{*Report:FinancialStatus*} displays the report with a system name of "FinancialStatus."

POD
The POD code pulls project information contained on custom project pages. The code requires
an extended pattern to identify the layout containing the pod, and then specify which pod to
include. The POD code is only valid in presentations.

{*POD:<LayoutSystemName> #PodSystemName=<PodSystemName>*}

Note: This field code goes in the shape's alt text.

Example
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{*Pod:<LayoutSystemName> #PodSystemName=<PodSystemName>*} is the basic naming
pattern. For example, {*Pod:ProjectHomeLayout #PodSystemName=DataFormForHome*}
displays the pod with a system name of "DataFormForHome" within the layout
"ProjectHomeLayout."

METRIC
See Metric Field Codes with Options for information about adding metric codes and long string
metrics to documents.

FLAG
Use the FLAG field code to denote a special action to be performed.

Note: This field code goes in the shape's alt text.

Example

{*FLAG:RepeatForSelectedProjects*} - When placed on a slide, repeats the slide for all
selected projects.

{*FLAG:RepeatForMatrixRows*} - When placed on a slide, renders a new slide for each row of
a matrix.

PORTFOLIO SUMMARY
Use the PortfolioSummary field code to indicate that a shape is to be used to summarize a
portfolio presentation. Cannot be used with the "repeat" FLAG field code.

Note: This field code goes in the shape's alt text.

Example

{*PortfolioSummary:BulletedList #Fields=MD|[MetadataName],METRIC|
[MetricSystemName]...*}

{*
PortfolioSummary:SmartArt
#SmartArtLayouttype=VerticalPictureAccentList #ImageType=ProjectThumbnail*}

Portfolio Summary Field Code Breakdown:

PortfolioSummary:[SummaryType]
Always Required

Notes: BulletedList does not support project images.
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Possible values are:

l BulletedList
l SmartArt

SmartArtLayoutType=[LayoutTypeName]
Required for "PortoflioSummary:SmartArt"

Notes: The smart art will replace the shape the field code was in. If a user tries to specify a
SmartArt Type that is unsupported, the refresh will use VerticalPictureAccentList instead.

Full list of supported Smart Art types:

l AccentProcess
l AccentedPicture
l AlternatingFlow
l AlternatingHexagons
l AlternatingPictureBlocks
l AlternatingPictureCircles
l ArrowRibbon
l AscendingPictureAccentProcess
l Balance
l BasicBendingProcess
l BasicBlockList
l BasicChevronProcess
l BasicCycle
l BasicMatrix
l BasicPie
l BasicProcess
l BasicPyramid
l BasicTarget
l BasicTimeline
l BasicVenn
l BendingPictureAccentList
l BendingPictureBlocks
l BendingPictureCaption
l BendingPictureCaptionList
l BendingPictureSemiTransparentText
l BlockCycle
l BubblePictureList
l CaptionedPictures
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l ChevronList
l CircleAccentTimeline
l CircleArrowProcess
l CirclePictureHierarchy
l CircularBendingProcess
l CircularPictureCallout
l ClosedChevronProcess
l ContinuousArrowProcess
l ContinuousBlockProcess
l ContinuousCycle
l ContinuousPictureList
l ConvergingArrows
l CounterbalanceArrows
l CycleMatrix
l DescendingBlockList
l DescendingProcess
l DetailedProcess
l DivergingArrows
l Equation
l FramedTextPicture
l Funnel
l Gear
l GridMatrix
l GroupedList
l HalfCircleOrganizationChart
l HexagonCluster
l Hierarchy
l HierarchyList
l HorizontalBulletList
l HorizontalHierarchy
l HorizontalLabeledHierarchy
l HorizontalMultiLevelHierarchy
l HorizontalOrganizationChart
l HorizontalPictureList
l IncreasingArrowsProcess
l IncreasingCircleProcess
l InvertedPyramid
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l LabeledHierarchy
l LinearVenn
l LinedList
l MultidirectionalCycle
l NameandTitleOrganizationChart
l NestedTarget
l NondirectionalCycle
l OpposingArrows
l OpposingIdeas
l OrganizationChart
l PhasedProcess
l PictureAccentBlocks
l PictureAccentList
l PictureAccentProcess
l PictureCaptionList
l PictureGrid
l PictureLineup
l PictureStrips
l PieProcess
l PlusandMinus
l ProcessArrows
l ProcessList
l PyramidList
l RadialList
l RadialVenn
l RandomToResultProcess
l RepeatingBendingProcess
l ReverseList
l SegmentedCycle
l SegmentedProcess
l SegmentedPyramid
l SnapshotPictureList
l SpiralPicture
l SquareAccentList
l StackedList
l StackedVenn
l StaggeredProcess
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l StepDownProcess
l StepUpProcess
l SubStepProcess
l TableHierarchy
l TargetList
l TextCycle
l TitlePictureLineup
l TitledPictureAccentList
l TitledPictureBlocks
l TrapezoidList
l UpwardArrow
l VerticalAccentList
l VerticalArrowList
l VerticalBendingProcess
l VerticalBlockList
l VerticalBoxList
l VerticalBulletList
l VerticalChevronList
l VerticalCircleList
l VerticalCurvedList
l VerticalEquation
l VerticalPictureAccentList
l VerticalPictureList
l VerticalProcess

#Fields=[List of fields to display]
Optional

Notes: Multiple metadata fields and metric fields can be added by appending them to the ones
before with a ",". Any metric is allowed to be in the Fields section. Please note the vertical bar
character "|" between "MD" and "MetadataName".

Supported Metadata

l ProjectId
l ProjectName
l Description
l TeamLeader
l CurrentStage
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l NextGate
l LastGate

#ImageType=[ProjectImageType]
Optional

Notes: Project picture (thumbnail / main as defined in domain table).

MATRIX METRIC
Can only be used in PowerPoint. See Adding Accolade Objects to PowerPoint for information
about adding matrix metric codes to PowerPoints.

RICH TEXT MATRIX METRIC
Can only be used in PowerPoint. See Adding Accolade Objects to PowerPoint for information
about adding rich text matrix metric codes to PowerPoints.

RICH TEXT METRIC
Can only be used in PowerPoint. See Adding Accolade Objects to PowerPoint for information
about rich text metric codes to PowerPoints.

INFO
Used in office documents to show additional non-project information.

Code Description

{*INFO:RefreshTimestamp*} Only available to Excel documents.

Token is replaced with the time that a Smart
Refresh occurred. Useful for tracking how
fresh the data contained within a Smart
Excel Document is.

Learn More:

Field Codes Overview

"Accolade Field Code Placeholders" on page 794

"Metric Field Codes with Options" on page 794
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Accolade Field Code Placeholders
When you download a document from Accolade and open it in a Microsoft application, the
Accolade data replaces the field code in the document, making it difficult to tell what is
represented by a field code, especially if you are a Process Designer or Administrator
maintaining templates.

Each field code entered into a document is marked in the document with a placeholder so you
can determine the location of the code, even when it displays Accolade data. All Accolade field
code placeholders have names that begin with SGM_ and are saved as the following:

Microsoft Application Placeholder

Word Saved as bookmarks.

Excel Saved as cell ranges.

PowerPoint Saved as alternative text on the Web tab of
the Format (object) dialog box for the rel-
evant shape.

Use the tools within each Microsoft application to locate the placeholder.

Learn More:

Accolade Field Codes Overview

Accolade Field Codes Reference

"Metric Field Codes with Options" on page 794

Metric Field Codes with Options

To create a report showing the system names of all current metrics, use
Accolade Office Extensions or Accolade Online Reporting to create a
report that includes the Metric Display Name and Metric System Name
columns from the Metric Definitions subject.

Use metric field codes to do the following:

l Display a metric's value.

l Display other data related to the metric.

l Update a metric value (only in the case of a Long String type metric in a Word document
that is not a related document).

The basic pattern of a metric field code is the same as for other codes: {*source:name*}. For
metric codes, the source is always "Metric", and the name is the system name of the metric.
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For example, {*METRIC:TCost*} displays the value of the metric whose system name is
"TCost".

Note: Because a metric code uses the metric's system name, if a metric's system
name changes, you must update any templates or reports that contain a
code for that metric.

Important! This does not apply to MetricRichText tokens.

Option Patterns

Metric codes have optional additions to the basic pattern. Options can:

l Make the code display something other than the metric value.

l Change how the value is displayed.

l Enable the code to update a metric value in addition to displaying it. This capability is
limited to codes for Long String type metrics in Word documents that are not related
documents.

If options are added, they are listed after the code's name. The pattern for a metric code with
options is: {*METRIC:name option*}. The name and options, if any, are separated by a
space.

Example

{*METRIC:NPV #DisplayName*} would show the NPV metric's display name rather than the
metric value. And {*METRIC:NPV #ProjectCurrency #Format2*} would display the value in the
project currency using that currency's second format.

There are two types of options, primary and secondary:

l Primary Option - Identifies the data that replaces the value, so a code can contain only
one primary option.

l Secondary Option - Specifies how the field code behaves, so a code can contain one
or more secondary options either in addition to or without a primary.

The options in the table below are intended for use in ordinary, non-updating codes while the
options in the second table are for codes that update Long String metrics in Word.Options in
one table should not be combined in the same code with options from the other table.

Metric Code Options

Some options in the following table can be used with all types of metrics, while others should
be used only in certain types, as shown in the table.
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Option Option Type Description

All Metric Types

#DisplayName Primary Displays the metric's display
name.

#Description Primary Displays the metric's descrip-
tion.

#DataType Primary Displays the metrics data
type.

#OnceOnly Secondary The field refreshes only
once, then the persisting
bookmark is deleted. Add a
code with this option to a
Smart Excel cell to display
the metric value once, after
which the same cell updates
the metric.

Only List Metrics

#ListItems_Pipe Primary Displays the metric's list
items in a pipe-delimited
string.

#ListItems_Comma Primary Displays the metric's list
items in a comma-delimited
string.

#ListItems_CR Primary Displays the metric's list
items in a carriage-return-
separated list.

#ListItems_Table Primary Displays the metric's list
items in a table format.

Only Currency Metrics

#ProjectCurrency Primary The metric's value is given in
the project currency.

#CorporateCurrency Primary The metric's value is given in
the corporate currency.

#Format1 Secondary The metric value is dis-
played using the first number
format listed in the Currency
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Option Option Type Description

reference table.

#Format2 Secondary The metric value is dis-
played using the second
number format listed in the
Currency reference table.

Long String Metrics Update Options

Ametric field for a Long String type metric can update the metric's values when the code is
inserted in a Word document. The metric is updated in Accolade when the document is saved
back to Accolade. If the document version is created as a link to an external document or web
page, the metrics does not update when the document is published. For information on setting
up the Word template, see "Updating Metrics in Accolade From Documents (Long String
Metrics)" on page 195.

Important! Long string metric field codes apply only to Word documents and are
not applicable in other Microsoft applications. This feature is not supported for
related documents.

This kind of code has three options. These options cannot be used in non-updating codes, and
the options listed in the table above should not be added to updating codes.

Option Option Type Description

#Updateable Secondary This metric can be updated
by the code if this option is
present.

#DefaultValue=(value) Secondary Displays the text following
"=" when the metric is empty
in Accolade. If the # char-
acter is part of the value,
enter "##" in the template.

Important! If
there is no
default value, a
string of spaces
is inserted into
the field. To edit
the field, delete
the spaces
before entering
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Option Option Type Description

text.

#MaxLen=(value) Secondary Sets a maximum length, in
characters, for the field. The
value must be a number
under 2000. If this option is
not used in the code, the
metric field has a size limit of
2000 characters.

Example

For a Long String type metric named BusiCase:

l The code {*Metric:BusiCase #Updateable*} allows the metric to be updated.

l The code {*Metric:BusiCase #Updateable #MaxLen=500 #DefaultValue=Enter the
business case*}:

l Would allow the metric to be updated.

l Would allow the user to enter up to 500 characters in the field.

l Would display the text "Enter the business case" if the metric was empty when the
document was opened.
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Customer Support

Customer support is available by email and by telephone. See www.sopheon.com/contact.

General Sopheon Corporation

6870West 52nd Avenue
Suite 215
Arvada, CO 80002
Telephone: +1 (303) 736 4900
Fax: +1 (303) 736 4949
info@sopheon.com

For additional location information, see www.sopheon.com.

Technical Publications

Your feedback is always welcome! Send comments and suggestions about this online Help's content to
techpubs@sopheon.com.
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